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Foreword
It gives me great pleasure to look back at the days when I worked for Craig Danuloff at
his Boulder service bureau because things are so much better now. Back then, we
worked in a perpetual state of rage and anxiety. We let customers peer over our shoulders as we inadvertently mangled their pages and ruined their text, we'd wait an hour
or more to typeset a single page only to watch it rip to shreds in the processor, and
we'd sit by helplessly as documents for major customers became hopelessly corrupted.
Behind it all was a single product, Aldus PageMaker, and the myth of desktop publishing. Customers streamed into our storefront under the misconception that desktop
publishing would expand their options and save them money. Having come from a
traditional paste-up background, I knew for a fact it was just the opposite. Back in the
days before personal computers, you could work wonders armed only with a knife and
a waxer and never have to worry about files corrupting and pages refusing to print.
But we always had faith. One day, we felt certain, desktop publishing would develop
into a viable alternative, and we would be there to reap the benefits. As it turns out, we
were half right. We didn't quite reap the benefits the way we thought we would- our
service bureau is now the site of a Greek restaurant- but PageMaker, personal computers, PostScript, typesetters, and hundreds of peripheral software and hardware
elements have improved over the years by an order of magnitude. Nowadays, desktop
publishing has not only brought more people into the publishing industry, it has
permanently cornered the professional design market. I can assure you from hard-won
personal experience, the PageMaker story is an unqualified s uccess.
This book is a similar success and the best part is the author himself. Craig Danuloff is
one of those gifted people who can look at a piece of software, organize its capabilities
into a natural hierarchy, and deliver his thoughts on the matter in the amount of time it
takes most of us to remove the shrink wrap. If you learn half as much from him as I
have, you'll be running circles around PageMaker halfway through the book.
-Deke McClelland
Author of Macworld Photoshop 2.5 Bible
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Introduction
I first met PageMaker one sunny summer day in 1985. The program had just been
officially released, and I had just plunked down $8,000 for an Apple LaserWriter and
started what would later become known as a desktop publishing service bureau. Almost
nine years later (that's 42 years in computer and dog years), it is amazing to think back
to those days when PageMaker ran in 512K and was the single most amazing piece of
microcomputer software that many people had ever seen. Back then, as a member of
the PageMaker beta test group, I could even call Mike Templeman (one of PageMaker's
chief programmers) and have my feature requests added to the next in-house version
and shipped to me within a few days. Ah, the good old days.
At that time it was pretty easy to be a PageMaker expert. All you had to do was understand the Place command and the pasteboard, and remember to hit Command-S every
few seconds. The only thing that really confused anybody was handlebars. Handlebars
are part of the text blocks that PageMaker uses to store and manipulate text, and for
some reason, beginners always let their handlebars run wild.
Today it's not so easy to be a PageMaker expert. Being a PageMaker expert now means
knowing quite a bit about typography (tracking, kerning, baselines), color (process,
spot, tints, traps), printing (separations, composites, PPDs), document management
(indexing, table-of-contents generation, linked files), and a whole lot more. And for some
strange reason, handlebars still confuse people.
And that's the reason for this book. It's almost impossible to become really proficient at
PageMaker without some help, and I want you to become a PageMaker expert. This is a
worthwhile goal because, if you're like many of the people who use PageMaker, some
important part of your job is probably dependent upon your being able to use
PageMaker productively. You probably don't have hours to spend creating andrecreating documents. When you finish a publication, you need to know that it will print
and that it will come out looldng as you expect it to. And I'm sure you want to take
advantage of all those hidden features and capabilities that the programmers stuck in
there even if they're not obvious and even if they aren't in the manuals.
So over the next 19 chapters, we're going to go over PageMaker 5 with a fine-toothed
comb. You're going to learn what every single feature, option, and undocumented
keyboard shortcut does, and more importantly I'm going to explain them all in the ldnd
of real-world context in which you'll find yourself working. You'll notice pretty quickly
that I don't pull any punches and when something isn't right I just blurt out my opinion.
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I think that's part of what you pay me for. I also believe that honest criticism can have a
positive effect on future versions of PageMaker- so if you agree with any of my
"comments," please let Aldus know.
For your efforts- reading this book and working with PageMaker- you'll be rewarded
with what remains an amazingly empowering tool, and even more amazing publications
of your own creation.

What's Inside
This book is aimed primarily at the beginning or intermediate PageMaker user, although
even the most experienced PageMaker users will learn a few things. (Hey, I learned
quite a few things while writing it.) There are three major parts in the book: Introducing
PageMaker, Mastering PageMaker, and Advanced Topics.
Part I, Introducing PageMaker, lays the foundation for using the software by describing
the basic page layout metaphor PageMaker uses and the commands and techniques
you'll use universally as you work. Absolute beginners will want to read the chapters in
Part I carefully because, as in most endeavors, the fundamentals are extremely important to ultimate mastery. I would even advise those who have a good amount of
PageMaker experience to read through the chapters in Part I, searching for that item
that you didn't know or one technique you aren't already using. A simple improvement
in some basic technique, such as your ability to select objects or change view sizes, can
pay off big in terms of productivity.
The chapters in Part 1:
Chapter 2, System Requirements and Installation. If you haven't yet installed your
copy of PageMaker, or if you want to better understand the hardware and software
requirements that will make it operate more efficiently, read this chapter carefully.
Chapter 3, What's New in PageMaker 5. Especially designed for those familiar with
previous versions of PageMaker, this chapter takes a quick look at every new feature,
command, and option in PageMaker 5.
Chapter 4, Terms, Tools, and Menus. Here's where the reaJ introduction to PageMaker
begins, with some basic terms you'll have to know, and then a top-to-bottom review of
every menu command and floating palette PageMaker 5 provides.

Chapter 1: Introduction

Chapter 5, A Brief Tour of PageMaker. The basics of actually using PageMaker are all
covered in this chapter, including creating new publications, learning your way around
the publication window, opening existing files, saving your work, and quitting when
you're finished.
Chapter 6, Publication Window Basics. The last chapter in this section focuses on the
publication window, and how you can control the PageMaker environment by changing
view sizes, scrolling the display, creating column guides, working with the rulers, and
manipulating text and graphic objects.
Part II, Mastering PageMaker, covers the most central PageMaker tasks, the creation
and manipulation of text and graphics. This includes importing text, creating text in
PageMaker, using the story editor, and how to use style sheets to automate text formatting. I cover both internally created and imported graphics as well as all kinds of
graphic manipulations. Finally, I introduce the control palette.

How gurus get that way
Did you ever wonder how software experts get to be software experts? Over the
years, at trade shows, conferences, and user groups, I've had the chance to spend a lot
of time with a lot of computer gurus and software wizards. Since I spend a lot of my
time trying to help others achieve such status, I often ask these folks how they got to
know so much. You may be surprised to learn that most of these folks admit to reading
their software manuals and other computer books. And they don't just read them once,
they read them several times at different points in their experience.
You see, it's impossible to pick up everything the first time. There is simply too much
information, and without a wide range of experience, many subtleties and advanced
topics just won't make sense. Rereading a manual or book after you've had more
experience always results in new insights and understandings.
So if anyone (or any other book) tries to tell you that real Macintosh users don't read
manuals, take it as a big clue that they don't know what they're talking about. And
when you read this book, or any other, spend some time in chapters that cover
subjects you're already comfortable with. They just might provide the biggest surprises.
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These chapters represent the heart of PageMaker. Experienced users should pay
particular attention to Chapter 9, which covers PageMaker's little-understood advanced
typographic features, and Chapter 13, which focuses on the new control palette. By the
same token, beginning users may want to just skim these chapters at first and come
. back to them later after gaining more experience in the more-fundamental skills.
The chapters in Part II:
Chapter 7, Creating Text. It would be hard to create too many interesting publications
without text, so this chapter tells all about importing text into PageMaker from just
about any external source. It also explains how you can create text right in the publication window or by using the PageMaker story editor.
Chapter 8, Sample Project One. For those who would like to test out everything learned
in the first seven chapters, this sample project allows you to work step-by-step in
creating a simple flyer. All the files you need are included on the disks in the back of this
book.
Chapter 9, Formatting Text. Once you've got the text in PageMaker, the fun really
begins as you learn to use the program's typographic capabilities to modify character
and paragraph formatting. This chapter introduces dozens of typographic controls,
including fonts, leading, kerning, tracking, Jetter spacing, baseline shift, and many more.
Chapter IO, Style Sheets. This is a chapter about productivity. Style sheets help you to
automate your work and ensure consistency within publications and between publications. You'll learn how to use them in this chapter and how to integrate them into your
word processor.
Chapter I I, Graphic Elements. Even the most elegant typography needs the company
of at least a few graphics or graphic elements. This chapter shows you how to import
graphics created in other applications, create graphics in PageMaker, and then integrate graphics throughout your documents.
Chapter I2, Sample Project Two. Building on everything covered thus far, and focusing
on the new skills learned in Chapters 9, 10, and 11, this second sample project provides
another opportunity to follow along and practice your PageMaker skills.
Chapter I3, The Control Palette. Another productivity-focused chapter, here you'll
learn all about the PageMaker's new control palette, which makes it faster and easier to
format text and manipulate textblocks and graphics. In addition to complete coverage
of the control palette itself, dozens of new keyboard shortcuts are included.

Chapter 1: Introduction

Part 111, Advanced Topics, moves beyond the basics to look at advanced capabilities
provided by PageMaker as well as other Aldus software. These include the details of
working with color, using Aldus Additions, formatting long documents, printing, and
Aldus prepress software including Aldus PrePrint, Aldus PressWise, and Aldus
TrapWise.
The chapters in Part III:

Chapter 14, Working with Color. Adding color to your publications is easy in
PageMaker, and this chapter introduces all of the color tools you'll want at your disposal. Many of the important issues related to color printing are covered her e, too,
including process color, spot color, and tints; how to work with colored EPS graphics;
and import ing and exporting colors.
Chapter 15, Aldus Additions. More than 20 additional features are provided in
PageMaker 5 in the form of Aldus Additions, which are plug-in modules that appear in
the Aldus Additions submenu. This chapter introduces Additions technology, provides
a detailed look at all of the Addit ions included with PageMaker, and examines a few of
the third-party Additions available for separate purchase. You will also learn about
creating custom scripts using the Aldus Additions scripting language.
Chapter 16, Long Document Features. When documents go beyond a certain length, a
number of new issues arise in terms of formatting them for easy reading and reference
and managing their production. This chapter focuses on PageMaker features geared
especially for such long documents, such as generating tables of contents and indexes,
printing multiple publications, and linking externally stored text and graphic files.

Chapter 17, Printing Publications. There are two parts to printing PageMaker files, and
this chapter covers them both. First it provides tips to help you construct documents
that have the best chance of printing without incident. Then it takes you through every
option and feature of PageMaker's powerful printing dialog boxes.

Chapter 18, Sample Project Three. The last sample project ties together just about all
of PageMaker 's capabilities, as you follow along in the production of a simple newsletter
that includes color, a table of contents, and more.

Chapter 19, Aldus PrePress Tools. In most professional publishing environments,
PageMaker won't be used alone but rather will be used along with one or more of the
Aldus PrePress software programs introduced in this chapter: Aldus PrePrint, Aldus
PressWise, or Aldus TrapWise. You'll also learn about Aldus Fetch in this chapter- a
great media database application, which is provided in a trial version on the disks
included with this book.
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Several icons throughout the book point to information of special interest.
Tips are time-saving shortcuts or quick techniques that will help you work
smarter.

Operations tips are little-known or undocumented ways to get the most from
PageMaker.

Background icons alert you to information about how and why things work the
way they do.

System 7 sections cover features and issues of particular Importance to System
7 users.
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In This Chapter
•

System requirements and recommendations

•

How your Macintosh, hard drive, RAM, and monitor affect
PageMaker

•

Keeping your older versions of PageMaker

•

Running the Aldus Installer/Utility

•

Third-party utilities you should be using

••••••••••••••••••••••••••••••••••••••••••••••••

IntheBegb.urlng ______________
When Aldus released PageMaker 1.0 in June 1985, the system requirements and installation techniques for the application were fairly simple - PageMaker came on a single
floppy disk and ran only on the Apple Macintosh 512K computer. And since Macintosh
hard drives were virtually unheard of, installing PageMaker was as easy as inserting the
disk.
Today, the system requirements and installation techniques for PageMaker version 5
are more complicated. PageMaker can be installed on more than two dozen different
Macintosh models, the program itself ships on half a dozen 1.44MB floppy disks, and
the installation procedure is affected by the printers, scanners, word processors, and
graphics applications you intend to use with the program.
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Part 1: Introducing PageMaker

This chapter explains the hardware and software requirements of PageMaker 5 and the
procedures for installing the application. I'll begin by reviewing the basic system
requirements prescribed by Aldus and then look at each aspect of a Macintosh publishing system in detail. Next, the actual software installation is reviewed. Finally, I'll cover
some post-installation modifications to your system.

System Requirements and
Recommendations
In preparing to release a new version of PageMaker, Aldus has to make a number of
hard decisions: "Should Aldus Manutius or the Yuppie be in the start-up screen?", "Will
the box be all purple or purple and some other color?", and "What should we claim is
the minimum required hardware configuration?"
You see, the minimum system requirement is not really the minimum hardware configuration on which PageMaker will run. It is minimum hardware configuration on which
Aldus believes you can use PageMaker without experiencing physical pain and calling
the company to complain about how slow the thing is. It's a classic struggle between
marketing and sales: On the one hand, the company wants to claim that almost anyone
can run PageMaker on almost any Macintosh (which is actually true), but on the other
hand, it wants to set a reasonable expectation so people with under-powered Macs
don't buy PageMaker and have an unpleasant experience. Like most other software
companies, Aldus tends to err on the side of "A slow user is better than no user" or "Sell
now- apologize later."
According to Aldus, the minimum system requirement for PageMaker 5 is a
68020-equipped Mac with 5MB of RAM, 5MB of free hard drive space, and
System Software 6.07 or later. Its more realistic "recommended system" is a
68030-based system with 8MB of RAM, 14MB of free hard drive space, and
System Software 7.0 or higher. To instaJI everything on the PageMaker disks,
you'll need 23MB of free hard drive space. Living in the real world, I would
probably call that configuration the "practical minimum" and recommend a
25MHz 68030 with 20MB of RAM, at least 1OOMB of free hard drive space, and
System Software 7.1 or higher. The ideal system would include a 68040equipped Mac with 32MB to 128MB of RAM and a 300MB or larger hard drive.

Chapter 2: System Requirements and Installation

11

The bottom line is that PageMaker appreciates horsepower as much or more than any
other program you probably own. The measurable, real-world performance difference
between PageMaker running on a 5MB Mac SE/30 and PageMaker running on a 32MB
Quadra 800 is several hundred percentage points. In case you aren't going to rush out
and buy a new Quadra 800 system just because I recommend it, in the following sections I'll examine each individual aspect of a Macintosh publishing system, pointing out
the effect each has on PageMaker's performance and how I would incrementally upgrade an existing setup.

The Macintosh
OK, it doesn't really matter which Macintosh you use to run PageMaker. It
matters what processor is inside the Mac on which you run PageMaker. Macs
use microprocessors from the Motorola 68000 family, which started with the
68000 chip in the original Mac 128 and all models through the Mac SE. The
68020 was introduced with the Mac II, and the 68030 came along not long after
in the Mac Ilx, Hex, and Ilci. The latest and greatest version is the 68040, which
is used in all Centris and Quadra Macs. Thanks to the slick numbering scheme,
you don't really have to understand microprocessors to get the picture: Higher
numbers are better. Each new version of the 680x0 processor provides a 200300 percent increase in raw power, which translates almost directly into
software speed.
In addition to the processor model number (68020, 68030, 68040), you almost always
see processors described in terms of their clock speed, which describes the rate at
which the processor can process data. Again, bigger is better, and better translates
directly into software speed. Early 68030 Macs Qike the Mac Ilci) ran at 25MHz, while
newer models often run at 33MHz. Accelerator cards containing SOMHz 68030 processors are widely available. Don't underestimate the value of a few more MHz when
buying a new Mac or accelerator.
Almost every Mac currently shipping has a 25MHz 68030 processor or better, so unless
your Mac Is more than two years old you probably don't have a processor problem.
Recent exceptions include the Color Classic, Classic II, LC II, and llvi, which use a 16MHz
68030. But if you have one of these Macs, or any older model, dozens of reasonably priced
accelerator boards ($300- $700) let you upgrade to a 40MHz 68030 or 33MHz 68040
processor without fordng you to buy a whole new Macintosh. And since all of these
processors are from the same Motorola family, you'll find virtually no compatibility problems after you upgrade.
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RAM
Once you've got a fast, or reasonably fast, processor, you need enough RAM so the
processor can operate at peak level. Limited RAM forces the processor to sit idle while
data is transferred in and out of RAM.
Aldus specifies 5MB of RAM as the minimum total for any Mac running PageMaker. On a
Mac with 5MB of RAM, the System Software will consume at least 1.5MB to 2.5MB of
RAM, which would leave between 2,500K and 3,500K for use by PageMaker 5. This is
barely adequate since PageMaker's default memory minimum is 2,750K. Of course, if
you have lots of extensions and fonts or a big Adobe Type Manager (ATM) cache, or if
you want to run QuickTime or another application at the same time as you're running
PageMaker, your System Software will probably consume more than 2.5MB of RAM. The
result is that there won't be 2.5MB left for PageMaker. (As I write this, my System
Software is consuming just over 4MB of RAM, and I don't even have all of my standard
extensions loaded.)

How many Ks in an MB?
If you're confused about the relationship between Ks and MBs, here's a brief
summary of computer math: The smallest unit of measurement on the computer is a bit,
which is a single character t hat can be on or off. Bits are arranged in groups of 8, and 8
bits equal one byte. Since the computer uses a binary system, each byte can represent
numbers ranging from 0 to 255. This really isn't important, but What is important is that
each character in a file (letters or numbers) consumes 1 byte of storage space. Since the
number of bytes in any file can quickly get very large, the size of files is measured in
kilobytes, with each kilobyte equal to 1,024 bytes. The shorthand for kilobytes is KB or
sometimes just K. When measuring larger items, like the size of disk drives or RAM, the
numbers get much larger again, and so the commonly used unit of measure is millions
of bytes, er megabtyes. The shorthand for a megabyte is MB, and 1 megabtye is equal to
1,000 kilobytes (1MB = 1,000K). So saying that PageMaker needs 2,500K of RAM its
equivalent to saying that it needs 2.5MB of RAM.

Chapter 2: System Requirements and Installation
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This is why the "recommended" configuration includes 8MB of RAM. With 8MB installed, even if your System Softwar e grabs 3.5MB, and you have 75 fonts loaded, and
you run QuickTime, and your ATM Cache is set at 512K, and yo u launch Microsoft Word
firs t, you probably will s till have 2,750K left for PageMaker. A perfect world, right?
Not yet. While 2,750K is the "factory preset" range fo r minimum and preferred memory
requirements for PageMaker, they are not the "optimum" memory requirements.
PageMaker runs much quicker and with far fewer problems in 5,000K or more. Hence, if
you need a full 5MB free in order to optima lly run PageMaker, then you probably want
to start out with 20MB, 32MB, or 64MB of RAM so that you can run your bloated System
Software with all your favorite extensions and fonts and s till have 5,000K left for
PageMaker. In these configurations, you'll also be able to run other key applications,
such as Word, FreeHand, and Photoshop, while us ing PageMaker.
To unders tand how memory allocation works, s elect the PageMaker 5 application icon
and choose the Get Info command from the Finder's file menu. (You cannot change
memory allocation while the application is running, so if PageMaker is open, you'll have
to quit first.) In the Get Info dialog box, s hown in Figure 2-1, you'll find the Memory
Requirements options. The Suggested s ize option is unmodifiable, but both Minimum
size and Preferred size can be changed. Aldus sets these three options at 2, 750K, 2, 750K,
and 2, 750K, respectively.

Figure 2-1:
Memory options in the Get Info
dialog box , w ith the Preferred
size changed from the factory
preset 2,750K.
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Note that I'm using System 7.1 for purposes of this illustration. If you are using
System 7.0, 7.01, or System 6 with MultiFinder, option names vary slightly.
System 6 without MultiFinder has no equivalent options to control memory.
When you launch PageMaker, it requests the "Preferred" amount of memory from the
System Software -let's say 3,500K. If that amount is available, great, PageMaker will be
allocated 3,500K and will launch. If only 3,000K is available - less than the Preferred
amount but more than the Minimum amount- PageMaker will be allocated 3,000K, and
it will still launch. But if less than 2,7500K (the Minimum amount) is available,
PageMaker will not launch. Instead, a dialog box appears telling you that not enough
memory is free. In System 7.1 this dialog box also offers to close other applications that
are open but not being used to free enough RAM to launch PageMaker.
When PageMaker launches, portions of the program are read from the hard disk and
loaded into the allocated RAM. Note that I said "portions" of the program. PageMaker 5
itself is almost a full 3MB in size- so the entire program wouldn't even fit into RAM if
only 2,750K were allocated, and even a full3,500K would leave very little room for
documents. This tight fit allows PageMaker to keep only minimal amounts of program
code, publication information, and screen display information in RAM, forcing frequent
reads from the hard drive, which inhibits performance.
Changing the Preferred option in the Get Info dialog box to 4,000K, or even 5,000K,
provides enough memory to bring in all necessary program code as well as most or all
of any open publications. You'll find overall performance improved significantly. Setting
the option higher than 5,000K has little or no additional beneficial effects.

Hard drives
Two aspects of a hard drive are important in relation to PageMaker- size and speed.
The hard drive size you require depends on the type and quantity of publications you
create and on the other uses you have for your Macintosh. The hard drive speed you
require depends on how cute you still find the moving hands of the watch cursor.
PageMaker is a hog when it comes to disk space. The application itself uses 3MB of
space on your hard drive, and depending on the installation options you choose, the
Aldus folder consumes another 5MB- 6MB. Add in the tutorial and help files and the
total reaches almost 15MB, nearly the size of starter hard drives just a few years ago.
PageMaker files (which are generally called publications) vary dramatically in size, but
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are generally much larger than the files created with word processors or graphic
applications. And you will need room to store not only the PageMaker files themselves
(and backup copies of these files), but also all the text and graphic files being used as
components of publications. A book like this takes up about 5MB on disk in PageMaker
publications and original text files.
Today's small to mid-sized hard drives, 120MB to 170MB, are sufficient for "casual"
PageMaker users. Drives in the 300MB to 500MB range are more appropriate for heavy
publishers and don't cost much more than the smaller drives. Large drives, offering 1
gigabyte (a GB or l ,OOOMB) of storage or more are still a little pricey but getting more
affordable all the time. You would be hard pressed to fill that much space with just
PageMaker and its related files, but if you do serious color work in Adobe Photoshop,
store lots of 24-bit TIFF images, or keep a couple of dozen QuickTime movies around, it
isn't really overkill.
ln addition to providing more storage space, large hard drives tend to provide better
performance, both in terms of disk access time, which is reported in milliseconds (ms),
and in terms of throughput, which is reported in megabytes per second (MB/sec). Older
hard drives (four years or more old) , especially 20MB and 40MB models, are generally
rated at access times of between 40ms and 85ms. Today's smallest and slowest drives
have access times of 40ms or better, and most drives larger than 80MB offer speeds of
20ms or less. Once you get into drives of over 200MB, access time is guaranteed to be
less than 15ms, which is fast enough for nearly any purpose. (If you have a hard drive
and don't know how fast it is, you can get utility programs from on-line services and
user groups that will test your drive and report on its performance.)

Drive throughput can vary dramatically at all capacities. Throughput is a measure of a
drive's ability to transfer a large amount of data into RAM. It is a more important
measure than access time for most desktop publishing (DTP or dtp) and graphics work
- access time is critical when reading lots of small files, like spreadsheets, database
records, and word processing documents- but dtp files are large. It is less important
how long it takes to get to the file (the access time) than the time it takes to read the
whole thing (throughput).
Most drives under 500MB offer throughput maximums of only about 1.5MB/sec, while
the fastest available drives today can sustain transfer rates of over 5MB/sec. Throughput capacity used to be hard to determine, but most drive vendors and manufacturers
now list this statistic in ads. If not, ask the salesperson before you buy.
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Your Mac also affects how much throughput your drive can produce, because the SCSI
port on each Mac model has a throughput limit. On early Mac II models this limit was
1.3MB/sec, on the Mac llci it is 2.1MB/sec, but Centris and Quadra Macs all support
speeds over 3MB/sec (some as high as 5MB/sec).

Defragmenting your drive
No matter what s ize drive you have, you can always improve its performance by making
sure it is regularly defragmented. Defragmenting a drive rearranges the files stored on
the drive so that each is stored in sequential sectors and all free space is located at the
end of the drive. This allows the drive to read files more quickly and with less effort
because each file is stored all together in one location rather than in pieces all over the
drive. Keeping your drive defragmented will not only improve its performance, but will
also reduce the wear and tear caused by everyday use, and therefore lengthen drive life.
I recommend Alsoft's Disk Express II for defragmentation, although Norton Utilities,
MacTools, and other packages also provide adequate defragmenting features.

Removable storage
Many people have chosen to add removable storage devices - SyQuest, Bernoulli, and
optical drives are the most popular - in recent years. These devices allow essentially
endless storage (as long as you can afford new blank cartridges) and provide a great
way of transporting large files between Macs or to a service bureau. Most removable
devices offer access times between 20 and 80ms (some older optical drives are slower
than this) and data-transfer rates of a bout 1.3MB/sec. This means that these devices are
somewhat s lower than most hard drives and should not be used for primary storage
whenever possible. You can open files stored on a removable device from within
PageMaker, but if you are going to do extensive work, you'll gain performance by
copying the files onto your hard drive.

Monitors
The monitor you use when working in PageMaker is very important. Your productivity,
and the all-important fun-to-drudgery ratio, is greatly affected by your monitor. As a
practical minimum, you should have at least a 12-inch monitor with 8-bit video. A 14inch monitor with 1~bit video is preferred, and a 16- to 21-inch monitor with 24-bit
video is what you should be dreaming about.
A number of factors affect monitor s uitability. Many are a little technical.
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Making the choice
Here's a look at them one by one:
•

Physical size. The desire for physical size in a monitor seems
obvious -the larger the monitor, the more of a page you can see at one time. It
normally takes a 17-inch monitor to display a full page, and a 21-inch monitor to
display two full pages. But physical size is not the only factor that impacts how
much you see on screen: The monitor's resolution and pixels per inch are the
real determining factors.

•

Resolution. A standard Macintosh 13-inch color display has a resolution of 640 x
480. This means the monitor displays 640 pixels horizontally by 480 pixels
vertically. Most 12-inch monitors (and the 10-inch screen in the Macintosh Color
Classic) have a resolution of 512 x 384. Most 15-inch monitors provide resolutions of 832 x 624, while most 21-inch monitors offer resolutions of 1,152 x 870.
You can change the resolution on some monitors, increasing or decreasing the
amount of information displayed. Many 15-inch monitors, for example, can toggle
between their native 832 x 624 resolution and a 640 x 480 resolution that makes
them act more like a standard 13-inch monitor. Resolution changes are normally
done via the Monitors control panel, although sometimes it is necessary to
change an adapter on the video cable to change resolutions. Since the physical
size of a monitor remains constant when resolution changes, the change is
achieved by altering the number of pixels per inch that the monitor displays.

•

Pixels per inch (ppf), dots per inch (dpi). It is the number of pixels per inch a
monitor displays that determines how many pixels it can fit from one edge to
another, and consequently the resolution of the monitor. The original Macintosh
standard was 72 pixels per inch, and all of today's Apple monitors use between
70 and 80 ppi. Larger monitors often use 90 ppi or higher, especially in higher
resolution modes. When you see a Mac monitor at 90 ppi, you will immediately
notice that the menu bar, menus, dialog boxes, and everything else look smaller
than normal. Some people find this smallness disconcerting, although others
think it is a worthwhile trade-off for improved resolution.

•

Bit depth. The number of different colors that a monitor is capable of displaying
is described as its bit depth. There are four possible bit depths: 1-bit can show
only black and white, 2-bit can show 4 colors, 4-bit can show 16 colors, 8-bit can
show 256 colors, 16-bit can show more than 32,000 colors, and 24-bit can show
16.7 million colors. You set bit depth on the Monitors control panel, which uses
the equivalents shown in Table 2-1 to refer to the various bit depths.

18

Part I: Introducing PageMaker

Table 2-1
The Monitors control panel lists bit depths by
the resulting number of colors.
Bit depth

Monitors control panel equivalent

1-bit

Black and White

2-bit

4 colors

4-bit

16 colors

8-bit

256 colors

16-bit

65,536 colors (or Thousands)

24 bit

Millions of colors

Bit depth is a case where bigger is not necessarily better - in fact bigger is
slower. The more colors you ask your monitor to display, the longer it takes the
screen to refresh when you change view sizes, scroll the display, or turn to a new
page. The advantage of higher bit depths is improved color accuracy. What you have
to decide is how much accuracy you need and the amount of display speed you
are willing to pay for it.

Why 24 bits equal16.7 million colors
Wondering why 24-bit color shows 16.7 million colors? The answer lies in the binary

system that computers use, in which there are only two digits, 0 and 1. This means the
computer counts 0, 1, 1 0, 11, 100, 101, 110, 1 11, 1000, 1001, and so on. A bit is one
digit long. A byte is eight digits long, meaning that it can accommodate up to 256
variations. How did I figure this out? Take the number 2 -as in two digits- and raise
it to a power equal to the number of digits in the unit. In a byte, you have 28 which
equals 256.
So a 1-bit monitor has the opportunity for each pixel to be only 0 or 1, meaning
black or white (on or off). An 8-bit monitor can keep track of (28) or 256 different
options for each pixel, 16-bit equals (216) or 65,5 36 options per pixel, and 24-bit
equals (224) or 16.7 million options per pixel.
But this leaves another mystery. Why is 16-bit color usually referred to as 32,768
colors and not the 65,536 that the math suggests? The answer is that 16-bit and higher
video signals have to divide evenly into thirds- one each for the red, green, and blue
color channels (hence RGB video) - and the video card devotes 5 bits per channel 15 bits total - to this and reserves the leftover bit for color overlay. Therefore, in
practice, you get only to 215, or 32,768 colors.
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For most projects, you should work in 8-bit mode (256 colors). This provides
reasonable color display (although limited technical color accuracy) and very
fast screen-refresh speeds. When you need to select colors from an on-screen
color library and want as much color accuracy as possible, switch to 16-bit
(thousands) or 24-bit mode. These higher bit depths also allow imported TIFF
files to look great on screen. But remember to switch back to 8-bit mode after
you're through selecting colors or have finished looking at the pretty TIFF images
so you don't continue working in the slower mode.
•

Video Cards and VRAM. The bit depths available in the Monitors control panel
are not limited by your monitor- any color monitor can display any number of
colors - but rather by your video card or the amount of video RAM (VRAM)
installed on the card. You can usually improve the bit depth of your system by
adding more VRAM or getting a new card without replacing your monitor.
The amount of VRAM you need to achieve a certain bit depth depends on your
monitor's size and resolution. Larger monitors and higher resolutions mean
more pixels on screen, and each pixel requires proportionally more VRAM for
each increase in the bit depth. In other words, every time you increase bit depth,
monitor size, or resolution, you'll need more VRAM.
Not all video cards are expandable to handle all bit depths and all monitor sizes.
The video circuitry built into most of today's Macs, for example, can handle only
16-bit color up to 16-inch monitors or 832 x 624 resolution. In order to use larger
monitors, higher bit depths, or higher resolutions, you must purchase a new
video card. Check your manual or with the manufacturer of your card for the
specifics of your configuration.

•

QuickDraw Acceleration. Another aspect of video cards that can affect the way
PageMaker displays objects on your monitor is QuickDraw acceleration.
QuickDraw is the Mac system for displaying text and graphic objects on screen.
Many video cards use custom chips and proprietary techniques that can draw
objects on screen faster than the Mac normally draws them - often hundreds of
times faster. Since PageMaker redraws its display very frequently- as you turn
or scroll pages or change view sizes - accelerated QuickDraw has a big effect. A
QuickDraw-accelerated video card is a worthwhile investment for any serious
PageMaker user.

Working with multiple monitors
Any Macintosh with expansion slots can easily work with more than one monitor, but
very few people seem to take advantage of this extraordinary capability. If you have the
desk space (and this is often the most limiting factor), think about adding a second
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monitor to your system for ultimate productivity. A second monitor lets you view two
publications at once, leave a ll PageMaker palettes open and place the m out of the
way but easily accessible, or view a full document in another application (such as a
word processor or graphic package) while maintaining full access to your PageMaker
publication.
The cost of a s econd monitor and video card starts at jus t $300 for a 13-inch black and
white monitor, to about $600 for the least-expens ive 13-inch color setup. I recommend
second monitors highly as a way to get comfort, convenience, and productivity.

Printers and printer drivers
Most PageMaker files are ultimately output-to PostScript printers, such as an Apple
LaserWriter or Linotronic imagesetter. PostScript is a page description language invented by Adobe Systems that makes it possible to print the s ame document on many
different kinds of printers without having to make adjus tments for the resolution or
capabilities of each printer. Pos tScript is almost a universal standard in laser printers
(well, at least in Macintosh laser printers) and in imagesette rs.
In order to print PageMake r 5 files to any PostScript printer, you must use the new

LaserWriter 8.0 driver instead of your old LaserWriter driver. LaserWriter 8.0 is included with PageMaker and automatically ins talled with it. It appears in the Chooser
after the PageMaker installation.
LaserWriter 8.0 provides a number of performance improvements and new features not
available in earlier versions of the LaserWriter driver. For PageMaker, switching to
LaserWriter 8.0 makes PageMaker finally compatible with background printing (because
the Aldus Prep file is no longer necessary) and ends PageMaker's dependency on Aldus
Printer Description (APD) files. Instead, PageMaker 5 uses PostScript Printer Description (PPD) files, which the LaserWriter 8.0 driver s upports for use by all Macintosh
applications. Most of the PPD files you'll need are included along with PageMaker and
ins talled as part of the PageMaker installation. You can get other PPD files from on-line
services or from printer manufacturers.
The new LaserWriter 8.0 driver was codeveloped by Adobe Systems and Apple
Computer. Adobe distributes a version of the driver called PSWriter 8.0, but it is
identical to the Apple vers ion, LaserWriter 8.0, which you get along PageMaker 5.
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PageMaker documents can be printed on non-PostScript printers, including Apple
ImageWriter dot-matrix printers, StyleWriter ink-jet printers, or any QuickDraw printer.
The results depend on the content of your publications: PostScript fonts will print
accurately only if you use ATM, but TrueType fonts will print well on non-PostScript
printers. TIFF images and bit-mapped graphics are usually affected by the low resolution of most non-PostScript printers, and object-oriented graphics such as those
created in Aldus FreeHand and Adobe Illustrator may a lso suffer on QuickDraw printers.

System Software
While PageMaker 5 can be used with System Software 6.07 or 6.08, I strongly
advise you to install System 7.1 or later. This is true for several reasons, not the
least of which is that System 7 is now the Mac standard in terms of software
development- just about any new program you've purchased or upgraded in
the past two years was designed and tested with System 7 in mind. Although
these programs are all still System 6 compatible, they are really better suited to
System 7. As the inimitable David Ramsey says, "System 6 users are just grapes
under the steamroller of progress." In other words, you're going to have to
upgrade, so you might as well do it now.

Older Versions of PageMaker _ __
Before starting the actual installation of PageMaker 5, you need to decide what to do
with your previous version of PageMaker. (If you do not have an older version of
PageMaker on your hard drive, skip ahead to the next section; I'm not talking to you.)
You have two options: You can delete the old version of PageMaker (and all of its
associated files)or you can move the old version (and all of its associated files) into one
folder so that once you start using PageMaker 5, your Mac, you, or PageMaker 5 aren't
confused by the older version's files.
PageMaker 5 uses a new file format, so publications created in older versions
must be converted to the new format before they can be edited or printed using
PageMaker 5. This conversion automatically takes place when you open an
older file in PageMaker 5, but it will change the files slightly, possibly altering
the way words wrap or the exact position of graphic elements. In most cases
these changes are slight or unnoticeable, but they still require that you look
over any converted publication before printing it.
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As a result, many people choose to keep their older version of PageMaker around for a

while so minor changes to existing publications can be made quickly and easily without
the time and effort of converting the files to the new format. There is no real reason not
to keep your old copy of PageMaker around, except for the disk space it will continue to
consume on your hard drive. If you want to keep PageMaker 4.2 around, you can do so
without any special preparation. To keep using PageMaker 4.0, move the Aldus folder
that is inside your System folder into the folder where you keep PageMaker 4.0, making
sure the PM4.2 RSRC file and Aldus Prep file are inside this folder before you move it, as
illustrated in Figure 2-2. After you've moved these files, delete the Aldus folder, PM4.0
RSRC, or Aldus Prep files that remain in your System folder. (Warning: Do not delete the
"Aldus folder" folder from your System folder - that belongs to Aldus Persuasionwhile the "Aldus" folder belongs to Aldus PageMaker. Next time you talk to Aldus be
sure to say thanks for such a crystal clear naming convention.)
Figure 2-2: To
keep versions
of PageMaker
4.0 or earlier
on your hard
drive, move all
related files
into one
folder.
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If you have publication files created in PageMaker 3.0 or earlier, you'll have to keep

other versions of PageMaker on your hard drive. To work with PageMaker 3.0 publication files, for example, you must either work directly in PageMaker 3.0 or use PageMaker
4.0 to convert your PageMaker 3.0 files into PageMaker 4.0 format. At that point, they
can be edited and printed, or opened and converted by PageMaker 5. For PageMaker 2.0
or even 1.0, the story is the same: You can open or convert a publication only with the
version that created it, or the next major version. To keep PageMaker 3.0 or earlier on
your hard drive, put the application and all of its related files (such as the PageMaker
3.0 Defaults file, pmusdick.dct, pmusram.dct, and pmuser.txt) into the same folder and
delete any copies of these files from your System folder or other locations.
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When you want to delete an old copy of PageMaker, drag the application and all of its
associated files, including the Aldus folder, the PMx.x RSRC file, and Aldus Prep (these
last two may be lying free in your System folder), to the trash. Then choose the Empty
Trash command from the Special menu.

Installing PageMaker
With your hardware in place and your old copy of PageMaker out of the way, you're
ready to actually install PageMaker 5. Well, almost.
Before installing, it is a very good idea to restart your Macintosh with all extensions
turned off. (Hold down the Shift key and choose Restart from the Special menu.) This
. turns off any virus-checking utilities, which is a good idea since Installer applications
continually trip the alarms in virus checkers. PageMaker's Installer seems especially
sensitive and has a better chance of success if all other extensions are temporarily out
of the way.
You might also want to defragment your hard drive before running the installer. As I
mentioned earlier, this will improve the performance of your drive and prolong the
drive's life. Defragmenting before a major installation will ensure that the program and
all of its support files are written to your hard drive efficiently, thus getting you off to a
good start with your new application. This is by no means mandatory, but worth the
effort in most cases.
The last thing you should do before the actual installation is to verify that you have
enough free space on the hard drive where you intend to install PageMaker and on the
hard drive containing your System folder. Of you have multiple hard drives, or hard
drive partitions, these do not necessarily have to be the same drives.) PageMaker and
its associated files will consume 3MB to 5MB at minimum and up to 23MB if you install
all files and tutorials, and the Aldus folder will consume 5MB or more inside your
System folder. In addition, the LaserWriter 8.0 driver and PPD files will need another
1MB in your System folder (they are placed inside the Extensions folder in System 7).
The Installer will warn you of space deficiencies during the installation, but it is easier
to make sure you have enough space before the process begins.
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The PageMaker 5 install program
PageMaker's installation is automated by the Aldus Installer/Utility. This program
copies the required files from the PageMaker disks onto your hard drive, cr~ting a new
PageMaker folder and adding the Aldus folder to your System folder. PageMaker must
be installed from the floppy disks using the installation program - it is impossible to
copy the contents of the disks to your hard drive and then install the program.
Begin the installation by inserting Disk 1 into a disk drive, and double-click on the Aldus
Installer/ Utility application. This will bring up the Aldus Installer Main Window dialog
box and the windows shown in Figure 2-3.
Figure 2-3:
Double-clicking
on t he Aldus
Installer/ Utility
application
begins the
process used to
install
PageMaker on
your hard disk.
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Quit
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Six installation options are given in this dialog box; by default the bottom five are
preselected. Deselecting one or more of these buttons will suppress the installation of
unwanted files, reducing the amount of space consumed. The
six options:
•

Install Everything. Checking this option chooses all of the other options and
installs PageMaker 5, templates, tutorial files.. Aldus additions, and filters.

•

PageMaker 5.0. This option creates a new folder on your hard drive called
"Aldus PageMaker 5.0" and installs the PageMaker 5 application, the PM5.0 Help
file, and several other files in this folder. Additionally, a folder called Aldus folder
is created inside your System folder, and PageMaker's filters, dictionaries, and
color libraries are placed inside this folder. Figure 2-4 shows the files added to
your hard drive when this option is selected.

•

Tutorial. Select this option to install the Learn PM5 on-line tutorial program, as
well as the files you need to follow along with the tutorial in the PageMaker
manual, into the Aldus PageMaker 5 folder. If you are new to PageMaker or want
to see a good on-screen s ummary of the new PageMaker 5 features, select this
option. You can always delete these files from your hard drive once you have
reviewed them.
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•

Alters. Select this option to install some or all of PageMaker's import and export
filters. You need an import filter for each application whose text or graphics files
you want to use in PageMaker publications. You need an export filter for any
applications to which you want to export text from publications.

•

Additions. Select this option to install some or all of the Aidus-provided Aldus
Additions. These Aldus Additions provide many of the important new features in
PageMaker 5; so unless you are very short on disk space, you'll want to install all
of them.

•

Printer Description flies. Select this option to install some or all of the PPD files
Aldus provides. These PPD files are used by the LaserWriter 8.0 printer driver,
and you'll need one for each kind of PostScript printer to which you'll print
PageMaker files.

Once you have selected the appropriate options, click the Install button or press the
Return key. At this point, the Installer runs some basic diagnostics to verify that your
hardware, RAM, System Software, and other system attributes are adequate for the
installation to proceed. The results of this diagnostic are displayed on screen, and
saved to a file, called Aldus Installer Diagnostics, in your new PageMaker 5 folder. You
can review this file later using any word processor, or delete it.

26

Part I: Introducing PageMaker

Selecting templates, PPDs, Additions,
and filters
Depending on your installation options, you now will be asked to select the specific
Additions, templates, or PPD files (shown in Figure 2-5) that you want to install. Install
only those files you think you will really need, since each will consume disk space and
potentially slow down PageMaker's operation. On the other hand, each is relatively
small and has only a small effect on performance, so don't hesitate to install any
potentially useful files. If you are uncertain what you need, select and install all available
files. To select more than one file, hold down Shift and click on each file name you want
in each dialog box before clicking the OK button to proceed.
Figure 2-5:
The selection
dialog box for
PostScript Printer
Description files
(PPDs).

Printer description files

•

Select the printer description file(s) to be
Installed:

[ Cancel ]

5253 Color PostScript Printer
9400PS
Adobe LaserJet It Cartridge
RGFA StudloSet2000
RGFR_nccuset u52.3
AGFA_flccuSetSF U52.l
RGFA_fro Set9400 u52.3
RGFA_froSet9400SF u52.3

it

OK

D

Help

'()<

In order to print from PageMatcer, you must lnstoll ot least
one printer description file.

Select a location on your hard drive
After personalizing your copy of PageMaker, the dialog box in which you designate the
folder to install the program and files appears, as s hown in Figure 2-6. PageMaker uses
this dialog to confirm that you have enough free space for the installation options you
have selected. If adequate free space is not available, click the Cancel button to return
to the Aldus Installer Main Window dialog box, and then select fewer installation
options or quit and create more free space on your hard drive before trying the installation again.
If enough free space is available, you may, if you wish, change the name of the folder

into which PageMaker will be installed and the location on the drive where this folder
will be placed. In most cases, you will probably not want to change the name of the
Aldus PageMaker 5.0 folder, so there is no need to modify the "Install in folder" option.
You should, however, use the scrolling window and drive button to select where you
want the Aldus PageMaker 5.0 folder placed. When you have determined the location,
click the Install button to begin.
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Figure 2-6:
The dialog box
used to designate
the folder in
which PageMaker
will be installed.
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0 Norton Utilities 2.0
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n Install D
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Help

ln stoll in folder:
I Rid us PogeMoker 5.0 1

Stortup spoce ouollllbl e: 8550K
Stortup spoce required: 4676K

You con lnstoll on this disk.

Personalize your copy
The next step is to enter your name, company name, and serial number, as shown in
Figure 2-7. This information is recorded on your hard disk to help you find your serial
number should you call for technical support and to discourage the distribution of
illegal copies of PageMaker. Note that PageMaker 5 now includes a network copydetection feature that prevents two people on the same network from using the same
copy of PageMaker.
Figure 2-7:
The Aldus Personalization dialog box.

Pleose personollze your copy of "Ridus PogeMok er 5.0"
Nome:
Compony:
Serlol number:

I Crolg M. Oonuloff

n

IPRI, Inc.

[ Concel ]

I 02-

[

OK

Help

D
]

R uolld serlol number or seruice controct number will be required
when you co li Rid us Technlclll Support. Pl e11se ent er it here so thot It
Will be IIUOIIOble.

After clicking the OK button, you are shown the name, company, and serial number as
you have entered them; you are asked to confirm these entries. Click the OK button if
the information shown is correct, or click the Change button to return to the previous
dialog box and change any information.
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Insert the PageMaker disks
During the installation process, you will be prompted for the disks that the installer
requires. The progress of the installation will be shown on screen in the dialog box.
When the installation is completed, an Alert box will display "Installation Complete!"
You should now restart your Macintosh before attempting to launch PageMaker
so the system extensions can load. PageMaker 5 itself adds one extension,
called Shared Code Manager, to your Extensions folder. If you use an extension
manager utility, make sure that this extension is turned on s o it loads before
you try to use PageMaker.

After the Installation
When the installation program is finished, you may want to change the location of some
of the files the Aldus Installer has added to your hard drive. You can move the files in
the Aldus PageMaker 5.0 folder around as you desire, but it is important to keep all the
files together. Several of these files- Aldus Installer Diagnostics, Aldus Installer
History, and Read Me- are not even needed by PageMaker 5. These files take up only a
few kilobytes of disk space, however, and may be helpful to the Aldus technical support
staff if you have problems. If you don't wish to keep them on your hard drive, copy
them onto a floppy disk for future reference.
You can move the Aldus folder out of your System folder to any other location
on your hard drive. If you do, PageMaker will ask you to locate this folder the
first time you launch PageMaker, but will operate properly as long as the folder
can be located and its contents are unchanged. In the future, PageMaker will
remember where you have placed the Aldus folder. Moving the Aldus folder into
the PageMaker 5 folder itself is not a bad idea: This reduces the size of your System
folder, eliminates the chance of damage if the System folder ever needs to be
replaced, and keeps all of the PageMaker 5 files in a single location.

Reinstalling PageMaker 5
If the program is ever damaged or removed from your hard disk, you will need to

reinstall it with the Aldus Installer/Utility, following the steps described previously for a
first-time installation. Before reinstalling, delete the damaged program along with all of
the other PageMaker 5 files, including those in the Aldus folder. Be careful not to delete
any third-party Additions or filters that were installed separately.
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You can also use the Aldus lnstaJler to add or reinstall filters, PPDs, or Additions
without reinstalling PageMaker itself. To do this, either launch the Installer/Utility and
then select the needed options (filters, PPDs, Additions) or double-click any filter, PPD,
or Addition from any original PageMaker disk. This will launch the Installer and prompt
you for a location to install the selected file.

Utilities for PageMaker Users _ __
Now that you have PageMaker installed, you should seriously consider adding a few
utilities to your System - if you don't have them already. These programs add features
that allow you to work more productively in all applications.

Font managers
Managing fonts on the Macintosh should be easy by now. After all, it's been
almost 10 years since the Mac brought typographic variety to personal computers. But the truth is that the Mac System Software still doesn't handle fonts
intelligently. Utilities like Suitcase II or Master-Juggler are just as important
today- even with System 7- as they were six years ago at their introduction.
The Macintosh System Software doesn't make it easy to work with large font collections
or to rapidly change the fonts you are working with. System 6 manipulated fonts with
the Font/DA Mover, a kind of software torture device that ruined more System Software
than any computer virus yet conceived and wasted more time than any video game.
System 7 replaces the brute force methods of the Font/DA Mover with the bureaucracy
of the Fonts folder. Ah, progress.
Think I'm exaggerating? Try adding a few new fonts to your System 7 Fonts folder. Just
drag their icons onto the Fonts folder or the System folder icon. Oops, you have to quit
all of your open applications first. Now try again. That was easy, wasn't it? Open an
application or two to make sure the fonts were added. Now go back into the Fonts
folder and remove the fonts- drag them out onto the desktop. Oops, you have to quit
all of your open applications again. Now try again. Next, make a folder in which to store
unused fonts. Add your entire collection of screen fonts, printe r fonts, and TrueType
fonts to this folder. Now pick some new fonts to add to the System folder's Fonts folder.
Make sure you copy all the associated screen fonts and printer fonts- you won't be
warned if you miss any, but your files will not print correctly, and ATM won't be able to
draw characters from any screen fonts that don't have corresponding printer fonts.
This sure is a good system, isn't it?
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No, it isn't. Which is why you need Suitcase II or MasterJuggler. (I prefer MasterJuggler
because of its cleaner user interface, which is shown in Figure
2-8.) With one of these utilities, you can store PostScript screen and printer fonts as well
as TrueType fonts in any folder on your hard disk or on a network file server, and add
or remove them with a few mouse clicks. You never have to move the fonts- saving
time and ensuring that screen and printer fonts always stay together. You can also add
or remove fonts without havi ng to quit open applications. In fact you can even add fonts
while working in PageMaker and use those fonts immediately.

Figure 2-8:
Master]uggler lets
you add or remove
fonts w ith a mouse
click.
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Font-fami1y management
The next problem with fonts is that the Macintos h System Software doesn't group font
families in the font menu, which results in the kind of disorganization shown on the left
side of Figure 2-9. Adding a font-family manager, like Adobe Type Reunion, Now Utilities'
WYSIWYG menus, or Dubl-Ciick's MenuFonts, can give you a clean and organized font
menu, as shown on the right side of Figure 2-9. As an added bonus, these utilities
display each font and family name as they will appear when selected.

Dialog-box utilities
Navigating through the various hard drives, partitions, folders, network volumes, and
removable drives where you store the text and graphic elements for your PageMaker
publications, as well as the publications themselves, can be a difficult task when you
rely on the built-in tools of the Mac's standard File Open dialog box. Dialog-box utilities
make this navigation easier by a llowing you to jump directly back to recently used
folders or files. They also make new folders, delete files, and check disk space from
inside any Open or Save dialog box.

Chapter 2: System Requirements and Installation

Fig ure 2-9:
A standard
font menu
(left) and a
font menu
organized
by font
family
(right).
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The most popular dialog-box utilities are Super Boomerang (part of the Now Utilities
package) and Directory Assistant (part of the Norton Utilities package), but many
other packages also provide these features. I find Norton's Directory Assistant to
have a cleaner interface, but Now's Super Boomerang, shown in Figure 2-10, offers a few
extra features.
Figure 2-10:
Super
Boomerang lets
you jump directly
to any recently
used folder.
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Compression
File compression has become a very hot topic in the Macintosh world over the past
year. Once used primarily to send files by modem, it now is used everyday by aJI kinds
of Macintosh users. For PageMaker users, compression can be helpful because the text
and graphic files you use in your publications can take up a Jot of disk space. Also,
compressing files can make it easier to transport them - by modem or by disk- to
another location, such as a service bureau.
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Three kinds of compression products compete for your attention:
•

Driver-level compressors, such as eDisk and Stac, require you to reformat your
hard drive in order to install them, but they work automatically and invisibly
from then on. They compress every file on the disks on which they are installed,
including data files , applications, and System Software.

•

Automatic compressors, such as AutoDoubler and Stuffit SpaceSaver, are
extensions that compress files in the background according to your preference
settings. You decide which files are compressed, and all files are automatically
decompressed when opened or copied to another location.

•

Manual compressors require you to select files for compression and decompression. You have total control over the process but must participate at every step.

Selecting the right compression product requires that you consider how much disk
space you have and how much time delay you are willing to put up with in order to save
space. I do not believe that driver-level compressors are a good solution except in
extreme situations where disk space cannot be expanded. Hard drives are too inexpensive to put up with the time delays of compressing every file written to disk and then
decompressing every file each time it is used.
Automatic compressors are a reasonable short-term solution (until you can buy a larger
hard drive) because you can set the compression rules to suit your needs. The best
solution, in my opinion, is a combination of manual and automatic compression (as
provided by Now Compress, Stuffit Deluxe with Magic Menu and Stuffit SpaceSaver, or
my personal favorite combination of DiskDoubler and AutoDoubler). These solutions
can automatically compress some files- all data files over SOK that haven't been
edited in 30 days, for example- and provide you with quick access to compression for
other files you need to squeeze down for one reason or another.

Adobe Type Manager (ATM)
This utility shouldn't be news to anyone working with PageMaker. ATM makes
PostScript fonts look good on screen by using the font outlines from printer-font files to
clearly render screen fonts. ATM is vital in PageMaker because it allows you to use any
font at any point size or in any type style and still have type that is clearly legible at any
magnification. It also makes it easy to see fine detail of text placement and line endings
and lets you see on-screen some (but clearly not all) of the effects of kerning and letterspacing manipulations. Without ATM, a great many fonts are virtually illegible on-screen
at many different view sizes.
In order to use ATM, you must load both the screen-font files and the printer-font files
for all PostScript fonts. Keep the printer-font files in the same folder as the screen fonts
- either in the Fonts folder in your System folder or in the folder you use to store fonts
accessed via Suitcase II or MasterJuggler.
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••••••••••••••••••••••••••••••••••••••••••••••••
Summary
•

Aldus says you can use PageMaker with a 68020 Mac, 5MB of RAM, a 40MB
hard drive, and System 6.07.

•

Craig says you need a 68030 or 68040 Mac with 20MB of RAM, a 200MB+
hard drive, and System 7.1 to comfortably use PageMaker.

•

Making sure you have plenty of RAM allocated to PageMaker can help it run
faster and operate with fewer problems.

•

PageMaker provides and requires PSWriter 8.0 to replace your existing
LaserWriter printer driver.

•

You can keep your old version of PageMaker on your hard drive. just move it,
along with all of its associated files, into a new folder.

•

Installing PageMaker is easy if you follow the on-screen instructions.

•

After you install PageMaker, get Masterjuggler, Now Utilities,
AutoDoubler, DiskDoubler, and Adobe Type Manager.

••••••••••n•••••••••••••••••••••••••••••••••••••
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What's New in
PageMaker5
••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
•

A summary of features brand new in PageMaker 5

•

A review of features introduced in PageMaker 4.2

W A look at features enhanced from PageMaker 4.0

•••••••••••••••••••••••••••••••••••••••••••••••
For the experienced computer user , there is nothing quite like the feeling of a new
version of a favorite software application. Seeing the new menu commands, tools,
floating palettes, and dialog-box options is exciting because each promises improved
productivity or new ways that the program can help you get your work done.

New Features in PageMaker 5
This chapter saves you the trouble of hunting through PageMaker, the user manuals, or
even this book to figure out what is new in version 5. I'll introduce you to virtually every
new menu command, tool, palette, and dialog-box option in PageMaker 5. You can then
start putting these new features to work the next time you use PageMaker, perhaps
even before you read the more detailed discussion about these new capabilities in later
chapters.
The main focus of this chapter is on features new or improved since version 4.2; but
because many people did not upgrade from version 4.0 to 4.2, I also cover new capabilities introduced in 4.2.

p
T
E
R
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Aldus Additions
Aldus Additions technology makes PageMaker extensible- new features can be added
to the program by dropping modules into the Additions folder inside the Aldus folder or
by writing scripts in an English-like scripting language. More than 20 Additions modules
are included with PageMaker 5 as examples of what Additions can do and to provide
some important and useful features. Most are accessed via the new Additions submenu
in the Utilities menu (see Figure 3-1). Chapter 15, "Aldus Additions," provides more
details on this new technology. Here are the highlights.
Figure 3-1:
The Aldus Additions submenu
in the Utilities m enu.

Baseine

Fild .
Fi1d next
C'han~e ..
Spe!lug...

MB

&e.
889
ML

Index entr y... H.
Shll'YI~)(

CreateIndex ..•
CreateTOC ...

Gridzlid ...
Marl(sman 1. o...
Pand~ra 0. 920.. .
Resizer 1.0...
Safari- kit guides ...
Safari - make goJkles .. .
Zepllyr Clear\S'j!eep'"
Zepllyr SmariAtign I.Z
00 S111dae Sollware 00

Acqo.ire Image.. .

Addconrdtile .. .
Azalea POSNT Bar Code .. .
Azalea UPC-EAN Bar Codes.. .
Balance co!urms...
Blid bo'*lel...
Bllels and oornberilg...
Celer ...

•

Add cont'd line. Adds "Continued on ... " and "Continued from ... " comments to
the bottom or top of a text block, documenting where the next or previous text
block in the story is located. These serve to help the reader of your publication
follow the flow of stories that have been placed across several different pages.

•

Acquire Image. Gives PageMaker the ability to scan images directly from scanners compatible with the relatively new TWAIN scanning standard. These
scanned images will be placed directly into your publication as TIFF files.

•

Balance columns. Evens the top or bottom of two side-by-side text columns.
Options allow you to determine the point of alignment and decide where any
leftover lines of text will be positioned.

•

Build booklet. Allows you to create a copy of your publication with its pages
arranged into signatures as required for commercial printing and folding. Extensive options are provided to control the page signatures. This Addition provides
a limited set of the features found in Aldus's Press Wise imposition software.
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•

Bullets and numbering. Adds consecutive numbers or a special character bullet
along with a tab at the start of each selected paragraph. You can apply this
addition to selected paragraphs, to specific paragraph styles, or to some specific
number of consecutive paragraphs.

•

Create color library. Saves the colors in the current color palette as a
PageMaker color library, which makes it easy to reuse the colors in another
publication or distribute the colors to other PageMaker users.

•

Create keyline. Creates a box around any object in your publication, at any
distance from the object edge that you specify, and using any file and line attributes you specify. The keyline can be placed in front of or behind the existing
object, and you can specify that the object knock out the keyline with or without
some remaining overlap. You can use this Addition to create a design element or to
build traps around colored objects.

•

Display pub info. Produces a listing, which can be saved to an external text file,
of all fonts, styles, and linked objects in the current publication. This will be used
most often when you are transporting files to another location, such as a service
bureau, for output and want to make sure that all necessary fonts and linked files
are printed properly.

•

list styles used. Collects a list of all paragraph styles used in the selected story

and creates a new text block that displays this list.
W Display story info. Provides a dialog box full of information about any selected
story. Details include the name of the placed file, first page in publication where
the story appears, last page where the story appears, number of text blocks the
story consumes, total character count, and number of column inches the story
consumes in the current layout.
•

Display text block info. A companion to Display story info, this Addition provides a dialog box of information about one specific text block. Details include
the pages on which prior or subsequent text blocks (for the same story) can be
found, number of characters in this block, and block size.

•

Drop cap. Creates an instant drop cap for the selected paragraphs. This Addition
does create nice looking drop caps, but note that if you edit the text in the first
part of any paragraph in which a drop cap has been created, you will have to
remove and then reapply the drop cap.

W Edit tracks. Used to modify the tracking curves PageMaker uses for its five builtin tracks. This provides extremely precise control over tracking, and changes
can be applied to specific documents or all PageMaker publications.
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•

Expert kerning. Removes any existing kerning and applies specific manual
kerning based on the c urrent font and character pairs selected. You control the
kerning applied by selecting a kerning strength and font design type.

•

Find overset text. Checks your publication for unplaced text (which is referred
to as "overset text" for some unknown reason) so you can place it or extend the
current text block. Normally, unplaced text occurs when you first place a story in
your publication, but it can also occur when you edit a story, adding text or
graphics, or change typographic specifications. This Addition makes it easy to
make sure all of your text is placed correctly and to find any text that is not.

•

Ubrary palette. This Addition, which appears under the Windows menu instead
of in the Additions submenu, provides a scrapbook-like means of storing and
organizing text, graphics, and images for use in your publications. Each object
placed in the library palette can be named and described with keywords, and
you can search a library for specific items. Any number of libraries can be saved
to disk, but only one library can be open at a time.

•

Open stories. Opens the PageMaker story editor and automatically opens up to
15 stories in the current publication for editing. It is designed to automate the
process of opening stories in the story editor when most or all of the stories in
your publication need editing.

•

Open template. PageMaker 5 provides a number of publication templates in a
special scripted format, which can only be opened with this Addition. The Open
template dialog box is much like a standard Open dialog box, in which you select
from a list of available templates and even see a template preview. Opening a
template creates a new untitled publication file with many placeholder elements
already in place, and predefined margins, paragraph styles, and guide lines.

•

Printer styles. Used to create style sheets containing specific printing dialog box
option settings that can be easily applied to any print job. It also allows you to
queue any number of publications for batch printing and create informational
pages containing file information such as creation date, filename, and printing
time.

•

PS Group it I PS Ungroup it The PS Group it Addition is PageMaker's answer to
the Group command found in most Macintosh applications. Choosing this
addition creates a new EPS file containing all selected elements and then places
this EPS file in the place of those elements. You can then move or transform the
elements as a grouped object. The PS Ungroup it Addition allows you to replace
the EPS file with the original "ungrouped" elements at any time.
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•

Run script. Used to run scripts written in the Aldus Additions scripting language.
A script can exist as a story within the current publication or can reside in a text
file on your hard drive.

•

Running headers/footers. Automatically adds customized running header or
running footer text block<; to the pages of your publication. The text in the
running headers and footers is taken from a paragraph with a certain defined
style. The location of the running header and footer, and its paragraph style, are
defined using options in this Addition.

•

Sort pages. Used to rearrange the order of pages within your publication by
dragging thumbnail representations of the pages into a new order.

•

Traverse text blocks. Lets you jump directly to the first, last, previous, or next
text block in any story. It is helpful when a story is positioned in many text
blocks or over many pages, and you need to quickly find a specific block.

•

Update PPD. The PPD files that are used by LaserWriter Driver 8.0 can be
customized with this Addition so they know exactly the amount of available
memory and preinstalled fonts on your printer.

Beyond the Aldus Additions that are provided along with PageMaker, you can get other
Additions from third-party developers or as shareware or freeware programs available
from on-line services or user groups. More information on these Additions and details
on how you can get a complete up-t<Hlate catalog of all third-party Additions is included in Chapter 15, "Aldus Additions."

Scripting
The Aldus Additions scripting language means that the power of Aldus Additions is
available to anyone, not just programmers who know how to use C and other programming languages. Addition scripts are simple English-like command sets, much like
HyperCard scripts or the macro languages available in many other applications. With a
little practice, you can write scripts to automate any complex or repetitive PageMaker
tasks or even to make PageMaker do things that would be nearly impossible to do
manually.
Scripts can be written right inside of PageMaker as new stories, or they can be written
in any word processor and saved as text files. A sample script is shown in Table 3-1. To
use your scripts, you select the Run Script Additions from the Additions submenu.

40

Part I: Introducing PageMaker

Table 3-1
A sample script in the Aldus Additions scripting language.
- Fract ion script
-Selects and reformats the denominator
textsel ec t -word
ty peopt ions 80 , 58 ,33 ,0
position subscript
textcursor -char
- Selects and changes normal sl ash
- to opt shift 1 fraction slash
textselect 0
textenter .. /"
-Se l ects and reformat s the numerator
textc ur sor -c har
textse l ect -word
ty peoptions 80 ,58 , 33 ,0
posit i on supe r script
- Leaves cur sor where you started to r es ume printing
textcursor +word 2
position norma l
redraw on
- end of sc ript

Baseline shift
Every character in every font you use on your Mac is defined by its designer to sit on an
imaginary baseline so it will be properly aligned with all of the other characters. This
new command, found in the control palette and in the Type specifications dialog box
(under the Options ... button), lets you override the baseline of any character, moving its
baseline up or down in Ylo-point increments.

Built-in color separation
One of the top three reasons many people were pulling their hair out about past versions
of PageMaker was that you could not print process--color separations directly from
within the program. That task used to require Aldus PrePrint, but no more. PageMaker 5
can directly print spot or process colors as spot or process--color separations.
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To be more specific, you can now create separations as long as your publication
includes only text and graphic elements created within PageMaker, imported EPS
graphics, and preseparated (DCS or CMYK TIFF format) images. Files containing images
that are not preseparated (RGB TIFF files) must still be output via Aldus PrePrint in
order to produce process-color separations.

Colors palette
The colors palette now shows a small swatch of each color next to the color name and
indicates colors that are tints with a (%) symbol, and imported EPS colors with a (PS)
symbol. Spot-color names are shown in roman characters, while process colors are
displayed in italics. The palette, shown in Figure 3-2, also allows you to specify whether
you want color applied to the fill of the selected element, the line around the selected
element , or both.
Figure 3-2:
The new Colors palette gives you
more information about available
colors.

Control palette
The floating control palette was introduced in PageMaker 4.2, but has been substantially enhanced in PageMaker 5. The palette now has three distinct modes: character,
paragraph, and object. In character mode, shown in Figure 3-3, you can specify font,
type size, type style, leading, tracking, kerning, and baseline shift.
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Figure 3-3:
The control
palette in
character
mode.

In paragraph mode, shown in Figure 34, you can specify paragraph style,
alignment, left indent, right indent, first-line indent, space before, space after,
and grid size.
Figure 3-4:
The control
palette in
paragraph
mode.

In object mode, shown in Figure 3-5, you can specify the size, location, scaling, cropping, rotation, skew, and reflection.
Figure 3-5:
The control
palette in
object mode.

Custom line weights and fill patterns
Uneweights can now be defined in any weight between 0.1 point and 800 point, in 0.1-point
increments. Fill shadings can now be in any shade of gray using the new ability to tint
colors (grays are tints of black). And the new Fill and line dialog box, shown in Figure
3-6, makes it easy to quickly change the fill and line attributes of any selected object.

Figure 3-6:
The new Fill
and line
dialog box.
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Custom view sizes
Holding down Command-spacebar in PageMaker 5 brings up the new magnifying glass
tool, shown in Figure 3-7, which you can use to zoom in on any specific area of any page,
at magnifications of up to 800 percent. You can use the zoom tool by clicking it while
pointing to any area of the page, or you can click and drag it to define the precise area
you want to zoom in on. Hold down the Option key in addition to Command-spacebar to
change the tool into a demagnifying glass, which unzooms.

Figure 3-7:
You can now zoom in on
anything with the magnifying
glass icon.

Dictionary editor
This stand-alone utility, shown in Figure 3-8, lets you create new dictionary files for use
by the PageMaker's spelling and hyphenation systems. You can add, delete, import, and
define hyphenation for words in your custom dictionaries.
Figure 3-8:
The d ictionary editor
promised in
PageMaker 4.0 has
finally arrived.
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Font matchlng
Every time you open a publication, PageMaker 5 checks to see if the fonts used in that
publication are currently available on your Macintosh. If fonts are not available,
PageMaker will use either Super Adobe Type Manager (if installed) to simulate the
missing fonts or its PANOSE font-matching feature to provide substitute fonts. In either
case, you avoid the display and printing problems associated with missing fonts. The
Preferences dialog box lets you control many font-mapping options.
The PANOSE font matching system classifies fonts according to their visual characteristics and helps suggest other available fonts similar to those that are missing. Its dialog
box is shown in Figure ~9. You can override any PANOSE suggestion and select any
available font to substitute for any missing font, and all substitutions can be defined as
temporary Oasting until you close the current publication only) or permanent Oasting
until you change the substitution preference).
Figure 3-9:

The PANOSE
dialog box
maps m issing
fonts to
available fonts.
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Indents/tabs dialog box
An Apply button has been added to this dialog box, which is shown in Figure
~10, so you can preview changes to tabs and margins. The Tab action button has been
renamed the Position button, which is used to numerically specify the location of a new
tab. Also, the Indents/tabs dialog box now automatically resizes itself to fit across your
monitor, taking advantage of larger displays and minimizing the need to scroll within
the dialog box.
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Figure 3-10:
The new
Indents/tabs
dialog box
lets you
preview
results before
clicking OK.
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Import filters
New import filters provide support for CGM, DXF, EPS, Windows Metafile, PC Paintbrush, PhotoCD, PageMaker 5 story, text-only, and TWAIN.

Import of EPS spot colors
Spot colors applied within imported EPS graphics are now added to PageMaker's color
palette when those graphics are imported. This allows you to apply these spot colors to
other elements within your publication or edit these colors, changing the way the color
appears in the EPS graphic.

Interruptible screen redraw
By far my favorite new feature that Aldus introduced in PageMaker 4.2 is interruptible
screen redraw. It sounds technical, but it simply means that you don't have to wait for
PageMaker to finish redrawing the screen before you make your next move. As soon as
you choose your next menu command, click a palette icon or enter a keyboard command- PageMaker stops redrawing the screen and executes your command. Then it
begins redrawing the screen again.
This saves tremendous amounts of time, because PageMaker redraws the screen
frequently- every time you turn the page, change view sizes, or scroll across your
publication. This screen redraw puts every text and graphic element in its proper place,
relative to your last action, but it can take several seconds. And often you are ready to
take another action, maybe even one that will change the display again, before the
screen redraw is complete. Go ahead, PageMaker can now handle it.
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Kerning
PageMaker's existing manual kerning and range kerning capabilities can now be controlled using the control palette, which makes it possible to kern in J.1ooth of an em
increments. (The Hs and J.1oo of an em kerning keyboard equivalents remain available.)
The new Expert kerning Addition provides an automatic method of kerning selected
PostScript Type 1 fonts, based on a kerning strength value that you specify.

Menu layout revisions
In PageMaker 5, the new Utilities menu provides a home to most of the commands
formerly found in the Options menu, while the new Layout menu holds most of the
commands that used to be in the Page menu. When using the story editor, the Layout
menu is replaced with the Story menu, and the Element menu disappears altogether.

Multiple open publications
PageMaker 5 allows you to simultaneously open as many publication files as your RAM
will allow. Once open, you can switch freely between publication windows, copy
elements between publications, drag-and-<.lrop objects between publications, and
arrange the on-screen windows to display some or all open publications at once. The
new Tile and Cascade commands in the Window menu automate the process of on-screen
cleanup. See Figure 3-11 for an example.

Expanded object linking
PageMaker's existing linking capabilities have been extended to include support for the
System 7 edition manager (Publish and Subscribe), Microsoft's OLE technology, and a
proprietary Aldus "hot link" between PageMaker and FreeHand and several other
applications. These features provide several new commands including Paste Link ... and
Insert Object (OLE support), Editions (edition manager support), and Edit Original
(Aldus hot link and OLE support).
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Figure 3-11:
Open as
many
publications
as you want
simultaneously in
PageMaker 5.
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No Break option for text
The No Break option, in the Type specifications dia log box, lets you specify that the
currently selected text must fit on a single line in the current text block. PageMaker will
compress the characters and the space between the words and c haracters on the line
as necessary to force the selected text to fit on a single line. Choosing the Break option
returns the text to its normal state, allowing it to break as needed.

New color libraries
PageMaker 5 includes s upport for several new third-party color matching systems,
including PANTON£, TruMatch, Toyo, DaiNippon, and Focoltone. Other color matching
systems can be purchased separately and added later. Figure 3-12 shows some of the
possibilities.
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Figure 3-12:
Examples of
color choices
presented by
some of
PageMaker S's
color matching
systems.
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Printing improvements
The printing dialog boxes a nd print engine in PageMaker 5 have been entirely rewritten,
providing a cleaner interface , more out put options, and faster print times. The new
Print dialog box, shown in Figure 3-13, uses selectable dialog boxes, rather than nested
dialog boxes, for easier navigation.
New printing options include range printing so you can print any set of pages from your
publication including out-of-sequence pages, a PostScript error handler that prints a
message when a printing error occurs, filename and date markings on printed pages,
scale to fit print scaling, and built-in color separation.
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Figure 3-13:
The new Print
dialog box
provides more
options in a lessconfusing
format.
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Rotation/transformation
Any text or graphic object in PageMaker can be rotated in .01-degree increments, as
shown in Figure 3-14, via the new rotation tool or the control palette. Objects can also
be reflected horizontally or vertically and skewed in .01- degree increments via the
control palette.
Figure 3-14:
Any elem ents can be
manipulated with t he
rotation and transformation options.
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••••••••••••••••••••••••••••••••••••••••••••••••
Summary
•

PageMaker 5 includes many improved capabilities. Examples include the ability
to preview changes in the Indents/tabs dialog box, the ability to zoom in on
any specific element at any level of magnification, custom line weights and fill
percentages, additional import filters, and improved typographic control.

•

The new features from PageMaker 4.2 remain, and in many cases have been
improved. These include the control palette, which has many new features,
interruptible screen redraw, Aldus Additions, and linking features such as
support for the Edition manager and the FreeHand hot link plus new support
for OLE linking and embedding.

•

PageMaker 5 presents many brand-new features, including more than a dozen
new Aldus Additions, built-in color separation capabilities, the ability to open
multiple publications, font matching technology to avoid problems with
missing fonts, and many new color libraries .

••••••••••••••••••••••••••••••••••••••••••••••••
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Terms, Tools,
and Menus
••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter

a

Basic Macintosh and PageMaker terminology

•

A summary of every PageMaker menu command

•

An overview of each tool in the PageMaker tool palette

••••••••••••••••••••••••••••••••••••••••••••••••

The PageMaker User Interface
Since its introduction over eight years ago, one of PageMaker's great strengths has been
its intuitive user interface. PageMake r is very "Mac-like" - all of its menus, tools, and
dialog boxes act just like those in all other Mac applications. For the benefit of first-time
Macintosh or PageMaker users, this chapter introduces these basic aspects of working
with PageMaker and then provides a summary of each command in the PageMaker
menus and each tool in the PageMaker toolbox.
After reading this chapter, you will have a good understanding of PageMaker's range
and capabilities. More experienced users may find this information sufficient to allow
them to begin their own experimentations. Less experienced users may find these
summaries a bit overwhelming. In either case, remember that this is only a brief tour;
the remainder of the book provides the details required to master the range of possibilities suggested in this chapter.
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Basic Terminology
Just to make sure everyone is speaking the same language, I'll define a few familiar but
important terms that will be used throughout this book. These terms define how you
interact with PageMaker, working with your mouse and keyboard to use menus, palettes, and dialog boxes. This section is pretty basic, so experienced Mac users can skip
ahead. If you aren't a Mac veteran, however, your effort in reading through this section
will be rewarded with a much easier time learning PageMaker.
Of course, this isn't an "lntro to Macintosh" book, so I'll assume that you already know
how to perform the basic functions required to operate your Macintosh, such as turning
on your computer, inserting a disk, and copying files. Terms such as mouse, monitor,
window, icon, cursor, and desktop should already be familiar too. If you are unfamiliar
with these functions or terms, please consult your Macintosh Owner's Manual.

Mouse operations
The most fundamental of all Macintosh operations is using a mouse. The old point-andclick, as illustrated in Figure 4-1. Here's a quick look at the terminology associated with
using your mouse:

* To

move your mouse is to move it without pressing the button.

•

To click is to press the button and immediately release it without moving the
mouse. For example, you click on a tool icon to select a tool.

•

To double-click is to press and release the button twice in rapid succession
without moving the mouse.

•

To press and hold is to press the button and hold it down for a moment. I refer to
this operation when an item remains on screen only so long as the mouse button
is pressed. For example, you press and hold on a menu name to display a list of
commands.

•

To drag is to press the button and hold it as you move the mouse. You then
release the button to complete the operation.

Menus
Menus hold most Macintosh (and PageMaker) commands. To choose a command is to
pick it from a group of related items. A command is chosen from a pull-down menu by
dragging down the menu until the command you wish to choose is highlighted and then
releasing the mouse button. A highlighted command is displayed with white letters on a
black background.
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Figure 4-1 :
The point,
click, and
drag mouse
operations.

Drag

Like other Macintosh applications, PageMaker offers four kinds of menu commands:
•

Commands followed by an ellipsis. When a menu command is followed by an
ellipsis ( ...)as shown in Figure 4-2, a dialog box will appear when the command
is chosen. This dialog box will request information before executing the command.

Figure 4-2: A command followed by an ellipsis.

•

Hierarchical submenus. As soon as these commands are highlighted, a second
menu pops up either to the right or left (depending on available space on the
display). This second menu, shown in Figure 4-3, is called a submenu, hierarchical menu, or a pop-up menu. Submenus are lists of options that can be selected
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by dragging onto the submenu, then dragging up or down the menu until the
desired option is highlighted, and finally releasing the mouse button. If the entire
submenu is not visible, it will scroll as you reach its top or bottom.
~
~

Leodlng
set width

~

Type st yle

~

~

No trock <>seQ
Uery l oose
loose
"'Normol
Tight
Uery tight

Figure 4-3: A command submenu.

•

Toggling command options. These are commands that turn on and off a particular PageMaker function. In some cases, a check mark (-{) is displayed in front of
the command name when the feature is turned on, as shown in Figure 44. In
other cases, the name of the command itself changes to reflect the effect
achieved by choosing the command .

..

'

.,; Rulers
v'Snop to rulers
Zero l ock

XR
XI

v'Guldes
XJ
v'Snllp to guides X U
Lock guides
Column guides ...

Figure 4-4: A toggling command.

•

Executing commands. Comma nds that do not fall into one of the above
categories simply execute as soon as they are chosen.

Many menu commands can be chosen by simultaneously pressing two or more
keys on your keyboard. Such a key sequence is called a keyboard equivalent. The
keyboard equivalent for a command is listed to the right of the command in its
menu. Throughout the text, I list keyboard equivalents in parentheses after menu
commands are discussed.
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Dialog boxes and options
A dialog box can present information to you, request information from you, or both. In
most cases, dialog boxes appear in response either to a command that you have chosen
or to some action that you have taken. When a dialog box requests information, it does
so by presenting you with options.
Dialog boxes contain four kinds of options:
Radio buttons. Within a group of options among which you may select only one
alternative, small round buttons, shown in Figure 4-5, appear before each option
name. These a re called radio buttons. To select or deselect a radio button option,
click on the round button itself or on the name of the option following the
button. Only one radio button option in a set can be selected at a time: Selecting
one will deselect a ll othe rs. Several sets of radio buttons may appear in a single
dialog box, but only one from each set can be selected at any one time. An option
is selected when the button is filled and deselecte d when the button is empty.
Ploce:
® As new story
0 Repl oclng entire story
0 lnsertlnq t eHt

Figure 4-5: Radio buttons.

---------------------------------------

Check boxes. Within a group of options among which you may select any
number of alternatives, small square buttons appear before each option name.
These are called check boxes. To select or deselect a check box, as shown in
Figure 4-6, click on the square before the option name or directly on the
option name itself. If that option was previously deselected, it will become
selected; if it was selected, the option will become deselected. Multiple check
boxes in a set may be selected or deselected. An option is selected when an X
is displayed and is deselected when the box is empty.
PostScript print options
181 Downlood bit- mopped fon t s
181 Downlood PostScript fonts
181 1nclude color imoges
181 Melee Aldus Prep permanent
0 Uiew l ost error mcssoge
0 TIFF for position onln

Figure 4-6: Check boxes.

------------------------------------------------
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•

Option boxes. Options for which you must enter data are called option boxes, as
shown in Figure 4-7. Most option boxes contain default data when the dialog box
first appears. When this default data is selected (highlighted with white characters on a black background), you can enter new values from the keyboard, and
the default data will be replaced. To select a value in an option box, double-click
on a newly entered value or drag over the current value.

•

If there are several option boxes in a particular dialog box, you can move to the

next option box by pressing the Tab key or move to the previous option box by
pressing the Shift-Tab key combination.
Inside
Top

lo.s I
Ii====l
0.5
I

Oublde

lo.s
I~====l

Bottom 0.5

Figure 4-7: Option boxes.

•

Pop-up menus. Options that are presented as porrup menus, such as those
shown in Figure 4-8, display only the current setting when the dialog box first
appears. To view the list of alternatives for these options, the current option (or
an icon in some cases) must be selected by pressing and holding down the
mouse button on top of it. This will "pop up" a menu displaying the available
options. Select an option from the pop-up menu by releasing the mouse button
when the name of the option is highlighted. If an option in a pop-up menu is
followed by an ellipsis ( ...). choosing it will bring up yet another dialog box,
containing additional options.
Position:

I Normoll

Position: r.,..Normlll
Superscript
Subscript

I

Figure 4-8: Pop-up menus.

Once you have finished entering, selecting, and choosing options, you exit a dialog box
by clicking on buttons. The most common buttons are the OK and Cancel buttons.
When placed within dialog boxes, buttons also serve as commands, initiating an action
or bringing up another dialog box.
Dialog boxes that don't request information are known as alert dialog boxes, since their
purpose is to alert you to some fact. Some alert boxes warn you of the consequences of
the action you are about to take and allow you to abort that action. Other alert boxes
inform you of some event that has already happened, allowing you only to acknowledge
that you are aware of the event.
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You will sometimes discover that an option, command, or menu is dimmed, as shown in
Figure 4-9. Dimming indicates that an item has no effect on a certain situation. Dimmed
items cannot be chosen or selected.
Figure 4-9:
Dimmed commands cannot be selected.
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Miscellaneous terms
A publication is any single PageMaker file. Publications are sometimes called documents
or files. All the PageMaker files that are part of the same final document are collectively
known as a book. A book, which may be a magazine, technical document, or an actual
book, is made up of multiple PageMaker publications.
All the text from a single word-processed file is called a story. A story can be created by
typing text into a text block or by using the New Story... command in the story editor. It
also can be created in a word processor and imported into PageMaker. A story can fit
into a single text block or span any number of threaded text blocks. You can determine
the text blocks that a story flows through by placing the text insertion point anywhere
in the story and choosing the Select all command (Command-A) from the Edit menu all text in the story will be selected, including all the text in all the threaded text blocks
(see Figure 4-10). You can see all the text from a story by placing the text insertion point
anywhere in the story and choosing the Edit Story... command from the Edit menu.
Figure 4-1 0:
All text from a
single story can
be selected even
though it flows
through multiple
text blocks.
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PageMaker's Menus, Commands,
and Palettes -------------------------------------------As in most Macintosh programs, PageMaker's menu commands provide the bulk of its
power. This section introduces each of PageMaker's nine menus and every command in
each of those menus. This will familiari~e you with the range of PageMaker's capabilities
so you will know what to expect as we start moving through the program in detail in
later chapters. This section can also serve as a summary reference when you need to
brush up on any command.

C7J

For every PageMaker command introduced in this section, available keyboard

~ equivalents are listed in parentheses following the command name.

The Apple menu
As in all Macintosh applications, the Apple menu, shown in Figure 4-11, contains desk
accessories and, in System 7, other items from your Apple menu folder. Also, the Apple
menu includes the About PageMaker ... command.

Figure 4-11:
The Apple menu as It appears,
customized in System 7.
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About PageMaker.... This command brings up the PageMaker copyright screen,

which is the first dialog box seen when PageMaker is launched. This time,
however, the dialog box includes information about the current version of the
System file and available RAM. The copyright screen d isappears as soon as the
mouse button is clicked.
Holding down the Command key while choosing the About PageMaker command
produces a listing of all installed Additions, import filters, export filters, and some
internal PageMaker version numbers. This dialog box, shown in Figure 4-12, is
useful to verify that PageMaker recognizes all of your Additions and filters correctly.
Holding down the Shift key while choosing the About PageMaker command brings
up an Easter egg. (Easter egg is a technical term that refers to small hidden treasures
programmers leave inside software programs to amuse themselves or get across
some secret message. A surprisingly large number of programs have Easter
eggs, including Word, Photoshop, the Finder, and many others.)
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Figure 4-12: The About PageMaker dialog box displays installed Additions and filters.

The File menu
As in most Macintosh applications, the PageMaker File menu, s hown in Figure 4-13,
controls broad document-level activities, including opening, closing, printing, and
saving documents. Additionally, the File menu controls the importation of text and
graphic images and the exportation of text files.
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Figure 4-13:
The File menu.
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•

New ... (Command-N). Creates and opens a new publication or template. Choosing the New ... command brings up the Page setup dialog box, where you define
the attributes of the new publication.

•

Open ... (Command-O). Selects and opens any existing PageMaker publication or
template. Choosing the Open ... command brings up the Open publication dialog
box, in which you locate and select a particular file to open.

W

aose. Closes the current open publication or template document but does not
quit PageMaker. lf unsaved changes have been made to the file being closed, the
Save changes before closing? dialog box appears, prompting you to save
changes, discard changes, or abort the file closure. Choosing the Close command
for an untitled file brings up the Save as dialog box, which prompts you to name
and save the file. The Close command is dimmed when no publication or template document is open.

W Save (Command-S). Updates the disk file version of the current publication or
template document to include all changes made since the last save. Choosing the
Save command for an untitled document brings up the Save as dialog box, which
prompts you to specify a filename and location for the file. The Save command is
dimmed if no changes have been made since the last save.
•

Save as.... Brings up the Save as dialog box, which prompts you to name and
save the document, select the location to which the document will be saved, and
choose whether the document will be saved as a publication or as a template.
Saving documents via the Save as ... command reduces the size of the file and
leaves the previously saved version available for backup purposes. If you attempt to save a document using the name of an existing file, an alert dialog box
appears, asking you to confirm replacement of the existing file with the document you are saving.
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•

Revert. Discards all changes made to the current publication or template and
restores the file as it was last saved using either the Save or Save as .. . command.
Choosing the Revert command brings up an alert dialog box that prompts you to
confirm or abort the reversion. Pressing the Shift key while choosing the Revert
command discards only those changes made since the last mini-save rather than
the last Save or Save as .. . command. Once the Revert command has been
selected and confirmed, you cannot undo it. The Revert menu is dimmed when it
is impossible to revert to any previous version.

•

Export.... Saves text from the currently selected story as a separate file that can
be used in a word processor. Choosing the Export. .. command brings up the
Export document dialog box, which prompts you to specify the location and
attributes of the file to be exported. Exported files can be saved in text-only
format or in the formats of several popular word processors. The Export ...
command is dimmed if no text is selected.

•

Place... . (Command-D). Copies a text or graphic file from disk into memory so it
can be added to the publication. Choosing the Place .. . command brings up the
Place document dialog box, in which you select the file to be placed and specify
placement attributes. Text documents, word-processed documents, paint-type
graphic files, draw-type graphic files, encapsulated PostScript (EPS) files, and
tagged image file format (riFF) files are eligible for placement.

•

Unks.... (Command-=). Brings up the Links dialog box, which is used to manage
the links between a PageMaker publication and the external text and graphic files
that it includes. The Links dialog box displays a list of the text and graphic files
that have been placed in the current publication. For each file in this list, PageMaker determines if the external file or the version of the file that currently
appears in the publication has been modified, and provides you with the option
of replacing the copy of the file that is currently in the publication with the
version in the external file.

•

Book... . Brings up the Book publication list dialog box, which is used to assemble a number of separate PageMaker files so the Table of Contents ... and
Index commands can be used to create a table of contents or index for an entire
publication. This also allows you to print all the files that are part of a book from
the Print dialog box of the current file.

•

Preferences.... Brings up the Preferences dialog box. The options in this dialog
box control the unit of measure used in rulers and in other dialog boxes, the
position of ruler and column guides in the stacking order, and the point size at
which text is greeked during display. If no document is currently open, a change
in the settings of the Preferences options will change the default values used for
any new documents created later.
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•

Page setup.... Brings up the Page setup dialog box, which contains various
options regarding the electronic page on which a publication is created. This is
the same dialog box accessed by the New ... command. if no document is currently open, a change in the settings of the Page setup options will change the
default values used for any new documents created later.

•

Print ... (Command-P). Initiates the printing of one or more pages of the open
document. Choosing the Print .. . command brings up the Print to dialog box,
which is used to specify a wide range of printing attributes and options.

•

Quit (Command-Q). Exits PageMaker, closing all open publication windows and
returning control to the Macintosh Finder. If an open document has unsaved
changes when the Quit command is chosen, the Save changes dialog box appears, prompting you to save or discard the changes. If the current document is
untitled when the Quit command is selected, the Save as dialog will appear,
prompting you to name and save the document.

The Edit menu
Most of the commands in the Edit menu, which is s hown in Figure 4-14, are standard
Edit menu commands in a ll Macintosh applications. They control the manipulation of
selected elements and the Macintosh Clipboard. Additionally, the Edit menu is the
home of PageMaker's Edit story and Edit original commands.
Figure 4-14:

The Edit menu.
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•

Undo (Command-Z). Reverses the effect of the last action, returning the file to its
exact state prior to the last action. Not all actions can be undone: If the last
action cannot be reversed, the Undo command will read Cannot undo and will be
dimmed; if the action can be reversed, the Undo command will name the action
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eligible for reversal. Immediately after one action has been undone but before
another action is done, the Undo command becomes a Redo command, allowing
you to undo the undo or, equivalently, to redo the original action.
•

Cut (Command-X, or keypad period). Deletes the selected text, objects, or text
and graphic objects from your document and places them on the Macintosh
Clipboard. The effect is identical to the Cut command in other Macintosh software. If no text or element is selected, the Cut command is dimmed.

•

Copy (Command-C). Makes a copy of the selected text, objects, or text and
graphic objects from your document, placing them on the Clipboard. The effect
of this command is identical to the Copy command in other Macintosh software.
If no text or element is selected, the Copy command is dimmed.

•

Paste (Command-V, or keypad 0). Places a copy of the Clipboard contents into
your document. These elements become selected after being pasted into the
document so you can adjust their position. A copy of the pasted text or graphic
objects remains on the Clipboard so it can be pasted again. If the Clipboard is
empty, the Paste command is dimmed.

•

Clear (Delete or Backspace key, or Shift-Clear on keypad). Deletes the selected
text, elements, or text and e lements from your document without placing them
on the Clipboard. If no text or element is selected, the Clear command is
dimmed.

•

Multiple paste .... Brings up the Multiple paste dialog box, where you specify
how many copies of the current Clipboard objects you want to paste and the
horizontal and vertical distance from the first copy where you want subsequent
copies positioned.

•

Select all (Command-A). Selects all objects in the current publication window or
all text in the current story. If the text tool is positioned within a story, the entire
story is selected. If the text tool is not positioned within a story- that Is, any
tool other than the text tool is selected or the text tool is positioned on an empty
portion of the page - a ll text and graphic objects on the page(s) being displayed
are selected, along with all text and graphic objects on the pasteboard.

•

Editions¢Subscribe. Brings up the Subscribe to dialog box, where you select an
edition file to import into your publication. You can also import edition files
using the Place command, so this command is never necessary.

•

Editionsc:>Subscriber options. Brings up the Subscriber options dialog box. This
dialog box provides options that control the updates for linked edition files. The
most important is the a bility to have edition files updated automatically or
manually. Another option launches the application that c reated the edition, and
opens the edition file. Edition files can also be managed via the Links dialog box,
so this command is never necessary.
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EditionS¢Stop all editions. Selecting this command stops all automatic edition
updates set via the Subscriber options dialog box. You can override this option
with the Update or Update all commands in the Links dialog box.

""

•

Paste Unk. Available only when the contents of the Clipboard are from an OLE
server application. When selected, the Clipboard objects are pasted as a linked
OLE object, which allows bidirectional updates.

•

Paste special.... An alternative to the Paste ... command, it brings up the Paste
special dialog box. This dialog box lists the file formats in which the current
Clipboard contents are available. You select the format you want and click the
Paste or Paste link buttons to import the elements.

•

Insert object. ... Brings up a list of OLE server applications in which you can
create a new text or graphic object and then import that object back into
PageMaker. After selecting an application or object type, the application
launches, and a new file is opened. When you choose the Update command from
that application, the data you have created will be pasted as a linked OLE object
into PageMaker.

•

Edit story (Command-E). Opens a new window containing the complete text of
the currently selected story, or if no story is currently selected, a blank window
in which a new story can be created. When a story window is open, PageMaker is
in its story editor, and a slightly modified menu bar appears.

•

Edit original. Available only when a selected object is linked to its original
application via an Aldus hot link, the System 7 Edition Manager, or OLE. When
chosen, this command launches the application that created any linked imported
elements. These elements may have been imported via the Place, Subscribe to,
or Insert commands. For most objects, the creating application is opened, and
the selected elements are opened for editing. For objects created by OLE servers,
a submenu may present additional options.
The Edit original command can be invoked by holding down the Option key and
double-clicking on any linked element. Holding down the Shift key while selecting
the Edit original command- or while holding down the Option key and doubleclicking- allows you to select the specific application you want to open.

The Utilities menu
As its name suggests, the Utilities menu, which is shown in Figure 4-15, provides a collection of commands that add features to PageMaker. These include all Aldus Additions,
the Find/Change/Spelling commands that work only in the PageMaker story editor, and
commands to build and create indexes and tables of contents for your publications.
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Figure 4-15:
The Utilities menu.
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•

Aldus Additions. This submenu provides access to all currently installed Aldus
Additions. Additions are plug-in commands that add a wide range of capabilities
to PageMaker, including object grouping, print styles, and expert kerning. An
Addition is also used to execute scripts you write with the Aldus Scripting
Language.

•

Find.•. (Command-8). Brings up the Find ... dialog box, which is used to initiate a
search for a specific text string or type specification. The search can be limited
to the currently selected text or current story, or it can be applied throughout
the current publication. The Find ... command is available only when working in
the story editor.

•

Fmd next (Command-,). Repeats the most recent search executed using the Find

command. The Find next ... command is available only when working in the story
editor.
•

Change .•. (Comrnand-9). Brings up the Change dialog box, which is used to
initiate a search for a specific text string or type specification and then to change
the text that is found into a different text string or type specification. The search
can be Limited to the currently selected text or current story, or it can be applied
to the current publication. The Change ... command is available only when
working in the story editor.

•

Spelling... (Comrnand-L). Brings up the Spelling dialog box, which is used to
check the spelling of the current story in the story editor. Unknown words are
flagged in the dialog box, at which time they can be corrected, ignored, or added
to your own dictionaries. The Spelling... command is available only when
working in the story editor.

•

Index entry... (Command-;). Brings up the Create index entry dialog box, which
is used to add an entry to an index being built with PageMaker's Create index.. .
command. Before choosing this command, you should select the word or phrase
to be indexed or at least position the cursor in the paragraph containing that word
or phrase. The Create index entry dialog box allows you to specify the index item
itself, the page range for the index reference, and topic cross-references.
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•

Show index..•. Brings up the Show index dialog box, which presents a listing of
all current index entries. From this dialog box, individual index entries can be
edited. When this command is selected, PageMaker must compile the index list,
which may take a few minutes.

•

Create index .... Brings up the Cr eate index dialog box, which presents options
for the cr eation of an index based on entries made using the Index entry .. .
command. The options allow you to replace the current index (if one exists),
index all publications in the book list (if any exist), title the index, include section
headings, and specify formats used in the index.

•

Create TOC .•.• Brings up the Create TOC ... dialog box, which presents options
for the creation of a table of contents for paragraphs in which the "Include in
table of contents" option has been selected. The options allow you to replace the
current table of contents (if one exists), include all publications in the book list in
the table of contents, title the table of contents, include section headings, and
specify formats used in the table of contents. When the OK button is clicked, the
specified table of contents is created.

The Layout menu
The Layout menu, shown in Figure 4-16, provides commands that control your publication window. This includes control over view size, rulers and guides, and column
guides, as well as page turning, addition and removal of pages, and displaying or
removing items from master pages.
Figure 4-16:
The Layout menu.
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•

View submenu. Pr esents all available view-size commands, which you use to
change the magnification size of your publication on screen.

•

Viewc:>At in window (Command-W). Changes the display in the publication
window so that it displays all of the current page(s) selected. The actual r eduction depends on the size and resolution of the monitor being used. Choosing the
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Fit in window command when it is already selected refreshes the video display.
Holding down the Shift key while selecting this command changes the display to
include all of the selected page(s) plus the entire pasteboard. A check mark (-1)
before the command indicates that it is selected. Fit in window view can also be
selected by holding down the Command and Option keys while clicking the
mouse button anywhere in the publication window, provided that the display is
at any view size other than Fit in window.
•

View::>25% size (Command-O). Changes the display in the publication window to

25 percent of its actual size. PageMaker centers the display based on the items
centered in the previous view size. Choosing the command when it is already
selected refreshes the video display. A check mark (-1) before the command
indicates that it is selected.
•

View::>50% size (Command-S). Changes the display in the publication window to

50 percent of its actual size. PageMaker centers the display based on the items
centered in the previous view size. Choosing the 50% size command when it is
already selected refreshes the video display. A check ma rk (..f) before the command indicates that it is selected.
•

View::>75% size (Command-7). Changes the display in the publication window to

75 percent of Its actual size. PageMaker centers the display based on the items
centered in the previous view size. Choosing the 75% size command when it is
already selected refreshes the video display. A check mark (-1) before the command indicates that it is selected.
•

View::>Actual size (Command-!). Changes the display in the publication window

to a full-size representation of the current page(s). PageMaker centers the
display based on the items centered in the previous view size. Choosing the
Actual size command when it is already selected refreshes the video display. A
check mark (-1) before the command indicates that it is selected. Actual size view
can also be selected by holding down the Command and Option keys while
clicking the mouse button anywhere in the publication window, provided that
the display is at any view size other than Actual.
•

View::>200% size (Command-2). Changes the display in the publication window

to 200 percent of its actual size. PageMaker centers the dis play based on the
items centered in the previous view size. Choosing the 200% size command when
it is already selected refreshes the video display. A check mark ("J before the
command indicates that it is selected. The 200% view can also be selected by
holding down the Shift, Command, and Option keys while clicking the mouse
button anywhere in the publication window, provided that the display is at any
view size other than 200%.
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•

Viewc:>400% size (Command-4). Changes the display in the publication window
to 400 percent of its actual s ize. PageMaker centers the display based on the
items centered in the previous view s ize. Choosing the 400% size command when
it is already selected refreshes the video display. A check mark (..f) before the
command indicates that it is selected.

•

Guides and rulers submenu. Presents a collection of commands relating to onscreen guide lines a nd rulers.

•

Guides and rulersc:>Rulers (Command-R) . Toggles on and off the display of
rulers along the top and left edges of the publication window. A check mark (..f)
before the command indicates that it is currently selected (rulers are displayed);
choosing it at this time will deselect it (rulers become hidden). Rulers use the
current measurement system as set in the Preferences dialog box.

•

Guides and rulersc:>Snap to rulers (Command-[). Causes any object being
repositioned to align with the vertical and horizontal tick marks in the rulers. A
check mark (..f) before the command indicates that it is currently selected
(elements snap to tick marks) ; choosing it at this time will deselect it (elements
will not snap to tick marks) .

•

Guides and rulersc:>Zero lock. Locks the zero point of the rulers so that the
intersecting lines in the upper left corner of the publication window become
unselectable and unmovable. A check mark (..f) before the command indicates
that it is currently selected (zero point is locked) ; choosing it at this time will
deselect it (zero point becomes unlocked) .

•

Guides and rulersc:>Guides (Command-.!). Displays all nonprinting column, ruler,
and margin guides that have been created for the pages in the publication
window. A check mark (..f) before the command indicates that it is currently
selected (guides are displayed) ; choosing it at this time will deselect it (guides
become hidden) .

•

Guides and rulersc:>Sn ap to guides (Command-U). Gives all column, ruler, and
margin guides a magnetic pull on the pointer, text blocks, and graphic elements
when these elements are being positioned. A check ma rk (..f) before the command indicates that it is currently selected (elements snap to guides); choosing
it at this time will deselect it (elements will not s nap to guides when moved) .

•

Guides and rulersc:>Lock guides. Locks all existing column and ruler guides and
prohibits the creation of new guides. A check mark (\~ before the command
indicates that it is currently selected (guides are locked); choos ing it at this time
will deselect it (guides become unlocked). The Lock guides command is dimmed
when the Guides command is not selected.
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Guides and rulei"S¢Scroll bars. Toggles the display of the scroll bars on the right
and lower edges of the publication window. You may wish to hide the scroll bars
to provide additional space on screen for the display of your publication. A check
mark (;/) before the command indicates that it is currently selected (scroll bars
are displayed); choosing it at this time will deselect it (scroll bars are hidden).

• Column guides.... Brings up the Column guides dialog box, in which you define
or edit the number of columns and space between column guides for the current
page(s). The Column guides ... command is dimmed when the Guides command
is not selected.
• Go to page ... (Command-G). Brings up the Go to page dialog box, in which you
can enter any page number in the document or select the left or right master
page. The display then changes to the selected page.
• Insert pages.. . . Brings up the Insert pages dialog box, in which you specify any
number of pages to be added to the current document. New pages can be placed
before or after the current page or between the current pages (if working on
facing pages).
• Remove pages... . Brings up the Remove pages dialog box, in which you specify
the removal of any number of pages from the current document. Pages to be
removed are specified by page number. Removing a page deletes t he contents of
the page, removes a page icon from the bottom of the screen, and renumbers all
subsequent pages.
•

Display master items. Toggles on and off the display of all text and graphics from
the appropriate master page on the current page. For example, if a border
appears on the right master page, selecting this command (indicated by a check
mark [vi], would display the border on the current page (if it is a right-hand
page); if this command is deselected (unchecked), the border is not dis played.
Master items will print only if they are displayed.

•

Copy master guides. Sets the column guides and ruler guides on the current
page(s) exactly as they appear on the corresponding master page, removing any
customization that has been done to the guides on the c urrent page. The Copy
master guides command ls dimmed if the current guides already match the
master page(s) guides.

•

Autoflow. Activates the automatic or semiautomatic text-flow features to be used
when placing text. The actual flow method used is determined through the use of
the mouse and various key commands while the text is being poured into the
document. A c heck mark (;/) before the command indicates that it is currently
selected (autoflow is activated); choosing it at this time will deselect it (autoflow
becomes deactivated). If no document is currently open, a change in the
Autoflow command will change the default setting used for any new documents
created at a later date.
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The Type menu
The Type menu, which is shown in Figure 4-17, provides control for typographic and
character-formatting aspects of your publication. To modify text or apply formatting,
you must first select it with the text tool. Selecting any of these commands when any
tool other than the text tool is selected will set defaults for the next time a new text
block is created.
Figure 4-17:
The Type menu.
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•

Font submenu. Displays all currently available fonts. Selecting a font from this
menu changes the current text selection or, if no text is selected, sets the font for
the next text entry (provided the cursor is not reset before the text is entered). A
check mark before a font name indicates that the font is applied to the selected
text or is the current default.

•

Size submenu. Displays some of the available type sizes (in points) for the
currently selected font. A check mark before a size indicates that the size is used
by the selected text or is the current default. Type sizes not presented in this
menu can be set using the Type specifications dialog box.

•

Leading submenu. Displays some of the available leading sizes (in points). A
check mark before a leading name indicates that the leading is used by the
selected text or is the current default. Leading sizes not presented in this menu
can be set using the Type specifications dialog box.

•

Set width submenu. Displays character-width options that can be applied to the
currently selected text. Character-width manipulation is used to condense or
expand text by a specified percentage of the default character width. The options
presented include predefined widths ranging from 10% to 130% or the "Other ..."
option, which allows you to enter any percentage from .1 % to 250.0% in .1%
increments.
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•

Track submenu. Displays tracking options for the currently selected text.
Tracking adjusts the space between characters by kerning adjacent letter pairs.
The six options presented allow you to manipulate the tracking of the selected
text by degrees ranging from very loose to very tight. The Normal option applies
the default kerning specified for the current font, and the No track option removes this default kerning.

•

Type style submenu. Displays available style effects that can be applied to text:
Normal, Bold, Italic, Underline, Strikethru, Outline, Shadow, and Reverse (white
letters). Effects are toggled on and off when selected, as indicated by the presence
or absence of a check mark (../). Any number or combination of effects can be
selected at the same time. Selecting the Normal effect turns off all other effects.

•

Type Specs... (Command-T). Brings up the Type specifications dialog box, where
you can alter the font, type size, leading, type style, case, and position of the
currently selected text or, if no text is selected, for the next text entry. This
dialog box also provides access to the Type options d ialog box, where the height
of small caps and the size and location of superscript and subscript type is set.

•

Paragraph ... (Command-M). Brings up the Paragraph specifications dialog box,
where you specify the hyphenation, pair kerning, alignment, indents, and spacing
of the currently selected paragraph(s). This dialog box also allows you to add
rules above or below the selected paragraph and control letter- and wordspacing.

•

Indents/tabs... (Command-!). Brings up the Indents/Tabs dialog box, in which
you specify the left and right margins, first-line indent, and tab settings for the
current paragraph(s).

•

Hyphenation ... (Command-H). Brings up the Hyphenation dialog box, which is
used to specify hyphenation attributes of the currently selected paragraph or
style sheet. You can choose among three different hyphenation methods, limit
consecutive hyphens, and set the width for PageMaker's hyphenation zone.

•

Alignment Displays a pop-up menu of alignment options for the currently
selected paragraph(s). If no text is selected, the alignment choice applies to the
next text entry, provided that the text-insertion point is not moved before the
text is entered. The alignment for the current paragraph has a check mark (../)
next to it. If more than one paragraph is selected, and they have different alignments, no check mark will display.

•

Style submenu. Displays all currently defined style sheets. Choosing a style
sheet applies that style sheet's attributes to the currently selected paragraph(s).
The style sheet chosen for the current paragraph has a check mark ('>/) next to it.
If more than one paragraph is selected, and they have different style sheets, no
check mark will appear.
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•

Define styles... (Command-3). Brings up the Define styles dialog box, which
allows you to create a new style sheet, edit or remove existing style sheets, or
import style sheets from another publication or template. If no document is
currently open, a change in the settings of the Define styles options changes the
default settings for new documents created later.

The Element menu
Many of the commands in the Element menu, shown in Figure 4-18, are used to modify
graphic elements created in PageMaker. Others, such as Bring to front and Define
colors ... , apply to both text and graphic elements.
Figure 4-18:
The Element menu.
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•

Une submenu. The various line weights and styles provided in this submenu can
be applied to any graphic element created with the line, circle, or rectangle tools.
You can apply only one line weight or style to any graphic element. When a
single graphic element is selected, the line weight or style specified for that
element has a check mark (1) before it. If more than one graphic element is
chosen, a check mark appears only if all selected elements use the same line or
style.

•

Fill submenu. The various shades and patterns provided in this submenu can be
used to fill any graphic element created with the rectangle or circle tools. You
can apply only one shade or pattern to any graphic element. When a single
graphic element is selected, the shade or pattern specified for that element has a
check mark (..J) before it. If more than one graphic element is chosen, a check
mark appears only if all selected elements use the same shade or pattern.
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•

F1ll and line... (Command-]). Brings up the custom Fill and line dialog box, in
which you can specify any file value or line weight between 0 and 800 points,
choose any available fill or line color, and set fill and line attributes suc.h as
Overprint, Transparent background, or Reverse line.

•

Bring to front (Command-F). Moves the selected element(s) to the top of the
stacking order that PageMaker uses for layering elements.

•

Send to back (Command-B). Moves the selected element(s) to the bottom of the
stacking order that PageMaker uses for layering elements.

•

Remove transformation. Removes any rotation, skewing, or reflecting that has
been applied to an object via the control palette. You cannot use this command
on lines drawn in PageMaker.

•

Text wrap.... Brings up the Text wrap dialog box, which you use to control how
text wraps or flows around an independent graphic. Options let you flow text
over graphics, wrap text around a rectangular or irregular graphic boundary, or
jump over graphics. You can also specify the amount of standoff you want
between the graphic and any wrapping text.

•

Image control. ... Brings up the Image control dialog box, in which you set
controls to manipulate the appearance of a currently selected (painted-graphics
file or scanned image) graphic. Controls include line screen value, angle, and
transfer function. The Image control. .. command is dimmed unless a paintformat or TIFF image is selected.

•

Rounded comers.... Brings up the Rounded corners dia log box, which presents
six alternative corners for use on rectangles and squares drawn in PageMaker. If
no document is currently open, a change in the settings of the Rounded corners
options changes the default setting used for documents created later.

•

Define colors... . Brings up the Define colors dialog box, in which colors can be
added, edited, or deleted.

•

Restore original color. Removes any colors applied to the object within PageMaker, returning the object to the color as imported. This command is dimmed if
no PageMaker color has been applied to the graphic or if the graphic is a file
format that cannot include color information.

•

Un.k info .... Brings up the Link info dialog box, which is used to verify or modify

the relationship between text and graphic elements used in the current publication and their original disk files. This command allows you to update a text or
graphic element within the publication to reflect changes that have been made to
the original disk file, or to replace the text or graphic element with the contents
of a different disk file.
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•

Unk options••• . Brings up the Link options dialog box, which allows you to
determine whether text and graphic information that has been imported into the
publication is actually stored in the publication or is accessed from its original
disk file, and if changes to the original disk file will be automatically used in the
publication.

The Window menu
The Window menu, shown in Figure 4-19, provides control over publication windows,
story editor windows, and all PageMaker palettes.
Figure 4-19:
The Window menu.
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•

Help.••• Brings up the PageMaker help system, which provides on-line information about all PageMaker commands and a multitude of PageMaker topics.
Context-sensitive help is also available by pressing Command-? and then selecting any command or tool.

•

Show clipboard. Displays a window containing the contents of the Macintosh
Clipboard. Clipboard contents are usually the result of the last Cut or Copy
command but may be left over from some application that was open before
PageMaker was opened. The Cut, Copy, and Paste commands cannot be used
while the Clipboard window is open. To close the Clipboard, click on the close
box in the Clipboard title bar.

•

Tile. Arranges all open windows, either layouts or stories, into a neat side-by-side
placement. Holding down the Option key while choosing the Tile command when
in the story editor tiles all open stories from all open publications.

•

Cascade. Arranges all open windows, either layouts or stories, into a layered
display with all title bars visible. Holding down the Option key while choosing
the Tile command when in the story editor cascades all open stories from all
open publications.
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Tool palette (Command-6). Toggles the display of the tool palette. The tool
palette can be moved and closed just like any other Macintosh window. A check
mark (.../) before the command indicates that it is currently selected (tool palette
is displayed); choosing it at this time will deselect it (tool palette becomes
hidden). The tool palette can also be hidden by clicking the close box in its title
bar.
Style palette (Command-Y). Toggles on and off the display of the style palette,
which lists the names of all currently defined PageMaker text styles. The style
palette can be moved, sized, and closed using the window title bar, size box, and
close box, respectively. A check mark(.../) before the command indicates that it is
currently selected (style palette is displayed); choosing it at this time will
deselect it (style palette becomes hidden).

•

Color palette (Command-!<). Toggles on and off the display of the color palette,
which lists the names of all currently defined PageMaker colors. The color
palette can be moved, sized, and closed using the window title bar, size box, and
close box, respectively. A check mark(.../) before the command indicates that it is
currently selected (color palette is displayed); choosing it at this time will
deselect it (color palette becomes hidden).

•

Control palette (Command-'). Toggles on and off the display of the control
palette, which provides quick access to character, paragraph, and object formatting. A check mark (.../) before the command indicates that it is currently selected
(control palette is displayed); choosing it at this time will deselect it (control
palette becomes hidden).

•

Ubrary palette. Toggles on and off the display of the library palette, which
displays a collection of text or graphic elements you have c reated. The first time
the command is chosen, you are asked to select the library palette that you want
to open. The library palette can be moved, sized, and closed using its title bar,
size box, and close box, respectively.

The Story menu
When the story editor is open, the Layout and Element menus disappear, and the Story
menu, shown in Figure 4-20, is added. This menu contains commands to open and close
stories and control the display of on-screen elements in the story editor.
•

New story. Creates a new story window in the story editor. This window is
initially untitled and can be used to enter a new story from the keyboard or to
hold a text file that has been imported using the Place ... command.

76

Part I: Introducing PageMaker

New st ory
Close story

:lll W

Dlsplll!J 'i
v'D i spla' st le nomes

Figure 4-20: The Story menu

•

Close story (Command-W). Closes the currently selected story in the story
editor. lf any changes have been made to the story, and the story has not been
placed in the current publication, a dialog box asks if you would like to place the
story or discard the changes. If only one story window is open in the story editor
when this command is selected, the story editor itself is closed and you are
returned to the layout view.

•

Display Paragraphs. Toggles the display of s pecial characters in the current
story. Special characters include spaces, em and en spaces, fixed spaces, tags,
returns, line ends, page numbers, and index markers.

•

Display style names. Toggles the display of a bar in the story editor window
listing the name of any style sheets applied to paragraphs in the current story.

The tool palette
The tools in PageMaker's tool palette, or toolbox, initiate a variety of actions. Select a
tool by clicking on its icon in the tool palette. The palette itself, which is shown in Figure
4-21, can be repositioned anywhere within the publication window by dragging its title
bar, and it can be closed by clicking on its close box. When closed, the tool palette can
be redisplayed by choosing the Tool palette command from the Windows menu.
Figure 4-21:
The Tool palette.

•

Arrow tool (Shift-Fl). Used to select text and graphic objects, manipulate the

column and ruler guides, operate the scroll bars, turn pages, and choose commands from the menus. The arrow tool appears automatically when the cursor is
positioned over the menu bar, page icons, scroll bars, or the palette itself.

Chapter 4: Terms, Tools, and Menus

77

•

Diagonal line tool (Shift-F2) . Used to create a line between any two points on the
current page(s) or pasteboard. Hold down the Shift key while creating a new
diagonal line to force the line to be drawn at a 45-degree angle to the edge of the
page. The initial weight, style, and color of a new line is defined by the setting of
the Line command and color palette.

•

Perpendicular line tool (Shift-F3). Used to create lines at 45-degree angles on the
current page(s) or pasteboard. The initial weight, style, and color of a new line is
defined by the setting of the Line command and color palette.

•

Text tool (Shift-F4). Used to create a new text block, to set the insertion point in
an existing text block, or to select text in an existing text block.

•

Rotation tool (Shift-FS). Used to freely rotate any text block or graphic element.

•

Square comer tool (Shift-F6). Used to create a new rectangle with square
corners. Holding down the Shift key while creating a new rectangle will force the
shape to be a square. The corners of any shape created with the Square corner
tool can be adjusted using the Rounded corners ... command from the Element
menu. The new shape will be bordered by a line with the weight and style
selected with the Line command, and filled with a shade as specified with the Fill
command.

•

Oval/circle tool (Shift-F7). Used to create a new oval. Holding down the Shift key
while creating a new oval forces the shape to be a circle. The new shape will be
bordered by a line with the weight and style selected with the Line command,
and filled with a shade as specified with the Fill command.

•

Cropping tool (Shift-F8). Used to crop an imported graphic, uncrop a cropped
graphic, or position the remainder of a cropped graphic within its borders.

The control palette
PageMaker introduced the control palette in version 4.2 and has given it a major
upgrade in version 5. The control palette now appears in one of three distinct states,
depending on what type of object(s) are selected.
•

Character view. In this view, shown in Figure 4-22, the control palette lets you
set font, type size, tracking, kerning, type style, type case (small caps, all caps,
etc.), type position (superscript, subscript), leading, width, and baseline shift.

Figure 4-22: The control palette in character view.

78

Part I: Introducing PageMaker

•

Paragraph view. In this view, s hown in Figure 4-23, the control palette lets you
set paragraph style, first indent, space before, space after, left indent, right
indent, grid size, grid alignment, grid size, and alignment.

Figure 4-23: The Control palette in paragraph view.

•

Object view. In this view, shown in Figure 4-24, the control palette lets you set X
and Y positions, width and height, scaling, rotation, reflecting, skewing, and
cropping.

Figure 4-24: The Control palette in object view.

••••••••••••••••••••••••••••••••••••••••••••••••
Summary
•

Use basic mouse operations such as point, click, drag, and double-click to
control PageMaker.

•

Menu commands can bring up dialog boxes or subme nus, toggle command
states, or execute commands.

•

Dialog boxes include radio buttons, check boxes, option boxes, and pop-up
menus.

•

PageMaker uses eight menus, a tool palette, and a control palette to present its
major commands and tools.

••••••••••••••••••••••••••••••••••••••••••••••••

A Brief Tour of
PageMaker
••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
•

Methods of launching PageMaker

•

Defining new publications in the Page Setup dialog box

•

What's what in the publication window

•

PageMaker defaults and preferences

•

Saving and Quitting

••••••••••••••••••••••••••••••••••••••••••••••••

Launching PageMaker
Now you're ready to start using PageMaker. This chapter reviews the basic skills you'll
need to create publications - you will use them in virtually every publication, no
matter how simple or complex.
The first of these basic skills is launching. You can't use PageMaker if you can't launch
it, and there are five different ways to get PageMaker going:
1. Double·dick on the PageMaker icon.

2. Select the PageMaker icon and then choose the Open ... command from the
Macintosh File menu.
3. Double-dick on any document that was created with PageMaker 5. If PageMaker
5 is available, this launches the a pplication and opens the selected file. If
PageMaker is not available, an alert dialog box informs you that the application
has not been found. If this happens, launch PageMaker using one of the first two
methods and then open the file using the Open command, which is described
later in this chapter.
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4. Drag the icon from any PageMaker publication and drop it onto the PageMaker 5
application icon. (fhe PageMaker 5 icon will be highlighted when the icon is in
the .::orrect position for this drag-and-drop launch.)
5. Choose PageMaker from the menu of a launching utility, such as Now Menus,
OnCue, or System Ts Apple menu.
Once PageMaker has launched successfully, the copyright window (also known as the
start-up screen), shown in Figure 5-l, and menu bar appear. The copyright window is
provided simply as an introduction to the software, verifying that you are now running
PageMaker. It also makes the lawyers happy.

n

Figure 5-1:
The PageMaker
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Changing your start-up screen
If you are comfortable using Apple's ResEdit utility and want to change the graphic
in PageMaker's start-up screen, you can do so quite easily by modifying the PM5.0
RSRC file, as shown in Figure 5-2. Before you do this, you should make a backup copy
of that file so you can restore the file to its original state if you get tired of your changes.
To change the start-up screen:
Step 1. First, prepare the graphic you want to use in your favorite graphic editor
(Aldus FreeHand, Adobe Photoshop, or any other graphic program will
do). Make sure the graphic is no larger than 486 pixels x 287 pixels.
Copy your graphic into the Scrapbook.
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Step 4. Open the Scrapbook and copy you r new start-up screen graphic to the
' Clipboar.d.
'
I

Step 5. Click on the existing start-up graphic and choose Paste from the Edit
menu (Command-V).
Step 6. Close the PICT window.
Step 7. Choose the Save command and then Quit ResEdit.
Step 8. Launch PageMaker, and your new start-up screen will appear.
I

.
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To move past the copyright window, click the mouse button. You are now ready to
begin using PageMaker. Unless you opened PageMaker by double-clicking on a publication document or using the drag-and-drop method, no windows are opened automatically- the PageMaker menu bar, shown in Figure 5-3, is your only evidence that the
application is running. If you are using System 7, or System 6 with MultiFinder, you will
see the PageMaker 5 icon in your Application menu, but the Finder desktop, or any
windows open from other applications, will still be visible.
After launching PageMaker, you can
•

Create a new PageMaker publication or template document

•

Open an existing PageMaker publication or template document

•

Alter PageMaker's default settings

•

Quit PageMaker and return to the Macintosh Finder

The next sections of this chapter describe the process of creating new PageMaker
publications or templates and opening existing publications and templates. Later, the
discussion will turn to altering application defaults and quitting PageMaker.
Figure 5-3:

The
Page Maker

desktop
without an
open file.
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Creating a New Publication
You create a new PageMaker publication by choosing the New ... command from the
File menu (Command-N). This command brings up the Page setup dialog box (see
Figure 54), in which you specify the initial attributes of the new publication.
Figure S-4:

The Page setup
dialog box.
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The Page setup dialog box controls the following aspects of a PageMaker document:
•

The number of pages that make up your document and the page number of the
first page

•

Whether the pages will be prepared as a double-sided document and whether
facing pages will be viewed simultaneously on screen

•

The size of the top, bottom, inside, and outside margins

•

The page-numbering style that is used for automatic page numbers

Each of the options in this dialog box is described in the following sections. To leave the
Page setup dialog box without creating a new publication, click the Cancel button. If the
options are set to your satisfaction, click the OK button. A new publication based on the
specifications you have requested will appear on screen. Note that this new publication
is unsaved and untitled until you use the Save or Save as ... command to write this new
file to disk. It is possible to later return to the Page setup dialog box and make changes
to any of your initial options- I'll discuss these types of changes later in this chapter.
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Page size and orientation
The Page option specifies the total size of every page in the publication. The dimensions describe the on-screen electronic pages that PageMaker creates to represent your
publication. Later, when preparing to print your publication, you will usually select a
paper size that is the same size or larger than this page size so that the publication can
be printed easily. If you elect to use a page size that is larger than the largest paper size
available on your printer, you'll have to use a special printing technique known as
"tiling," which I discuss in Chapter 17, "Printing Publications."
A number of page-size options are available, including those commonly used in the U.S.
(Letter, Legal, and Tabloid) and Europe (A3, A4, AS, 85), as well as in graphic arts
(Magazine, Magazine Wide, etc.). The dimensions of many standard page size options
are listed below. When a page-size option is selected, the dimensions are automatically
displayed in the option boxes to the right of the Page dimension option.
Option

Dimensions

Letter

8.5 inches by 11 inches

Legal

8.5 inches by 14 inches

Tabloid

11 inches by 17 inches

A4

8.268 inches by 11.693 inches

A3

11.693 inches by 16.535 inches

A5

5.827 inches by 8.268 inches

B5

6.929 inches by 9.842 inches

Magazine

8.375 inches by 10.875 inches

Magazine N arrow

8.125 inches by 10.875 inches

M agazine Wide

9 inches by 10.875 inches

Magazine Broad

10 inches by 12 inches

The Custom option allows you to specify the dimensions for any non-standard page
size. Custom page sizes can be up to 42 x 42 inches. Values entered in the option boxes
for the width and height of a custom page are accurate to MOO inch (or 0.06 pica).
The Orientation option determines if your electronic pages will be positioned as taller
than wide or wider than tall. In effect, the display for a 7-inch by 5-inch page in the Tall
orientation is the same as that for a 5-inch by 7-inch page in the Wide orientation. In
some other Macintosh applications, the Tall orientation is known as portrait and the
Wide orientation is called landscape.
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Page numbers and the number of pages
The Start page #option specifies the page number given to the first page in your
publication. Each subsequent page is automatically numbered sequentially. PageMaker
can accept a starting page number as high as 9999. PageMaker displays page numbers
on the page icons in the lower left corner of the publication window, and places them
on any pages where the page number marker (Command-Option-P) is set, either directly or via the master page.
The # of pages option determines how many pages are created for the new publication.
PageMaker supports a maximum of 999 pages in one publication (or as many as disk
space allows) and a minimum of just 0- although such a publication would have only
master pages and could not be printed. Figure 5-5 shows what happens when you try to
exceed the maximum. Additional pages can be added to a publication at any time, so
you do not need to specify extra pages "just in case." In fact, PageMaker's autoflow
feature automatically adds them as needed. It is better to err with too few pages rather
than too many- blank pages in a publication significantly affect the file size of the
document and therefore waste disk space while they remain unused.
Figure 5-5:

The alert dialog box that
appears when you try to
create a publication with
more than 999 pages.

Cannot insert the specified pages.
Number of pages per publication must
range from 1 to 999.
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Also in the Page setup dialog box is the Numbers ... button, which you use to specify the
style of page numbers in your publication. Click the Numbers ... button, and the Page
numbering dialog box will appear, as shown in Figure 5-6. Five options are available,
representing Arabic, Roman, and alphabetic numbering. Click the radio button corresponding to the page-numbering style you want to use. You can also enter up to 16 characters
in the "TOC and index prefix" option box if you want special text to be added before
page-number references in any table of contents or index created using the Create TOC ...
or Create index ... command. After completing these options, click the OK button.
Figure S-6:
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Managing long documents
To create a publication with more than 999 pages, you'll have to use several
separate PageMaker documents, segmenting the publication into logical subdivisions
such as chapters. You should normally break long publications into several smaller
PageMaker documents long before reaching PageMaker's 999-page limit. A number
of benefits accrue from creating large publications as a series of smaller documents:
Ma11ageablllty. Document size is more manageable so that documents fit on
floppy disks for easy backup and transportation.
Speed. Documents can be opened, closed, and saved more quickly when they
are reasonably sized.
Safety. Fewer pages will be affected by file loss, damage, or intemal corruption,
should it occur.
logic. Smaller documents more accurately reflect logical breaks that occur in
most documents, such as chapters or sections. This also allows running heads or
footers containing the chapter or section name to be placed on master pages.
(This would not be possible in a single PageMaker document containing multiple chapters or sections.)
While there is no hard-and-fast rule, breaking long documents into files of no more
than 100 to 200 pages each is a good practice. At these lengths, file size and
performance remain acceptable (unless a document contains an unusually large
number of imported graphics).

Configuring double-sided documents
You use the Double-sided option when creating documents that will be reproduced on
both sides of the paper- this does not configure PageMaker to print double-sided
documents. When the Double-sided option is selected, PageMaker presents two master
pages instead of one, allowing unique master-page items such as running heads, footers,
and graphics to be added to left and right pages independently. It also positions the
inside and outside page margins appropriately on left and right pages.
If you create a publication that will be reproduced as double-sided but does not
have any distinguishing differences between right and left pages, it is not
necessary to define your document as double-sided. The only advantage in doing

so is that you can use the Facing pages option. The possible disadvantage is
that you may have to create two identical master pages -requiring additional
effort and increasing the chance of introducing alignment errors.
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Every odd-numbered page in a double-sided publication will be a right-hand page, and
every even-numbered page will be a left-hand page. Changing the value of the Start page
# option to an odd value from an even one, or vice versa, will force right pages to
become left pages and left pages to become right pages. The inside margin will always
be on the left edge of odd pages and on the right edge of even pages. The page icons
that represent pages in the current publication identify right and left pages by the bent
corner at the top outer corner of each page, as in Figure 5-7.
Figure 5-7:
Page icons for a double-sided document.

When the Facing pages option, shown in Figure S-8, is selected, PageMaker displays
adjacent right and left pages in the publication window. Working on facing pages is no
different than working on a single page, except that PageMaker must use a larger
reduction to display both pages at the Fit in window view size. Using the Facing pages
option allows you to monitor the relationship between pages that your readers will see
simultaneously, although it tends to slow down display speed because more information is being shown.
Figure 5-8:
When the Facing pages
option is selected, two
pages appear in the
publication w indow (top).
When it is not selected,
only one page is displayed (right).

The Facing pages option can be toggled on and off while you are creating your publication (as described later in this chapter) so that you can enjoy the speed benefits of
viewing single pages while doing the bulk of your layout and the display benefits of
facing pages when you want to check the results.

Margins
Four option boxes make up the option called Margin in unit of measure: Top, Bottom,
Inside, and Outside (or, if the Facing pages option is not selected, Left and Right). The
values entered in these option boxes represent the distance from the edges of the
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electronic page to the margin guides that PageMaker automatically adds to each page of
a publication. As with all PageMaker measurement options, values are entered in the
current unit of measure, as specified in the Preferences dialog box.
In most cases, the area within your margins will contain the body copy or primary
elements of each page in your publication; however, it is possible to position, display,
and print elements outs ide the margin boundaries, as shown in Figure 5-9. Many master
page items, such a'5 running heads, footers, and page numbers, are commonly positioned outside the defined page margins.
Figure 5-9:
Text or graphic objects can exceed
the margins.

;. . . fX·Y·2\

To override the current unit of measure, use the one-character abbreviation for
the unit of measure you wish to specify. (Use i for inch , p for pica, c for cicero,
m for millimeter - each fully described later in this chapter in the section
about the Preferences dialog box.)

""'

Once you are satisfied with the settings in the Page setup dialog box, click the OK
button or press the return or enter key on your keyboard. PageMaker then creates the
new document you have specified, and a publication window will appear, showing the
first page of your new document.

The Publication Wlndow
The overall screen display presented when a document is open is called the publication
window. Assuming the application defaults haven't been changed, the publication
window, s hown in Figure 5-10, includes:
•

The PageMa.ker menu bar. This bar contains menu-bar titles, representing
groups of PageMaker commands that can be d is played by selecting menu-bar
titles.

•

A window for each open publication. Publication windows are named Untitled
until you specifically save and name them, at which time the document name is
dis played in the title bar. Either one or two pages of your document are visible in
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each publication window, depending on the page(s) currently selected, whether
the publication is defined as double-sided, and whether the Facing pages option
is selected. The margins of each page are marked with dotted rectangles. AJl text
and graphics that have been added to any publication page will appear on
screen, as will all column guides and ruler guides.
•

Two rulers. One ruler is at the left edge of the publication window, and the other
is across the top of the publication window. The rulers are turned on and off by
choosing the Rulers command from the Options menu. Rulers are divided into
units specified in the Preferences dialog box. A small dotted line on each ruler
marks the current location of the cursor as it moves in the publication window.
The zero point of the rulers is fully adjustable, as described in Chapter 6, "Publication Window Basics."

•

The tool palette. Contains PageMaker's eight tools. The tool currently selected is
highlighted, and the cursor displays the icon of the selected tool when positioned anywhere over the publication. A tool is selected by clicking on its icon. The tool
palette can be opened, moved, or closed -just like any other Macintosh window.
Menu bar

Ruler 2

Tool palette

Figure 5-1 0:
A PageMaker
publication
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•

Page icons for the master-page icons (labeled L and R) and regular-page icons
(labeled with their page numbers). If your display is not large enough to contain
all of the regular page icons, then arrows for scrolling the page icons will appear
before the first-page icon and after the last-page icon. The icons of the page(s)
currently displayed are highlighted, and you can move to another page by
clicking on its page icon.

•

The pasteboard. The area in the publication window surrounding the displayed
pages is called the pasteboard. This space can be used to store text and graphic
elements that are temporarily (or permanently) not being used in your
publication's pages.

•

Scroll bars for the publication window. These operate exactly as other Macintosh scroll bars: Use the arrows for line-by-line scrolling, click in the dimmed
area in the bar to scroll about one-half the current display, or drag the scroll box
to manually determine the amount of display to be scrolled.

•

The pointer cursor. This displays while the arrow tool is selected in the toolbox
or the cursor is positioned over the rulers, menu bar, toolbox, palettes, or scroll
bars. Other cursor icons display when corresponding tools from the toolbox are
selected.

As you'll see later in this chapter, you can change PageMaker's application defaults and

determine which elements appear when a new publication is created. Other elements
you can control include the style palette, color palette, and control palette.

Opening Existing Publications
PageMaker 5 can open any publication created in PageMaker 5 or in PageMaker 4.2 or
4.0. This can be done from inside of PageMaker 5, from the Finder desktop, or with the
aid of an application-launching utility. You can use PageMaker 5 to edit publications
created with PageMaker 1.0, 2.0, or 3.0, but you'll have to go through a few extra steps
to convert them into a usable format before PageMaker 5 can open them. These steps
are outlined later in this section.

Opening files from the desktop
If PageMaker is not already running, you can open both PageMaker and a specific file at
the same time by double-clicking on the icon of the PageMaker publication. You can
identify PageMaker 5 publications by the icon shown in Figure 5-11 (viewed by icon or
small icon at the Finder) or by the type "PageMaker 5.0 document" (when viewing files
by name, date, size, or type. )
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Figure 5-11:
The PageMaker 5
publication icons and
name list when viewed
from the Finder.
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If an alert dialog box with the message "Application not found" appears when you

double-dick on a PageMaker publication, try launching the PageMaker application and
then opening the file using the Open ... command. For some reason, your Macintosh is
not properly associating these two files. If this problem persists , rebuild the desktop file
on your Macintosh (hold down Command-Option at sta rt-up after the extensions have
loaded but before the Finder desktop appears).
In System 7, you can also launch a document using the "drag-and-drop" feature.
To do this, drag a PageMaker document icon onto the PageMaker application
icon, or an alias of the PageMaker application icon, and release it. This will
launch the application and open the document. It's sort of like throwing a file
into the trash, except you are throwing the file into an application.

Opening files from within PageMaker
To open an existing PageMaker 5 document while inside PageMaker, select the Open ...
command from the File menu (Command-O). This action brings up the Open publication dialog box shown in Figure 5-12. Next, select the file that you want to open from the
scrolling file listing and click the OK button. To work on a copy of the se lected file
without modifying the origina l, select the Copy option. This will open a new, untitled
copy of the selected file. The Copy option is automatically selected for PageMaker
template files, since you usually want to use a copy of the template file to create your
new publication. To modify the template itself, click the Original option before clicking
the OK button.
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Figure 5-12:
The Open publication dialog box, with
t he folder bar
selected.
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When the scrolling list contains many filenames, enter the first letter of the desired
filename to move to a specific section of the alphabetical listing, or enter the first few
letters of the filename to quickly locate a s pecific file. If the file you want to open is on a
different disk or hard-dis k volume, use the Desktop (or Drive) and Eject buttons to
move between available drives and remove dis ks so that other dis ks can be inserted.
Double-click on any folder in the scrolling file listing to open that folder and display the
listing of files contained in the folder. Use the folder bar pop-up menu, above the
scrolling file lis ting, to close folders and move back up the folder hierarchy. Doubleclicking on a filename is equivalent to selecting the filename and clicking the OK button.

Opening PageMaker 4 files
To open files created in PageMaker 4.0 or 4.2, launch PageMaker 5 and then use the
Open .. . command as described above. PageMaker 4.0 and 4.2 files are converted into
PageMaker 5 files automatically. The converted files will be o pened as untitled, so use
the Save or Save as .. . command to give them a name and make the conversion permanent. This does not delete or modify your original 4.0 (or 4.2) file in any way. If
PageMaker has a problem converting your file, try giving it a little more RAM (changing
the values in the Get Info dialog box) and/or make s ure you have plenty of free space on
your hard drive.
After a publication has been converted, check the layout carefully; you may need to do
some cleanup before printing the files to adjus t for any repositioning of text or graphics
that may have occurred during convers ion.

Opening files from PageMaker 1.0, 2.0, or 3.0
PageMaker 5 cannot directly open publications created in versions of PageMaker earlier
than vers ion 4.0, so you have to use ear lier versions of PageMaker to convert files up
through the versions. If you have a PageMaker 2.0 publication, for example, launch
PageMaker 3.0 and open the file to convert it into a PageMaker 3.0 publication. Then

Chapter 5: A Brief Tour of PageMaker

93

save the file, launch PageMaker 4.0 (or 4.2) and open the 3.0 publication to convert it
into a 4.0 publication. Now you can launch PageMaker 5 and open the 4.0 publication,
and it will be converted into a 5 file. This is obviously a lot of work and requires reinstalling your old versions of PageMaker (assuming you don't still have PageMaker 3.0
lurking somewhere on your hard disk). Unfortunately, it is the only way to convert old
files for use in the current version.

Page setup options
After you have been working in a publication, you may find that you need to change the
options specified in the Page setup dialog box when the publication was created. This
can happen when you are not able to fit all the required information into your publication without going to a larger page size or if you decide that you would like slightly
smaller margins. In any case, by choosing the Page setup command from the File menu,
you can again display the Page setup dialog box, first shown in Figure S-4 and repeated
here as Figure 5-13.
Figure 5-13:
The Page setup
dialog box.
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I introduced the options in the Page setup dialog box earlier in this chapter, but as you
review them here, pay particular attention to the effect that changes to these options
have on an existing publication:
•

Page size and dimensions. Changes made to the page size will not affect elements that have already been placed on the pages of the publication. Existing
elements will remain in place, with the new page size being positioned behind
them. If the new page s ize is smaller than the old, some objects may now appear
on the pasteboard. They can, of course, be freely repositioned anywhere on the
resulting page(s).
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•

Orientation. As with the Page s ize option, changes to the orientation of a page
will not affect existing text or graphic elements. Existing elements remain in
place, with the page being rotated behind them. Almost certainly, some of the
existing page elements will now be positioned on the pasteboard, but they can
be freely repositioned anywhere on the resulting page.

•

Start page#. The starting page number can be changed to any number between
1 and 9999, as long as the highest resulting page number in the publication is not
higher than 9999. (So a publication with its first page numbered at 9999 could
only be 1 page long. The first page of a 999 page publication cannot be higher
than 9000.) If you are working on a double-sided publication, changing this
option from an odd number to an even number, or vice versa, will change all
right-hand pages to left-hand pages, and all left-hand pages to right-hand pages. If
you are working in a double-sided publication with facing pages, objects that
bleed across the two pages remain attached to what were formerly the left-hand
pages. In addition to renumbering the page icons at the bottom of the publication window, all pages containing automatic page numbers will also be updated.

•

Number of pages. Changing the Number of pages option adds or deletes pages
from your publication. New pages are added after the currently selected page.
The pages that will be deleted if you lower the total page count depend on the
number of pages being removed, but a dialog box will tell you which page
numbers will be lost before they are actually deleted. Using the Insert pages and
Remove pages commands from the Layout menu provides more direct control
over these processes.

•

Double-sided. The primary effect of changing the setting for the Double-sided
option is on the margins of your pages. When a publication is double-sided, it has
inside and outside margins instead of right and left margins. Depending on the
current margin settings, changing this option can have an important effect on the
margins displayed in your document. Also, the Facing pages option is available
only when the Double-sided option is selected. If you change a double-sided
publication with facing pages to a single-sided publication, objects that bleed
across the two pages remain attached to what were formerly the left-hand pages.

•

Facing pages. Deselecting the Facing pages option leaves objects that bleed
across the two pages attached to the left-hand pages only. Selecting the Facing
pages option forces PageMaker to delete some ruler guides if any newly facing
pages have a combined total of more than 40 ruler guides.

•

Margins. Resetting any of the margins will move the margin lines as displayed on
all pages of the publication, without adjusting any existing text or graphic
objects. Objects can be manually repositioned if required.
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Defaults and Preferences -------------------Most options and command settings in PageMaker are preset before you alter them.
These default settings represent the most commonly used setting for a particular option
and are intended to save you time and trouble by accurately presuming the settings
that you will want to use. New publications, for example, are by default created on
letter-sized paper with rulers and the toolbox displayed in the publication window, text
that does not wrap around graphics, and lines and shapes that are created with a
1-point line weight.
When default settings are different from what you use most of the time, the process of
constantly changing options from one setting to another can be tedious and timeconsuming. Not surprisingly, you can customize PageMaker to remember and use the
default settings that you choose. This is true for a wide range of options found in dialog
boxes and on menus. It is possible to change the default settings permanently, so all
new publications use the new defaults, or temporarily, so they remain defaults for a
single publication.
Default settings that are changed permanently are called application defaults. These
default settings are changed before a publication window is opened. You can change the
default setting for every menu command that is not dimmed. Application defaults
remain set until they are reset or until the PMS Defaults file (in the System Folder's
Preferences folde r) is deleted from your hard drive. (Deleting this file, by the way, is a
quick way to reset all application defaults to their factory settings.) The new defaults
apply to publications created after they are set- but do not affect any existing publications.
Default settings changed within a publication apply only to that publication. These are
called publication defaults and can be changed only while a publication is open. They
remain set until modified, even if the application defaults are reset or the PMS Defaults
file is deleted from your hard drive.

Preferences Dialog Box _ _ _ _ __
The Preferences d ialog box- accessed via the Preferences ... command in the File
menu, and shown in Figure 5-14- contains a variety of miscellaneous options that
pertain primarily to working in the publication window. As with the options described
above, you can change the default settings for a specific publication or you can set
application defaults that will apply to every new publication. Most of these options have
little to do with document-specific issues, so it's to your advantage to set them to your
liking as defaults.
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Figure 5-14:
The Preferences
dialog box.
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Options available in the Preferences dialog:
•

LayoutiMeasurement system. The Measurement system option offers a choice of
five units of measure. The selected units are displayed in the rulers and used in
aJI dialog boxes that require measurements.
It is possible to change the Measurement system option at any time while
creating a publication, but be aware that doing so might make it difficult to
properly align objects. This is true because the ruler tick marks in the new
measurement system probably will not correspond to those in the previous
system, and objects aligned with tick marks are more accurately positioned than
objects aligned between tick marks. Therefore, newly positioned objects, whether
they are aligned to new tick marks or between them, will probably not line up
with objects aligned with tick marks from the previous measurement system.
When entering measurements into a dialog box, you can override the selected
measurement system by adding an abbreviation to the value- i for inch, m for
millimeter, p tor pica (with any value following the p indicating points), or c for
cicero (with any value following the c indicating points). For example, if the
dialog asks for the Margin measurement in inches, entering 3p6 would specify 3
picas 6 points (or 3~ picas), entering 20m would specify 20 millimeters, and
entering 8c3 would specify 8 ciceros 3 points (or 8~ ciceros).

•

Layoutivertical ruler. The Vertical ruler option lets you specify a different unit of
measure for the vertical ruler than the unit used on the horizontal ruler. The top
option is the unit of measure chosen as the current Measurement system option.
Other options include decimal inches; millimeters, picas, and ciceros. The last
option - Custom - allows you to specify a vertical ruler divided by any number
of points.
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By using the Custom option to specify the number of points used in the leading
of the body copy of your publication, it is very easy to improve the consistency
of the alignment of your text blocks - especially when aligning the baselines of text
in adjacent columns. Using the Snap to rulers command facilitates this even further.
•

Layout problemslshow loose/tight lines. The two Layout problems options
provide a visual indication of places in your publication where PageMaker has
violated settings for specific text and paragraph options. Turning on these
options makes you aware of these violations so you can correct them if necessary. In most cases, you would not notice these discrepancies if PageMaker did
not highlight them.
When the loose/tight lines option is selected, PageMaker displays a gray bar
behind any text that is positioned in violation of the settings for Jetter- and wordspacing in the Spacing attributes dialog box, as shown in Figure 5-15. PageMaker
violates these settings when the requested justification and hyphenation make
following them impossible.
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Figure 5-15: PageMaker highlights violations of text and paragraph options.

•

Layout problems<>Show "keeps" violations. When the Keeps violations option
is selected, gray bars are displayed behind any lines of text that violate the
settings for the Keep with next, Widow, or Orphan option in the Paragraph
specifications dialog box.

•

Graphics. The setting of this option determines whether PageMaker draws
images so they display quickly on screen or so they look their best. This affects
on-screen display only and has no effect on output quality. Choosing the Gray
out option provides the fastest on-screen performance- every graphic is
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replaced with a simple gray box. Choosing the Normal option instructs PageMaker to display PICT and TIFF images in low-resolution mode, while the High
resolution option displays each of these with the best possible quality (but the
slowest on-screen drawing time).
You can force PageMaker to temporarily draw all images in their highest
resolution by holding down the Command key while clicking on the current
page icon or selecting a view size from the View sizes submenu.
•

Guides. Selecting the Front option sets the guides at the top of the stacking order
on any particular page, making it easy to select them for repositioning. Selecting
the Back option sets the guides at the bottom of the stacking order, making it
difficult to select them inadvertently while trying to reposition objects.
Often when selecting items in the publication window, you will find yourself
accidentally selecting guidelines. Setting the Guides option in the Preferences
dialog box to Back can help, but to ensure that you don't inadvertently
select guidelines, hold down the Command key when selecting objects with
the arrow too. When the Command key is pressed, it is impossible to select
guidelines.

•

Save. This option determines how PageMaker writes your files to disk when you
choose the Save command. Experienced PageMaker users know that the Save as
command in prior versions of PageMaker created a new, smaller version of a
PageMaker by saving the file in a more efficient way, eliminating the internal
remnants of deleted objects and the layout process.
Selecting the Smaller option instructs PageMaker to always save the smallest
possible file when the Save command is used. Selecting the Faster option results
in faster completion of the saving process, but file sizes are likely to be somewhat larger by comparison. If you use the Faster option, you can still use the
Save as command to occasionally save a compacted copy of your publication.

•

Control palette<>Horizontal nudge. The precision of the nudge buttons in the
Control palette is controlled via these three options. Set the Horizontal nudge
option to the number a nd unit of measure by which you want any selected object
to move horizontally each time the nudge button is pressed. By default, the unit
of measure corresponds to the selected unit of measure for the entire publication.

•

Control paletteivertical nudge. Similarly, the Vertical nudge option should be
set to the number and unit of measure by which you want any selected object to
move vertically each time the nudge button is pressed.

•

Control paletteiUse "Snap to" constraints. When this option is selected, nudging
objects via the control palette will move them to the next nearest ruler tick mark
or non printing guide, if the Snap to option is selected in the Guides and rulers
submenu, and the element is within 3 pixels of a guide or ruler tick mark. In other
words, this option makes a nudged object act like a dragged object does when
the Snap to option is being used.
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Other Preferences
In addition to the option available at the first level of the Preferences dialog box, the
Other ... button can be used to access additional options. The Other Preferences dialog
box is shown in Figure 5-16.
Figure 5-16:
The Other preferences dialog box.
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•

Autoflow: Display all pages. This option is designed as a pure time-saver.
Selecting it lets PageMaker autoflow your text without showing its progress page
by page. Avoiding all that screen redraw makes text flowing much faster. When
finished, PageMaker displays the final page or pages (if Facing pages are being
used) and you can then resume work on your publication.

•

Size of internal bitmap. Each time a graphic file is placed into PageMaker, the
program builds a display representation of the graphic. This option determines
the amount of memory used to create and store that graphic. When the imported
graphic appears on-screen, this representation is used if the Graphicsc:>Normal
option is selected in the main Preferences dialog box. If the Graphicsc:>High
resolution option is selected , the data from the original graphic file is used.
Increasing the size of the internal bitmap option allows PageMaker to create a
better-looking representation of imported graphics, but at the same time it
increases the size of publications. Decreasing this option has the opposite effect,
reducing publication size and the quality of on-screen bitmaps. When you print
your file, PageMaker gets the data from the original graphic, unless it is unavailable, and so the setting of this option has no effect. rt you did print a publication
with a missing graphic, then a larger internal bitmap would improve the resulting
print, but even the best bitmap is not a good subsititute for a missing original
graphic. As a result, you should e ither make sure the original linked graphics are
available when printing or increase the size of the Auto include images under
option (discussed next) so that graphics are stored within your publication itself.
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Auto include images under. This option determines PageMaker's default behavior in terms of importing graphics (fully embedding them within the publication
file) or linking them (maintaining a relationship with the externally stored
graphic file.) Normally, PageMaker imports graphics that are 64K or smaller and
links graphics larger than 64K.
Leaving larger graphics linked helps keep publication sizes down but adds to
your document- and file-management responsibilities because you'll have to
make sure the linked files are available in order to properly display and print the
publication.

•

Text<>Use typographer's quotes. Selecting this option instructs PageMaker to
watch out for the improper use of the inch and foot marks (" and ') in places
where quotation marks and apostrophes CU" and ") are typographically correct. If
this option is selected, quotation marks and apostrophes are substituted as
necessary.

•

Text<> Preserve line spacing in TrueType, Preserve character shape in
TrueType. In rendering characters from TrueType fonts, PageMaker has a choice
of making the characters more accurate in terms of line spacing and less accurate in terms of character shape, or more accurate in terms of character shape
and less accurate in terms of line spacing. These options let you decide which
aspect of TrueType fonts will be more accurate. These options have on-screen
impact only; they have no effect on the printed quality of TrueType fonts.

•

Text<>Greek text below. This option controls the size at which PageMaker no
longer tries to accurately display type on the screen, replacing the characters of
the text with thin gray bars. The size is specified in the number of pixels that
would stack vertically to make up a capital letter when displaying the type. This,
of course, depends on both type size and the current view size. For example,
displayed at the Fit-in-window view size, the height of a 6-point character is less
than 6 pixels; when viewed at 200% view size, the height of a 6-point character is
more than 6 pixels.
The benefit of greeking text is that PageMaker is able to display the thin gray
bars much faster than it can draw each individual character. Since characters are
probably illegible when displayed at such small sizes, it is usually better to forgo
the character display for a faster screen refresh. See Figure 5-17 for a comparison.

•

Story edltor<>Font, Size. The two options determine the font and type size used
to display text in the story editor. Use the pop-up menus to select any font
available on your Macintosh and any of 14 type sizes, or type in the font size
you prefer.
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Figure 5-17: The same page at Fit-in-window size with standard (left) and "greeked" (right)
text display.

•

Story editor::>Display Style names. Selecting this option adds a vertical column
to each story editor window, in which the names of styles applied to any displayed paragraphs will appear.

•

Story editor::>Display 11. Selecting this option causes all nonprinting characters
to appear in story editor windows. Nonprinting characters include paragraph
marks (~) . spaces, and tabs.

Saving a Publication
Saving your work frequently is as important in PageMaker as it is in any software
program. Until you save, you risk losing the work you've done since the prior save. Like
most Mac programs, PageMaker provides the Save (Command-S) or Save as ... commands
in the File menu. Their operation also follows Mac standards:
•

The Save command (Command-S). If the document is titled, the Save command
updates the disk version of the file to reflect the current contents of the file,
preference settings, and all publication windows. If the document is untitled, the
Save command invokes the Save as ... command, described next. It is possible to
receive a Disk full error message, shown in Figure 5-18, during the operation, in
which case the Save as ... command must be used to change the drive or volume
on which the publication is to be saved.
Cannot soue os.
Dlsl: full .

[ Continue

D

751 3: 34

Figure 5-18: The dialog box that appears when you try to save a publication or template to a
disk or volume without adequate space available.
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The Save as... command. Use the Save as ... command to determine the drive
location, filename, and file type of a document before it is saved. Choosing the
Save as ... command from the File menu brings up the Save publication as dialog
box shown in Figure 5-19. The name of the currently selected drive appears
directly below the Desktop (or Drive) and Cancel buttons, and the name of the
current folder, if any, appears in the pop-up folder bar. (If no folder is currently
open, the drive name appears in the pop-up folder bar.)
1/}. Folder File Dr lu e Options
Soue publicntlon us

1 I:JI?I:1 1

Jell Publlcotlons f .,.J
D .l<inu<Jry NI?UisloHcr
(~ SlliiiPiii~J EIOH 1r111111

D ·rnP [ ostello Colle< tlon

(Desktop

0

n

OK

D

I [ Concel I

=Dock Ontn
Soue os:
® Publication
O Templot e

Copy:
®No oddltlonol files

0 Files for remote printing

~====:::,::==~
0 0
lrh e Dylon

Monthl~

All linked files

D Soue preuiew

Figure 5-19: The Save publication as dialog box.

To alter the drive and folder to which your publication will be saved, use the
Desktop (or Drive) and Eject buttons along with the pop-up folder bar and the
scrolling file listing. If your publication is titled, the current filename appears in
the filename option box directly below the scrolling file listing. If your document
is untitled, no filename appears in the filename option box. Enter or edit the
filename as you wish, using up to 32 characters.
The Save as ... option also determines whether your publication will be saved as
a normal PageMaker publication document or as a template document. Choose
the Template option to create a new PageMaker template, or use the default
Publication option to create a normal PageMaker file.
The Copy linked files option is used to copy all graphic files used in the publication, but not stored within the publication itself, to the folder to which the
publication is saved. If you have deselected the Store copy in publication option
in the Link options dialog box for any graphics that you have imported, this
option provides a quick way to gather all the files that will be needed to print
your publication. This is especially useful when you will be transporting your
PageMaker file to another location for editing or printing - you don't want to
accidentally forget some of the linked files. Linked documents are described
more fully in Chapter 16, "Long Document Features."
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When you have selected the filename, location, and file type, click the OK button
or press Return to initiate the save. You can also click the Cancel button in the
Save publication as dialog box to return to the publication window without
initiating the save operation. If you try to save a publication with the same name
as an existing publication (in the current drive and folder), PageMaker will
present the Replace existing dialog box, shown in Figure 5-20, asking you to
confirm that you want to replace the existing file. Click Yes to save over the
existing file, or No to return to the Save publication as dialog box, where you may
change the filename or location of the save.
Replace eHistlng

"Northwest Boljcott" 1

n

Cancel

J)

( Replnce

)

Figure 5-20: The Replace existing dialog box.

If the disk or volume that you have selected does not have enough room for the file

being saved, the Cannot save as dialog box- which was shown in Figure 5-18appears. Clicking the Continue button returns you to the Save as ... dialog box so you
can select another drive or volume and re-execute the Save as ... command.

When to use Save as...
Using the Save as ... command has two main benefits. The first is security- if you use
the Save as ... command to save multiple versions of your publication, stored in different locations, your chance of substantial loss of work due to file corruption or a system
crash is dramatically reduced. Second, if you are not using the Smaller save option in
the Preferences dialog box, files saved using the Save as ... command will usually be
significantly smaller than those saved with the Save command. Depending on the
contents of the file, executing a Save as ... command can save from 20 to 50 percent of
the size of the file. This savings occurs because PageMaker purges all deleted graphics
and discards temporary data that had accumulated during the text-editing process.
When you execute the Save as ... command, you can either choose a new filename or
location, thereby creating a backup copy of your file, or you can save the publication
with the same name and location as it currently has, overwriting the current copy of the
file. This method reduces file size without creating a backup copy. If hard-disk space
permits, however, I recommend giving files created with the Save as ... command new
names and later deleting older versions manually. Using the Save as ... command to
save over the current file is potentially dangerous, and it is always a good idea to create
backup files. You never know when you might need them.
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PageMaker's mini-save
Any time you move to another page, change the page setup options, click the OK button
in the Define styles dialog box, perform a Save or Save as ... , or click the icon of the
current page, PageMaker performs a mini-save of your document. Information from this
mini-save is stored in a temporary file on your disk- your current working file is not
updated. PageMaker uses the information from the mini-save to minimize the amount of
work lost in the event of a system crash and as reference for use by the Revert command.
In most cases, when you reopen a PageMaker file after your system has crashed while

using PageMaker, you will find that your publication still has the changes that were
made to it after it was last saved - this is the result of the mini-saves PageMaker had
done before the crash. If you want to discard these mini-save changes and return the
file to its state as of your last formal save, choose the Revert. .. command from the File
menu.
While working on a publication, you can return to the last mini-save, discarding all
changes made to your file since that time, by holding down the Shift key and choosing
the Revert ... command from the File menu. This provides an important second line of
defense when you discover that you have made a big mistake in a document, since the
revert to mini-save can often undo the big mistake without losing all of your recent work
(as the regular Revert command would). For a complete discussion of the Revert. ..
command, see Chapter 6, "Publication Window Basics."
Although the mini-save is a tremendous feature and will probably save you some effort
at one time or another, do not let it discourage you from using the Save or Save as ...
commands often. Mini-saves should be considered only a safety net of last resort.

Finishing with PageMaker
When you have finished working in a publication, you can close the publication window. Then you can open a different publication, create a new publication, or quit
PageMaker altogether.

Chapter 5: A Brief Tour of PageMaker

105

Closing a publication
To close an open publication, choose the Close command from the File menu, or click
the close box in the upper left corner of the publication window. If you have made any
changes to the file, a Save changes? dialog box will appear, as shown in Figure 5-21 ,
asking if you would like to save your publication before closing it. Clicking the Yes
button will perform a Save operation (or a Save as ... if the file is untitled) and then close
the file; clicking the No button will close the file without saving the changes; and
clicking the Cancel button will return you to the publication window without saving the
file or closing it. Canceling is useful if you want to choose the Save as ... command in
order to change the name or location of the file, or if you would like to continue working
on the publication.

Figure 5-21 :
The Save changes?
dialog box.

Soue " The Costello Collection" before
closing?

H

Yes

IJ [

No

I[

Cancel

When you have closed all open publications, only the PageMaker menu bar remains onscreen. At this point, your options are the same as they were when you first launched
PageMaker: You can create a new PageMaker publication, open an existing PageMaker
publication, alter PageMaker's application default settings, or quit PageMaker and
return to the Macintosh Finder.

Quitting PageMaker
When you have finished your work in PageMaker, choosing the Quit command from the
File menu (Command-Q) closes the current publication (if one is open) and returns
control of your Macintosh to the Finder. Like the Close command, the Quit command
prompts the appearance of a Save changes? dialog box, as shown in Figure 5-20, and
you will be asked to save changes if any have been made to any open publications since
they were last saved. Clicking the Yes button performs a Save operation (or a Save as ...
if the file is untitled), then closes the file and the application. Clicking the No button will
close the file and the application without saving the changes. Clicking the Cancel button
returns you to the publication window without saving the file or closing it. If no publication window is open, or if no changes have been made since the last save operation,
PageMaker quits without presenting a dialog box.
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••••••••••••••••••••••••••••••••••••••••••••••••
Summary
•

You can open PageMaker by double-clicking on the PageMaker icon, doubleclicking on any PageMaker document, dragging a PageMaker document onto
the PageMaker application icon, or using a Macintosh launching utility.

•

The New... command lets you create a new publication and define all of the
attributes of your electronic pages. You can change any of these attributes
later, although it is best not to have to change the page size or margins.

•

Each open publication appears in a publication window, which displays one or
two pages from the file (depending on your use of the Facing pages option),
page icons for master pages and all publication pages, ru lers,·palettes, and a
pasteboard.

•

Any options you set when PageMaker is open but no publications are open are
saved as application defaults. Options set when a publication is open but the
arrow tool is selected are saved as document defaults.

•

The Preferences command and dialog box let you specify a number of attributes of your PageMaker environment, including the default measurement
system, control palette nudge amounts, layering of guidelines, and the font
and type size used in the story editor.

•

PageMaker's Save As command can be used to compress your publ ications,
and it allows you to transfer all files linked to the current publication to a single
location for easy transport. PageMaker regularly performs an automatic minisave, which reduces your chances for losing work in the case of an application
or system crash .

••••••••••••••••••••••••••••••••••••••••••••••••
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Publication
Window Basics
••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
•

Changing view sizes, zooming, and scrolling publications

II Adding, removing, numbering, and turning pages
II Controlling master pages
•

Working with column guides and ruler guides

•

Text and graphic objects

••••••••••••••••••••••••••••••••••••••••••••am••

Getting Around in PageMaker
PageMaker's electronic layout environment is legendary for the way it automates design
and production without changing the basic nature of these processes. Experienced
designers and production people find PageMaker familiar and intuitive because its
capabilities are implemented in natural and logical ways. People who have never before
formally created documents find PageMaker comfortable and natural as well.
Now that you've had an overview of PageMaker's commands and have seen how
publications are created and saved, you're ready to learn how to work in a PageMaker
publication window. The basic techniques introduced in the first part of this chapterzooming, scrolling, a nd turning pages- may seem trivial, but in reality they are vital to
the proficiency and productivity you achieve in PageMaker. You use them frequently,
and how adept you become at their subtleties will determine how quickly you can
create documents.
Other important basic skills are introduced in this chapter. Master pages help accelerate the creation of publications and ensure design consistency. Column guides, rulers,
and ruler guides also help with consistency while aiding in accuracy. Finally, you'lllearn
the many ways PageMaker lets you select text and graphic objects- another seemingly
trivial task that separates the good PageMaker users from the great ones.
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View sizes
PageMaker provides eight standard view sizes for use while creating publications and
lets you define custom view sizes to suit your needs. Each view size provides a different
level of magnification to the pages in the publication window: Enlarged view sizes
provide great detail but allow only small portions of a page to be displayed on screen;
reduced view sizes provide a view of an entire page or set of pages at one time but show
very little detail. Alternating between enlarged and reduced view sizes, which you can
do easily, makes it possible to precisely edit text and graphic details and still maintain
the overall sense of design and quality afforded by "the big picture." See Figure 6-1 for a
comparison.
Figure 6-1:
The Show pasteboard,
Fit in window, actual
size, 200%, and 400%
view size displays.
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The most basic way to change view sizes is to use the commands in the View submenu
in the Layout menu. When you use these commands, the display centers the new view
size based on what is centered in the current display (or, in the case of Fit in window,
the most recent display). Another way to change view sizes is to use keyboard and
mouse shortcuts or the zoom tool. With either of these methods, you can determine
what will be centered on the screen at the new view size by positioning the mouse at
this location before changing the view size.
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Here's a summary of PageMaker's eight standard view sizes:
•

Fit in window. This view size, selected automatically each time a new publication is created, reduces the currently displayed page(s) so that they are entirely
visible within the publication window, along with some of the surrounding
pasteboard. Select this view size using the keyboard equivalent of Command-W,
or you can hold down the Command and Option keys while clicking the mouse
button. (The mouse-button method will work only if the Fit in window view size
is not the current view size.)
The Fit in window view size is not tied to any specific reduction percentage,
because it is dependent on the size of your monitor. On a Macintosh Classic, for
example, the Fit in window view s ize is greatly reduced, whereas on a 21-inch
monitor it is almost equal to actual size. You'll usually use the Fit in window view
to get a good look at the overall layout of specific pages or your overall publication. It is also good to use when placing text and graphics or when moving text or
graphic elements around a page.

•

Show pasteboard. This view size was a hidden feature in previous versions of
PageMaker. Power-users called it "Fit in world," because it displays everythingthe current page(s) of the publication and the entire pasteboard surrounding
those pages. In PageMaker 5, you can now easily access it as the Show pasteboard command in the View hierarchical menu. It can also be selected by
holding down the Shift key while selecting the Fit in window command.

•

25% size. This view size displays the publication at 25 percent of its actual size.
The keyboard equivalent to switch to this view size is Command-D.

•

50% size. This view size displays the publication at 50 percent of its actual size. It

is used primarily to see a larger section of the publication than is possible at
75%, Actual, or 200% view size. The keyboard equivalent to switch to this view
size is Command-5.
•

75% size. This view size displays the publication at 75 percent of its actual size. It
is used primarily to see larger sections of the publication than are possible at
Actual or 200% view size. The keyboard equivalent to switch to this view size is
Command-7.

•

Actual size. The Actual size view size displays the publication on the screen at
exactly the size it was specified in the Page setup dialog box. Actual size is used
for most text and graphic editing. The keyboard equivalent to switch to this view
size is Command- I. Holding down Command-Option and clicking the mouse
button will change the view size to Actual size if it is not the current view size.

•

200% size. This view size is an enlargement twice the actual size of the publication. Normally, only a small portion of a page is visible at the 200% view size,
which is used primarily for text editing and precision placement of text and
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graphics. The keyboard equivalent to switch to this view size is Command-2.
Holding down Shift-Command-Option and clicking the mouse button will change
the view size to 200% if it is not already the current size.

•

400% size. The 400% view displays the publication on-screen at four times its
actual size. At this view size, it is extremely easy to position objects accurately or
edit text set in very small point sizes. The keyboard equivalent to switch to this
view size is Command-4.

To summarize, here are five different ways you can change view sizes in PageMaker:

1. Select a new view size from the View submenu in the Layout menu.
2. Press the keyboard equivalent for one of the view sizes.
3. Use a keyboard and mouse combination shortcut for one of view sizes.
4. Use the zoom tool (Command-spacebar or Command-Option-spacebar) and click
the mouse to zoom in or out.
5. Use the zoom tool (Command-spacebar or Command-Option-spacebar) and drag
to create a custom zoom size.

The new zoom tool
Another way to change view sizes is with the zoom tool, which is new in PageMaker
5. The zoom tool toggles through the view sizes and allows you to zoom in on specific
areas or elements of your pages.
To access the zoom tool, hold down Command-spacebar. The cursor will change to
a magnifying glass with a plus sign in its center. Point to the part of the page you want
centered in your new view size and click the mouse button to jump to the next level of
magnification (that is, if the view was at 25 percent, it will go to 50 percent; if it was at
50 percent, it will go to 75 percent, etc.) Pressing the Option key while still holding
down Command-spacebar will get you the magnifying glass with a minus sign in its
center. This works in reverse of the plus sign (surprise!)- click with this to move to the
next largest reduction.

,,

You can also use the zoom tool to perform what is known as an arbitrary zoominstead of clicking with the magnifying glass, use it to drag a selection rectangle
around the elements or area that you want to zoom in on. Release the mouse button
and Page Maker will enlarge the page so your selection fills the screen. In this case, you
are zooming in on certain items regardless of the degree of magnification necessary. In
some ways, this is the opposite of normal view size, where you first select a magnification size and then find out which page elements display at that view size.

- -
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The keyboard equivalents and mouse shortcuts for view size commands are shown
here:
View

Keyboard Shortcut

Show pasteboard

Shift-choose Fit in window

Fit in window

Command-Option-. or Command-W

Command-Option-Click

Actual Size

Command-Option-. or Command-1

Command-Option-Click

25% size

Command-O

50% size

Command-S

75% size

Command-7

200% size

Shift-Command-Option-. or Command-2

400% size

Command-4

Mouse Shortcut

Shift-Command-Option-Click

Scrolling the display
Since most view sizes display only a portion of the current page(s) on screen, you'll also
need to know how to adjust screen display. This can be done with the horizontal or
vertical scroll bars, the grabber hand, or by using the Command-Click method, or zoom
tool.
•

The scroll bars. As with all Macintosh scroll bars, you can adjust the vertical or
horizontal position of your current display using the scroll bars on the right and
bottom edges of the publication window. If the scroll bars are not visible, choose
the Scroll bars command from the Guides and rulers s ubmenu in the Layout
menu.
The scroll bars can be used in a number of ways: Pressing the up, down, right, or
left scroll arrow adjusts the display in small increments; dragging the box in the
scroll bar to the relative position that you would like to have displayed determines how much the display is changed; clicking in the gray area of the scroll bar
·
adjusts the display by about one-half its size.

•

Tite grabber hand. The grabber hand is a special cursor icon that is accessed by
holding down the Option key while pressing and holding down the mouse
button. When the grabber hand is activated, a movement of the mouse will move
the portion of the publication displayed in the publication window, as seen in
Figure 6-2. This is an excellent way to make fine adjustments in the display and is
generally preferred over the scroll bars, which are better suited to more dramatic changes in the display.
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Figure 6-2:
The g rabber hand
icon in action.

Holding down the Shift key while using the grabber hand constrains the display
movement to either horizontal or vertical movement only, depending on the
first direction moved with the mouse. The grabber hand icon disappears as
soon as the Option key is released, returning the cursor to its previous form.
•

Command-Click view size changes. As described in the previous section, if you
change view sizes by using the Command-Option-Click or Shift-Command-OptionClick method, you can specify the exact object that will be centered on the
screen. When working in Actual, 200%, or 400% view size, you can very quickly
zoom out to Fit in window, locate the element that you want to center in your
new display, and then zoom in on it directly. This can be faster than using either
the scroll bars or grabber hand when working in enlarged views.

•

The zoom tool. As with the Command-Click changes, you can often use the zoom
tool (Command-spacebar or Command-Option-spacebar) to quickly change sizes
and refocus on specific areas of the on-screen pages. And the arbitrary zoom
feature, described earlier in this chapter, is a great way to focus on exactly the
parts of your pages that you need to work on.

Turning the page
PageMaker's publication window displays only one page (or two pages if the Facing
pages option is selected) of your publication at any time. The highlighted page icon(s)
at the bottom of the display indicate which page(s) are currently displayed in the
publication window.
Changing the page(s) being displayed is as easy as selecting the appropriate page
icon(s) from the bottom of the publication window, as shown in Figure 6-3. The maximum number of page icons that fit along the bottom of the display depends on the size
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of your monitor. If they cannot all fit, arrows pointing left and right appear before the
first and after the last page icon, respectively. It may be necessary to scroll these icons
to locate the page that you need. This is done by clicking on the appropriate arrow.
Figure 6-3:
Page icons are used to select
the page or pages to display.
Left and right scroll arrows
appear when all page icons
do not fit on the screen.

When a new page icon is selected, the watch cursor will momentarily appear while
PageMaker reads information about the new pages from your disk and executes a minisave. The new page(s) will then appear on the screen. The selected page(s) will display
at the view size and screen position as when last saved or displayed.
If you hold down the Shift key while clicking the page icon, the new page will be

displayed at Fit in window size, regardless of the previous view size used. To
change the view size of all the pages in your publication at once, hold down the
Option key while choosing a view size from the View submenu in the layout menu.
It is also possible to turn the pages by choosing the Go to page ... command from the
Layout menu. This command brings up the Go to page dialog shown in Figure 64. Enter
the page number in the option box and then press Return or Enter or click the OK
button. The effect of this action is exactly the same as selecting a page icon, as described above. If you enter an unavailable page number, the alert dialog box shown in
Figure 6-5 will appear. Clicking the Cancel button in the Go to page dialog box returns
you to the currently displayed page.
Figure 6-4:
The Go to page dialog box.
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Figure 6-5:
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Holding down the Shift key when you choose the Go to page command puts
PageMaker into a ..slideshow mode" in which it flips from one page (or pair of
pages) to the next every few seconds until you click the mouse button. This can
be useful when you are looking for something and don't know which page it is
on or when you want to use PageMaker as a quasi-presentation tool.

Adding pages
While creating a publication, you may often find that you need more pages than are
currently available in the file. As long as the current publication has fewer than 999
pages, you can easily add any number of additional pages using the Insert pages ...
command from the Layout menu. Pages can be inserted before, after, or between the
currently selected pages -so you have to first turn to the page before, after, or between which you want to insert new pages before choosing the Insert pages ... command.
Once the command is chosen, the dialog shown in Figure 6-6 appears. Here, you specify
the number of pages that you wish to add and their position relative to the currently
selected publication page.
Figure 6-6:

The Insert pages dialog box.
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Click the OK button after making these selections to insert the pages. H you try to add
too many pages, forcing the publication size to exceed 999 pages, an alert dialog box
will appear, requiring you to modify your request. Also, you cannot add pages if they
will force the page number of the last page in the publication beyond 9999. Clicking the
Cancel button in the Insert pages dialog box returns you to the currently selected
page(s) without adding any pages.
The pages you have inserted- either before, after, or between the selected pageswill not affect the items already positioned on any existing pages. For example, if
threaded text blocks (described in Chapter 7, "Creating Text'') link pages 8 and 9, and
you have inserted two pages between pages 8 and 9, the threaded text will remain in
place, now flowing from page 8 to page 11, skipping pages 9 and 10. All following pages
in the publication are appropriately renumbered as soon as the new pages are inserted.
New pages display all master-page elements and guides.
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Another method of inserting pages is automatic: It is executed when text is being placed
using the Automatic text flow option. When text is autoflowing and more text remains to
be placed when the last page is filled, PageMaker automatically inserts pages, one or
two at a time, and the text autoflow continues. If the publication becomes 999 pages
long, the autoflow stops. The process of automatic text flow is also described more fully
in Chapter 7.

Removing pages
The process of removing pages from a publication is handled by the Remove pages ...
command in the Page menu. When this command is chosen, the Remove pages dialog
box appears, as shown in Figure 6-7, and you specify the range of page numbers to be
deleted. The default deletion range is the currently selected page(s). Any legitimate
page range can be specified, even every page in the publication. An alert dialog box
appears if unavailable pages are specified.
Figure 6-7:
The Remove pages dialog box.

Remoue poges

[

Remoue IIO!Je(s):

~

through:

0J

OK

H

( Concel )

Removing a page deletes the page and a ll items on that page. If you want to save the
elements, move them to the pasteboard before choosing the Remove pages .. . command. Click the OK button or press the Return or Enter key after selecting the page(s)
for removal.
Before deleting the specified pages, an alert dialog box like the one shown in Figure 6-8
warns you that removal of a page cannot be undone and allows you to cancel the
removal. Clicking the OK button causes PageMaker to delete the page(s). All following
publication pages will be renumbered appropriately after the deletion. Note that
deletion of an odd number of pages in a double-sided publication will cause subsequent
pages to switch sides - left pages will become right pages, and vice versa.
Figure 6-8:
The alert dialog box
that displays before pages
are deleted.
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Although you cannot undo the removal of pages, you can regain them by using the
Revert command, or more usefully the "revert to mini-save" option described in Chapter 5, "A Brief Tour of PageMaker."

W"orking with Master Pages _ __
Each PageMaker publication begins with one or two master pages, represented by the L
Oeft master page) and R (right master page) icons in the lower left corner of the publication window. Single-sided publications, which are made up only of right pages, have
only a right master page. Publications that have the double-sided option selected in the
Page setup dialog box have both left and right master pages.
Master pages hold text, graphics, and column and ruler guides that repeat on soine or
all of the publication pages in a document. By default, anything that you add to a master
page automatically appears on every corresponding Oeft or right) page in the document. Positioning these items on master pages, rather than on each individual page,
avoids the potential for error associated with retyping or repos itioning elements and
also minimizes file size.
Common uses for master pages include:

•

Headers. Master pages often carry running heads or footers, including rules,
chapter and book titles, and page numbers.

•

Design grids. Design grids are often set up on master pages, including column
guides and horizontal and vertical ruler guides.

•

Repeating elements. Page borders and common graphic elements, especially
company logos, are often positioned on master pages for flyers, handouts, or
transparencies.

To place text, graphics, or guidelines on a master page, select the master page icon in
the publication window. Master pages look and act exactly like all other pages of a
publication. Text can be created on the master page (using the text tool) or imported
(using the Place ... command). Graphics can be created on the master page (using one
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The page-number placeholder that appears on the master page will be replaced by the
actual page number on every page in the publication. Even though the page-number
character is only a single digit, page numbers up to four digits long will be properly
applied, depending on the page numbers assigned to your publication in the Page setup
dialog box. Be sure to account for the number of digits that might make up the highest
page numbers when deciding on the positioning and justification. For instance, in the
third example in Figure 6-9, the page number is centered under the graphic using the
centering command rather than visually adjusting it on the page. This ensures that
every page number will be centered, regardless of how many digits it contains.
If you are creating a double-sided publication, you must add the automatic

page-numbering character to both the right and left master pages. In many
cases, you can save time by first creating the text block for the page number on
one master page and then copying that text block and pasting it onto the other
master page. The automatic page-numbering marker will automatically switch
from LM to RM (or vice versa) when placed on the second master page.
The numbering style used by the page numbers in your publication is set by choosing
the Page setup ... command from the File menu and then clicking the Numbers ...
button. Select the numbering style you desire and click the OK buttons to return to your
layout. See Chapter 5, "A Brief Tour of PageMaker," for more information on the Page
numbering dialog box.

Master-page elements on publication pages
Once elements have been added to the master page(s), they will appear on the corresponding publication pages and will print on these pages exactly as if they had been
added to the pages directly. On the publication pages, master-page elements cannot be
selected- they are inaccessible, as if already printed on the paper.
It is impossible to move, delete, or edit individual master-page elements while working
on a publication page; however, it is possible to remove all the master-page e lements on
a publication page. Once removed, they will neither display nor print. This removal of
master-page elements is accomplished by choosing the Display master items command
in the Layout menu, which toggles the display of master-page elements on and off. A
check mark (\~ is displayed next to the Display master items command when the
master items are displayed and is removed when they are not displayed. This is commonly used to suppress running footers and page numbers on the first page of a
chapter or section.
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In many cases, you will wish to display only some of the elements from the master page.
Since PageMaker provides only ali-or-nothing control over master-page elements, many
users have found that a simple work-around technique allows selective deletion of
master-page elements in many cases.
To "remove" specific master-page elements without deselecting the Display
master items command, place a PageMaker-created graphic shape on top of the
master-page element to be hidden, filling the shape with the fill color Paper and
giving the shape a line weight of None. This creates an opaque mask that covers
the master-page element so that it will not display or print. Other elements can
even be placed on top of the masking shape, as long as they are a bove the mask
in the stacking order. An example of this is shown in Figure 6-10.
Figure 6-10:
Creating a
shape with a
" None" line
and "Paper"
fill allows
you to
selectively
mask
master-page
elements
from any
page of your
publication.

Hbrkinglin the r
Hbrking:

Guidelines and master pages
Besides holding text and graphics, master pages are most frequently used to set up a
design grid that is used on most or all pages of the publication. This grid is made of
column guides and ruler guides that are used as references for the placement and
positioning of text and graphics. These guides are placed on the master pages and
appear on corresponding publication pages, just like text and graphic master-page
elements.
Unlike text and graphic elements, however, guides from the master pages can be
repositioned or even deleted on each individual publication page. Ma nipulating guides
on any one publication page does not affect those guides as they appear on the master
pages or on any other publication page. Manipulating guides directly on the master
pages, however, immediately changes those guides as they appear on every publication
page except those on which the guidelines have been customized.
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The details of working with column guides and ruler guides on publication pages are
included in the next section of this chapter.

Printing master pages
lf you want to print just the items on a master page, create a blank publication page,

make sure the Display master items command is selected, and print the blank page.
This has the effect of printing only the elements of the corresponding master page. You
cannot print master pages directly. If you delete all of the page in your publication,
which is possible, the master pages will remain intact-but at that point you cannot
print them.

Guidelines and Rulers ------------------------Earlier, PageMaker's primary function was described as "allowing the precise positioning of text and graphics on a page." In this section, three important tools that
PageMaker provides to achieve this goal are introduced: column guides, ruler guides,
and the rulers themselves.

Colt•mn guides
The primary function of column guides is to act as the left and right margins for the text
blocks that you add to your pages. They can also be used to position or align graphics.
The number of column guides any page needs can be set individually, and you can
customize the placement of column guides on any page. Usually you'll begin by adding
column guides to your master pages so there is some level of consistency throughout
your publication, and then c ustomizing them on individual pages as necessary.
To add column guides to any page (including a master page) or to alter existing column
guides, select the Column guides ... command from the Layout menu. The Column
guides dialog box, as shown in Figure 6-11, will appear. Beware that the Column guides
command will be dimmed if the Guides command (in the Guides and rulers submenu)
isn't selected. You can tell when this command is not selected because no column
guides or ruler guides will be visible on any pages.
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The Column guides dialog box contains two options: Number of columns and Space
between options. When opened, the current specifications of any existing column
guides on the current page will be displayed. If the existing column guides have been
customized (moved to new positions), the word Custom will appear in the Number of
columns option box. A page can have up to 20 columns, and the space between columns can be any value less than a certain ratio determined by the number of columns.
If only one column is defined, the Space between columns value is ignored.
Figure 6-11:
The Column guides
dialog box as it
appears when not
using facing pages.

Column guides

I[

D

OK

[ Cancel ]
Number or t:olumns:

Hyour document has facing pages, PageMaker assumes that you wish to set the column
guides identically for both of the facing pages (see Figure 6-12). 1f this is not the case,
and you want to create unique column-guide specifications for the left and right pages, select
the Set left and right pages separately option, and the Column guides dialog box will then
display separate option boxes for the left and right pages, as shown in Figure 6-13.
Figure 6-12:
When your publication uses the Facing
pages option, you
have the choice of
creating column
guides identically or
seperately for left and
right pages.

Figure 6-13:
The Column guides
dialog box as it
appears when the Set
left and right pages
seperately option is
selected.

n

Column guides

OK
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[ Cancel ]
Number of columns:

Column guides
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Number of columns:

11
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II•

OK

II~~
0
IInches
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left and right pages separatel y

II

[ Cancel ]
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When the OK button is clicked, PageMaker calculates the width of each column and
then draws the column guides on the page. Column guides are represented by blue
lines on color monitors and by dotted vertical lines on grayscale displays- single lines
for the leftmost and rightmost column guides (those automatically placed on the left
and right margin lines) and double-line guides representing the adjacent edges of
columns (with the double lines separated by the value specified for the Space between
option), as shown in Figure 6-14. Since the leftmost and rightmost column guides are
placed directly on top of the existing margin guides, they appear as darker lines.
Columns created by the Column guides dialog box are always equally spaced between
the left and right page margins; however, once the column guides have been created,
they can be repositioned manuaJiy so that they are not equally spaced. Like other
PageMaker elements, column guides are dragged to a new position.
Figure 6-14:
A page with three columns- two
double lines in the center and two
single lines over the margins.
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To reposition a column guide, press and hold the mouse button while positioning the
arrow tool on the column guide (in the case of double-line column guides, point directly
at one of the lines). The cursor will become a double-sided arrow when you have
successfully selected the column guide and will remain a double-sided arrow as long as
the mouse button remains depressed. The column guide can now be repositioned. Use
the small dotted lines that track the location of the cursor (shown in Figure 6-15) on the
rulers to help position the column guides. If the control palette is open, the exact
location of the column guides will be displayed there. Column guides must be at least
one pica away from another column guide.
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Figure 6-15:
Moving one of the column guides
by dragging with the arrow
cursor.
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Rulers
PageMaker's vertical and horizontal on-screen rulers assist you in accurately executing
your design specifications by helping you to accurately size and position elements. The
rulers are displayed or hidden by using the Guides and rulers submenu in the Layout
menu (Command-R). When the Rulers command has a check mark (.,f) in front of it, the
rulers are displayed; choosing the Rulers command will then hide the rulers. When the
Rulers command does not have a check mark in front of it, the rulers are not displayed;
choosing the Rulers command will then display the rulers.
Both the horizontal and vertical rulers include tick marks, which divide the ruler into
subunits. The units in the horizontal ruler are determined by the measurement system
option, and the units in the vertical ruler are determined by the vertical ruler option,
both of which are found in the Preferences dialog box. You can set both the horizontal
and vertical rulers to use the same measurement system, or you can use different
systems in the two rulers. See Chapter 5 for a complete discussion of the measurement
system options.
As you change view sizes while working on your publication, you'll notice that the
rulers and the tick marks in the rulers are enlarged and reduced along with your
publication pages, as illustrated in Figure 6-16. As a result, the amount of space marked
by the distance between any two tick marks is not consistent but is dependent upon the
current view size. It is also affected by the size and resolution of your monitor and, of
course, the currently selected measurement systems.
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Figure 6-16:
Ruler tick marks change
with the view sizes. The
decimal inch ruler is
shown (top to bottom)
at Show pasteboard, Fit
in window, 500Al, 75%,
Actual, 200%, and
400% view sizes. Note
that the Fit in window
size and 50% size are
similar, due to the size
of the monitor.
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The space represented by the distance between tick marks at the various view sizes in
the various units of measure are listed here:
Vlewslze

Inches

Decimal

Millimeters

Pleas

Fit in window

118:5

0.1:5

5.0mm

1 pica

50% size

118:5

0.1:5

5.0mm

6 points

75% size

1/16:5

0.05:5

1.0mm

3 points

Actual size

1132:5

0.05:5

1.0mm

3 points

200% size

1132:5

0.05:5

0.5 mm

1 point

The current position of the cursor is constantly tracked in both the horizontal and
vertical rulers by small dotted lines. These lines make it easier to position elements
accurately and therefore reduce the need for column and ruler guides. Theoretically,
elements that are precisely aligned to tick marks in the rulers are accurate to l444o inch
(or 0.0002 inch, 0.001 mm, or 0.016 point). Items aligned between two tick marks on the
ruler are positioned less accurately. In reality, the precision of your output device,
which depends on both its resolution and physical condition, affects the precision of
such exacting s pecifications.
To help you position objects so that they are precisely aligned with a ruler tick mark,
PageMaker provides the Snap to rulers command in the Guides and rulers submenu of
the Layout menu. When this command is selected, as indicated by the presence of a
check mark (-./) in front of the command, it is impossible to position objects between
ruler tick marks - the edges of the object nearest the cursor will automatically ,.snap"
to the nearest ruler tick marks, vertically and horizontally. Since the number of tick
marks dis played varies with the current view size, you can place objects more precisely
by enlarging the view size.
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To turn on the Snap to rulers command, choose the Snap to rulers command (Command-[) from the Options menu. The Snap to rulers command will display a check mark
in front of it when selected. To turn off the Snap to rulers command, again making it
possible to position objects freely, choose the Snap to rulers command again. The
check mark before the command disappears and the zero-point marker reappears.

Measuring with the ruler
When using a ruler to measure a distance in real life, you place the zero point of the
ruler at the beginning of the distance and read the measured distance from the tick
marks on the ruler. Only in cases where it is impossible to position the zero point at the
beginning of the distance being measured are you forced to calculate the distance
between two points by subtracting the nonzero value at the beginning of the measured
distance from the value at the end of the measured distance. For example, if the measured distance starts at 1.5 inches and ends at 4.75 inches, your measured distance is
4. 75 - 1.5 =3.25 inches.
To measure distances on PageMaker's electronic page, you use the same technique,
except that instead of moving the ruler so that the zero point is aligned with the beginning of the distance to be measured, you change the position of the zero point without
physically moving the ruler itself. For any new single-sided publication, the zero point of
both the horizontal and vertical rulers is at the upper left-hand corner of the electronic
page. For double-sided publications, the zero point is located at the top of the electronic pages and centered between them. The default zero point is shown in Figure 6-17
for both a single page and facing pages.
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Figure 6-17: The location of the default zero points for single- and facing-page displays.
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To reset the zero point, drag the zero-point marker from the upper left comer of the display
(in the corner between the vertical and horizontal rulers) and position it at the point on
the display that you wish to align with the horizontal and vertical zero points of the
rulers. As the zero-point marker is dragged, perpendicular lines extend across the screen
so that the new zero point can be aligned precisely, as shown in Figure 6-18. As soon as
the zero-point marker is released, both rulers are redrawn with the new zero point.
Figure 6-18:
Repositioning the zero
point of the horizontal and
vertical rulers.
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Since resetting the zero point is so easy, you can use it to measure the size of graphic
elements, to accurately position text blocks, and to measure and position column and
ruler guides. Sometimes, however, you may want to set the zero point of your ruler at a
precise location from which it cannot be moved, either intentionally or accidentally.
PageMaker allows you to lock the zero point so that it cannot be moved without purposely unlocking it.
To lock the zero point, choose the Zero lock command from the Guides and rulers
submenu of the Layout menu. The zero-point marker will disappear from the upper left
corner of the display, making it impossible to select and reposition it. The Zero lock
command displays a check mark in front of it as long as it is selected. To unlock the
zero point and again make it possible to reset the zero point, choose the Zero lock
command again. The check mark before the command disappears and the zero-point
marker reappears.

Ruler guides
As we've seen, the vertical and horizontal rulers displayed in the publication window
help you locate any position on the screen or measure any distance. In addition to
these, you can also create ruler guides or guidelines to assist with the positioning and
alignment of elements. Ruler guides are nonprinting dotted lines-much like column
guides and margin guides- that can be freely created and positioned on publication
pages in order to create reference points for the positioning and alignment of text or
graphic objects.
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Ruler guides are created by dragging from inside the horizontal or vertical ruler out into
the publication window, as shown in Figure 6-19. As soon as the c ursor leaves the ruler
and enters the publication window, a rule r guide becomes visible as a cyan line on color
monitors or a dotted line on grayscale monitors, being positioned by the drag. Ruler
guides can be created only when the Guides command in the Rulers and guides
submenu of the Layout menu is selected (when there is a check mark in front of the
command). It does not matter which tool is currently selected in the toolbox when
guides are created. Up to 40 ruler guides can be created on a single page or set of facing
pages, including both horizontal and vertical ruler guides. Ruler guides created on the
associated master pages, whether displayed or not on the publication page, count
toward this total.
Figure 6-19:
Ruler guides are created by
dragging them out of the
rulers into position on the
publication page.
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Ruler guides are most often used to mark some location that is measured from the
rulers. Since the zero point of the rulers is often changed while creating a publication,
marking a particular position with a ruler guide avoids having to relocate it every time
you want to position or align an element with this point. Ruler guides are especially
useful on master pages, where they can designate specific boundaries or positions that
should be observed on most pages.
Ruler guides can be repositioned at any time by dragging them as required. With the
arrow tool, click and hold the mouse button on the ruler guide; the arrow then becomes
double-sided and can be dragged in either direction. To remove a ruler guide, drag it
back into the ruler and release the mouse button.

More about guides
As mentioned earlier, column guides and ruler guides can be created on master pages

exactly as on any other publication pages. Guides created on master pages automatically appear on each corresponding publication page, just as text and graphic elements
do-but with one important difference. Text and graphic elements placed on the
master pages cannot be moved or deleted directly on publication pages; but column
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and ruler guides that appear on publication pages by virtue of their inclusion on master
pages can be moved and deleted directly on the publication pages. Changing the guides
on any publication page does not affect the position of the guides on the corresponding
master page or on any other publication pages. Column and ruler guides from the
master pages can be thought of as the "starting point" for guides on each of the corresponding publication pages, rather than as literal elements.
In the course of using PageMaker you will sometimes modify the ruler guides provided
by the master pages as they appear on individual pages, and you will sometimes add
additional ruler guides to individual pages. Occasionally after making one of these
modifications, you'll want to get rid of these changes and return the ruler guides to their
original state as defined on the corresponding master page. You can do this very easily,
by using the Copy master guides command on the Layout menu. Choosing this command reverts all column and ruler guides to be exactly as on the corresponding master
page- any movements, deletions, and additions made to the guides are removed. The
Copy master guides command, is dimmed if all column and ruler guides are already set
exactly as they are on the corresponding master page. Immediately after choosing the
Copy master guides command, you can choose the Undo command from the Edit menu
to return the guides to their customized positions.
Column guides, ruler guides, and margin guides are normally displayed on-screen as
you work. These guides can be distracting, however, when you are trying to envision
the look of the publication without them. You can hide the guides at any time by
deselecting the Guides command in the Guides and rulers submenu of the Layout menu.
This command toggles the display of the guides on and off, as shown in Figure 6-20.
When the guides are hidden, the Snap to guides, Lock guides, and Column guides ...
commands are dimmed and cannot be used.
Hiding guides also makes it impossible to add new column guides or to select
existing guides. When guides are hidden, you can add new ruler guides by
dragging them out of the rulers, but as soon as you release the mouse button,
they become invisible. If you don't realize that your guides are hidden, this can
be confusing as your guidelines seem to disappear.
The Preferences dialog box, brought up by choosing the Preference ... command in the
File menu, contains a Guides option that determines the relationship of all guides to text
and graphic elements on the page. When the Front option is selected, guides will be
automatically at the top of the stacking order and therefore easy to select. When the
Back option is selected, guides are placed at the bottom of the stacking order, and in
order to select them, you will have to either move any items that overlap them or select
the guides at a point at which they are not overlapped.
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Figure 6-20:
The Guides
and rulers
command
from the
Layout menu
removes all
column
guides, ruler
guides, and
margin
guides from
the display,
as shown on
the right.
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Guides do not print, regardless of whether or not they are displayed on the publication
page.
Most column guides and ruler guides are created to assist in the positioning or aligning
of text or graphic elements on the page, and since you usually want to position an
element exactly at the guide(s), PageMaker's column guides and ruler guides have a
"magnetic" quality. This magnetism is activated by choosing the Snap to guides command (Command-U) from the Guides and rulers submenu of the Layout menu. The
command toggles on and off the magnetic pull of the guides. When a check mark (>/)
appears before the command, all guides on the displayed page will act as magnets to
any elements positioned very close to guides, Any element being positioned within two
pixels of a guide is pulled to the exact position of the guide - elements already in place
are unaffected by turning on the Snap to guides command. This is a useful feature in
most cases, saving you the trouble of performing exacting placement with an
unexacting mouse,
The magnetism of guidelines may be unwelcome in some cases. For example, you may
want to position an element based on some alignment other than the existing guides,
intentionally close to, but not exactly aligned with, one of the guides, Choosing the Snap
to guides command (Command-U) from the Options menu (removing the check mark)
toggles off the magnetism of t he guides so that elements can be positioned very close
to, but not exactly aligned with, guides on the page, as shown in Figure 6-21.
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Figure 6-21: With the
Snap to guides command chosen, it is
possible to position this
text block very close to
the column guide and
margins without having
it snap into them.
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Column and ruler guide security
Because column guides and ruler guides can be selected and positioned just like any
text or graphic element, it is possible to select and move them accidentally while trying
to select other elements. There are four ways to avoid this:
If you hold down the Command key while selecting objects, it becomes impossible to select ruler guides or column guides. The Command key temporarily
locks the ruler guides and column guides in place.
To permanently lock ruler guides and column guides in place so they cannot be
selected and moved either intentionally or accidentally, select the Lock guides
command in the Rulers and guides submenu of the Layout menu. The command
(located in the Guides and rulers submenu of the Layout menu) toggles on and
off the ability to select column and ruler guides. A check mark (..J) appears before
the command when it is selected (and the guides are locked).
Another technique for making it more difficult to accidentally select ruler guides
is to use the Guides in back option in the Preferences dialog box. When this
option is selected, it is difficult to select guides when they are overlapped by other
objects, but they remain easily selectable wherever they are not overlapped.
Finally, you can hide the guides by deselecting the Guides command in the
Guides and ruler submenu of the Layout menu. This makes them temporarily
invisible and impossible to select.
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Manipulating Elements
Every page in a PageMaker publication is a collection of text and graphic elements.
Some are created in other applications and imported into PageMaker whereas others
are created within PageMaker itself. In any case, the ability to collect these text and
graphic elements from a variety of external sources, add new internally created elements, and then manage the arrangement of these many elements is really the definition
of what PageMaker does. So it is very important that you understand how to control
elements both individually and in groups.
This section examines the basics of element control: the mechanical logistics of selecting, arranging, moving, copying, and deleting text or graphic objects. By the way, for the
sake of a little variety, the words "elements," "objects," and "items" are used interchangeably in this discussion. They all refer to text blocks or graphics that exist within
PageMaker.

Element layers: the stacking order
Not surprisingly, if you add one element to a page in a PageMaker publication and then
add another element in exactly the same spot, the latter element will overlap the
former. This idea that every element you add to your publications is layered in relation
to every other element is important, even though layers are not obvious when elements
don't overlap. (See Figure 6-22.)
You can tell how objects are layered on any page of your publication by watching the
order in which elements are drawn when you first turn to a particular page or change
view sizes. The inherent layering of elements also comes into play during printing, when
"lower" objects are sent to the printer before "higher" objects. If you experience printing errors, you can infer something about which page elements are causing the problem
by how long it takes after printing begins for the error to occur.
Figure 6·22:
Each text or g raphic
object on a page is
situated on a unique
layer. When objects
overlap each other
physically, the front
most object will cover
underlying objects.
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PageMaker's hierarchical order of objects, demonstrated by the order in which objects
are drawn when the screen is refreshed and the way in which objects overlap physically,
is called the stacking order. It is important to be aware of the stacking order because it
affects the manipulation of objects, as I will discuss in the following sections.
The following principles apply to the stacking order:
•

Newly created objects are automatically placed at the top of the stacking order,
above all other objects that already exist on the page. If an older object is
repositioned to overlap a newer object, it moves to the top of the stacking order.

•

The Bring to front command in the Element menu (Command-F) moves a selected object to the top of the stacking order.

•

The Send to back command in the Element menu (Command-B) moves a selected object to the bottom of the stacking order.

•

The stacking order of elements on the master page(s) is independent of the
stacking order of elements on publication pages. Moreover, by definition, the
stacking order of master-page elements is always placed below the stacking
order of all elements on the publication page- including publication-page
elements that have been moved with the Send to back command.

•

Column guides and ruler guides are positioned either above or below each
object on a page according to the current setting of the Guides option in the
Preferences dialog box. When guides are above text and graphic objects, they
are easy to select and reposition. When they are behind all text and graphic
elements on a page, you are less likely to select them by mistake when trying to
select a text or graphic element. In fact, it is impossible to select guides that are
covered by any object when guides are set behind objects. To select them, you
must do so at a spot where they are not overlapped.

Selecting elements
The action of "selecting" an element is a fundamental skill in the Macintosh interface. In
most Macintosh software, you select an object by clicking on it with some kind of
pointer tool, usually an arrow tool. Once selected, the object is highlighted or marked in
some way as a visual confirmation of its selection. A selected object can be the object of
various menu, dialog, mouse, and keyboard commands.
PageMaker employs these basic Macintosh selection concepts plus some more
advanced ones. PageMaker has two independent levels of selection -selection of an
object itself, such as a graphic or text block, and selection of text inside a text block.
This section covers the selection of objects. Text selection is discussed in Chapter 9,
"Formatting Text."
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When an object is selected, handles become visible around the object, as shown in
Figure 6-23. A selected text block shows horizontal handlebars at the top and bottom
with solid rectangular handles at the four corners; a line shows a solid rectangle at each
end; a shape is surrounded by eight solid rectangles; and an imported graphic shows a
solid diamond at each corner.
Figure 6-23:
A selected line, shape,
and text block.

D

select~ text
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Objects and groups of objects can be selected in a variety of ways:
•

Using the arrow tool. The arrow tool can be used to select a single object, a group

of objects, and objects that are partially or fully overlapped by other objects.
To select a single object, select the arrow tool from the toolbox, and click anywhere
on a text or graphic element to select the element. Graphic objects created in
PageMaker with no interior shading can be selected only by clicking on their
edges. As soon as you select an object, all other objects become deselected.
To select more than one object, hold down the Shift key while selecting objects.
This will select the new object and the previous selection will not become
deselected -the newly selected object is instead added to the selection.
To select objects that are completely or partially overlapped by other objects
(as shown in Figure 6-24), hold down the Command key while clicking over the
overlapped object. Each mouse click will select the object one layer lower in
the stacking order. Normally, you might select the top object and then use the
Send to back command from the Edit menu to change the stacking order.
Command-selecting overlapped objects is a much faster method.
Figure 6-24:
An object that is completely
overlapped by another can be
selected by holding down
the Command key and
repeatedly clicking on the
overlapping object.
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Creating a marquee. The marquee, shown in Figure 6-25, is a powerful tool for
selecting objects that may be difficult to select using the arrow tool or for quickly
selecting a specific group of objects.

Figure 6-25:
Dragging a marquee with
the arrow tool selects all objects
completely enclosed by the
marquee.

------ - ----- -------- ------- ~

----------------- :'

selected text
- -- -- -- --------- - ------ - -- - ·~

A marquee is created by positioning the arrow tool in any blank space on the
publication window, holding down the mouse button, and then dragging the
arrow tool while keeping the mouse button depressed . As this is done, a dashed
rectangle, called a marquee (because of the way the dashed line moves around
the border), is formed. All objects enclosed completely within the marquee that
you create become selected. Objects contained only partially within the marquee
will not be selected .
It is usually easy to determine if a graphic object is entirely contained within a
marquee as it is being created, but it is more difficult to tell if a text block is
completely contained. This is because the handles of a text block are not displayed unless the block is already selected, and these handles often extend left
and right far beyond the visible te>.1:. When using the marquee to select text
blocks, be sure to create a large enough marquee to enclose the entire text block.
When objects are selected with a marquee, all other objects are normally deselected. If you hold down the Shift key while creating a marquee, the newly
selected objects will be added to the current selection - the previous selection
will not become deselected.
•

Using the Select all command. The Select all command is a fast way to select a
large number of objects. As long as the text tool is not selected, choosing the
Select all command (Command-A) from the Edit menu selects all objects on the
currently displayed page(s) and on the pasteboard surrounding these pages (see
Figure 6-26). If the text tool is selected and the text insertion point is in a text
block, all text in that text block is selected. If the text tool is selected but the
insertion point is not set within a text block, nothing happens.
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The Select all
command selects all
elements on the
current page(s) and
pasteboard, except
master-page items.
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Deselecting elements
It is aJso important to know how to deselect objects, so you don't accidentally modify them
or delete them, and because the selection handles can be quite distracting to look at.
There are several ways to deselect an object or objects:
•

To deselect everything, position the cursor on any blank space in the publication window and click. All elements will be deselected.

•

To deselect everything, select any tool from the tool palette except the rotation
tool. This immediately deselects aJl currently selected objects. The rotation tool
doesn't deselect objects because it assumes you want to rotate the selected
objects.

•

To deselect some but not all objects, hold down the Shift key and click the arrow
tool on a selected object. The object will become deselected without affecting
any other selected objects.
This technique, in combination with either the Select aJl command or the
marquee discussed above, makes it possible to quickly select most (but not all)
of the elements in an area or on a page. To do this, create a marquee or use the
Select aJl command to select all the objects in the area or page. Then, hold
down the Shift key and click on the selected elements that you want to deselect.
This subtractive process is often a much faster way of selecting a large number
of objects.
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Moving elements
While creating a publication, you will frequently need to reposition and adjust the
placement of both text and graphic objects. Sometimes this is true because your initial
placement was inexact, other times it is due to an alteration or improvement in your
design. In any case, it is not difficult to reposition elements at any time. In fact, the
interactive and impermanent nature of a PageMaker layout is one of its best features.
Before moving an object you must first select it, as described above. There are then
three ways of moving objects:
•

Dragging the object into position. With the arrow tool located anywhere on the
selected object except on one of its handles, click and hold down the mouse
button and then drag the object(s) to the new position. (Clicking on a handle will
change the size of an object, not its position.) If you hold down the mouse button
for a few seconds before moving the mouse, you will be able to see the objects
that you are repositioning while you drag them. If you begin to move the mouse
as soon as you press down the mouse button, you will see only a box marking
the outline of the selected object(s).
Pressing the Shift key before or during a move constrains the movement either
horizontally or vertically, depending on the initial direction of the drag (see
Figure 6-27). This technique can be used to preserve the vertical alignment of
an object while repositioning the object horizontally, or vice versa. You can
also release the Shift key during a move to eliminate the constraint, or press the
Shift key during an unconstrained move to add a constraint to the remainder of
the move. If you inadvertently begin the move in the wrong direction, undo the
move (Command-Z) and begin a new, constrained move.
To position objects precisely, work at as large a view size as is practical. Create
vertical and horizontal ruler guides to indicate the new position before you move
the object. Then use the Snap to guides and Snap to rulers commands from the
Edit menu as necessary. If you get the element positioned precisely in one
direction, press the Shift key to keep this alignment while continuing to adjust
the position in the other direction.

Figure 6-27:
Holding down the Shift key
while dragging an object
constrains the move in the
first d irection dragged.
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Another way to improve the precision of object placement is to work with the
control palette, introduced in Chapter 13, "The Control Palette." Using the
control palette, you can numerically set the position of any element or change
the position of an element by moving it up, down, right, or left, by a specific
amount.
•

Cut and Paste. To make dramatic moves, such as moving an element to a page
that is not currently displayed, use the Cut and Paste commands from the Edit
menu. After the object(s) to be moved have been selected, choose the Cut
command (Command-X) from the Edit menu. This removes the objects from the
current page and places them on the Clipboard. Turn the page or adjust the
display so the new location for the object is visible and then choose the Paste
command (Command-V) from the Edit menu. A copy of the object is transferred
from the Clipboard and added to the current page. You can now drag the object
into position, using the techniques described above.

•

Dragging between pages. To move objects between pages, drag them to the
pasteboard, turn the page, then drag them into position on the new page. Be sure
that the objects are positioned completely on the pasteboard before turning the
page; otherwise, they will remain on the original page. This method is well suited
to moving large, complicated objects, which can occasionally cause a system
crash when moved using the Cut and Paste commands.
This can also be useful when you need to move an object or group of objects off
one page but are unsure as to where they will finally be needed - leave them on
the pasteboard as long as you like. Once you determine where they belong, you
can select them and drag them into position.

•

Dragging between publications. To move elements from one publication to
another, open both publications and position their windows so that each is
visible. You can use the Tile command in the Window menu to do this automatically. Select the elements you want to move and then drag them over to the
other publication. As you drag to the edge of the first window, PageMaker will
start to scroll the display, thinking at first that you want to position the selected
elements elsewhere on the page or pasteboard. Continue dragging so that your
cursor leaves the first window and is then clearly positioned in the second, and
the selected elements will appear. Release the mouse button when the elements
are in position.

Copying and pasting objects
By copying an object you can both ensure consistency in your publication and avoid
the effort of recreating the object. This is especially useful for any graphic object whose
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consistent size is important, such as a line spanning the column width or boxes of a
certain size around photographs or illustrations.
To duplicate an object or group of objects, select the object(s) and choose the Copy
command (Command-C) from the Edit menu. The Copy command will be dimmed if no
object is currently selected. Turn the page or adjust the view size, if necessary, and
then choose the Paste command (Command-V) from the Edit menu. The duplicate
object(s) will appear in the center of the current display, selected, and the arrow tool
will be selected in the toolbox. Drag the pasted object into position as desired.
When your publication makes frequent use of certain text or graphic objects, such as
rules, photo boxes, or other ornaments, it is often a good idea to keep a copy of each on
the pasteboard, copying it for use whenever it is needed in the publication, as shown in
Figure 6-28. This saves the time and trouble of searching through the publication for the
last occurrence in order to make a copy every time one is needed.
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Figure 6·28:
Keep commonly
used text and graphic
objects on the
pasteboard for easy
access.
···:·········
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The Copy command makes a duplicate of all selected objects and places them in the
Macintosh Clipboard, shown in Figure 6-29. The Paste command makes another duplicate of the objects in the Clipboard and places the second copy on the displayed page.
Since the original copy remains in the Clipboard after the duplicate has been pasted,
the objects in the Clipboard can be pasted repeatedly- until another object or group
of objects is placed in the Clipboard by using the Cut or Copy command. Objects
remain in the Clipboard as long as your Macintosh is turned on, even after you quit
PageMaker. Therefore, it is not necessary to paste the objects immediately after copying- you can turn the page or reposition other elements. In fact, you can choose any
command except Cut or Copy without disturbing the Clipboard contents.
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The Library palette
Another way to organize frequently used items is to store them in the Library
palette, an Aldus Addition accessed via the Window menu. The Library palette can
store any text or graphic element, and you can save libraries to disk or load existing
libraries from disk so your element collections can be used in many different publications.

I

Moving an element or group of selected elements to the Library palette is easy: just
select the element(s) and clkk the plus sign button in the Library palette. If you want to
give the elements a name or use keywords that will help you search for them later,
double-click on the copy of the element in the Library palette window.
To transfer any item from the Library palette back onto any page in your publication, tum to the appropriate page and then drag the element out of the Library palette
and onto the page, and then release the mouse button. As you drag the cursor onto
the page, your cursor will appear as a "loaded gun" icon, indicating that you are about
to place a new element on the page. Unlike other similar icons used by the Place
command, however, this one releases the element when you let go of the mouse
button rather than when you click on it.
More information on the Library palette can be found in Chapter 15, "Aldus
Additions."

- - --"-- -- ----= ---- ·-

Figure 6-29:
The Clipboard can
be made visible by
choosing the Show
Clipboard command
from the Edit m enu.
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The Multiple paste command lets you make any number of copies of the current
Clipboard objects and position them at some specified horizontal and vertical offset
from the original objects. To use the Multiple paste command , select the objects you
want to work with and then choose the Copy comman d. Next, choose the Multiple paste
command from the Edit menu and the Multiple paste dialog box will appear, as shown
in Figure 6-30.

~
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Figure 6-30:

Multiple p11ste

The Multiple paste
dialog box.
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Enter the number of copies you want in the Paste o ption box and then specify the
horizontal and vertical offset you want applied to each of your copies. Selecting a
horizontal offset of .25 inches and a vertical offset of .40 inches, for example, results in
the multiple paste effect shown in Figure 6.31. Note that you cannot specify a horizontal
or vertical offset when using the Multiple paste command with text.
Figure 6 -31 :

The results of a multiple paste.

Holding down the Option key while choosing the Multiple paste command
executes the multiple paste without opening the Multiple paste dialog box. The
options entered the last time the dialog box was used are applied.
To perform a manual version of the multiple paste, select any objects and copy
them to the Clipboard. Then press Command-Option-V to paste one copy. Drag
this copy to a new location and then press Command-Option-V repeatedly to
paste s ubsequent copies. Each will be placed at the s ame horizontal and
vertical offset as the first copy that you positioned manually.

Deleting elements
Selected elements can be deleted in three ways:
•

Choose the Cut command (Command-X) from the Edit menu. This removes the
selected objects, but places them on the Clipboard so that they can be pasted
somewhere else. If you choose the Cut command by mistake, choose the Undo
command (Command-Z) from the Edit menu to restore the deleted object(s).
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•

Choose the Clear command from the Edit menu. This removes the selected
objects but does not place them on the Clipboard. This is often used when you
need to delete an object or group of objects but do not want to lose the current
Clipboard contents. If you choose the Clear command by mistake, choose the
Undo command (Command-Z) from the Edit menu to restore the deleted
object(s).

•

Press the Backspace or Delete key on your keyboard. This is equivalent to
choosing the Clear command. The deleted objects are not placed on the Macintosh
Clipboard but can still be restored by choosing the Undo command (Command-Z)
from the Edit menu. This too can be used when you need to delete an object or
group of objects but do not wish to lose the current Clipboard contents.

Undo and Revert ---------------------------------"I wish I hadn't done that." For all the times that you find yourself thinking these words,
PageMaker provides two special commands: Undo and Revert . These commands
reverse the last action or series of actions performed on your document. PageMaker
also provides a hidden command called Revert to mini-save, which you can use when
the Revert command is too dramatic.

Undo
The Undo command (Command-Z) in the Edit menu reverses the last action taken in
your publication. Not all actions can be reversed, but most actions that affect the layout
of your publication or its contents can be, including any actions that do not have a builtin opposite action.
It is possible to use the Undo command to cancel the following:
•

The repositioning of any text or graphic object or guide.

•

The resizing of any text block or graphic.

•

The cropping of any imported graphic.

•

Any use of the Cut or Copy command. (The Paste command can be undone by
simply deleting the pasted objects.)

•

Changes made in the Insert pages, Remove Pages, or Page setup dialog boxes.
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It is not possible to use the Undo command to cancel the following:
•

Any changes made using commands from the Type menu.

•

Any changes made using the Lines or Fill commands.

•

Changes in view size or display.

•

Selections or deselections of objects.

•

Any use of the Save or Revert commands.

To use the Undo command (Command-Z), simply choose it from the Edit menu. The
most important thing about using the Undo command is that you must use it immediately after you perform the original mistaken action. Since the Undo command can
reverse only your last action, any action taken, however minor, after the mistaken one
will be reversed by the command, making it impossible to reverse your mistaken action.
For example, suppose you move some objects by dragging them with the arrow tool
and then decide that you are unhappy with the new position and would like to return
them to their original position. You must choose the Undo command as soon as you
release the mouse button after dragging the objects- if you click the mouse button or
choose another tool from the toolbox, you can no longer reverse the r elocation of the
objects. The Undo command will simply deselect the tool you have clicked on.
When the last action performed can be reversed, the Undo command will read Undo
action, where the word action specifies the particular action that will be undone by
selecting the command. When the last action performed cannot be reversed , the Undo
command is dimmed.
Immediately after you have used the Undo command and your last action has been
reversed, the Undo command becomes the Redo command - allowing you to negate
your use of the Undo command . The Redo command will read Redo action, where the
word action specifies the particular action that will be redone by selecting the command. Several examples are shown in Figure 6-32. After you choose the Redo command
(Command-Z) from the Edit menu, the Undo command reappears- it is then possible
to reverse the action of the Redo command, again undoing the original action (which
was just redone).

Revert
Suppose you revise your document by performing a series of actions. After making
these changes, you may decide that the publication would look better in the original
layout. Since you have performed several actions, you cannot use the Undo command

Chapter 6: Publication Window Basics

143

Figure 6-32:
A variety of the
possible Undo and
Redo commands.
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to restore it to that layout. You may not even remember precisely how the document
looked. But PageMaker does. The Revert command returns your document to its exact
form immediately following the last save operation with the Save command or the last
mini-save. This is useful when you have made important changes in your document that
you now regret, such as deleting pages or important elements, editing text content, or
rearranging page elements.
Mini-saves are performed automatically whenever you turn the page in your publication,
click on the current page icon , change the page setup specifications, or click OK in the
Define styles dialog box. Information from the mini-save is kept in a temporary file on your
disk so PageMaker can access it if you request to revert to the last mini-save or in the
case of a system crash.
To revert to the last mini-save, hold down the Shift key and choose the Revert
command from the File menu. The Revert to last mini-save? dialog box, shown
in Figure 6-33, will ask you to confirm your selection.
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Figure 6-33:
The Revert to last mini-save?
dialog box that appears after
choosing the Revert command
with the Shift key held down.
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Once you have reverted to the version of the last mini-save, you cannot return to the
version of the document displayed prior to choosing the Revert command. If you are
sure that you want to revert, click the OK button; if not, click the Cancel button. If you
click OK, your document will be restored to the version saved in the last mini-save. If
the mini-save was executed when you turned a page, you will be returned to the page
displayed just prior to the mini-save.
If the mini-save version is not far enough back, you can now execute a regular Revert

command to return to the version saved by your last Save command. Choose the Revert
command from the File menu (without holding down the Shift key). A Revert to lastsaved version? dialog box, shown in Figure 6-34, will ask you to confirm your selection.
Figure 6-34: The Revert to lastsaved version? dialog box.
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Once you have reverted to the last saved version, you cannot return to the version of
the document displayed prior to choosing the Revert command. If you are sure that you
want to revert, click the OK button; if not, click the Cancel button. If you click OK, your
document will be restored to the version saved by the last Save command.
If you have not saved your document since opening it, the document will be returned to

the version that was opened. lf you are working on a new document that has never been
saved and titled, the Revert command is dimmed.
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• •••••••••••••••••••••••••••••••••••••••••••••••
Summary
•

PageMaker has eight standard PageMaker view sizes, accessible from the View
submenu or by using keyboard or mouse equivalents.

•

You can move around a page with the grabber hand (Option-mouse), scroll
bars, or by changing view sizes.

•

Turn pages in your publications using the page icons, Go to page command
(layout menu), or keyboard equivalent (Command-Tab).

•

Add or delete pages with the Insert pages and Remove pages commands
(Layout menu).

•

Text and graphic elements placed on master pages appear on all other publication pages.

•

Column guides help you control the flow of text; ruler guides help you align
manually positioned elements.

•

Ruler tick marks change to display the best possible accuracy of the current
view size. The ruler zero point can be reset by dragging the zero-point marker
from the intersection of the horizontal and vertical rulers.

•

Text and graphic elements appear on PageMaker pages in a stacking order
determined by the order in which elements are added and the use of the Send
to front and Send to back commands (Element menu).

•

You can backtrack your work using the Undo and Revert commands .

••• •••••••••••••••••••••••••••••••••••••••••••••
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In This Chapter
•

Understanding stories and text blocks

•

Importing text from word processing files

•

PageMaker import filters

•

Creating text in PageMaker

•

The PageMaker story editor

•

Exporting text from PageMaker
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Text in PageMaker
Text is the most basic element in any publication, and PageMaker provides a great
many tools to help you create, manipulate, and control text. In fact, PageMaker has so
many text-related capabilities that it is going to take three full chapters to describe
them all in detail. This chapter focuses on text acquisition and creation: how you import
text that was first created in a word processor into PageMaker, and how you can create
text directly in a publication window or using the story editor.
Chapter 9 is devoted to editing and manipulating text after it is a part of your publications. This includes all character and paragraph formatting, as well as tabs, hyphenation, and all aspects of precision typography. Finally, in Chapter 10 you'll learn about
style sheets, a great text-formatting shortcut that not only saves time and effort but
improves the quality of just about any document.
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Stories and Text Blocks ---------------------When you open the newspaper to read the latest gossip about those crazy Hollywood
celebrities, you know that if the story that begins on page one doesn't fit entirely on that
page, you have to turn to another page to read the rest of the juicy details. This familiar
situation can be used to introduce three terms that are critical to your work with text in
PageMaker: story, text block, and threading.
The story is the entire collection of information- even though it starts on one page and
ends on another. The text blocks are the pieces of the story on each different page. And
threading is the linkage between the text block that holds the first part of the story and
the text block that holds the end of the story. Figure 7-l illustrates threading.
Figure 7-1:
This story
starts in the
text blocks on
the left page
and is
threaded to
text blocks on
the right
page.

Of course, a story won't always fit in just two text blocks-the Amy Fisher letters ran
over 20 different pages in the Irrational Inquirer, for example. On the other hand, a short
margin note or a figure caption can be a complete story in just a sentence or two. The
defining factor is the number of threaded text blocks that contain the story; if it all fits in
one text block, that's a story. If it threads through hundreds of text blocks on hundreds
of pages, that's a story, too.
Text bloc~ act in many ways like other on-screen objects you are already used tothey can be moved, resized, or deleted. Text blocks are automatically created when text
is imported, entered in the publication window, or transferred from the story editor into
the publication window. (You'lllearn all the details of creating text blocks later in this
chapter.)
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If an entire story cannot fit in a text block, it is threaded to another text block, as shown

in Figure 7-2. The process of threading text through multiple text blocks can be done
manually, or it can be done automatically. Usually, text that flows thr<¥Jgh multiple text
blocks starts at the top of one column or page, ends at the bottom of the text block, and
threads to the top of another text block in the next column or on the next page. It then
continues, from the bottom of one text block to the top of another, until the entire story
is in position.
Figure 7-2:
A story
threaded
through several
text blocks.
Note that there
is still unplaced
text that
follows the last
text block, as
indicated by
the arrow at
the bottom of
the final text
block.
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Changing the size of a text block
When you select a text block (by clicking on it with the arrow tool), handlebars appear
at the top and bottom of the block, marking the block's beginning, end, and width. Each
handlebar has two handles, which appear as block dots at either end of the handlebar.
Dragging a handlebar handle resizes the text block. As you drag one of these handles, a
box representing the new text block size is displayed (see Figure 7-3). When you release
the mouse button, the text inside the block reflows to fill the new text block size. This is
exactly the same process used to resize any graphic object.
Figure 7-3:
Dragging the
handle on
the end of a
text block
handlebar
allows you to
resize the text
block to a
new height
or width.
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Each text block handlebar has a tab (shown in Figure 7-4), which sometimes displays a
symbol that provides information about the text block. When more text appears than is
shown in a text block, a plus sign ( +) or downward arrow appears in the tab in the lower
handlebar. A plus sign appears when text in the current block flows to another text
block. A down arrow appears when there is text that does not fit in the current text
block but it has not yet been flowed into another text block. Clicking the plus sign or
down arrow in a tab reloads the text flow icon (described later in this chapter) so that
the text that does not fit in the text block can be placed into other text blocks.
Figure 7-4:
By dragging on the tabs
that appear in the upper
and lower handlebars of a
selected text block, you can
change the size and
position of the text block.
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Dragging a handlebar tab, by pressing and holding down the mouse button while
dragging the mouse, allows you to change the position of the text in the text block:
•

Dragging the top handle upward or downward will change the vertical positioning of the first line in the text block. All text in the story will be moved upward or
downward. This reflows all the text blocks In the story, potentially making new
text visible or leaving some text unplaced at the bottom of the last text block in
the story.

•

Dragging the lower handle upward will shorten the text block, hiding all text
below the lower handle to the end of the block. If this is not the last text block in
the story, the hidden text will appear at the top of the next text block, and all text
will flow through all subsequent text blocks.

•

Dragging the lower handle downwards will lengthen the text block, displaying
additional text in the text block when the mouse button is released. H this is not
the last text block in the story, the new text is flowed back from the top of the
next text block, and all text in the story will reflow appropriately. If no more text
remains in the document, the tab in the lower handlebar is empty, and dragging
the handlebar downward will have no effect-when you release the mouse
button, the handle will return to its previous position below the end of text.

You can also change the size of a text block and perform most of the other manipulations described in this chapter, using the PageMaker control palette. The control
palette is covered in detail in Chapter 13.
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If the size of one of the text blocks containing the story is changed (by moving either

one of the text block handlebars or text block handles), then the text in the story
reflows, adjusting to the new size of each text block. As a result, a change in the size of
one text block can affect the position of all of the text in a story. The way in which text
is affected by resizing a text block depends on the modification:
•

If the bottom of one text block is moved up two lines, those two lines appear at

the top of the next block, and every block in the thread will gain two lines at the
top and lose two lines at the bottom. If the last text block cannot hold all lines of
text that flow into it, the downward arrow will appear in the lower handlebar tab
when that block is selected: You can either lengthen the block to accommodate
the remaining text or pour the remaining text into a new text block.
•

If the bottom is moved down two lines, two lines are pulled from the top of the

following text block. In the second text block, all the text moves up two lines, and
two more lines are pulled from the third text block, and so on. If this process
causes all of the text in any one text block to be pulled to the text block that
precedes it, that (now empty) text block is automatically deleted.
•

If text is cut out of the middle of a text block, all lines throughout the story and

all its threads that are located below the cut will move up to fill the void. Any text
block that loses all its text to the preceding text block is automatically deleted.
•

If text is inserted in the middle of a text block, a ll lines throughout the story
and all its threads will move down to create s pace for the new text. If the last text

block cannot fit all lines that flow into it, the down arrow will appear in the lower
handlebar tab when that block is selected. You can either lengthen the block to
accommodate the remaining text or pour the remaining text into a new text
block.
•

If one text block in a threaded story is deleted, the links remain active between
all remaining text blocks, just as if the deleted text block had never existed.

Moving a text block
You can reposition a text block by dragging it to any new location. Just select the arrow
tool from the toolbox, point the arrow cursor inside the text block, press and hold the
mouse button, and drag the text block to its new position. If you drag the text block into
one of the edges of the display, your publication will scroll a utomatically. If you hold
down the Shift key while you drag, your movement will be constrained either vertically
or horizontally.
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Combining text blocks
One of the important rules you should learn about text blocks is that you don't want
any more of them than you need. This is true for a variety of reasons, including the fact
that extra text blocks often come back to haunt you at print time and that beginners
tend to create a great many unthreaded text blocks in situations where a few threaded
ones would be much easier to manage and manipulate.
If you eve~ find that you have two, three, or even four text, blocks where just one
would do, there are three different ways you can combine thos~ text blocks:
Use the text tool to select the text in the last unneeded block and cut it out with
the Cut command (Command-X). Now set the text insertion point at the end of
the preceding text block, enter one space character by pressing the spacebar,
and paste the text from the Clipboard with the Paste command (Command-V).
Repeat this process until all extra text blocks have been removed and all the text
is in a single text block.
Use the arrow tool to select the last text block in the sequence and cut it out with
the Cut command (Command-X)~ Now set the text insertion point at the end of
the preceding text block, enter one space character by pressing the spacebar,
and paSte the text from the Clipboard with the Paste command (Command-V).
Repeat this process until all extra text blocks have been removed and all the text
is in a single text block.
Use the arrow tool to select the last text block in the sequence and choose the
Send to back command (Command-B) from the Element menu. Now hold
down the Shift key and select the second to last text block (so you have two text
blocks selected) and again choose the Send to back command from the Element
menu. R~peat this process, selecting additiortal text blocks with the Shift key and
sending the entire group t0 the back, until all the text blocks you want to
combine· have been selected. Now choose the Cut command (Command-X)
and then select the text tool and set the insertion point to create a new text
block. Choose the Paste command, and the text from all of the text blocks you
selected and cut should be placed in the next text block. The text from the text
blocks should be in the same order it was originally, but check carefully for any
transposition.

If you hold down the mouse button for a second or two before you begin to
drag, you will be able to see your text as you reposition it, as shown in Figure 7-5.
If you begin dragging immediately after clicking the mouse button, you will see
only a box marking the outline of your text block.
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Figure 7-5:
Dragging a text block to a
new position.
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You can also move a text block using the Cut and Paste commands, but this will
sever the text block from the rest of its story. In other words, text will no longer
flow from any preceding or to any following text blocks. While this is usually
undesirable, there are times when you will want to sever a text block from its
story, and using Cut and Paste allows you to do this.
To move a text block from one page to another, drag the text block onto the
pasteboard, turn to the desired page, and then drag the text block into its new
position. This will not affect the text block's position in any threaded story.

Importing Text
Let's get one thing clear- PageMaker is not a very good word processor. While it has
extensive typographic tools, and its story editor is a word processor of sorts, you will
be better off doing your word processing in a true word processing package and then
importing your text into PageMaker. Don't let anyone tell you differently.
You can use just about any word processor you would like. PageMaker can import text
from every popular Macintosh, DOS, and Windows word processor. And it imports this
text while maintaining a ll character and paragraph formatting that has been applied to
the text in the word processor. In most cases, it even imports attached style sheets.
(Style sheets are shortcut lists of text formats-they are described in detail in Chapter 10.)
The process of importing text into PageMaker goes something like this:
•

You choose the Place ... command from the File menu.

•

You select the text file you want to import.

•

The text import filter that corresponds to the file you selected converts the file
into a format PageMaker can use.

•

A progress dia log box documents the import process.

•

If the file includes any fonts that are not currently available, the PANOSE font

matching dialog box appears, allowing you to choose replacement fonts .
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A text flow curs or then appears, indicating that the file has been imported and
allowing you to position the file within your publication.

Each of these s teps is reviewed in detail in the following sections.

The Place... command
You import text into PageMaker using the Place ... command from the File menu. Aldus
has a very emotional attachment to the Place .. . command, because when PageMaker
was introduced, this ability to import text (and graphic) files while retaining their
formatting was unique. Now it is not unique, and renaming the command as Import ...
would be much more logical. But Aldus has always preferred tradition to logic when it
comes to issues of user interface. Don't believe me? Why are there three Link-related
commands in two diffe rent menus? Why don't the cursor navigation keys match those
of Microsoft Word? Why do PageMaker, FreeHand, and Pers uasion have three completely different user interfaces? But I digress .. .
Choosing the Place ... command brings up the Place document dialog box (see Figure 7-Q),
where you select the word processing file you want to import. You can also select any
existing PageMaker 4.0 or PageMaker 5 publication, if you want to import stories that
are used within that publication.
Figure 7-6:
The Place document
dialog box.
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The Place dialog box lists every text or graphic file that PageMaker can import from the
current folder. If a file you want to import is not listed, either it is not in the current
folder, or it is currently saved in a file format that is incompatible with PageMaker. More
precisely, it is currently saved in a file format for which an import filter is not currently
installed. As you'll learn later in this chapter, you can solve this problem either by
installing the correct import filter or by converting the file into a format that does
correspond to an available import filter.
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H you want to import a file that is stored in another folder or on another drive, you can

locate the file using the standard Macintosh dialog box navigation methods:
•

To open a fold er, double-dick on it.

•

To close a folder, press Command-up arrow.

•

To close a folder, select another from the menu under the current folder name.

•

To close a folder, click the c urrent drive na me.

•

To close all folders, click the Desktop button (System 7 only).

•

To move to the next drive, press Command-right arrow.

•

To move to the next drive, press the Drive button (System 6 only).

•

To move to the previous drive, press Command-left arrow.

Once you've located the file you want to place, select its filename. H you have selected a
text file, the first Place option will read As new story. If a graphic file has been selected,
the option will read As new graphic. The second and third Place options are used to
replace or insert text, as described later in this chapter.
At the bottom of the dialog box are three text placement options:
•

Retain format. This option instructs PageMaker to convert and utilize the
existing paragraph and character formatting. If it is not selected, existing character and paragraph formatting is stripped from the file as it is imported. The
Retain format option is automatically selected for files from known word processors.

•

Convert quotes. This option causes PageMaker to scan the file being imported
and attempt to intelligently change straight double quotation marks (') into
typesetting (opening and closing) quotation marks(" and'').

•

Read tags. This option causes PageMaker to look for style tags in the imported
file. Style tags are the names of PageMaker styles, placed between the characters
< and > at the beginning of paragraphs in the word processed file. When
PageMaker finds a style tag, it formats the paragraph using the current formatting defined by the named style. H this option is not selected, PageMaker treats
tags as normal text, printing each tag character for character: <tag name>. Style
sheets and tags are more completely discussed in Chapter 10.

When the file you want to import has been selected, and all options correctly set, click
the OK button, double-dick the filename, or press Enter or Return to proceed.
PageMaker then reads the file from d isk, converts it using the appropriate import filter,
and prepares to position the text into your publication.
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Import file filters
In order for PageMaker to import text from a word processor, the text must be stored in
a file format that is compatible with one of PageMaker's import filters. Import filters are
s mall convers ion routines that PageMaker uses to convert the text and formatting from
a word processing file into a format that PageMaker can use. A complete Jist of the text
import filters included with PageMaker is s hown here.
Acta

ASCII

DCA

M S Word 1.05

MS Word 3.0

M S Word 4.0 I 5.0

MS Works 1.0

MS Works 2.0

WordPerfect (Mac 1.0)

WordPerfect (Mac 2.0)

WordPerfect (PC 4.2)

WordPerfect (PC 5.0)

RTF

WriteNow 2.0

WriteN ow 3.0
PageMaker 4 .0

XyWrite 3

I 4 .2

PageMaker 5.0

These import filters are kept in the Aldus Filters folder inside the Aldus folder in your
System folder. They are ins talled automatically along with PageMaker, but you can copy
additional filters to this folder anytime. New import filters are sometimes sent out by
Aldus, or you can get them from the Aldus forum on CompuServe (GO ALDUS) or
AppleLink. For example, a filter for MacWrite Pro was released just after PageMaker 5 itself.

C/J
To check which filters are installed in your Aldus Filters folder, hold down the
~ Command key and choose the About PageMaker command from the Apple menu.
If you have a file from a word processor not supported by PageMaker, you can almost

always convert the file into the format of a supported word processor or save the file as
a text-only (ASCII) file. First t ry to use the Save as command in the word processor to
save the file in the format of another popular word processor or into an industry
standard file format like DCA (document common architecture) or RTF (rich text
format). If this is not possible, you can use a utility like MacLink Plus, which is s hown in
Figure 7-7, or the MacLink Trans lators to convert the file. Programs of this type support
conversion between hund reds of Mac and PC file formats for word processors, spreads heets, databases, and graphics programs.
Import filters do their work after you have clicked OK in the Place dialog box. For the
most part, these conversions are handled automatically, but a few of the filters, including ASCII, PageMaker 4.0/4.2, PageMaker 5, Excel, and optionally Microsoft Word 4.0/5.0,
present dialog boxes that let you control file conversion options.
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Figure 7-7:
The Maclink
Plus dialog box
as it converts a
DOS MultiMate
file into a Mac
Microsoft Word
5.0 file.
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The Smart ASCII import filter options
The first of these appears automatically when an ASCII (text-only) file is imported. The
Smart ASCII import filter dialog box, shown in Figure 7-8, presents several options:
Figure 7-8:
The Smart ASCII import
filter dialog box.
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•

Remove extra carriage returns. Many ASCII text files have a carriage return at
the end of every physical line, whether it is the end of a paragraph or not. The At
end of every line option strips all of the carriage returns from the file, causing the
text to run together instead. This means that you have to manually add carriage
returns where they are required, but it is far easier to add carriage returns where
they are needed than to have to manually remove them where they are not
needed.
The Between paragraphs option deletes carriage returns as necessary so that
there is never more than one carriage return in a row in the resulting file.
The But keep tables, lists and indents as is option causes the import filter to
retain carriage returns preceding lines of the imported text that begin with
spaces or tabs or contain embedded tabs.
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•

Replace _or more spaces with tab. If the text document being imported uses
spaces to position text, this option designates that multiple-space sequences be
removed and tabs be substituted. This is important because text positioned with
spaces will usually not align properly in PageMaker-setting tabs is a much more
accurate method of positioning text. After selecting this option, enter the number
of consecutive spaces you want replaced with a tab. The default setting is 3.

•

Monospace, import as Courier. When this option is selected, all text in the
imported file will appear in the Courier typeface.

•

No conversion, import as is. This is the default option and will be the correct
option for most text files . When selected, carriage returns are not removed,
consecutive spaces are never replaced with tabs, and the text file will appear in
the default font. This option is automatically deselected if any one of the other
options in this dialog box is selected.

The PageMaker 4.0/4.2 and PageMaker 5 import filter
options
Selecting an existing PageMaker 4.0, 4.2, or 5 file in the Place dialog box brings up the
PageMaker Story Importer dialog box, as shown in Figure 7-9. This dialog box lists the
first 20 characters of each story in the selected publication. You can select any story
that you want to import, hold down the Shift key to select more than one story, or use
the Select all button to bring all of the stories into the current publication. If you use the
Select all button, the stories you are importing will be concatenated into a single story
in your new publication.
Figure 7-9:
The PageMaker Story
Importer is used to
copy stories from
other PageMaker 4.0,
4.2, or 5 publications.

PageMaker 5.0 Story Importer, u2.0
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If you cannot remember the content of any story based on the small amount of text that

appears in this dialog box, select the story you want to see more of and click the View
button. The complete text of the selected story will appear in a story-editor like window.
You can limit the number of stories that appear in the Story importer by using the
option at the bottom of the dialog box to only include stories that contain a certain
number of characters or more. This limits the appearance of small stories such as
cutlines, sidebars, page numbers, and cross references.
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After selecting the stories you want to import, click the OK button, and PageMaker will
import the selected text just as if it had come from a word processing file. Naturally, all
style sheets and text formatting will be imported in tact.

The Microsoft Excel import filter options
Selecting a Microsoft Excel spreadsheet file brings up the Excel import filter, shown in
Figure 7-10. By default, all existing data in the selected spreadsheet will be imported,
but if you've used name cell ranges, you can import only a specified name cell range
using the Cell range option. Other options allow you to specify the tab alignment used
for your imported data, import or discard the text formatting that has been applied in
Excel, and truncate long text cells to the length of their cell boundaries.
Figure 7-10:
The Microsoft Excel
import filter can read
any Excel spreadsheet
into PageMaker.

u

Pl11ce EHcel r11nge:
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OK

[Cancel]
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Tab alignment:
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The Microsoft Word 4.0/5.0 import filter options
A similar import filter dialog is available for Microsoft Word 4.0 or 5.0 files, but this
dialog box, shown in Figure 7-11, does not appear automatically. To access it, you must
press and hold the Shift key down while clicking the OK button in the Place document
dialog box. After setting the options in this dialog box, click the OK button to continue
the text placement or the Cancel button to abort the text import.
Figure 7-11:
The Microsoft Word 4.0
- 5.0 import filter dialog
box.

Microsoft Word 4.0/5.0 Import filter, u2.1
181 1mport table of contents entries
® From .c. paragraphs
0 From outline
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®Set width
0 M11nual kerning
0 Troclc kerning
1811mport page break before p11ragroph
®As poge break before
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0

OK

D

[ Concel ]
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The options in this dialog box:
•

Import table of contents entries. Use of this option instructs PageMaker to mark
table of contents entries from the imported text as they were marked in Word 4.0
using either the .c. paragraph markers or the Word outline. (See the Microsoft
Word user manual for more information on Word's table of contents commands.)

•

Import index entries. Use of this option instructs PageMaker to mark index
entries from the imported text as they were marked in Word using the .i. markers. (See the Microsoft Word User Manual for more information on Word's index
commands.)

•

Import condensed/expanded type. There are three options for how condensed
or expanded type is placed into PageMaker. The Set width option causes
PageMaker to use its Set width option to make the text appear in PageMaker as it
did in Word. The Manual kerning option causes PageMaker to kern the characters so that the text appears in PageMaker as it did in Word. The Track kerning
option causes PageMaker to use its Tracking option to make the text appear in
PageMaker as it did in Word.

•

Import page break before paragraph. When this option is selected, Word's Page
break before paragraph formatting is imported into PageMaker as either a Page
break before or a Column break before option in PageMaker's Paragraph specifications dialog box. Page breaks that result from Word's automatic pagination,
and hard page breaks (entered into Word with the Shift-Enter key combination)
cannot be transferred into PageMaker.

Supported text formatting
Even with the proper import filter, every formatting attribute of your text or word
processing file may not be converted properly. The following table lists formatting
attributes and indicates whether these attributes are converted by the most common
import filters. A "Y" indicates that the formatting attribute will remain after the file is
imported into PageMaker. An "N" indicates that the formatting attribute will be lost in
the conversion process.
MSWord

DCA

.RTF

y

y•

y

Y2

Y2

y

Y2

y

y

y

y

y

yJ

N

y

MacWrlte
II

WPrfct

4.0

s.o

Worlcs

Item
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1.02

Fonts

y

y

y

y

Sizes
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y
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y

Italic

y

y

y
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(continued)
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Some fonll m ay be converted.
Whole point sizes only.
"Redline text" is imported as italic.
StrikeU1ru with hyphens only.
Use Word import filter d ialog box.
PageMaker makes them 'liz normal type a nd 'll above baseline.
Except formulas a nd line numbers.
Bar tabs become left tabs.
If set in paragraph dialog.
Except special characters.
As endnotes.
If page range is indicated with ".i(.' and ".i).', two references separated by com ma will be imported.
As long as not designated with hidden text.
Border above and below only, imported as paragraph rules.

Font mapping
As the text file you selected is converted and imported into PageMaker, a progress
dialog box will appear. Under the progress bar in this dialog box, you will see messages
documenting some aspects of the conversion process. A few s uch dialog boxes are
shown in Figure 7-12.
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Figure 7-12:
Some of the progress dialog
boxes that appear when
placing text files.

165

( Concel ]
Importing "2 Installing U.l (PMS)."
Importing style sheet informotion.

[ Concel ]
Importing "2 lnstolllng U.l (PMS)."
Importing teHt.

[ Concel ]
Importing "2 lnstolllng U.l (PMS)."
Merging stylesheet informotlon.

[ Concel ]
Importing "PM4 06 lHt."
Importlng lnllne grophic.

[ Concel )
Importing "PM4 06 THI."
Merging stylesheet informotlon.

U the PANOSE Font Matching option is turned on (in the Preferences dialog box under
the Map Fonts button) and any of the fonts used in the imported text file are not currently installed on your system, then a PANOSE dialog box like the one shown in Figure
7-13 will appear. If you are using Super ATM instead, no dialog box will appear, but you
may see the Super ATM "spinning letter A cursor" as your document is being composed. The PANOSE dialog lists all currently unavailable fonts, along with font substitutions that are either suggested by the PANOSE system, have been defined as exceptions
in the Preferences dialog box, or were saved as permanent substitutions in a previous
editing session.
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Figure 7-13:
The alert dialog
box that
appears when
all type faces
used in the
word processed
document are
not available in
PageMaker
when the file is
imported.
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Editing PANOSE font matching exceptions
The PANOSE font matching system is designed to automatically map missing fonts
to other similar fonts that are installed on your Macintosh. It uses a proprietary system
of describing fonts based on their visual characteristics. Rather than relying on the
PANOSE system to map your missing fonts, you can define an exception list that is used
to substitute for missing fonts.
To do this, choose the Preferences... command from the File menu, then click the
Map Fonts button. This brings up the Font Matching dialog box. Now make sure the
PANOSE font substitution option is selected. The Substitution tolerance scroll bar
defines how exact of a match the PANOSE system must make in order to consider one
of the fonts available in your system as an acceptable match for a missing font. If you
want the PANOSE system to map fonts only when a perfect match is found, slide the
scroll bar to the right, to a value of 100, or Exact If you want less-than-perfect matches
to substitute as well, slide the scroll bar toward the left, nearer to the 0 or Loose setting.
If a font is missing, it is missing; so you might as well allow the PANOSE system to
match any font that is reasonably close in design. So I recommend a mid-range setting
between 50 and 70.
If the PANOSE system cannot find a match within the tolerance you suggest, it will
instead substitute the font specified by the Default font option. Use the pop-up menu
to select the font you want substituted for all missing fonts in your publications that
cannot be replaced by the PANOSE system.
The last control you have over PANOSE font substitutions is the exception list. This is
a list you create and maintain that defines the specific fonts you use and the fonts you
want substituted should those fonts ever be unavailable. To create or modify your
exception list, click the Exceptions... button and use the Add ..., Edit.,., and Remove ...
buttons.
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To change the predefined or default substitution for any font, select the font name and
then choose the font you want to substitute using the Substitute font pop-up menu at
the bottom of the dialog box. lf you want this substitution to occur every time you open
this file, click the Permanent option in the lower right corner of the dialog box. If you
want this substitution to apply for the current work session only, leave the Temporary
option selected. Repeat this process for all of the listed missing fonts. When you're
finished, click the OK button.

Ro~gText __________________
When PageMaker is finished reading the word processed file, the cursor becomes one
of two text flow icons: manual text flow or autoflow text flow. The autoflow text icon
appears if the Autoflow command (in the Layout menu) is checked, and the manual text
flow icon appears if it is not. You can get a third text flow icon, the semiautomatic text
flow icon, by holding down the Shift key. Any of these icons, which are shown in Figure
7-14, can be used to add text to your publication. The operation of each is described in
detail in this section.

semiau:~~u;~c~~~~ I ~

The manual,
automatic text flow icons.

rrr mr I

Before adding the new text, you can use the page icons, the keyboard equivalents
(Command-Tab and Command-Shift-Tab), or the Go to page .. . command to find the
spot where you want to insert the text. You can even turn to the page, if necessary, or
reposition the display using the scroll bars, grabber hand, or view-size commands.
None of these actions will cause you to lose the text flow icon.
If you decide that you don't want to add the imported text at this time, click on the
arrow tool in the toolbox and the text flow icon will disappear. You will then have to
reselect the Place ... command and choose the file again when you want to import it.
This technique can be applied anytime a text flow icon appears-clicking on the arrow
tool will always discard it.

Imported text can be added anywhere on any publication page, on the master pages, or
on the pasteboard. Not surprisingly, adding text to publication pages is most common.
The pasteboard is a good place to put text if there is only a small amount and you want
to see it before putting it into position, or if you aren't sure what text is actually in the
file you imported. After you review any text you place on the pasteboard, you can drag
it into position on any page or delete it.
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To actually place the text, position the text flow icon where you want the top of the new
text to appear, and click the mouse button. What happens next depends upon which
text flow icon you are using:
•

Manual text flow. With the manual text flow icon, you decide where to begin
each block of text. After you click the mouse button, the text will flow into a new
text block, and in the handlebar tab at the end of that text block the down arrow
will appear if not all of the imported text has been placed. You then must click
this down arrow with the arrow tool to manually reload the text icon to continue
the text flow process. Then you select where you want the next text block to
appear, turning the page or adjusting the view if necessary, and repeat the
process.
Manual text flow is the default setting when the Autoflow command from the
Options menu is not selected. If Autoflow is selected, manual text flow can be
temporarily accessed by pressing the Command key.

•

Fully automatic. With the automatic text flow icon, once you begin the text flow,
PageMaker will add the text, column by column, page after page, until the entire
story is placed. Pages will turn automatically, and if required, new pages are
added automatically until the document reaches its 999-page limit or PageMaker
runs out of disk space.

You can stop automatic text flow at any time by clicking the mouse button. When
the Autoflow command is selected, fully automatic text flow is the default setting.
When Autoflow is not selected , fully automatic text flow can be accessed temporarily by pressing the Command key.
•

Semiautomatic. With the semiautomatic text flow icon, text placement works just
like it does with the manual text flow icon, except that you don't have to reload
the icon after each text block. Instead, the text icon is reloaded automatically.
You then can decide the location of the next text block and repeat the process
until all text has been placed.
Semiautomatic text flow is initiated by pressing the Shift key, regardless of
whether or not the Autoflow command is selected.

Manually placing imported text
The manual text flow icon gives you full control over the placement of imported text
within your file. It is best suited to situations where the text being placed will not
continue in a regular formation from column to column and page to page. Ad layouts,
newspaper, and magazine designs are examples of documents whe;t: the manual (or
maybe the semiautomatic) text flow icon should be used.
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To begin placing text with the manual text flow icon, position the cursor between your
column guides at the vertical location where you would like the text block to begin, and
click the mouse button. Alternatively, you can define the exact size and position of the
text block you want to put the text in by drag-placing to create a marquee that will
define the text block and then releasing the mouse button. This method of defining text
blocks is described in more detail later in this chapter.
Text from your imported file will then flow into the text block you have created, until all
the text has been placed, the bottom margin of the column is reached, the bottom of the
pasteboard is reached , the bottom of the predefined text block is reached, or the text is
interrupted by a graphic that has been formatted to stop text flow. When the text flow
stops, the text block is selected (as indicated by the handlebars at the top and bottom
of the text block), and the lower handlebar tab will display a down arrow if all of the text
in the story did not fit in the text block. The arrow tool is automatically selected, so you
can easily reposition the text block, resize the text block, or reload the text flow icon to
continue flowing the text. (See Figure 7-15.)
Figure 7-15:
Using manual text flow, you
determine where each text
block begins, and you must
reload the text flow icon if
necessary, as shown above.
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II more text remains to be placed, point the arrow tool at the down arrow and click the
mouse button. This reloads the text icon so that it is ready to place the additional text.
The remaining text may be flowed into existing columns, placed into a new text block
that is created manually, or placed onto the pasteboard. You can either turn the page or
insert new pages into your publication without disturbing the loaded text icon. Position
the text icon where you want the top of the next text block to be and click the mouse
button to flow the remaining text into the new text block. Repeat this process until all
the text in the document has been placed.
Remember that manual text flow is the default setting unless the Autotlow command is
selected (marked with a check mark) in the Layout menu. If the Autoflow command is
selected, and the automatic text flow icon appears, you can still change the flow to
manual mode temporarily by holding down the Command key.

Using the Autoflow command
In longer documents, the process of positioning the text cursor icon, initiating the text
flow, reloading the flow icon, and repositioning the text cursor icon (including turning
or creating pages) may become slow, boring, and repetitive. In these cases, you will
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want to use the Autoflow command to automate the process of flowing text documents.
Autoflowing text works much like manual text flowing except that PageMaker automatically reloatls the text icon cursor and initiates the flow in the next available column
(moving left to right). PageMaker turn pages as necessary and even inserts new pages
until all the text in the file is placed, the 999-page limit of the publication is reached, or it
runs out of disk space.
Automatic text flow is initiated with the automatic text flow icon, which appears when
the Autoflow command is chosen from the Layout menu. Choosing the Autoflow
command toggles a check mark (--/) on and off in front of the command. When the check
mark appears before this command, the loaded text cursor will by default become the
automatic text flow icon, and text flow will be automatic. You can choose the Autoflow
command at any time-before choosing the Place ... command or after the manual text
flow icon has appeared. You can also access the automatic text flow icon by holding
down the Command key while the manual text flow icon is displayed.
Once the autoflow text icon is displayed, position it at the top of the column wher e the
text document is to begin, and click the mouse button. Text flows through each subsequent column in the publication, turning and adding pages as necessary, until all text in
the placed document has been positioned. (See Figure 7-16.) You can interrupt automatic text flow at any time by clicking the mouse button. To restart automatic text flow,
click the down arrow to r eload the text flow icon, position the autoflow icon at the top
of the next column, and click the mouse button to restart automatic text flow.
Figure 7-16:
Using automatic text
flow, text automatically
continues to flow from
column to column,
page after page.

Semiautomatic text flow
A third method of text flow is semiautomatic, in which each column of text flow must be
initialed individually, but the text icon is reloaded automatically if additional text
remains after the text block is filled. Semiautomatic text flow is initiated with the semiautomatic text flow icon, which is displayed by pressing the Shift key and holding down
the mouse button when either the manual or automatic text icon is displayed .
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To begin semiautomatic text flow, position the semiautomatic text icon at the beginning
of the column where you want the text to begin, and click the mouse button to initiate
the text flow. When the text flow stops, the text icon will r eload, and if the Shift key is
still held down (or depressed at that time), the semiautomatic text flow icon will appear
again. If the Shift key is no longer being held down, then either the manual text flow icon
or the automatic text flow icon (shown in Figure 7-17) will appear, depending on the
current setting of the Autoflow command in the Layout menu.
Figure 7-17:
Using semiautomatic
text flow, you decide
where each text block
begins, but you do not
have to reload the text
flow icon after each
new text block is
created.

Semiautomatic text flow is useful whenever you want to flow all the text from a particular document but do not wish to fill each available column top to bottom, as automatic
text flow would.

Drag-placing to create a new text block
The most common way to create text blocks is by positioning one of the text flow icons
at the top of a page or column and then clicking, but that is not the only way. If you
want to create a text block where there are no column guides, or if you want to create a
text block that is sized differently than the current column guides, you can drag-place
with any of the text flow icons.
Simply position the cursor at the upper left corner of your desired text block, press and
hold down the mouse button, and drag to the lower right of your desired text block (see
Figure 7-18). Now release the mouse button. Your newly defined text block will immediately be filled with text. This same trick can be used with the text tool from the tool
palette, but in that case the insertion point will flash, ready for you to enter text into the
new text block.
Text blocks created with this method can cross existing column guides and can be
positioned on the pasteboard or anywhere else in a publication. If all of the text in the
story doesn't fit in the text block you define, a down arrow will appear in the tab of the
lower handlebar of the text block. This is true even if the automatic text flow icon was
used. You can then reload the text flow icon as described above and place the additional text either normally or using the drag-place method.
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Figure 7-18:
Drag-placing w ith any text
flow icon allows you to
determine the size and
placement of the new text
block, regardless of column
guides or margins.

I

I

~

Importing text into or over an existing story
Sometimes you'll need to add imported text to an existing story in your publication, or
to replace the existing text in a story. This can happen for a number of reasons:
It can happen "by surprise"-when your editor or colleague hands you the new
disk and asks "Can you use this newer version?"
•

You may have done it intentionally, deciding that a document needed more
editing than is appropriate for PageMake r, so you returned to the word processor to make major changes.

•

You may lay out an article and find that it is not long enough. By inse rting text
into a story that has already been placed, you can then work with the combined
text as a single story rather than as two separate stories.

•

You can update old layouts with new articles. By replacing the existing story
rather than simply deleting it and placing the new text as a new story, you can
preserve the positioning and formatting of the text blocks as they thread through
the publication.
You can use the Place .. . command to replace the text in an entire story, to
replace a portion of a story, or to add imported text to an existing story. To do
this, select the text you want to replace, or position the insertion point at the
position where you want to insert the new text. If you want to select an entire
story, use the text tool to set the insertion point anywhere within the story and
then choose the Select all command from the Edit menu (Command-A). To
select a portion of a story that spans multiple pages and/or text blocks, set the
insertion point at the start of the section you want to select, then turn to the
end of the section you want to select, hold down the Shift key, and click the text
cursor. All text between the original insertion point and the Shift-click will be
selected.
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Then choose the Place .. . command. The Place document dialog box appears, as shown
in Figure 7-19. Select the file you wish to import from the scrolling file listing on the left
side of the dialog box (navigate to other folders or drives if necessary). If the file you
selected is a compatible text file, the second and third Place options become selectable
in one of two configurations. Of these options remain dimmed , the text insertion point
was not set in an existing text block before the Place ... command was chosen.)
Figure 7-19:
The Place options from the Place
document dialog box.

Ploce:
® As new s tory
0 Reploclng en lire story
0 Reploclng sel ect ed teHt

If some text was selected when the Place ... command was chosen, the second option is

Replacing entire story, and the third option is Replacing selected text. Select Replacing
entire story if you want the file you import to replace the entire story in which text was
selected. This will replace all of the story's text even if you did not select the entire
story. Select Replacing selected text if you want only the text you selected to be replaced; this leaves all text before and after the selection intact.
If no text was selected when the Place ... command was chosen, but the insertion point

was set inside a text block, the second option reads Replacing entire story, and the
third option reads Inserting text. Se lect the Replacing entire story option if you want the
file you import to replace the entire story in which the cursor was set. Select Inserting
text if you want to add the text from the imported file to the existing story, starting at
the position where you set the insertion point.
Inserting text into an existing text block using the Place ... command is exactly the same
as entering additional text manually. This means that the text below the insertion point
flows through any s ubsequent text blocks in the story, and if all of the text doesn't fit
into the last text block, you'll have to either lengthe n that text block or create a new text
block to hold the final text. To check for unplaced text, select the last text block in the
story and look for a down arrow in the tab in the bottom handlebar.
After selecting the appropriate options, double-click the selected filename, click OK, or
press Return or Enter. The selected file will be converted and imported. A progress
dialog box will appear, as will a font substitution dialog box, if necessary. The text then
replaces the existing text or adds to it, depending on the options you selected.
You can also replace the text in a story using the Link info ... or Links ... command, as described in Chapter 16, "Long Document Features ." In fact, that is an
easier way to replace an entire story; you cannot use the link commands to
replace a portion of a story, however.
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Creating New Text
In addition to importing text with the Place .. . command, there are two other ways you
can get text into your publication. You can either create text right on your publication
pages or you can create text in the s tory editor and then import it onto your publications pages. In this section, you'lllearn how to create text directly on publication pages.
Creating text in the story editor is covered in the next section of this chapter.
To create new text on a publication page, select the text tool from the tool palette,
pos ition the 1-beam cursor where you want the text to begin, and click the mouse
button. Be sure you are not overlapping any existing text blocks, or else your new text
will be added to that text block rather than creating a new one. Once the text insertion
point is set (it will be flashing on and ofQ, start typing. The size of the text block you
have created is determined by where and how the text tool is positioned and the mouse
button clicked.
If the cursor is set within an existing text block, any new text entered is added
to that text block. In this case, no new text block is created. As you add text, all
following text flows through the multiple text blocks. If the end of text does not fit

into the last text block, the down arrow will appear, and you will have to re load
the text flow icon and place the remaining text.
If the cursor is set by clicking between existing column guides, the new text

block will be the width of that column and as long as required to hold the text
you enter (to the limit of the bottom of the page). The text will automatically
begin at the left margin, and text will automatically wrap to the width of the
column, as shown in Figure 7-20.
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Figure 7-20: Text placed or created between column guides takes the width and length of
the colum n.
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If the cursor is set by clicking at any location that is not between two column

guides, the new text block will be nearly as wide as the current page, and as long
as required to hold the text you enter (to the limit of the bottom of the page or
pasteboard). See Figure 7-21 for an example.
Thtunfvtrn t d n; h ls nofin9 "•t()'OI.IS n-o •cifttnct and ....., p.I SSHOUt of tMsttnot. Or. btltr lll.l t
dtwk>~ . lt PIS•s • way, but lt n.wr btgtn b dt wlop, lfld hJS ntvtf ctu t d from plSsin9 a w.~ ay; lt mM•Jn..
itstlf In bolh m • s ...• h lwson istlt,lti t M;Jtmtn ti liP Its nowishrrwnt
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Figure 7-21: The text block created when text is entered on the pasteboard can be nearly as
wide as the page itself.
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Drag-placing predefines the text block size. If you want to define a text block
that does not conform to existing column guides, position the text tool's !-beam
cursor anywhere in the publication window, except over an existing text block,
press and hold the mouse button, and drag to the size that you wish the new text
block to be. Then release the mouse button and the insertion point will flash in
the upper left corner of the new text block. Enter your text before clicking the
mouse button again.

To enter more text than will fit into one text block, you have to thread the text to a
second text block and then continue entering text into the second text block. To do this:

STEPS:

Entering Additional Text In a Full Text Block

Step 1.

Select the arrow tool and click on your new text block so that its handles appear.

Step 2.

Click and hold on the tab in the handlebar at the bottom of the text block
and push the handlebar up two or three lines. The down arrow symbol will
now appear in the tab in the lower handlebar to show that not all text has
been placed.

Step3.

Click the arrow tool on this tab, and the cursor will become a loaded text
icon. (Make sure to click the mouse button quickly; if you press and hold it
down, the loaded text icon will not appear.)

Step 4.

Position the loaded text icon at the location where you want the second text
block to be locate d, and click the mouse button. The text that you had
hidden under the bottom handlebar will then appear.

Step 5.

Select the text tool from the toolbox, position it to the right of the last word
in the new text block, and click the mouse button. The insertion point is
now set, and you can add more text to this text block.

Step6.

Repeat this procedure each time you fill a text block and want to enter
additional text.
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Cutting and Pasting Text
One of the most common text-editing functions is cutting or copying text from one
location and then pasting it to another location. If you select text with t he text tool and
then cut, copy, and paste it within PageMaker, the text retains all of its character-level
formatting but does not retain its paragraph-level formatting. Instead, the text will
assume the paragraph-level formatting of the text block into which it is pasted, or if it is
pasted into a new text block, it will take on the default paragraph-level formatting. (The
distinction between character-level and paragraph-level formatting is fully described in
Chapter 9, "Formatting Text.")
II you select a text block with the arrow tool on the other hand, and then cut, copy, and
paste it to another location, it will retain both the character-level formatting and the
paragraph-level formatting.

Special Characters
When entering text into PageMaker, you'll frequently need access to the special characters shown in the table in this section. Here you can sec each of the characters
PageMaker makes available in mos t PostScript and TrueType fonts, the keys you need
to press to add these characters to your text, and the codes you'll need to enter to use
these characters in the Find or Change dialog boxes.
In addition to these special characters, most fonts make available other characters as
part of their extended character sets. These vary widely from font to font and font
vendor to font vendor. To find out what extended characters are lurking in your fonts,
use a desk accessory like Key Caps or open the Charset.PTS template included with
PageMaker 5. Changing the font in this publication to any one of your fonts, and th en
printing it will provide you with a complete map to the font's extended character set.
Note that some fonts-mostly unusual display fonts, public domain or
s hareware fonts, or fonts from small type houses-don't honor this special
characters list. You should always check your special characters carefully after
your pages are printed; they can sometimes appear correct on screen and yet
print incorrectly.
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Special characters and their keyboard equivalents
Characters

Keyboard Equivalent

Code for Find/ Change

Current page number

Command-Option-p

"3

Discretionary hyphen

Command- (hyphen)

1\

Ellipses

Option-; (semicolon)

Option-;

Em dash

Shift-Option- (hyphen)

1\

Em space

Command-Shift-m

"m

En dash

Option- (hyphen)

En space

Command-Shift-n

">

Line break

Shift-Return

"n

Non-breaking hyphen

Command-Option- (hyphen)

"-

Non-breaking slash

Command-Option-/ (slash)

"I

Non-breaking space

Option-spacebar

"s

Single quotation close

Option-Shift-]

"]

Single quotation open

Option-]

"[

Open quotation

Option-[

"{

Close quotation

Option-Shift-[

"}

Thin space

Command-Shift-t

"<

"=

The Story Editor
The story editor is a word processor of sorts that is built into PageMaker for those
times when the formatting of text within your publication makes it hard to read and
edit, or when you need to do some fairly extensive text entry or editing but don't want
to switch to your word processor. You can move any story that has already been
placed into your publication into the story editor, import new stories directly into the
story editor, or create new stories in the story editor.
The story editor is accessed with Edit story command from the Edit menu (Command-E).
If the text cursor is set within a text block, or a text block is selected with the arrow

tool, when the story editor command is chosen, the story contained in that text block is
opened in the story editor. If no story is selected (with either the arrow tool or the text
tool) when the story editor command is chosen, an empty, untitled story window
appears, along with the story editor menu bar. You can also enter the story editor by
triple-clicking with the arrow tool on any text block in your publication.
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The menu bar changes a little when you leave the layout view and enter the
story editor: The Layout and Element menus are removed and the Story menu
is put in its place. Also, the Find ... , Change ... , and Spelling commands are
available in the story editor but dimmed when working in the layout view.
The first thing you'll notice about the story editor is that all text appears in one font and
at one type size, regardless of the font and type size that was used to format the text.
This is the way the story editor is supposed to work; you s pecify a font and type size
that is easy to read in the Preferences dialog box, and all stories use that font and type
size in the story editor. The idea is that in the publication window stories are often
formatted with fonts and small point sizes that make them difficult to read. Also the
many threaded text blocks that hold longer stories slow down your ability to read and
edit a story. In the story editor, an entire story appears in one easily scrollable window
and in one easy to read font and type size, as shown in Figure 7-22.
Figure 7-22:
A window in the
PageMaker story
editor.
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You can apply character or paragraph formatting to text while it is in the story editor,
but the results of some commands-such as font, type size, and letter spacing commands-will not display in the story editor. Rest assured that these commands have
been applied, and you'll see them when you switch back to the publication window.
Complete details on using all of PageMaker's character and paragraph formatting are
provided in Chapter 9.
To return from the story editor to the layout view, click the close box in the story editor
title bar, choose the Edit layout command from the Edit menu, or choose the layout
option from the submenu of the publication name in the Window menu.
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Importing text into the story editor
To import a file from disk to the story editor, open the story editor (Command-E) and
then choose the Place ... command from the file menu, just as you would in the publication window. This is a change from PageMaker 4.0 or 4.2, when an Import ... command
in the Story menu served this purpose. Select any available file using the Place dialog
box, as described earlier in this chapter.
Once imported, the new story appears in a new story editor window. You can now
review the story or edit it as necessary before placing it into your publication.
To place the story into your publication, choose the Edit Layout command from the
Edit menu (Command-E) or click the close box in the story editor window. The Edit
layout command transfers you to the publication window directly; clicking the close
box displays a dialog box like the one shown in Figure 7-23. Click the Place button if you
want to add the story to your publication.
Figure 7-23:
This dialog box appears when you
try to close an unplaced story in the
story editor.

I(

Place
The story has not
been placed.
(Discord

J

I
[ cancel I

When the publication layout reappears, the cursor will be the manual or automatic text
flow icon (depending on the status of your Autoflow command). You can then place this
story anywhere in the current publication, using the techniques described earlier in this
chapter. You can edit the story in the story editor again at any time by selecting it with
the text or arrow tool and choosing the Edit story command (Command-E) or by tripleclicking on any text block in the story with the arrow tool.
Alternatively, you can just close the story in the story editor and discard it without
adding it to your publication. To do this, click the window's close box or choose the
Close story command from the Story menu. Before the story disappears, a dialog box
will appear asking you to confirm that you want to discard a story that has not been
placed. Click the Discard button only if you are sure; there is no way to get the story
back after discarding it.

Creating new text
When an untitled window appears in the story editor, you can begin creating a new
story immediately-just start typing. If an untitled window is not available, choose the
New story command from the Story menu to create a new untitled window.
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After entering and editing a new story in the story editor, you can place it into the
current publication by choosing the Edit Layout command from the Edit menu (Command-E), or clicking the close box in the story editor window. This brings the publication window forward and provides a text placement icon with which you can position
and lay out the text.
Once positioned within your publication, stories created in the story editor behave
exactly like stories imported from an external word processor. The one exception is
that they are not linked to any external file, so PageMaker's Link commands cannot be
used on these stories. (fhe Link commands are introduced and explained in Chapter 16,
"Long Document Features.") You can, however, export stories created in the story
editor to an external word processing file, using the Export. .. command, as described in
Chapter 9, "Formatting Text.n

The Find command
The story editor's Find command can search for text within a selection in the current
story, in the entire current story, in all stories in the current publication, or in all open
publications. To perform a search, choose the Find ... command from the Edit menu,
and the Find dialog box will appear as s hown in Figure 7-24.
Find

Figure 7-24:

The Find dialog box.
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The options in the Find dialog box:
•

And what. If you are searching for specific text, enter or paste that text into the
Find what option box. In searches that are looking for text attributes regardless
of the specific text, leave this option blank.

To search for text that matches some characters and varies in other characters,
include wild-card characters in your search text by adding question marks ? to
the search text. (fo search for an actual question mark character, enter /\?.) For
example, searching for ?alk would find all occurrences of walk, talk, and any
other four-letter word ending with alk.
You can include other special characters in your search by inserting them as
specified in the following table.
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This table shows special characters, the symbols used to search for them, and
the keyboard equivalents that produce them in normal text. If the symbol itself is
used as the search symbol, enter the keyboard equivalent directly into the Find
or Change dialog box. The caret character (") is created by pressing Option-6.
Character

Search symbol

Keyboard equivalent

Any character (wildcard)

?

n/a

Bullet

•

Option-S

Ca ret

'"'

Shift-6

Computer-inserted hyphen

"c

n/ a

Copyright symbol (©)

©

Option-g

Ellipsis

Option-;

Em dash

Option-Shift-

Em space

"m

Command-Shift-m

En dash

"=

Option-

En space

">

Command-Shift-n

Index entry marker

"·
I

n/a

In line graphic marker

"g

n/a

Line end (Shift-Return)

"n

Shift-Return

Nonbreaking hyphen

"-

Command-Option-

Nonbreaking space

"s

Option-Spacebar

Nonbreaking slash
Optional hyphen

"I
"-

Command-

Page number marker

"# or " 3

Paragraph end (Return)

"p

Command-Option-p

Question mark

?

?

Registered trademark (®)

®

Option-r

Tab

"t

Tab

"<

Command-Shift-t

TM

Option-2

Thin space
Trademark symbol

(11'1 )

Command-Option-/

Typographer's open quote

Option-[

Typographer's close quote

Option-Shift-[

Single open quote

Option-)

Single close quote

Option-Shift-]

White space

"w

Spacebar
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Options. Select the Match case option if you want the search to be limited to the

exact capitalization entered in the Find what option box, or leave this option
deselected if you want to find that text regardless of its capitalization. Select the
Whole word option if you want to search to locate the text when it is an entire
word or phrase and not a component of another word or phrase. (For example, a
search for and that is not limited to whole words would also find Andy, Band, and
Operand. If the search is limited to whole words, these occurrences would not be
found.)
•

Search Document Use this option to limit your search to the current publication

only or to include all open publications.
•

Search Story. This option determines what text is searched. Selecting the
Selected text option limits the search to text that was highlighted before the
Find ... command was chosen. Selecting the Current story option causes the
search to begin at the current location of the insertion point, continue to the end
of the story, and then ask if the search should start again at the top of the story.
Selecting the All stories option instructs the search to begin at the top of the first
story that was placed in the publication and continue through each story in the
publication in the order in which they were imported. If the Search document
option is set to All publications, the search will then continue through the stories
in each open publication.

•

Atbibutes... button. Clicking the attributes button brings up the Attributes

dialog box, shown in Figure 7-25. By selecting a paragraph style, font, type size,
and type style in this dialog box you can limit your search to text that matches
these selected attributes; or if no text was entered in the Find what option, it will
search for any text matching these attributes. Select the desired attributes from
the pop-up menus and then click the OK button to return to the Find dialog box.
Find nttrlbutes

H

Find:
Pnrn style: ~

( Cnncel )

OK

H

Font:
pn
Size:
~I>
Type style: Rn

Figure 7-25: The Attributes dialog box lets you search for text by its formatting rather than
its content .
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With all of the Find dialog box options set, click the Find button to begin the search, or
click the Cancel button to return to the story editor without executing the search. As
the search proceeds, PageMaker will highlight results that match the search. The Find
dialog box remains on-screen when a match is found, and the Find button changes to
Find next. If the text that is found is not the text you are looking for, click the Find next
button to search for the next matching occurrence. if necessary, you can move the Find
dialog box to a new position by dragging its title bar.
When PageMaker finds text that you want to edit, you can close the Find dialog box by
clicking its close box, or you can click in the story and begin editing the selected text.
To restart the search using the same search parameters , choose the Find next command (Command-,) from the Edit menu. This will locate additional matching text, if it
exists in the selected search range, and highlight that text. At this point you can edit the
text or continue to search by again choosing the Find next command (Command-,).

The Change command
The Change ... command (Command-9) is used to locate a specific text or style attribute
and replace it with another text or style attribute. For example, you might want to find
each italic occurrence of Father Smith and change it to Rabbi Rosen in bold text. Or you
might want to find all 9-point text and change it to 10 point.
The options in the change dialog box (shown in Figure 7-26) are almost identical to
those in the Find dialog box, as described earlier.
Figure 7-26:
The Cha nge dialog
box is used to
perform search and
replace operations.
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These are the only unique options:
•

Change to. This option box is used to enter text that should replace the text
entered in the Find what option box. As in the Find what option box, special
characters can be used in this option box (see the list earlier in this section), but
wild-card characters (?) cannot.
When changing text attributes regardless of the specific text, leave this option
blank.
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Attributes... button. The Attributes dialog box now includes two sets of options,

one for the search text and one for the change text.
After completing the Change dialog box options, four buttons are available to
execute your search and replace operation. If you do not want to execute the
search and replace, click the close box in the upper left corner of the Change
dialog box to return to the story editor.
•

Click the Find button to locate the first occurrence of the text and attributes
selected. PageMaker will highlight the text it finds, and you can then click the
Change button to execute the replacement, the Change & find button to execute
the replacement and find the next occurrence, the Find button to skip the
replacement and find the next occurrence, or the Change all button to execute
the replacement and change every other occurrence in the selected text range.

•

The Change button is available only when text matching the search attributes is
selected, usually as a result of the Find button. Clicking the Change button
replaces the selected text with the text in the Change top option box and/or the
attributes set in the Attributes diaJog box. After executing the change, you can
e ither close the Change dialog box by clicking its close button or click the Find
button to locate the next occurrence of the search text, or the Change aJI button
to change every other occurrence in the selected text range.

•

The Change & find button is available only when text matching the search
attributes is selected. Clicking this button executes the replacement and finds
the next occurrence of the search text or attributes.

•

Clicking the Change all button finds each occurrence of the search text or
attributes and replaces it with the new text or attributes, without stopping each
time to confirm the replacement. When this button is clicked, a progress dialog
box shows the number of replacements made.

PageMaker does not allow you use the Undo command to undo any changes made in
the Change dialog box, but you can undo changes by reversing the options, searching
for the text or attributes you changed to, and replacing them with the text or attributes
you changed from.

TheSpell[ngconunand
You can spell check any or all stories in your publication by choosing the Spelling
command (Command-L) from the Edit menu. This brings up the Spelling dialog box,
shown in Figure 7-27. If you want to spell check only a portion of your text, select that
part of the text before choosing the Spelling command.
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Figure 7-27:
The Spelling dialog
box in the story
editor.
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Rdd ...

181 Rlte rnote s pe llings 181 Show duplicates
Scorch docume nt: 0 Current publlcllti on ® All publlco tlons
Search s tory: 0 Selected teu t 0 Current s t ory ® Rll s tories
Options:

If any text was selected when the Spelling command was chosen, the search option
Selected text will be selected . If not, the Current story option will be selected. Uyou want
to check the s pelling in all stories in the current publication, choose the All stories option.

Initiate the spell-checking process by clicking the Start button or pressing Return.
PageMaker will then begin to search the specified text range. When a suspect word is
found, PageMaker highlights the word in the story windo, and displays it in the Change
to option box. Above the Change to option is a brief description of the problem with the
suspect word. A list of possible correct words appears in the scrolling list below the
Change to option. If the Spelling dialog box is in your way, you can move it by dragging
its title bar.
At this point, you have several possible actions:
•

To replace the suspect word with a word from the suggestion list, simply click
the replacement word and then click the Replace button or press Return.

•

To manually correct the suspect word, edit the text in the Change to option and
then click the Replace button or press Return.
You can also click in the story window to manually edit the text directly in the
window. This causes the Spelling dialog box to disappear, and you will have to
reselect the Spelling comma nd (Command-L) to continue the s pell-checking
process. (Be sure no text is selected when you re-execute the Spelling command,
or the Selected text search option will be chosen, and you will have to select the
Current story option to complete the s pell-checking operation.)

•

H nothing is wrong with the s uspect word, click the Ignore button (or press

Return if the Ignore button is highlighted).
•

H you want to add the suspect word to your own dictionary so PageMaker will

not flag it as sus pect in the future, click the Add ... button, and the Add word to
user dictionary dialog box, shown in Figure 7-28, will appear, with the suspect
word entered in the Word option box. PageMaker a utomatically adds tilde (-)
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symbols representing possible hyphenations of the word. You can remove these
symbols by deleting them if you do not want the word to be hyphenated in that
way, or add additional tilde characters to mark other possible hyphenations. As
in the Hyphenation dialog box, three consecutive tildes represent the preferred
hyphenation, two consecutive tildes are the second-best hyphenation, and single
tildes are Jess desirable but legitimate hyphenation points.
Click the OK button when satisfied with the new word and its hyphenation, or
the Cancel button if you decide not to add this word to your dictionary.
Rdd word to user dlclion11ry

II

Word:
[sumpt4ous
Dictionary: ~~U~S~En=g~lls~h~l------'

( C11ncel ]

Rdd:

0 Rs olltowercose

OK

I

[ne moue]

@ Enoclly 11s typed

Figure 7-28: The Add word to user dictionary dialog box.

Continue working in the Spelling dialog box until all of your text has been checked, and
then click the close box in the upper left corner of the title bar to return to the story
editor. To return to the layout view, choose the Edit Layout command (Command-E)
from the Edit menu, the Replace command (Command-D) from the File menu, or click
the close box in the story window (or all open story windows).

The Clipboard, Edition Files,
and OLE
Everyone who uses the Macintosh is familiar with the Clipboard, which lets you cut or
copy text or graphics and then paste them back into the same file or into another file.
PageMaker of course supports the Mac's Clipboard, and in addition it supports two
extensions to the Clipboard mechanism, System 7's edition manager (sometimes called
Publish and Subscribe), and Microsoft's OLE (Object Linking and Embedding).

The Clipboard
The Clipboard may seem like a strange way to get text into a PageMaker publication,
but in fact it is quite handy and can even let you bring in text that cannot be brought in
using any other method. This is true because anything that you can cut or copy onto
the Macintosh Clipboard can be pasted into PageMaker. This includes text or graphics
obtained from several different sources:
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Within the current publication. The Clipboard can be the fastest way to move a
text block from one page to another-but r emember that when you cut or copy a
text block, it becomes disconnected from any other threaded text blocks.

•

Another PageMaker publication. The trick was very handy before PageMaker
supported multiple open publications and allowed you to drag text or graphics
between two files. But even now it can still be convenient.

•

A document in another application. Since virtually every application on the
Macintosh lets you copy to the Clipboard, this lets you transfer text from many
programs whose files cannot be placed directly into PageMaker (because they
are not compatible with PageMaker import filters). To do this, cut or copy the
text you want to transfer, open PageMaker and the publicati on you want to add
the text to, and choose the Paste command.

•

The Scrapbook. The introduction of MultiFinder , and then System 7, diminished
the role of the Scrapbook on the Macintosh, but it still represents a good way to
temporarily store text and graphic elements that you need to move from one
program to another . PageMaker is fully compatible with all file formats supported by the Scrapbook, so anything you can put in the Scrapbook you can
copy and paste into PageMaker.

The Paste command
In most cases you'll use the Paste command just as you would in any other application:
Choose Paste from the Edit menu (Command-V), and the text or graphic elements will
appear on the current publication page. In some cases, however , PageMaker works a
little differently than other programs.
When you paste text from another application or text that was selected with the text
tool and cut from a text block elsewhere within PageMaker, a new text block is created
on the current publication page. If you paste text that was cut as an entire text block
(selected with the arrow tool) from within PageMaker, the pasted text block will retain
its original size. In either case, after the Paste occurs, the cursor automatically becomes
the arrow tool, and you can then move or resize th e resulting text block as explained
next.

An option for pasting text is to use a form of the drag-placing trick in troduced earlier:
Create a new text block by dragging with the text tool, and then choose the Paste
command (Command-V) to flow the text into the new text block. If the entire selection
of pasted text will not fit within the text block , a down arrow will appear in the handlebar tab at the bottom of the text block. You can then flow the remaining text as described earlier. The drag-place method will not work if the Clipboard contains more
than one text block or if it contains both text and graphics.
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Another option, if the Clipboard contains text, is to add the pasted text to an existing
text block. To do this, set the text insertion point in any existing text block at the point
where you want the text to be inserted, and choose the Paste command. The text will
be added just as if it had been entered from the keyboard. Of course, all subsequent
text in the story will flow downward through the text blocks, so you should check the
end of the last text block to make sure all text remains visible.

The Paste Special command
When you copy text or graphic elements to the Clipboard, some applications provide
the Clipboard with information in more than one file format. When you then use the
Paste command, PageMaker automatically selects the file format that it can use most
easily or accurately. The Paste Special command allows you to choose which of the
avaHable file formats is used to transfer the contents of the Clipboard into PageMaker.
When you choose Pas te Special, the available file formats for the current contents of the
Clipboard are listed in ranked order of which PageMaker can best import, as shown in
Figure 7-29.
Figure 7-29:
The Paste Special dialog
box lists all file formats
available for the current
contents of the
Clipboard.
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System 7 edition files
System 7's edition manager was supposed to be the next step beyond the Clipboard in
allowing elements to move between Macintosh applications. Through its Publish and
Subscribe commands, the edition manager provides a way to export text or graphic
elements from one System 7 sawy application (Publish) and import them into any
other System 7 sawy application (Subscribe). Of course, thjs is just what you can do
with Copy and Paste, but with Publish and Subscribe the link between the source
document and the destination document remains alive. This means that if the original
document changes, the text or graphics transferred via Publish and Subscribe can be
manually or automatica lly updated to reflect those changes.

1
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Publish and Subscribe perform as advertised, and due to some strong-arm tactics by .
Apple Computer, nearly every program updated since the release of System 7 includes
these features. Still, very few people appear to actually use these capabilities to transfer
elements between their applications. It could be the stupid names, it could be the
clumsy interface, it could just be another symptom of the whole System 7 marketing
flop. Who knows?
PageMaker supports the Subscribe half of Publish and Subscribe, letting you import
elements (called edition files) that were exported using the Publish command in other
applications. You cannot Publish from within PageMaker, which means you cannot
create new edition files of text or graphic elements from inside your publication. Aldus
has placed the Subscribe commands in the Editions submenu in the Edit menu. Choosing the Subscribe to command brings up the Subscribe to dialog box, shown in Figure 7-30.
This dialog box allows you to select any edition files you want to import into your
publication, and after s ubscribing to an edition file, it presents the Subscriber options
command. This command brings up the Subscriber options dialog box, shown in Figure
7-31, which you can use to dete rmine when updates made in the original file will be
passed through to the PageMaker publication, or to open the original a pplication and
the original document file.
Figure 7-30:
The Subscribe
to dialog box is
used to import
edition files.
You can also
import t hese
files w ith
the Place
command.
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You do not, however, ever have to use these commands, even if you want to work with
edition files. You can uSubscribe" to edition files by simply placing them with the Place
command just like any other text or graphic element, update their external links using
the Links command and launch the application that created the original document, and
open the original document, us ing the Edit original command.

OLE objects
Microsoft's answer to System 7's edition manager is a technology called Object Linking
and Embedding (OLE), which is available for both Windows and System 7. Like the
edition manager, OLE provides a way to move elements from one application to another
and have any changes made to the original document pass through to copies that are
used within other documents. Actually, OLE provides two ways to do this. OLE-linking
works very much like the edition manager, in that a new data file is created to hold the
elements exported from the source application (the OLE equivalent of the Publishing
application), and that data file is then imported into the destination application (the
OLE equivalent of the Subscribing application). OLE-embedding, on the other hand,
does not require that a new data file be created; instead the original document from one
application is itself imported into the destination application.
PageMaker supports both OLE-linking and OLE-embedding. Although OLE is not as
widely supported on the Macintosh as the edition manager, it is supported by all
Microsoft applications, including the immensely popular Word and Excel.

The Paste Link command
To create an OLE-link, all you have to do is copy text or graphics from a document in an
OLE compatible application (which is technically !mown as an OLE server), switch into
PageMaker, and then choose the Paste Link command. The Clipboard contents will then
appear as a new object in the publication window.
You cannot edit OLE-linked text or graphics within PageMaker but instead must edit
them using the application that created them. To do this, select the OLE object and
choose the Edit Object command from the bottom of the Edit menu, or triple-click on
the object itself. This will launch the application that created the object and open the
document from which the object was copied. Edit the document to your heart's content
and then choose the Update command from the application's File menu. Close the
document or quit the application if you want, and then switch back into PageMaker.
Any changes you made will automatically be reflected in your publication.
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If you do not want changes made to the original document to automatically transfer to
the OLE-linked object in your publication, select the object, choose the Link options
command from the Element menu, and deselect the Update automatically option. (A
complete discussion of PageMaker's Link options is presented in Chapter 16, "Long
Document Features." See the discussion there for more details.)

The Insert object command
The Insert object command lets you use any OLE-server application on your Mac to
create new elements for your publication, and initiate this process from inside of
PageMaker. To begin, choose the Insert object. .. command from the Edit menu. This
brings up a list of the kind of objects you can create using the OLE-compatible programs on your hard drive, as shown in Figure 7-32.
Figure 7-32:
The OLE objects list dialog
box from the Insert object
command.
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Select the type of object you want to create and click OK. This will launch the program
that you'll use to create the object. A new document is automatically opened, and you
can then create the text, spreadsheet, or graphic using any of the tools and features
that application provides. When you've finished, choose the Update command from the
File menu, close the document or quit the application if you want, and switch back into
PageMaker. The new element you created will automatically be imported into your
PageMaker publication as an OLE-embedded object. Figures 7-33 and 7-34 show the
process.
Now that this OLE object is in your PageMaker publication, you can edit it at any time
by selecting it and choosing the Edit object command from the bottom of the Edit menu
or by triple-clicking on the object itself. The application that created the object will be
launched , and the document containing the element will be opened.
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Figure 7-33:
An Excel
document
being created
for use in
PageMaker.
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Figure 7-34: The
finished Excel
worksheet in the
Page Maker
publication.

_ 1)o

II

Jenuery Newslette
.J

~

.~

,:'I

.~1

.1 .

.:'1

.J

r • •O OoOo Oo OOO OO O O O OOOOO OO OOOOOOOO Oo O OO OO OOO OOO O O OOo OO OOoOO O O O OOOO O OO O OOOOOO oo o oo ooo oo o o o o o o oo o o

f e ntral Region Continues Sales Domination
;..,

!"-,

fwllh res.~lb fran the lost four qucrters nowa:>mp ete, It cnn l::e """"
fn; lhaJt queolion h at rur best roles r!!p'eo!nbtlle5 ere II 'ling a nd 'Ml'king
)n tleoe1trd regen. Fer lhefiflh straight ye::v the Cenrof regen •runced
'epre!e'lb llle5 frantle East and Sovtl regons, to w n tle mnt.d roles
~· sweepsltkes.

fL

Expo~gText ________________
After editing text in PageMaker, you will occasionally want to export your text out of
PageMaker into word processing (or text-only) format. This allows you to take advantage of the superior text-processing features provided by most word processors or to
use the text for some other purpose.
PageMaker allows you to export any amount of selected text, or an entire story, to a
disk file in text-only or word process ing format. The word processing formats available
to you depend on the import/export filters available in the Filters folder inside the Aldus
folder that is in your System folder. Files exported to one of the word processing
formats will retain all of the c haracter- and paragraph-formatting attributes that were
applied in PageMaker. Style sheets used to format text that is exported to Microsoft
Word will also be converted and included in the exported file. Style sheet tags can be
included in any exported text file, regardless of the export format.
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To export text, select the text you wish to export, or, if you wish to export an entire
story, set the insertion point anywhere in the story. Choose the Export ... command
from the File menu, and the Export document dialog box will appear, as shown in Figure
7-35. Select the File format that you wish to use for your exported file from the scrolling
list on the right side of the dialog box. Check the Export option, and select the Entire
story option if you want to export all the text within the currently selected text block. If
the insertion point was set but no text was selected when the Export ... command was
chosen, the Selected text only option will be dimmed.
Figure 7-35:
The Export document
dialog box is used to
save stories from your
publication in standalone text files.
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Click the Export tags check box if you would like style sheet tags to be placed before
each paragraph in the exported document. Style sheet tags consist of the style sheet
name placed between the less than ( <) and greater than (>) characters. By exporting
style sheet tags, you make it possible to use the Read tags option in the Place document
dialog box when importing the document back into PageMaker, thereby retaining all
style sheet links. Microsoft Word users do not need to use this option, since style
sheets are exported to and imported from Microsoft Word files automatically.
Enter a name for your exported file in the option box below the scrolling file list. Any
legitimate Macintosh filename is acceptable. Use the folder bar, folde rs, drive icon, and
Eject and Desktop buttons to select the location to which your exported file will be
saved. When satisfied with a ll of the options, click the OK button or press the Return
key to save the exported file, or the click the Cancel button to abort the export process
and return to the publication window.
After editing your exported file in a word processor, you can reimport it into
PageMaker, replacing the existing text with the updated file or placing it into a new
publication. All of these options were described earlier in this chapter.
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••••••••••••••••••••••••••••••••••••••••••••••••
Summary
•

Text exists in PageMaker publications as logical stories and in physical text
blocks. Text flows through the various text blocks of a story as you adjust the
size of the text blocks.

•

You can resize text blocks by dragging on the handles that appear when the
text block is selected or by pulling the tabs on the top or bottom text handlebars.

•

Text is imported into PageMaker using the Place ... command. PageMaker
uses import filters to convert text from virtually any word processor into the
format that it stores in your publications. In most cases, all formatting will
transfer perfectly.

•

If any font in the imported document is unavailable, you can use the PANOSE
font matching system built into PageMaker to select the fonts you want to
substitute for those that are missing.

•

You can flow text into PageMaker text blocks using the manual, semiautomatic, or automatic text flow methods. You can also create text blocks by dragplacing text with the text cursor.

•

The story editor is a mini word processor built into PageMaker. It lets you see
text in a legible font and type size regardless of how the text is formatted in
your publication, and provides Font, Change, and Spelling commands.

•

You can export the text from any PageMaker story, saving it in a new font on
disk in text-only format, or in the format of many popular word processing
applications .

••••••••••••••••••••••••••••••••••••••••••••••••
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Creating Your Publication
1. To begin creating your publication, first launch PageMaker. There are several
ways to do so.
•
•

Double-dick the PageMaker icon on your desktop.
Select the icon or filename, and choose the Open ... command from the
File menu, or press Command-O.
• Use a launching application or utility such as Now Utilities, QuicKeys,
or On Cue.
Click your mouse button anywhere on your display to dispense with the copyright screen.
2. Choose the New ... command from the File menu or press Command-N to bring
up the Page setup dialog box, in which you delineate specifications for many
global attributes of your document. Set the options as follows:
Double-sided: selected

Page size: Letter
Orientation: Tall

Facing pages: selected

Start page #: 1

#of pages: 2

Margin in inches: Inside: 0.5, Top: 1, Outside: 0.5, Bottom: 1

Figure 8-2 shows the completed Page setup dialog box.
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Figure 8-2: The Page setup dialog box containing your newsletter specifications.

(Note: This project uses inches as the unit of measurement. To make this the current
Measurement system, use the Preferences .. . command in the File menu.)
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Tips for working in dialog boxes:
•

When selecting or deselecting radio-button or check-box options, you can click
either inside the circle or square or on the option name next to the button or box.

•

Press the Tab key to move to the next option box, selecting the current value
there. Once selected, enter a new value to replace the selected value if necessary.
Press Shift-Tab to move backward between option boxes.

•

Double-clicking on the value in an option box will also select it so that it can be
overwritten (replaced).

•

Setting the insertion point in an option box allows you to use the Backspace or
Delete key to delete existing values.

When you have finished entering the specifications for the new publication, click the OK
button or press Return or Enter to instruct PageMaker to create the document as you
have specified.
A new publication window displays, showing the first page of your publication, as
shown in Figure ~3. The on-screen display includes page icons for the left and right
master pages as well as pages 1 and 2, the toolbox, scroll bars, and the rulers. Your
display may be different if the default settings have been changed. (If the rulers are not
visible, press Command-R.)
Ill

Untitled· I

Figure 8-3:
The new
publication
window
resulting from
your page
specifications.

:'1

•.1 .

-~

I81 ToolboH

D '- 11- IA
~l o l o ltl

,,...,

198

Part II: Mastering PageMaker

Preparing the Master Pages
Every PageMaker publication has one or two master pages (one if your document is
single-sided, two if the double-sided option in the Page setup dialog box is selected).
These master pages are used to hold items that repeat from page to page, such as
running heads or footers, page numbers, or graphics. By placing repeating elements on
the master pages, you ensure that they will be positioned exactly on each page. This
procedure saves you the effort of repeatedly positioning identical elements from page
to page.
Master pages can also hold column guides and ruler guides, which can be used to
create an alignment grid for elements that will be placed on the actual publication
pages. For example, you may want the top of specific kinds of text blocks to begin some
distance below what has been defined as the top margin of your pages. By placing a
ruler guide at this position on the master page, you can easily and accurately execute
your design without the effort and potential for error that can result from measuring the
correct distance on every page.

The left master page
To add a simple rule and company logo to the bottom of each page in your newsletter,
do the following:
3. Click on either of the master page icons, labeled Land R (for left and right) in the
lower right corner of the display. The master pages appear in the publication
window.
4. Command-Option-Click anywhere in the bottom half of the left page. This magnifies your screen display to the Actual size view size. Then move the page with
the hand icon-accessed by pressing the Option key and clicking with your
mouse-until you can clearly view the bottom margin of the left page.
5. Drag downward from the horizontal ruler at the top of the display to create a
ruler guide. This guide can be dragged up and down, very much as you would
drag a block of text or other element. Drag the ruler guide until it is one-quarter
inch below the bottom margin. This defines the location of the top of your simple
line and logo.
6. Select the perpendicular line tool. Draw a line across the bottom margin of the
left page, extending from the left margin to the right margin. While drawing your
line, dragging into the edge of the window will scroll the display as needed.
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7. Select the arrow tool. Drag the line directly downward. Since you want to change
only the vertical position of the line, press and hold the Shift key, and the movement of the line will be constrained in the first direction that you drag. For
example, if you drag the line upward while pressing the Shift key, the line can
move only up and down- not diagonally or horizontally. This allows you to
precisely position your line in one direction without disturbing its position in
another direction. Using the Shift key to constrain movement works when
moving any graphic or text element in PageMaker as well as in many other
Macintosh applications. After pressing the Shift key, drag the line downward
until the line snaps to the ruler guide.
8. While the line remains selected, change its weight (thickness) by choosing the
Line command from the Element menu. Hold down the mouse button as you
choose this command, and a hierarchical pop-up menu of available line weights
displays to the right of the Element menu. Keeping your mouse button pressed,
move the arrow cursor horizontally in the direction of the hierarchical list until
one of the line weights becomes highlighted. You can scroll up and down to
choose different weights. After a little practice, working with these hierarchical
pop-up menus will be almost as easy as any other mouse operation. Release the
mouse when you are satisfied with your line weight selection. In this case,
choose the 2 pt option.
9. Drag another ruler guide, this time from the vertical ruler on the left of your
display. Move this guideline until it lines up with your right margin (making sure
that you are still on the left master page). This will help you in locating the
company logo.
10. To represent the company logo, select the rectangle tool and draw a rectangle
one inch wide and one-quarter inch high. While the rectangle is still selected,
choose the Hairline option from the hierarchical Line menu. Then choose the
tight crosshatch pattern (third from the bottom) from the Fill pop-up, which is
also under the Element menu. With the arrow tool, position the makeshift logo
one-eighth inch below the 2-point line that runs across the bottom of the page.
The right side of the logo should be flush against the vertical ruler guide, as
shown in Figure 8-4.
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Figure 8-4: The left master page containing the line and logo elements you have created
thus far.

The right master page
11. You now need to make a mirror image of your line and logo for the right master
page. First, select both elements. You can do this by dragging with the arrow
tool, surrounding the line and logo with a rectangular marquee. Or you can click
on the line and then Shift-Click on the logo. After both elements are selected,
choose the Copy command from the Edit menu or press Command-C. This puts a
copy of both items into the Macintosh Clipboard, to be used later at your convenience.
12. Scroll over to the right master page, using the scroll bars or the hand tool
(accessed by pressing the Option key and clicking).
13. Notice that your horizontal ruler guide appears on this page too. Horizontal
guides always show up on both pages of a facing-page spread. However, you are
missing the vertical ruler guide. So drag a guide from the vertical ruler, aligning it
with the left margin of the right master page.
14. Choose the Paste command from the Edit menu or press Command-V. This
produces a copy of your simple line and company logo in the center of your
display. You want to position these elements slightly differently on the right
master page than you did on the left master page.
15. When you paste one or more elements, they are selected immediately after they
appear on your screen. This is so they can be positioned easily. Taking care not
to deselect the line and logo, drag at either element. If you begin your drag
quickly, PageMaker represents the position of two elements as a thinly outlined
rectangle. If you click and hold for a moment before moving your mouse,
PageMaker correctly represents both elements as you drag. Move the elements
so that the 2-point line snaps under the horizontal ruler guide and the left side of
the line is flush with the vertical guide.
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16. Deselect both elements by clicking on a blank area of your display. Then scroll
rightward, if necessary, and select the new copy of the company logo. For
purposes of this exercise, you want the logo to be on the left side of the right
master page, a mirror image of the left master page. While constraining your drag
by pressing the Shift key, move the logo until its left side is flush with the vertical
ruler guide.
Figure 8-5 shows how the completed master pages look.

Figure 8-5:
The left and
right master
pages as they
now appear.
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Adding a Masthead to Page 1 _ __
Now that you have your master page elements in place, you will want to add a masthead to the top of page 1. The masthead, also called a flag, is the title of your newsletter,
represented in an eye-catching manner that visually states your purpose.

Creating the masthead text
17. Click on the page 1 icon to turn to page 1. You could also use the Go to page ...
command from the Page menu (Command-G), but it is usually faster to click the
page icon or press Command-Tab.
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18. Zoom in to the top area of page 1 by Command-Option-Clicking. Select the text
tool from the toolbox and position the text entry cursor (also known as the !beam) in the upper left corner of the page, just inside the top and left margins.
Click the mouse button and a flashing vertical cursor will appear against the .left
margin. The flashing 1-beam cursor indicates that you are ready to enter the text
for your masthead.
19. Suppose that you decide to call your newsletter Information! As you type the
characters 1-n.f-o-r-m-a-t-i-o-n-!, you will notice that they emerge from the left
margin in 12-point Times Roman. This is the default type size and typeface
specification used by PageMaker. On the second sample project, you will learn
how to alter the default settings used for type size, typeface, and many other
PageMaker options.)
20. To change the typeface and type size of your masthead, you must first select the
text you want to alter. PageMaker uses the same principles of selection and
modification employed by most Macintosh word processors: Text must be
selected (highlighted) for any of its attributes to be changed. There are several
ways to select text in PageMaker:
•
•

•
•

Drag the 1-beam cursor over the text to be selected.
Double-dick on a word in the text block to select the entire word.
Select additional text one word at a time by holding the mouse button
down after the second click and then dragging.
Triple-dick on a word to select the entire paragraph.
After setting the text entry cursor within a text block, choose the Select
all command (Command-A) from the File menu to select the entire
story, even if it spans many text blocks on many pages.

In this case, you want to select the entire text block, which consists solely of the
word Information!, so you can use any of these techniques.
21. Once the text block is selected, choose the Font command from the Type menu.
A hierarchical list of typefaces loaded into your System file or opened with
Suitcase II or MasterJuggler will appear. Choose the Helvetica option from this list.
22. Choose the Size command to display a pop-up list of commonly used type sizes.
Choose the 48-point option. The result is a much-enlarged version of your
masthead, which is more impressive and eye-catching than the original 12-point
Times type.
23. Choose the Type style command from the Type menu to display a pop-up menu
listing of styles, and choose the Bold option (or press Shift-Command-B).
24. To center your masthead, choose the Alignment command from the Type menu;
then choose the Align center option from the corresponding pop-up listing (or
press Shift-Command-C).
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Your masthead text now appears in the font, type size, type style, and horizontal
position shown in Figure 8-6. To adjust the vertical position, you must first learn a little
about PageMaker text blocks.

Figure 8-6:

The 72-point,
Helvetica Bold
masthead as it
appears
centered on
page 1.
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A PageMaker text block is a discrete element that can be selected, moved, resized, and
deleted. Text blocks are created automatically when you enter new text after clicking
with the text tool or when text is imported using the Place ... command from the File
menu. When selected, text blocks ar e marked by handlebars that appear on the top and
bottom of the text block. As you shall see, handlebars can be moved in relation to each
other by dragging at the small tab that extends upward or downward from the middle of
the handlebar. To see the text block for your masthead text, select the arrow tool from
the toolbox and click on the word Information!
With handlebars displayed, you can change the position of a text block by dragging it.
Press and hold the mouse button down while pointing anywhere in the text block
except on its handles or tabs. Since you want to alter only the vertical positioning of the
text block, press the Shift key to constra in the drag movement. Another method of
vertically positioning a text block without disturbing the block's horizontal positioning
is to drag the tab on the upper handlebar of the text block. By dragging upward on the
handlebar and releasing, you cause the text block to rise. Dragging downward on the
upper handlebar lowers the text. Note, however, that when you drag downward, the
bottom handlebar will often remain motionless, so a line or more of text may remain
hidden. If this happens, drag downward on the lower handlebar, which will contain a
small down arrow. (fhe later portion of this chapter includes more information on
using the lowe r handlebar tab of a text block.)
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25. Move the masthead text vertically, either by dragging the text block while
pressing the Shift key or by dragging the tab on the upper handlebar, until the
top of the text block snaps to the top margin (see Figure ~7).

······--·····-·················-······-······- ····..n···-·}·····-·········-··········-······-·······-····

r 1-n-f-o-r-m-a-t-i-o-n-!
u

I
Figure 8-7: Move the text block upward by dragging its upper handle until it snaps to the
top margin .

Isolating the masthead from the newsletter
If you were to stop now, you would s imply have a big word at the top of a page. There is
nothing to distinguish the mast head from other large blocks of text, such as headlines.
Although you won't be creating any 72-point headlines, the sheer immensity of a
masthead is not necessarily enough to instruct a reader as to the purpose of this text
block. But a simple graphic can go a long way to visually establishing a masthead for
what it is. You will be using the simplest of all graphics - a straight line - to set your
masthead apart from the rest of your newsletter.

26. Add an ~point rule under your Information! text. First, with the arrow tool, drag a
guide down from the horizontal ruler to a point about one-quarter inch below the
masthead text. Then select the perpendicular line tool from the toolbox and
position the cursor at the intersection of the vertical ruler guide (from the right
master page) and the new horizontal guide. Draw a line to the right margin so that it
stretches across the page. Make s ure to drag slightly down from the horizontal guide
so that the line sits just under the guide. If your view size does not display the
entire width of the page, PageMaker will automatically scroll your display.
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27. With the line selected, choose the 8 pt option from the Line pop-up listing under
the Element menu. If you created your line under the guide as instructed in the
previous step, the 8-point weight of the line will appear below the guide as shown
in Figure 8-8.

1· · · .... ,.~-r,..~t·~-o~· r·~·m:a~-~~l:o·~·ri~l·········

----------------------~~~

. . .. . . . . , . i

Figure 8-8: The completed masthead with text and an 8-point line.

Column Guides --------------------------------------Now that you have completed the masthead, you are ready to add the first article to
your newsletter. The format that you are going to use calls for the lead article to be set
in two columns directly below the masthead. It is advisable to always define your
columns prior to pouring any text.
28. Choose the Column guides ... command from the Layout menu. This command
allows you to define up to 20 columns per page and to also specify the amount of
space between columns. Choosing this command br!ngs up the Column guides
dialog box, which is shown in Figure 8-9. This dialog box defines the number and
placement of equidistant column guides for the current page or pages. Setting
the column guides while working on the master pages affects the guides on all
corresponding publication pages. In this case, you want to enter 2 for the Number of columns option and define the Space between columns as 0.5 (assuming
you are still using inches as the units of measure). Click the OK button to instruct
PageMaker to close the dialog box and add the specified column guides to the page.

n

Column guides

OK

n

[ Cancel )
Number of column s:
Spoce between column s:

'-l.o_~.:...._--'llnches

Figure 8-9: The Column guides dialog box contains the number of guides plus gutter
specifications.

206

Part II: Mastering PageMaker

To define the two columns, PageMaker has added three column guides to your page.
One is in front of the left margin guide, one is in front of the right margin guide, and one
is in the middle of the page with a one-half-inch gutter between its two sides (according
to your specifications in the Column guides dialog box). The amount of room between
the left and center column guides and the center and right column guides is equal.
PageMaker simply subtracts the combined gutters from the total width of a page and
divides that amount by the number of columns. The result is the width of each column.
In this case, each column is 3.5 inches wide. (In later chapters, you will learn how to
move column guides to create individually wider or narrower columns.)

Placing Text
As discussed in the previous chapter, you can prepare your text in a word processor
before using it in PageMaker. For the lead article in this newsletter, you will import a
document previously created in a word processor.

29. Before you import the story text, drag down another ruler guide, which you will
use to align the top of the text into the columns on your page. Drag the guide
down from the horizontal ruler to a location about two inches below the
8-point line.

Importing an article from a word processor
30. After you choose the Place ... command from the File menu (Command-D), the
Place document dialog box (shown in Figure 8-10) appears, allowing you to select
the text file to be imported and to specify the way in which the text is used.
Ploce document

lei! PM Dible ChB Files f .... J
~

0 Main Story I

[ l:ject ]

I[

[Desktop]

[ Concel ]
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D

= Dock Dolo

D Poge 2 Sidebar
D Poge 2 Story I

Pl oce:
® Rs new story

0
0
Options:

181 Retoin
181 flo1~Jln

fonnot

llt~fll<l< i!H.J l~ n tlrt~ S1 OJ'!)
ln~•~ rt i11 1J t l!l!t

181 Conuert quotes 0

Reod togs

<rOPI>iniJ duto

Figure 8-10: The Place document dialog box shows various options.
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The scrolling file listing and the Eject and Desktop buttons in this dialog box
provide the standard means for locating files on any available disks or in any
available folders. (Remember that you can use any text document that you have
ava ilable for this exerc ise, provided it is at least one page long.) Once you have
successfully located and selected a file to be used for the lead article, you may
want to examine and perhaps manipulate some of the Place document dialog box
options.
There are three Place radio buttons. The first option, As new story, is the only
option that is not dimmed a nd is s uitable for this purpose. (fhe remaining two
options are useful when replacing existing text.)
There are also three Options check boxes. The Reta in format option, which is
selected by default, instructs PageMaker to utilize exactly the text and paragraph
formatting of the incoming document. Deselecting this command would cause
the placed document to be stripped of its character formatting (such as fonts,
type sizes, and type styles) and paragraph formatting (margins, indents, and
tabs). The Convert quotes option alerts PageMaker to substitute an opening or
closing quote" or" in place of a leading or trailing standard quote("). If this
option is deselected, the quotation marks remain unchanged. The Read tags
option is used when style sheet tags have been entered into a word processed
document. I discuss style sheets a nd tags in more detail in later chapters.
31. Locate and select the Main Story 1 file in the Project 1 folder on the disk accompanying this book. Click the OK button or press the Return or Enter key. The
dialog box closes, and your cursor changes to the manual text flow icon, indicating that PageMaker is ready for you to put the selected a rticle into position.

Manually pouring a story
32. Position the manual text flow cursor at the intersection of the new ruler guide
and the leftmost column guide; then click your mouse button. The text from your
document will flow into the column, stopping when it reaches the bottom
margin. (Now, if you like, you can reposition your ruler guide.) Since the entire
document does not fit into a single column, there will be a down arrow in the tab
of the lower handlebar of the new text block, indicating that more text remains to
be placed.
33. Click on the down arrow, and the manual text flow cursor will reappear. Position
your cursor in the right-hand column, vertically aligning it with the beginning of
the text in the left column, and click the mouse button to begin the text flow in
this column. If enough text remains in the document, the text will flow down to
the bottom margin.
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34. Make sure that the tops of both columns are even with each other by selecting
each text block and then dragging each upper handlebar flush with the most
recently created horizontal ruler guide. If necessary, line up the bottoms of both
columns as well by dragging at the lower handlebars
Figure 8-11 shows how your document should appear now.

Figure 8-11 :
The result of pouring
an article into two
columns with a onehalf-inch gutter
between them.

Formatting Text
Now that you have placed your first story in position, you can change the character and
paragraph attributes of the text to fit both your design scheme and your personal
preference. In the following steps, you will change the font for the entire article; set the
type size, leading, and first-line indent; and create a headline as a separate text block.
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Changing type specifications
35. Click anywhere inside the first or second column of the text and press CommandA or choose the Select all command from the Edit menu. This ensures that
ensuing text changes will affect the entire article, even those portions you may
not have poured yet. Choose Helvetica from the Font pop-up listing under the
Type menu. Then choose the 10-point type size from the Size pop-up listing.
Your next step is to change the leading of your article. Like typeface, type size, and
other text attributes, leading can be altered by way of a pop-up menu. The unique
property of the Leading pop-up listing, however, is that the options offered vary depending on the current type size value. For example, if you select a 24-point type size,
the Leading pop-up listing will contain 23-point through 26-point options in half-point
increments, plus a few larger sizes. But if you select a 12-point type size, the half-point
variations are offered in the 11-point to 14-point range. As shown in Figure 8-12, the
solid leading value (equal to the current type size) is always displayed as bold.

Figure 8-12:
The Leading pop-up
menu as it appears
when the selected
text has 24-point
and 12-point type
size, respectively.
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36. Suppose that you want to change the leading to 12.5 points. Unfortunately, this
value is not included in the Leading pop-up list when the type size is set to 10point. To access other leadings, choose the Other ... option from the Leading
pop-up menu; the Other leading dialog box, shown in Figure 8-13, displays. Enter
12.5 into the option box and press Return. This gives you 10/12.5 type, or 10point type size on 12.5-point leading, which is an extremely legible combination
for most typefaces.
Other leading

It 4.3

Ipoints

I[

OK

D

[ Cancel )

Figure 8-13: The Other leading dialog box allows you to enter a leading that does not appear in
the pop-up menu.
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Changing paragraph specifications
37. To increase the legibility of your text, you need to add a first-line indent to and
some space below each paragraph. With your entire story still selected, choose
the Paragraph ... command from the Type menu or press Command-M. This
brings up the Paragraph specifications dialog box, which controls a number of
attributes that are applied to whole paragraphs. Here's a brief discussion of each
of the options offered by this dialog box.
The Indents options allow you to add specified amounts of horizontal space to
selected paragraphs. The horizontal space indicated by the Left value is added
between the left column guide and the selected text. The space indicated by the
Right value is added between the right column guide and the selected text. The
First option adds space between the left column guide and the first line of text in
the paragraph. You will be using the First option to add a first-line indent to the
newsletter text.
The Paragraph space options allow you to add specified amounts of vertical
space between selected paragraphs and their neighbors. The Before option
inserts space between the first line of a selected paragraph and the preceding
paragraph; the After option inserts space between the last line of a selected
paragraph and the following paragraph.
The Alignment pop-up menu allows you to select from five alignments: flush left,
centered, flush right, justified, or force justified. These options perform identically to the options available from the Alignment pop-up under the Type menu,
as explained in the following chapter.
Finally, the Options check boxes allow you to determine the manner in which
PageMaker breaks a paragraph at the end of a column. For example, you can
prevent two paragraphs from becoming separated or specify that a paragraph
never breaks between columns. Figure 8-14 shows how the Paragraph specifications dialog box appears.

n
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Figure 8-14: The Paragraph specifications dialog as it should appear before you click the OK button.
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For complete information about the Paragraph specifications dialog, refer to Chapter 9,
"Formatting Text."
38. Of the Indents options, change the First value to 0.25, or on~uarter inch. Also
change the After value in the Paragraph space column to 0.125, or one-eighth
inch. Then click the OK button or press Return, directing PageMaker to implement your changes. You can now see that your indents call attention to the
beginning of each paragraph. The space after each paragraph helps to set
paragraphs apart slightly. The result is two very readable columns of text.
Incidentally, if your paragraphs already contain introductory tabs or multiple spaces,
both of which are common typewriting devices for indicating the beginning of paragraphs, these should be deleted. First-line indents serve the same purpose and are
much easier to implement and manipulate. Figure 8-15 shows the formatted text.

Figure 8-15:
Your two
columns of
text, fully
formatted.
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Creating a drop cap
You will now create a drop cap, a design d evice for introducing your article to a reader.
You will set the first letter of your article in a larger type size, sticking up into the white
space above the first line of text. You will use one of the Aldus Additions that is included with PageMaker 5 to make the drop cap.

Ill

212

Part II: Mastering PageMaker

39. Select the first letter in the first paragraph of your article. Actually you don't
have to select the first letter, just set the insertion point anywhere in the paragraph to which you want to add a drop cap.
40. Go to the Utilities menu and hold down the mouse button while selecting the
Additions command. A submenu of available Aldus Additions appears. Scroll
down the submenu and choose the Drop caps Addition.
41. The Drop caps Addition dialog box now appears. Enter 2 into the Number of lines
option and click the OK button. The Addition will then manipulate the size of the
initial character and Insert tabs as necessary to have the other lines wrap around
the drop cap character. Figure 8-16 shows the completed drop cap.
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'
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Figure 8-16: The two-line drop cap as it appears when completed.

Adding a Headline
The only element that this article still lacks is a headline. A headline is needed to
introduce the article and summarize its purpose. You'll add this headline in the same
manner as you created the masthead-by typing it directly into PageMaker. Generally,
headlines are set as wide as the text they introduce. If an article is poured into a single
column, the headline should be one column wide. If the article is poured into two
columns, like yours, then the headline should stretch across both columns. Therefore,
you need to create a headline that extends the entire width of the image area, from left
margin to right margin.
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The problem here is that you have set up two columns. If you were to click with the text
tool in one of these columns, your headline text block would only be one column wide.
There are three ways to rectify this situation:
•

Choose the Column guides ... command from the Options menu and change the
Number of columns option to 1. This would return your page to a one-column
format and allow you to create a headline the width of the page. It will not alter
the format of any two-column text already positioned.

•

Click in one of the two columns and type in your headline text. When you are
finished, you can stretch the width of this existing text block to any width. (fhis
method is demonstrated in the intermediate sample project in Chapter 12.)

•

Override the column guides by drawing the width of your page with the text tool.
This is the quickest and easiest method, as demonstrated in the following step.

42. You will be using the third method of overriding the column guides by dragging
with the text tool. When you drag with the arrow tool on an empty portion of
your page, you create a marquee, which is useful for selecting multiple elements.
By dragging with the text tool, you also create a marquee of sorts. The dotted
rectangle drawn with the text tool, however, determines the width of your
column of text. Within the two-inch-high area between the masthead and the
columns of type, click on the left column and, without releasing, drag the entire
width of the page to the right edge of the right column. Figure 8-17 demonstrates
how your drag should appear.

Figure 8-17: Dragging the entire width of the image area with the text tool defines the width of
the text block.
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43. Once you have defined the width of your text block, you can type in your headline. I recommend Two Faculty Members From Domus Academy Excel at Via. You
may, of course, use this opportunity to express yourself creatively and enter
another headline.
44. Press Command-A to select all of the text in the headline. Change the typeface to
Helvetica and the type size to 36-point, using the same methods described
throughout this chapter. Also, make sure that the leading is set to Auto (ShiftCommand-A). Center the headline by pressing Shift-Command-C or choose the
Align center option from the Alignment pop-up listing under the Type menu.
45. Vertically position the headline text block evenly between the masthead and the
two-column article by Shift-dragging with the arrow tool. Figure 8-18 shows the
final headline.
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Figure 8-18: The fully formatted headline for your two-column article.

This ends the discussion of page 1. You have successfully created a masthead to
announce your news letter, a lead story to inform your readers, and a headline to
introduce the lead story. Figure 8-19 shows the completed first page. On page 2, you will
pour two more s tories and give each article a headline. You will also draw a box around
one of your stories to provide visual emphasis.
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Figure 8-19:
The first page of the
newsletter is complete, including
masthead, headline,
and two-column story.
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' mbers From
Excel at \t1a

Creating the Second Page
You are now ready to create the second page of this two-page newsletter. You will be
placing two more stories, both originally created using Microsoft Word.

Placing and formatting a three-column
story
46. Click on the page 2 icon to turn to the second page. You can also reach page 2 by
pressing Command-Tab.
47. When your screen displays page 2, you will notice that it matches the left master
page. The rule is at the bottom, the company logo rectangle is in the bottom
right corner, and there is only one column defined. On this page, you will be
changing your format slightly to accommodate three columns of text. Therefore,
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choose the Column guide ... command from the Utilities menu. After the Column
guides dialog box appears, enter 3 in the Number of columns option and 0.5 in
the Space between columns option. Then click OK. Four column guides appear
on the page, defining three equal columns.
48. Drag a horizontal ruler guide down to a point two inches below the top margin.
Assuming that you have not moved the zero point of your rulers, this point will
correspond to the 3-inch tick mark on your vertical ruler. The area above this
guide designates the area where you will create the first headline. Then drag
another horizontal ruler guide down to a point corresponding to the 6-inch
marking on the vertical ruler. Both guides will he lp you position the first article
on this page.
49. Now that you have defined the boundaries for your article, you are ready to
place the text. Choose the Place ... command from the File menu. Select the file
"Page 2 Story 1" and double-click or press the OK button in the Place document
dialog box.
50. Position your manual text flow cursor up against the top ruler guide and inside
the first column, and click. After PageMaker has poured the first column of your
article, click on the tab of the lower handlebar of the text block.
51. Next, click the manual text flow cursor at the intersection of the top ruler guide
and the second column. The text will again flow to the bottom margin. For this
purpose, however, you want this column of text to extend only down to the
lower horizontal ruler guide. This means that you must drag the lower handlebar
of the second text block up to the lower ruler guide and then click on the lower
tab, as shown in Figure 8-20.
52. Finally, position your manual text flow cursor flush with the top ruler guide and
click inside the third column. Uke the second column, this column should extend
only to the lower ruler guide. Since the text is not yet fo rmatted properly, it will
now flow somewhat beyond that boundary.
53. Now it is time to format the text. Select the text tool, click inside any one of the
columns of text, and press Command-A to select all of the text. Then change the
type specifications to 10/12.5 Helvetica, using the Font, Size, and Leading pop-up
menus as described earlier in tills chapter. Also, add a first-line indent of 0.25 inch and
an After spacing of 0.125 inch to your paragraph formatting. If your text is not already
ragged right, select the Align left option from the Alignment pop-up menu.
This article is now poured into t hree columns and fully formatted (see Figure 8-21).
Notice that the format exactly matches the article on page 1. It is generally a good idea
to keep your body text consistent throughout a newsletter or any document. This gives
your pages a reliable design structure , which aids your readers by reducing potential
confusion. The best type, after all, is type that goes unnoticed but not unread.
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Shorten the second column by
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Creating a headline and a subhead
Your next step is to add both a headline and a subhead to this story. As mentioned
earlier, a headline serves as an introduction to an article. A subhead further elucidates
the story, often relating very closely to the headline both visually and conceptually. A
headline might ask a question that is answered in the subhead. The headline might
make a statement to which the subhead poses a logicai question, which is answered in
the text. In this case, you will create a direct, two-word headline designed simply to
attract the reader. Your subhead will summarize the article and state its purpose.
54. First you will create a two-column headline. If you haven't already done so,
magnify your screen display to Actual size view and position your display so you
can see the top of the page. Select the text tool and position your cursor at the
intersection of the top and left margins. Drag from this point to the right edge of
the second column, as shown in Figure 8-22.
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Figure 8-22: Drag w ith the text tool to create a two-column headline.

55. Type in the words VIA Backgrounder. Then select both words with the text tool
and format the entire text block to 36-point Helvetica Bold. Move the headline up
until it is flush with the top margin.
56. To visually link your two-column headline with your three-column text, you will
add a three-column subhead. Again with the text tool, drag from a point between
the headline and text on the left margin all the way across the page to the edge of
the right column. Then type the subhead Corporate responsibility a top
priority in all aspects of VIA operations. Select the whole text block and
format the subhead to 24-point Helvetica. To further distinguish the subhead
from the headline, select the Italic option from the Style pOJ}-Up menu under the
Type menu (or press Shift-Command-O. giving the subhead a visually interesting
slant. Vertically position this text block between the headline and the article. The
completed headline and subhead are shown in Figure 8-23.
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Figure 8-23: The completed headline an d subhead shown with three-column article.

Creating a Sidebar
The last article you will place into this newsletter will obvious ly have to fit in the empty
area occupying the bottom right third of the page. This area is purposefully much
smaller than the area containing the three-column article, since the next story you pour
will act visually as a supporting story, or sidebar, to the feature story. A sidebar includes
additional information along the same lines as the feature story-information that is
interesting, although not necessarily as important.
To distinguish it from the feature story, a sidebar is often set off by a box. To further
highlight the article, its box might have a drop s hadow. A drop shadow is a black or gray
box, largely hidden in back of the firs t box, that gives your page a sense of dimension,
as if the box surrounding the article is hovering above the page, casting a shadow onto
the page.

Drawing a box with a drop shadow
57. Before creating the sidebar, you s hould establis h a border and a drop s hadow.
But first, you must set another ruler guide to help position your article and the
graphic elements that surround it. Drag a horizontal ruler guide down to one-quarter
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inch below the lower horizontal ruler guide. (This s hould be at the 6Y.rinch tick
mark on the vertical ruler, provided that you have not moved your ruler origin.)
58. The easiest way to create a drop s hadow box is to create the shadow firs t. Select
the rectangle tool and drag from the intersection of the new horizontal ruler
guide and the left edge of the second column to the bottom right margin corner,
as shown in Figure 8-24. While the shape is still selected, choose the 40%screen from
the Fill pop-up menu under the Element menu, and choose the None options from the
Line pop-up menu. The result is a rectangular , medium gray value screen with
no outline.
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Figure 8-24: This gray rectangle with no outline will act as the drop shadow to your sidebar box.

59. The next step is to create the box in front of the shadow. The box s hould be the
same vertical and horizontal dimensions as the shadow to ens ure a cons istent
and realistic relationship between them. The shadow is, after all, being cast by
the box. Therefore, you can create the box by making a copy of the existing
shadow. Assuming the gray rectangle is still selected, choose the Copy command
from the Edit menu or press Command-C. Then immediately bring a copy of the
shadow from the Macintosh Clipboard to your page by choosing the Paste
command from the Edit menu or pressing Command-V. The pasted rectangle will
appear directly in front of the original rectangle.
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60. Drag the selected rectangle one-eighth inch above and to the left of the bottom
right margin corner, as shown in Figure 8-25. In this way, it is just slightly offset
from the original rectangle behind it. While the forward shape remains selected,
choose the Paper option from the Fill pop-up listing and 1 pt from the Line popup listing. The box is now completed, appearing to be in front of the drop
shadow. You are now ready to place the text into the box.
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Figure 8-25: The completed box with its offset d rop shadow.

Pouring and formatting the sidebar text
61. Before you place your text, yet another ruler guide is required. This time, drag a
vertical ruler guide to about one-quarter inch from the right margin (one-eighth
inch in from the right edge of the box). This guide will define the right column
guide of your sidebar text.
62. Choose the Place ... command or press Command-O, select the Page 2 Sidebar
file, and press Return. When your manual text flow cursor appears, do not click.
This time, you will draw the column width of your text with the text tool, just as
you did earlier when creating headlines and subheads. Drag with the manual text
flow cursor from the intersection of the left edge of the second column and the
lowest horizontal ruler guide Oust inside the box) over to the newest vertical
ruler guide, as shown in Figure 8-26.
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Figure 8-26: Dragging with the manual text flow cursor to define the column width of the
sideba r text.

63. After PageMaker p ours your text, select all the sidebar text with the text tool and
change the type specifications, or specs, to 12-point Helvetica with Auto leading.
Also make s ure the text is flus h left and give each paragraph a 0.25-inch first-line
indent, as described earlier in this chapter. Incidentally, this text is s lightly larger
than other text in the newsletter to further highlight the sidebar. Because it is a
small article with large text, it seems friendly, making a person more likely to
read it. If it is well written, a sidebar may spark a reader's interest in the main article.
64. Click on the text with the arrow tool and, if necessary, adjust the lower handlebar of the text block to within one-eighth inch from the bottom edge of the box.
The upper handlebar may need to be adjusted as well so that it touches the
horizontal ruler guide.

Creating the sidebar headline
65. Like any other article, a sidebar needs a headline. The headline will fit in the area
between the feature article text and the s idebar box. Select the text tool and drag
in this area from the left edge of the second column to the vertical ruler guide on
the far right of the page to define the headline column width. Then type Guiding
Principles and change the s pecs to 24-point Helvetica Italic (known as Helvetica
Oblique). If necessary, adjust the position of the headline vertically to match the
position shown in Figure 8-27.
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Figure 8-27: The headline accurately positioned above the sidebar drop shadow box.

Your newsletter is now complete. If you want to, demagnify your display to Fit-in-window
view size. It should closely match the page shown in Figure 8-28.
Figure 8-28:
Page 2 displayed at the
Fit-in-window view size.
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All that is left to do is save your newsletter to disk for future reference and print the file
to an output device.
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Saving the Newsletter to Disk
You always want to store files to disk that you create. Generally, you want to save a file
before you are done creating it. I've postponed the discussion of the Save command to
this point in order to focus this sample project on the newsletter-creation process itself.
When you create files of your own, however, I recommend that you execute the Save
command frequently. This way, you won't lose very much information if you get a
system error, or if you are forced to restart your computer for some other reason.
When you save a file to disk, all the work you have been doing is transcribed from your
computer's memory to disk. The file that you save can be transferred to other floppy or
hard disks and will thereby remain available should you want to use it again at a later
date. You never know when you may want to access this file again, especially in the
case of a periodical publication like a newsletter. Once you have established a certain
visual style, you will want to build on it again and again. For example, in future versions
of this newsletter, you could open this same file to spare yourself the time and effort of
re-creating your master page items and the masthead text. Considering that the creation of these items alone consumed the first third of this chapter, there is much to be
gained by saving this file.
66. Choose the Save command from the File menu or press Command-S. Since you
have never saved this file before, the Save publication as dialog box appears, as
shown in Figure 8-29. The folder bar and Eject and Drive buttons allow you to
determine to which disk or hard drive and to which folder you want to save your
file. You must also enter a name for your file in the option box under the list of
existing files. I suggest the name Two-page Newsletter, but you can enter any
name that you like.
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Figure 8-29: The Save publication as dialog box, used to name the file and determ ine t he drive
and folder to which it will be saved.
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Determining a filename and location is a very important process. First-time users often
make the mistake of giving their files very general or obscure names and saving them to
arbitrary disks. In the short run, this can be fine. You may not have many files, only two
or three folders' or disks' worth, and you can easily find them and tell them apart. But
you would be surprised how little time it takes to amass a very large number of files. If
you use PageMaker often, you can easily create enough files to fill many folders or disks
every month, making random file storage an organizational nightmare. Here are a few
tips for saving your files:
•

Save similar files to the same folders. In other words, save newsletters to one
folder or set of folders, fliers to another, business letters to another, and so on.

•

When naming a file, ask yourself if you have provided enough information to
recall the contents of the file a few months, or even years, later. Make your
names specific and exact. Remember, you have 32 characters to name your file,
so there is no need to be cryptic or overly brief.

•

How will you be able to differentiate this version of your document from previous or future versions? You don't need to date your file, since the Macintosh
System already provides this information, but adding a version or issue number
to the end of a filename can be helpful in distinguishing similar files.

After determining a file destination and entering a filename, click the OK button or press
the Return or Enter key. Your file is now saved so you can reuse it in the future.

Printing a Two-Page Document
The last step in producing a document in PageMaker is to print it. PageMaker files can
be printed to nearly any printer you have connected to your Macintosh or to a highresolution imagesetter at a desktop publishing service bureau or commercial printer.
There are many different printing options in PageMaker, but for now I'll just focus on
the ones you need in order to print your newsletter ..
67. First, make sure your printer is turned on. Then use the Chooser to select the
printer driver that represents your printer (the LaserWriter 8.x driver is used for
all PostScript printers) and select your printer.
68. Choose the Print ... command from the File menu or press Command-P. This
brings up the Print to dialog box, shown in Figure 8-30. Enter the number of
copies of each page of your file you want to print in the Copies option. Usually,
this number should be 1. If you want to print large quantities of copies, you
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generally can save money by outputting a single original and having photocopies
or offset prints made from the original set. The Page range option controls which
pages in your file will print. Select the All radio button to print the entire file, or
enter the page range in the From and to option boxes. For example, if you wanted
to print only page 1, select the From radio button and enter 1 for both the From
and to values.
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Figure 8-30: The Print document dialog box, containing your printing specifications.

69. PageMaker lists the name of the printer that you have chosen next to the words
Print to: at the top of the dialog box. If you are using a PostScript printer, just
below the printer name is the Type option, which you use to specify the specific
make and model of printer you are using. This is done by selecting a PostScript
Printer Description (PPD) file from the pop-up list. PPD files have somewhat
cryptic names, but they generally include the name of the printer manufacturer,
model, and version of PostScript. Select the one that represents your particular
printer.
70. After all your specifications are complete, click on the OK button to instruct
PageMaker to print your file. The Print to dialog box disappears and the Print
s tatus dialog box a nd Cancel button displays. The Print status dialog box lists
various situations regarding your current print job, including fonts being downloaded and error condition messages sent back by the printer. The Cancel
button allows you to cancel the print job if you discover a problem.
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After your pages print, examine them to make sure they meet your expectations. If you
see any problems, make the necessary changes to your file. You may even find it
advantageous to make changes to your newsletter that are not outlined in this chapter.
Try experimenting with the fonts and other type specifications. Try jazzing up the
masthead. The newsletter outlined in this chapter is not designed to be used as is for
your personal newsletter needs. But it can act as a structure upon which you can build
a more complex, more personalized newsletter. Or, you may want to develop a newsletter in a completely different direction.
In either case, by successfully completing this project, you have demonstrated an
understanding of the most basic and essential commands and options offered by PageMaker.

I
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Formatting
Text
••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
W Formatting versus editing
W Character formatting versus paragraph formatting

•

Formatting characters

•

Character spacing, tracking, and kerning

•

Formatting paragraphs

••••••••••••••••••••••••••••••••••••••••••••••••
Now that you know how text gets into PageMaker, you're ready to learn how to format
text in your publications. PageMaker provides extensive and extremely precise formatting of both character and paragraph attributes. More extensive and precise than any
word processor currently available, in fact, which is why you'll usually perform some
amount of text formatting in PageMaker even if it was fully formatted in your word processor.
Wait a minute. Didn't it say in Chapter 7 that PageMaker wasn't a word processor and
that as much text editing as possible should be in a real word processor? Yes, but I'm
making a distinction between editing and formatting. Editing means changing what words are
on the page, and formatting means changing how the words look on the page. PageMaker is
only a mediocre text editor, but it is a great text formatter, as you'll soon discover.
The text in a PageMaker publication is defined by many different attributes, such as
font, type size, leading, character width, tracking, kerning, alignment, margins, tabs,
hyphenation, and many other others. The commands to control this formatting are
found in the Type menu and the control palette and can be applied using numerous
keyboard equivalents. This chapter details PageMaker's formatting attributes and
introduces the Type menu commands and keyboard equivalents you can use to apply
them. Formatting commands in the control palette are covered in Chapter 13, "The
Control Palette." You'll also learn a lot about formatting in Chapter 10, "Style Sheets."
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Characters and Paragraphs
To understand PageMaker's text-formatting features, you have to know the difference
between character-level formatting attributes and paragraph-level formatting attributes.
Character attributes are applied independently to any word or character; font, type size,
leading, kerning, and tracking are all character attributes. Paragraph attributes, on the
other hand, are always applied to an entire paragraph at once; they include margins,
spacing before and after paragraphs, tabs, and hyphenation rules.
This distinction means that the effect of any text formatting depends on the text that is
selected and the command that is chosen. If one word is selected and a characterformatting command is chosen, only that word will be changed. But if one wqrd is selected
and a paragraph-formatting command is chosen, the entire paragraph will be changed.

Character-formatting basics
How you apply character-level formatting depends on whether you are formatting new
or existing text:
•

Existing Text. To apply character-level formatting to existing text, select the text
you want to change (see Figure 9-1) and then choose character-formatting
commands from the Type menu (or their keyboard equivalents).

•

New Text. You can also define the character-level formatting of text before you
create it by setting the insertion point into a new or existing text block, selecting
the desired formatting commands and options (from the Type menu or using
keyboard equivalents), and then typing.

•

New Text. If you move the text insertion point into another existing text block
(using the text tool) and begin typing again, the new text will take on the character-level formatting attributes of the character immediately preceding where you
set the insertion point.

Figure 9-1:
Character
formatting
applies only to
selected
characters.

The rlifference between litersture and }Nt'k't/ltmllis tbst
jm1malism is ut~reatkl.ble and literatt~re is not read.
-Oscar Wilde
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To change the default character-level formatting attributes, which will effect all
text subsequently entered in new text blocks, select any tool except the text
tool and then select the desired character-formatting options.

Paragraph-formatting basics
To change paragraph-level formatting attributes, set the insertion point anywhere
inside the paragraph to be modified or select any word or words in that paragraph. To
change the paragraph formatting of several paragraphs at once, make a selection so
that at least one character of each paragraph you want to modify is selected and then
choose the paragraph-formatting commands. To change the left margin of three consecutive paragraphs, for example, select the text in such a way that all or part of the
three paragraphs are selected, as shown in Figure 9-2.
Figure 9-2:

Paragraph
formatting
applies to all
words in any
partially
selected
paragraph.
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that I am unable to make myself clear to those who refuse to
be
• · a. • nti ve.
Every free action is produced by the concuarence of two
a uses; one moral, i.e. tl1e will which detennines the act; the otl1er
)hysical, i.e. the power "vhich e:-:ecutes it. When I walk towards
n object, it is necessaa)' first that I should will to go tl1ere, and, in
1e second place, that my feet should c~ary me. lf a paralytic wills
o mn and an active man \viii not to, they will both stay where
hey ru·e. The body-politic has the srune motive powers; here too
·orce and will are distinguished, will under the name of legislative
ower and force under that of executive power. Without their
'OtlCllll'ellCe, nothing is, or should be, done.
\Ve have seen
power
ongs to · • · • • ·
and can belong to it alone. It may, on the other hand, readily be
seen, from the principles laid down above, that the executive
power cannot belong to the generality as legislature or Sovereign,
because it consists wholly of particular acts which fall outside the
hompetency of the law, and consequently of the Sovereign, whose

Because formatting is directly tied to the current text selection, it is important to be able
to quickly and accurately make text selections while working in the layout window or in
the story editor. (fext formatting can be done in either the layout or the story editor,
but the results of many commands are not displayed in story editor windows.) Here are
several different methods of selecting text that you should become familiar with:
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•

Drag over the characters that you want to select, character by character. Dragging upward or downward will select additional lines of text, and dragging across
columns of a threaded story will select large text sections quickly.

•

Double-click on a word with the text tool to select that word, hold the mouse
button after the second click, and drag to select additional words.

•

Triple-click inside a paragraph to select that paragraph, hold down the mouse
button after the third click, and drag to select additional paragraphs.

•

Set the insertion point by using keyboard equivalents to move the cursor. The
following keyboard equivalents are available:

To move cursor

Press these lceys

One character left

Left arrow or keypad 4

One character right

Right arrow or keypad 6

One word left

Command-left arrow or Command-keypad 4

One word right

Command-right arrow or Command-keypad 6

To beginning of sentence

Command-keypad 7

To end of sentence

Command-keypad 1

To beginning of line

Keypad 7

To end of line

Keypad 1

One line down

Up arrow or keypad 2

One line up

Down arrow or keypad 8

To beginning of paragraph

Command-keypad 8

To end of paragraph

Command-keypad 2

To beginning of story

Command-up arrow

To end of story

Command-down arrow

In the story editor

Press these lceys

To end of story

Command-keypad 6 or end

To beginning of story

Command-keypad 9 or home

Scroll display one line up

Command-up arrow

Scroll display down one line

Command-down arrow

•

Set the insertion point at one end of the text you want to select, locate the
opposite end of the text you want to select, press the Shift key, and click t he
mouse button. All text between the original insertion point and the Shift-dick will
be selected.
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Set the insertion point anywhere in the text block and choose the Select All
command from the Edit menu (Command-A) to select all the text in the story,
including all text threaded through text blocks on all pages.

B Set the insertion point at one end of the text you want to select, and extend the
selection using the following keyboard equivalents:
To extend selection

Press these lceys

One character left

Shift-~

or Shift-keypad 4

One character right

Shift-~

or Shift-keypad 6

One word left

Option-~or

One word right

Option-~

To beginning of sentence

Shift-Command-keypad 7

To end of sentence

Shift-Command-keypad 1

To beginning of line

Shift-keypad 7

To end of line

Shift-keypad 1

One line down

Shift-! or Shift-keypad 2

One line up

Shift-i or Shift-keypad 8

To beginning of paragraph

Shift-Command-i or Shift-Command-keypad 8

To end of paragraph

Shift-Command-! or Shift-Command-keypad 2

To end of story

Shift-Command-keypad 6

To beginning of story

Shift-Command-keypad 9 or Shift-HOME

Shift-Command-keypad 4

or Shift-Command-keypad 6

Holding down the Shift key while pressing the right- or left-arrow key selects one
character at a time; pressing Shift with the up- or down-arrow key selects one line at a
time. Holding down the Shift and Option keys and pressing the right or left arrow
selects one word at a time. Pressing the Shift and Command keys with the up or down
arrow selects one paragraph at a time.

Character-Formatting Details
Character formatting is controlled by the first seven commands in PageMaker's Type
menu, which is shown in Figure 9-3. The first six provide control over one specific
character-formatting attribute each: Font, Size, Leading, Width, Tracking, and Style. The
seventh is the Type Specs ... command, which provides a single dialog box in which all
character-formatting attributes can be specified.
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Figure 9-3:
The Type menu is home to all characterformatting commands.
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In the following list, I briefly introduce each of the six character-formatting commands
and their submenus. See the discussion of the Type Specs ... command later in this
section for more details.
W The Font command displays a submenu listing aJI fonts currently available to

your System Software and the names of any missing fonts that are used in the
current publication (these font names appear dimmed in the submenu).
W The Size command displays a submenu listing commonly used type sizes. It also
provides the Other ... command you can use to specify a type size not listed in
the submenu.

Type size changes can also be made using keyboard equivalents. To make the
currently selected type one point smaller, press Shift-Command-Option-,
(comma). To make the currently selected type one point larger, press
Shift-Command-Option-. (period). To change the currently selected type to the
nex-smaller standard type size, press Shift-Command-, (comma). To change the
currently selected type to the next-larger standard type size, press Shift-Command-. (period).
W The Leading command displays a submenu listing possible leading options; but

like the Size menu, this is not a complete listing, and the Other ... command
allows you to specify any desired leading value. The Auto leading option applies
leading that is 120% of the current type size. You can change the value of Auto
leading in the Spacing attributes dialog box, as discussed later in this chapter.
•

The Set width command brings up a pop-up menu offering several preset character widths. You can use the Other ... option to enter any width value between
0.1% and 250.0% in 0.1 % increments.

•

The Track command is used to adjust the character spacing of the selected text,
loosening or tightening the text. It is fully discussed later in this chapter.

W The Type style command displays a submenu offering PageMaker's type styles:

plain, bold, italic, underline, strikethru, shadow, outline, and reverse.
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The Type specs command
Choosing the Type menu's Type specs ... command (Command-T) brings up the Type
specifications dialog box, which provides full control over the character attributes of
the currently selected text. Shown in Figure 9-4, it includes all the fo rmatting capabilities
of the first six Type menu commands, plus control over type color , position, case, wor d
break, baseline shift, and more.
Figure 9-4:
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dialog box.

Type specifications
Font :

~

Size:

1~11>

l eading:

I Auto

Set width:

INormotl l> I '7. Size

Color:

I Blo ck I

I poin ts

II> I points

Type style: ~ Normol
0 Bold

Position:
Cose:
Track :

ISup erscr ipt I
IAll caps I
ITight I
0

0
0

I to lie
Underline

0
0

No Oreak

Outline
Shadow

0
0

I!

OK

(

Cancel

B

( Options ... ]

(11-11'1 Fonts ... ]
® Break

Reuerse
Strlk ethru

Font
The Font option displays the name of the font used by the currently selected text (or a
blank box if more than one font is represented within the current text selection) .
Clicking on the font name (or blank box) brings up the Font pop-up menu, listing all t ype
faces currently available and the names of any fonts used in the document that ru·e
currently unavailable. Unavailable font names are dimmed in the listing, indicating that
they have been removed from the System file or Fonts folder or unattached via a font
utility like Suitcase II or Master Juggler . Font names in the pop-up menu are listed
alphabetically, with the listing centered on the currently selected typeface. (If the
current font is Aachen, most of the listing will be below the selection; if the current font
is Zapf Dingbats, most of the listing will be above.) Scrolling up or down the list allow s
access to all available fonts. Releasing the mouse button while a typeface name is
selected changes the currently selected text to that font.

Size
The Size option controls the type size (in points) of the currently selected text. The Size
option consists of an option entry box and a pop-up menu. The t ype size of the currently selected text is displayed in the option entry box unless all the selected text is
not set in a single type size. Any value between 1 and 650 in 0.01 -point incr ements can
be entered in the option box. See Figure 9-5 for examples of the range in type sizes. The
Size pop-up menu is accessed by selecting the arrow next to the option box; it lists the
same few type sizes presented in the Size command pop-up menu discussed above. For
PostScript fonts, type sizes apperu· in outline style when actual screen fonts are
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available. (All TrueType font sizes appear in outline style.) If you don't have Adobe
Type Manager installed, these outlined sizes will display more clearly on-screen than
the non-outlined sizes, but this affects only on-screen legibility: Both the outlined and
non-outlined sizes will print at full quality on a PostScript printer. For TrueType fonts,
all sizes appear in outline type.
You can also change the size of any selected text using keyboard equivalents. To make
selected type one point smaller, press Shift-Command-Option-, (comma). To make the
currently selected type one point larger, press Shift-Command-Option-. (period). To
change the currently selected type to the next-smaller standard type size, press ShiftCommand-, (comma). To change the currently selected type to the next-larger standard
type size, press Shift-Command-. (period).
Figure 9-5:
PageMaker can
produce type in sizes
between 1 and 650
points in 0.01increments.
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If for some reason, 650-point type is not large enough for you, there are two

easy ways to get it even larger. First, you can copy text, paste it back as in PICT
format (use the Paste special command), and then stretch it as large as you
need. Second, you can use the Scale option in the Print dialog box (use the
Paper options button) to scale the 650-point type up to 999%.1 hope you have a
big printer ...
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Leading
The Leading option is similar to the Type option in its use of the option box and pop-up
menu. The current leading setting is displayed in the option box unless the selected text
includes more than one leading option. You can enter any value between 0 and 1300 in
0.1-point increments in this option box. The pop-up menu, which is displayed by
holding down the mouse button on the arrow icon, lists several leading settings that
might be appropriate for the current type size. The number of leading choices and
range of leading choices available in this pop-up menu vary, depending on the current
type size. In many cases, Auto leading will be suitable for your text. Auto is, by default,
120% of the current type size. (10-point type would use 12-point leading, 14-point type
would use 17-point leading.) Using the Auto leading option in the Spacing attributes
dialog box, you can control the percentage used to calculate Auto leading. Any value
between 0% and 200% can be entered for the Auto leading percentage.
Leading controls the amount of vertical space between lines of text and was named
after the lead shafts that were placed between lines of type on old typesetting machines. Controlling leading allows you to significantly affect the amount of space taken
up by your text, as well as the look and feel of the text. Type set with a very loose
leading is often easier to read than type set with a tight leading- but of course requires much more space. You should always feel free to experiment with leading - it is
one of the easiest and most significant ways to change your publication.
PageMaker can apply leading in one of three ways: proportional, top-of-caps, or
baseline, as illustrated in Figure 9-6. You specify which leading method PageMaker will
use for a specific paragraph in the Spacing attributes dialog box, accessed via the
Paragraph command and the Spacing button in the Paragraph options dialog box.
Proportional leading applies two-thirds of the space above the baseline and onethird of the space below the baseline.
•

Top of caps leading is measured from the top of a capital letter to the top of a
capital letter in the line below.

•

Baseline leading is meas ured from the baseline of one line of text to the baseline
of the next line of text.

Any time that one line of text contains characters with two different leading specifications, the larger leading setting will prevail. When making a large initial capital letter, for
example, you might have a 24-point character on the same line as 12-point characters. If
both the 24-point character and the 12-point character use Auto leading, then the entire
line will be set at 29-point leading (the Auto leading for the 24-point character), and the
leading will be larger than required . This can be corrected by cha nging the leading for
the 24-point character to 14-point or smaller, so that the Auto leading of the 12-point
character will be larger and therefore prevail.
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Figure 9-6:
You can tell
which leading
method is used
by selecting a
line of text.
Here the
proportional
method is used
on top, the
top-of-caps
method is used
in the middle,
and the
baseline
method is used
on the bottom.
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Set Width
The Set Width option is a pop-up menu offering eight alternatives that control the
width, as a percentage, of the selected text, allowing you to compress or expand type,
as shown in Figure 9-7. The Normal option, which is the default, sets each character at
the width that was defined for it by the font designer- 100% of its normal width. The
70%, 80%, 90%, 110%, 120%, and 130% options compress or expand the type as their
names suggest. To set any other width percentage, choose the Other ... option and
enter any value between 0.1 % and 250.0%, in 0.1 % increments. The Set Width option is
primarily used to achieve special graphic effect with type, and care should be taken not
to modify any type so severely that you compromise its legibility.

Track
The Track option offers the ability to modify the default character spacing of your text.
The six tracking options are No track, Very loose, Loose, Normal, Tight, and Very tight.
These options use vague terminology because the actual spacing modification made by
these options depend upon the particular font and type size being used -not because
PageMaker's tracking abilities are imprecise. Figure 9-8 shows the different tracking
options as applied to one particular paragraph. See the section on character spacing
later in this chapter for a detailed account of how PageMaker's tracking really works.
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Figure 9-7:
The 70%,
90%, 100%,
and 120%
Set Width
options.

Good judgment comes fromexperience, and experience comes
from bad judgment.
-Barry LePatner

Good judgment comes from experience, and
experience comes from bad judgment.
-Barry LePatner
Good judgment comes from experience, and
experience comes from bad judgment.
-Barry LePatner
Good judgment comes from experience, and experience comes from bad
judgment.
-Barry LePatner

Figure 9-8:
A sample
paragraph set
with Very
tight,
Normal, and
Very loose
tracking.

The universe exists; it is nothing that grows into existence and that
passes out of existence. Or, better still, it develops, it passes away,
but it never began to develop, and has never ceased from passing
away; it maintains itself in both states.... It lives on itself, its excrements are its nourishment.
-Friedrich Nietzsche
The universe exists; it is nothing that grows into existence
and that passes out of existence. Or, better still, it develops, it
passes away, but it never began to develop, and has never
ceased from passing away; it maintains itself in both states ....
It lives on itself, its excrements are its nourishment.
-Friedrich Nietzsche
The universe exists; it is nothing that grows into existence an d that passe s out of existence. Or, better still, it
develo ps, it passes away, but it never began to develop,
and has never ceased from passing away; it maintains
itself in both states .... It lives on itself, its excrements
are its nourishment.
-Friedrich Nietzsche
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Style
The Type style option consists of eight options, each of which has a check box in front
of it. Any of these options may be selected by clicking the check box or clicking on the
style name. Most of these type styles have keyboard equivalents. They are listed below.
Selecting the Normal option deselects all other options. Selecting any of the options
other than the Normal option deselects the Normal option.
Style

Keyboard equivalent

Normal

Shift-Command-Z (spacebar)

Bold

Sh ift-Command-S

Italic

Shift-Command-1

Underline

Shift-Command-U

Strikethru

Shift-Command-/

Outline

Shift-Command-D

Shadow

Shift-Command-W

Reverse

None

Break/No Break
The No Break option instructs PageMaker that all of the selected text must fit on one
line in the current text block. To accomplish this, PageMaker will modify the character
spacing within the selected text as necessary, even if it means squishing letters together. The Break option is selected by default.

Options
Clicking the Options button in the Type Specifications dialog box brings up the Type
options dialog box, which has five options that affect character formatting. Each of
these, shown in Figure 9-9, provides control over character-formatting definitions that
were uncontrollable in earlier versions of PageMaker. These Include the size of small
caps and both the s ize and position of superscript and subscript characters.
Figure 9-9:
The Type options
dialog box is nested
in t he Type specifications dialog box.

Type options
Smoll cops size:

jijiMj ~ of point slzo

Super/ subscript size: ~ '7. of point size
Superscript position:

~ '7o of point size

Subscript position:

~ '7. of point size
r,;----, point s ® Up
L.:.__J
0 Down

Bosellne shift:

n

OK

I Can cel

B
]
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The baseline shift option is a completely
new, and for many people, a long-awaited
feature. It allows you to move any selected
characters above or below their natural
baseline in J..1 o-point increments. Why the
baseline shift option is buried in the Type
options dialog box is another of the great
mysteries of the PageMaker user interface.
Fortunately, access to the baseline shift
option is easily available via the control
palette, as discussed in Chapter 13, and it is
from there that you will likely most frequently use this typographic capability.

-

-

":""""
'

Using
Superscript and
Subscript to
create fractions

il
il

After changing or viewing the settings in the
Type options dialog box, click OK to return
to the Type Specifications dialog box.

Formatting
Paragraphs
Paragraph formatting in PageMaker controls
the margins and alignment of a paragraph
within its text block, the spacing between
one paragraph and another, the way lines of
a paragraph break across columns or pages,
rulers on any sides of the paragraph, spacing
of words and letters, hyphenation, and tabs.
These attributes are controlled by the
Paragraph, Indents/tabs, Hyphenation, and
Alignment commands.

:
I

One thing you can do
by modifying the size and
position of superscript and
subscript characters is create great looking fractions.
To do this, set the size of
your superscript and subscript characters to 50% or
60% of the body text size
and set the position of the
superscript to 30% and the
position of the subscript to
0%. Finally, kern the numerat or characters (the
superscripted characters)
and the denominator characters (the subscripted characters) closer to the slash.
At a type size of 12 points,
you'll need to kern the numerator about three-tenths
of an em and the denominator about two-tenths to
get a good fit. Of course,
the exact kerning will depend upon the font you're
using and your own taste.

-

'I

I

i

i
:
I

I

~·

The Paragraphs command
Choosing the Paragraphs command from the Type menu brings up the Paragraph
specifications dialog box, shown in Figure 9-10. This dialog box provides control over
paragraph indents, spacing, alignment, and options.
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Figure 9-1 0:

The Paragraph
specifications
dialog box.

n
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Paragraph indents
Indents offset the text edges in any paragraph from the edges of the block. You set
indents independently for the left and right sides of a paragraph and the first line of text
in the paragraph.
•

The Left indent option specifies the positioning of the left edge of each line in the
paragraph relative to the left edge of the text block.

•

The First indent option specifies the position of the left edge of the first line of
type in a text block relative to the left edge of the other lines in the paragraph. In
other words, the first line of each paragraph gets the indent specified for the Left
indent plus the indent specified for the First indent. Since you can enter a positive or negative value into the First indent option, the first line may be closer to
the edge of the text block (as is the bullet in this paragraph) or it may be further
indented as are the first lines in traditional first-line indented paragraphs.
To create a paragraph where the first line has a more pronounced indent than
the other lines in the paragraph (an effect that is traditionaJiy accomplished by
placing a tab character before the first line of a paragraph), the First indent
option should be given a value equal to the distance that the first line should be
indented. To create a paragraph where the first line begins to the left of all other
lines in the paragraph Qike the first line in the previous paragraph), the First
indent value should be given a negative value equal to the distance before the
left margin that the first line should begin. Note that the First line indent can only
be as negative as the Left indent is positive, or the specification would call for the
first line to begin outside the text block. See Figure 9-11 for examples.

•

The Right indent option specifies the positioning of the right edge of every line in
the paragraph relative to the right edge of the text block.
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Figure 9-11 :

•

The paragraph on the
left has a
negative firstline indent;
the paragraph on the
right has a
positive firstline indent.
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Timeless style. It is our belief

Working out of our first studio, a

that innately functional furniture

rented loft on Via Boccaccio, near

has no limits in time or space. We

Milano's North Station, Gio and Suni

advocate the usefulness of furni-

produced the initial line of VIA 1.618

ture without regard to fads or

furniture in 1985.

trends.

Paragraph indents can also be specified in the Indents/tabs dialog box, using a ruler and
indent triangles exactly like those used in Microsoft Word. These are fully described
later in this chapter.
The next set of options control space placed before or after paragraphs, to
separate them from text that precedes and follows. You should always use
these options to separate paragraphs, and neve r press the Return key twice
(inserting two consecutive carriage returns) to separate paragraphs. There are
several reasons for this. One is that when a paragraph lands at the top of a
column, PageMaker will automatically ignore the space before command, so
that the first line in the paragraph lines up correctly at the top of the column. Of
you want to force the Space before to appear even when at the top of a column,
add a paragraph rule to paragraph, but give that paragraph rule a line width of
none.) U a carriage return (which is really just an empty paragraph) is used to
space paragraphs, on the other hand, you will occasionally find a new paragraph starting one line below the top of a column because the spacing carriage
return is sitting on the first line of the column.
Another reason for using the Space before and Space after options to separate
paragraphs is that doing so, especially when your paragraphs are formatted
using style sheets, makes it much easier to globally adjust the amount of space
between paragraphs, which may become necessary in order to make your text
fit in the available space. When carriage returns have been inserted, you have
to manually select each one and change its size or leading in order to increase
or reduce the spacing between paragraphs. When Space before and Space after
are used, you can simply select a range of paragraphs or modify the style sheet
definitions.
•
•

Space before. Enter the amount of blank space you want inserted
before the selected paragraphs.
Space After. Enter the amount of blank space you want inserted after
the selected paragraphs.
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The paragraph options at the bottom of the Paragraph Specifications dialog box provide seven options, six of which affect the arrangement of text within your layout. The
final option is used to select paragraphs for inclusion in a PageMaker-generated table of
contents.
•

Keep lines together. When this option is turned on, the paragraph will never be
broken across pages, columns, or above and below a graphic. PageMaker will
flow the paragraph forward until it fits in its entirety on one page in one column.
To accomplish this, PageMaker may have to leave a larger block of white space
than usual, so care should be taken when applying this option to paragraphs
containing more than a few lines of text.

•

Keep with next __ lines. This option instructs PageMaker to place the current
paragraph on the same page and in the same column as the first lines of the next
paragraph. You can enter the values 1, 2, or 3 in the option box. This option is
most often used to guarantee that headlines or subheads are not placed at the
end of a page or the bottom of a column, but it can also be used in other circumstances, such as keeping the lines of an address together. If PageMaker is unable
to lay out your text in keeping with the setting you make from this option, and if
the Show keeps violations option is selected in the Preferences dialog box,
PageMaker alerts you that the text is being positioned differently than you have
requested by adding a yellow (or gray) bar over your text.

•

Column break before. When this option is selected, the paragraph will always
begin at the top of the next available column.

•

Page break before. When this option is selected, the paragraph will always begin
at the top of the next available page.

•

Widow control __ lines. When a paragraph starts on one page and ends on
another, the lines on the page where the paragraph starts are sometimes called
widows. In most long publications, it is unprofessional for only 1 or 2 lines of a
paragraph to be widowed at the end of a page. This option instructs PageMaker
to allow not less than the specified number of lines to remain at the bottom of a
page. When this option is selected, enter either 1, 2, or 3 in the option box to
instruct PageMaker to keep at least 1, 2, or 3 lines of the paragraph at the bottom
on any page on which the paragraph begins. If PageMaker cannot keep these
lines at the bottom of the page, the paragraph is moved so that it starts on the
top of the next page. If PageMaker is unable to lay out your text in keeping with
the setting you make from this option, it will tell you (by adding a gray bar below
your text) if the Show keeps violations option is selected in the Preferences
dialog box.

•

Orphan control __ lines. When a paragraph starts on one page and ends on
another, the lines on the page where the paragraph ends are sometimes called
orphans. In most long publications, it is unprofessional for only 1 or 2 lines of a
paragraph to be orphaned at the top of a page. This option instructs PageMaker
to allow not less than the specified number of lines together in the end of a
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paragraph that is broken across two or more pages. When this option is selected,
you can enter values 1, 2, or 3 in the option box to instruct PageMaker to move at
least 1, 2, or 3lines of the paragraph to the top of the page on which the paragraph ends. PageMaker accomplishes this by moving lines from the end of the
preceding page to the top of the following page. If PageMaker is unable to lay out
your text in keeping with the setting you make from this option, it will tell you
(by adding a gray bar below your text) if the Show keeps violations option is
selected in the Preferences dialog box.
•

Include in table of contents. When this option is selected, the entire text of the
paragraph, and the page number on which it is positioned are included in the
table of contents created with the Create TOC ... command. In general, this
option is used only for headlines and subheads that are one or two lines long.

Paragraph lines
Clicking the Rules button in the Paragraph specifications dialog box brings up the
Paragraph rules dialog box, which lets you add lines above or below any paragraph in
your publication. It is shown in Figure 9-12. The top and bottom halves of this dialog
box are identical, providing for the definition of lines above or below the paragraph.
Figure 9-12:
The Paragraph rules

dialog box.

Paragraph rules
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Line style:
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Line color:
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line width:
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Indent: left~ Inches
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Paragraph rules automatically put lines above and/or below paragraphs, so you can
achieve this effect without having to draw the lines manually. This guarantees that the
rules (lines) will be the exact width of the paragraph or the width of the text in the
paragraph (depending on the option you select), and it makes it easy to position the
rules very precisely relative to the text in the paragraph. An even bigger benefit is that
the paragraph rules flow along with the text when any changes cause the text to ref! ow
within its text block or even to another text block. If you created lines with the line tool,
you would have to measure the line length very carefully to match the text or paragraph
size, and it would be much more difficult to accurately position the lines and keep them
in position.
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Boxing and shading headlines
You can use the Parag raph rules option, along with the Line style, Une color,
and Line width options to create very nice effects with headlines or subheads. For
example, suppose you want to add a 30% gray box over some subhead text that
is set with 14-point text and 16-point leading . To do this, you first define the
30% gray tint in the Edit colors dialog box. Then, select the subhead and open
the Paragraph rules dialog box. Choose the Custom ... Line style option and
specify a 16-point line weight. Use the Line color option to select the 30% gray
color you defined, and set the Line width option to the width of the text.
This produces a 30% screen over your subhead, but it forces the screen to end
just at the start of the first letter and the end of the last letter in the subhead. To
create a more natural look, specify a negative .15-inch (-0.15) indent to the left
and right of the line width. Now the 30% screen starts .15 inch before the first
character in the subhead and ends .15 inch after the last character in the
subhead. This same trick of adding negative indents when using the Line width
of the text option can be used with any rule you add above or below paragraphs.

For each rule added with the Paragraph rules option, you use the Line style pop-up
menu to define the line weight or style and the Line color pop-up to select a line color.
The Line width option determines if the line is to be drawn at the width of the longest
line of text in the paragraph or at the full width of the text block, regardless of the actual
text width. The left and right Indent options are used to add an indent to the line, which
shortens the line width accordingly.
To control the placement of paragraph rules, click the Options ... button in the Paragraph rules dialog box, shown in Figure 9-13. The Top and Bottom options are used to
specify how far above or below the baseline of the first or last line of the paragraph the
lines will be placed. If these options are set to Auto, rules are placed even with the top
or bottom (respectively) of capital letters in the first or last line (respectively) of the
paragraph. Entering Top or Bottom values larger than the current leading moves the
lines away from the text, and adds leading to the first or last lines of the paragraph.
When the Align to grid option is selected, an extra space is added to the first line of the
paragraph below the rule. This helps to ensure that all lines of text in that paragraph
text block remain aligned to the grid specified with the Grid size option. You'll usually
want to enter the value of the leading used in your body copy into the Grid s ize option.
When creating layouts with multiple columns of text, this helps ensure that the
baselines of the text in all of the columns are aligned.
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Figure 9-13:
The Paragraph rule options
dialog box.
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After setting the Paragraph rule options, you can click the OK button to return
to the Paragraph rules dialog box; but if you are finished setting paragraph
options, you can hold down the Option key while clicking the OK button (or
pressing the Enter key), and all three dialog boxes- Paragraph rule options,
Paragraph rules, and Paragraph specifications- will close. By the way, this
Option-Click trick works in all nested (multiple level) dialog boxes within PageMaker.

Spacing
The Paragraph specifications dialog box has one more nested dialog box- the Spacing
attributes dialog box which is accessed by clicking the Spacing... button. This dialog
box, shown in Figure 9-14, is used to set the Word space and Letter space parameters
PageMaker uses to justify text, turn on pair kerning, select a leading method, and
specify the default size of automatic leading. Each of these options is discussed in detail
elsewhere in this chapter: Word space and Letter space and pair kerning are covered in
the character spacing section, and leading items were discussed in the characterformatting section earlier.
Figure 9-14:
The Spacing attributes
dialog box.
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Indents and Tabs _ _ _ _ _ __
The Indents/tabs dialog box lets you visually manipulate the left, right, and first-line
indents, and tab settings, for any paragraph or group of paragraphs. To access this
dialog box, choose the Indents/tabs command from the Type menu (Command-!). The
Indents/tabs dialog box, s hown in Figure 9-15, appears positioned above the selected
paragraphs. In most cases, it is automatically positioned so that its left and firs t-line
markers lined up above the current left edge and first-line indents.
lndento/lob•

Figure 9-15:

The Inde nts/
tabs dialog
box.
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The width of the Indents/tabs dialog box is dependent upon the size of your monitor,
but you can scroll the rule r either right or left by clicking on the arrows at either end.
You can also move the dia log box by dragging its title bar. Wherever it is positioned, the
zero point on the ruler represents the left edge of the current text block.
The left, right, and firs t-line indent markers are small black triangles that appear just
above the ruler. By dragging these markers to new positions above the ruler, you can
adjust the corresponding indents. A digital measure of the marker position appears in
the Position option box as you drag. To see the effect of a margin change, or any other
change you make in this dialog box, click the Apply button. To save the changes made
in the dialog box click OK, and of course click Cancel to close the dialog box while
discarding any changes. (you can even use the Cancel button after having used the
Apply button.)
If you've selected more than one paragraph before the Indents/tabs command was

chosen, the indents and tabs of the topmost paragraph will appear in the Indents/tabs
dialog box even if s ubsequent paragraphs have different indents or tabs. If any changes
are then made to the indent or tab options, and the Apply or OK button is clicked, the
settings shown in the dialog box will be applied to all paragraphs, wiping out any
differences they may have had.
In earlier versions of PageMaker, when the selected paragraphs had different
margin or tab settings, the space above the ruler was grayed in the Indents/tabs
dialog box to remind you of these differences. No s uch reminder exists in
PageMaker 5.
Tab markers are small downward-pointing arrows that also appear above the ruler.
Four types of tabs are s upported: Left, Right, Center, and Decimal. Each tab has a
unique icon that appears in the ruler when the tab is set. Any tab can have a tab leader,
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which fills the space between the position where the tab key is pressed and the tab
itself is positioned. PageMaker supports a dotted leader, a dashed line leader, an
underline leader, and a custom leader that allows you to enter any one or two characters to be used as the tab leader. Leaders, shown in Figure 9-16, provide a visual reference between items on a line, making it easier for the eye to follow the line to the
tabbed item. Tab leaders must be assigned when the tab is created -you cannot add a
leader to an existing tab.
Figure 9-16:
Tab leaders begin where the
Tab key is pressed and end
where the tab is positioned.

Lunch Menu
Peanut butter & jelly .......... ..............50¢
Hamburger ..................................... $ 1.20
C old Pizza ..........................................95¢
Banana .... ................ ...... ...................... 1.2¢

By default, each PageMaker paragraph has a left tab stop, with no leader, positioned at
each J..2-inch increment in the paragraph. You can reset these tab stops, add new stops,
delete specific stops, or manipulate existing stops.
•

To remove all the existing tabs, and reset the paragraph indents, click the Clear
button.

•

To add a new tab, click the icon representing the kind of tab that you want to
create, click the arrow next to the Leader option box to select a leader from the
pop-up menu, and then click the mouse button in the ruler at the position you
want the new tab. (You cannot create a new tab on top of an existing indent
marker. Instead, you must create the tab elsewhere and then drag it into position
over the indent marker.)
You can also add a new tab by selecting one of the tab icons, selecting a type of
tab leader, and then entering the position where the new ta b should be placed in
the Position option box, and then clicking on the arrow next to the Position
option box and selecting the Add tab command from the pop-up menu. This will
place a new tab at the specified position .

•

To add a series of tabs at equally spaced intervals, add the first new tab at the
desired position and then choose the Repeat tab command from the Position
options pop-up menu. PageMaker will automatically add additional tabs at equal
distances between the current tab and the right margin.

•

To check the position and leader of an existing tab, click on the tab in the ruler.
The position of the tab will be displayed in the Position option box, the type of
tab will be selected in the tab icons, and the leader type will be shown in the
Leader option box.
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•

To reset an existing tab, select and drag the tab icon horizontally in the ruler. As
you move the icon, the current position will be displayed in the Position option
box. Release the tab when satisfied with the new location. Alternatively, you can
select an existing tab in the ruler, enter the value of the position to which you
wish to move the tab in the Position option box, and then choose the Move tab
command from the Position pop-up menu.

•

To delete any tab, click and drag the tab icon down below the ruler (vertically)
and release the mouse button. The tab icon will disappear. To remove all the tab
stops for the current paragraph, click the Clear button and all tabs will be
removed.

•

To add a leader to an existing tab or to change the tab type, click on the tab
you want to modify and then click on the icon of the tab leader you want to apply.

Hyphenation
The professionalism and quality displayed in any publication are substantially affected
by the way in which it is hyphenated. Many documents produced with early desktop
publishing suffered from rivers of white space caused by the then-prevalent lack of
sophisticated hyphenation features. PageMaker provides very powerful hyphenation
abilities that you can easily use to produce very professional-looking publications.
In general you will want to hyphenate most body text used in your PageMaker publications. In most cases, headlines, subheads, captions, and other short text passages
should not be hyphenated. Three kinds of hyphenation are available in PageMaker:
•

Manual hyphenation requires that you insert regular hyphens, or discretionary
hyphens, into your text. Discretionary hyphens remain invisible, hidden within a
word, until PageMaker finds it necessary to hyphenate the word at that point.
Then the hyphen appears as a normal hyphen. If a shift in the text later moves
the word from the end of the sentence, the discretionary hyphen disappears
again.

•

Dictionary hyphenation uses the 110,000-word Houghton Mifflin Company
hyphenation dictionary and your own user dictionary to find the correct way to
hyphenate text in your publication. This is the default method of hyphenation.

•

Algorithm hyphenation applies a set of rules to words in need of hyphenation to
determine where hyphens should be placed. The hyphenation algorithm may be
able to hyphenate words missed by dictionary hyphenation, although it is
possible for improper hyphens to be inserted. When using this type of hyphenation, you should verify that all inserted hyphens are correct.
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Secret publication diagnostics
PageMaker includes a littl~-kn0wn diag111ostic and repair routine:that c~n check
the internal structure of your publication and even fix structure problems that
may result in crashing, corrupt files, or printing problems. To access this diagnostic, i hold down the Option and Shift keys while choosing the Hyphenation
command. PageMaker will run the diagnostics (which takes only a second or two
in most cases) and then beep at you. It will beep once if your publication has no
problems, 'twice if tlilere is a probler'r1 but PageMaker'has fixed it, and three times
if there is a problem but PageMaker cannot fix it.
This trick is good to use when you have a publication that crashes ever)' time '
you turn to a specific page, prints with missing page items, or exhibits other
strange behavior. If you get the dreaded three beeps "sorry, we can't help you"
result; you should immediately do a Save as ... to make a copy of your publication
and then realize you are living on borrowed time. From that point, you can try to
cut your publication in half (duplicating it and then deleting half the page,s from
each file) and then ' run the diagn'ostic again to figure out where the 't rouble
resides. Often it will lie in one particular story or graphic item, and deleting that item
and.replaciog it can t;>e a permanent cure.

Hyphenation is controlled in the Hyphenation dialog box (shown in Figure 9-17), which
is accessed via the Hyphenation ... command in the Type menu. The first option is used
to turn hyphenation off or on. When hyphenation is off, all other hyphenation options
have no effect.
Figure 9-17:
The Hyphenation dialog box.
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Other hyphenation options:
•

Manual only. Select this option if you do not want hyphens added to your text
based on PageMaker's hyphenation dictionary or hyphenation algorithm. In this
case, only hard hyphens and discretionary hyphens will appear in your text.
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Hard hyphens are created by inserting the standard hyphen character into a
word. When a hru·d hyphen is inserted, PageMaker will hyphenate the word at
that point, if appropriate, but the hyphen will appear in the text even if the
hyphen is not at the end of a line, as illustrated in Figure 9-18. This makes the use
of hard hyphens very dangerous- they should never be used except in cases
where you want the hyphen to appear regardless of whether it is at the end of a
line or not. Discretionary hyphens should be used in all other cases.

Every free action is produced by the concurrenc
two causes; one moral, i.e. the will which
ines the act; the other physical, i.e. the power whi
it. When I walk towards an object, it is
first that I should will to go there, and, in th
place, that my feet should carry me. If a
c wtlls to run and an active man will not to,
both stay where they are. The body politic h
e same motive powers; here too force and will
· nguished, will under the name of legis!ative nr.tvPt1
force under that of executive power. Without
nothi is, or should
done.
Figure 9-18: Hard hyphens at the end of a line and in the middle of a sentence.

You add discretionary hyphens to your text by setting the insertion point between
any two characters and pressing Command--. The discretionary hyphen will
appear only when the word can be correctly hyphenated at the point of the
discretionary hyphen. Until that time, discretionary hyphens remain hidden. You
can add discretionary hyphens to several points in a single word, and PageMaker
will then use the one that provides the best fit in any given situation; unused
discretionary hyphens remain hidden without causing any problems.
You can delete a discretionary hyphen by positioning the insertion point to the
right of the hyphen (if it is visible) or between the two characters where you know
the hyphen exists (if it is not visible) and pressing the Delete or Backspace key.
•

Manual plus dictionary. This option causes PageMaker to use automatic hyphenation to hyphenate text as it is placed into your publication, entered with the text
entry tool, or any time the size of a text block is modified, in addition to allowing
the insertion of manual hyphens. Uyou set the insertion point inside the text block,
then choose the Automatic Hyphenation option and click the OK button in the
Hyphenation dialog box, the story will not be hyphenated until it is resized or
repoured.
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You can specify that certain words never be hyphenated by placing a discretionary hyphen in front of the word. This not only tells PageMaker not to hyphenate
this particular occurrence of the word, but it keeps PageMaker from hyphenating
any occurrence of this word anywhere in the current publication. You can,
however, add your own disc retionary hyphens within the word, which will allow
PageMaker to hyphenate the word (any time it occurs in the publication) at the
point of a discretionary hyphen but nowhere else.
•

Manual plus algorithm. This option is actually Manual plus d ictionary plus
algorithm. It applies automatic hyphenation and algorithmic hyphenation and
allows manual hyphenation. Algorithm-based hyphenation uses a set of rules to
determine where words can be hyphenated. Rule-based hyphenation provides
hyphenating of words not found in a hyphenation dictionary, but may add some
incorrect hyphens. When using this option, you should a lways check your
document carefully before printing the final copy and de lete any hyphens that
PageMaker has added that you do not want.

•

Umit consecutive hyphens. The value set for this option determines how many
lines in a row can end in hyphens. It is important to limit consecutive hyphens
because if too many lines in a row end with hyphens, documents tend to look
unprofessional. While there is no hard-and-fast rule for how many consecutive
lines should be allowed to end in hyphens, many publishers think no more than
two, or three at the most, should be permitted. Deleting hyphens is not the only
solution to this problem; often you should try to rewrite one of the sentences
causing the hyphenation pro blem or alter the hyphenation of lines earlier in the
paragraph so that the multiline hyphenation problem disappears.

•

Hyphenation zone. For unjustified text, the Hyphenation zone option determines
which words PageMaker attempts to hyphenate, and if a word has multiple
hyphenation points, which hyphens are selected. The goal is for PageMaker to
end each line within the Hyphenation zone: So a larger zone means more ragged
paragraphs, and smaller zones mean more hyphens will be inserted. Suppose
you define a .25-inch Hyphenation zone. On each line, PageMaker looks to see if a
word ends within that last .25 inch of the line. If one does, then the next word is
pushed down to the next line, and everything is fine. If no word naturally ends
within the hyphenation zone, then PageMaker attempts to hyphenate any word
that crosses the zone, to create a hyphenated ending within the hyphenation
zone. Figure 9-19 illustrates a Hyphenation Zone.
When text is justified, the setting of the Hyphenation zone option has no effect.
Instead hyphenation is determined by the Word space and Letter space options
in the Spacing dialog box. These options determine how much PageMaker can
move characters and words in order to fill lines without hyphenating, and so
they indirectly affect hyphenation. These options are described more fully in the
next section of this chapter.
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Figure 9-19:
Unjustified
text is
hyphenated
so that a
word ends,
whether
naturally or
with a
hyphen,
within the
hyphenation
zone.

•

I

Every free action is produced by the concurrence of two causes; one moral, i.e. the will which
~etermines the act; the other physical, i.e. the power
!which executes it. When I walk towards an object,
:tis necessary first that I should will to go there,
and, in the second place, that my feet should carry
me. If a paralytic wills to run and an active man
will not to, they will both stay where they are. The
~ody politic has the same motive powers; here too
orce and will are distinguished, will under the
name of legislative power and force under that of
executive power. Without their concurrence, noth. ng is, or should be, done.

Add .... If you want to add words to your own personal hyphenation dictionary,
determining how these words will be hyphenated when either the Manual plus
dictionary or Manual plus algorithm options are used, click the Add button. The
Add word to user dictionary dialog box, shown in Figure 9-20, will appear.

Figure 9-20:
The Add word to user
dictionary dialog box.

Add word to user dlctlonory
Word:

Irllm- i bunc- uous

Olctlonory:

I US English I

Add:

0
®

As oil lowercose
Euoclly os typed

I[

OK

H

[ Concel )
[Aemoue)

If a word was selected when you chose the Hyphenation command, that word
will appear in the Word option box. If this is not the word you want to hyphenate, delete it by pressing the Delete key, and if no word was selected, simply

enter the word you want to hyphenate. Then mark places in the word at which
you want to allow hyphenation using the tilde(-) character. You can rank the
priority of the hyphens you add within a word by placing one tilde at the most
preferred hyphenation point, two at the second-best hyphenation point, three at
the third-best hyphenation point, and so on. When ranked hyphens are included
in a word, only the best or second-best hyphens will be used when the Manual
plus dictionary option is selected, but any hyphens (first, second, third, etc.) wiJI
be used when the Manual plus algorithm option is used. When you have finished
adding your new word, click OK to return to the Hyphenation dialog box.
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You can also use the Add ... button and the Add word to user dictionary dialog
box to remove existing words from the hyphenation dictionary. To do this, enter
the word you want to remove and then click the Remove button.

The Alignment command
Any paragraph in PageMaker can be aligned to the left or right edge, centered, or fully
justified. You can also force-justify text across the current paragraph width. Paragraph
alignment is adjusted relative to the width of the paragraph's text block. Paragraph
alignment can be adjusted for any paragraph that is fully or partially selected. There are
three ways to change the alignment for a paragraph:
•

Use the Alignment option in the Paragraph specifications dialog box, which is
accessed by choosing the Paragraph ... command (Command-M) in the Type
menu.

•

Use the Alignment command in the Type menu to choose from a pop-up menu of
the five alignment options.

•

Use the keyboard equivalents for each of the alignment options: Shift-CommandL for Left, Shift-Command-R for Right, Shift-Command-C for Center, Shift-Command-J for Justify, and Shift-Command-F for Force justify.

Typography in PageMaker
PageMaker's ability to produce fine typography has become an important and often
misunderstood topic as more and more professional document production has been
moved onto the desktop. The fact is that PageMaker has extensive and extremely
precise typographic capabilities, including all of the following character-spacing control
features: kerning pairs, manual kerning, range kerning, automated expert kerning, letter
spacing, tracking, and electronically condensed and expanded type. These features
provide you with more precision than traditional typographers could achieve using
traditional photomechanical typesetters, and in many cases more precision than
current imagesetters or PostScript-based output systems can even reproduce. There is
no need to worry about PageMaker's typographic powers.
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Character spacing, tracking, and kerning
The ability to control the exact placement of each character relative to other characters
is the cornerstone of a strong typographic system. On the Macintosh, the position of
each character relative to the character before and after it is based on information
included within the font being used. The designer of each font s pecifies the amount of
s pace that each character in the font occupies (its width) and the amount of s pace that
should be placed before and after the character (its side bearing), as shown in Figure
9-21. By default, most software positions characters according to these specifications,
which generally results in clearly legible and aesthetically pleasing text.
Figure 9-21:
Each character has a
width, defined by a
right and left side
bearing. Certain pairs
of letters are defined as
kerning pairs and have
specific spacing w hen
next to each other.

For the more typographically sophisticated, there is often a desire to make adjustments
to these default character s pacing and positioning s pecifications. Such adjus tments
make it possible to correct for characters that appear too closely set or too far apart,
have their spacing exaggerated at larger point sizes, or simply consume too much s pace
on the page when using their default spacing. Adjusting character spacing is confusing
for a number of reasons, not the least of which is that the terminology used to describe
its tools and techniques are not s tandardized . ln fact they are used in contradictory
ways by different software vendors and typographic practitioners.
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PageMaker provides the following tools and terminology:
•

Kerning refers to adjustments in spacing between two characters. There are no
Jess than four types of kerning control in PageMaker: Automatic pair kerning
adjusts the spacing between letters in Xooo of an em increments according to
kerning pair information built into the font itself. Manual pair kerning lets you
adjust the space between any two characters in increments of a positive or
negative !-1o, ~s. or Yloo of an em. Range kerning is exactly like manual pair kerning
except that you can apply it to any number of characters at once. Expert kerning
automates the process of adjusting kerning values between two characters by
analyzing the shapes of the particular characters and kerning the characters
based on a specified "strength" value that you specify.

•

Tracking modifies the space between characters, using a set of point-size
dependent tracking curves that have been custom defined for a particular font.
Tracking offers an intelligent modification of the space across a range of characters that aims to adjust the overall visual density of type on a page.

•

Letter spacing adjusts the space between characters based on exaggerations or
minimizations of the normal amount of letter space defined by the font designer.
It is somewhat cruder than tracking or kerning in that it doesn't directly take into
account the characters involved, the font, or the type size.

II Condensing or expanding type is the moral equivalent of asking your spouse to
sit on your suitcase in order to get it closed: It isn't elegant and it may not be
pretty but it will probably get the job done in a pinch.
The character spacing tool or the combination of character-spacing tools that you
should use in a given situation depends upon the effect you are trying to achieve. Pair
kerning is probably the most commonly used tool, applied by most people as a matter
of course to all text larger than body copy. Tracking should be used as the First method
of changes to a range of characters because it makes changes based on (usually)
professionally developed tracks. In actuality, tracking is probably under-utilized in
PageMaker because it is not well understood and has been criticized in the past. See my
complete discussion of tracking later in this section to clear up these issues. After tracking
has been applied, manual kerning of character pairs or ranges should be performed. Finally,
letter spacing (and word spacing) should be used to help PageMaker correctly justify
and hyphenate your text. An in-depth discussion each of these features follows.

Automatic kerning of pairs
In most fonts, after the font designer specifies the width and side bearing of each
character, they specify certain character pairs that they believe need some space
between them other than the sum of the right bearing of the first character and the left
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bearing of the second. These are called kerning pairs. In the ideal, whenever the two characters in a kerning pair are placed next to each other, the software application should
replace the default spacing (the sum of the side bearings) with the kerning pair spacing.
But kerning pair spacing is not used automatically. In fact, only a few Macintosh applications are capable of reading the kerning pair data from a font and using it to correctly
position characters. PageMaker can use kerning pair information to accurately position
characters, but it does not do so by default. This is because kerned pairs take longer to
display on screen, and often the improved accuracy of character placement is barely
visible at smaller type sizes and therefore not worth the slower display performance.
If you want kerning pairs used in your publication, you must select the paragraphs in
which you want them used, turn the kerning pair option on, and specify the minimum
point size for which you want kerning pairs used. To do this, choose the Paragraph .. .
command (Command-M) from the Type menu and click the Spacing .. . button in the
Paragraph specifications dialog box. Here you'll find the Pair kerning option, which can be
turned on and off via its check box, and the Auto above _ _ points option box. TI1is option
specifies the size above which pair kerning be used. Both are shown in Figure 9-22.

Figure 9-22:
Pair kerning optionjrom the
Spacing dialog box.

I

P11lr kerning:

181 Auto oboue [D points

I

By default, the Auto above option is set to 4 points. This is a change from the default of
12 points used In earlier versions. This means that PageMaker now does a lot more pair
kerning, which is fine but does slow down screen redraw a bit (it has no effect on
printing times). I suggest a setting of between 9 points and 12 points unless you are
typographically sensitive, because text smaller than that really doesn't need pair
kerning in most cases, and it will provide more snappy on-screen performance.

KernEdit
If you want to edit the kerning pair information stored within any of your fonts, use the
KernEdit utility progran1 provided with PageMaker 5. KernEdit is a very powerful kerning
pair editor that allows you to open any font, change or delete the existing kerning pair
information, add new kerning pairs, or even move ke rning pair information from one
font to another. The changes you make will be saved in the font file, and will therefore
apply to all applications that read pair kerning data from the font, not just PageMaker.

Using KernEdit (shown in Figure 9-23) is relatively easy, although you wouldn't want to
edit kerning pairs yourself unless you are an experienced typographer or have a very
fine eye for this kind of detail. After opening a font in KernEdit, select the character pair
you want to modify from the scrolling list along the left edge of the dialog box. KernEdit
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automatically displays a word that contains the pair of letters you have selected.
To choose another word, use the WordView pop-up menu. To actually change the
kerning pair data, either move the triangle that appears between the letters in the sample
word, click the right or left arrows next to the kerning value, or select the kerning value and
enter your desired value. Changes as small as V.ooo of an em space are supported.
Figure 9-23:
The KernEdit
utility provided
along with
PageMaker lets
you edit the
kerning of pairs
in any font.
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KernEdit also provides a tracking option, although this is provided to help you see how
the characters will appear when used in real documents, and tracking changes are not
saved along with the font. What you should do is modify the tracking value until the
characters in the word have an overall spacing that you like, and then perform the
specific pair kerning as described above. This simulates the way your font will be used
in the real world, when tracking will likely be applied to it in addition to the kerning
pairs. Details on every KernEdit option are provided in the program's help system,
available via the Help ... command in the Apple menu.

Manually kerning text and range kerning
Using automatic kerning pairs is a good first step to better typography, but in many
cases, you'll still want to manually adjust the space between characters. PageMaker lets
you add or remove space between characters in increments of V.o, J.2s, or V.oo of the type's
point size. To do this, position the cursor between the two characters you want to
modify, or select any group of characters that you want to kern. Then, use the following
key combinations to kern the selected type:
•

To add space between characters in J.2s-point increments, position the insertion
point between the characters and press Shift-Command-Delete or Command-~.
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•

To delete space between characters in l-2s-point increments, position the insertion
point between the characters and press Command-Delete or Command-f-.

•

To add space between characters in l1oo-point increments, position the insertion
point between the characters and press Shift-Command---7.

•

To delete space between characters in l1oo-point increments, position the Insertion point between the characters and press Shift-Command-f-.

•

Press Command-Option-K to remove all kerning between two characters, returning the kerning to its original, unmodified, setting.

•

Use the kerning option in the control palette to kern in either l1oo·or l1o-em
increments with the nudge arrows, or enter kerning values between 1 and -1. For
details on using the control palette, see Chapter 13.

In many cases, you will not be able to see a visible difference as you add or delete space
because the display is not accurate enough. Whenever possible, zoom in to 200%or
even 400% while kerning characters manually. (Or you can use the new zoom tool by
pressing Command-spacebar and zoom in up to 800%.) In any case, the spacing will be
adjusted accurately when your document is output on a high-resolution PostScript printer.
The kerning modifications you make affect the space after each character. So if you set
the insertion point between two characters and change the kerning value, your changes
are actually added to the first character. This means that if you select an entire word
and apply range kerning, you are not only changing the spacing between each pair of
letters but also the spacing between the last letter of the word and the first letter of the
next word. II you don't want to change this inter-word spacing when range kerning one
particular word, select all of the letters of the word except the last letter.

Kemlng Into the margins
Since kerning affects the space after any selected character, and because
PageMaker ignores any kerning applied to the last character on a line, you have
to be a little tricky to kern characters into the left or right margins. To kern into
the left margin, insert a non-breaking space (Option-spacebar) before the first
letter in the line, select that space, and then kem to pull the first letter into the
margin. (The kerned characters may appear to disappear sometimes, but just
refresh the display by reselecti111g the current view size from the View submenu
and they will reappear.) Kerning into the right margin (when text is fully or right
justified) works the same way: Add a non-breaking space after the last character
on the line, select that space, and then kern into it.
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Expert kerning
To automate the process of manually kerning characters, PageMaker provides the
Expert kerning Addition, shown in Figure 9-24. This Addition removes any existing
manual kerning from any selected text and then adds new manual kerning based on its
own evaluation of the selected type and the settings you make for its Kerning strength
(0 to 2.0) and Design class (fext, Display, Poster, points) options. These settings are
really just guidelines based on standard practices in terms of how much kerning should
be applied, so you may have to experiment a bit to determine which of these options
suits your needs in various situations.
Figure 9-24:
The Expert kerning dialog
box.
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Tracking
Another way of automatically kerning text over a range of characters is tracking.
Tracking is clearly the least understood of PageMaker's character-spacing tools. The
feature's option names (Loose, Very Loose, Tight, Very Tight, and Normal) have been
the subject of unfair and inaccurate ridicule ever since they were introduced in
PageMaker 4.0. They're unpopular because terms such as "Loose" and "Tight" sound
imprecise, and some people have therefore concluded that they reflect some sort of
imprecise typographic control. But in fact the terms are not imprecise, they simply
de note the relative amount of spacing that each option applies. Tracking values change
for every font and every type size. So while the "Loose" option does have an exact
meaning expressed in a percentage of the normal character spacing, that meaning is
different for 14-point Times than for 18-point Times, and the 18-point Times value is
different that it is for 18-point Helvetica. This can be seen by looking at tracking curves,
as illustrated in Figure 9-25.
The basic trend of most tracking curves is that character spacing is reduced as point
size increases. This compensates for the fact that normal increases in character spacing
at larger point sizes often give text the look of having too much white space. As can be
seen in the examples in Figure 9-26, there is a great difference between the effect of the
different tracking curves on 36-point text and on 12-point text.
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Figure 9-25:
Tracking
curves specify
the amount of
increase or
decrease in the
default character
spacing for one
particular font at
every different
point size.
Five separate
tracking curves
are specified
for a font,
corresponding to
PageMaker's five
tracking options.
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Figure 9-26:
The three lines of both the
12-point and 36-point lines
have tight, normal, and
loose tracking applied (top
to bottom).
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Character spacing
You can also change the space between characters with the Letter space and Word
space options in the Spacing attributes dialog box, which is shown in Figure 9-27. Unlike
kerning and tracking, which are designed to produce pleasing visual relationships
between characters, letter and word spacing are designed to help PageMaker hyphenate and justify your text. And unlike manual kerning, range kerning, expert kerning, and
tracking, which are character-level attributes, letter and word spacing are paragraphlevel attributes: They always apply to all of the characters in a paragraph.
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Figure 9-27:
The Spacing attributes
dialog box.
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To access the Letter space and Word space options, select the paragra phs you want to
format, choose the Paragraph command (Command - M) from the Type menu, and then
click the Spacing... button inside the Paragraph Specifications dialog box. Examples of
the results you can achieve with these options are shown in Figure 9-28.
PageMaker measures both word spacing and letter spacing in Ylooth of a spaceband (the
width created when you press the spacebar). When a paragraph is not justified, word
and letter spacing are based on the Desired options, and the Minimum and Maximum
options have no effect. When a paragraph is justified, PageMaker follows a series of
steps to determine how much word and letter spacing will be used:
•

If a word does not naturally end at the end of a line, PageMaker then attempts to

make the last whole word fit onto the line by compressing the space between the
words on that line.
•

If this cannot be done without compressing the word space more than the
specified Minimum word space option, it then tries instead to expand the space
between words, up to the specified Maximum word space, to push the last word
down to the next line.

•

If this cannot be done without exceeding the Maximum word space option,

PageMaker attempts to hyphenate the last word according to the current hyphenation option.
•

If suitable hyphenation cannot produce a line ending that keeps the word
spacing within its specified range, then PageMaker adjusts letter spacing by first
compressing the s pace between letters and then by expanding the s pace between letters.

•

If changing le tter spacing within the range specified by the Minimum and Maxi-

mum letter spacing does not produce a s uitable line ending, then PageMaker
creates a suitable line ending by expanding the space between words as much as
necessary, even beyond the specified Maximum word space option.
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Figure 9-28:
This sample
paragraph
shows the
result of
increasing
maximum
word
spacing
(top) and
red ucing
minimum
letter
spacing
(bottom).
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Every free action is produced by the concurrence of two!
Lauses; one moral, i.e. the will which determines the act; th~
pther physical, i.e. the power which executes it. When I wa~
l:owards an object, it is necessary first that I should will to gl
lliere, and, in the second place, that my feet should carry me. I
~paralytic wills to run and an active man will not to, they will
~oth stay where they are. TI1e body politic has the same motive,
powers; here too force and will are distinguished, will underthell
pame of legislative power and force under that of executive
r,ower. Without their concurrence, nothing is, or should be

I

~one.

I

Every free action is produced by the concurrence of tw~
auses; one moral, i.e. the will which determines the act; the othe
hysical, i.e. the power which executes it When I walk towards
n objec~ it is necessary first that ! should will to go there, and,
n the second place, that my feet should carry me. If a paralytic·
·lis to run and an active man will not to, they will both stay
here they are. The body politic has the same motive powers;
ere too force and will are distinguished, will under the name o
~eg is lative power and force under that of executive power. With
put their concurrence, nothing is, or should be, done.

PageMaker's default values provide for a wide range of word- and letter-space movement: The space between words can range from 50% of a spaceband to 200% of a
spaceband, and the space between letters can range from 5% less than normal to 25%
more than normal. You may want to narrow these ranges to force more hyphenation
and less dramatic word and letter spacing in your justified paragraphs. I find that values
of 75% to 150% word spacing, for example, produce much more pleasing results.
Setting all three letter spacing options to the same value, 0 for example, effectively turns
off letter spacing so that PageMaker has to determine line endings using hyphenation
and word spacing changes only. Or you can set both the Minimum and Desired letter
spacing to "0," so PageMaker will not reduce the space between letters but may expand
the space if necessary.
The allowable ranges for setting word space and letter space options are listed here. All
options can be modified in 1% increments
• Minimum Word spacing:

O%to 500%

• Desired Word spacing:

;e: min and ~ max
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• M aximum Word spacing:

0% to 500%

• Minimum l etter spacing:

-200% to 0%

• Desired letter spacing:

~

• Maximum letter spacing:

0% to 200%
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min and s; max

After setting Word s pacing and Letter spacing options, ·(:lick the OK button to apply
these settings, click Reset to return all options to their original settings, or click the
Cancel button to negate them and return to the Paragraph specifications dialog box.

••••••••••••••••••••••••••••••••••••••••••••••••
Summary
•

Formatting attributes are divided into character-level attributes that can be
applied to any individual character and paragraph-level attributes that are
always applied to an entire paragraph.

•

Character formatting attributes include font, type size, type style, leading,
tracking, and width. These attributes are set by selecting text with the text tool
and then using commands in the Type menu or options in the Type specifications dialog box. You can also apply character formatting using the control
palette.

•

Paragraph formatting attributes include margin indents, before and after
spacing, tabs, hyphenation, alig nment, paragraph rules, and letter spacing
options. These commands are primarily controlled using the Paragraph specifications dialog box, com mands in the Type menu, and the contro l palette.

•

Character spacing in PageMaker can be controlled using automatic pair
kerning, manual kerning, range kerning, the Expert kerning Addition, tracking,
letter spacing, or by condensing or expanding type. Pair kerning and tracking
should almost always be used for text larger t han body copy.

•

Tracking is a font- and point-size specific way to modify the space between
characters in o rder to produce better-looking and better-fitting type. Manual
and range kerning can accomplish this, too, but require much more effort and
experience.

•

When justifying text, PageMaker decides how to break lines depending on the
option settings in the Spacing attributes dialog box and the Hyphenation
dialog box. You use the options in these dialog boxes to specify how dramatically PageMaker can alter the default letter spacing of you r text in order to
meet its justification and hyphenation goals .

••••••••••••••••••••••••••••••••••••••••••••••••
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•
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Creating style sheets
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Importing and exporting style sheets

•

The Styles palette
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You Say Tomato, I Say...
I'll start with an admission: I may be the only person left who calls these things style
sheets. It's the name I learned when first confronted with this feature in the original
Microsoft Word on the IBM PC. (Everyone has some dirt in their past.) Aldus just calls
them styles, but I think that is too easy to confuse with character styles Qike bold or
italic). Others call them paragraph styles, which is actually a pretty good name. But I'm
used to style sheets, so Jet's just leave well enough alone.

What are they? They're the most important trick you will ever learn to save time and
improve the consistency of your publications. Style sheets allow you to specify a
complex set of attributes with a single click of the mouse button and then change these
attributes globally at any time. A style sheet consists of a name, which usually describes
the kind of paragraph the style sheet defines, and a definition, which identifies the textformatting attributes that the style sheet assigns to any paragraph to which the style
sheet is applied. PageMaker's style sheets can contain attributes from the Type specifications, Paragraph specifications, Indents and tabs, and Hyphenation dialog boxes.
Style sheets automate the process of formatting text. They make it possible to specify
the formatting attributes of a paragraph only once, and then use that specification an
unlimited number of times. This not only saves time and reduces effort and complexity,
but it also ensures consistency- every paragraph using a particular style sheet will be
identical. A set of default style sheets is created for every PageMaker publication, and
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since style sheets can be imported from word processing documents, exported to word
processing documents, and shared between publications, the benefits of defining and
using style sheets can be enormous.

Working with Style Sheets
Style sheets are useful because most documents are composed of several kinds of
paragraphs, each of which is used repeatedly throughout the publication. This book, for
example, uses five primary types of paragraph formats:
•

Body text. Set in 11-point Memphis Light book with 13.5 points of leading.
Paragraphs are left justified with a 0.375-inch first line indent. Widow and orphan
control options are set to 2 lines each.

•

Major Subheads. Set in 24-point Helvetica Compressed bold with Auto leading.
Paragraphs are left justified with 0.5 inch of space above each. Keep with next
option set to 2 lines.

•

Minor Subheads. Set in 18-point Helvetica Compressed oblique with Auto
leading. Paragraphs are left justified with 0.33 inch of space above each. Keep
with next option set to 2 lines.

•

Inline Graphics. Same as body text, with 0.25-inch space before, 0.1-inch space
after, keep with next 1 line.

•

Cutlines. These are set in 10-point Helvetica Condensed italic with Auto leading.
Before spacing of 0.25 inch.

Without style sheets, formatting the book would require assigning the above attributes
over and over again by selecting each individual menu command and completing the
required dialog box options for each separate paragraph. And any design changemaking the subheads a little bit larger, for example - would require going through the
publications page-by-page and reformatting each subhead paragraph appropriately.
With style sheets, this scenario improves dramatically: The specifications for the five
paragraph styles need to be specified only once- when defined as style sheets - and
then they are applied to the te>.'t as needed. Applying style sheets to a paragraph, a
process sometimes called tagging, is quick, simple, and accurate. Once tagged, the
paragraph instantly assumes all of the formatting defined by the style sheet. And when
the inevitable design changes occur, all that is required is a change to the style sheet
definition; the resulting change automatically applies to every paragraph tagged with
that style sheet.
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Creating Style Sheets
There are several ways to define new style sheets in PageMaker: They can be defined
from scratch, based on some formatted text that already exists in the publication, or
based on another style sheet that already exists. When you first start working with style
sheets, you'll have to define a lot of new ones or redefine a lot of existing ones. Over
time you should build up a library of style sheets that cover the bulk of the paragraph
types you'll use, and you will be able to reuse these by continually importing them into
your publications. The result will be that you will spend very little time actually formatting text.
·

Defining a style sheet from scratch
To begin defining a new s tyle sheet, choose the Define Styles ... command from the Type
menu, and the Define styles dialog box will appear (as shown in Figure 10-1.) If it is not
selected already, click on the word Selection at the top of the scrolling list on the left
side of the dialog box and then click the New ... button. The Edit style dialog box will
now appear, as shown in Figure 10-2. It is here that you specify the name and formatting
attributes for the new style sheet.
Figure 10-1:
The Define styles dialog box.
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Figure 10-2:
The Edit style dialog box.
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To name the new style sheet, enter any name up to 32 characters long into the Name
option box (some nonalphabetic characters ar e not allowed in style names). Try to
name your style sheet descriptively but use as short a name as possible so that you can
see it easily in the Styles palette. The Based on option should remain set to No style.
Now you're ready to define the attributes that your new style sheet will apply to any
paragraph on which it is used. In the lower portion of the Edit style dialog box is a
listing of the current settings of the sty le sheet's attributes. These settings come from
the current default settings of the vru·ious options used to define style sheets or from
the formatting of the text that was selected when the Define Styles ... command was
chosen.
To edit these specifications, use the Type ... , Para ... , Tabs.. ., and 1-lyph ... buttons.
These access the Type specifications, Paragraph specifications, Indents and tabs, and
Hyphenation dialog boxes, r espectively. Each of these dialog boxes is used exactly as
described in Chapter 9, "Formatting Text." As you edit the various options in these
dialog boxes, the style sheet specification listing is updated to reflect the current
attributes of the style sheet.
When you are satisfied w ith the specifications for the new style sheet as listed in the
lower portion of the Edit style dialog box, click the OK button to complete the definition
of this new style sheet or the Cancel button to abort the creation process. In either
case, you are returned to the Defin e styles dialog box. The name of the new style sheet
now appears in the scrolling style sheet listing. To return to the publication window,
click the OK button or the Cancel button.
You can also begin the process of defining a new style sheet by holding down
the Command key and clicking on the No style line in the Styles palette. (If the
Styles palette is not displayed, choose the Style palette command from the
Windows menu.) This brings up an empty Edit style dialog box, where you can
name the new style and edit its specifications as described above. If any text is
selected when you Command-click on the No style line, the new text block will
use the specifications of the selected type as its defaults, or the Based on
option will display the name of the selected text's style sheet, if there is one.

Defining a style sheet based on existing text
The process of defining style sheets from scratch , as described above, requires that you
know in advance the specifications that you want to ascribe to your new sty le sheets.
This happens sometimes, but more often you will not know the final specifications for
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your publication until you create a few pages of it and experiment with various formatting possibilities until you become satisfied. In this case, you will want to "capture" the
results of your trial-and-error formatting, creating a style sheet for each different ldnd of
paragraph that you have defined. These style sheets can then be used to format the
remainder of your publication.
To create a style sheet based on an existing paragraph, use the text tool to set the
insertion point in one of the formatted paragraphs you want to use as a basis for your
new style sheet and choose the Define styles .. . command from the Type menu. (Note
that you want to set the insertion point rather than select the whole paragraph because
one italicized or bold word may cause problems, as you'lllearn later.) The Define styles
dialog box will appear, and the word Selection will be highlighted in the scrolling list
(unless the selected paragraph has already been defined as a style sheet). Selection
refers to the text paragraph that was selected when you chose the Define styles ...
command. The specifications for the selected paragraph are listed in the lower section
of the dialog box. These are the specifications that PageMaker assumes you want to use
in your new style sheet.
Click the New ... button, and the Edit style dialog box will appear. Enter the name you
wish to give this new style sheet in the Name option box. The Based on option will be
blank, unless the paragraph that you selected before choosing the Define styles ...
command had been defined previously as another style sheet.
You can now edit any of the attributes of the style sheet by clicldng on the Type ... ,
Para... , Tabs ... , and Hyph ... buttons and changing options in the associated dialog
boxes. Since the default attributes of this new style sheet came from a paragraph that
you formatted, this will probably not be necessary. However, if any attributes of the
selected text are not uniform - if there is one bold word within a paragraph of plain
text, for example- the word mixed will follow the specification of that attribute in the
specification listing, as shown in Figure 10-3.
Figure 10-3:
The word mixed appears
for any attribute that is not
uniform in the selected
text when a new style
sheet is created.
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Any attributes followed by the word mixed will have to be reset so they can be applied
uniformly throughout the paragraph. To reset the type style, for example, click the
Type ... button and click either the Normal or Bold option so all words will be set in the
same type style. The word mixed then disappears from the specifications listing.
The Define next style option is used to determine the style sheet that will be applied to
paragraphs that are created by pressing the Return key within a paragraph to which the
current style has been applied. The purpose of this option is to speed up text entry by
automatically applying style sheets as new paragraphs are created. For example, the
paragraph following each subhead in this book uses the Body text style sheet. By
assigning Body text to the Next style option for the subhead style sheets, paragraphs
created after entering subheads are automatically assigned the Body text style. The
setting of the next style option does not affect the style sheet of paragraphs following
the current paragraph unless the Return key is pressed -regardless of the setting of
the Next style option, any style sheet can follow any other if it is manually applied to the
following paragraph.
When you are satisfied with the specifications for the new style sheet as listed in the
Edit style dialog box, click the OK button to complete the definition of this new style
sheet or the Cancel button to abort the creation process. If any conflict remains in the
specifications, a dialog box, like the one shown in Figure 104, appears when you click
the OK button, and you will have to resolve the conflict. If no specification conflicts
exist, the Define styles dialog again displays, with your new style added to the scrolling
list. To return to the publication window, click the OK or Cancel button.
Figure 10-4:
One of the alert dialog
boxes announces a conflict
in a new style sheet.
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You can also define a new style based on existing text by selecting the text and
holding down the Command key while clicking on the No style line in the Styles
palette. Of the Styles palette is not displayed, choose the Style palette command
from the Windows menu.) This will bring up the Edit style dialog box, where
you can name and edit the attributes of the style, as described above. Click the
OK button after defining the new style sheet or the Cancel button to abort the
creation, and you will return immediately to the publication window.
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Creating new style sheets based on existing
style sheets
Many paragraph styles used in a publication are very similar, but not identical, to other
paragraph styles used in the publication. For example, the minor subheads in this book
have the same type face and alignment as the major headlines, but different type sizes,
type styles, and paragraph spacing.
In PageMaker, you can create style sheets that are based on existing style sheets. When

one style sheet is based on another, it has exactly the same attributes as the style sheet
upon which it is based, except the few attributes that are set differently. Using this
technique reduces the amount of effort required to define the based-on style sheet and
creates a dynamic link between the two style sheets - if an attribute is changed in the
base style sheet, it is automatically changed in the second style sheet.
For example, suppose we define a style and name it Subhead 1, giving it the attributes of
Times-Bold 18/20, fully justified, with a first-line indent of 3 picas. We then define
another style, which is based on Subhead 1, and name it Subhead 2. The only attribute
that we change for Subhead 2 is its alignment, which is set as aligned left. Figures 10-5
and 10-6 display the Edit style dialog boxes for these two styles.
Figure 10-5:
To base one style sheet on
another, you begin with
one style sheet that uses
most of the attributes you
want in the second style
sheet.
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Notice that Subhead 2 does not display a typeface, type s ize, or first-line indent specification in its attribute listing. Instead, it s imply reads Subhead 1 + flush left. All paragraphs to which Subhead 2 is applied will be Times-Bold 18/20 with a first-line indent of
one-half inch, as long as Subhead 1 is so defined, or until the typeface, type size, leading,
or first-line indent is specifically edited in the Subhead 2 style s heet definition. If the
definition of Subhead 1 is edited so that Helvetica is the specified font instead of Times,
all paragraphs to which Subhead 2 has been a pplied will immediately become Helvetica
as well. The link between a style sheet and the sheet on which it is based is dynamicchanges made in the attributes of a style sheet are passed directly to any style s heets
based on the c hanged style sheet.
If we created a third style sheet, called Subhead 3 which is based on Subhead 2, a
change to an attribute in Subhead 1 would affect Subhead 1, Subhead 2, and Subhead 3.

To create a new style sheet that is based on an existing style sheet, choose the Define
styles ... command from the Type menu, and the Define styles dialog appears. Depending on the currently selected text in the publication window, either one of the style
sheet names or the word Selection will be selected. If the s tyle sheet that you want to
base your new style sheet on is not selected , select it from the scrolling list. Next, click
the New.. . button and the Edit style dialog box appears. The Name option box will be empty,
but the Based on option box will clisplay the name of the style s heet selected when the New. ..
button was clicked. Enter a name for your new style sheet in the Name option box.
The specification listing for the new style sheet will contain only the name of the Based
on style. At this point, the new style is exactly the same as the style on which it is
based. By using the Type . .. , Para ... , Tabs ... , and Hyph ... buttons and their associat~d
dialog boxes, you can specify the attributes of this new style sheet that are clifferent from the
Based on style sheet. The specifications listing reflects these changes as you make them.
When you are satisfied with the specifications for the new style sheet as listed in the
Edit style dialog box, click the OK button to complete the definition of this new style
sheet or the Cancel button to a bort the creation process. The Define styles dialog box
again displays, with the name of your new style sheet added to the scrolling list. To
return to the publication window, click the OK button or the Cancel button.
You can also create a new style sheet that is based on an existing style sheet by selecting a paragraph that uses the existing style sheet, holding down the Command key and
clicking on the No style line in the Styles palette. Or you can select the name of the style
in the Styles palette that you want to base the new style on (first make sure no text is
selected) and then hold down the Command key and click on the No style line. Either of
these methods will bring up an empty Edit style dialog box, with the Based on option
already set, so that you can name the new style and edit its specifications. Click the OK
button after defining the new style sheet or the Cancel button to abort the creation, and
you will return immediately to the publication window.
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To break the link between a style sheet and the style sheet that it is based on, select the
No style option in the Based on pop-up menu. This removes the name of the based-on
style from the specification listing and replaces it with the specifications themselves.
This does not change any of the specifications for the style sheet, only the way that
they are listed. This does, however, break the link between the style sheets so that if the
style sheet on which this style sheet was based is edited, this style sheet will not be
affected. You can also change the Based on style sheet from one to another by selecting
the name of any current style sheet in the Based on pop-up menu.

Default style sheets
PageMaker automatically creates the five style sheets shown below for every new
publication. While these are representative of commonly used kinds of paragraphs,
their default specifications probably won't match those that you regularly intend to use
in your publications. You can correct this situation by redefining the default style
sheets to meet your needs.
The original default style sheets:
Body text

Times Roman 12/Auto, left aligned, 2-pica first indent, kern above 12,
auto hyphenation

Caption

Times-Italic 10/Auto, left aligned

Headline

Times-Bold 30/Auto, left aligned, include in TOC

Subhead 1

Times-Bold 18/Auto, left aligned, include in TOC

Subhead 2

Times-Bold 12/Auto, left aligned, include in TOC

To set your own default style sheets, close all open publications and then choose the
Define Styles command. Now edit the default style sheets as necessary. You can rename
them, change the formatting they specify, add or delete styles, and even import other
styles that you have defined for other publications. (Importing style sheets is described
In the next section of this chapter.) When you've set all the style sheets to meet your
needs, close the Define styles dialog box. Now when you create any future new publications, the default style sheets that you have specified will be created and included in
your publications.
Redefining the default style sheets provides every new publication that you create with
these default style sheets, and gives you access to quick and easy text formatting and
an assurance of perfect consistency throughout your publications. Of course, you will
still need to edit your c ustomized default style sheets within some specific publications,
and sometimes you'll have to create additional style sheets for particular tasks, but
overall you'll find that a well-thought-out set of default style sheets is one of the best
ways to boost PageMaker productivity and quality.
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Importing Style Sheets
Once you've defined a good set of style sheets for one publication, you can move those
style sheets to other publications to save even more time in formatting text and to
ensure consistency among different files.
PageMaker makes it easy to import styles from one publication into another. Open the
publication you want to import the style sheets into, and then choose the Define
styles ... command from the Type menu to bring up the Define styles dialog box. Click
the Copy ... button and the Copy styles dialog box appears, as shown in Figure 10-7.
Locate the publication containing the style sheets that you want to import, select the
name of the publication, and click the OK button or double-dick the publication name.
All style sheets from the opened publication will then be added to the list of style sheets
in the current publication. If the names of any imported style sheets have already been
assigned to styles in the new document, PageMaker warns you that the imported style
sheets will override the existing style sheets. To preserve any existing style sheets that
have the same names as the style sheets being imported, rename them before performing the import.
Figure 10-7:
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Style sheets and word processors
The concept of s tyle sheets is not unique to PageMaker. Several popular word processors use style sheets, and although these style sheets are implemented slightly differently than PageMaker's style s heets, they provide bas ically the same function - by
assigning a group of formatting attributes to a named style s heet, those attributes can
be quickly applied and edited.
Style sheets from both Microsoft Word (see Figure 1().8) and WordPerfect files are
converted into PageMaker style sheets when their files are placed into PageMaker. This
conversion is done by the same import filter that converts all other document formatting. The style sheets from the word processor become PageMaker style sheets, named
just as they were in the word processor, specifying the same formatting, and tagged to
all the same paragraphs. These style sheets can then be used and edited just as if they
had been created in PageMaker.
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Figure 10-8:
Microsoft Word's Define
Styles dialog box.
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If the PageMaker publication already contains a style sheet with the same name as an

imported style sheet, the existing style remains, and all paragraphs in the word processed document that have been formatted with that style sheet name will assume the
attributes of the PageMaker style sheet.

Style sheet tags
When using a word processor that does not have a style sheet feature or whose style
sheets cannot be imported into PageMaker, it is possible to manually tag paragraphs so
that the predefined style sheets are applied as the text is placed into PageMaker. To do
this, you put the name of the style sheet in between less than ( <) and grea ter than (>)
symbols and add it to the beginning of each group of paragraphs that use a pa rticular
style. This is best illustrated through an example. The word processing document
shown in Figure 10-9 includes manual style sheet tags for three styles: Headline, Body
text, and Analytic Comment.
When this file is placed into a PageMaker publication that already has style sheets
defined with the names Headline, Body Copy, and Analytic Comment, those styles can
be automatically applied to the paragraphs as specified by the manual style sheet tags.
To do this, use the Place command to import the file and select the Read tags option in
the lower right corner of the Place document dialog box. This instructs PageMaker to
look for manual style sheet tags, remove them, and tag the associated paragraphs with
the existing style sheets that have the same name. After placing the word processed
document shown in Figure 10-9 in this way, the text will be formatted (according to the
style sheets) as shown in Figure 10-10.
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Figure 10-9:
A text
document
with style
sheet tags
before each
paragraph.
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If the Read tags option is not selected, tags are treated like any other text, and the text
will appear as shown in Figure 10-11 (exactly as it appeared in the word processed file).

Figure 10-11:
Tagged
documents
imported
without using
the Read tags
option are
treated as
normal text
files.
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Manually tagging paragraphs for style sheets is usually too tedious to be worth the
effort, although it can be made tolerable with a macro utility or glossary feature that
automates the tagging process by reducing it to one or two keystrokes. In most cases,
unless you must have the person who does the word processing specify the tags
(because the person doing the layout does not know which paragraphs should receive
which tags), it is faster and easier to just apply the tags once the text is in PageMaker.
Ironically, the best way to get manual tags in a word processing file is to have
PageMal{er itself generate them when it exports text out of a publication. As described
later in this chapter, PageMaker's Export command can add manual style sheet tags so
you can edit text in any external word processor and then bring it back into the publication without losing the style sheet assignments. Of course, this doesn't help you assign
style sheets in the first place, but it does help you to keep style sheet assignments once
you've made them.
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Applying Style Sheets
Creating style sheets is the hard part. Applying them is easy. All you have to do is select
a paragraph, partial paragraph, or group of paragraphs and choose the style sheet you
want to apply from either the Styles palette (accessed by choosing Style palette in the
Windows menu) or the Style command submenu (in the Type menu).
Once the style sheet has been selected, the paragraph will immediately reformat to the
defined specifications. Because it is a paragraph attribute, style-sheets formatting
applies to entire paragraphs that are partially or fully selected when the style sheet
name is selected. Even if the insertion point is set in a paragraph but no text is selected,
a style sheet can be applied to that paragraph.

Overriding Style Sheets _ _ _ __
Because style sheets are a paragraph-level formatting attribute- a single paragraph
can have only one style sheet applied to it, and a style sheet is applied to an entire
paragraph and not just to a portion of a paragraph- you usually cannot do all of your
formatting with style sheets. Inevitably you'll need to apply some character-level
formatting to some of the words within a style-sheet-formatted paragraph, making some
words bold or larger or setting them in a different font. PageMaker calls such characterlevel formatting overrides, because these represent inconsistencies in the application of
the style sheet to the paragraph.
You can apply character-level formatting to style-sheet-formatted paragraphs without
limitation. You have to be careful, however, because if you apply a different style sheet
to a paragraph that contains overrides or reapply the current style sheet to the paragraph, all overrides will be removed except type style overrides. Type style overrides
remain active even when a style sheet is reapplied to a paragraph or when a different
style sheet is applied to the paragraph.
Suppose for example that you have a line of text that contains one bold word (the rest
are plain), one 24-point word (the rest are 18 point), and one word in the Times font
(the rest are Helvetica), as shown in Figure 10-12. If the current style sheet is reapplied,
or a new style sheet is applied to this sentence, the Times font and the 24-point type
size will disappear (conforming instead to the specifications of the applied style sheet),
but the bold word will remain distinguished from the other words (by being un-bold). If
the applied style sheet has bold defined as its type style, every word in the sentence
will become bold except the previously balded word, which will become plain: In other
words, applying the style sheets toggles the setting of any override type styles that are
included in the style sheet. [f the overriding type style is not included in the applied
style sheet, the override is unaffected. So the italic word in our original paragraph
would be set in bold italic after the new style sheet was applied.
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All incon~fstencies
in form~tting are

281

Type style diHerenc:es are reversed by sly/a sheets.

Type style differences are reversed by style sh-ts.

overridden by
style sheets
except type style
overrides, which
are unchanged or
are reversed
when a new style
sheet is applied.

There is a way to preserve any non-type style overrides: Hold down the Shift
key while applying a new style sheet. The Times font and 24-point type size in
the above example, in this case, would remain as they were, and only the nonoverridden text in the paragraph would be formatted according to the style
sheet specifications.

The Styles Palette
The Styles palette, shown in Figure 10-13, is a floating window that lists the names of all
currently defined style sheets along with entry No style. The palette can be displayed at
any time by selecting the Styles palette command from the Windows menu. When the
Styles palette is displayed, a check mark(/) appears before the Style palette command.
Selecting the Styles palette command while the palette is displayed will remove it from
the publication window. The Styles palette can be moved, sized, and closed using the
window title bar, size box, and close box, respectively.
Figure 10-13:
PageMaker's default Styles palette.
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The Styles palette serves many functions:
•

Checking style of text. As soon as any paragraph is selected, or the insertion
point is set, the Styles palette highlights the name of the style that has been
applied to the selected text. If the selected text contains text of more than one
style sheet, no name is highlighted. If the selected text has not been formatted
using a style sheet, the No style line is highlighted.
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\
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\

If the selected text contains formatting overrides for any attributes other than

type style, a plus sign appears after the style sheet name. Type style ovehrides
cause the plus sign to appear if only overridden text is selected. If both ty.~e style
overridden text and non-<>verridden text are selected, no plus sign will appear.
•

Applying style sheets. To apply a style sheet to any number of paragraphs,
select the paragraphs and then click on the appropriate style sheet name in the
Styles palette. The paragraphs will immediately format as specified by the
selected style sheet. More information about the application of style sheets is
included in the preceding section, "Applying Style Sheets."

•

Refonnatting edited style sheet text. To remove non-type-style overrides from
formatted text, select the te>..t in question (a plus sign will appear after the style
sheet name in the Styles palette) and reselect the style sheet name. The plus sign
will disappear, and the text will return to the pure style sheet specifications.
Type style overrides must be removed manually.

•

Disassociating text from a style sheet. There are times when you want to
disassociate a particular paragraph from the style sheet that has been applied to
it. The most common reason for this is that you intend to edit the style sheet
specifications, but you want this particular paragraph to retain its current
formatting. To remove the style sheet, select the text to be disassociated and
then select the name No style from the Styles palette. The formatting of the
selected text will not change, but the text is no longer associated with the style
sheet- any editing done to the style sheet will not be applied to the disassociated text.

•

A shortcut to editing an existing style sheet. To edit a style sheet, hold down the
Command key and then click on the name of the style you want to edit. The Edit
style dialog box appears. Editing a style sheet is described fully in the next
section of this chapter.

•

A shortcut to creating a new style sheet. The Styles palette can be used to
create a new style sheet from scratch, based on either formatted text or an
existing style sheet.
To create a new style sheet, make sure that no text is selected. Hold down the
Command key and then click on the name No style in the Styles palette. The Edit
style dialog box will appear. Here, you name the new style sheet and specify its
attributes, as described in the next section of this chapter.
To create a new style sheet based on formatted text, select the text, hold down
the Command key, and click on the name No style in the Styles palette. The Edit
style dialog box will appear, listing the attributes of the selected text. You can
then name the new style sheet and, if required, edit its attributes.
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To create a new style sheet based on an existing style sheet, select any paragraph (or set the insertion point within any paragraph) to which the based-on
style sheet has been applied. Hold down the Command key and then click on the
name No style in the Styles palette. The Edit style dialog box appears, listing the
name of the selected style sheet both in the Based on option box and as the only
attribute listing. You can then name the new style sheet and, if required, edit its
attributes.

Editing Style Sheets
One of the biggest advantages of using style sheets is being able to edit their attributes
at any time. When a style sheet is edited, all of the paragraphs to which that style sheet
has been applied -throughout the current publication -are instantly updated.
There are two ways to begin editing a style sheet. The first is to choose the Define
styles ... command from the Type menu, select the name of the style you want to edit
from the scrolling list, and then click the Edit ... button. The second is to hold down the
Command key while clicking on the style sheet name in the Styles palette. Either
method brings up the Edit style dialog box. Once the Edit style dialog box appears, you
can edit any attributes of the selected style sheet. The current specifications of the style
sheet are listed in the lower portion of the dialog box.
You can edit the style sheet name in the Name option box. Names can be up to 32
characters long, although some special characters cannot be used in style sheet names.
You can also edit the Based on option by selecting another style sheet name from the
pop-up menu. If the current style sheet is based on another style sheet, you can break
the link between the style sheets by selecting the No style option in the Based on popup menu. This will remove the name of the Based on style from the specification listing
and replace it with the specifications themselves.
Edit the specifications for the current style sheet, using the Type ... , Para ..., Tabs ... , and
Hyph .. . buttons and their associated dialog boxes. Click OK to close each dialog box
and return to the Edit Style dialog box. The specification listing will reflect these
changes. When you are satisfied with the name and specifications for the style sheet,
click the OK button (twice if you began with the Define styles ... command). The Define
styles dialog box will again display. If you have edited the style sheet name, the new
name appears in the scrolling list. You can perform any other functions available, click
the OK button to save all style sheet changes, or click the Cancel button to negate all
style sheet changes. In e ither case, you will return to the publication window. If changes
were saved, the publication window and Styles palettes will be updated.

\
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Editing style sheet text
\

Even after a style sheet has been applied to a paragraph, it is still possible to edit the
paragraph or any of the text that it contains. This is done using the same text- and
paragraph-editing techniques described in Chapter 9, "Formatting Text." For example,
you can select a word and make it bold, center the paragraph, add tabs in the Indents/
tabs dialog box, or make any other editing changes. These edits will affect only the
word(s) or paragra ph(s) to which they are applied and will not affect any other paragraph using the same style sheet. To edit every paragraph that has been formatted with
a particular style sheet, use the style sheet editing techniques described in the preceding section.
An edited paragraph (or any of the text it contains) is still associated with its style

sheet - any changes made to the style sheet attributes will be applied to the paragraph. When an edited paragraph (or any of the text in it) is selected, a plus sign(+)
appears after its style sheet name in the Styles palette.
Once a paragraph has been edited, you can create a new style sheet that reflects the
current specifications of the paragraph by selecting the paragraph , and then either
Command-double-clicking on the word No style in the Styles palette or choosing the
Define styles ... command from the Type menu and clicking the New ... button. Either
method produces the Edit style dialog box, which displays the name of the original style
in the Based on option box and complete specifications for the modified paragraph
listed below. You can then name the new style sheet and, if required, edit the style
sheet specifications.
To return the specifications of an edited paragraph to the original specifications of the
style sheet applied to it, select any portion of the paragraph and click on the style sheet
name in the Styles palette or select the style sheet name from the Styles command from
the Type menu. This will correct any inconsistencies in the paragraph except type style
overrides, which must be corrected manually.

Expo~gStyreSheeb
When exporting text documents using the Export ... command from the File menu, you
can export specifications for every style sheet or simply export a style sheet tag that
represents the associated style sheet by placing a marker at the beginning of every
paragraph. The process of exporting text documents is fully described in Chapter 9.
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••••••••••••••••••••••••••••••••••••••••••••••••
Sum~ary
•

Style sheets provide an easy and accurate way to apply character and paragraph formatting.

•

You can define style sheets, using the options in the Type specifications,
Paragraph specifications, Hyphenation, and Indents/ tabs dialog boxes, or you
can base style sheets on existing paragraphs. You can also import style sheets
from word processing files or other PageMaker publications.

•

To apply a style sheet, display the Styles palette, select the text you want to
format, and click the name of the style you want to apply. You can also apply
styles using the Style command in the Type menu.

•

To change the specifications of a style sheet, use the Edit button in the Define
styles dialog box. Any changes made to style sheet definitions automatically
appear in all paragraphs to which the style has been applied .

••••••••••••••••••••••••••••••••••••••••••••••••
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PageMaker's text-formatting abilities set it apart from most word processors, and its
ability to integrate graphics with text - and even create new graphics - puts it in
another realm entirely. In this chapter, you'll learn all about working with both imported and PageMaker-created graphics.
The majority of graphics you'll use in PageMaker will be created in dedicated graphics
applications like Aldus FreeHand, Adobe Photoshop, or even Microsoft Excel (when you
need business charts), and then imported into PageMaker. As this chapter explains,
PageMaker works with imported graphics much like it works with imported text. When
your graphic needs are more simple, you can use PageMaker's own tools to create lines,
boxes, ovals, and other ~ornamental" graphics.
Once you have a graphic element in your publication, whether imported or created
internally, it can be freely positioned on any page in the publication, resized, rotated,
skewed, or cropped. And graphic elements can be set as inline graphics, which flow
along with text, or you can use the text wrap option to force text to wrap around the
graphic elements.

p

T
E
R
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Importing Graphics _ _ _ _ __
The process of importing graphics into PageMaker is similar to the process of importing
text, as described in Chapter 7, "Creating Text."
•

Graphics are prepared in a dedicated graphics application and saved in a
PagcMaker-compatible format.

•

The Place ... command is used to select the graphic file you want to import.

•

The graphic is positioned within your publication.

•

You can reposition, resize, or crop the graphic and specify text wrap options, if
necessary.

Preparing graphics
PageMaker can import graphics that are stored in the most popular graphic file formats:
MacPaint (MPN1), PICT, Encapsulated PostScript (EPS), and Tagged-Image file Format (IlFF).
Most graphic applications on the Macintosh allow you to save files in one or more of these
formats, as do many PC-based graphic applications.
•

Paint-type graphics, such as those created by SuperPaint, PixelPaint, and
MacPaint (shown in Figure 11-1). These applications provide a wide range of
graphic capabilities, but bitmapped images created in such applications are
limited in resolution to 72 dots per inch (dpi), the resolution of most Macintosh
monitors. When output at the higher resolutions of laser printers and imagesetters,
bitmapped graphics usually have a jagged look that is not pleasing. However, a
tremendous amount of clip art is available in this format, giving the nonartist access
to a variety of images that can be placed in PageMaker quickly and easily.

Figure 11 -1: A bitmapped graphic image created in MacPaint.
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Draw-type graphics saved in PICT format, such as those created in MacDraw II,
Canvas, Cricket Draw, and many other applications (see Figure 11-2). These graphics
applications are best suited to the creation of geometric images consisting primarily of regular lines and shapes, such as technical illustrations and architectural
renderings. Draw-type images will print at the full resolution of any PostScript
output device, even when scaled larger or smaller than their original sizes.

Figure 11-2: Draw-type art created in Canvas.

•

Encapsulated PostScript (EPS) graphics, such as those created in Adobe Illustrator, Aldus FreeHand, and some graphic scanning applications. These types of
graphics (as shown in Figure 11-3) can describe any kind of image using the full
power and precision of the PostScript language. Illustrator and FreeHand support the infinite manipulation of line, curve segments, text, and colors.

Figure 11-3: An encapsulated PostScript graphic created in Aldus FreeHand.
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TIFF fonnat documents, commonly created with scanners and their software or
with image-editing software, such as Adobe Photoshop or Digital Darkroom, or
paint-type software that supports color. Usually the TIFF format (see Figure 11-4)
is used to store photographic images or high-resolution bitmapped art. The
resolution of TJFF images varies depending upon the source, but these images
are often of extremely high quality. PageMaker's Image control.. . command
makes it possible to manipulate TIFF format documents inside of PageMaker, as
described later in this chapter.

Figure 11 -4: A scanned graphic saved in TIFF format.

Most graphics programs can save files in one of these formats, but if you do find a
graphic in an incompatible file format, you may be able to convert it into a usable
format with a file conversion utility such as MacLink Plus. Or, you may be able to open
the file in a program that supports a wide range of formats, like Adobe Photoshop, and
then save it in a PageMaker-compatible format. As another option, try importing the
graphic, using the Macintosh Scrapbook and Clipboard. (Cut the graphic out of its
current application, paste it into the Scrapbook, open PageMaker, and then copy it out
of the Scrapbook and paste it into PageMaker.)
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Unlike text files , graphic files cannot be edited inside PageMaker. They can be positioned, scaled, and cropped, and MacPaint or TIFF files can be modified with the Image
Control command, but they cannot be edited without returning to the application that
created them. The sequence of events necessary to edit a graphic file in its original
application and then have those changes reflected back in your PageMaker publication
depends upon the type of graphic file being used and the application that created it.
For graphics created in Aldus FreeHand, Aldus SuperPaint, and Aldus PrePrint,
PageMaker supports a proprietary mechanism called the Aldus hot link that makes it
very easy to update graphics. All you have to do is triple·dick on the graphics with the
arrow tool or select the graphic and choose the Edit Original command from the Edit
menu. The original application and original document file will open, and you can then
make any changes necessary. Save your changes, and when you return to PageMaker,
the graphics in your publication will be updated reflecting the saved changes.
Similarly, PageMaker supports the System 7 edition manager, which uses the Publish
and Subscribe commands, and their associated options, to link documents created in
one application to elements from those documents used within other applications.
Changes made to original documents can flow through to other documents automatically, or updates can be requested manually. Another mechanism supporting this
capability is Microsoft's Object Linking and Embedding (OLE), which is also supported
by PageMaker 5.
For graphics not eligible for an Aldus hot link and not imported using the edition
manager or OLE, PageMaker's own linking, as controlled with the Link ... and Link
options ... commands, provides tools to help keep current versions of graphics in your
publication. Using System 7's edition manager and Microsoft's OLE to import and
manage graphics is discussed in more detail later in this chapter. For a complete
discussion of PageMaker's Unk ... and Link options ... commands, see Chapter 16, "Long
Document Features."

The Place command
Before importing any graphic into PageMaker, you must decide if you want it to be an
independent graphic or an inline graphic. An independent graphic, as shown in Figure
11-5, is one that you can freely position anywhere on any page of your publication, and
that will remain in that location unless you move it. An inline graphic, as shown In Figure
11-6, is one that you embed within a text story, and which therefore flows with that text
story- moving up or down a page, or even from one page to another- as the text is
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edited. You'll usually use inline graphics in longer publications, such as books and
technical manuals, where graphics are related to specific text passages and the text is
likely to be edited and therefore flow from page to page. Independent graphics, on the
other hand, are common in flyers, newsletters, magazines, and other publications
where text flow is unlikely to be very drastic.
Figure 11-S:
An independent
graphic is not
attached to any
other elements on
the page. These
graphics can even
cross column and
page boundaries, as
in this example.

If you want to import a new element as an independent graphic, you don't have to make
any special preparation. To import an element as an inline graphic, however, you must
select the text tool and set the text insertion point at the location in an existing text
block where you want the inline graphic to be positioned. If you want to import a new
graphic to replace an existing graphic in your publication, select the graphic you want
to replace.
Now choose the Place... command from the File menu. In the Place document dialog
box, which is shown in Figure 11-7, the choices depend on what was selected before the
dialog box was opened. If the text cursor was set in an existing text block, the options
read As independent graphic and As in line graphic. If an existing graphic was selected ,
the options read As independent graphic and Replacing entire graphic. If the text cursor
was not set, and no graphic was selected, only the As independent graphic option will
be available.
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Figure 11-6:
lnline graphics are
treated as
characters or
paragraphs of text.
Here the chair is
placed as an inline
graphic as a
paragraph, and
the small cones are
placed like
characters in the
text.
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Figure 11 -7:
The three possible combinations of Place options for
graphic files.
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Choose the appropriate Place option, and then locate the graphic file you want to
import in the scrolling file list. The options at the bottom of the Place document dialog
box apply only to text importation and are therefore dimmed when placing graphics.
To place the graphic, double-click on the filename or select the file and then click the
OK button.
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PageMaker then reads the selected file from your drive and prepares to position the
graphic in your publication. When importing an inline graphic, the graphic appears
automatically at the location where the insertion point was set. If you are importing a
file as an independent graphic, one of the five graphic placement icons shown in Figure
11-8 appears.
Figure 11-8:
The paint, PICT, EPS, TIFF, and
Scrapbook graphic placement
icons used by PageMaker.
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These graphic placement icons work like the loaded text cursor introduced in Chapter
7; locate the area on your publication page, pasteboard, or master page where you want
to put the graphic and then click the mouse to release the graphic. If necessary, you can
turn to the appropriate page using the page icons or the Go to page ... command
(Command-G), or reposition the screen display using the scroll bars, grabber hand, or
view-size commands, before clicking the mouse button, without losing the graphic
placement icon.
There are actually two ways you can place the graphic:
•

To place the graphic at its full size, position the graphic placement icon at the
position on the page where you want the upper left corner of the graphic to be
located, and click the mouse button, as shown in Figure 11-9. The graphic is
then placed at full original size, flowing over any text or existing graphic elements, column or ruler guides, or edges of the electronic pages. The graphic is
now selected, ready to be sized and, if necessary, repositioned.
f?S" ........... ............. . .... ....... .. .
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Figure 11-9: Position the graphic placement icon where you want the upper left corner of the
graphic to be located, and then click the mouse button to place the graphic.
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To place the graphic at some specific size, position the graphic placement icon
at the position on the page where you want the upper left corner of the graphic
to be located. Click and hold the mouse button while dragging to create a
marquee of the final size for the imported graphic. This marquee can be created
across column guides, onto the pasteboard, over existing text, or anywhere else.
Release the mouse button when the marquee is correctly sized and positioned,
and the graphic will flow into this defined area. If necessary, th~graphic will be
scaled to fit within the space defined by the marquee.

Edition files and OLE objects
PageMaker supports System Ts publish and subscribe technology (also known as the
edition manager), allowing you to import edition files using either the Place command
or by the more standard method of using the Subscribe to command in the Edit menu.
Functionally, there is no difference between importing an edition file with the Place
command and the Subscribe to command. If you are used to working in PageMaker and
don't use editions very frequently, you'll probably find the Place command more
convenient. If you do regularly work with editions (does anybody regularly work with
editions?) or want to remind yourself of the extra capabilities the Edition manager
provides, then you might prefer the Subscribe to command. It's up to you.
You can also bring in graphic objects using Microsoft's OLE technology from programs
like Microsoft Excel. But to bring in OLE objects, you cannot use the Place command,
you'll have to use the Paste Link or Insert Objects commands in the Edit menu. For a
more complete discussion of OLE technology, see Chapter 7, "Creating Text."

Manipulating Imported Graphics _
After you have imported a graphic, whether as an independent or inline graphic, you
can resize, reposition, or crop it. You can also replace any graphic with any other or
update the imported graphic to reflect changes made in the original document in the
original application.
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Resizing graphics
To resize a placed graphic, whether independent or inline, select the graphic with the
arrow tool, then drag one of the graphic's handles with the arrow tool. Every graphic
has eight handles, and dragging any one of them will stretch the graphic, distorting it
only in the direction of the drag (see Figure 11-10). Be sure that the pointer turns into a
double-headed arrow when you select the handle; this confirms that you have selected
the handle rather than the graphic itself. You may have to hold the mouse button down
for a few seconds before beginning to drag the mouse to allow the double-headed arrow
icon to display.
Figure 11-1 0:
A graphic can be resized by
d ragging on any of the
graphic handles that appear
when the graphic is selected.

As you resize an imported graphic, an empty box represents your resized graphic, while

the graphic itself remains visible at its original size. To see the graphic at any new size,
hold the mouse still for a few seconds while keeping the mouse button pressed. The
graphic will redraw temporarily at its new size- you can then continue to resize it if
you are not yet satisfied with its appearance. When you are satisfied, release the mouse
button, and the graphic will be permanently redrawn. H you want to return the graphic
to its original size after resizing it, use the Undo command (Command-Z) from the Edit
menu immediately after releasing the mouse button.
You can ensure that a graphic is resized proportionally, avoiding any distortion
to the original image, by holding down the Shift key while you drag one of the
four corner handles of the selected graphic, as shown in Figure 11-11. If the
graphic has been previously distorted, as soon as you hold down the Shift key
and click on any graphic handle, the graphic snaps back to its original proportions. You cannot proportionally resize a distorted graphic while maintaining
the distortion.
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Figure 11 -11:
Proportionally resizing
graphics is accomplished by pressing the
Shift key while scaling.

When resizing paint- or TIFF-type graphics, hold down the Command key while dragging, (with or without the Shift key depending on whether or not you want to resize
proportionally), and PageMaker allows you to reduce or enlarge the graphic only to
sizes that can be printed at the best possible resolutions on the currently selected
PostScript output device. As you drag, the graphic will snap to the nearest available
size, as shown in Figure 11-12.
Figure 11-12:
Holding down the Command key while
resizing a TIFF file scales the graphic so
that it prints at a resolution consistent
with that of your printer.

PageMaker makes these determinations based on the resolution of the graphic and the
resolution of the current output device. For example, since many paint-type graphics
are created at a resolution of 72 dpi, and most laser printers print at 300 dpi, these
graphics should be printed only at sizes that are 96 percent, 72 percent, 48 percent, or
24 percent of the original size. At these sizes the 72 dpi can be divided evenly into
the result of the resolution times the reduction percentage (300 x 0.96 + 72 = 4). At a
percentage where the dpi could not be divided evenly, the resulting image would not be
reproduced as smoothly. You will find that 300-dpi graphics cannot be reduced when
you are printing to a 300-dpi printer, but they can be reduced to a number of different
sizes when a 1,270-dpi or higher-resolution printer is selected. Especially when working
with gray-scale scanners, you might want to reduce the dpi at which you scan to allow
yourself more freedom in high-quality reductions and enlargements.
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Draw-type and EPS graphics, on the other hand, can be sized to any percentage of the
original size and will still print with the highest quality possible because their original
definitions are mathematically described rather than being based on a particular
resolution.

Repositioning graphics
An independent graphic can be positioned by simply dragging it with the arrow tool:

Point the arrow tool anywhere on the graphic except on its handles, click and hold the
mouse button, and drag the graphic to a position. If you need to position the graphic on
an area of the page that is not currently displayed on screen, drag the graphic past the
edge of the display, and the page will scroll automatically.
The only way to relocate an in line graphic is to cut and paste it to a new position. To do
this, select the graphic with the Arrow tool, choose the Cut (Command-X) command
from the Edit menu, select the Text tool, position the insertion point within any text
block in your publication where you want to position the inline graphic, and choose the
Paste (Command-V) command from the Edit menu. You can make an independent
graphic into an inline graphic in the same way; cut the independent graphic, select the
text tool and set the insertion point in the text block, and then choose the Paste command: The graphic will now be positioned within the text block.
An inline graphic can be moved up or down within its current text position by clicking
on it with the arrow tool and dragging up or down. During this action, the cursor will
tum into a double-sided vertical arrow (shown in Figure 11-13) with a horizontal line
through it. The horizontal line represents a text baseline, and any possible movement of
the graphic will be altering its baseline as if it were text. The amount of movement
possible- in some cases none will be possible- is dependent upon the paragraphformatting attributes that have been applied to the inline graphic.
Figure 11-13:
You can reposition an inline
graphic by dragging it up or
down with the arrow tool.
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A more precise way to position an inline graphic is to manipulate its text-formatting
attributes. By selecting an inline graphic, you can reposition it by setting its leading
option and paragraph spacing. You can also use the Keep with next option, and other
paragraph-formatting options. The baseline shift option from the control palette can be
used too. Finally, you can create style sheets and apply them to inline graphics just like
any other text paragraph.
By a pplying the Align to grid option to an inline graphic, you can make sure that
the line of text that follows the graphic is always lined up with your design grid,
regardless of any repositioning or manipulations (rotation, cropping, skewing,
etc.) done to the inline graphic. To access the Align to grid option, click the
Rules button in the Paragraph s pecifications dialog box and then click the
Options button in the Paragraph rules dialog box.

Cropping graphics
Any placed graphic, whether independent or inline, can be cropped using the cropping
tool from the toolbox. Cropping removes a portion of the placed graphic, reducing the
space occupied by the remaining graphic without changing the graphic's size.
To crop a graphic, select the cropping tool from the toolbox and click anywhere on the
graphic (if it is not already selected) so that the graphic handles are displayed. Position
the cropping tool over any handle (as shown in Figure 13-14) so that the handle shows
through the middle of the cropping tool, and press and hold down the mouse button.
The cursor will become a two-headed arrow, and you can now drag the handle to trim
off the edge of the graphic. You can also decrop the graphic to reinstate any previously
trimmed portions of the graphic: Using the cropping tool, drag a handle back over the
previously trimmed portion of the image.
Once a graphic has been cropped , you can reposition the graphic within the remaining
graphic frame. By repositioning the graphic within its frame, you can expose previously
trimmed parts of the image and hide previously exposed portions. This is accomplished
by positioning the cropping tool inside the gra phic borders, rather than on any handle
or on the graphic frame, and pressing and holding the mouse button down until the
grabber hand cursor appears, as shown in Figure 11-15. While still holding the mouse
button down, drag the mouse to re position the graphic within the frame. This technique
is useful for cropping a graphic in order to reduce the amount of space it occupies
rather than to eliminate any particular portion of the graphic. Once you have determined the correct size for the graphic frame, you can position the underlying graphic
for best display within the available space.
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Figure 11-14:
You can crop a graphic w ith the cropping
tool by clicking on any graphic handle.

Figure 11-15:
After being cropped, a graphic can be
repositioned within its graphic frame.

Changing between independent and inline
graphics
Using the Cut and Paste commands, you can turn an independent graphic into an inline
graphic, or an inline graphic into an independent graphic. To tum an independent
graphic into an inline graphic, select the graphic and choose the Cut command from the
Edit menu (Command-X). Then select the text tool and set the insertion point at the
location within an existing text block where the new inline graphic should be positioned. Finally, select the Paste command from the Edit menu (Command-V).
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To turn an inline graphic into an independent graphic, select the inline graphic with
either the arrow tool or the text tool and choose the Cut command from the Edit menu
(Command-X). If you are selecting with the arrow tool, handles will appear when the
graphic is selected. To select the graphic with the text tool, drag over it so that it
becomes highlighted. After cutting the graphic, select the arrow tool, and then choose
the Paste command from the Edit menu (Command-V). If you use the Paste command
with the text tool selected, even if you have reset the insertion point, the graphic will
remain an inline graphic.

Replacing or updating graphics
After you have positioned, sized, and cropped an imported graphic element, you may
find it necessary to replace the graphic with a newer version or to replace it with an
entirely new graphic. Or you might have used a black box or dummy graphic to hold the
place of a graphic and later need to replace this placeholder with a final graphic.
PageMaker provides two ways to replace an existing imported graphic with another: the
Place .. . command and the Links ... or Link options ... command. (For a complete discussion of the Links commands, see Chapter 16, "Long Document Features.")
To replace one graphic with another using the Place .. . command, select the existing
graphic with the arrow tool, and then choose the Place... command (Command-D) from the
r!.le menu. This brings up the Place dialog box. From the scrolling file listing, select the
graphic me you want to import and then select the Replace existing graphic option. Finally,
click the OK button or double-click the graphic file name. The new graphic will be imported,
repladng the selected graphic.

If the new graphic is the same size as the existing graphic (before any scaling or

cropping), the new graphic will be scaled and cropped to fit the space of the old
graphic exactly. If you don't want to maintain the existing cropping values,
deselect the Retain cropping data option in the Place dialog box. (Note that this
option has no effect on edition files or OLE linked graphics.) If the new graphic
is a different size than the existing graphic, it will be scaled so that the size of
one of its edges exactly matches the size of one edge of the graphic being
replaced. In this case you will probably have to resize or crop the new graphic
to properly fit in your layout. If the proportions of a graphic are changed by the
replacement process, you can quickly get the graphic back to its original
proportions by holding down the Shift key and clicking on any graphic handle.
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The new graphic also receives the graphic boundary (which controls how text
wraps around the graphic) of the graphic it is replacing. This boundary may
include irregular text wrapping and text placement attributes as set in the Text wrap
dialog box. The graphic boundary is described more fully later in this chapter.
To replace one graphic with another, or to replace an existing graphic with an
updated version of the same graphic, you can use PageMaker's file-linking
features. To do this, select the existing graphic with the arrow tool, and then
choose the Links info ... command from the Element menu. Select the name of
the file you wish to use to replace the existing graphic, and click the Link
button. PageMaker warns you that you are disposing of an existing graphic, and
you may then cancel the replacement if you wish.

Creating Graphic Elements _ _ __
The PageMaker toolbox contains four tools that can be used to create simple graphic
elements directly in your publication:
•

The diagonal line tool is used to create line segments.

•

The perpendicular line tool is used to create line segments at 4!Xlegree angles.

•

The square corner (rectangle) tool is used to create rectangles and squares.

•

The circle/oval tool is used to create ovals and circles.

In addition, you can apply lines above or below any paragraph in your publication,
using the options in the Paragraph rules dialog box. Each of PageMaker's graphic tools
and paragraph rules is discussed below.

The Line Tools
A straight line is a basic design element that will be required in almost every publication
that you ever create in PageMaker. Two tools can be used to draw straight lines in
PageMaker- the diagonal-line tool (see Figure 11-16) and the perpendicular-line tool
(see Figure 11-17). Using the diagonal-line tool, you can draw a continuous straight line
between any two points on any page or on the pasteboard. The direction of the line can
be constrained to any 4!Xlegree angle by holding down the Shift key. The effect of
constraining the diagonal-line tool is exactly like using the perpendicular-line tool,
which draws lines only at 4!Xlegree angles.
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Figure 11-16:
The diagonal-line tool in action.

Figure 11 -17:
The perpendicular-line tool in action.

To use either line tool, select it from the toolbox and then position the crossbar cursor
at the position where you want to begin the line. Drag the mouse in the direction of the
proposed line until the line is the proper length. If you drag into the edge of the display
while drawing a line, the screen will automatically scroll in that direction. Use the ruler
tick marks and dotted lines that track the cursor position to check the length of the line.
If you are drawing lines on the margin between two colum n guides, use the Snap to
guides command to ensure accuracy. ln most cases, the precision of your drawing will
be greater at more enlarged view sizes and is best at the Actual or 200% view sizes.
While drawing a horizontal or vertical line, the line is created on one side of the crossbar or the other. You can flip the line to the opposite side of the crossbar by moving the
crossbar itself slightly to one side.
Lines can be drawn only at the current default line width, which is indicated in the Lines
command submenu in the Element menu. You can change the current default line width
by selecting a new line width whenever a line or shape is not currently selected. A line
width selection made while a line or shape is selected will apply only to the selected
element and will not become the new default. Figure 11-18 shows the range of line styles.
Figure 11 -18:
Available line styles in
PageMaker.

• ••••••••••••••••••
......
.............. ....••.....
...............................
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Immediately after the line has been drawn, it is selected, as indicated by the handles
that appear at each end of the line. You can manipulate a selected line in several ways:
•

The line weight can be changed by selecting any of the options from the Lines
command submenu in the Element menu, or with the Lines and File command
from the Element menu. This includes predefined line weights and styles and a
Custom ... option that lets you define any line from 0 to 800 points in l-i~rpoint
increments. If a line's weight or style is changed, the line remains centered on its
original position.

•

The line length can be changed by dragging one of its handles with the arrow
tool, as s hown in Figure 11-19. When one of the handles is selected, the cursor
will become a two-headed arrow. If the two-headed arrow does not appear,
dragging at a handle will move the line rather than change the line length.

ttl
Figure 11-19: Dragging on the handle of a selected line changes its length.

•

The line can be repositioned by dragging it with the arrow tool positioned
anywhere except at a handle, as s hown in Figure 11-20.

Figure 11 -20: Dragging on a line anywhere except at its handles moves the line.

•

A color can be applied to the line by selecting a color from the Colors palette.

•

The line can be cut, copied, or deleted using the Cut (Command-X), Copy
(Command-C), and Clear commands (from the Edit menu) or the delete key.

A deselected line can be selected using any of the techniques described in Chapter 5, "A
Brief Tour of PageMaker."

The Shape Tools ________________
The two shape tools in the toolbox allow you to create basic shapes in PageMaker, and
any shape can be stroked with any of the line weights and s tyles found in the Lines
command submenu in the Element menu, or filled with the fill patterns from the Fllls
command submenu in the Element menu. Or you can use the Fill and line command from the
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Element menu to set both of these attributes at once. Shapes are used as basic design
elements to create borders around objects, to make drop-out boxes, and, in some cases, to
cover up other elements.
G The square<omer tool (see Figure 11-21) is used to create a rectangle with
square corners. With the Shift key pressed, the rectangle is constrained to a
square with square corners. The corners of any rectangle or square can be
modified by selecting the shape and then choosing the Rounded corners ...
command from the Options menu, as described later in this chapter. A rectangle
can be changed into a square at any time by selecting it, holding down the Shift
key, and clicking on one of the rectangle's handles.

1'---------4-11

Figure 11-21 : The square-corner tool in action.

m The circle/oval tool (see Figure 11-22) is used to create ovals and, with the Shift
key, to create circles. An oval can be changed into a circle at any time by selecting it, holding down the Shift key, and clicking on one of the circle's handles.

[C___
Figure 11-22: The circle/oval tool in action .

As any of these shapes is drawn, it is stroked with the current default line as selected in

the Line command and filled with the current default Fill pattern as selected in the Fill
command. Immediately after it has been drawn, the shape is selected, as indicated by
the handles that appear on all sides.
You can manipulate a selected s hape in several ways:
8

The line weight can be changed by selecting any of the options from the Line
command s ubmenu in the Element menu. This includes predefined line weights
and styles and a Custom ... option that lets you define any line from 0 to 800
points in Ylo -point increments.
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•

The fill can be changed by selecting any of the options from the FiU command
submenu in the Element menu.

•

The size of the shape can be changed by dragging one of its handles with the
arrow tool. When one of the handles is selected, the cursor becomes.a tw<r
headed arrow, as shown in Figure 11-23. 1f the tw<rheaded arrow does not
appear, dragging at a handle will move the shape rather than change its size.

Figure 11-23: Any shape can be resized by dragging at one of its handles.

•

The shape can be repositioned by dragging it with the arrow tool, as shown in
Figure 11-24. If the shape's selected fiH pattern is None (from the Fill submenu in
the Elements menu), you must drag the shape by the lines that define it, placing
the arrow tool anywhere on the line except on a handle. A shape that has any fill
pattern other than None can be selected and moved by positioning the arrow
tool on the lines or anywhere on the fiii inside the shape.

Figure 11-24: Shapes can be repositioned by dragging anywhere except on their handles. If
filled, they can be dragged by their contents as well as their borders.

•

A color can be appUed to the shape by selecting a color from the Colors palette.

•

The shape can be cut, copied, or deleted using the Cut, Copy, Clear commands
(from the Edit menu) or the delete key.

A deselected shape can be selected using any of the techniques described in Chapter 5.
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I,ine Weights and Fill Patterns
You can apply line weights, styles, and fi!J patterns to PageMaker-created graphic
objects using the Line or Fill submenus in the Element menu, or you can use the Fill and
line command (Command- ]) in the Element menu. This new PageMaker 5 command
brings up the Fill and line dialog box shown in Figure 11-25. It lets you specify both line
weights and styles and fill patterns, specify line and fill colors, and set object-level
overprinting for lines and/or fills.
Figure 11-25:
The Fill and line
dialog box.
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The line weights and patterns available are the same as those provided in the Line
submenu, as were shown in Figure 11-18. Or you can choose the Custom ... command
and specify any line weight from 0 to 800 points in Ylo-point increments. The Reverse line
option draws all lines in white instead of black; such lines are visible only when drawn
on a filled or solid background. The Transparent background option makes the space
between dashes in dashed line patterns transparent instead of opaque.
The available fill patterns are s hown in Figure 11-26. For both the selected line and fiH,
you can choose any available color from the Color pop-up menu. If you want to use a
color not already in the color palette, you have to use the Define colors command from
the Element menu to add the color before applying it from the Lines and fills dialog box.
Use of the Define colors dialog box is described in Chapter 14, "Working with Color."
Figure 11 -26:
Available fill patterns in PageMaker.
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The Overprint options for both lines and fill patterns provide a way to specify that
either aspect of the current object will overprint, rather than knockout, the colors of
any underlying text or graphic elements. Overprinting is most often used as a form of
trapping, to avoid unsightly gaps between colors that can occur because of
misregistration during the printing process. To correctly use overprinting, you must
understand the relationship between the objects in your publication, the colors of
those objects, and the prepress and printing methods that will be used to reproduce
your document. A complete discussion of object level overprinting, and all of
PageMaker's color-specific capabilities, is included in Chapter 14.
The Transparent option makes it possible to see through any gaps between dashed or
double lines. If this option is not selected, the Paper color is automatically applied to
these spaces. After setting the options in the Unes and fill dialog box, click OK. The line
or shape that was selected then redraws, approximating its new line weight or fill
pattern. You shouldn't count on the display representations being very accurate,
especially for the density of fill patterns. The relatively low resolution of your display
just cannot produce shadings accurately. Some line weights, such as hairlines, will also
be inaccurate on-screen. Trust the line weight and fill pattern names (1-point, or 30%,
for example) and discard what you see on-screen. When printed on any PostScript
device, the lines and fills will be accurate, as illustrated in Figure 11-27.
Figure 11-27:
On-screen
versions (left)
and printed
versions (right)
of a 20%, 60%,
and diagonalline fill style plus
hairline, 0.5point, and
1-point line
styles.

Wrapping Text around Graphics
When a graphic object in your publication is next to a text block or overlaps either fully
or partially, you will want to wrap the text around the shape of the graphic. PageMaker
can automatically wrap the text around the graphic in a rectangular fashion, or you can
perform some manual adjustments and have the text wrap follow the irregular shapes
of your graphic.
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To turn text wrap on for any graphic, select the graphic object and choose the Text
wrap ... command from the Element menu. The Text wrap dialog box will then appear,
as shown in Figure 11-28. The options in this dialog box determine how text reacts to
the graphic, both when text is flowing and when text overlaps the graphics. In most
cases, you'll set text wrap options after both text and graphics are in place, but you can
also set these options after adding the graphics but before adding the text, or you can
set text wrap defaults that apply to all future graphics you add to your publication.
Figure 11-28:
The Text wrap dialog box.
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Adding a graphic boundary
Text wrap works in PageMaker when a graphic boundary is defined around a graphic
object. The graphic boundary defines the minimum space between the graphic and any
surrounding text and is represented by a dotted line that appears around the graphic
whenever it is selected. When a graphic does not have a graphic boundary, text can
flow or be positioned directly on top of the graphic.
To create a graphic boundary, select a graphic and then choose the Text wrap ...
command from the Element menu. The three Wrap option icons at the top of the dialog
box determine the kind of graphic boundary your graphic will have. The three Text flow
icons determine how text will react to the graphic boundary when flowing towards the
graphic object.
•

Wrap option. The first Wrap option is the None icon, which leaves the object

without a graphic boundary or removes any existing graphic boundary. When
this option is selected, text can fully overlap the selected graphic, as shown in
Figure 11-29.
The middle icon is the Regular graphic boundary icon, which adds a rectangular
graphic boundary around the graphic. This graphic boundary will be offset from
the object by the distance specified by the Standoff option described later. This
will cause text to wrap around the graphic according to this rectangular graphic
boundary, as shown in Figure 11-30.
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Figure 11-29: Text with no graphic wrap.
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Figure 11-30: A rectangular graphic boundary.

The third icon is the Custom graphic boundary, but this icon cannot be selected
directly. Instead, it becomes selected automatically when a rectangular graphic
boundary is customized, as discussed later. If this icon is selected, selecting the
None icon or the Rectangular graphic boundary icon will remove the custom
graphic boundary, replacing it either with no graphic boundary or with a rectangular graphic boundary, respectively.
•

Text flow. If either the Regular graphic boundary or Custom graphic boundary
option is selected, then three Text flow options become available for selection.
(If the None icon is selected for the Wrap option, then the Text flow options
cannot be selected, and all three icons will be dimmed.) These options specify
how text will react to the graphic if it is positioned within the column guides or in
previously created text block when text is being flowed.
Selecting the Column break icon causes text to stop flowing when it reaches the
top graphic boundary. If the automatic flow option is currently selected, text flow
will resume at the top of the next column.
Selecting the Jump graphic icon causes the text to stop flowing when it reaches
the graphic boundary at the top of the graphic and resume flowing under the
graphic boundary below the graphic.
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The Wrap around icon causes the text to continue flowing when it reaches the
top graphic boundary, wrapping all sides of the graphic that intrude into the text
block and continuing to flow below the graphic.
•

Standoff in _ _ The four values entered for this option (in the current unit of

measure) control the distance from the graphic to the top, bottom, left, and right
edges of its rectangular graphic boundary. These values determine the space
between the graphic and any text. You can enter a different value for each of the
four settings.
If a graphic boundary is customized, as indicated by the selection of the Custom

graphic boundary icon in the Wrap option, the values in the Standoff in option
become irrelevant for that graphic boundary. If a graphic is resized after the
graphic boundary and standoff values have been set, the amounts of standoff will
remain the same for the scaled graphic as for the graphic at its original size the values are not reduced proportionally.
When the Text v.rrap options have been set to your satisfaction, click the OK button or
press Return or Enter. The graphic element will now refl ect the settings you have
specified. If a graphic boundary has been specified, it will be displayed. If text did not
previously wrap around this graphic, the text will not wrap around the new graphic
boundary until the graphic is repositioned - even if it is just dragged out of position
and then back to its exact previous position. If the text did wrap the graphic previously,
the text will rewrap to reflect any changes made in the

Customizing a Graphic Boundary _
Once a rectangular graphic boundary has been created for a graphic element (by
selecting the Rectangular graphic boundary icon in the Wrap option of the Text map
dialog box, or if the graphic is created while the Rectangular graphic boundary is the
default setting), the position and shape of the graphic boundary can be customized to
better fit the graphic. See Figure 11-31 for an example.
This is done by manipulating the corner points of the graphic boundary, which are
called graphic boundary handles. These a llow you to resize and reposition the graphic
boundary with respect to the graphic itself. It is also possible to add additional graphic
boundary handles so you can define the graphic boundary more precisely, closely
matching the form of an irregularly shaped graphic. Actually you can customize a
graphic boundary in four different ways:
II Drag boundary segments.
•

Drag boundary handles.
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•

Create additional boundary handles by clicking on the graphic boundary, and
then drag the new boundary segments or boundary handles.

•

Delete existing boundary handles by dragging one on top of another, and then
manipulate the remaining boundary segments or boundary handles.

Figure 11-31 :
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Normally every time you move a boundary segment or boundary handle,
PageMaker recomputes the text wrap and you have to wait for the screen to
refresh. You can te mporarily prevent this recomputation by holding down the
spacebar while adjusting the graphic boundaries or boundary handles. Keep
the s pacebar down while you move as many boundaries and handles as you
need, and then release it. The text wrap will then be recomputed, and
PageMaker will redraw the screen to reflect these changes. This can substantially speed up the process of customizing the boundary of an irregularly
shaped object.

The Image Control Command _ _
Although earlier I said that it is impossible to modify graphics imported into PageMaker
from other graphic applications, the Image control. .. command from the Element menu
does make it possible to modify some attributes of paint-type and TIFF-format graphics
while they are in PageMaker. Choosing the Image control. .. command displays the
Image control dialog box, shown in Figure 11-32.
In the Image control dialog box, you can make any of the following modifications:

•

Adjust the line-screen, screen angle, and function used to output paint-type or
TIFF graphics
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•

Adjust the gray level mapping used to output TIFF graphics

•

View the effects of these changes in your image without closing the dialog box
I me e control

Figure 11-32:
The Image control
dialog box as it
appears when a TIFF
graphic is selected.
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To begin the manipulation, select the graphic that you wish to manipulate and then
choose the Image control. .. command from the Options dialog box. If the graphic you
select is not a paint-type or TIFF graphic, the Image control command will be dimmed.
The Image control dialog box will appear, as shown in either Figure 11-32 or Figure
11-33. You can move the Image control dialog box to another location on your monitor
by dragging its title bar. This allows you to see the effect that your manipulations are
having on your graphic without repeatedly closing the dialog box.

Figure 11-33:
The Image control
dialog box as it
appears for a
MacPaint or
monochrome TIFF
image.

n
[]

~~~

U nt.>s!ln : Ilf'l T

lightness

OK

(Cancel
( Reset

....L...I-L..L.L..Lcwon~st (

1111111!!

JJ

I
I
I

To understand the control provided by the options in this dialog box, you must understand a little about how PostScript printe rs work. When a document is converted into a
PostScript file and sent to a PostScript printer, the printing device applies a series of
dots to the page in accordance with the instructions given in the PostScript commands.
Since most PostScript printers can create only black dots, they utilize a halftoning
technique to simulate gray areas.
To determine which dots should be on and off in order to produce a halftone,
PostScript uses the concepts of halftone cells, frequency, angle, and function. Each
PostScript output device contains some number of machine pixels -these are the
smallest dots that the printer is capable of producing. Laying a uniform square grid over
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the printable area divides the machine pixels into halftone cells. Each machine pixel
belongs to one of the halftone cells, and each halftone cell is made up of some number
of machine pixels.
The grid that divides the imageable area has a frequency, which is the number of
halftone cells per inch into which it divides the imageable area, and an angle, which is
the number of degrees by which the grid (and thereby each halftone cell) is rotated
from being parallel to the bottom of the page. The function of a halftone cell is the
mathematical expression used to determine the order in which individual pixels that
make up the cell will be turned off in order to simulate increasing gray levels.
Each PostScript printer has default values for the frequency and angle of its halftone
cells and for the function used to simulate gray values. These defaults are used unless
other values are specified in the Image control dialog box for the Lines/ In (frequency),
Angle, and Screen (function) options.
The first set of options in the Image control dialog box contains the Black and white,
Screened, and Gray options. These options determine how the image appears on the
screen, which of its attributes can be manipulated, and to what degree they can be
manipulated. The Black and white option indicates that the selected image has no gray
values, as with most paint-type graphics. It will be selected automatically when appropriate, usually for bitmapped paint-type images. You can manually select the Screened
option, but not the Gray option, for these kinds of images.
The Screened option indicates that the selected image is a gray-scale image, and it too
will be selected automatically when appropriate. When the Screened option is selected,
you can adjust the Screen, Angle, Lines/In, Lightness, and Contrast options, all of which
are unavailable when the Black and white option is selected.
The Gray option is available only when working on a Macintosh II equipped with a highresolution monitor with the Monitors control panel device set to display two or more
colors or shades of gray (and preferably 16 or more) . This option enables PageMaker to
display gray values on-screen for the selected image, but it has no effect on the output
of the image. When the Gray option is selected, the Screen, Angle, and Lines/In options
are dimmed.
The Screen option determines whether a line or dot screen pattern is used to create the
graphic image. As we mentioned, this is essentially the function used in the halftoning
process. When the dotted icon is selected, machine pixels in the halftone cell are turned
off in an evenly spaced pattern to represent specific gray values. When the lines icon is
selected, machine pixels are turned off so that the remaining pixels form a linear
pattern. See Chapter 17, "Printing Publications," for examples of these options.
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The Angle option determines the angle of the screen used to create the image when
printed. Control over this option is useful when creating special effects in conjunction
with the Screen option.
The Lines/In option determines the number of lines per inch used to create the image
when printed. This controls the frequency of the halftone cells, as discussed earlier.
The higher the number used for the Lines/In option, the smoother an image will appear,
but the fewer the number of availa ble s hades of gray. The lower the number used for
the Lines/In option, the coarser an image will appear, but the greater the number of
available shades of gray.

Gray value mapping
The remaining options in the Image control dialog box control the ma pping of actual
gray values to printed gray values. For example, a linear mapping prints an area defined
as 10% gray as 10% gray, an area defined as 70% gray as 70% gray, and so on. An inverse
mapping prints an area defined as 10% gray as 90% gray, an area defined as 30% gray as
70% gray, and so on.
The bar chart displayed in the Image control dialog box represents the current mapping
s pecification. The x-axis represents the actual values, and they-axis represents the
printed values. When an image is first selected, linear mapping is selected -the values
increase from 0 to 100 relative to both the x- and y-axes.
There are three different ways to control gray value mapping: using the Contrast and
Lightness options; using the Normal, Negative, Posterize, and Solarize icons; or using
the mapping bar chart itself.
The Contrast option allows you to adjust the entire range of gray values to compress or
expand the range of gray values in the image. Clicking on the upper contrast arrow
darkens values less than 50% and lightens values greater than 50%. Clicking on the
lower contrast arrow lightens values less than 50% and darkens values greater than
50%. These changes are displayed in the bar graph as they are made.
The Lightness option allows you to lighten or darken all values in the image at the same
time. Pressing on the upper lightness arrow darkens all values (except those already at
100%), and pressing on the lower lightness arrow lightens all values (except those
already at 0%). These changes are displayed in the bar graph as they are made.
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The four mapping icons allow you to quickly access four common mapping optionsNormal, Negative, Posterize, and Solarize. A Normal mapping is equivalent to the linear
mapping described earlier, and a Negative mapping is equivalent to the inverse mapping described earlier. The Posterize mapping uses a stair-stepped mapping that groups
a range of values and makes them identical. This is done for several ranges and results
in stair-stepped gray values - transitions between gray values are abrupt rather than
smooth . The Solarize mapping changes all 50% gray values to 100% gray (black),
doubles all values between 0% and 40%, and inverts all values from 60% to 100%.
After you have manipulated any or all of these options, clicking the Apply button redraws
the image based on the new settings without closing the dialog box. Clicking the Reset
button resets all options in the Image control dialog box to their original settings.
Clicking the OK button executes the changes and closes the dialog box; clicking the
Cancel button restores the image to its original values and closes the dialog box.
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••••••••••••••••••••••••••••••••••••••••••••••••
Summary
•

PageMaker can import the most popular graphic formats: MacPaint, PICT, EPS,
and TIFF.

•

You can add graphics as independent elements or place them inline with
existing text blocks so they flow along with the text.

•

Any graphic can be freely moved or resized. You can ensure that a graphic is
resized proportionally by holding down the Shift key while resizing it.

•

You can crop any graphic w ith the crop tool and move the graphic within its
cropped window by dragging with the cropping tool in the middle of the
graphic.

•

PageMaker's line, rectangle, and circle tools let you create these basic shapes in
your publication. You can set these objects in a variety of line weights and
styles, and fill shapes with any color or shading and a variety of fill patterns.

•

You can wrap text around any imported or PageMaker-created graphic, and
customize the graphic boundary to have text wrap around the irregular shape
of any graphic. Hold down the spacebar while adjusting the graphic boundary
to prevent the screen from redrawing at every change.

•

You can lighten, brighten, or adjust TIFF images and bitmapped graphics
(MacPaint format), using the Image control command .

•• ••••••••••••••••••••••••••••••••••••••••••••••

318

Part II: Mastering PageMaker

c

H

.;\;

Sample
Project Two
In this chapter, you will use PageMaker to create a two-sided flier like those commonly
used for marketing and direct mail. The step-by-step explanation of this flier, represents
the second of three sample projects presented in this book. This one focuses on an
intermediate-level collection of commands and features offered by PageMaker and
demonstrates how these features can be used to satisfy a variety of publication production needs.
Since your flier will be two-sided, you will create it as a two-page document. You will
also design the flier to be folded into thirds for easy and inexpensive mailing. As an
added customer incentive, you will include a discount clip-out coupon at the bottom of
the flier.
Fliers do not generally contain superfluous text, so for this project you will use only one
fairly short text file. You will also import a graphic saved in the MacPaint format.
Throughout the creation of this flier, you will use the typefaces Palatino and Zapf
Dingbats. If you do not already have the Palatino or Zapf Dingbats screen fonts loaded
into your System file, copy them into the Fonts folder in your System folder (if you are
using System 7), or use the Font/DA Mover to install them (if you are using System 6)
from your System Software floppy disks .

Creating Your Publication
1. To begin your publication, launch PageMaker and then click your mouse button
to dispense with the copyright screen.
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Changing default settings
Before you create a new file, you will alter some application default settings in PageMaker. Aldus has set PageMaker defaults to the most commonly used settings for each
option. By changing these defaults to accurately reflect your needs, you can save the
time and energy it would take to change specific settings over and over again in each
publication. Here are some examples of the default settings built into PageMaker:
•

A new file is created for Letter-size paper with Tall orientation.

•

Inches is the default unit of measurement.

•

Type specifications are set for 12-point type size, Times Roman typeface with
Auto leading, and flush left alignment.

•

Two column guides are set to provide one column per page.

•

The default line weight is 1 point and the default fill is None, providing transparent interiors for boxes drawn in PageMaker.

Many of these defaults are useful, but as you continue to work in PageMaker, you will
discover more and more defaults that do not satisfy your most common requirements.
PageMaker recognizes that your publication needs and page-creation worldng habits
are as unique as you are, so the application allows you to specify your own defaults. If
you create legal-size pages more often than letter-size, you may want to change the
default setting for the Page size option. If you prefer the typeface New Baskerville to
Times Roman, you can change the Font option as well.
There are two ways to change defaults settings. The first method is to choose commands and select options at the PageMaker desktop while no publications are open.
This resets the application defaults and applies for every new file that you create from
that point on, until you again reset the defaults. The second method is to choose
commands and select options in an open file while no element is selected. These
become publication defaults, which affect only the current file and do not affect files
you create in the future.
2. To begin, choose the Preferences ... command from the File menu to display the
Preferences dialog box. One of the options in this dialog box, the Measurement
system option, determines the system of measurement used in the rulers and dialog
boxes while you create documents. PageMaker offers five units of measurement:
• Inch, the most commonly used system of measurement in the United
States.
• Inch decimal, which divides the standard inch into ten equal segments.
• Mllllmeter, a metric unit equal to ~ 000 meter or ~0 centimeter. The
metric system is used commonly throughout Europe.
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• Pica, a unit of measure that is roughly ~ inch. A pica is subdivided into
12 equally sized units called points. Picas and points are the traditional
unit of measurement for American typesetting and page composition
and are now the preferred system of measure ment in desktop publishing applications.
• Ciceros, a unit of approximately 4J-2 millimeters, the traditional unit of
measurement for European typesetting. Like the pica, a cicero is
subdivided into 12 points. (One cicero point is approximately equal to
1.06 pica points.)
You can also select a unit of measure from the Vertical ruler column
that affects the scale on your vertical ruler only. Generally, this option
should be set to the same unit of measure selected from the Measurement system column.
3. For worldng through this example, Choose the Picas option from the Measurement system pop-up menu. Also choose Picas from the Vertical ruler option.
Click the OK button or press the Return or Enter key to confirm your changes.
Figure 12-1 shows the new defaults.
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Figure 12-1: The Preferences dialog box showing the new default settings.

This change in the default setting for Measurement system, from inches to picas, has
now been saved to the PMS Defaults file, which resides in the Preferences folder inside
your System folder (if you are using System 7). Any new documents created in PageMaker will default to picas instead of inches, as long as Picas remains the default
setting. Existing documents, however, will retain the same system of measurement that
was chosen the last time each document was saved.
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If you want to alter any other default settings, now is the time to do so. For this project,
you will alter type specification defaults, line width and fill settings, and some settings in
the Page setup dialog box.

4. Choose the Type specs ... command from the Type menu or press Command-T.
This brings up the Type specifications dialog box, in which you can change
settings for font, s tyle, size, and leading options in one location, rather than
having to choose from several menu commands.
The first option in the Type specifications dialog is the Font pop-up menu. The
scrolling list of fonts available displayed by clicking the current typeface name
contains the same options accessed by choosing the Font command from the
Type menu. Clicking on the arrows to the right of the Size and Leading pop-up
menus offer the same choices available by choosing the Size and Leading commands. Alternatively, you can enter any value up to 650 for the Size option or
1300 for Leading. Values are accurate to ~ 0 point.
The Set width option allows you to condense or expand type. You can choose
one of the preset options in the pop-up menu or enter a value between 5% and
250% in Y!o percent increments in the option box. Any V<l:lue under 100% produces skinny type; any value over 100% creates wide type, relative to the normal
width of the typeface characters.
Use the Color option to change the color of your type. All currently defined spot
and process colors appear in the pop-up listing.
The Position pop-up menu allows you to create superscript or subscript text.
This option is especially useful for fractions. The Case pop-up menu allows you
to determine whether selected or default text is set as Normal (uppercase and
lowercase characters), All caps (uppercase letters only), or in Small caps (capitals the s ize of lowercase letters). The effects of these options are demonstrated
later in this chapter.
The Track function in PageMaker alters the amount of space set between letters
and between words. The amount of space varies depending on the current type
size. See Chapter 9, "Formatting Text," for complete details on using the Tracking
option.
The Type style options are identical to those displayed upon choosing the Type
style command from the Type menu. They are merely presented in a different
format for easier access.
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5. For this project, the options in the Type specifications dialog box, shown in
Figure 12-2, should be set as follows:
Font: Palatino

Position: Normal

Size: 36

Case: Normal

Leading: 37.5

Track: No track

Set width: Normal

Color: Black

Type style: select Bold and Italic options

When you have finished entering and selecting the specifications listed above,
press the Return key.
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Figure 12-2: This Type specifications dialog box shows your new default settings.

6. For the final default type specification, you will change the alignment of your text
from flush left to centered. To accomplish this, choose the Align center option from
the Alignment pop-up menu under the Type menu or press Shift-Command-C.
Now that you have altered the default settings for the font, style, size, leading,
and alignment of your text, you are ready to set other defaults. The following
settings can be changed without accessing dialog boxes.
7. The coupon at the bottom of your flyer will be surrounded by a fairly heavy
dashed line, or coupon border. Choose the Line command from the Element menu
to display the list of line weights, and choose the second coupon border (the
fifth option from the bottom). Next, choose Paper from the Fill pop-up menu. Any
shape created with PageMaker's line or shape tools will have a coupon border
outline and an opaque interior.
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8. Choose the Snap to rulers command from the Guides and Rulers submenu in the
Layout menu or press Command-[. This activates PageMaker's Snap to rulers
feature, which constrains the creation and manipulation of elements to a grid
determined by the current system of measurement. For example, since you'll be
working in picas at the Actual view size, each tick mark on the horizontal and
vertical ruler will indicate )1.1 pica, or 3 points. When Snap to rulers is turned on,
you will be able to create or move elements only in increments of 3 points. This
3-point grid will help you to maintain consistency in placement of text and
graphics throughout your document.
9. The last group of default settings you will change affects the number of master
and publication pages, as well as the margins you will use to create your flyer.
Fliers generally require only one master page and two publication pages. For this
flier, your margins should be slightly smaller than PageMaker's present settings.
To alter these settings, choose the Page setup ... command from the File menu.
The options in the resulting Page setup dialog box, shown in Figure 12-3, s hould
be set as follows :
Page size: Letter

Double-sided: not selected

Orientation: Ta ll

Facing pages: d immed

Start page #: 1

Margin in picas: Left: 3,

Top: 3, Right: 3, and Bottom: 3
#of pages: 2

When you have finished entering and selecting the specifications listed above,
press Return.
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Figure 12-3: The Page setup dialog box contains your new default settings.
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Creating a New Document
Now that you have changed default settings for commands from every menu except the
Pages and Windows menus, it is time to see how these altered defaults affect the
creation of a new document.
10. Choose the New ... command from the File menu or press Command-N. Notice
that the resulting Page setup dialog box contains all your new default settings.
Press Return to confirm these settings and create a new file.
A new publication window displays, showing the first page of your publication. Vertical
and horizontal rulers should also be d is played , both measuring picas. (If necessary,
press Command-R to dis play the rulers.) Notice that there is now only one master page
icon, labeled R for right. Any element or guide that you put on this master page will be
displayed on both pages of your flier.
11. Click on the master page icon in the bottom left corner of your screen display.
You will not create any elements on the master page because no text or graphic
items will appear on both sides of the flier. However, both sides will share the
same basic layout, so you will use the master page to establish a consistent
system of ruler guides.

Setting up ruler guides
Creating a two-fold flier is fairly tricky because you have to consider how each of three
panels (on each side of the paper) will appear when viewed alone as well as when the
flier is fully opened. Therefore, each panel must be indicated by fold lines on your
electronic pages. Two horizontal ruler guides will serve as these fold lines.
You must first determine the size of each panel. At first, this may seem easy. The page
will be folded two times, with both folds in the same direction, to create three panels.
Therefore, each pa nel should be one-third page in size. However, you will fold the two
outer panels over the middle panel, so you must accommodate the thickness of the
paper folding over on itself. The bottom panel must be the smallest. It will fold over the
middle panel, which should be slightly longer to accommodate the thickness of the
paper at the fold and to ensure that the edge of the bottom panel will not touch the
second fold line. The third panel must be even longer because it will be folding over the
thickness of two layers of paper. For a professional appearance, you want the edge of
the outer panel to be flush with the edge created by the first fold.
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To determine the exact size of each panel, you must first establish your overall page
size 8~ inches wide by 11 inches tall, or 51 picas by 66 picas. You will fold the flyer
lengthwise, so if each panel were exactly one-third page tall, it would measure 66 + 3 =
22 picas. The bottom panel should be the smallest, so you subtract one pica from it: 22
-1 =21 picas. You add this 1 pica to the larger top panel: 22 + 1 = 23 picas.
12. The zero point of your ruler is currently at the top left corner of the master page.
With this in mind, drag down two ruler guides from the horizontal ruler at the
top of your display to indicate the fold lines in your flyer. Since the top panel is to
be 23 picas tall, drag the first horizontal ruler guide to the 23-pica mark of the
vertical ruler Gust at the center of the 24-pica label). The middle panel is to be 22
picas tall, so drag a second horizontal ruler guide down to the 23 + 22 = 45-pica
mark of the vertical ruler (halfway between the 42- and 48-pica labels). This
leaves a bottom panel that is appropriately 66 - 45 =21 picas.
Throughout this project, you will create and use additional horizontal ruler guides. To
avoid as much confusion as possible, I will refer to the two current horizontal ruler
guides as the upper and lower fold lines.
Now you need a few more horizontal ruler guidelines to indicate the margins of each
panel. Since the flier as a whole has a 3-pica margin around all sides, each panel should
have 3-pica margins of its own. You may notice that each panel already has left and right
margins of 3 picas. However, the top panel is missing a bottom margin; the bottom panel
is missing a top margin; and the middle panel is missing both a top and bottom margin.
13. To establish the bottom margin of the top panel, drag a guide from the horizontal
ruler to a position 3 picas above the upper fold line: 23- 3 = the 20-pica mark on
the vertical ruler. Then drag another horizontal ruler guide to represent the top
margin of the middle panel. This must be located at: 23 + 3 = the 26-pica mark on
the vertical ruler. Next, represent the bottom margin of the middle panel by
dragging a horizontal ruler guide to 3 picas above the lower fold line, at 45- 3 =
the 42-pica mark on the vertical ruler. And finally, drag a guide to 45 + 3 = the 48pica mark to be the top margin of the bottom panel of the flier.
From now on, I will refer to the four newest horizontal ruler guides as the first, second,
third, and fourth fold margins, numbered from top to bottom of the page.
14. Having created all fold lines and fold margins required to guide you in the
creation of your flier, you are finished with the master page. Click on the page 1
icon at the bottom of your display to return to publication page 1, which should
appear as shown in Figure 12-4.
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Figure 12-4: Page 1 of t he flier, containing the fold lines and fold margins that you created as
horizontal ruler guides on the master page.

Saving the document to disk
In the first sample project, I waited until you had finished creating the entire document
before instructing you to save the file. In this way, I was able to isolate my description of
the Save command. However, you will not normally want to wait until a document is
completed before saving it to disk. Generally, it is advisable to save a document after
your first major step in its creation. Considering your establishment of ruler guides on
the master page as a major first step, you are now ready to save.
15. Choose the Save command from the File menu or press Command-S. When the
Save publication as dialog box appears, enter the name Two-sided flier, or some
other appropriate and sufficiently descriptive filename, into the option box
under the list of filenames in the current folder. Use the Desktop and Eject buttons
in combination with the folder bar to determine the destination to which your
file will be saved, and then press the Return key or click OK. PageMaker will take
a few moments to save your file to disk, after which the filename will appear at
the top of your screen display in place of the word Untitled in the current title bar.
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Now that your flier is saved to disk, I will periodically instruct you update the file by
choosing the Save command or pressing Command-S after each major step in creating
your document. The Save command wlll no longer produce the Save publication as
dialog box but will simply overwrite the existing file. If you want to produce the Save
publication as dialog box, perhaps to save the file to a different folder or disk, choose
the Save as .. . command from the File menu.

Placing the Body Copy
You are now ready to create the text and graphic elements of your flier. You begin by
placing the body copy. As I mentioned at the beginning of this project, a flier does not
generally contain a large amount of text, since it is intended to be read quickly. Therefore, you will use a short text file, called Product Description, from the PM Bible Chl2
Files f folder. You can drag this folder from Disk 1 onto your hard drive or use the files
directly off the floppy disk.
16. Choose the Place ... command or press Command-D. When the Place document
dialog box appears, double-click on the Product Description file from the PM Bible
Ch12 Files f folder. When the publication window reappears, click with your
manual text flow cursor in the upper left margin corner.

Adjusting column width of existing text
Since you did not set a new application default for the column width, and you did not
adjust the column width on the master page, your story pours the entire width determined by the margins specified in the Page setup dialog box. However, this is most
likely an unsuitable column width for flier text, since body copy this wide (45 picas) is
generally difficult to read. Reducing the width of an existing text block is a very simple
task. Surrounding your text block (assuming it is selected) are four square handles,
each located at an end of one of the two handlebars. These handles are useful for
adjusting the column width of the text block.
You will also be making use of the small dotted tracking lines that appear on the vertical
and horizontal rulers, monitoring the location of the cursor. As you move your cursor,
these tracking lines also move to document the current cursor position. Tracking lines
are very useful in positioning elements.
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17. If your text block is not selected, click on it with the arrow tool to display its
handlebars and four square handles. Click and hold on the lower left handle, and
notice how a rectangle appears surrounding the text, demonstrating its horizontal
and vertical dimensions. The tracking line on the horizontal ruler is at the 3-pica
mark. Drag the lower left handle to the right until the tracking line aligns with the
9-pica mark, then release. Next drag at the lower right handle of the text block
toward the left to the 42-point marker on the horizontal ruler. Once completed,
you will have decreased the column width of your text block by 6 picas (or one
inch) on each side, as demonstrated in Figure 12-5. Your new text block width is
33 picas, a more readable column width and thus more suitable to this project.
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Figure 12-5: The column width of the text block has been reduced by dragging text
block handles.

Changing type specs
The next step is to change or adjust the type specifications of your text. Notice that
your current text is not in 36/37.5 Palatino Bold-Italic, the setting you specified when
you altered the default type specifications. This is because this text was imported
into-rather than created directly in-PageMaker. Regardless of the default type specs,
a text file is generally imported from a word processor with its specifications intact. (An
exception is a text file with style sheets, as I demonstrate in the sample project in
Chapter 18.)
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18. Select the text tool. Click anywhere inside the imported text block and press
Command-A (Select all). Then press Command-T to access the Type specifications dialog box. Change the textface, size, and leading to Palatino 12/Auto, using
the procedure you used for changing the default settings. Make sure that Normal
is the only selected Type style option and press Return.
19. This block of text will probably look better if you fully justify it, so that the left
and right edges of each line of text are flush with the edges of the text block
itself. While the type is still selected, choose Justify from the Alignment pop-up
menu under the Type menu or press Shift-Command-J.
20. As usual, the final step in creating your text block is to adjust its position vertically by dragging at its upper and lower handlebars. Select the arrow tool and
drag the upper handlebar tab down to the 15-pica mark on the vertical ruler (as
indicated by the tracking line). Then drag the lower handlebar to the bottom fold
margin of the middle panel (the horizontal ruler guide 42 picas from the top of
the page).
21. Press Command-S to update your file on disk.

A headline with default type specs
The area from the top margin to the top of your body copy (15 picas) is allocated for a
headline and a simple graphic. You will create the headline first.
22. Select the text tool and Command-Option-Click at the top of the page to magnify
your page to the Actual view size. Then click with the text tool just below the top
margin to establish a text entry cursor, and type What's a chance meeting got en
to do with great furniture? There are two symbols in this sentence that you
may not recognize or know how to access. One is the paragraph sign (en). In these
sample projects, I use the paragraph sign to indicate a carriage return, marking
the location at which you should press the Return key to set your cursor on the
next line before typing the following words. You may not even recognize that the
second symbol is not an ordinary character. It is the apostrophe('), or right
single quotation mark. You may have instead pressed the straight single quotation mark('). In general, both the straight single quote 0 and the straight double
quote (')should be avoided; the left and right single(' and ')and double ("and")
quotes-which are more distinctive and attractive-are the correct symbols.
Each quote is accessed by pressing the following key combinations:
Left double quote

Option-[

Right double quote

Shift-Option-[

Left single quote

Option-]

Right single quote (apostrophe)

Shift-Option-]
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Once you have completed inputting your headline text, notice how it looks. It is centered, 36/37.5 Palatino Bold-Italic, just as you specified in your default type specs!
Because this is exactly what you want, no alterations are necessary. Here is an example
of how you can save time and energy by establishing defaults before creating a new file.
23. Select the text tool and click on the text block. Then adjust the vertical placement of the headline by dragging its upper handlebar flush with the top margin
of the page. Once your headline appears as shown in Figure 12-6, press Command-S to save the file.
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Figure 12-6: The 36/37.5 Palatine Bold-Italic flier headline.

Adding a Simple Graphic
The following steps outline the addition of a simple graphic between the headline text
and the body copy on the first page of your flier. The graphic you'll use is in the PM
Bible Chl2 Files f folder on Disk 1. PageMaker supports most popular graphic file
formats- including MacPaint, PICT, EPS (Encapsulated PostScript), or TIFF (tagged
image file format). A drawing application generally supports only a s ingle format. Here
are a few examples of popular graphics applications, along with the formats supported
by each for saving files that you intend to import into PageMaker:

•
•
•
•
•

•

MacPaint

Save normally, paint format

SuperPaint

Save as MacPaint or PICT file

MacDraw

Save as PICT file

Aldus FreeHand

Export as EPS file

Adobe Illustrator

Save with a Macintosh preview, EPS format

Adobe Photoshop

Save as TIFF, PICT, or EPS file
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Be sure to save your graphic files in one of these formats before trying to import the file
into PageMaker.
24. Choose the Place ... command from the File menu or press Command-D. This
brings up the same Place document dialog box, shown in Figure 12-7, that you
have used to import files. Select the "Top/Chair.EPS" file from the file listing. You
will notice that as soon as you click on an available graphic filename, some of the
Place options change. Since no graphic is currently selected in your PageMaker
file, the only option that is not dimmed is the As independent graphic option.
This indicates that your graphic will be placed into your flier normally, rather
than as a replacement for an existing graphic. If you had selected a graphic
before choosing the Place ... command, a second option, reading Replacing entire
graphic, would also become available for selection. This option would allow you
to replace the selected graphic with a placed graphic, including resizing and crop
marks (both of which will be described shortly). After selecting a graphic
filename to be placed, press Return.
25. Your cursor will change to a small PS icon because you are using an EPS format
graphic. When you place other file formats, you get other icon types: MacPaint
files display a paintbrush, PlCT files display a pencil, and the TIFF files display a
small gray square. Position the PS cursor in the upper left portion of your
window and click to place the graphic.
Ploce document
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Figure 12-7: The Place document dialog box displays the options avai lable when importing
a graphic.

Your graphic will now appear on page 1, surrounded by handles to demonstrate that it
is selected. This graphic includes two elements, a top icon and a chair icon, as shown in
Figure 12-8. In this case, you want to use only the top, so you'll have to crop out the
chair. This is very common when importing clip-art files, for example. One page of clipart often contains several drawings, which saves space and decreases the number of
files on disk.
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Figure 12-8: An imported graphic file with two graphic elements.

PageMaker provides a built-in cropping feature for removing extraneous images from an
imported graphic file. To crop a graphic is to cut away some portion of the graphic so it
is no longer visible in your document. The cropped portion still exists, and you may reexpose it later if you want to, but it is hidden from view.
26. Select the crop tool Oower right corner of toolbox) and click on your graphic to
select it. Eight handles are displayed-one in each corner and one on each side.
Click on the right-most handle and drag left until only the top icon graphic is
visible. (Be sure to click on a handle! If you click inside the graphic with the crop
tool, you will get a grabber hand icon, as discussed in the next few paragraphs.)
Notice that the crop tool works by cutting off horizontal or vertical strips of the
image only, as shown in Figure 12-9. Therefore, you cannot effectively use the
cropping tool to modify images that jut slightly into each other's perpendicular
boundaries. Such fine-tuning operations must be performed in a graphics application prior to importation of the graphic.

Figure 12-9: Cropping off a portion of a placed graphic.

27. After cropping out any extraneous portions of your graphic, select the arrow tool
and drag the graphic to center it between the headline and body copy.
28. Once you have established the size of your graphic by cropping and have
positioned it correctly, you may find that you have over cropped or under
cropped and need to make adjustments. Select the crop tool again and click on
the graphic to select it. This time, instead of clicking on a handle, click inside the
graphic and hold. Your cursor will change to a grabber hand icon, as shown in
Figure 12-10. Now drag with the grabber hand. This moves your graphic independently of the cropping boundaries. This is especially useful if you have cropped
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the graphic to an exact s ize but aren't quite sure what details of the graphic you
would like to see. Dragging with the grabber hand doesn't affect the s ize of the
graphic, as does dragging at the handles; it affects only what portion of the
graphic is visible.

Figure 12-10: Positioning the graphic inside the cropping boundaries.

29. After you have cropped your graphic and until you are s atis fied with its appearance, select the arrow tool and click on the graphic to select it. Then press
Command-C to execute the Copy command. You will be using this copy of your
image in a logo at the bottom of the page.
30. Press Command-S to update your file on dis k.

Creating a Clip-Out Coupon
In the next few steps, you will create a clip-out coupon on the bottom panel of the flier.
Inside this coupon, you will input some text directly into PageMaker, including a logo.
This logo will also consist of a graphic element in the form of a reduced vers ion of the
image you will have just copied.

Drawing the coupon border and dragging
guides
31. Scroll down to the bottom panel of page 1. Select the rectangle tool and drag
from the top left margin corner of the bottom panel to the bottom right margin
corner. The resulting box should look like the one shown in Figure 12-1 1. Notice
that the outline of this box is a medium-weight coupon border, the one you
selected when setting defaults. The interior is white, also matching your new fill
default, Paper.
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Figure 12-11 : The coupon box created with the rectangle tool.

Right now, your page has only one column, and the left and right column guides are
flush with the left and right sides of your coupon border, respectively. This means that
any text you create inside the coupon will be as wide as the coupon itself, which would
make the edges of the text unreadable. Text inside a coupon border must have s urrounding margins, just as text on a page must have margins. In order to establish these
margins, you will move your column guides.
32. Column guides, like ruler guides, are not stationary. They can be moved by
dragging them with the arrow tool. Select the arrow tool and drag the left column
guide rightward to the 6-pica mark on the horizontal ruler. (If you cannot drag
the column guide but instead find yourself dragging the coupon border, check
that the Guides option is set to Front in the Preferences dialog box. Also make
sure that the Lock guides command in the Options menu is deselected; that is, it
does not have a check in front of it.) Next drag the right column guide leftward to
the 45-pica mark on the horizonta l ruler.

Entering the coupon text
33. Select the text tool and click inside the coupon, anywhere between the column
guides. Then type All VIA Tables, 20% off '!I This month only (Remember that
the symbol~ means that you should press the carriage return key.)
Your text appears in the default type specs of centered 36/37.5 Palatino Bold-Italic.
These type specs fit the requirements of the coupon to an extent, but some of the text
will need to be changed. For example, the second line of text should be smalle r to
downplay its significance.
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34. Triple-dick on the second line of text with the text tool. This selects the entire
paragraph, from carriage return to carriage return. Then press Command-T to
display the Type specifications dialog box. Change the type size to 18 point,
change the leading to Auto, and change the type style to Normal. Then press
Return.
35. With the second line of text still selected, press Command-M to access the
Paragraph specifications dialog box. Press the Tab key repeatedly until the After
option is selected and change the value to 3 picas. Then press Return.
36. Select the text tool and drag at the text block to position it vertically, as shown in
Figure 12-12. Then press Command-S to update your file on disk.
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Figure 12-12: The text for your coupon positioned accurately.

Enhancing the coupon with
graphic elements
In the next steps, you will add a graphic to the coupon. But first, you must make room
for it. The graphic belongs between the words VIA and tables in the first line of text. To
make room, you must insert spaces between these two words. Not ordinary spaces, but
fixed spaces. When you press the spacebar, you create a variable space-a space that
may be changed by PageMaker to accommodate the alignment of the text block. This
occurs most commonly when you justify text, since PageMaker must stretch or shrink
the amount of space between each word in a line of type to fill the column width. Fixed
spaces are always the same width, regardless of whether the text block is justified,
centered, or aligned left or right. These are the three kinds of fixed spaces, followed by
the key commands used to access them:
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•
•
•

Em space, a space as wide
as the point size of the text

Shift-Command-M

En space, a space half
as wide as the point size

Shift-Command-N

Thin space, one-quarter
the width of the point size

Shift-Command-T
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A 12-point em space is 12 points wide, a 12-point en space is 6 points wide, and a 12·
point thin space is 3 points wide.
37. Click with the text tool between the words VIA and tables. Then press ShiftCommand-M twice and Shift-Command-Nonce to create two em spaces and one
en space. This amount of space will allow sufficient room for the logo graphic.
38. Choose the Place ... command, select the file Table. TIF, click the As independent
graphic option, and click OK. Now place the graphic and use the arrow tool to
drag it into position. Figure 12-13 shows the coupon with the graphic in place.
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Figure 12-13: The coupon complete with the inline graphic.

The next two graphic elements you will add are two small pairs of scissors, which will
indicate that the coupon is to be clipped from the flier and brought into a local VIA
retailer for friendly and courteous redemption. These scissors are accessed as characters of the typeface Zapf Dingbats, a standard PostScript font that contains graphic
elements and symbols and is built into nearly all PostScript printers.
39. Select the text tool. Without clicking on screen, press Command-T to access the
Type specifications dialog box. Change the type specs to 24/Auto Zapf Dingbats
and select the Normal style option. Then press Return. Since no text is selected,
you cannot immediately see the effect of your change. This is also an indication
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that you have altered the default settings for this file. No longer will text default
to 36/37.5 Palatino Bold-Italic; now you will create text in 24/Auto Zapf Dingbats.
This change does not affect any other files. Existing files will still use the same
defaults they used when they were saved, and new files will still default to 36/37.5
Palatino Bold-Italic.
40. With the text tool, draw a little box just above the coupon border from the left
margin to the left column guide, a distance of 3 picas. Qt does not matter how tall
you draw the box.) Then press Shift-4. Although this key combination produces a
dollar sign in most typefaces, in Zapf Dingbats it produces a pair of scissors .
Then press Shift-Command-L, the keyboard equivalent for flush-left text alignment.
41. Select the text tool and position the text block vertically so that its lower handlebar rides just below the top coupon border. Then press Command-C to copy the
symbol.
42. For the sake of symmetry, you might want to create a second pair of scissors,
horizontally aligned with the first, but positioned on the right side of the page.
Press Command-Option-V to paste a copy of the scissors to your page exactly
over the existing ones. Select the arrow tool from the toolbox, select the top pair
of scissors, hold down the shift key, and drag the text block toward the right so it
is positioned between the right column guide and right margin, and its handles
snap to the guides, as shown in Figure 12-14.
43. Press Command-S to update your file on disk. Then press Command-W to
demagnify your display to the Fit in window view size. You have successfully
completed the inner side of this two-sided flier, as shown in Figure 12-15.
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Figure 12-14: The scissors character from the Zapf Dingbats typeface is used to visually indicate
the pureose of the coupon border.
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Figure 12-15: The entire first side of y our flyer, viewed at Fit in Window size.

Building the Hier's Outer Side _ __
You are now ready to create the second side of your two-sided flier. The three panels
on this side will include a mailer and two blocks of text imported from a graphics
program. In building this next page, I will introduce you to rectangles with rounded
corners; layering elements in front and in back of other elements; and reversing,
rotating, and condensing text.
44. Click on the page 2 icon at the bottom of your display to go to page 2. Then
Command-Option-Click on the middle of the page to magnify your view to Actual
size. If necessary, scroll rightward so that the right margin of the page is visible.
45. Your next step is to create a block of text to exact specifications by paying close
attention to the vertical and horizontal ruler while dragging with the text tool.
Select the text tool and click and hold down your mouse button at the location
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where the horizontal ruler tracking line aligns with the 43-pica mark and the
vertical ruler tracking line meets the 26-pica mark (flush with the top margin of
the middle panel). Without releasing, drag downward about 5 picas (to the 48pica mark) and to the right until the text tool snaps to the right margin. Then,
before typing, change the type specs to 9/10 Helvetica using the Type specifications dialog box as described throughout this chapter. This changes the type
specs for this text block only, without altering your default settings.
46. Type the words Post offlce will not deliver without sufficient postage. Press
Command-A to select the entire block of text and press Shift-Command-K to
change the type to uppercase letters. The type should already be centered. (If
you have changed the Alignment option, press Shift-Command-C.)
47. To correctly position the text block vertically, click on it with the arrow tool and
Shift-drag it downward one-half pica, to the location shown in Figure 12-16. (Use
the vertical ruler to measure.)

POST OFFICE
WILLNOT
DELIVER
WITHOUT
SUFFICIENT
POSTAGE.

Figure 12-16: The new little text block, selected to display column width and vertical
positioning.

48. Select the rectangle tool, which is the second tool on the bottom row of your
toolbox. You will use this tool to create a small box around your small text block,
indicating the dimensions of a typical postage stamp. Position the rectangle tool
cursor at the intersection of the top margin of the middle panel and the right
margin of the page. Then Shift-drag downward and leftward 5 picas to the 43-pica
mark on the horizontal ruler and the 31-pica mark on the vertical ruler.
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49. Notice that your small square with rounded corners has a fat coupon border and
a white interior (as specified by your defaults), thereby covering up your text.
Perhaps this postage marker will attract more attention if it appears as a black
box with the text in white. Therefore, while the shape is still selected, choose the
Solid option from the Fill pop-up listing in the Element menu and select None
from the Line pop-up listing.
50. The rectangle shape could have a little more flair, which you can add by rounding
its corners by choosing the Rounded comers ... command in the Element menu
to bring up the Rounded corners dialog box. This dialog box allows you to select
from six corner options, ranging from perpendicular to very rounded. The fourth
option is currently selected. Select the second option of the top row, as shown in
Figure 12-17, and press Return. The rounded corners of the black shape are now
greatly reduced. In fact, on screen they appear to be almost perpendicular.
Rounded corners

1

OK

n

( Cancel ]

Figure 12-17: The Rounded corners dialog box, with second corner option selected.

In Step 46, you created some text. Unfortunately, you cannot see it now because the
black square is in front of the text. Like most desktop publishing applications,
PageMaker relies on a layering convention. Any on-screen element is considered to be
in front of some elements and in back of others. Thus, when you create a document,
you are really creating an electronic collage of lines, shapes, text blocks, and imported
graphics. Every time you create a new element, you place it at the front of this electronic collage. Newest elements are always created in front of their predecessors, so the
black square is currently in front of the text.
You can change the layering relationship between elements, using the Bring to front
and Send to back commands in the Element menu. These commands allow you to bring
a selected element in front of all other elements on the page or send an element behind
all other elements on the page. The next step demonstrates how to use one of these
commands.
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51. Your black square should still be selected. Choose the Send to back command
from the Edit menu or press Command-B to send the square to the back of the
page, behind the text block.
52. Your text is now in front of the black shape, but it remains invisible because the
type is black, the same color as the shape behind it. To be sure that the text
block is in front, select the text tool and click in the middle of the black square. A
text entry cursor will blink at your exact click point, indicating that there is
indeed text there. To make this text visible, press Command-A to select the
entire text block. Then choose the Reverse option from the Type style pop-up
menu under the Type menu. This makes the text white. Click on the arrow tool to
deselect the text, and you will see that it is now reversed against a black background, as shown in Figure 12-18. Press Command-S to update your file on disk.
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Figure 12-18: The reversed postage text against a black square background.

53. No mailer would be complete without a return address. If necessary, scroll
leftward until the left margin is clearly visible. Before typing any text, change the
default type specs to 12/Auto Palatino Bold-Italic, using the Type specifications
dialog box. Then select the text tool and position your cursor at the intersection
of the top margin of the middle panel and the left page margin. Click at this point
and drag rightward 15 picas to the IS-pica mark on the horizontal ruler. Also
drag downward enough to accommodate a few lines of text. Press Shift-Command-L to make the type in this text block align on the left. Type VIA /nternationa/11 1205 University Ave. ~Northwestern, AU 34210.
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54. VIA's company name looks nice in Palatino Bold-Italic type, but it is indistinguishable from the address. So triple-click on the second line of the text block to select
the entire first address line. Then Shift-Click on the third line, selecting it entirely
as well. To make this text plain, press Command-Option-spacebar. Or you could
have chosen the Normal option from the Type style pop-up under the Type
menu. The text is now set in Palatino Roman (plain style, without bold or italic),
as shown in Figure 12-19. Press Command-S to update your file on disk.

I
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~205 University Ave.

Northwestern, AU 34210
i
Figure 12-19: The return address, with selected type in Palatino Roman (plain).

Condensing and rotating text
The only portions of the flier that remain incomplete are the top and bottom panels,
which present a special challenge. Due to the way in which the folds of the flier overlap
each other, the text on both the top panel and the bottom panel must be upside down.
This ensures that the customer, when unfolding the flier, can continue to read each
newly presented panel without having to turn the flier upside down at any point. (fo
fully understand this concept, try folding your flier after you have printed it.)
55. Scroll to the top panel of the current page. Using the Type specifications dialog
box, change the default type specs to 48/50 Palatino Bold-Italic, a larger type size
than you have employed so far. Next select the text tool and click somewhere
near the top of the page. Type the phrase, Special Pricing WOn The Finest
Italian Furniture.
56. You want to grab your reader's attention the moment he or she picks up your
flier. One way to do this is to alter the type slightly. In this case, you will condense the type, making it thinner than normal. While your text entry cursor
remains in the text block, press Command-A to highlight both lines of type. Then
choose the Set width command from the Type menu to access a pop-up list of
possible compression or expansion percentages. Choose the 70% option. Your
text now appears approximately the same width as 36-point text, as shown in
Figure 12-20.
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Figure 12-20: Compressing the select type to 70% normal width.

57. Now to rotate your text. To do this, you'll need to bring up the control palette,
which is done by selecting Control palette from the Windows menu or pressing
Command-'. You may not have worked with the control palette yet, but it is fully
introduced in Chapter 13, "The Control Palette." Here, you will just skim the
surface of this powerful tool (see Figure 12-21).

Figure 12-21: The Control Palette allows you to rotate and flip objects.

58. Get the arrow tool, and select the text block. In the control palette, you first need
to click in the middle of the proxy, which is the box that is the second element
from the left edge of the control palette. It looks like a small square with handles
in each corner, on each edge, and in its center. Clicking in the middle should put
a selection dot on the center handle. (If you accidentally click twice, the dot
turns into an arrow. If this happens, click again to turn it back into a dot.)
Selecting the dot in the middle of the proxy tells PageMaker that you want to rotate the
selected text block from its center so it stays in the same place on the page. If one of the
corners or edges of the proxy was selected, the text block would move out of position
when you rotate it.
59. Since you want to flip the text block over, you can use the two reflecting options,
which are the small buttons on the very right edge of the control palette. Both
show small "F'' characters on them depicting the reflection they control. The top
one is the Horizontal reflecting button, and the bottom one is the Vertical
reflecting button. Click each of these buttons once. Figure 12-22 shows the
rotated block.
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I
Figure 12-22: Once rotated, you can still edit your text in PageMaker 5.

60. Next, to add text to the bottom panel, scroll down to the bottom of the page.
Select the text tool from the toolbox, click inside the bottom panel, and type at
prices like this, it just won't last Press Command-A to highlight all text and
again choose the 70% option from the Set width pop-up menu under the Type
menu. Select the text block with the arrow tool and again flip the text upside
down using the Text rotation ... command.
61. Again you'll use the reflecting buttons on the control palette to flip your text
block over. Select the arrow tool, select the text block, and then select the
control palette. Make sure the center handle in the proxy is selected. Then click
the Horizontal reflection and then the Vertical reflection buttons.
62. Press Command-W to demagnify your page to the Fit in window view size. Finally,
press Command-S to update your file on disk. Figure 12-23 shows the completed
second side.

Printing the Two-Sided Flier
63. Your flier is now complete. The only step remaining is to print the finished
document. Make sure that your printer is on and chosen, using the Macintosh
Chooser desk accessory. Then press Command-P to access the Print to dialog
box. Indicate one copy, and print from page 1 to 2 as described at the end of the
first sample project (see Chapter 8, "Sample Project One''). When the two pages
of your flier are finished printing, put them back-to-back to simulate the document after it is photocopied or offset printed. Then try folding it. This will give
you a sense of how two-fold Cliers work.
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Figure 12-23: The entire second side of your flier, viewed at Fit in Window size.

Examine your pages and make sure they meet your expectations. If you see any problems, make the necessary changes to your file. Successfully completing this chapter
demonstrates an understanding of some intermediate functions and operations offered
by PageMaker. This will help you to understand future discussions in this book, confirm
previous topics, and provide you with a more-developed working knowledge of the
PageMaker environment.

c

The Control
Palette
••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
•

Character formatting with the control palette

•

Paragraph formatting with the control palette

•

Manipulating objects with the control palette

••••••••••••••••••••••••••••••••••••••••••••••••
Business guru Tom Peters says that it is OK to s teal ideas from your competitors. He
calls it "creative swiping" and suggests that strong and well-managed companies should
see what their competitors are doing successfully, copy it, and improve it. Tom Peters
would love PageMaker's control palette. An unmitigated rip-off of Quark's measurements
palette, the control palette in PageMaker 5 is superior in nearly every way, providing an
elegance and power that is worthy of the original PageMaker user interface.
It's been a long time since Aldus added anything to PageMaker that was worthy of the
original user interface, and I've said so more than once over the years, so allow me to
heap praise now that it's due. The best software tools are those you hardly notice; the
ones that help you get your work done without being intrusive or requiring you to shift
your focus from the job you're trying to do onto the tools you're trying to use. The
control palette achieves this goal perfectly. Why did the control palette turn out so
well? Mostly because a real PageMaker user- the original PageMaker thunder-lizard
himself, Olav Martin Kvern- was largely responsible for the design.
Beyond its theoretical perfection, why should you care about the control palette?
Several reasons. First, it lets you apply character and paragraph formatting without
pulling down a menu or encountering a dialog box. The same is true for moving,
resizing, and rotating both text and graphic objects. This is fast and efficient. In fact, you
can even perform all of these tasks without reaching for your mouse. Second, the
control palette gives you quick feedback as to the current status of elements in your
publication. With a single glance you can find out the font, type size, and leading of your
text or if a graphic has been reduced, enlarged, or rotated. This helps you ensure
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consistency and find small errors that usually aren't caught until too late (after the job
comes back from the printer.) Finally, the control palette adds numerical precision to
many tasks that used to require a good eye and a steady hand. You can specify that you
want the edge of a text block to start 3p7 to the right of your paper's edge, or that an
EPS graphic should be enlarged by 25 percent, rather than calculating, or approximating, these changes.

When to Use the Control Palette
Remember in school when the teacher would force you to learn and practice some
ridiculously complex mathematical formula, only to later explain that there was a vastly
s uperior shortcut? You had to experience the pain of the long method so you would
better understand and appreciate the shortcut, or so you were told. I never particularly
believed or appreciated that logic, and yet I'm guilty of this very same "teachjng
method" myself. Well, sort of.
You see, nearly every command in the control palette duplicates a menu command,
dialog box option, or mouse trick that you've learned in one of the earlier chapters. I
introduced those first, and without clearly mentioning the control palette alternative,
primarily because in PageMaker you won't completely give up any one method of
choosing a command for any other. In some ins tances the control palette will be the
most efficient, at other times a keyboard shortcut will be best, and once in a while a
good old-fashioned menu command and dialog option will be required. So I just want to
make sure you're well rounded and ready for any occasion. Also, as a matter of practicality, segregating all of the control palette discussion into this chapter will best serve
anyone who worked with earlier versions of PageMaker and needs to add a complete
understanding of the control palette to their otherwise vast PageMaker awareness. In
any case, I apologize if this is making you have third-grade flashbacks.

Control Palette Basics ------------------------To begin working with the control palette, choose the Control palette command in the
Windows menu (Command-'). This is the single quote key. The control palette appears
near the bottom of your screen as a small floating window. The specific commands in
the control palette depend upon which tool is currently selected, and which element on
your page is currently selected.
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The control palette can display four distinct command sets:
•

Deselect mode. When any tool other than the text tool is selected, but no
elements are selected, the control palette simply displays the current location of
the cursor, as shown in Figure 13-1.

Figure 13-1: The control palette as it appears when nothing is selected.

•

Object mode. When any tool other than the text tool is selected, and any text or
graphic object is selected, the control palette displays the position (X and Y),
sizing (H and W), scaling (%), cropping, rotation, skewing, and reflecting options,
as shown in Figure 13-2.

Figure 13-2: The control palette as it appears in the object mode.

•

Character mode. When the text tool is selected, and the character view button is
selected, the control palette displays the font, style, type size, leading, tracking,
set-width, kerning, and baseline shift options, as shown in Figure 13-3.

Figure 13-3: The control palette as it appears in the character mode.

•

Paragraph mode. When the text tool is selected, and the paragraph view button
is selected, the control palette displays the style sheet, alignment, cursor position, indents, space before/space after, grid size, and align to grid options, as
shown in Figure 13-4.

Figure 13-4: The control palette as it appears in the paragraph mode.

To hide the control palette, choose the Control palette command from the Windows
menu again, press Command-', or click the close box in the palette's left edge title bar. If
you want to move the control palette to another location on your monitor, drag it by
the left edge title bar, as shown in Figure 13-5.
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Figure 13-5:
Move the
control
palette by
dragging on
the title bar
along its left
edge.

Before looking in detail at each of the control palette modes and the commands and
options they provide, there are a few basic control palette characteristics you should
understand. These include control palette elements such as the Apply button, the
proxy, and the nudge buttons, and ways of interacting with the control palette using
your mouse and keyboard.

Activating the control palette
Like PageMaker's other floating palettes - the styles palette and the colors palette - you
can always look at the control palette to read information about the currently selected
element, but if you want to use the control palette to make any formatting changes, you
have to first activate, or select, it. When the control palette, or panel, is activated, the
bar on its left edge is highlighted, as shown in the top portion of Figure 13-6.
Figure 13-6:
The control
panel as it
appears when
activated (top)
and when not
deactivated
(bottom).

There are several ways to activate or deactivate the control panel:
•

Press Command-- (grave, on same key as tilde).

•

Click in the control panel to activate it, click in the layout window to deactivate it.

•

When any element except text is selected and you press a key, the control panel
becomes activated.

If you try to change control palette options without first activating the control palette,

any keys you press on your keyboard will be applied to the selected text or graphic
element. If you always use the mouse to select the control palette option you want to
modify, this won't be a problem, but if you tend to do as much as you can from the
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keyboard, you'll have to get used to pressing Command-' to activate the control palette
before modifying commands, and then pressing Command-' again to deactivate it when
you're finished . An alternative is to press the Return key or click the Apply button with
the mouse after making a change in the control palette; this will save your changes and
deselect the control palette automatically.
If you want to apply changes made in the control palette but not deactivate the

control palette, hold down the Shift key while pressing the Return key or
clicking the Apply button.

The Apply button
On the left end of the control palette is a large button that displays an icon representing
the currently selected tool, object, or element. This is the Apply button, which works as
an Enter key for the control palette. When the Apply button is pressed, any changes
that have been made to options in the control palette are applied to the current selection.
You can invoke the Apply button by clicking it with the mouse or by pressing the Enter
or Return keys on your keyboard. The Apply button is also invoked if you press Tab or
Shift-Tab, which move forward or backward through options in the control palette.
The icon on the Apply button always reflects the current selection. There are more than
20 different icons possible, as shown in Figure 13-7.

Figure 13-7:
The various icons that
appear on the control
palette Apply button

The proxy and reference points
Next to the Apply button, except whe n the text tool is selected, is a rectangle called the
proxy. The proxy, shown in Figure 13-8, has nine marked reference points: one in each
corner, one on each edge, and one in its center. Exactly one reference point is always
selected. You can change the selected reference point by clicking on any reference
point in the proxy or by clicking on the corresponding handle in the selection rectangle
around the object in the layout view.
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The selected reference point is important because it specifies the spot from which any
measurements or modifications are made. When you first encounter the control palette,
you might not see why reference points are needed, but you have to remember that
you're dealing with a computer here, and computers aren't very smart. An example will
illustrate: Suppose you are working on two different layouts, one in which you want to
center the dominant graphic in the middle of the page and another in which you want to
center the graphic one inch below the top of the page. If you gave those simple instructions to any self-respecting paste-up artist, they would know that you want the middle of
the graphic centered on the page in the first case, and that you want the top of the graphic set
one inch below the top of the page in the second. The computer, on the other hand, can't
make those assumptions, and so you must specify that it is the middle of the first
graphic that should be centered and the top of the second. Otherwise you might get the
upper left edge centered on your first page, and the bottom right edge of the graphic
centered one inch below the top of the page in the second. Reference points, as shown
in Figure 13-9, let you specify which part of an object you want to measure from.
Figure 13-9:
Objects
centered
w ithout
regard for
reference
points (left)
and with the
correct
reference
points
selected
(right).
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Although computers aren't very good at making assumptions, they are very good at
executing precise, and even complex, instructions. So PageMaker provides not one but
two different kinds of reference points, stationary reference points and movable reference
points. A stationary reference point is created by clicking a reference point once, so it
becomes a solid square. A movable reference point is created by clicking the reference
point a second time, so it becomes an arrow. (See Figure 13-10.)
Figure 13-10:
An example of movable (left) and stationary or
nonmovable (right) reference points as they
appear in the control palette proxy.

IQi]g

Stationary reference points are anchored- the corresponding point on the selected
object will remain where it is if you resize, rotate, skew, or crop the object. Moving an
object is an exception: If you move an object using the control palette while a stationary
reference point is set, the stationary reference point will move to the specified coordinates.
When a movable reference ppint is set, on the other hand, the corresponding point on
the selected object moves as if you dragged it with the mouse when moving, resizing,
rotating, skewing, or cropping. This causes very different results than if a stationary
reference point had been used, as shown in Figure 13-11.
Figure 13-11:
The movable (left) and stationary
(right) reference points have very
different effects when used to move,
resize, rotate, and skew graphics
with the control palette.

Navigating the control palette
Your experience in navigating Macintosh dialog boxes will serve you well in the
PageMaker control palette. To select any option or to move from one option to another,
you can either use the mouse to click directly in the option you want to modify, or you
can move through options from the keyboard by pressing Tab to move forward and
Shift-Tab to move backward. When an option is selected, a black bar appears above or
below that option, as shown in Figure 13-12.
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Figure 13-12:
A black bar appears above options in
the control palette when they
are selected.

When you want to select an existing value to replace it, you'll have to click right on the
current option or drag over the current option. If you want to modify the existing
option, you'll just want to set the insertion point in the appropriate location. Some
control palette options let you select the option value and the option unit of measure
separately, so be careful when setting the insertion point. If you make an incorrect
selection within an option, use the arrow keys to correct the cursor position.
Figure 13-13:
In some control palette options, you can
select the option itself, the unit of
measure, or both.

Changing values
Once you've selected the option you want to modify, there are several ways to change
option values:
•

Type replacement values. If you fully select an existing option, you can type in
new values. When the option is numeric, PageMaker assumes you are using the
default measurement system unless you append the abbreviations for some
other measurement system (i for inches, p for picas, c for ciceros) to your entry.
If the selected option includes a pop-up list, PageMaker will try to guess what
option you are selecting as you enter characters. For example, when you type
"Bo" into the Paragraph Styles option PageMaker will fill in the option "Body
Copy" if that is the first existing style sheet that starts with the letters "Bo."

•

Arithmetically modify the existing values. For numeric options, you can create
an arithmetic expression using the characters + (plus),- (minus), * (times), and I
(divided by). For example, if the current value of an option is 3, and you want it
to be 4, you can set the text insertion point after the 3 and type +1. Or if you want
a graphic to be half its width, select the W option and enter /2. When you click
the Apply button or press Enter or Return, PageMaker calculates the correct
result. (Ain't computers smart!) Figure 13-14 shows how the formulas appear.
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Figure 13-14: You can modify values in the control palette with arithmetic formulas.
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This is particularly useful when you want to move or resize an object by some
fixed but irregular amount Qike an eighth of an inch, which is .125) and the
current value is also not a round number. Rather than calculating that 2. 79 + .125
= 2.915, you can just enter + .125, and PageMaker does it for you.
While you cannot do math across different units of measure (1" + p6), you can
temporarily change the units of measure for a single option by pressing
Command-Option-M.
•

Use the nudge arrows. In both object mode and character mode, many control
palette options have nudge arrows before them. The default change caused by a
single click of a nudge arrow is ){ooth of an inch, but you can set your own default
nudge amount for both the horizontal and vertical directions in the Preferences
dialog box. lf you hold down the Command key while clicking the nudge button, a
move called the "power nudge," values change by Yto of an inch (see Rgure 13-15).

Figure 13-15: The nudge arrows change values by Ylooth of an inch (or Yloth of a percent).
Holding down the Command key lets you "power nudge" changing values by V1oth of an inch
(or 1 percent).

•

Use the pop-up list. Some options in the character and paragraph modes provide
pop-up menus of available options, as shown in Figure 13-16. To use these, click
on the arrow that appears to the right of the current option setting and select
from the list.
The number of options that the pop-up scrolling list can display is limited if the
control palette is too close to the bottom of your screen. Drag the control palette
by the bar at its far left to a position higher on your display, and these pop-up
menus will be easier to use.

•

Resetting values. If you incorrectly change the values in any control palette
option or accidentally modify an option you didn't mean to change, you can reset
any control palette option to its original value by pressing Escape or the Clear
key from the keypad before you click the Apply button or press the Tab key.
Once you press the Apply button or the Tab key, you can use the Undo command in the Edit menu.
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Figure 13-16: A pop-up scrolling list in the control palette.

Accuracy and positioning
Values displayed in the control palette are accurate to J.2o of a point, or l1« of an inch
(.018 mm). This is far more accurate than the rulers, which are only accurate to Y-1 of a
point when using the 400% view size, and even less accurate at lower levels of magnification. Control palette options expressed in percentages are accurate to .!1o of a percent.
The Snap to guides and Snap to rulers options from the Guides submenu apply to
control palette changes only if you check the Use snap to constraints option in the
Preferences dialog box. Otherwise, changes made via the control palette will be executed literally, regardless of existing guide lines and ruler ticks.
If you do select the Use snap to constraints option, and the Snap to guides or Snap to

rulers options are selected in the Guides submenu, then any change to the size or
placement of an object will snap to guides within 3 pixels or the nearest ruler tick mark.
Note that the number of ruler tick marks and their accuracy is affected by the current
view size. Larger magnifications have a larger quantity of more accurate tick marks, so
zoom in as much as possible when accuracy is important.
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When Snap to guides is selected, and the Use snap to constraints preference is set, you
will sometimes find that when you enter a specific value into a control palette option,
the value will change when the Apply button is clicked. This is a result of selecting a
value that does not exactly correspond with a nearby guide or tick mark and the object
"snapping" to that guide or tick mark.

Character Mode ----------------------------------Character mode is used to check the current character-level formatting of selected text
and to modify the character formatting of selected text. The control palette automatically switches into character mode, as shown in Figure 13-17, as soon as you select the
text tool from the tool palette.
Figure 13-17:
The control
palette in
character
mode.

If the text tool is selected, and the control palette is in paragraph mode, you can switch
into character mode by clicking the character-view button that appears just to the left of
the Apply button, just above the paragraph-view button. The keyboard equivalent for
switching between character and paragraph modes is Command-Shift-' .

The options available in the character mode are:
•

Font. The Font option, shown in Figure 13-18, displays the name of the font used to
format the selected text, if all selected text is in the same font. If two or more fonts
are used in the selected text, this option appears empty.
Choose a new font for the selected text by either clicking the down arrow and
choosing a font from the scrolling pop-up menu, or by clicking in the option box
and typing the name of the font you want to select. As soon as you type one or
more characters, PageMaker tries to guess the font you want to select and automatically fills in the font name for you. If the correct name appears, press Enter or
Tab to apply that font. If an incorrect name appears, keep typing additional characters until the correct font appears.
If some of the fonts used in the current publication are not available, these are
displayed at the top of the pop-up scrolling font list. If substitute fonts have been

assigned using the PANOS£ font-matching system, the names of substituted fonts
appear in brackets following the names of the missing fonts.
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Figure 13-18: The font option in the control palette.

•

Style options. The type style options appear as a series of small buttons, labeled
with the first letter of 12 different type style options (see Figure 13-19). These are
(with brackets around the letters used to represent them on the option buttons)
[N]ormal, [B]old, [I]talic, [U]nderline, [O]utline, [S]hadow, [R]everse,
[S]trlkethru, [c] small caps, [C] all caps, [s]uperscript, and [s]ubscrlpt.

mal II!J l®llllijlel cl Cl11 Jl
Figure 13-19: The style options in the control palette. Note that some are on (Bold, Underline),
some are dimmed (Italic), and the rest are off.

Clicking one of these button toggles the style for the selected text on or off. When
an option is selected (turned on) it appears primarily in black. If the selected text
does not have an option uniformly applied (some words are bold and some are
not), then that option will appear dimmed, although you can still select the
option to turn it on or off for all of the selected text.
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You can also move from one style to another using the arrow keys, and toggle
the options on and off by pressing the spacebar. Although you can apply small
caps, all caps, superscript, and s ubscript options from the control palette, to
modify the specifications of these options - the size of small cap text or the size
or position of superscript or s ubscript- you must use the Type specs ... command and then click the Options button in the Type specifications dialog box.
•

Type size. The type size option displays the current type size and lets you select
alternative sizes from a scrolling pop-up list or type the type size you desire. You
can also use arithmetic to enla rge or reduce the type size.
Clicking the up arrow increases type size by Yto point; holding down the Command key while clicking the up arrow increases the type size by 1 point. Clicking
the down arrow decreases type size by Yto point; holding down the Command key
while clicking the down arrow decreases the type size by 1 point.
The allowable range of type sizes is 4-point to 650-point, in Yto-point increments.

•

Leading. The leading option displays the leading of the selected text and lets you
select alternative leadings from a scrolling pop-up list or type the leading you
desire. You can also use arithmetic to enlarge or reduce the leading.
Clicking the up arrow increases leading by Ytopoint; holding down the Command
key while clicking the up arrow increases the leading by 1 point. Clicking the
down arrow decreases leading by Yto point; holding down the Command key
while clicking the down arrow decreases the leading by 1 point.
The allowable range of leadings is 0-point to 1,300-point, in Yto-point increments.

•

Tracking. The tracking option displays the tracking applied to the selected text
and lets you select an a lternative tracking from a scrolling pop-up list. You can
also type the name of the desired track into the option box, the same way you
type font names into the font option box.

•

Set width. The Set width option displays the current width of the selected text
and lets you select an alternative tracking from a scrolling pop-up list. You can
also type an a lternate width directly into the option box. Allowable widths range
from 5 percent to 200 percent.
Clicking the right arrow increases width by 1 percent; holding down the Command
key while clicking the right arrow increases the width by 10 percent. Clicking the
down arrow decreases width by 1 percent; holding down the Command key
while clicking the left arrow decreases the width by 10 percent.

•

Kerning. The kerning option displays the current amount of kerning applied to
the selected text and lets you adjust that kerning by typing a replacement value
into the option box or by using arithmetic to modify the displayed value. The
allowable kerning range is from -1 em to 1 em.
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Clicking the right arrow Increases width by 1 percent; holding down the Command key while clicking the right arrow decreases the width by 10 percent.
Clicking the left arrow increases width by 1 percent; holding down the Command
key while clicking the left arrow decreases the width by 10 percent.
•

Baseline shift. The baseline shift option, shown in Figure 13-20, displays the
current position of the baseline of the selected text relative to its normal position
(as defined by the font designer). You can modify the baseline position by typing
in a new value or by using arithmetic to modify the c urrent value. The allowable
range is -1,600 points to 1,600 points.
·
Clicking the up arrow increases baseline shift by J.1o point; holding down the
Command key while clicking the up arrow increases the baseline shift by 1 point.
Clicking the down arrow decreases baseline shift by J.1o point; holding down the
Command key while clicking the down arrow decreases the baseline shift by 1 point.

~ llil [Q) [Q) ~@ ®
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Bubbles

MCGuire's

Figure 13-20: Sample text manipulations done using the baseline shift option.

Paragraph Mode
Paragraph mode, shown in Figure 13-21, is used to check the current paragraph-level
formatting of selected paragraphs and to modify the paragraph-level formatting of
selected text. To enter the paragraph mode you must first select the text tool and then
click the paragraph-view button. This button appears to the left of the Apply button
under the character-view button. The keyboard equivalent for switching between
character and paragraph modes Is Command-Shift-·.
Figure 13-21:
The control
palette in
paragraph
mode.

Performing paragraph-level formatting using the commands in the control palette is no
different than when using commands in the Type menu or associated dialog boxes. You
must first select the text you want to format and then choose the necessary commands.

Chapter 13: The Control Palette

361

Options available in the paragraph mode:
•

Paragraph Style. This option displays the name of the curre nt style sheet used
to format the selected text, if the same style sheet has been applied to all of the
selected text. If two or more style sheets are used in the selected paragraphs, the
option box appears empty.
Choose a new style sheet by clicking the down arrow and selecting from the
scrolling pop-up menu or by clicking in the option box and typing the name of
the style sheet you want to apply. As you type, PageMaker tries to guess the style
sheet you want to select and automatically fills in the style sheet name for you. If
the correct name appears, press Enter or Tab to apply the style sheet. If an
incorrect name appears, keep typing additional characters until the correct style
sheet is selected.
If your control palette is positioned too close to the bottom of your screen, the

pop-up scrolling list can only display one or two style options. In this case,
reposition the control palette at any location farther from the bottom of the
screen, and selecting paragraph styles will be much easier.
•

Alignment. The alignment of the currently selected text is documented by the
highlighted alignment icon, if all of the selected paragraphs have the same
alignment. If not, no alignment icons are highlighted . To set the alignment of the
selected text, click any one of the five alignment icons.

•

Cursor-position. This option isn't an option at all, because you cannot change it.
It is simply an indicator, providing you with the precise current horizontal

location of the cursor within the current text block. (It does not tell you where
the cursor is when set outside of a text block.)
•

Indent options. There are three indent options in the control palette, just like in
the Paragraph specifications dialog box: left, right, and first line. These display
the current indent values of the selected paragraphs, and you can modify the
indents by replacing the existing values or by using arithmetic to change them.

•

Space before/Space after. Again corresponding to the options in the Paragraph
specifications dialog box, these options display the current amount of space set
before and after the selected paragraphs. To modify the spacing, select the existing
values and type in new values or use arithmetic to enter your modifications.

•

Grid size. This option specifies the size of the text grid that PageMaker uses
when the Align-to-grid option is selected. It corresponds to the Grid size option
normally found in the Options dialog box in the Rules dialog box in the Paragraph Specs dialog box in the Options dialog box.
Normally you want to specify a grid size equal to the leading for the body copy in
your document. II using the body copy leading isn't appropriate for some reason,
use some multiple of the body copy leading like 50% or 200%.

•

Align to grid option. Toggle on and off the Align to grid option by clicking the left
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(off) or right (on) buttons. Use of this option causes PageMaker to align the first
line in the next text paragraph to the current user-defined grid. This option is
generally used to help align text in multiple-column layouts and help produce
more-professional looking publications.

Object Mode _ _ _ _ _ _ _ __
When the control palette is open, and any tool except the text tool is selected, the
object mode is displayed, as shown in Figure 13-22. This mode presents information
about text blocks or graphics (either those created in PageMaker or those imported into
PageMaker) as objects and lets you modify a number of characteristics of these objects.
Options available in the object mode:
Figure 13-22:
The control
palette in
object mode.

•

Position (X and Y). The X and Y options display the current coordinates, relative
to the on-screen rulers, of the selected reference point within the selected object.
If no object is selected, or you are drawing a new object, the X and Y options
display the location of the cursor.
You can move the selected object by entering new X or Y values or by using
arithmetic to change the X and Y values. The specific effect of changing the X and
Y values depends on whether the current reference point is a movable or nonmovable reference point, as described earlier in this chapter. Any value that
represents a position on the current page or pasteboard is allowable, but values
that would position the element off the current page and pasteboard are not
permitted.
If multiple objects are selected, the position coordinates reflect the bounding
box of the group, as shown in Figure 13-23. You'll also notice that when multiple
objects are selected, most of the object mode options, except position and
rotation, are not available.

Figure 13-23: The control palette as it appears when multiple objects are selected.

Chapter 13: The Control Palette

363

You can also move the selected object by clicking the right or left nudge or up or
down arrows. Clicking any arrow moves the object in the arrow's direction by
Xoo inch; holding down the Command key while clicking an arrow moves the
object in the arrow's direction by Xo inch.
Lastly, skipping the control palette altogether, you can use the keyboard nudge
to move the object. First deactivate the control palette (Command-') and press
the arrow keys to move the object by Xou inch, or Command-arrow to move the
object by Xo inch.
•

Sizing. The [H) eight or [W]idth options display the size of the selected object. If
multiple objects are selected, the sizing options disappear. If the selected object
is a line, its' [L]ength is displayed instead. lf you are drawing a new rectangle, the
coordinates reflect the point at which you began drawing.
You can resize a selected object by entering new W or H values or by using
arithmetic to change the W and H values. The current reference point sometimes
prevents you from changing theW or H options; if the top or bottom center
reference point is selected, you cannot change the X value. If the right or left
center reference point is selected, you cannot change the Y value. When the
center reference point or any corner reference points are selected, either X or Y
values can be changed. An option that cannot be changed appears in plain type
(instead of the usual bold), and you won't be able to select it.
The allowable range for the W and H options includes any value that represents a
position on the current page or pasteboard. Values over 45.51 inches for graphics or 22.75 inches for text blocks are not allowable. Also, you cannot resize any
object so that any part of it would go outside the current pasteboard.
You can also resize the selected object by clicking the right or left nudge or up or
down arrows. (Which side of the object moves depends on whether the selected
reference point is an anchor square or arrow.) Clicking the right or up arrow
enlarges the object by Xoo inch; holding down the Command key while clicking
the right or up arrow reduces the object by Xo inch. Clicking the left or down
arrow enlarges the object by Xoo inch; holding down the Command key while
clicking the left or down arrow reduces the object by Xo inch.

•

Scaling percentage. Just to the left of the sizing option are the percentage size
option boxes. If you select an object with the arrow tool, and the object is an
imported graphic, these display the current size of the object as compared to its
original size. If you select a graphic object created in PageMaker (with the line,
rectangle, or circle tools), or a text block, the display always begins at 100%even if the object was previously resized.
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You can directly modify the s ize of any object by clicking in the [H]eight or
[W]idth scaling option box and entering a new scaling percentage in Y.()-point
increments. The only limit is that you cannot enlarge the object so it no longer
fits on the current pasteboard. Depending on the currently selected reference
point in the proxy, you may not be able to modify either the height or width
option. If the top or bottom center reference point is selected, you cannot
change the width value. If the right or left center reference point is selected, you
cannot change the height value. When the center reference point or any corner
reference points are selected, either width or the height values can be cha nged.
An option that cannot be changed appears in plain type (ins tead of the usual
bold), and you won't be able to select it.
•

Scaling/Cropping. These two buttons indicate whether changes made to the
graphic you are manipulating will resize the graphic or crop it. The scaling icon
is selected automatically when you select a graphic with the arrow tool, and the
cropping icon is selected automatically when you select a graphic with the
cropping tool. You can toggle between these two by clicking directly on their
icons in the control palette.

•

Proportional scaling. When you manually resize an object (by dragging one of its
handles with the arrow tool), holding down the Shift key forces the object to
remain proportional. Clicking this button has the same effect on control palette
scaling- it makes it impossible to scale any graphic disproportionately. In other
words, any change you make to the [H) eight of an object, either in the scaling
option or the scaling percentage, will affect the [W]idth o ptions equally and
automatically. Conversely, changing the [W]idth will make the [H]eight react
accordingly.

•

Printer resolution scaling. This option also mimics a traditional keyboard
shortcut. Selecting this button (it appears black when selected) makes control
palette s caling use PageMaker's magic stretch , automatically scaling bitmapped
and TIFF graphics to a s ize compatible with the resolution of the currently
selected printer.

•

Rotation. The rotation option displays the current rotation of the selected
object. Change the rotation by entering any value between -360 and 360 degrees
in 0.01-degree increments. You can also use the up or down nudge arrows to
rotate the object in Y.~egree increments. Holding down the Command key while
clicking an arrow rotates the object in the arrow's direction by Y.oo degree.
If a stationary reference point is selected, rotation occurs around that point. If a

movable reference point is set, that point moves to accomplis h the requested
rotation.
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Skewing. The skewing option displays the number of degrees that the selected

object is skewed. You can change the skew amount by entering any value
between -85 and 85 degrees in 0.01-degree increments. You can also use the up
or down nudge arrows to rotate the object in Y.o-degree increments. Holding
down the Command key while clicking an arrow rotates the object in the arrow's
direction by Xoo inch.
•

Refledion (Horizontal and Vertical). The two reflecting buttons let you quickly
flip any element horizontally or vertically (see Figure 1~24). When these buttons
are selected, you can also select or deselect them by pressing the spacebar.

The kind of reference point you have selected (stationary or movable) is particularly important in its effect on the result of using the reflecting buttons.

Figure 13-24: The Reflection option can be used to flip an object horizontally or vertically.

When an object has been reflected with either button, a black borde r appears
around both, indicating that one has been selected. I can't really figure out why
the buttons don't highlight like the Printer resolution scaling button does must be that famous Aldus aversion to consistency.
•

Baseline offset option. When the object you select is an inline graphic, the
control palette changes slightly with the Baseline offset option replacing both the
proxy and the X andY options (see Figure 1~25). This option displays the
location of the inline graphic's baseline relative to the baseline of the text that
surrounds it. When a value of 0 appears, the inline graphic is on the baseline of
the text. The range of allowable values is 0 to the height of the inline graphic.
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Figure 13-25: The control palette as it appears w hen an inline graphic is selected.

You can also use the up or down nudge arrows to move baseline in Ylo-inch
increments. Holding down the Command key while clicking an arrow rotates the
object in the arrow's direction by J.1oo inch.
Selecting inline graphics and then using the baseline shift option allows you to
shift the inline graphic with more precision than you get by dragging it with
the arrow tool. And by shifting the baseline by large amounts, you can move
in line graphics more dramatically than the arrow tool allows.
Here is a list of keyboard shortcuts for the control palette:
Shortcut

Result

Display/Hide control palette

Command-'

Activate/Deactivate control palette

Command-'

Character view/Paragraph view

Command-Shift-'

Next option

Tab

Previous option

Shift-Tab

M ove within option

Arrow keys

Select reference poi nt in proxy

Arrow keys when proxy is active. Numbers on
keypad when Numlock is active.

Apply changes

Enter or Return or Tab

Undo changes

Esc or Clear

Change measurement system

Command-Option-M

Nudge selected object

Command-arrow key

Chapter 13: The Control Palette

36 7

••••••••••••••••••••••••••••••••••••••••••••• •••
Summary
•

The control palette displays four distinct sets of options, depending on the
current selection. The four options (or modes) are deselect, character, paragraph, and object.

•

To use the control palette, you must make it visible by choosing it from the
Windows menu or pressing Command-' (quote). After selecting the object you
want to manipulate, activate the control palette to change its options, by
pressing Command-' (grave) or by clicking in the control palette with the
mouse.

•

After changing values in the control palette, click the Apply button (near the
left edge of the palette) with the mouse, or press the Return or Enter key. Or
you can use the Tab or Shift-Tab keys to move between options in the control
palette.

•

The rectangle with corner and edge dots is called the proxy and is used to
specify the reference point for control palette options. You can select any dot
to set the reference point. Clicking once sets a nonmovable reference point,
and clicking twice sets a movable reference point.

••••••••••••••••••••••••••••••••••••••••••••• •••
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Working
with Color
••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
W Defining spot and process colors

•

Color issues: tints, registration, overprinting, and more

•

Using the colors palette to apply colors

•

Working with color libraries

•

Editing colors

•

Importing colors from other publications

•

Exporting colors to color libraries

W Deleting colors

••••••••••••••••••••••••••••••••••••••••••••••••
Color draws people into the content of your publication by adding impact and interest
to any page. Used effectively, color can be one of the most powerful design tools you
have in creating a publication. PageMaker puts these design tools squarely in your
hands by giving you the ability to create and print spot- and process-<:olor publications
easily. Before you delve into the details of using PageMaker's new color tools, though, it helps
to understand the basics of how colors are printed on a commercial printing press.

Spot- and Process-Color Printing
There are two basic ways to print color on a commercial printing press: using spotcolor inks or process-<:olor inks. In spot-color printing, the printe r uses a premixed,
opaque or semi-opaque ink to print the colored objects. You specify what spot-<:olor ink
to use from among the hundre ds of spot-<:olor inks available to your printer.

H
A
p
T
E
R

372

Part III: Advanced Topics

In process-color printing, the printer uses only four translucent inks- cyan (C),
magenta (M), yellow (Y), and black (K)- to reproduce colors. By printing different
sizes and combinations of these CMYK ink dots close together on a page, the printer
can simulate hundreds of different colors. To understand what I'm talking about, you
should consider how a photograph is reproduced on a commercial press.
An original photograph is called continuous-tone art because it consists of solid shades
of smoothly blending color. To print on a commercial press, the continuous-tone image
must be broken into sets of dots of various sizes- one set of dots for each of the four
process-color inks. Each set of dots, called a halftone screen, must be set at a unique
angle, so that the dots of process ink print side by side instead of on top of each other
in the final printed piece. (If the dots are positioned properly, the result is a rosette
pattern that helps to create the color illusion. If the dots are off even slightly, an unsightly moire pattern prints ins tead , breaking the color illusion. Information on how
screen angles are set in PageMaker is provided in Chapter 17, "Printing Publications."
Halftone dots also vary in size- s mall dots are used to print lighter areas and larger
dots to print darker areas. In the final printed piece, your eye uses the dots of ink to
perceive dozens of different colors.

You can see what I'm describing by picking up any magazine and flipping to a color
photograph in it. If you look very closely at the color photograph (you may even want
to grab a magnifying glass to help you out), you'll notice small dots of color that make
up the image. Up close, those dots look like cyan, magenta, yellow, and black dots. From
a distance, though, your eye merges those colored dots to perceive a simulation of the
range of colors from the original photograph.
To break a continuous-tone image into four halftone screens, the photograph is typically scanned. In electronic publishing, the scanned image is then placed in the electronic publication. Process colors can also be applied to the text and graphic elements
that you create in PageMaker, and you can import process-color graphics from other
programs into PageMaker. As with the photographs, the process colors in these elements are reproduced by halftone dot screens of each process-color ink needed to
create the particular color. When elements are colored with s pot colors, by contrast,
they print as solid areas unless you apply a halftone screen to them to create a lightened color, called a tint.
You transform your PageMaker publication into something that can be reproduced on a
printing press by printing color separations - one separation for each process- and
spot-color ink in your publication. (Spot-color separations are typically called spot-color
overlays.) These separations are typically produced by a service bureau, which prints
onto film that a commercial printer then uses to make the printing plates that are used
on the press. A separate plate is used to print each ink in your publication.
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A number of factors influence whether you use spot or process colors - or both types
of color- to print a publication. The three key factors are time, money, and design.
Using process colors typically takes more time and costs more than printing spot
colors. However, you should use process colors if you need to use more than four
colors in your design, if you're printing color photographs or other imported elements
that require process colors, and if you have the time and the budget.
You should use only spot colors if you have a limited budget and can accomplish your
design using three or fewer colors. (If you need to print four or more spot colors, you
should use process colors instead, as it then becomes the more cost-effective color
choice.) You should also use spot colors when you need to make a precise color match
in a corporate logo or some other graphic or when you want to use a special spot-color
ink, such as fluorescent or pearlescent.
In some instances, you'll want to use a combination of process a nd spot colorsthough this can be cost prohibitive if you go over six separations (four process, two
spot). You may, for example, need to use five or six colors to print an annual report that
includes color photographs and a corporate logo that has precise color matching
requirements.

Other Printing Issues _ _ _ _ __
In addition to understanding the difference between spot and process colors, it also
helps to know these key terms: registration, trapping, knocking out, and overprinting.

Registration and trapping
Each ink in a print job must print in exact alignment- called registration - with the
other inks in the job to give you the printed results you want. If inks print out of alignment, two things may happen. When spot colors misregister, small, perceptible gaps
appear between the adjacent colored objects. When process colors misregister, either
small gaps appear between adjacent objects or slight shifts in color appear, making
perceptible halos (third colors) around the objects.
Misregistration often occurs because of the mechanical limitations inherent in printing,
even on high-quality presses under near-ideal conditions. Any number of factors cause
misregistration, including the natural absorbency and stretch in paper, inadequate film
registration, or the slight misalignment of the press. Since the human eye can detect
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both gaps and color shifts, even minute ones, these printing problems undermine the
quality of your print job. Printers have developed trapping techniques to compensate
for these problems. Trapping is the process of slightly overlapping adjacent color
objects to prevent perceptible gaps and color shifts. The question of who should be
responsible for trapping and what tools they should use is a key problem to solve in
preparing your color publications for the press. For a more detailed discussion of trapping,
and Aldus' trapping utility, Aldus TrapWise, see Chapter 19, "Aldus PrePress Tools."

Knocking out and overprinting
When overlapping colored objects print, the top object usually knocks out the objects
underneath it. In other words, the top object prints and the other objects do not print
where the top object overlaps them. The reason this happens is s imple - you want to
control the color of the top object. If the top object prints on top of other objects, the inks
intermingle on the press where the objects overlap, creating an unexpected third color.
In some instances, however, you do want the top color to overprint the bottom color.
For example, you may want to obscure the gaps that sometimes occur between objects
when they print on a press. Overprinting lets you trap those gaps, so they aren't as
obvious to the human eye. You may also want to create a third color inexpensively.
Overprinting two spot colors can create a third color without the expense of printing a
third spot color. You should try this technique only if you have experience, however, as
you can also get some strange results.

Working with your printer
Color can be a challenging tool to use well because you need to keep in mind at all times
how your publication will print on press. It hasn't always been the case that you needed
to understand commercial printing. In traditional color publis hing, you - as the person
creating the color publication -were respons ible for creating mechanicals that
specified what you wanted in your final printed piece. Your commercial printer then
took those mechanicals and used a whole team of highly trained prepress technicians to
transform the mechanicals into the plates that were used to print the piece on the press.
Electronic publishing blurs that clear distinction between design and printing respons ibilities by making you responsible for more of the steps involved in printing a color
publication. On the other hand, the emergence of these electronic tools is also making
color printing more affordable, and it's giving you unprecedented control over your
publication process. By mastering PageMaker's tools and the basics of commercial
printing, you can achieve the printed results you want at a reasonable cost.
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To help you in this learning process, you shou~d follow the advice that Aldus lays out
over and over again- seek out commercial printers who are s upportive of the emerging electronic publishing trend and make those vendors your friends. For that matter,
make friends with the service providers who help you scan images or do other tasks in
preparing your color publications. You can learn from these people. The earlier you
involve them in your design project, the better your printed results are likely to be. You
should also review the Commercial Printing Guide, which is part of your PageMaker
documentation. This four-color booklet provides extensive information on all aspects of
commercial printing and preparing color publications in PageMaker.

The Colors Palette --------------------------------The Colors palette is a key tool in working with colors in PageMaker. You use the
palette to apply colors to the lines and fills of PageMaker objects, text, and imported
graphics. To open the Colors palette, shown in Figure 14-1, you choose the Colors
palette command from the Window menu.
Colors

Figure 14-1 :

The Colors palette lists all existing
spot colors, process colors, tints, and
colors from imported EPS elements.
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The color list
The main thing you 'II find on the Colors palette is a list of the colors you created or
imported into your publication. A color swatch appears to the left of the color name, so
you can get a quick idea of the color (if you're lucky enough to have a color monitor).
The color names then reveal whether the color is a spot color, a process color, or a tint
of one of those. Spot-color names appear in plain text, and process color names in italic
text. A percent (%) sign appears to the left of the tint names, which are either pla in or
italicized depending on whether they are spot- or process-color tints.
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If you imported an EPS graphic that contains spot colors, those colors appear on the

palette list as well. You'll recognize those colors because an EPS symbol shows up
between the color swatch and the color name. If you imported an EPS from Aldus
FreeHand that contains process colors, those colors also appear on the palette list.
However, PageMaker does not display process colors that are imported in EPS graphics
from other programs. (PageMaker prints those process colors- they just don't appear
in the palette list. The reason they don't appear is that PostScript doesn't offer a
standard way to describe process colors, so PageMaker doesn't have a way to capture
information from other programs.) You can apply EPS colors to other objects in your
PageMaker publication, just as you would any other color. You can also edit imported
EPS spot colors. For more information, see ~Editing colors" later in this chapter.
Six colors are listed in the Colors palette by default - [Paper] , [Black], [Registration],
and three spot colors (Red, Green, Blue). The Red, Green, and Blue colors can be
deleted at any time from any publication, or you can delete them when no publication is
open to remove them from the default color list. In fact, I recommend deleting them
permanently as they serve no real purpose. To edit this default, choose the Define
colors ... command when no publications are open, click one of the default spot colors,
and click Remove. Click the Yes button when PageMaker displays the alert. Repeat
these steps two more times for the other two spot colors. Another option is to edit
these defaults or delete them and then replace them with other default colors that you
do use frequently.
You cannot remove the [Paper], [Black], and [Registration] options. These "colors" are
used in all PageMaker publications:
•

Paper. The [Paper] option is a peculiar one. Basically, it's a non<olor. When you
apply it to an object, that object knocks out any colored items that appear
behind it, so that the paper shows through. You can edit [Paper] to simulate on
screen the color of the paper you're printing on. That simulation doesn't print,
however. It just gives you an on-screen sense of what your final design will look
like.

•

Black. The [Black] option is a 100% process black ink, which you cannot edit.
Any objects with this [Black] applied knock out objects placed behind them, with
one critical exception- text. Black text automatically overprints anything
placed behind it. In most instances, that's great- you want black text to overprint, particularly small, serif text that's difficult to trap. However, you may
occasionally want black text to knock out (or other black items to overprint).
You can accomplish this goal by creating 100% tints of the default black and
setting those tints to overprint (or knock out- depending on what you want to
do). For more information, see "Creating tints" later in this chapter.
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In PageMaker 4.2 and earlier, the default black color was a spot color. If you are
used to using the default black as a spot color, you'll have to convert the new
process<olor default into a spot color.
•

Registration. The [Registration] item is another non<olor. Basically, you apply it

to items that you want to print on every separation. If you create your own crop
marks or registration marks, you can place them in your publications and apply
[Registration] to them, so they'll print on every separation.

Applying colors to elements
Once the Colors palette is open, you use it by first selecting the element or elements to
which you want to apply color and then selecting a color from the palette. You can
apply colors to a variety of objects that you create in PageMaker, including text, lines,
rectangles, and ellipses. You can also apply colors to some Imported graphics, such as
Encapsulated PostScript (EPS) files and monochrome or grayscale bitmapped images.
Don't be fooled though- when you apply color to imported graphics, you're not
changing the intrinsic color of these graphics. Instead, you're overriding the intrinsic
color information. The color you apply in PageMaker dictates what separations the
graphic prints on and, therefore, what spot or process inks are used to print the
graphic. If you remove a color that you apply to an imported graphic, PageMaker uses
the imported graphic's internal color information to print the graphic on the appropriate separations.
To apply colors to most objects, you select the object with the pointer tool and click
the color name on the Colors palette list. There are a few exceptions to keep track of,
though. You need to select text with the text tool to apply a color to it. Rectangles and
ellipses require a few extra steps because you can apply different colors to the line and
fill of these objects. After you select the rectangle or ellipse, you choose Fill, Line, or
Both from the pop-up menu on the Colors palette. To specify whether the color you
click is applied to the fill, line, or to both the fill and line, choose Fill, Line, or Both from
the pop-up menu at the top of the palette, which is shown in Figure 14-2. Alternatively,
you can click the Fill and Line buttons to the right of the pop-up menu to accomplish
the same task. Then you click the color name to apply the color to the part of the object
that you specified.
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Figure 14-2:
The Colors pa lette
allows you to apply
colors to t he fill, line,
or both the fill and
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You can also choose the Fill and line ... command on the Element menu to apply separate fill and line colors. Choosing this command lets you specify a custom line weight
between 0 and 800 points and lets you overprint the color you're applying to the line or
fill. For more information on overprinting, see the "Other Printing Issues~ section earlier
in this chapter.
Removing colors is as easy as applying them. With lines and text, you s imply apply a
different color. So, for example, if you color a text block red and then decide that you
want it to be black, you select the text again and click Black on the Colors palette. With
rectangles and ellipses, select the object and then either choose None from the Une or
Fill submenu on the Element menu or choose the Fill and line .. . command on the
Element menu and make changes in the dialog box that appears. With imported graphics, select the graphic and choose the Restore original color command from the Element menu.

Defining New Colors
PageMaker lets you create and print spot and process colors based on your own
specifications or choose spot and process colors from one of the color matching
systems included with the product. (For more information on the color matching
systems, see "Using the color matching systems" later in this cha pter.) To create a spot
or process color, choose the Define colors ... command from the Element menu, and
click the New ... button. Then, in the Edit colors dialog box, shown in Figure 14-3, you
can enter values to specify the color you're creating.
You can quickly open the Edit color dialog box and specify a color by pressing
the Command key while clicking on the [Black] or [Regis tration] colors in the
Colors palette.
The Define colors dialog box, s hown in Figure 14-4, lets you set:
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Figure 14-3:
The Edit colors dialog
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Name. You can enter a name up to 31 characters in length. However , it's easier to
read shorter names in the Color s palette list. When you' re specifying a process
color , you should enter a descriptive name that y ou'll recognize easily on the
Colors palette. When you're specifying a spot color , you should enter the name
that appears in the swatch book you're using to pick the spot color . Why?
Because the name of the spot-color ink typically prints on the spot-color overlay.
If you use the name the spot-color ink manufacturer uses, your commercial
printer has a clear confirmation of the spot-color ink to use in your print job. If
you're choosing spot or process colors from one of the color matching systems
included with PageMaker, y ou should leave the Name option blank. The name of
the color you select in the library will appear automatically in the Name option
box.

•

Type. Click Spot, Process, or Tint to specify the type of color you're cr eating. For
more information on tints, see "Creating tints" later in this chapter.

•

Model. PageMaker offers three color models: RGB (r ed, green, blue), HLS (hue,
lightness, saturation), and CMYK (cyan, magenta, yellow, black). Each color
model provides a differ ent w ay to describe color . There are a number of reasons
why we need different models to describe colors, all of w hich have to do with
how we perceive colors and how different devices- such a monitors, scanners,
commercial presses, and so on - handle color. If you want to learn more about
color models, y ou should consult the art secti on of your local bookstore or
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library. However, to create colors in PageMaker (or any other graphics software
package for that matter), you need to master only two basic concepts: 1) When
you create spot colors, it doesn't matter in the slightest what color model you
select; 2) when you create process colors, you should choose only the CMYK
color model.
The reason it doesn't matter what model you use to create spot colors is simple.
You're not actually creating the spot color in PageMaker. You're creating a tag
that you apply to objects to ensure that those objects print on a separate spotcolor overlay. Your commercial printer then uses that overlay to create a separate
printing plate and to print those objects with the appropriate spot-color ink.
When you create process colors, however, the model you use and the values you
specify do affect what prints on the press. Cyan, magenta, yellow, and black inks
are used to print process-color publications. If you use a different color model to
create process colors, PageMaker simply converts the RGB or HLS values to
CMYK values when you print the process-color separations. This conversion
isn't a simple one to make, so PageMaker can only approximate the color you
specified. You'll get more predictable results if you simply use the CMYK model
to begin with.
•

Overprint. Check this option if you want the color you're creating to print over
any colors that appear behind it in the publication. (In other words, any objects
that have the color applied print over any objects that appear behind them in
the publication.) Leave this option unchecked if you want the color to knock out
colors that appear behind it. For more information on overprinting see "Other
Printing Issues" earlier in this chapter.

•

CyanjMagenta/Yellow/Black. If you're creating a process color, enter values or
adjust the scroll bars for each of the process-color inks. You should keep these
rules in mind when specifying these values: First, Don't rely on what you see on
screen to specify these colors. Working on a color monitor gives you an idea of
what your final design will look like, but the colors on a monitor rarely match
printed colors exactly- even when you control your environment and calibrate
your monitor regularly. Instead, use printed process-color charts to select colors
and then enter the values from those charts to specify the colors in PageMaker.
Second, don't use too much ink to print a color. The maximum amount of ink you
can specify is 400%- 100% each of cyan, magenta, yellow, and black. However,
the more ink that appears on any area of a page, the more likely it is that the
paper will become over saturated and stretch or tear on the press. For most
presses, the maximum recommended ink coverage is 250%-320% -so the values
you enter shouldn't exceed these totals.
Third, specify process colors that use only two inks, if possible. The more inks
you use to create a color, the more challenging it is to print them in register.
When process inks print out of register, you get unsightly moire patterns that
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undermine the illusion of color you're trying to create. l.f, as a rule, you specify
most of your process colors with two inks and only occasionally specify more
inks, you'll achieve better printed results.
•

libraries. This pop-up menu, shown in Figure 14-5, presents the available color
matching systems from which you can select predefined colors. The use of these
colors is described next.
Croyon
Greys
PM5 Col or Lib
OIC COLOR GUIDE
FOCOLTONE
MUNSELL® High Chromo Colors
MUNSELL® Book of Color
PANTONEe> Cooled
PANTONEe> ProSim
PANTONE ~ Uncoo t e d
PANTON[ ProSim EURO®
PANTDNEe> Process
PANTDNEe> Process Euro
TDYOpc
TRUMATCH 4 - Color Sel ec tor

Figure 14-5: A number of color libraries are provided with PageMaker 5.

Using the colors matching systems
Achieving exact printed results with color is an almost impossible task. A number of
factors affect the difference that inevitably occurs between the colors you ask for and
the colors you get on press. These factors range from the lighting in which you view the
specified color, the color proof, and the printed color to the press standards of the
commercial printer you're using. Even the most exacting printer working on the highestquality press cannot promise you exact color matches because of the sheer number of
variables that affect printing.
Basically, then, you have a choice. You can either fret and fume about every little
nuance of difference, or you can work out acceptable tradeoffs with your printer. (Your
printer, for example, may be a ble to guarantee that a certain object will hold its color
through a print run, if you're willing to compromise on the exact color of some other
objects. Typically, printers can control some variables, just not all variables.)
You can also rely on color matching systems, which have emerged as an effective way
to achieve more predictable printed results. PANTONE, Inc. set the stage for these
systems when it released the first spot-color matching system more than 30 years ago.
Up to that point, achieving predictable printed results was hit or miss at best. The
PANTONE system gave designers and printers more reliable results, and their color
matching systems continue to set the standard for reliable color results. However, the
growth of color printing has led to the release of several other spot- and process-color
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matching systems, several of which are included in electronic form in PageMaker.
Figure 14-6 shows some of the library dialog boxes. The systems in PageMaker include a
Focoltone library, several MUNSELL libraries, several PANTONE libraries, a TOYO
library, a TRUMATCH library, and others. You s hould contact individual vendors for
more information about where to purchase their swatch books.
Figure 14-6:
A selection
of dialog
boxes from
the color
libraries
provided in
PageMaker 5.
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To choose a color from a color matching system, choose the Define colors ... command
from the Element menu and click the New ... button. Open the Libraries pop-up menu
and select a color matching system. The Library dialog box for that color matching
system opens, so that you can choose a color. Click on a color to select it (or press the
Shift key and click on several colors to select more than one at a time). As a rule, you
should accept the default names for the colors so you know what you've selected when
you consult swatch books and so on. However, you can edit the name of a color if you
wish. If you select more than one color at a time, the word MULT appears in the Library
dialog box. Then, when you close all of the dialog boxes, the individual color names
appear on the Colors palette.
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If you cannot locate a particular library in the Edit colors dialog box, the files

may not be stored in the correct location on your hard drive. You need two
files: the color-picker file, which is called Aldcolor.add, and the library file,
which has an ACF or BCF extension. The color-picker file appears in the Additions folder in the Aldus folder in your System folder. The color library file
appears in the Color folder in the same location. You can always reinstall these
files from the PageMaker installation disks.

Creating tints
To control your color printing costs, you may limit yourself to printing black and one
spot color. You can expand your palette, however, by creating tints of that spot color. A
tint is a lightened version of a spot color that prints on the same spot-color overlay, so
you don't incur extra printing costs. PageMaker creates the tint by applying a halftone
screen to the solid spot color and thereby controlling the number and size of the dots
of ink printing the tint. You specify the size of the screen when you choose an exact
percentage fort' .e tint. Figure 14-7 shows samples of tints.
Figure 14-7:
An element with a solid spot
color applied (left), a 70o/o tint
of that spot color (center), and a
30o/o tint of that spot color.

To create a tint, choose the Define colors ... command from the Element menu. Click the
New ... button, then click the Tint option. A different set of options now appears in the
Edit color dialog box, which is shown in Figure 14-8, so that you can specify a tint.
Choose the color on which you want to base the tint from the Base color pop-up menu.
Then, enter a value or use the scroll bars to specify the exact percentage of the tint. You
can specify tints in increments as small as 1%. However, printing presses typically
cannot hold a tint to that precise a level, so you may want to think in 5% or 10% increments. You also should be wary of specifying tints below 20%- most presses cannot
print that light a tint. You may want to consult your printer for advice about how fine a
tint you can print. When you're done specifying the tint, enter a name for it. As a rule,
choose names that include the base color, so that you know what color you're selecting
on the Colors palette. Then click OK to close the dialog boxes.
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Figure 14-8:
The Edit color dialog box
and the Tint option.
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You can also specify that a tint overprints, so that any objects that have the tint applied
will print on top of any objects behind them. This is a very useful feature because there
may be times when you want a color to knock out some objects and overprint others.
To do that, you can create one color and then create a 100% tint of that color and set
the tint to overprint (by checking the Overprint option). The color and the tint are
identical, but one knocks out and the other overprints the objects it's applied to.
Here's one final suggestion on tints: Always consult your printer before applying tintsparticularly light tints -to fine objects, such as hairline rules, small serif text, and so
on. It's usually better to use a solid color to print fine objects because the objects hold
their shapes better when you print. However, your printer will be able to give you the
best advice.

Editing Colors _ _ _ _ _ _ __
After you create a color, you can always edit it. PageMaker will automatically update
any objects to which the color is applied. It will also update any tints based on that
color, so stand warned if that's not the result you're expecting. Note, as well, that you
can edit the spot colors included in EPS graphics but not the process colors.
To edit a color, choose the Define colors ... command from the Element menu. (You can
also press the Command key and click the color name on the Colors palette to quickly
open the Edit color dialog box and make changes.) In the Define color dialog box, click
the color you want to edit, then click the Edit ... button. The dialog box shown in Figure
14-9 appears. You can now change any of the specifications you want.
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Figure 14-9:
The Edit color dialog box
can be used to change
color names, definitions,
or color models.

n

Edi t color
Name:

lrovo 0 205pc Mild Gre~

Type:

®Spot

Model:

@ RGB

0

Process

0

HLS

D Ouerprlnt
Red:
Green:
Blue:

0

OK
Cancel

385

B
]

O Tint
CMYK
libraries:

[t)

!!:] "lo
§] "1.
[ ] "1.

You can convert a spot color into a process color, or a process color into a spot
color, by holding down Command-Option-Shift and clicking on the color name
in the Colors palette.
When you edit colors, you should follow the same principles as when you create them.
For example, don't rely on the color on screen to make your edits. Instead, work from
printed swatch books of spot or process colors. Be particularly careful if you change a
spot color into a process color because process-color inks can only simulate a spotcolor ink. (Process colors are printed with translucent inks and spot colors with
premixed, semi-opaque inks, so the results look very different in print.) If you work from
printed color charts, you'll get more predictable printed results. You should also note
that Aldus doesn't recommend editing colors from the color matching systems. The
companies that created the different color matching systems intended you to get very
specific printed results by using their colors. If you don't want those results, then you
should specify your own colors.

Editing imported EPS graphics
PageMaker also lets you edit spot colors in imported EPS graphics - a feature that can
save you time and money when you print. When you print color publications, you want
to control the number of separations that print, so that you can manage your costs. You
may, for example, be creating a five-color publication that will print with the four
process-color inks and one spot-color ink. You don't want to use a second spot color by
accident then, or you'll end up with an expensive extra separation when you print. Plus
you'll incur the additional cost of having the printer strip together the two spot-color
overlays so they both print on the same printing plate.
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One of the easiest ways to end up with an unexpected extra separation is to import an
EPS graphic that includes a different spot color than the one you're using in your
publication. If that happens, you can always go back to the original application for the
EPS, change the color, and then place it into PageMaker again. (OLE linking and embedding and the special FreeHand hot link all make this process pretty simple to execute.)
You may not have the original graphic file, though, or you may not want to spend the
time to edit and reimport the graphic. That's where it's handy to edit the spot color in
PageMaker.
To merge spot colors in an imported EPS with spot colors in your publication, choose
the Define colors ... command from the Element menu. In the color list, select the EPS
color you want to edit. (fhe identifying EPS icon that appears in the Colors palette list
doesn't appear in this list, so be sure to check the color name before you open the
Define colors dialog box.) Click the Edit. .. button, then click the Tint button. For the
Base color, select the color you want to merge with and then type 100% for the tint
percentage. Then click OK to close the dialog boxes. Now, the spot-colored objects in
the EPS graphic will print on the same overlay as the base color. You can also convert a
spot color in an EPS graphic to a process color.
When you import an EPS graphic from Aldus FreeHand, PageMaker lists all of
the colors in that EPS on the Colors palette list- even if those colors aren't
actually applied to an object in the EPS graphic. In other words, if you create a
number of colors in FreeHand, use only a few of them, and then export an EPS
file, all of the color information in the file is included in the EPS. And all of those
colors appear in the PageMaker publication. To keep your PageMaker Colors
palette organized and to be clear what colors are actually being used in the EPS,
consider deleting unused colors in the original FreeHand file before you export
the EPS graphic.
If your FreeHand document contains lots of unused colors, a quick way to

delete them all is to copy the entire FreeHand illustration and then paste it into
a new FreeHand document. This transfers only those colors used in the illustration so you can then export the file as an EPS file without any extra colors.

Replacing one color with another color
Sometimes you may want to do more than edit a color slightly. You may want to
completely replace it with another color and have the replacement color automatically
update all objects to which it's applied. You'll find having the ability to update objects
automatically particularly useful if you working with a long publication.
To replace one color with another color, choose the Define colors ... command from the
Element menu. Click the color you want to replace, then click the Edit .. . button. Change
the name of the color to the name of the color you want to replace it with. For example,
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if you want to get rid of a color named Purple and make all objects with Purple applied
Mauve, you would change the name Purple to Mauve. If the color is a process color, you
can change the CMYK values to the new specifications. Then click the OK button to
close the Edit color dialog box. An alert message will appear asking whether you really
want to change all objects to the other color. Click the OK button to replace the colors,
then click the OK button to close the Define color dialog box.
PageMaker removes the original color from the Colors palette and replaces it with the
new color. Any objects that had the original color applied now have the new color
applied. Any tints that were based on the original color also change to the new color
(which is why it pays to include the base color in your tint names- so you can predict
what will change.)

Importing Colors
You can specify colors in one PageMaker publication and then quickly copy those colors
into another publication. To copy a few colors from one publication to another, create
one or more objects- such as rectangles, ellipses, or lines -in the publication that
contains the colors you want. Apply the colors you want to the objects. Then, either cut
and paste or copy and paste the objects into the other publication. The colors now
appear on the Colors palette in the other publication, so you can apply them to other
objects.
To copy all of the colors from another publication, choose the Define colors ... command from the Element menu. Click the Copy ... button. When the Copy colors dialog
box opens, locate and double-click the PageMaker publication that contains the colors
you want. Click the OK button to close the Define colors dialog box. All of the colors
from the other publication now appear in the Colors palette in your publication. Figure
14-10 shows the dialog box.
Figure 14-10:
The Copy colors dialog
box Jets you bring in
colors from other
publications.
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If a color you're copying has the same name and different specifications than a color in
your publication, you decide whether or not to replace the color. PageMaker displays
an alert message that asks whether or not to replace the color. You can click the OK
button to replace it or the Cancel button to retain the color in your publication. If two
colors have the same name and specifications, PageMaker doesn't import the color.

Exporting Color Libraries
If you use a certain combination of colors over and over again, you may want to create

them once and then turn them into a color library that you can access all the time. (You
could also create a color template. However, when you create a color template, aJI of
the colors you create are present on the Colors palette. Creating a color library lets you
have instant access to your standard colors but doesn't automatically clutter the
palette with colors that you won't necessarily use in every publication.)
To create a custom color library, open a publication and specify all the colors you want
to appear in that library. Be sure to give each color a meaningful name, so that you
know what you're selecting from the library you create. Then, choose the Create color
library ... command from the Additions submenu on the Utilities menu. The dialog box
shown in Figure 14-11 appears. For Library name, enter the name you want to appear in
the Libraries list in the Edit color dialog box. The File name, on the other hand, is the
name of the actual color library file that's stored in the Color folder in the Aldus folder
in your System folder. Obviously you'll want to choose unique names for each Library
name and File name you create. For File name, either accept the default name or change
it to a name you want. Be sure to include the .BCF extension, however, or PageMaker
won't recognize the library you create. Then, enter a number between 1 and 10 to
specify the number of columns and rows of colors that appear at one time in your color
library window. Click the Save button to save the library in the correct location.
Figure 14-11:
The Create color
library dialog box
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library nome:
File nome:

~

-~~----

Preferences
Colors per column:
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Colors per row:
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Notes:
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IMonthly Newsletter Colors I ( Concel )
INewsletter.bcf
I (soue os ...]

Color scheme for 1994- 95 newslellers, per
December '93 Design Team opproual #2 131
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Deleting Colors _ _ _ _ _ _ _ __
If you decide not to use a color, you can easily remove it from your publication. You

simply choose the Define colors ... command from the Element menu, click the name of
the color you want to remove, and click Remove. PageMaker then displays an alert box
that asks "Remove 'color' and change all 'color' items to black?" The dialog box is
shown in Figure 14-12. Click the OK button if you want to delete the color or the Cancel
button if you've changed your mind. Then click the OK button to close the Define colors
dialog box. If you chose to delete the color, any items to which you applied that color
change to black.
Figure 14-12:
The alert dialog box that
appears when you remove a
color.

Remoue TOYO 02B5pc ~ ond change
oil TOYO 02B5pc* item s to block?

OK

l n Concel

D

As a rule of thumb, you should delete colors from your publications if you decide not to

use them- particularly spot colors and particularly in long publications. It's just too
easy to apply a color to some small object on page 52 of a 90-page publication and
forget you've done it. Then, when you print separations of the publication, you end up
with an extra, expensive separation. Deleting unnecessary colors ensures that you print
only the correct number of separations.
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••••••••••••••••••••••••••••••••••••••••••••••••
Summary
•

Two kinds of color can be used in PageMaker: spot color and process color.
Spot color uses colored opaque ink to reproduce the colors defined on-screen.
Process color uses four translucent inks (cyan, magenta, yellow, and black) to
give the appearance of the defined color.

•

Spot or process colors can be applied to elements within PageMaker, or colors
can be applied in other applications before the elements are imported into
PageMaker.

•

When printing colored documents, there are many issues to consider, including
registration, element knockouts and overprinting, and trapping. For this
reason, you should work closely with your service bureau and commercial
printer before producing color publications.

•

The Define colors ... command and the Colors palette are the two main color
tools in PageMaker. The Define colors ... command is used to create new spot
or process colors, select colors from existing color libraries, and edit any
existing colors. The Colors palette is used to apply colors to elements in your
publication.

•

PageMaker 5 allows you to edit spot colors from imported EPS graphics, which
can save you time in production and avoid problems producing separations or
reproducing your documents.

•

There are several ways to move colors between publications. You can import
colors from other PageMaker publications or existing color libraries, and export
colors from your publication to color libraries .

••••••••••••••••••••••••••••••••••••••••••••••••
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Aldus
Additions
••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
•

Introduction to Aldus Additions

II Review of in-the-box Aldus Additions
D

Third-party Additions

•

Aldus Additions scripting lang uage

••••••••••••••••••••••••••••••••••••••••••••••••
It's tough being popular. With over 1 million people all over the world using PageMaker
for an incredibly diverse range of publications, it has become difficult (or impossible)
for Aldus to add the "right" new features to each new PageMaker upgrade. Everyone has
their own Top 10 list, depending on the type of publications they create. Designers
think PageMaker should have more graphic design features. Book and technical documentation producers think PageMaker needs more long document features. Office
publishers would love to have more built-in text editing capabilities. And large publishing
departments think more workgroup features would be the best area of improvement.
Of course, they're aJJ right- it's just a matter of perspective. Realizing that it alone
could not extend PageMaker far enough in every possible direction, Aldus has instead
turned PageMaker into something of an open system with its Aldus Additions technology. This means that anyone can add features to PageMaker in order to satisfy some
particular need or desire. The designers can add graphic design features, the technical
publishers can add long document features, and so on.
Did I say that anyone could add features to PageMaker? Well, that is theoretically true;
although practically speaking, the programming skill required to create a new feature
will probably stop most PageMaker users from doing so. Even if you don't want to do
your own programming, you can still benefit by adding features that others have
created to your copy of PageMaker. These might be features created by commercia l
software developers and then sold as PageMaker Additions, or they might be features
created by individuals and shared via user groups or on-line services. Aldus hopes that

H
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eventually there will be hundreds of different commercial, shareware, and public
domain Aldus Additions for you to choose from. And to get the ball rolling, Aldus
designers have written almost two dozen Additions that are included in the box along
with PageMaker 5. Later in the chapter, I'll review each of these Additions, plus a wide
range of commercially available Additions.

How Additions Work
The core of Aldus Additions technology is the fact that instead of controlling PageMaker
using only the existing menu commands, dialog boxes, tools, and keyboard equivalents,
you can now control PageMaker by sending it commands. These commands can be sent
by Addition modules that load into the Aldus Additions submenu, from scripts that you
write yourself or import into PageMaker, or by other stand-alone applications. Let's take
a closer look at each of these:
•

Loadable Additions. The Additions formats you'll use most often are loadable
Additions like those provided with PageMaker 5. These Additions must reside in
the Additions folder inside the Aldus folder (which normally resides in your
System folder). PageMaker checks for these Additions during start-up and adds
the name of each into the Additions submenu in the Utilities menu. Choosing an
Addition from this menu executes that Addition, which can bring up a dialog box
to present you further options or may immediately cause some action to occur.
All of the provided Additions are introduced in the next section of this chapter,
as are several commercially available loadable Additions.

Loadable Additions must be written in the C programming language. These
Additions can both send commands to PageMaker and query PageMaker to get
data about specific aspects of your publication. These capabilities make loadable
Additions more powerful than Additions scripts.
•

Scripts. Scripts are simple command sequences that you can write yourself,

much like the scripts used in HyperCard or AppleScript or any other macro
languages with which you are familiar. Each Additions script is a simple text file,
which can be created in a word processor, in the PageMaker story editor, or
right in a text block in the publications window. To execute scripts, you choose
the Addition called Run Script. .. from the Additions submenu and then select the
script you want to run. More information on writing scripts is provided later in
this chapter.
Additions scripts can send commands to PageMaker, but they cannot query
PageMaker to get information about your publication or the elements on your
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pages. Also, Additions scripts must contain all of the parameters needed by any
of the included commands, they cannot present dialog boxes to ask for command
options at the time they are run. These limitations mean that scripts can automate
any sequence of events that you could normally accomplish with PageMaker
commands, but they have less powerful potential than loadable Additions.
•

Stand-alone applications. Using Additions technology, another application can
also command PageMaker by sending Additions commands via the System 7
Inter-Application Communication feature. Applications can both send commands
to PageMaker and can query PageMaker and receive q uery responses.

Additions Technology
Aldus Additions provide a new way of controlling PageMaker (or more precisely, the
software code that makes up PageMaker), but they do so indirectly. The Additions
themselves do not talk to the PageMaker code: Additions send their commands or
queries into a special "Additions processor" module- called the Additions Interface
Manager - that now exists within PageMaker. The Additions Interface Manager
interprets the Additions' commands or queries, converts them into binary code that
PageMaker itself can understand, and then calls the appropriate PageMaker code,
technically known as either Action routines or Information routines.
This indirect method has both positive and negative implications. It is good in that it
isolates Additions from changes in the PageMaker code, so Additions will usually not
require updating every time PageMaker itself is updated, and it limits the chance for an
Addition to damage PageMaker files since they cannot directly modify PageMaker data.
The downside is that this scheme limits Additions' capabilities to only those things that
PageMaker itself can already do. In other words, in a strict technical sense you cannot
add new capabilities to Page Maker with Additions, but rather all you can do is automate
capabilities that could already be performed with some manual combination of existing
PageMaker commands. This can be tremendously useful and time-saving, as the
Additions discussed later in this chapter will demonstrate, but this structure does impose
technological limits as to what Additions can accomplish.
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Additions in PageMaker 5 _ _ __
The Aldus Additions are installed by the Aldus installer utility, as explained in Chapter
2, "System Requirements and Installation." You can select among the 20 included
Additions, or just install all of them, as most people do. When installed, the Additions
are copied into the Additions folder inside the Aldus folder. If you ever need to save a
little space on your hard drive, or if you want to speed up the loading of your copy of
PageMaker by a few milliseconds, copy any Additions you don't use out of the Additions
folder and into the trash. If you later discover you need the deleted Additions, just rerun
the Aldus installer utility.
If you've been using PageMaker version 4.2 before upgrading to PageMaker 5, you will
notice that some of the Additions aren't completely new. Balance columns, Display Pub
Info, Drop Cap, Make Booklet, Run Script, and Sort Pages are all holdovers. Both Drop caps
and Make booklet (now known as Build booklet) are significantly improved, however.
Following is a short summary of every Addition that Aldus ships with PageMaker 5.

Acquire image
This Addition implements a new universal scanner interface language called TWAIN,
which makes it possible for you to scan images directly from your scanner into your
PageMaker publication. Images are saved in the TIFF file format. It saves you the trouble
of having to first scan images into a scanning utility or graphics program and then place
them into PageMaker. The only limitation is that TWAIN isn't supported on most older
scanners, so unless you have a newer scanner (circa 1993 or later) or have received an
upgrade for your old scanner (probably in the form of a replacement ROM chip), you
probably cannot use this Addition.

Add con't line
In any newspaper- or magazine-style layout where stories jump from column to column
or page to page in irregular patterns, adding a continued on/continued from notice to
the break points in your story is very helpful to your readers. This Addition is meant to
automate the process of adding these notices, and it does a good job within its own
limited scope.
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To use the Addition, use the arrow tool to select a text block to which you want a notice
added and select the Add con't line Addition. (fhe Addition won't run if the text tool is
selected.) The dialog box shown in Figure 15-1 appears, and you can choose to have the
continuation notice added at the top or bottom of the text block. After you click the OK
button, the Addition determines the correct page number reference and adds a new
text block containing the "continued from" or "continued to" text just above or below
the text block you selected.
Figure 15-1:
The Add can't line Addition.
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u
[ Concel I

Continuation notice
@Top of t eHtbloclc

0

OK

Bottom of t eHtbloclc

When the "continued from" or "continued to" text is created, a new style sheet is
automatically created for this new text block. The style sheet has the same type attributes as the adjacent text block, plus the bold type style and before and after paragraph lines. You can edit the definition of this style sheet, of course, or manually
override the type style to apply any formatting you want.
Continued line text blocks are not linked to their adjacent text blocks in any way, so if
the text block moves, or if the text block they reference moves, the continued line is not
automatically updated. You will have to manually change the reference page number or
delete the continued line text block, if necessary.

Balance columns
This simple Addition, shown in Figure 15-2, is meant to save you the trouble (if you find
this sort of thing troubling) of figuring out how to get the tops or bottoms of two sideby-side columns even. To use the Addition, select any number of side-by-side text
blocks (with the arrow tool), choose the Balance columns Addition, and then select
among the Alignment and Add leftover lines options.
Figure 15-2:
The Balance columns Addition
evens out columns in your
layout.

Bolonce columns
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Griping about Additions
The noble cause of Aldus Additions, as I described at the beginning of this chapter,
is to allow third-party software companies and individual users to add specific features
to Page Maker that address needs that are not pervasive enough to merit their inclusion
in the core PageMaker feature set. The Additions that Aldus includes in the box along
with PageMaker 5, this theory would hold, are simply meant as examples, suggesting
to users the potential of Additions technology and showing commercial developers
what kind of features they could implement as Additions.
Unfortunately, the Additions that Aldus has provided are neither good examples of
Additions nor are they features that are really aimed at filling nonpervasive needs.
Rather, I find them to be shoddy examples of Additions technology (or any programming for that matter~ and primarily aimed at filling inexcusable · gaps in the core
PageMaker feature set There are a few exceptions: Build booklet is an extremely
powerful and well-implemented Addition, as are Bullets and numbering, the Library
palette, and Sort pages. Expert kerning and Edit tracks are aimed squarely at the needs
of professional typographers and not otherwise needed by most PageMaker users.
Running headers/footers is extremely useful within a rather strict set of situations. The
rest of the Aldus Additions are cheap, poorly implemented, shoddily designed workarounds. They're a stunning display of bad user interface, a ridiculous lack of user
~::ontrol, and pathetic atfempts to get cheeR marks in some feature comparison against
QuarkXpress in future issues of Macworld magazine.
Hopefully, third-party Additions developers w ill take a more serious approach to
Additions development. And Aldus itself should make major efforts to build core
capabilities into PageMaker itself, and if it intends to ship features as Additions, they
should be of the same quality as any other PageMaker features. If they aren't, Additions
are going to get a bad name and become just another forgotten technology. Lastly,
while I'm dreaming of a perfect future, Additions must be liberated from the Additions
menu and freed to be ·placed in any PageMaker menu (or even dialog box) as
appropriate. The idea that a whole bunch of unrelated commands should sit under one
submenu would be comical if we weren't all now forced to live with it everyday.
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Build booklet
Perhaps the most sophisticated of the Aldus-provided Additions, Build booklet is
nothing less than a miniature version of the Aldus $2,000 PressWise page imposition
program. Imposition, for those of you who d idn't complete your printing apprentic~
ships, is the process of arranging the pages of a publication into signatures so that
when printed, folded, and bound, the pages will wind up in the correct order. (An indepth look at Aldus PressWise is included in Chapter 19, "Aldus PrePress Tools.")
In order to use the Build booklet Addition, which is shown in Figure 15-3, you need to
know how your publication will be printed, folded, and bound. This can range anywhere
from a relatively simple procedure where you fold all the pages in half and then put a
staple through them, to a much more complex procedure (which would normally be
done by your printer) where 4-, 8-, or 16-page spreads are created, folded, cut, and
perfect bound.
Figure 15-3:
The Build booklet
Addition creates
simple signatures by
imposing the pages in
your publications.
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The benefit of electronic imposition, not surprisingly, is that it makes manual imposition unnecessary. Manual imposition is a difficult, slow, and expensive task- but one
that is necessary in order to produce most multipage publications. You might have
never heard of imposition before, even if you regularly create long documents, but that
doesn't mean you haven't been paying for it. By imposing your own publications before
they are imageset, you will probably be able to save considerable sums of money on
your printing bill. Of course, to do this you must talk to your printer and enter the
correct imposition options or else you will make things worse instead of better and
s pend more money, not less.
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Because the Build booklet Addition cannot impose pages from more than one publication (it ignores any book list you may have created), you will not be able to use it to
impose longer and mor~omplex publications. In that case, you should ask your
service bureau or printer to use Aldus PressWise to impose your electronic files before
they are imageset.

Preparing to use Build booklet
The Build booklet Addition automatically creates a copy of the current publication
when it is run, and it then performs the imposition in this copy. This leaves your
original file untouched, but it means you must be completely finished with your publication before performing the imposition. You should finish all final text and page editing
and create your index and table of contents, if necessary, before using the Build booklet
Addition. It is also a good idea to save your publication before choosing the Build
booklet Addition, and make sure that your hard drive has plenty of free space (usually
an amount equal to twice the size of the publication is sufficient).

Build booklet options
The first option in the Build booklet Addition is Spread size, which refers to the total
size of your imposed pages. This will usually be two, three, or four times the size of
each individual publication page. This Spread size option is automatically adjusted
when the Layout option is changed, but you may want to then make further adjustments to provide room for crop marks or other items. Remember, the largest page size
that PageMaker can support is 42 inches x 42 inches, and that is therefore the largest
Spread size that it can support.
The scrolling page list provides a single page icon for every page in the current publication. You can rearrange the page order in this list by holding down the Option key and
dragging a page to a new position. (Use the Shift key to select more than one page at a
time for any manipulation.) You can also insert blank pages, leaving space for pages
that will be manually pasted in later, or you can delete pages so that they will not be
included in the imposed signatures.
The Layout option is the most important, defining the specific way that the Build
booklet Addition will rearrange your pages. The None option is used when you want to
make a copy of the current publication without automatically imposing any pages
(perhaps so you can manually rearrange pages or change the spread size).
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Three other binding styles are offered by the Layout option:
•

Saddle stitch. A saddle stitch is the kind of binding you find in most magazines:
The pages are folded over and stapled or sewn together at its spine. This is also
the kind of binding most often used for office phone directories and other small
business booklets.
Saddle stitching is best used in smaller publications- perhaps fewer than 25
pages - because the thickness of the paper itself becomes an issue when folding
a larger number of pages. The Use creep option, discussed below, can help in this
situation, but in larger publications it will be necessary to use perfect binding.

•

Perfect binding. This is the kind of binding you find most frequently in books:
The pages are glued together into the spine.

W Consecutive binding. The consecutive binding puts two, three, or four pages
together onto new, larger pages to save paper or film during imagesetting. In some
cases, this repositioning can also be used to create multipanel brochure folds.
Another option in the Build booklet dialog box lets you add and specify creep, which is
compensation added to the space between two pages that makes up for the thickness of
your paper and the effect this paper thickness has on the bound publication. You can
see the need for creep yourself by taking 30 or 40 sheets of paper and folding them in
half- the ends of the folded papers will be fanned, and not flush, because the outside
sheets must travel further (around the thickness of the inside sheets) than the inside
sheets. If this paper thickness was not accounted for when pages are positioned, the
pages in a bound publication would gradually creep in and out as you moved from the
outside of the publication toward the center and then back to the outside. Creep values
should be provided to you by your printer. The Gutter space option is more direct,
adding space between pages in the signature. This directly affects the spread size and is
applied equally to all pages in the publication.

Bullets and numbering
This Addition inserts a bullet character or a number, and a tab, at the start of some
s pecified number of paragraphs. To use the Addition, set the text cursor in the first
paragraph you want to bullet or number and then choose the Addition. Five different
bullet character options appear by default, but you can select any character to use as a
bullet by clicking the Edit ... button. To add numbers instead of bullets, click the Numbers button and you can choose between various numbering schemes. Figure 154
shows one example.
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Figure 15-4:
A numbered list
created by the
Bullets and
numbering
Addition.

TOP 10 REASONS
TO KEEP USING
PAGEMAKER ...
1:

2:
3:
4:
5:

6:
7:
8:
9:

10:

Love of the Place ... command
Features, who needs feature s?
An inimate relation ship with the
grabb er hand
Two word s: Aldus Additions
I am Paul Brainerd's love child
The purple box
Distant cousin of Aldu s Manutius
They've almost got the 3.0 bugs out
Free su bscri ption to Aldus Magazine
Fred Ebrahimi

The Range option lets you specify the paragraphs to which your bullets or numbers will
be applied. Your alternatives are any number of sequential paragraphs, selected
paragraphs, paragraphs formatted with a particular style sheet , or every paragraph in
the story. When you click OK, the Addition moves through each specified paragraph,
adding the appropriate bullet, or number and then entering a tab character. The new
bullets or numbers are automatically set at the same type size and leading as the
paragraph into which they are placed. Figures 15-5 and 15-6 show the options you have
in choosing bullets or numbers.

Figure 15-5:
The Bullets and numbering
Addition lets you select
among several types of
bullets.

_Bu_ll_
et_s_a_
nd_n_u_m_b_
er_in..:.g_ _ _ _ (
Bullet styl e:

OK

J

[ Concel )

[ llulleh )
[Numbers)
[ nemoue )
[ Edit...

nonge:
® For nent:

EJ porogrophs

IBody t ent I

0

All tho se with styl e:

0
0

Euery porogroph In story
Only sel ected porogrophs

Chapter 15: Aldus Additions

Figure 15-6:
The Bullets and numbering
Addition lets you select
among several
numbering styles.
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[ Remoue)
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0

Euery pllrogrnph in story

0
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Create color library
This Addition helps you keep colors uniform between publications. This can be handy
when you do lots of work for a specific client, project, or company and want to maintain
color consistency. When run, the Addition skims through the open publication and
creates a new color library that includes all of the colors in the publication. This color
library can then be imported into other publications to ensure that the exact same
colors are used.

Create keyline
This Addition creates a box, or keyline, around text or graphic objects in your publication. This can be done as a design element or to trap the colors in adjacent objects.
Using the Addition, which is shown in Figure 15-7, automates the manual process of
creating boxes with the box tool and of course adds a level of precision it would be
difficult for you to duplicate by hand . The Addition provides three primary options,
plus the ability to set attributes for your keyline using the Fill and line dialog box.
Figure 15-7:
The Create keyline
Addition.
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As shown in Figure 15-8, the options in the Addition dialog box let you define the

positioning of the keyline relative to the outer boundary of the elements (this value can
be positive or negative in increments of l-loo point), whether the keyline object will be
positioned in front of or behind the existing object, and the ability to knock out the
keyline and define an overlap (trap) to that knockout. Clicking the Attributes ... button
allows you to set line and fill options for your keyline box.
Figure 15-8:
The Create keyline
Addition lets you define
an overlap (trap).
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Display pub info
This Addition, shown in Figure 15-9, is designed to prevent problems at your service
bureau by providing you with a complete list of the fonts used in your publication, the
availability of those fonts in your System Software, and any linked elements in the file.
Also, it produces a list of the style sheets you've used . You can review the publication
information on screen and save it to a text file to give to your service bureau along with
your publication file. Or you can print the text file (using your word processor) and
hand it to the service bureau when you place your output order.
Figure 15-9:
The Pub Info
Addition
provides
information
about your
publication.
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Display story info I Display textblock info
For the statistically inclined, these Additions, shown in Figures 15-10 and 15-11 , tell you
everything you could possibly want to know about a single text story or text block,
including the name of the linked file, character counts, pages on which the first and last
text blocks are positioned, number of overset characters (these are characters in the
story that do not appear on any page - it should usually be 0), and the total size of the
text blocks in which the story lives .
Figure 15-10:
The Story info Addition.
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Figure 15-11:
The Textblock info Addition.
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Drop cap
This Addition creates a drop cap in the selected paragraph by enlarging the type size of
the first letter in the paragraph and then lowering the baseline of that character so it
sits on the same baseline as the second or third line in the paragraph. Then, the Addition inserts tabs and line breaks to manually wrap the text in the second and third lines
around the newly positioned drop cap. Not elegant in any way, but ultimately effective.
Figure 15-12 shows a drop cap created with the Addition.
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Figure 15-12:
A three-line drop cap
created by the Drop cap
Addition.
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Beyond specifying the size of the drop cap you want to create, the Addition, shown in
Figure 15-13, also allows you to jump to the previous or next paragraph in the story in
order to also apply drop caps there (although consecutive drop caps are rarely a wise
decision), and it gives you a Remove button that will undo all of the smoke-and-mirrors
formatting that makes the drop cap illusion work in the first place. This is important
because if you have to edit the text in the first few lines of any paragraph where you
have created a drop cap, you'll find that the text formatting becomes a terrible mess if
you don't first r emove the drop cap, then perform your editing, and then re-create the
drop cap.

Figure 15-13:
The Drop cap
Addition.
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Old-fashioned drop caps
An old PageMaker trick for creating drop caps can still be useful even now that the
Drop cap Addition is available. This trick calls for placing a graphic as your drop cap
character and then using the text wrap feature to make it look like a drop cap. See
Figure 15-14 for an illustration.
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Figure 15-14:
A drop cap created by wrapping text around a graphic element.

----

------~----~-----There ~re three vvays to get y0ur droR cap character. N~rP,ber one: lm'p prt a premade drop cap from a dip-art collection. A number of companies proauce ornate
alphabet clip-art just for this purpose. Number two: Produce your own drop cap art in
your favorite graphics application. Number three: Turn a letter in your PageMaker file
into a graphic and use that as a drop cap. To do this, you'll need nothing more than the
Scrapbook desk accessory. (And you thought there was no real use for the Scrapbook,
didn't you?,)
·
Step 1. Cut the first letter of the paragraph to which you want to add a drop
cap to the Clipboard.
Step 2. Open the Scrapbook and paste the letter in as the first item in the
Scrapboo~.
<

,

't < '

Step 3. Now, close the Scrapbook arid choose the Paste command. ·
Step 4. Select the Scrapbook file (it is usually found in your System folder) and
click OK in the Place dialog box.
Step 5. The loaded placement cursor will appear with the scrapbook icon.
Position it roughly over the paragraph into which you wal'lt toinsert the
drop cap and click. You'll then have to choose the arrow tool from the
tool palette to get rid of the placement icon so you don't place other
graphics from your scrapbook.
Step 6. Manually reposition and resize the drop cap graphic, as necessary.
Step 7. Select the drop cap graphic ahd choose the·Wrap text comhiand from
the Element menu. Choose the center wrap option and click OK.
Step 8. Customize the graphic boundary that controls the text wrap as necessary, to get the look you want for your drop cap.
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Edit tracks
PageMaker's tracking capabilities, as describe in Chapter 9, "Formatting Text," allow
you to assign one of five different tracks to any font used in your publication. This
Addition lets you modify the default values of these five tracks, adjusting the amount of
space set between characters in a font at different point sizes. You can adjust tracking
for any font that appears in your font menu by using the Font pop-up menu in the upper
left corner of the dialog box. Edit tracks supports all fonts formats, including bitmapped
fonts, PostScript Type 1 and Type 3 fonts, and TrueType fonts.
The five current tracks for the selected font appear in the dialog box, as shown in Figure
15-15. Each track is plotted on the graph as the percentage change in character spacing
at each type size. You can adjust any of the tracks by dragging on the tracking handles
(white boxes) or by dragging the curve itself. If you want to add new tracking handles,
hold down the Option key and click anywhere on a tracking curve. If you want to adjust
one of the tracks from the keyboard, select the track you want to adjust and then press the
up- or down-arrow keys to move the curve up or down in J.1o-percent increments, or press the
left- or right-arrow keys to change the current point size in J.1o-point increments.

Figure 15-15:
The Edit tracks
Addition lets you
modify each of
the five tracks for
any installed
font.
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The Tracking Values file
Since tracking values are stored in the Tracking Values file, if you edit your tracking
values, you will have to send your Tracking Values file to your service bureau if you send
publications for output. (This is not necessary if you do not edit the tracking values.) In
this case, make sure the service bureau understands that they must place your Tracking
Values file in the same folder as your PageMaker publication file before they launch
PageMaker and print your file. (They do not want to copy your Tracking Values file over
the one in their Aldus folder because it will then be used on all files they open in
PageMaker.) If you want to avoid any chance of error w ith your modified Tracking
Values file, print your publications to disk as a PostScript file and then give that
PostScript file to your service bureau rather than the original PageMaker file. This makes
error impossible and means that you don't have to give the service bureau y our
Tracking Values file.

If you want to move the tracking curves from one font into another font, you
can do so using the standard Macintosh Copy and Paste commands. Select the
font whose tracking curves you want to copy and choose the Copy command
(Command-C). Then switch to the font where you want to paste those curves and
choose the Paste command (Command-V). This will replace all five tracking curves.
After editing the tracking values for a particular font, click the Save button. If you make
changes and try to select another font, you will be prompted to save your changes first.
Tracking curves are stored in the Tracking Values file, which resides inside the Aldus
folder. This file provides tracking values for all of your publications. If you want to
cr eate a set of tracking values that applies to just one publication or one set of publications, quit PageMaker, move a copy of the Tracking Values file from the Aldus folder
into the folder with the publication files you want to use with different tracking values,
r estart PageMaker, and open one of the publications from that folder. Then use the Edit
tracks Addition to make modifications. These changes will be saved to the copy of the
Tracking Values file that is in the same folder as the open publication.

Expert kerning
This Addition, using technology licensed from font designer URW, examines every
character pair in the selected text, removes all existing manual kerning, and then kerns
the type based on t he amount of "kerning strength" you specify. Your options in
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defining the kerning strength range from 0.0 to 2.0, with higher values resulting in
greater amounts of kerning and therefore tighter spacing between characters.
You can select any amount of text before choosing the Addition, even text that includes
multiple fonts and type sizes. Normally, you will not want to use this Addition to make
adjustments to large amounts of text, however, because it is not the most efficient
method for manipulating character s pacing. See the complete discussion of kerning and
character-spacing options in PageMaker 5 in Chapter 9, "Formatting Text," for more details.
After you select the text you want to kern and choose the Expert kerning Addition, the
dialog box shown in Figure 15-16 will appear. Enter the desired kerning strength and click
the radio button corresponding to the kind of font that is being kerned: Text, Display, or
Poster font. If not, then enter the type size, and the Addition will make assumptions.
Figure 15-16:
The Expert kerning
Addition automates the
process of kerning any
text.
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Find overset text
It is all too common in a PageMaker-produced publication to be reading along and
suddenly find that a text block ends before the story is finished, even though this is
supposed to be the last text block in the story. In other words, the end of the story has
been cut off. This happens because of the way text flows through PageMaker text
blocks, which sometimes means that last-minute edits cause text to flow in such a way
that one or more lines get pushed past the end of the last text block in a story. If this
is n't caught before the fina l publication is printed, an embarrass ing mistake winds up in
your printed document.
Th e Find overset text Addition helps prevent this by searching for text that flows past
the end of your stories. This text is called overset text, which, as you know, is indicated
in PageMaker by a downward arrow appearing in the bottom handlebar of a text block.
You don't have to first select anything to use the Addition; when the Addition is run, it
will find the firs t text block that includes overset text, select it, and turn to the page
containing that text block so you can correct the problem. Then choose the Addition
again, and it will find the next text block. Repeat this process until an Alert dialog box
appears telling you that no more overset text remains.
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To check if a particular story contains any overset text, select that story and choose
the Display story info Addition, which lists the number of overset characters that the
story contains.

List styles used
This Addition runs through the currently selected story and collects the names of every
style sheet used to format any paragraphs of that story. It then creates a new text block
listing each of these style sheets. The idea, I guess, is to make it easy for you to create
and print a list of your style sheets. In general, however, I don't see why you would want
to do this. If it listed the formatting attributes of those style sheets, it would be more
useful; but overall, this is a perfect example of my premise that the Additions Aldus
provides are largely silly and unprofessional.

Open stories
Another in the "Gee Whiz, But Who Cares?" series of Aldus Additions. This one opens
up to 15 stories from your publication in the story editor, so that you can easily start
editing them. If you have more than 15 stories in your publication, and you only want to
edit a few at once, you're out of luck, because you cannot select which stories you want
and don't want to edit. Then again, if you want to edit more than 15 stories in
PageMaker's story editor, you have much larger problems than this ...

Open template
This Addition too is more interesting for the capabilities it suggests than for those it
actually delivers. Open template, shown in Figure 15-17, creates new publications,
complete with custom page sizes, guidelines, and placeholder text, for 17 "popular"
document types, and it does so by running scripts written in the Aldus scripting language that describe the document to be created. The potential power in this is that by
saving publications in the form of scripts instead of in the form of PageMaker publication files, you get publications that are much smaller, easier to transport, and easier to
customize, if you know the Aldus scripting language.
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Figure 15-17:
The Open
template
Addition lists the
scripted
templates that
you can use to
create new
publications.
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The problem is that you cannot save your publications as this kind of template. The
Template option offered by the Save as command creates the same kind of template
used in earlier versions of PageMa.ker, which Is more like the Stationary Pad documents
offered in System 7. In other words, you save a normal PageMaker document that, when
opened, makes a copy of itself for you to modify.
Since you cannot create your own "scripted templates," you're left with the 17 that
Aldus has provided. These are mildly (very mildly) interesting, not particularly well
implemented, and may save you a few minutes if you happen to need a publication
exactly like one of the templates. In the future, someone will probably release an
Addition that lets you save your publication in this "scripted template" format and
maybe even a nice on-screen text editor that lets you modify these scripted templates
before you open them. Or perhaps someone will start selling other presaved templates
in this new and compact format. Until then, Aldus has another check mark on some
feature list, and you have plain-Jane cassette labels.

Printer styles
As the name suggests, this Addition provides style sheets for printing. But that's not all:

It also provides a print queue that can manage the printing of different publications, and
It gives PageMaker the ability to print a file information job slug after each print job.
When you choose the Printer styles Addition, PageMaker opens a new temporary
publication and a dialog box appears as shown in Figure 15-18. This dialog box is used
primarily for print queue management, and it assumes you want to print the currently
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open publication, placing that file at the top of t he print queue list on the right side of
the dialog box. To add documents to the print queue, select them from the listing on
the left side of the dialog box and click the Add button. To rearrange the order in which
files will be printed, use the Item up or Ite m down buttons; to delete files from the print
queue, use the Remove button. This works very muc h like the Book list dialog box, with
which you may be fa miliar.
Figure 15-18:
The Printer
Styles dialog
box used to
manage the
print queue
and assign
printer style
sheets.
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Applying, creating, and editing printer style sh eets
Each file you add to the print queue can be tagged with a printer style sheet to s pecify
the Print dialog box options for that file. To tag a publication, highlight it in the print
queue and then choose a printer style from the Current style pop-up list. The style
name you select is then placed in front of the publication name in the print queue, and
while the document remains selected, a list of the printer style sheet option settings
appears in the lower portion of the dialog box.
To create a new printer style s heet, click the Define ... button. This brings up the Define
printer styles dialog box, shown in Figure 15-19. Using this dialog box and its various
buttons and options is very similar to working with the Define style sheets dialog box
and the Define colors dialog box. Clicking the New button allows you to name a new
printer style sheet and then set options for that style sheet in a series of dialog boxes
that mimic the Print dialog box and all of its subsidiary dialog boxes . Figure 15-20 shows
a style being c reated. See Chapter 17, "Printing Publications," for a complete description
of each Print dialog box option.
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Figure 15-19:
The Define printer
styles dialog box.
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Figure 15-20:
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publications in
the print
queue, as
shown in the
list on the right
side of this
dialog box.

Printer Styles

les~ Publlcntlons

t

•I

D Moren Newsletter
D Northwest Rlr11nes Boycott
D Quotes Pub
~

~
~

D
D

Shipping DoH tmplt copy
Shipping Cnrton tmp l t
Tope Templote
Tester
The Costell o Collection

Style:

I

ToDi sk 2400dpl

I

= Dock Onto

u

Add

[
(

lll'llHIUl'
ltl'm up

~

1
)

[

l:,jl'C1

[

Desktop

)(

Print

H

Cl ose

1
1

ColorSeps QMS - Jonunry ... ~
Qulekl'roof - Mon:n News ...
Tolllsk 2400dpl - Northwe ...

llt<lm dou•n)

I Prof s...
I Define ...

)
)

'o

Prtlltr : Turbolastr/Or-..; T~po : Llnotronfo 6!0 v~2.! ; P19n: All; Orientation: Tall; P11>tr sfzo : Lttltr:
Coplt1: I; Scalt : 100~; Omit TlFF filn; Vrttt to fllt : ... <POO . location>:* .stp; Color :
Composftt/Gra~soalt; Oplfmlud sorttn : l>tfault

After you've saved all of your option settings, your new printer style sheet will be listed
in the Define printer style sheet dialog box. You can use the Edit .. . button tore-access
the Print dialog box and change any options in your style sheet, as necessary. Use the
Copy... button to duplicate an existing printer style sheet and begin editing that copy,
or the Remove button to delete an existing printer style sheet. When you've finished
creating or editing printer style sheets, click the OK button to return to the main Printer
style sheets dialog box.
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Job slugs
The Preferences ... button in the Printer style sheets dialog box brings up options,
shown in Figure 15-21, that allow you to add and customize job slugs that print after
each file in the print queue, and a queue log file that tracks and reports on the printing
of all files in the queue. The Include job slugs option causes a page of information
relating to the process of printing each of your files to print after the file is printed. You
can add or delete various pieces of information to this job slug using the provided
options. Similarly, the Create queue log option, when selected, creates a single file that
tracks the printing of each file in the queue. Again you can customize the information
this report contains by selecting or deselecting the available options.
Figure 15-21:
The Preferences
dialog box is
used to select
elements to be
included in the
job slugs and
the queue log.
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PS Group it I PS Ungroup it
As you have undoubtedly noticed, PageMaker lacks the ability to group and ungroup
objects. This causes a lot of inconvenience when you want to move or modify several
objects together.
The PS Group it and PS Ungroup it Additions are essentially "software work-arounds"
for PageMaker's Jack of standard Macintosh Group and Ungroup commands. The PS
Group it Addition works by deleting any objects you have selected before choosing the
Addition and then r eplacing the objects with an encapsulated PostScript (EPS) copy of
those objects. This EPS copy will look exactly like the original objects and can be
moved, resized, and otherwise manipulated as a single object. This is very useful for
elements that must r emain in the same relative position to each other, such as the rules
shown in Figure 15-22. The PS Ungroup it Addition does the opposite, deleting the EPS
copy of the original elements and replacing them with the original elements themselves.
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Figure 15-22:
You can tell
t hese lines are
g rouped by
the placement
of their
selection
handles.

Choosing the PS Group it command forces PageMaker to execute a Save
command, thereby automatically saving all changes you have made to your
publication. When objects are grouped by PS Group it, and in the EPS format,
you cannot edit the content of the objects in any way. A new file, with the
filenan1e extension .PMG, is saved into the same directory as your PageMaker
file and must not be deleted if you want to be able to use the PS Ungroup it
Addition. Also, if you transfer your publication to another location for printing,
you'll have to take the .PMG file along as it will be linked to your publication
and required for high-resolution printing.
Because the EPS format can be printed accurately only on a PostScript printer, you will
be alerted if you attempt to print a publication that contains any PS Grouped elements
on a non-PostScript printer.

Running headers and footers
This Addition performs the fairly complex and useful task of creating unique running
headers or footers for all of the pages in your publication based on some speci£ic text
on each page. It is a good example of automating an otherwise endlessly repetitive task,
and it provides a range of options that allow you to create running headers and footers
to suit even the most complex needs. Figure 15-23 shows the dialog box.
To use this Addition, you must £irst select, with the arrow tool, a story that is threaded
across all of the pages of your publication. Then, choose the Addition from the Additions submenu.
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Figure 15-23:
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The Running headers \ footers dialog box then appears, where you must specify the
following options:
•

Fmd. This option specifies the style sheet on which the running header or footer

will be based. You specify whether you want the running header or footer based
on the first or last instance of a specific style sheet, and then you choose one of
the style sheets in your publication from a pop-up list. If you choose a style sheet
that does not exist on a particular page, then the header or footer carries forward the previous occurrence of that style sheet.
If you want to find something other than the first or last occurrence of a particular style sheet, click the Edit .. . button and you can define your search criteria, as
described late r in this section.
•

Insert. This specifies the text you want inserted as the running header or footer.
You can select among 11 different options that take some portion of the text
from the specified paragraph (First word, Entire paragraph, First three letters,
etc.) and make that text into your running header or footer.
lf none of these options is adequate, click the Edit. .. button and define your own

text insertion formula, as described later in this section.
•

Left pages and Right pages. These options determine the location where you
want the running header or footer placed. (Only the Right pages option is
available when your publication does not display facing pages.) The running
header or footer is creat ed as a new text block, placed at the location you specify
here. All measurements are taken from the upper left corner of the page, where
the ruler zero point is normally positioned. The new text block is formatted using
the style sheet you specify.
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Be careful that the location you specify for your running header or footer
doesn't overlap any other text blocks on your pages. If by some unfortunate
coincidence there is an overlap, and both text blocks have the same style sheet
applied to them, the Addition may delete the wrong text block when the
Remove existing headers/ footers option is selected.
To specify a custom search or custom insertion text, click the Edit ... button. This brings
up the Create custom content dialog box, as shown in Figure 15-24. Using the command
characters listed below, you can use this dialog box to define intricate search or
insertion patterns. Unfortunately, these command characters, and the sequence in
which you must use them in order to make them work, are so cryptic that you really
have to spend some time understanding these commands and doing some trial-anderror work in order to use them.
Figure 15-24:
The Create custom
content dialog box,
where you can get
hopelessly confused
trying to customize
search or insert settings.
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The commands used to customize Running headers and footers:
Command

Result

?

Any single character (except a line break)

<

The beginning of a paragraph

>

The end of a paragraph

@

0 or more occurrences of the preceding pattern

+

1 or more occurrences of the preceding pattern
0 or 1 occurrences of the preceding pattern
Either the preceding or the following character or text pattern

0

Any one of the characters listed within the brackets

\

The literal text pattern character following the backslash
The list of ASCII characters between the two characters before and after the dash

0

Groups of symbols or characters
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When you click the OK button, the Addition will proceed from the first to the last page
in your publication, adding new running headers or footers as specified. This will take a
few moments. During the process of creating the header or footers, a new file is added
to your hard drive: a .HDR file that is placed in the same folder as your publication to
record the position of the running header or footer. If you use the Edit. . . button to
create a custom search or insertion, a second file called HEADERS.INI is placed into
your Additions folder to track your custom command characters.
The running headers and footers this Addition cr eates are not linked to the text in your
publication, and so they are not automatically updated to reflect any changes in the
content or placement of your text. This means that you should not run this Addition
until the body of your publication is complete, or if you do run it earlier, r erun it to
collect the final correct data just before you save your finished publication before
printing. When you do this, be sure to use the Remove existing headers/ footers option.

Sort pages
This Addition, which has not changed since it was introduced along with PageMaker
4.2, allows you to r earrange the order of the pages in your publication. The Addition
produces a dialog box that displays thumbnail versions of each page in your publication. You can then drag any page to any new position. After pages have been rearranged, a new page icon appears under the thumbnail image to reflect the new page
number. The old page number- from before the Sort pages Addition was opened remains visible but is dimmed to differentiate it from the new page number.
If you're using the Facing pages option, facing pages are normally selected
together, but if you hold down the Command key, you can select and move just
one page at a time. If you want to insert a page (or a pair of facing pages)
between two other facing pages, hold down the Command key while you drag
the page into position.
To zoom in on the thumbnail pages, click the magnifying glass icon or press
Command-period. To zoom out, click the reduction icon (magnifying glass with
a minus sign) or press Command-comma.
Normally each page in the dialog box appears as a gray thumbnail, but you can see
details of the pages by clicking the Options ... button and then turning on the Show
detailed thumbnails option. Not surprisingly, it takes PageMaker a lot longer to draw the
detailed versions of the page than the gray versions. If you don't want to turn on the
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detailed view for all of your pages, select any individual page or pages in the dialog box
(use the Shift key to select multiple pages) and then click the Details button to see
details on the selected pages only.
When you click the OK button, the Addition does the actual work of switching the pages
around. U you can click the Cancel button, the Addition closes without implementing
your page sorting changes.

Traverse text block
This Addition, shown in Figure 15-25, adds a simple navigation capability to your text
blocks, making It possible for you to jump from the current text block to the next or
previous text block in that story or the very first or very last text block in that story.
Figure 15-25:
The Traverse textblocks
Addition lets you quickly find
the next or previous, or first or
last, text block in a selected

story.

Trnuerse teHtblocks

0

First In story
0 Preufous teHtblock
® NeHt teutblock
0 Lost In story

n OK

•

[ Concel ]

Third-Party Additions
In the long run, it will be third-party Additions that make or break Aldus Additions
technology. Remember, the idea behind Additions is that they free Aldus programmers
to spend their time adding core features to the product and allow third parties to add
specialized or vertical market features. So what have those third-party companies
produced so far? The following is a look at a few of the best third-party Additions
products that were either shipping or in development when PageMaker 5 itself was
released (August 1993).
Undoubtedly, more Additions will be available in the months and years ahead.
To get a complete Jist of current Aldus Additions, call the Aldus Developers
Cooperative at 800-685-3547, which will be happy to send you a complete list or
catalog at no charge.

Zephyr SmartAlign w /SuperSnap
Zephyr Design (206-324-0292)
This Additions combo lets you quickly and accurately adjust the positioning of objects
in relation to each other and to their surroundings in your publication. SmarWign
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provides the most robust alignment dialog box I have seen in any Mac program. (See
Figure 15-26). You have total control over both the alignment a nd the distribution of
selected objects both horizontally and verticaJiy. In Addition to the 16 alignment
combinations, the ability to distribute objects, eithe r within a new alignment, within the
existing boundaries of the selection, or with some fixed amount of space, is an extremely useful capability.
Figure 15-26:
The Zephyr
SmartAiign
Addition provides
great control over
element alignment
and distribution.

Align & Distribute oddltlon

I(

~

(Cancel

m0~
~~
~~
~~

0~[1!)~-~llgn
~!Em
0

OK

00 11@) -

I

Distribut e

)

J

Uertlcol

0

Distribute within bounds
® Distribute fiHed omount
Spoce:

111.00

I(In)

Horiz ontal

0

Distribute w i thin bounds
® Distribute fiH ed amount
Spoce:

11.00

I(In)

Oo mlnl-soue (slow)

Zephyr SuperSnap adds a new menu command labeled "ZAP" to your menu bar, which
controls the floating SuperSnap palette. (Zephyr plans to use the menu to support
future Additions as well.) SuperSnap lets you nudge objects, snap objects to ruler grids,
snap objects to gridlines, or snap objects to other objects on your page, as shown in
Figure 15-27. Or instead of snapping objects by moving them, you can switch the
SuperSnap palette into resize mode and make the edge of an object snap to a ruler grid,
gridline, or another object by being resized.
Figure 15-27:
The Zephyr SuperSnap floating
palette.

The SuperSnap palette lets you decide what part of the selected object is snapped with
its own proxy, which works just like the proxy in the control palette. (See Chapter 13,
"The Control Palette," for a detailed introduction to the proxy.)
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UPC-EAN BarCode, POSTNET Bar Code
Azalea Software (206-937-5919)
If you need postal bar codes for your business or publishing work, these Additions from
Azalea will be a welcomed addition. (No pun intended.) They create EPS format bar
codes for product labeling or postal sorting and place them into your publications.
Azalea UPC-EAN BarCode Addition creates version A, version E, EAN-8, EAN-13, and
ISBN bar code symbols in an EPS format that can be put into the design. The POSTNET
bar code Addition creates the kind of bar code that encodes ZIP codes on mail, saving
you time and money, especially when creating business reply mail pieces. Finally, if
these Additions don't satisfy your bar code needs, you can also contact Azalea and buy
a bar code font that lets you create bar codes in any Macintosh application.

Sundae Software
(800-398-5050)

Several separate Additions are currently available from Sundae Software. Here's a quick
rundown:
•

Baseline Grid sets up a grid on a selected box on your page, which is an ideal
way to keep track of the contents, orientation, and spacing of your text, much in
the way ruled paper does. More importantly it also creates a baseline that keeps
all columns perfectly lined up with each other. The dialog box provides a
plethora of choices regarding the placement and spacing of the lines. Once I had
completed placing all my text and graphics, I could remove the baselines altogether. PageMaker supposedly has a process for creating baselines, but it was so
convoluted - a detailed process that involved traversing four dialog boxes
repeatedly- that I could never get it to work like this $29 Addition.

•

Gridzoid is best for creating forms or templates for items such as labels. It
creates a rectangular grid on which you can place any number of evenly spaced
horizontal and vertical lines. You enter the dimensions of the rectangle as well as
the number of horizontal and vertical lines you want within the grid. You can't
space out the lines unevenly in the dialog box, although lines can be deleted or
added in the grid that this $39 Addition creates.

•

Safari goes further down the path of grid complexity. It can create uneven grids

or remove all gridlines from a publication at once. This Addition will create
gridlines, horizontally and/or vertically around all objects or around selected
objects in a publication. You can place or remove vertical and horizontal guides
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separately or work on both kinds of guides at once. For perfect alignment
between objects, I can imagine this $29 Addition working very well with Zephyr
Design's SmartAlign.
•

Marksmaker is a must for anyone doing more than basic work with service
bureaus. This $79 Addition places printer's marks, including crop and registration marks, guides, and color ramps on film for printing. Although PageMaker
itself does do this as well, it still doesn't recognize that film sheets rarely, if ever,
correspond exactly to a publication's pages. Marksmaker lays out the pages of
the publication onto the specified sheet of film, saving setup charges for users
and time for service bureaus.

PMproKit
EDCO Services (813-962-7800, 800.523-8973)

This $149 collection offers seven well-implemented Additions. A few of them were
intended for PageMaker 4.2 and offer features now included in PageMaker 5, but the
remaining capabilities are well worth the package cost. Figure 15-28 shows two of the
features.
•

Distort Type. This Addition quicldy expands or condenses selected type to the
width of another type size. You can then, for example, set type that is 18 points
high but only 15 points wide.

•

KemingPairs. This kerning tools lets you add, delete, and modify automatic kern
pairs while in PageMaker. The kern pairs take effect immediately and can be
saved as part of the screen font.

•

Rotate & Merge Text. You can select text and a horizontal or vertical line; the
text will be condensed or stretched to fit the length of the rule and moved to the
line. If you select a vertical rule, the text is rotated.

•

Pica Gauge. Allows you to move any object, including text blocks, to any position within the page; or to reduce, enlarge, or distort the object to an exact size.

•

Set Up Columns. Provides three options for setting up column guides: number of
columns, relationship of columns to each other, and absolute column width.

•

Ruler. Allows you to draw horizontal, vertical, or grid pattern sets of rules.

•

Tab Text. Establishes tab settings based on the width of the text lines, based on
the longest text line in each column.
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Fig ure 15-28:
The Distort Type
and Pica Gauge
Additions are part of
the PM Pro set of
Additions from
EDCO Services.
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Framz Proportional Borders
ShadeTree Marketing (602-279-3713, 800-678-8848)

This $99 Addition provides a set of 101 stylized borders that you can place around any
text block or graphic element in your publication. (See Figure 15-29 for a sample.) Many
of the available frames a re based on straight-line or box patterns, but there are also a
few whimsical frames, s uch as running feet. If the default set of 100 borders is not
enough for you, a second set of 100 frames is also available.
Figure 15-29:
The Framz Addition
provides 100 stylized
borders for use around any
object in your publications.
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Additions Scripts _ _ _ _ _ _ __
If you cannot find the perfect Addition to automate your use of PageMaker or add that
missing feature, you can turn to the Aldus Additions scripting language and try to write
your own PageMaker feature or automation. The language is extremely simple. It
consists of both commands (which tell PageMaker to perform some action) and queries
(which ask PageMaker for information about the current document or elements in that
document). It does not have many features you would find in a true programming
language, like variables, data structures, branching, or conditional structures. It just has
very simple commands and queries and a basic structure for passing parameters.
You can use the Additions scripting language to write scripts that are run using the Run
Script... Addition that is included with PageMaker, or you can write scripts that are
communicated to PageMaker via System 7 Apple Events from another application like
HyperCard or another Apple Events compatible language like AppleScript or UserLand
Frontier. Scripts run using the Run Script... Addition are called internal scripts and are
limited to using commands only; they cannot use queries. Scripts that will be run via
Apple Events are called external scripts and can use both commands and queries. Also,
the environments that support external scripts, including HyperCard, AppleScript, and
Frontier, usually provide branching and conditional structures, which can be teamed up
with the Additions scripting language to create very powerful scripted solutions.
In order to write Additions scripts, you need to get a copy of the Script Language Guide from Aldus. This manual is free if you return the request card
included in your PageMaker 5 box. If you don't have this card, you can buy the
book from Aldus for $35- call Aldus Customer Relations at 206-622-5500.
The Script Language Guide documents every command and query in the Additions
scripting language, as well as all of the parameters each accepts or returns. As with all
of the Aldus documentation, it is nicely produced, factually complete, and somewhat
short on the details of real-world implementation. If you have never used a macro or
scripting language before and don't have a programming background, a good first step
to working with the Additions scripting language would be to learn HyperTalk (the
programming language used by HyperCard) or AppleScript (the scripting language for
Apple Events). These are quite similar to the Additions scripting language, and there are
many good beginning programmer books and classes you can take to learn them. Once
you get the hang of these, you'll be able to teach yourself to write both internal and
external scripts in the Aldus scripting language quite easily.
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J.Habla usted parameters?
If you think I've shifted into another language, don't worry. This programming stuff
isn't nearly as hard as the real computer nerds want you to think it is. A command or
query is just a word that PageMaker will recognize and know how to act upon, and a
parameter is just a fancy term for the options that go along with commands. The
command to draw a line, "Li ne", needs parameters for the starting and ending points
of the line you want it to draw. These are expressed as x1 y1 x2 y2. To draw a line from
the ruler point one inch down and left from the upper left comer of a page to a point
one inch down and right from the upper right comer of a page, the command and
parameters you would need to send would be "Lin e (1i, l i l ( 7 i. li) ."
A complete script, which in this case converts a fraction into a typographer's
fraction, looks like this:
redraw o f f

text select -word
typeoptions 80,58 , 33,0
position subscript
textcursor -char
textselect 0
textenter "/H
textcursor -char
textselect -vJOrd
typeoptions 80, 58 , 33 , 0
position superscript
textcursor +\o:ord 2
position nonnal
redraw on
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••••••••••••••••••••••••••••••••••••••••••••••••
Summary
•

Aldus Additions make PageMaker extensible, allowing third parties or end users
to add new automation, features, and capabilities to suit their needs.

•

There are three kinds of Additions: Loadable Additions are written in the C
programming language, are placed in the Additions folder inside the Aldus
folder, and appear in the Additions submenu; Scripts are simple command
sequences that work much like macros or HyperCard scripts to drive
PageMaker commands and options; Stand-alone applications can also run as
Additions using inter-application communications to send commands and
queries to PageMaker.

•

More than 20 loadable Additions are provided with PageMaker 5. Many of
these are minor and unimportant, but several provide great new capabilities,
including Build booklet, Running headers\footers, Edit tracks, and Printer styles.

•

New Additions from third-party companies should prove to be the real benefit
of Aldus Additions technology. You can get a catalog of all currently available thirdparty Additions by calling the Aldus Developer Cooperative at 800-685-3547.

•

If you want to learn to use the Aldus Additions scripting language, you'll need
the Aldus Script Language Guide, which is available free from Aldus when you
register your copy of PageMaker 5. You can also purchase one from Aldus by
calling 206-622-5500 .

••••••••••••••••••••••••••••••••••••••••••••••••
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Long
Document
Features
••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
•

Using the Book command to link multiple publications

•

Creating a table of contents

•

Indexing your publications

•

Managing externally stored files

••••••••••••••••••••••••••••••••••••••••••••••••
The vast majority of PageMaker's capabilities work equally well on any kind of publication, from advertisements to brochures to newsletters to magazines to catalogs to
newspapers to books. But long documents have some production requirements that
shorter ones don't, like indexes, tables of contents, and a need to car efully manage
externally stored text and graphic files. These are the subjects of this chapter.

The Book Command
The core of PageMaker's long document capabilities is the Book... command, which
allows you to create logical connections between separate PageMaker files. Once you
do this, you can index, create a table of contents, or print multiple PageMaker files as if
they we re one large document. This means you don't have to create long documents as
a single PageMaker file, but rather can break them down into a series of more natural
and manageable publications while retaining the a bility to perform operations across all
parts of the final document at once.
Specifically, you use the Book ... command to create an ordered list, called the book list,
of the PageMaker files associated with your final document. Then, when you use the
Create index ... , Create TOC ..., or Print. .. commands you can apply them to all of the
files in your book Jist at once. (From here on I'll use the word "book" to refer to the final
document, but it could be any large document that spans more than one PageMaker file
- including technical documentation, magazines, or anything else.)
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How to build a book list
To build a book list, choose the Book ... command from the File menu. The Book
publication list dialog box then appears. On the left side of this dialog box is a list of the
folders and files on your hard drive, and on the right side is the publication's book list.
Files in the book list appear in the order in which they will be printed, indexed, and
added to the table of contents. If you are using the auto renumbering option, the order
of your book list also affects your page numbering.
To add a PageMaker publication to the book list, locate it in the left window and select
its filename (use the Desktop button and folder bar to navigate your d rives, if necessary). Then click the Insert button or double-dick on the filename. The selected publication will then appear in the book list. Normally the last file in the book list is selected
automatically so new files are added to the end of the book list. If you want to add a new
file to a specific location in the book list, select the file just above where you want the
new publication to appear befor e you click the Insert button. Continue selecting files
from your har d drive and adding them with the Insert button until you have completed
your book list.
If any files accidentally get added in the wrong order, or if the order in which you plan
to use the files changes, you can rear range the list by selecting a filename in the Book
list and then clicking the Move up or Move down button. You can also delete files from
the book list using the Remove button. It is very common to have to remove files from
the book list and then replace them with newer versions of those files that have slightly
different file names.
When the book list presented on the right side of the dialog box is correct, click the OK
button to close the Book publication list dialog box and save the book list. You can now
use the Create index ... , Create TOC ..., or Print entire book option, and all publications
in your book list will be affected. Details on using each of these commands acr oss
multiple publications are provided later in this chapter.

When to build a book list
Since the Create index ... , Create TOC ..., and Print ... commands (when used on multiple
publications) are all dependent on the book list, it is important to d ecide in which
publication you will create your book list. Generally you' ll need to create it in the
publication in which you intend to lay out your index or table of contents, or in the
publication from which you want to print all of the files in your book. Your index and
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table of contents are not likely to be in the same publication, although it is likely that
you will print from the file containing the table of contents, so you'll have to create the
book list at least twice if your publication has both an index and a table of contents. If
you want to use the book-printing feature from a chapter other than the one containing
the table of contents, then you may need to create the book list a third time as well.
Once you create your book list, you can send it to each of the other publications in the book list. To do this, hold down the Command key and choose the
Book. .. command. A dialog box appears, documenting progress as the list is
transferred into each publication. If any of these publications have existing
book lists, they are overwritten by this process without warning. When the
transfer is complete, the Book publication list dialog box appears, at which
point the book lists are synchronized and you can close the dialog box by
clicking OK or Cancel.
Exporting the book list to all of the publications in your list allows you to build
a table of contents in any publication (although you'll usually only want to do
this in one specific publication) and use the Print entire book option from any
file in the book. Most importantly it is vital to the process of creating a complete index. This hidden export feature was built into earlier versions of
PageMaker , too, and it is unclear why it wasn't "unhidden" and added as a new
button in the Book publication list dialog box in PageMaker 5.
Since book lists are not automatically sent to every publication in the book list, there
are a few book list tricks you can do. The first is that you can use one file in many
different book lists. You may, for example, have a one-page disclaimer that you include
in all your publications. It doesn't matter if that same file is included in the book lists of
10 different publications, it will always be included in the table of contents, index, and
book printing. You can also use the Book ... command to chain-print a group of entirely
unrelated publications. Do this by simply opening the first file you want to print and
using the Book ... command to build a book list of all the files you want to print. Then
choose the Print ... command and select the Print entire book option before clicking OK
to begin printing.

Page numbering in long documents
When printing the sequential publications in a book, you'll normally want PageMaker to
automatically r enumber the pages of each publication to reflect the count of pages in all
preceding chapters. To do this, you must choose the Auto r enumbering option in the
Book publication list dialog box.
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In some cases, however, you may not want to automatically renumber every publication
in your book. You might want to number the front matter sequentially using lowercase
roman numerals, for example, and then restart the actual text of your book at page 1. To
do this, set the page number style (in the Page setup dialog box) to lowercase roman
numerals in all of the files that contain front matter. Then in the first publication after
the one containing the front matter, select the Restart page number option in the Page
setup dialog box, shown in Figure 16-1, and set the page number style option to standard numbering. You'll want to make sure that standard numbering is selected in all of
the other files in the publication too. Then choose the Auto renumbering option in the
book list dialog box, and you're ready to print.
Figure 16-1 :
The Restart page
numbering option in
the Page Setup dialog
box and the Auto
renumbering option in
the Book publication
list dialog box team up
to let you create the
proper page sequence
for your publications.
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Page number prefixes
If you want to include a prefix before the page numbers in the publications of your book-

to indicate the book chapter or section -you can do so by typing the prefix in front of the
page number placeholder on the master pages of each publication, as shown in Figure 16-2.
This can be done in conjunction with the Restart page numbering option or without using
that option. A book divided into sections might have each page number in section one
begin with the roman numeral I (as in 1-1 , l-2, etc.) and then have each page number in
section two begin with the roman numeral II (as in 11-17, 11-18, etc.).
Figure 16-2: Adding a prefix
to the page number placeholder on a master page.

!...... . .... . . . .... . . . . .....
IV-LM
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Alternatively, you might want the pages of your publications to be numbered without
any prefix, but you find it useful to add a prefix to references to those pages when they
appear in the index or table of contents. These prefixes may be chapter numbers, section
numbers, issue numbers (when compiling a compilation index of older publications), or
any other identifying text. To do this, open each publication, choose the Page setup command, click the Numbers ... button, and then enter the prefix you want to appear into the
TOC and index prefix option, as shown in Figure 16-3. Save and close the publication.
Figure 16-3:
The Page numbering
dialog box provides the
TOC and index prefix
dialog box.
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Table of Contents
In any document more than a few pages long, the table of contents is probably the most
important page in the work. The table of contents provides your readers with a quick
overview of your document, as well as helping them to quickly locate sections of
particular interest. You probably haven't seen too many magazines, newspapers, or
nonfiction books that didn't include a table of contents. Even shorter documents like
newsletters and business reports can benefit from a table of contents - because if you
let your readers know "what's inside" and where specific information is located, they
are far more likely to read the material than if they have to figure those things out for
themselves. Yet many desktop publishers fail to add this important information to their
documents either because they forget or because they think building a TOC would be
too tedious.
In PageMaker, adding a table of contents is very easy. Just mark the text throughout your
publication that you want included in the table of contents - usually paragraphs that
are chapter names or major headlines -and then use the Create TOC ... command to
gather copies of these pa ragraphs together, along with the page numbers on which they
are placed, into a new text story that you can position anywhere in your publication.
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Marking TOC paragraphs
To tell PageMaker that you want a specific paragraph included in your table of contents,
position the text cursor in the paragraph, choose the Paragraph ... command (CommandM) from the Type menu, and select the Include in table of contents option, as shown in
Figure 164. Click OK to close the dialog box. Then repeat this procedure to mark each
paragraph i every publication in your book list that you want in the table of contents.
Figure 16-4: The
Paragraph
specifications
dialog box
contains the
Include in table of
contents option.
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If you use style sheets to format your documents (and after reading Chapter 10, "Style

Sheets," who could resist?) , you can build a good table of contents without manually
setting this option in every paragraph: Just change the definitions of the style sheets
used to format the paragraphs that should be in your ta ble of contents (chapter titles
and major headlines) so that the Include in table of contents o ption is selected.
To do this, choose the Define styles command (Command-3) and select the first s tyle
used to format paragraphs that should be in the table of contents. Click the Edit button,
then click the Para ... button, then select the Include in table of contents option. Click
OK twice to return to the Define styles dialog box if you want to modify other style sheets,
or hold down the Option key and click OK if you want to close all open dialog boxes and
return to your publication window. Both dialog boxes are s hown in Figure 16-5.
Of course, it is best to apply the Include in table of contents o ption in all appropriate
paragraphs when the style s heets you use are firs t defined. This ensures that it will be
applied correctly to all the different files that make up your book. If you have already
formatted your entire book, however, and need to modify the style sheet definitions to
add the Include in table of contents option, you only need to do this in one chapter and
you can then move these updated s tyle s heet definitions to all of the other chapters in
your book. Do this by opening each publication, choosing the Define s tyles (Command-3)
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Figure 16-5: The
Define Styles and Edit
Styles dialog boxes.
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command, and then using the Copy button to import the modified style sheets. Be sure
to do this for each file in your book list or you will wind up missing the table of contents
entries from the publications you forgot.

Creating the TOC story
After marking your table-<>f-contents entries, open the publication in which you want to
lay out the table of contents. (Of course, if you are creating a table of contents for a
document that is fully contained within a single PageMaker file, then no use of the Book
command is necessary.) Select the Create TOC .. . command from the Utilities menu, and
the dialog box shown in Figure 16-6 appears.
Figure 16-6 The Create
table of contents dialog
box.

n

Create toble of contents
Tille: lwhot's Inside

OK

,

[ Concel ]

0

llt>pllu:!! CBi~tlnq tnhlt.> ol euntonh
18] 1nclude boolc publications
Format:

0
0

No page number
Page number before entry
® Poge numb er after en try

Between entry and poge number:

~

The options in this dialog box determine how PageMaker scans your publications to
gather table of contents entries, and how it formats the page numbers that it adds next
to each entry.
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These options include:
•

Title. The title you enter here will be placed at the top of the new story that is
created to hold your table of contents. You can enter any title you want or leave
the default title of "Contents." It doesn't really matter what you enter here ,
because you will be able to edit this title after the table of contents has been
generated .

•

Replace existing table of contents. If the file you are working in already contains
a table of contents, the Replace existing table of contents option will be automatically selected. rt you deselect this option, you will create a second table of
contents. You'll generally want to leave it selected , so the new table of contents
replaces the existing one. When you replace an existing table of contents in this
way, any manual editing you have done to the existing table of contents will be
lost. (As you will see later in this chapter, you will manually edit the table of
contents for a variety of reasons.)

•

Include book publications. If your document does include several different
PageMaker publication files, and you have used the Book command to build a
book list, the Include book publications option is selected by default and table of
contents entries wiiJ be collected from all PageMaker files in the book list.
Deselect this option if you want to create a table of contents that contains only
entries from the current file, ignoring other files in the book list.

•

Fonnat. This option determines where the page number is placed in each table
of contents entry. The No page number option creates a table of contents that does
not include any page number references; the Page number before entry option places
the page number at the beginning of each entry in the table of contents; and the
Page number after entry option places the page number at the end of each entry.

•

Between entry and page number. This option determines what is placed
between the entry and page number on each line of the table of contents. The
default setting is "t, which inserts a single tab between the entry and the page
number. Other possible settings are shown in the following table.

Frequently used delimiter characters and the keys that produce them:
Character

Keys

White space

11

wor 11 W

Tab

11

t or 11T

Em space

11

m or 11 M

En space

II>

Thin space

II<

En dash

II=

Em dash

11

_ (underscore)
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After setting the options in the Create table of contents dialog box, click the OK button
to begin the actual compilation or click the Cancel button to return to the layout
without generating a table of contents.

Placing the table of contents
After PageMaker gathers all of the table of contents entries, a loaded text placement
icon appears just as if you had imported a new story with the Place command. (Unless
you were in the Story editor when the Create TOC ... command was chosen, in which
case the table of contents will appear as a new story window.) Place the table of contents like any other story, positioning the text placement icon between existing column
guides before clicking the mouse or drag-placing to create a custom-sized text block.
Once in position, the table of contents text may be edited freely, using either the text
tool or the story editor. Frequently you 'II have to edit some of the text because it is too
long, or you may get a few paragraphs that don't belong in the table of contents and
need to be deleted. You're also likely to want to modify some of the formatting for your
table of contents, but don't do that until you read the next section of this chapter,
which introduces TOC style sheets. Figure 16-7 shows a placed table of contents.
Figure 16-7:
A placed
table of
contents.

VIA '94

CONTENTS
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Another thing to keep in mind about editing the table of contents is that you'll usually
have to rebuild the table of contents several times as you create your publication,
unless you have far more will power than I do and an actually wait until you are really
finished before doing it for the first time. PageMaker gathers table of contents entries as
they exist when the Create TOC ... command is chosen, but that table of contents
remains accurate only until you edit your publication in such a way that any text in the
publication reflows (moves to another page). The table of contents is not linked to the
paragraphs they refer to as they exist on the pages of your publications, so when a table
of contents entry flows from one page to another, the table of contents is not automatically updated. This means that, although you may create the table of contents one or
more times before you finish your document, it is mandatory that you re-<:reate the
table of contents as the very last step in finishing your document, after all other
changes have been made to all files in the document.
After creating the table of contents that last time, when you are sure nothing in any
publications in the document will be changed (or at least not enough to move items
between pages), then you can do any final editing to the table of contents text and
verify the text formatting in the table of contents.

Table of contents style sheets
If your publications are formatted with style sheets, the Create TOC ... command
automatically creates new style sheets that are used to format your table of contents
entries. It adds one new style sheet for each existing style sheet that has that Include in
TOC option selected. The new style sheets are named the same as the corresponding
existing style sheets, with the letters TOC added to the front of their names, as shown in
Figure 16-8.
Figure 16-8:
New style sheets are automatically
created to help you format table
of contents entries.

Subhend I
Subhend 2
TOC handing 1
TOC handing 2
TOC hendlng 3
TOC Headline
TOC title

These new style sheets are initially formatted using the same options and attributes as
the style sheets on which they are based, but you are free to modify them as necessary
to properly format the text in your table of contents. In most cases this will mean
setting smaller type sizes, less space between paragraphs, and new tab settings. Any
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changes you make to the TOC style sheet definitions are not lost when the table of
contents is re-created - so this method allows you to at least partially format your
table of contents even before the final edition is created.

Indexing _____________________
A good index is also vitally important to the success of any long document, but creating
a good index is one of the most tedious jobs associated with publishing. As a result,
before indexing features like those in PageMaker were available, it was necessary to
endure the tedium or hire a professional indexing service to create a good index. Using
PageMaker's indexing features, however, you can produce a very professional index
with a fraction of the effort formerly required . PageMaker allows you to create an index
across all of the publications in your book, with up to three levels of indexed items,
cross-references, and a great flexibility in the type of page number citations used by
each index entry.
PageMaker's indexing abilities are best described as semiautomatic: First you manually
mark each index entry in each publication and then PageMaker collects these entries
and determines the correct page references. Specifically, a typical indexing project uses
the following procedure:
•

First, mark each text reference that you want included in the index. This can be
done manually using the Index entry command, or the story editor's change
command can be used to help automate this process.

•

Next, review your index with the Show index command. This lets you review
index entries alphabetically, making changes, adding or deleting entries.

•

Then choose the Create index ... command. This collects all of your index
references, determines the page numbers on which the cited references appear,
and compiles the index story.

•

The index then appears as a story you can place into your publication just like
any story imported using the Place command.

•

Once the index is in position, you can edit the index text, correcting any problems or improving character or paragraph formatting.

•

Finally, if your publication is edited in any way that would affect your indexchanges to the position of text or the text content- you'll have to re-create the
index and redo any index edits.

The following sections describe each of these steps in detail.

438

Part III: Advanced Topics

Marking index topics
The first step in creating an index in PageMaker is marking each item in the text that
you want to include in your index. PageMaker refers to each item you include in your
index as a topic reference. A topic reference can be any text of up to 50 characters,
including words, phrases, or proper names. To mark text as a topic reference, select it
with the text tool and then choose the Index entry ... command (Command-;) from the
Utilities menu. The Add index entry dialog box, shown in Figure 16-9, then appears.
Figure 16-9:
The Add index
entry dialog box.
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If you want to create an index entry at a certain spot in your text but don't want

to use any existing text as your topic reference, set the text insertion point and
choose the Index entry command (Command-;). The same Add index entry
dialog box will appear, but no default text will be included as the topic reference.
The Add index entry dialog box includes the following options:
•

Topic. The upper left section of the dialog box contains the topic option, which

consists of three options boxes stacked below the word Topic. Any text that was
selected when the Index entry command was chosen is automatically placed in
the top option box, thus making this text the topic reference. You can modify
this text as necessary to create the topic reference you desire.
The second and third option boxes below the Topic option are used for secondary or third-level references. Figure 16-10 shows a second-level reference.
Second- and third-level references expand and clarify index references for
complicated topics. In this book, for example, there are a number of references
to the general topic of style sheets. Rather than producing an index with a s ingle
style sheets ent ry of 10 or more page references, secondary references are used
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to separate the style sheets entries into more specific topics such as Creating,
Importing, For table of contents entries, and so on. The second-level style sheet
reference of Importing could also have third-level references from word processors and from other PageMaker publications.

I

lldd indeK entry
Type: ® Poge refere nce
Topic:

0

Cro ss-r e fe rence

OK

Jl

[ Cancel ]

;:.:So:..:.r.:..:.
t: _ _---,

I 1111 I
IEnuironmentol regulottol I~======:
I Pocific Coost

:=I====:

[

Rdd

J

[ Topic ... J

Poge range: 0 Current poge
0 To n e Kt s tyle chonge
0 To n e Ht use of s tyle: 0:-::S::t eps,o
~l
® For neH t @] parographs
0 Suppress p oge range
'-1

Pag e # override: 0 Bold

0 Itolic 0 Unde rline

Figure 16-10: An Index entry that includes a second-level topic reference.

To enter a second- or third-level reference, click the text tool in the appropriate
option box and enter the second- or third-level reference text. The reorder
button, located next to the first index option box, is used to exchange the text
between the first-, second-, and third-level index option boxes. If you need to
reorder an entry, click this button until the topic references are nested as you
require them.
•

The Topic ... button. One problem with pulling topic references from your text,
or entering them from the keyboard, is that any misspelling or terminology
deviation will become a separate item in the index from that of the correct
spelling or predominant terminology. For example, this book may contain
references to both the LaserWriter and to the Apple LaserWriter. The best way
to index these occurrences would be to have all index entries use one terminology or the other (probably Apple LaserWriter in this case) and have the other
terminology cross-refe renced (LaserWriter. See Apple LaserWriter).
To minimize this problem, PageMaker lets you check the current topic reference
against a list of all existing topic references. This makes it easy to correct misspellings or select an alternate terminology so all index entries will match. To
check a topic reference, click the Topic ... button. The Select topic dialog box, as
shown in Figure 16-11, then appears.
Your existing topic references (including first-, second-, and third-level refer-
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Select topic

n

OK "
[ Concel

I

leuel I: Assignments
Leuel 2:
Leuel 3:

~============~
~------------------~

Topic section: []]

I

I
[I mport I
[

Add

[NeHt section)

Level I
AI rll no schedules
airport
1\ncheroge, Alos ko

level 2

Anouneements

Pre- fltght

Level 3

Figure 16-11: The Select topic dialog box.

ences) appear in the top portion of the dialog box. Set the cursor in the box of
the reference you wish to check. Then use the pop-up list next to the Index
section option to select the first letter of the reference or of any alternative
terminology you think might be used for that reference. A list of existing index
entries for the letter you select appears in the lower portion of the dialog box. To
check another set of existing index entries, choose another letter from the Index
section option, or click the Go to next button, which moves you to the next
alphabetical index section that contains at least one index entry.
If you find an existing entry you wish to use instead of the current topic reference, highlight it and click the OK button, or double-click on the topic name. This
will change the entry for the Topic option in the Add index entry dialog box.
Click the Cancel button to return to the Add index entry dialog box without
resetting the current topic.

•

The Import button. In order to get the topic references you've used in other
publications in your book list to show up in the listing at the bottom of the dialog
box, you have to use the Import button. This makes your search for alternate
spellings and terminologies more complete and makes it easier to perform semiautomatic indexing as described later in this section. When the Import button is
clicked, a list of all publications in the current book list appears.
The Import button will be dimmed if no book list has been created for the
current publication or if all entries from the publications that are in the book list
have already been imported.

•

Sort. The Sort option in the Add index entry dialog box allows you to specify that
a particular topic reference should be sorted as if it were spelled differently than
it really is. For example, in most cases, topic references that begin with a number
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are sorted as if the number were spelled out (2nd is sorted as second). So if a
topic reference were 2nd base, you would write second base in the Sort option,
and when PageMaker alphabetized the index, the 2nd base item would be sorted
in alphabetical order within the Ss.
•

Range. The Range options, as shown in Figure 16-12, determine which pages are
included in the citation of the current topic reference. There are five options:

I

Add lndeH entry
Type: ® Page reference
Topic:
Pacific Coast

0 Cros s -referen ce
rSo:..:..r.::..
t: _ _--,

I
I I1IJ I
IEnulronmental regulatiol I~==~
:=I==~

OK

II

I
( Rdd I
(Topic ... I
( Cancel

Pa ge range: 0 Current page
0 To neHt style change
0 To neHt use of sty le: 1'-o""'s,...te-ps....,,o=->1
® For neHt @] parogrophs
0 Suppress poge runge
Poge

It

ouerrlde: 0 Bold

0 ltollc 0 Underline

Figure 16-12: The Index entry dialog box range options.

Current page. When this option is selected, the index item lists only the specific
page on which the topic reference is found.
To next style change. When this option is selected, the index item lists a range of
pages, starting with the page on which the topic reference is found and ending
with the page containing the first paragraph that has a style different from that of
the paragraph containing the topic reference.
To next use of style. When this option selected, the index item lists a range of
pages, starting with the page containing the topic reference and ending with the
page that contains the first paragraph using the style sheet specified in the popup menu following the option.
For next_ paragraphs. When this option is selected, the index item lists the
range of pages starting with the page containing the topic reference and ending
on the page containing the n111 paragraph after the one containing the topic
reference, where you specify n in the option box.
Cross-reference. This option is used to create cross-references. Cross-references
allow you to include alternate terminology or spellings in the index. Using our
previous example, you would add an entry for LaserWriter and then select the
Cross-reference option and use the Topic button to select the Apple LaserWriter
entry as the cross-reference.
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To create a cross-reference entry, click the Cross-reference (x-ref) option and
then click the X-ref. .. button. This brings up the Select topic dialog box, which
you use to select the index item to which the current index entry will refer.
•

Reference Ovenide. In most cases, the text of each topic reference in your index
and the page range for that entry will use the same type style. For some entries,
however, you may want to use a bold, italic, or underline type style for the page
reference to provide visual emphasis. The Reference override option makes it
easy to do this: Just select the Bold, Italic, or Underline option in the Add index
entry dialog box. If entries in your index are formatted using the selected type
style already, the opposite style will be used. For example, if you select the
Reference override: Bold option, but the text in your index is formatted as bold,
then the page range will be formatted as not bold.
Note that when you change the Reference override option, that setting remains
the default for all subsequent index entries until you change it again. So you
won't have to select these options repeatedly unless you want to set the reference override differently for different index entries. You usually don't want
different index entries to use different reference overrides, because it will make
your index unattractive and hard to read. You may, however, want to use one
reference override for index entries and another for cross-references. In this
case, be careful to correctly set the Reference override option one way when
creating index entries and the other way for when creating cross-references.
Even though the Reference override option will format your index text in a
certain way, you are still free to manually format the text without restriction.

Before clicking OK to close the Add index entry dialog box, double-<:heck your option
settings. The process of editing an index entry is somewhat indirect, as described later,
and it is much easier to catch mistakes early in this process. When you're sure everything is correct, click the OK button. This creates the index entry and closes the dialog
box. Or click the Cancel button if you want to close the dialog box without creating the
index entry.
In the layout view, there will be no visible result from your new index entry. In the story
editor, however, a black diamond called an index marker will appear before each word
or phrase that has been added to the index. If a word or phrase is indexed more than
once, multiple index markers will appear. The main reason that you might index a word
or phrase more than once is to cross-reference different terminologies. The first time
you index the word Font, for example, you might add a standard page reference and a
cross-reference from the word Typeface to the word Font. Or you might index a phrase
like "Government regulations" both literally (as Government regulations) and as Federal
regulations and perhaps several other common synonyms.
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You may also find that two index markers appear before a word because it has
been accidentally indexed twice. This can happen quite easily since there is no
sign in the layout view that a word or phrase has been indexed. If you locate a
twice-indexed word, you can remove one of the index entries by simply deleting
one of the index markers.

Indexing tips and shortcuts
PageMaker includes a number of keyboard shortcuts and other commands you can use
to complete indexing projects more quickly.

Quick index with defaults
To index a selected word or phrase without changing any of the default options in the
Index entry dialog box, use the Command-Shift-; (semi-<:olon) keyboard shortcut. This
indexes the selected text without opening the Add index entry dia log box, with the
Range option set to Current page and no second- or third-level references included. You
can later modify the options for this entry by selecting the text and choosing the Index
entry ... command, or using the editing capabilities of the Show index... command, as
described later.

Indexing names and titles
To index a proper name, select the name and press Command-Shift-Z. This indexes the
name last name first. So if you index the name Robert Zimmerman, it will appear in the
index as Zimmerman, Robert. To use this trick for names that have more than two
words Qike Hillary Rodham Clinton, or J. R. Ewing), you must insert a non-breaking
space character by pressing Option-spacebar between each word except the last two. In
these examples, the non-breaking spaces would have to be inserted between Hillary and
Rodham, and between J. and R., so the res ulting index entries would be Clinton, Hillary
Rodham, and Ewing, J. R.

Indexing with search and replace
When creating an index for a large publication, with many topic references and many
occurrences of each topic reference, you can ens ure that your index is complete by
working in the story editor and using the Change ... command. The Change ... command
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allows you to search for all occurrences of a particular word or phrase in the current
publication or in all open publications and add that word to your index. To do this, you
enter the word or phrase you want to index into the Find what option box and enter ";
(caret+ semicolon) into the Change to option box. Click the Change All button, and
every instance of your word or phrase is now in your index.
If you want to index only certain instances of the word or phrase or need to change the

options in the Index entry dialog box, use the Find button instead of the Change All
button, and then use the Index entry command and Change or Find next buttons as
necessary.

Defining index topics in advance
In most cases, you'll assign topic references as you go through your publications adding
index entries. Alternatively, if you know in advance the topic references you want to use
in your index, you can enter your list of topic references in advance. Doing this allows
you to verify that as you add index entries, each correctly corresponds to your predefined index goals.
To enter your list of topic references, choose the Index entry command (Command-;)
from the Utilities menu, and then click the Topic .. . button. The Select topic dialog box
will then appear. Enter each topic reference you want to add into the Level option
boxes (you may enter a main reference or a secondary or third-level reference) and
then click the Add button. Repeat this procedure until all of your topic references have
been added. The lower portion of the dialog box displays a complete list of all existing
reference topics, divided alphabetically, as illustrated in Figure 16-13.
Figure 16-13:
Existing topic
references are listed
in the Select topic
dialog box.
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After you have entered all topic references, click the OK command to close the Select
topic dialog box and then click Cancel to close the Add index entry dialog box. (Use the
Cancel rather than the OK button so you don't add a new index that isn't correctly
attached to a topic in your publication.) You can then open other publications in your
book and use the Import button in the Select topic dialog box to copy your master topic
reference list into each publication.

Editing topic references
After you have indexed a number of topic references, you should review your index
entries before creating the final index. This may reveal some missing index entries or
alert you to index entries that need to be edited before they appear in the final index.
Use the Show index ... command in the Utilities menu to quickly review the current
index entries for all publications in the current book list.

Using the Show index dialog box
Choosing the Show index ... command causes PageMaker to read the index entries for
the current publication and all other publications in the book list. If you want to limit
the list to only entries from the current publication, hold down the Shift key when you
choose the Show index ... command. A progress dialog box keeps you informed as
entries are read, and then the Select topic dialog box appears as shown in Figure 16-14.
This is the same dialog box you saw when using the Topic ... button in the Add index
entry dialog box; it lists all of the existing topic references and the page references that
are currently assigned to these topics. As you learned earlier, thi~ dialog box displays
topic references one alphabetical section at a time. Use the Index section pop-up or the
Go to next button to change to another alphabetical section of the entries.
Figure 16-14:
The Select topic
dialog box.
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What you see in this dialog box is an alphabetical list of all topic references at level 1,
level 2, and level 3, in addition to the current page reference. If any of your index entries
are not found on a specific page, one of the following symbols may appear in the
Reference column:
Symbol

Meaning

PB

Pasteboard

LM

Left Master page

RM

Right Master page

ov
UN

Overset Text (beyond end of a text block)
Unplaced text (in a story editor window)

?

Location uncertain

Editing, adding, and deleting topic references
From within the Show index dialog box you can edit any topic reference, or the options
associated with that topic reference, by selecting the topic reference in the list and then
clicking the Edit. .. button. The Add index entry dialog box then appears so you can
modify the topic reference or its options. The use of these options was discussed in the
previous section of this chapter.
From the Show index dialog box you can also add new topic references if they will be
cross-references to other existing index entries. To do this, click the Add ... button, and
enter the name of the new topic reference in the Add index entry dialog box. The Crossreference range option will be selected automatically. To assign a cross-reference, click
the X-Ref button and select one of the existing topic references from the Select topic
dialog box. Then click the OK button. You can now enter new topic references that need
corresponding page references from within the Show index ctialog, shown in Figure 16-15.
You can also delete topic references from your index using the Show index dialog box.
Just select the entry you want to delete and then click the Remove button. The selected
topic reference will be permanently deleted from your index. (If you delete any topic
references and then wish you hadn't, click the Cancel button to close the Show index
dialog box and the deletion will be effectively undone.)
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Figure 16-15:
The Show
index dialog
box.
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Capitalizing topic references
A new button in this dialog box in PageMaker 5, the Capitalize ... button, lets you fix a
common problem with index entries: incorrect capitalization. Unfortunately, this button
is not available if your publication has a book list - it only works when indexing a
single file. (Why does it only work on a single file? No good reason I can imagine.
Although I'm sure it was easier to program this way ...) You can use the Capitalize ...
button to capitalize the first word of any selected entry, or all level 1 entries in your file,
or of all index entries in the file. To capitalize a single entry, select that entry before
clicking the Capitalize button. In the Capitalize dialog box (shown in Figure 16-16), select
one of the three options and then click OK to return to the Show index dialog.
Figure 16-16:
The Capitalize d ialog box.
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When you are finished checking or editing the index entries, click the OK button to save
any changes you have made to the index and return to the layout, or the Cancel button
to return to the layout without saving changes.
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Show index dialog box shortcuts
Aldus added a number of new keyboard shortcuts to the Show index dialog box in
PageMaker 5 that can help you do "index housekeeping" very easily:
Keyboard Shortcut

Result

Option +Add X-ref button

Deletes all index entries added since the
Show index dialog box was opened, or since
the Accept button was clicked.

Option+ Remove ... button

Undeletes and index entries deleted since the
Show index dialog box was opened, or since
the Accept button was clicked.

Command + Option + Remove ... button

Deletes all page references from all index entries.

Command + Shift + Remove ... button

Deletes all cross-references from the index.

Command + Option + Shift+ Remove ... button

Deletes all index entries from t he index .

Creating the index
When all of your topic references have been marked and your publication has stabilized
to the point where text will no longer be flowing between pages, you are ready to create
the actual index. You can create the index before all of your topic references are
marked or when the layout is still in flux, but if you do, you will have to re<reate the
index later to get the final set of topic references and the final correct page references.
To create the index, open the PageMaker publication that will contain the index layout
and use the Book ... command (as described earlier in this chapter) to create or verify
the book list. When the book list is correct, choose the Create index ... command from
the Utilities menu, and the Create index dialog box, shown in Figure 16-17, appears.
Figure 16-17:
The Create index
dialog box.
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This dialog box offers four options:
W Title. The Title option is used to enter the text that will appear as the header of
the new index. You can edit this title after the index has been created, so the text
entered here is not very important.

W Replace existing index. The Replace existing index option is automatically
selected if the current file already contains an index, but you may want to
deselect it. This option should be selected if you want the new index to replace
the existing index in the current layout. Remember that if you have manually
edited the existing index, replacing it will cause all your edits to be lost. If the
current file contains more than one index, the most recently created index will
be considered the existing index.
•

Include book publications. The Include book publications option, which is
selected by default, causes the index entries from all PageMaker files in the
current book list to be included in the index that is generated. If you want to
create an index that contains only entries from the current file, regardless of the
number of files in the current book list, deselect this option.

•

Remove unreferenced topics. This option, when selected, causes the new index
to remove any topic references that do not occur at least once in the indexed
text. If, for example, you had created an index entry for the name Bugs Bunny
and later deleted the only paragraph containing the name Bugs Bunny, use of
this option would cause the name to be removed from the index. If this option
were not selected in this case, Bugs Bunny would be included in the index,
without a page reference.

The Format .. . button in the Create index dialog box provides access to a number of
additional options that control the index compiled by the Create index command.
Figure 16-18:
The Index format
dialog box.
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The options in the Index format dialog box, shown in Figure 16-18, cover:
•

Include index section headings. When this option is selected, the name of each
alphabetic section of the index will be included in the index. When this option is
not selected, no section headings are included in the index, although space is
placed between sections.

•

Include empty index sections. When this option is selected, alphabetic sections
of the index that do not contain any topic references are included in the index.
When it is deselected, only sections of the index containing at least one topic
reference are included.

•

Fonnat. The index PageMaker creates can be in one of two formats -Nested or
Run-in. ln the Nested format, each first-level topic reference is placed on its own
line, with second- and third-level topic references given their own lines, indented
under the first-level item. In the Run-in format, each first-level topic reference
begins a new line, but the second- and third-level topic references follow the
preceding level, continuing on the same line. New lines a re started only when the
paragraph specifications of the index text force text to wrap to a new line. Figure
16-19 compares the Nested and Run-in formats.

Referenc es
cross-references
page ref erences
topic references

References : cross-references
100 , ~3 ; page references
102 , LOOM ; topic references 115,
115 , 121 , 198

Figure 16-19: Examples of the Nested (left) and Run-in (right) index formats.

In order to separate topic references, page references, entries, and cross-references,
special characters called delimiters are inserted in the index. The remaining options in
this dialog box control which types of delimiters are used in the various circumstances.
Many of the characters used as delimiters, such as the en dash and en space, are
produced with special key combinations, as listed here.
Character

Key Combination

White space
Tab

"w or" W
"tor"T

Em space

"m or "M

En space

">

Thin space

"<

En dash

"=

Em dash

A

(underscore)
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•

Following topic. The entry made for this option determines the character that
will be placed between each topic reference and the page numbers or crossreference text. The default is two en spaces.

•

Page range. The entry made for this option determines the character that will be
placed between page numbers when a range of pages is listed. The default is an
en dash.

•

Between page #s. The entry made for this option determines the character that
will be placed between multiple page references to a single topic reference. The
default is a comma and an en space.

•

Before x-ref. The entry made for this option determines the character that will
be placed between a topic reference and its cross-reference text. The default is a
period and an en space.

•

Between entries. The entry made for this option determines the character that
will be placed between secondary entries in the Run-in format. The default is a
semicolon and an en space.

•

Entry end. The entry made for this option determines the character that will be
placed after the final topic reference when using the Nested format, or after each
reference when using the Run-in format. There is no default character.

After completing all the options in the Index format dialog, click the OK button to return
to the Create index dialog box. If additional changes are not required in the Create index
dialog box, click the OK button to begin the index generation.
lf the Include book publications option was selected, and any of the publications in the
current book list are not in their original location, a Find pub dialog box, as shown in
Figure 16-20, will appear. Use the scrolling file list and the Drive and Eject buttons to locate
any publications that have been moved, or use the Ignore or Ignore all buttons to create
the index without the entries from any missing publications. If the name of any publication has changed, highlight the new file in the scrolling list and click the OK button to
include the renamed publication in your index in place of the file that cannot be found.
Figure 16-20:
The Find pub
dialog box.
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The process of creating your index may take several minutes, depending on the number
of index entries that are included. The progress of the index generation will be shown in
a progress dialog box. When the index is complete, one of three events will occur:
•

If the Replace existing index option was selected, the new index will be placed in

the text blocks that currently hold the previous version of the index.
•

If you are in the layout view, and the Replace existing index option was not

selected, a text placement icon will appear. You can then use the text placement
icon to position and flow the index. See Chapter 7, "Creating Text," for information on using the text placement icon to flow text.
•

If the story editor is open, and the Replace existing index option was not selected,

the index will appear in a new story window. You can edit the index text, if desired ,
as described in the next section. To place the index into your layout, choose the
Place ... command in the File menu. This will cause a text placement icon to
appear; this icon can be used to flow the index text into the current publication.

Editing and formatting the index
Once placed, your index text can be edited and manipulated just like text imported from
a word processor or created with the text tool. You can change any text or paragraph
attributes in the index, modify the index style sheets, or apply new style sheets to the
index text. Note that PageMaker automatically creates style sheets for your index
entries and tags your entries with these style s heets, just as it did for your table of
contents entries. These style sheets are:
•

Index level I . This is the style sheet used to format first-level index entries.

•

Index level 2. This is the style sheet used to format second-level index entries. It
will be created only if your index includes second-level entries.

•

Index level 3. This is the style sheet used to format third-level index entries. It
will be created only if your index includes third-level entries.

•

Index section. This is the style sheet used to format the section headings of the
index.

•

Index title. This style sheet is used to format the index title.

You can therefore reformat your entire index by modifying the formatting definitions of
these style sheets. To do this, use the techniques explained in Chapter 10, "Style Sheets."
You can also format the text directly, overriding the current style sheet applications, or
tag your index entries with other style sheets.
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You'll always want to take a very careful look at your index, searching for improper
capitalization, topic references that are supposed to be identical but aren't, and ensuring the overall consistency of the entries. You can correct problems in your index in
two ways: Make corrections in your publication files and in the Show index dialog box
and then re-create the index, or edit the index story directly. If you will be using your
publication files again in the future or aren't finished creating or editing the publication
itself, you should definitely make corrections in the actual files and Show index dialog
box. If you choose to make corrections directly in the index story, remember that these
corrections will be lost if you have to later re-create the index for any reason (such as if
further editorial or layout changes make text flow across pages in any publication.) At a
minimum, if you do not want to make corrections in the actual files and Show index
dialog box, you should hold off on performing the edits to the Index story until you are
sure that there will be no changes in the publication files.

Links and File Management _ __
When you import a text or graphics file into a PageMaker publication, PageMaker
automatically notes the location from which the imported file carne (the drive and
folder it was in) and the date and time the file was modified. This information is used
later to determine if the original file has been modified since it was imported into
PageMaker, and in some cases, to reduce the amount of disk space consumed by
PageMaker files. The relationship between PageMaker and the external text and graphic
file is called a link. Similar details are tracked for elements imported using the Subscribe
to or Insert object commands.
PageMaker has three commands that Jet you control the links between original files and
your publication: the Links ... command in the File menu, the Link options ... command
in the Element menu, and the Link info ... command in the Element menu. With these
commands, you can find out if the external versions of your text or graphic elements
have been modified or the page number on which elements exist within your publication. You can also substitute one file for another by changing the link (or reconnect a
file that has been moved to a new location on your hard drive), unlink files that you
don't want to remain connected, and control the size of your publications by controlling
which graphic files are fully stored within your publication.

The Links command
The Links .. . command (Command-=) is the most powerful of the three link commands,
and the one you will use most often. Choosing the Links ... command brings up the
Links dialog box, which presents a list of all the text and graphic files that have been
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imported into the current publication. This list, as shown in Figure 16-21, gives the
name of the file that was imported, the kind of file it is (fext, Image, EPS, PICT, OLElinked, OLE-embedded, Subscriber), the page in the publication where the file is located, and a symbol indicating the status of the link.
Figure 16-21 :
The Links dialog
box.
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The symbols appear before each filename in the list. When a particular file is selected in
this list, the meaning of that file's link status symbol appears just below the scrolling
window (next to the word status). The link symbols:
•

No Symbol. If no symbol precedes the document name, the link is up-to-date, or
no link information exists.

•

NA. If the letters "NA" appear before a document name, there is no link information available, either because the document was pasted into your publication
and no links exist, or because it is an OLE-embedded object.

•

Question Mark. When a question mark appears, PageMaker is unable to locate
the external file from which the file was imported. 1f the file has been moved or
renamed and you would like to re-establish the link, or if you would like to link a
different file, use the Info ... button, as described later.

•

Solid black diamond. When a solid black diamond appears before a filename, the
external file has been modified since the text or graphic was imported into (or
exported from) PageMaker, and this element is set (via the Link option defaults
dialog box) for automatic updating. The newer version of this element will be
brought into the publication the next time it is printed or opened. You can force
the new element to be imported earlier by using the Update or Update all buttons.

•

Open diamond. When an open diamond appears before a filename, the external
file has been modified since the text or graphic was imported into (or exported
from) PageMaker, but the element is not set for automatic updating in the Link
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option defaults dialog box. If you want to import the newer version of the external file, select the element name and then click the Update button.
• Open triangle. When an open triangle appears before a filename, both the
external version of the element and the version of the element stored within your
publication have been modified. If you select this element and click the Update
button, the current external version will be imported and will overwrite the
current version that exists in your publication, losing all of the changes that were
made to that internal version.
The Page column lists the page number where the element was placed. If the imported
element does not appear on one of the publication pages, one of the following symbols
will appear:
•

Page#?. The element is an inline graphic whose position has not yet been
determined; the page number is currently unknown. When the story containing
the graphic is placed, this symbol will be replaced with an actual page number.

•

LM. The element is positioned on the left master page.

•

RM. The element is positioned on the right master page.

•

PB. The element is positioned on the pasteboard.

•

OV. The element is hidden in a text block that has not yet been fully placed.
When the text block containing the graphic is fully placed, this symbol will be
replaced with an actual page number.

•

X. The linked element is a story window that is open in the story editor and has
not yet been placed. When the story containing the element is placed, this
symbol will be replaced with an actual page number.

At the bottom of the Links dialog box, four buttons appear: Info ... , Options .. ., Update,
and Update all.
•

Info ... is used to select a new file to link to the currently selected element. This
button operates exactly like the Link info ... command, as described in the next
section of this chapter.

•

Options ... brings up the Link options dialog box, which presents three options.
When the Store copy in publication option is selected, a copy of the text or
graphic element is kept in your PageMaker publication. This option is selected
automatically for all text elements and cannot be deselected. When this option is
not selected, only a screen image of the element is kept in the publication, and
the external disk file is accessed when the actual element is needed for printing.
In this case, changes made to the external file must be used by PageMaker in
order to print the publication.
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When the Update automatically option is selected, each time the publication is
opened or printed, PageMaker determines if the linked file has been modified. If it
has been modified, PageMaker imports the new version for use in your publication. When using this option, remember that any modifications you make to the
copy of the element in your publication will be lost the next time the element is
updated.
The Alert before updating option- which is available only when the Update
automatically option is selected - determines whether PageMaker asks you to
confirm the element update each time a new external disk version is found.
When this option is selected, a dialog box will appear before the update takes
place, thereby allowing you to cancel the update. lf this option is not selected,
automatic updates occur without warning each time your publication is opened
or printed.
•

Update replaces the current version of the selected element that is used in your
publication with the newer version as found in the linked file.

•

Update all replaces all linked elements in the publication, not just the one
currently selected, with new versions as found in the linked files.

When you have finished modifying link information, click the OK button to close the
Links dialog box. If you have modified any elements by updating links, these changes
will now be reflected in your publication. You may want to examine your publication
carefully to verify that all updated text is positioned properly and updated graphics are
sized and positioned correctly.

The ljnk info command
The Link info ... command, found in the Element menu, brings up the Link info dialog
box (shown in Figure 16-22) just like the Link info button in the Links dialog box. It is
available as a separate command so that you can select one text or graphic element and
check the link info of one specific element without having to go through the Links dialog
box (and endure the associated wait while the Links dialog box checks every link in
your publication.)
The scrolling window on the left side of this dialog box shows the contents of the folder
where the linked file was originally found, with the linked file selected in some cases.
The link information is presented on the right side. If PageMaker cannot locate the
folder where the linked file was originally found, or if the linked file no longer exists, the
correct folder or file will not be displayed in the scrolling file list.
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Figure 16-22:
The Link info
dialog box.
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If PageMaker has correctly located the linked file, and you do not wish to change this

link, click the Cancel button to exit the Link info dialog box. Clicking the Link button
causes PageMaker to replace the copy of the element as it currently exists within your
publication with a copy of the element as it exists in the externa l file, regardless of
whether the external file has been modified since it was imported into PageMaker.
You can determine if the external file has been modified since it was imported into
PageMaker by comparing the dates and times listed for the Placed and Document
modified lines on the right side of the dialog box. The Internal data modified line tells
you when the copy of the element as it currently exists in your publication was last
modified. If this date/time is later than the Placed date/time, some changes have been
made to the element, and these will be lost if the link is updated. (You can also check
the status of the link before updating it by closing this dialog box with the Cancel button
and then using the Links ... command from the File menu to check the current link
status and update it, if necessary.)
You can also update the link manually, relinking a file that has been moved or renamed,
or selecting a new file that you want to use as th~ source of text or graphic image for the
current element. To do this, locate the file you want to link, select the filename, and
click the Link button. This causes PageMaker to replace the current eleme nt with the
information from the file you have selected.
If the Link button is clicked , and the result of the link update will be the Joss of modifica-

tions made to the element inside PageMaker, a dialog box like the one shown in Figure
16-23 appears, warning you of the effect your link will have. Click the Yes button to
complete the link and discard the current element or the No button to cancel the link
and leave the element unchanged in your publication.
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Figure 16-23:
The Li nk update
alert box.
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The Link Options command
The Link Options ... command, found in the Element menu, works just like the Link
options button in the Links dialog box but lets you bypass the Links dialog box to
directly verify or alter the link options for any selected text or graphic element. It also
allows you to set the default link options, which cannot be done using the Link options
button in the Links dialog box.
To see the link options for any imported element, select the text or graphic with the
arrow tool, and then choose the Link options ... command. The Link options dialog box,
as shown in Figure 16-24, will then appear. This dialog box presents three link options:
Figure 16-24:
The Link options
dialog box.
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Store copy in publication. When the Store copy in publication option is selected,
a copy of the text or graphic element is kept in your PageMaker publication. It is
selected automatically for all text elements and OLE-linked objects and cannot be
deselected. It cannot be used for OLE-embedded objects.
For graphic objects (except OLE objects), selecting this option causes a complete copy of the graphic file to be stored inside the PageMaker publication file.
When it is not selected, only a screen image of the element is kept in the publication, and the external disk file is accessed when the actual element is needed for
printing. In this case, PageMaker accesses the external file when printing the
publication, so if you plan to print from another location, you have to be sure to
take the externally linked graphic files al ong. You can do this by using the Copy
linked files for remote printing option in the Save as dialog box.
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•

Update automatically. When the Update automatically option is selected,
PageMaker determines whether the linked file has been modified each time your
publication is opened or printed. If the element has been modified, PageMaker
imports the new version for use in your publication. If PageMaker cannot find the
external element when opening the file, you will be prompted to locate it. When
using this option, remember that any modifications you make to the copy of the
element in your publication will be lost the next time the element is updated.

•

Alert before updating. The Alert before updating option, which is available only
when the Update automatically option is selected, determines whether
PageMaker asks you to confirm the element update each time a new external disk
version is found. When this option is selected, a dialog box will appear before the
update takes place, allowing you to cancel the update. If this option is not
selected, automatic updates occur without warning each time your publication is
opened or printed.

To modify the default link options, select the arrow tool from the toolbox, click on the
pasteboard or at some location on the current page where no element is located (so that
nothing is selected), and then choose the Link options ... command from the Element
menu. The Link options: Defaults dialog box appears as shown in Figure 16-25. This
dialog box presents the same options as the regular Link options dialog box, but at this
time their setting determines the default used by all text and graphics that have not yet
been imported.

Figure 16-25:
The Link options:
Defaults dialog box.
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After setting the options for both text and graphic defaults, click the OK button to save
the new defaults or the Cancel button to return to the publication without saving
default modifications.
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Working with links
Each time you open a publication, or print from a publication, PageMaker checks the
status of all linked elements and executes any scheduled automatic updates. If the
linked file cannot be found for an element that is not stored in the publication and is
scheduled for automatic updating, the Cannot find dialog box, shown in Figure 16-26,
appears. Using this dialog box, you can locate an element that has moved to another
folder or drive, or you can link a new file that has replaced the old version of the file.
Figure 16-26:
The Cannot find
dialog box.
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Saving and links
When linked graphic elements are not stored in your publication file, it is easy t o forget
to include these files when backing up publications or copying publications to disk for
transportation to another site. To avoid these mistakes, the Save as dialog box, shown
in Figure 16-27, includes two options: the Copy Files for remote printing option and the
Copy All linked files option.
Figure 16-27:
The Save as dialog
box provides
o ptions for copy ing
linked files.
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The Copy Files for remote printing option causes a copy of each file that is not stored in
your publication to be placed in the same folder in which the publication is saved. The
Copy All linked files option causes every linked file, whether stored in the publication or
not, to be placed in the same folder in which the publication is saved. Of course, unless
you are saving to some type of r emovable cartridge or tape, the total size of all files may
exceed the available storage space on your disk, and unfortunately PageMaker's save
operation will not prompt you for multiple disks during the save operation. Instead, it
provides you with an error dialog box. In this case, save the publication and its linked
files to a folder on your hard drive and manually copy them onto as many disks as are
necessary.
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•••••••••••••••••••••••••••••••••••••••••••••••
Summary
•

The Book ... command lets you create a list of PageMaker publication files to be
treated or printed as a single document for purposes of creating a table of
contents and index, with a single command.

•

You don't have to build a book list in every publication in your book, but you
do need one in the file that will contain the table of contents and index. You
can export a book list from one publication to all others in that book list by
holding dow n th e Command key w hile choosing the Book... command.

•

To create a table of con tents, you must first mark the paragraphs you want to
include with the Include in TOC option in the Paragraph specifications dialog
box. You can also use this option in your style sheet definitions. Then open the
publication in which you want to lay out the table of contents, verify that the
book list is accurate, and choose the Create TOC. .. command.

•

You can edit th e table of contents text or change its formatting, but both will
be lost if you later re-create the table of contents. The best way to format the
text in the table of contents is by using the TOC sty le sheets that PageMaker
automatically creates.

•

To m ark index entries, select the word or phrase you want to include and
choose Index entry from the Utilities m enu . For each index entry, you can
specify up to three levels of topic references and select among five different
m ethods of tracking page references. You can also create cross-references
between topic references.

•

To quickly index a word or phrase, select it and press Command-Shift-; .

•

The Show index command lets you preview your index, checking all topic
references and page references.
Creatin g an index is much like creating a table of contents. Use the Create
index command, then place the new story. Style sheets are created automatically, and you can edit these or ed it/format the text directly.

•

Text files and embedded OLE files are automatically saved within your publication files. You can control whether graphic files are saved inside your publication or linked externally.

•

The Links command produces a list of all elem ents used in your publication and
their link status. From the Links dialog box, you can modify, update, or remove
links between elements in your publications and external text and graphic files .

••••••••••••••••.

•••••• •

• ••••••••••••••••••
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Printing is what PageMaker is all about. Getting the pages of your publication out of the
computer and onto real paper so that they can be reproduced in quantity and distributed to the world. Or around the office. Or at least so you can mail one to your mother.
Printing your publication can be extremely easy or it can be somewhat complex,
depending upon the colors used in the publication, the kind of printer you'll be using,
the way that you'll be reproducing your document, and the level of quality you' re trying
to achieve. To get the best printed output from PageMaker, there are a number of things
you have to do, and the first part of this chapter focuses on the commonly overlooked
issues you have to worry about before you print your document. This is followed by a
complete review of the myriad options found in the cascading dialog boxes of the
Print ... command.

Things to Worry About Before
You Print
Most people don't think about printing until they're actually ready to go for the Print ...
command. But the fact is that most printing problems are caused by decisions made
while laying out the publication and adding text and graphic files or specifying colors.
Following is a list of things you should know to produce pages that have the best
chance of printing quickly and without incident.
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•

Page size versus Paper size. In order to print your publication at full size, the
Page size you specify in the Page setup dialog box must be the same size or
smaller than an available paper size in your printer. If your page size is larger
than your paper size, each page of your document will have to be printed either
at a reduced size or in sections (tiles). Both of these procedures are described in
this chapter. Paper sizes available in your printer are listed in the Print document dialog box, which is also described later in this chapter.

•

Imageable area. Most printers cannot print close to the edges of the paper due
to an unprintable margin area. For laser printers, this area is usually %inch to ~
inch. Imagesetters can us ually print edge to edge on any size paper. Once you
select the appropriate PPD file for your printer in the Print document dialog box,
the imageable area is listed in the dialog box. Check these specifications before
deciding on margins for your document or placing any elements within the
margin area. Items positioned in this unprintable margin will simply not appear
on the printed page unless the publication is printed at a reduced size.

W Scaled graphics. Imported TIFF or bitmapped graphics will look best if you don't

resize them, or if you resize them based on the resolution of your final output
device. PageMaker makes it easy to do this by providing a magic stretch feature
that calculates acceptable sizes of reduction and enlargement. To use this
feature, first make sure the correct printer type is chosen in the Chooser, and the
correct PPD file is chosen in the Print document dialog box, and then hold down
the Option key while resizing the graphic. Doing this limits the resizing to only
specific percentages that will maintain maximum image quality on the targeted
printer. For more details about this feature, see Chapter 11, "Graphic Elements."
•

Fonts. Three kinds of fonts are available for the Macintosh-laser fonts (which
are also known as PostScript fonts, outline fonts, or Type I fonts), Image Writer
fonts (which are also known as non-laser fonts), and TrueType fonts. See Figure
17-1 for a comparison. When preparing publications for final output on any
PostScript laser printer or imagesetter, be sure to use only laser fonts or
TrueType fonts. For other kinds of printers, you are best off using TrueType
fonts or using PostScript fonts along with the Adobe Type Manager (ATM).

PostScript

TrueType
Bitma

ed

Figure 17-1: Laser fonts (top) or TrueType fonts (center) produce smooth curves and highquality output. Non-laser fonts (bottom) produce jagged-edged type when printed on
PostScript printers.
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•

Text blocks. When text blocks are not created properly, you'll often wind up with
text that is not aligned as you expected or with missing text that is overset
(unflowed) at the end of the text block. Generally speaking, you want to create
your publication with as few text blocks as necessary, position most text blocks
within column guides or ruler guides, and not create text blocks that are too
much wider than the width of the text they contain.

•

Delete unused elements. Many printing problems are caused by elements that
aren't even supposed to be printed. Before you print, use the Select all command
from the Edit menu and look for text blocks that contain no text (they might have
a font definition that will produce a missing font error message), items that are
totally covered up by other items, or elements that were dragged to the pasteboard but accidentally sit partially on the publication page.

An Overview of the
Printing Process
Printing is an important step for your publication, whether you're going to output the
final copy of your publication or just create a printed proof for review. Forgetting the
many options in the printing dialog boxes for a moment (these are examined in detail in
the next section of this chapter), the printing process includes just three easy steps.
The first is selecting the proper printer driver and printer with the Chooser. Next, you'll
use the Print. .. command (Command-P) to access PageMaker's printing options. Finally,
as your file prints, you'll get a progress report and detailed status messages.

The Macintosh Chooser
Using the Chooser to correctly select a printer driver and printer not only determines
where your document will be printed, but it also controls which printing options will be
presented when you choose the Print. .. command. To access the Chooser, select it
from your Apple menu. When the Chooser appears, an icon for each printer driver
installed in your Extensions folder (or in the System folder itself if you're using System 6)
will appear along the left edge of the dialog box, as shown in Figure 17-2.
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Chooser

Figure 17-2:
The Chooser lists
the printer drivers
avai lable in your
Extensions folder.
Below the Chooser
here is the Setup
dialog box for
PostScript printers.
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Printer drivers are really little conversion utilities that work at print time to translate
your file from the native PageMaker format (in which they are stored on disk) into a
format that can be used by the printer you select. As a result, you can print from
PageMaker to any kind of printer for which you have a valid printer driver in the
Chooser. Several kinds of printer drivers are common, including those for the
LaserWriter, ImageWriter, StyleWriter, and various fax/ modems. You can also purchase
printer drivers that make it possible to print from your Macintosh to hundreds of
different printers not originally designed for the Mac.
When you click on the icon of a printer driver, a list of printers of that type that are
currently connected to your Macintosh (either directly or via your network) appears on
the right side of the dialog box. If you work on a large network, you'll also have to select
a zone, from a list that appears below the printer driver icons, in order to see a list of
available printers.
In order to print in PageMaker, you must select a printer driver in the Chooser even if
you don't have any printers connected to your Macintosh, or if you have a printer but it
is not the same type as the one on which your document will ultimately be output. You
have to select a specific printer only if you want to print to that printer directly. If you
will be printing a PostScript file to disk, you must select the LaserWriter printer driver
but do not need to select a specific printer.
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If you select the LaserWriter driver, you are also presented with a Setup ... button,
which you must use to select the appropriate PPD (PostScript Printer Description) file
for your printer. Click the Select PPD ... button and choose the file that matches the
printer you are using. If your printer is not listed, you may have not installed the correct
PPD when you installed PageMaker, or Aldus may have not included a PPD file for your
particular printer. You should contact Aldus or your printer manufacturer to obtain the
correct PPD file, but in the meantime you can click the Use Generic button, and you will
still be able to print your files.

Also available when the LaserWriter driver is selected is the Background printing
option, which appears just below the list of available printers. If you turn Background
printing on, when you print your file, it will be spooled to a file on your hard drive
before it is actually sent to the printer. The benefit of this is that it allows you to regain
control of your Macintosh and continue to work, in PageMaker or any other application,
while the printing is done in the background. Earlier versions of PageMaker were
incompatible with Background printing because of their reliance on the Aldus Prep file,
but PageMaker 5 is fully compatible with Background printing. If you use Background
printing, you'll need a good amount of free space on your start-up volume, sometimes
several times the amount of space the file itself stores on disk (depending on the size of
your linked graphic images).

The Print... command
After selecting a printer driver and printer, you are ready to initiate printing with either
the Print. .. command or the Printer Styles Addition. This chapter focuses on the Print. ..
command and the many options presented in its dialog boxes, but as described in
Chapter 15, "Aldus Additions," you can also access these options via the Printer Styles
Addition.
The Printer Styles Addition, shown in Figure 17-3, lets you save combinations of
printing options as printing style sheets and then quickly apply these style
sheets to documents you want to print. If you regularly print documents using
similar combinations of printing options or want to batch print multiple publications, each with different printing option settings, be sure to read the full
description of the Printer Styles Addition in Chapter 15.
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Figure 17-3:
The Printer Styles
Addition creates
printing style sheets
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printing.
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When you choose the Print ... command (Command-P), the Print document dialog box
appears. This looks like a normal dialog box, but in fact it is a little different than most
in that it is really four dialog boxes in one. This design was used because there are so
many options related to printing that they couldn't possibly all fit into just one dialog
box, and as demonstrated by the Paragraph specifications dialog box, nested dialog
boxes can get rather unwieldy. So in this dialog box you can switch among different sets
of options by clicking the buttons located just below the OK button. When printing to a
PostScript printer, these buttons are Document, Paper, Options, and Color, as shown in
Figure 174. Here's a quick look at the options each of these provides:
Figure 17-4:
The Print
document dialog
box offers four
selectable option
sections.
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The Print document dialog box. This set of options controls the most basic
printing issues such as number of copies, orientation, range of pages to print,
collation, proof printing, and whether or not all files in the book list will be
printed. You also use this dialog box to select the PostScript Printer Description
(PPD) file that corresponds to your output device.
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•

The Paper dialog box. This set of options defines the size of the paper onto
which you will be printing and the paper tray that will be used, and lets you
specify any reduction or enlargement of your pages. It also provides a tiling
option that is used when a single page of the document cannot fit on a single
piece of paper.

•

The Options dialog box. This set of options defines the quality at which graphics
in your file will be printed and what kind of printer marks will be added to your
pages. It also includes all of the options for printing your file to disk, including
control over the file format that will be saved, how downloaded fonts will be
handled, and the data format for included graphics.

•

The Color dialog box. This set of options includes control over composite color
or color separations, and mirror and invert options for printing film on
PostScript imagesetters. Each s pot- and process-color ink used in the document
can be individually included or excluded from printing, and some or all spot
colors can be converted to process colors. Other options include screen angles
and screen rulings.

Each specific option in each of these four dialog box parts is described in detail in the
following sections of this chapter. Once these options have been set, clicking the OK
button begins printing, e ither to the printer or to disk. A summary of the messages that
appear during printing is included later in this chapter. If you're using the Background
printing option in your Chooser, the print file will be spooled into the background so
you can continue working while the file prints. Background printing is also discussed
more fully later in this chapter.

Messages during printing
After the OK button has been clicked and printing has begun, PageMaker does a very
good job of informing you of what it is doing during the printing process. You are
informed of the page number and (if applicable) color separation currently being
printed and any fonts that are being downloaded . You also can see status messages that
are sent back from your printer. Two different dialog boxes appear during printing, one
of which provides the status messages and another that displays a progress thermometer and provides a Cancel button you can use to stop the printing. Another way to
monitor printing progress is to watch the page icons at the bottom of the publication
window, which are highlighted as each page is printed.
If you are using the Background printing option from the Chooser, the printing

messages flash by quite quickly as your file is spooled to your hard disk. You
can then, optionally, open the PrintMonitor window to watch the actual printing process. The PrintMonitor window, shown in Figure 17-5, provides much of
the same feedback information, including page status, font downloading
messages, and general printer feedback. You can also use PrintMonitor as a
second chance to cancel printing or to reschedule printing for a later time.

470

Part lll: Advanced Topics

Figure 17-5:
The PrintMonitor dialog
box shows the status of
background printing jobs.
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These are the messages that appear in the Print s tatus dialog box, and what they mean:
•

Looking for printer <printemame>. To begin the printing process, PageMaker
looks over your network for the PostScript laser printer corresponding to the
printer name last selected in the Chooser. If this printer is not available, an alert
box will appear. In this case, select the Chooser, select the correct printer, and
begin printing again.

•

Starting job. Your computer is now beginning communications with the
PostScript printer.

•

Busy. PostScript printers can process only one job, or file, at a time. If you are
not using Background printing, and another user is printing to the same printer,
you will be placed in a queue until the printer is available. If you do not wish to
wait, click the Cancel button and try again later or choose another available
printer.

•

Preparing printer. If the printer was just turned on and yours is the first document printed using LaserWriter driver 8.0 or later, this message appears as the
printer is prepared. Even though files like Laser prep (or Aldus Prep) no longer
exist, the PostScript printer s till needs to have a prep file loaded. This job is done
automatically by the LaserWriter 8.0 driver.

•

Preparing data. This message appears when PageMaker is translating your
publication into PostScript language and sending this information to the printer.

•

Processing job. While the PostScript interpreter inside your laser printer executes the PostScript code that represents your publication, the Processing job
message flashes.

•

Printing. This message appears while a page is being output, or printed, by the
printer.

Chapter 17: Printing Publications

4 71

•

Downloading fontname. As PageMaker automatically downloads font information to the printer, this message displays the name of the font being downloaded.

•

Fontname is not found. This message will appear in either of two cases: (1) Your

document contains screen fonts that are no longer available (dimmed in Font
pop-up menu), or (2) you are using a screen font for which no printer font is
available, either in the printer or for downloading.
As your document prints, the lights on your printer will flash to indicate activity and,
hopefully, progress. On some printers the flashing pattern of the lights actually has
meaning: Consult your printer's user manual for specific details for your printer. On
most Apple LaserWriters, for example, a double flash means that data is being received
by the printer, and a single flash means that the printer is processing data.

The Print... Command and Printing
Dialog Boxes
When you choose the Print ... command in most Macintosh applications, you get a Print
dialog box that is provided by the LaserWriter driver and consequently shows very
little variation from one application to another. In PageMaker however, choosing the
Print ... command produces a very different dialog box than that you find in other
applications. This dialog box includes four selectable sections that offer literally dozens
of new options to control the printing of your publication.

The Print document dialog box
When you choose the Print ... command (Command-P) from the File menu, the Print
document dialog box appears. This dialog box, shown in Figure 17-6, contains the most
basic and frequently used options for controlling the printing process, plus the Paper,
Options, and Color buttons with which you select other sets of options for morespecialized control over printing. The dialog boxes presented by each of these buttons
are described in the subsequent sections of this chapter. Also available is the Reset
button, which returns all options in the Print document dialog box to their default
settings.
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Figure 17-6:
The Print
document
dialog box.
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Using non-LaserWriter drivers
Even though PageMaker does not use the default laserWrlter Print dialog box, the
dialog box presented in PageM aker is specific to the LaserWriter driver. If you have any
other printer driver chosen when the Print. .. command is selected (for printing to an
lmageWriter, StyleWriter, or other QuickDraw printer), a similar but slightly different
dialog box appears (see Figure 17-7). It does not offer the Type option, as nonPostScript printers do not use PPD files, and it does not offer the Page independence
option since font downloading is also not an issue on non-PostScript printers. The
Paper button and dialog box are replaced with the Setup ... button and a dialog box
specific to the chosen printer that allows you to set the paper size and other printerspecific options .
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Figure 17- 7: The Print document dialog box for non-PostScript printers.
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The Print document dialog box options:
•

Print to: The name of the printer currently selected via the Chooser is listed
here. If this is not the printer to which you want to output your document, and
you do not intend to print a PostScript file to disk, click the Cancel button to
close the Print document dialog box, and use the Chooser to select the correct
printer. Using the Chooser to select your printer was discussed more fully earlier
in this chapter.

•

Type. This pop-up menu lists all of the PPD files (PostScript Printer Description
files) currently installed in the Printer Descriptions folder in your Extensions
folder. PPD filenames are abbreviations for the name of the printer they repr~
sent and the version of the PostScript interpreter installed in them. Dozens of
PPD files are provided and installed along with PageMaker 5, but you may also
obtain PPD files from printer manufacturers, Adobe Systems lnc., or your
Macintosh dealer.

Choose the one that corresponds to the PostScript printer on which you'll be
printing your publication.
•

Copies. Enter the number of copies that you want to print-any number from 1
to 32,000. In most cases, you should print only small quantities of your document
directly from PageMaker, since it is usually faster and more economical to
reproduce many copies of the publication by photocopying or offset printing.
In fact, to discourage printing of large quantities directly from PageMaker, earlier
versions supported a maximum quantity of only 100 copies. This limit has been
removed to support new PostScript printers that are specificaUy made to handle
large print runs, and should not be used to overwork poor old laser printers.

•

Collate. Checking this option forces PageMaker to print one complete copy of
the requested page range (or selected book list) before starting on the next copy.
This eliminates the need for manual collation but significantly increases printing
times. Using the Collate option slows printing because it forces the printer to r~
image each page for each copy of the publication. Without collation, the page is
imaged only once, and then all necessary copies are printed at that time.

•

Reverse order. Most printers normally print your pages in sequential order,
although some naturally print in a last-to-first order. This option allows you to
reverse your printer's natural page sequence, so that if you usually get the first
page first, you'll instead get the last page first; and if you usually get the last page
first, you'll instead get the first page first.

~-

Proof. Printing graphics, especially bitmapped images or TIFF files, is one of
the slowest aspects of printing any page on a PostScript printer. This
option removes all graphics from your publication and replaces them with
rectangle placeholders. This allows you to proof the copy and basic page
layout without wasting time printing the graphics. It may be the best kept
secret in printing productivity.
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•

Pages r::> All. This option causes every page of the publication to be printed. If
the Print all publications in book option is also selected, every page in every
document in the book list will be printed too.

•

Pages r::> Ranges. New to PageMaker 5, this option lets you specify individual
pages for printing, a range of pages you want to print, or any beginning or ending
portion of the publication that you want to print.
To print individual pages, enter their page numbers separated by commas
(3,7,19). To print a range of pages, enter the first and last page numbers in the
range separated by a hyphen (6-9). To print a beginning section of the publication, enter a hyphen and then the last page number in the beginning section ell). To print an ending section of the publication, enter the first page number in
that section and then a hyphen (26-).
You can also combine these different notations. For example, to print pages 3, 5,
12, 14 through 26, and 39 through the end of the publication, you would enter:
3,5,12,14-26,39-. To print page 77,9 through 15, and all pages up to 6, you would
enter: 77,9-15,-6.

•

Print blank pages. Pages that have no elements (except perhaps Master-page
elements) are normally suppressed from printing in order to avoid wasted paper
or film. If you want to print the blank pages in your publication, click this option.

•

Print r::> Both/Even/Odd. Use these options to limit the pages printed to either
only even-numbered pages or only odd-numbered pages. These options apply to
both the Print r::> All or the Print r::> Ranges options; so even if you specified a
range of pages that includes even page numbers but clicked the Odd option, only
the odd-numbered pages would print.

•

Page independence. This option affects how font use is managed within the
pages of your publication when it is downloaded to your printer or printed to a
PostScript file on disk. Normally all necessary fonts are downloaded at the
beginning of a file, and then every page of the publication assumes the fonts are
available. When this option is selected, however, font calls (which cause downloading when the font is not already present) are made on a page-by-page basis.
This can increase the size of print-to-disk files, and may require more memory in
the PostScript printer, but provides additional flexibility in how print-to-disk files
can be used.
You will not normally use this option when printing directly to a printer, or if you
are printing to disk and your publication will later be downloaded directly to a
printer. You may need to use this option if your print-to-disk file will be manipulated with a separation, imposition, or trapping program that handles fonts
differently than PageMaker. Your prepress service bureau should tell you if the
use of this option will be necessary for your files.
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•

Print all publications in book. Checking this option causes the print job to
include all publications in the current book list. (If there is no current book list,
this option is dimmed.) When printing all publications in a book, the Pages <> All,
Pages ¢ Range, Print <> Both/ Even/Odd, Print blank pages, and Page independence options are honored for all publications printed. If the Pages <> Range
option is used, publication pages are not renumbered, even if one of the Auto
renumbering options is selected in the Book list dialog box. For more information
about building a book list, see Chapter 16, "Long Document Features."

•

Use paper settings of each publication. When using the Print all publications in
book option, checking this option instructs each publication to use its own Size
and Source settings from its Paper print options dialog box. This makes it
possible to use a different amount of paper and/or paper tray for each publication in the book list. (More details on these options are provided later in this
chapter.)

•

Orientation. This option provides you with control over how each page in your
publication is oriented as it is printed. A page can be Tall (taller than wide) or
Wide (wider than tall), as indicated by the two icon buttons. In most cases, this
will match the orientation of the publication pages as set in the Page setup dialog
box, but when printing to imagesetters, you may want to rotate the page to use
paper or film more efficiently.

After setting the options in the Print document dialog box, you can proceed in several
ways:
•

Oick the Paper, Options, or Color button. Each of these brings up another set of
options, as described in the rest of this section, that control your printing.
•

Hold down Shift and click Print (or Save). This trick saves all the settings
you've made in the Print, Paper, Options, and Color dialog boxes as the
current defa ult settings but does not initiate a print job.

•

Click the OK button. This initiates the actual printing process. More information
about this process is provided later in this chapter in the section "Messages
during printing."

•

Click the Cancel button. This cancels the printing process and returns you to
the publication window.
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Printing changes In PageMaker 5
The fact that PageMaker no longer uses its own Aldus Prep file in the printing
process is the most visible change in PageMaker printing, but there are a number of
other changes, some subtle, some technical, that you may want to know about.
PageMaker does not " talk" directly to your PostScript printer anymore; instead
it relies completely on the selected PPD file to tell it about the printer, available
RAM, and downloaded fonts. This is why it is vitally important to select the
correct PPD file and to use the Update PPD Addition if the RAM or downloaded
fonts on your printer have changed.

{

~

When used with LaserWriter driver 8.x or later, PageMaker generates its own
PostScript code, which it passes to the LaserWriter driver for sending to the
printer. When other printer drivers are used (LaserWriter 7.x, StyleWriter, etc.),
or if you hold down the Option key while choosing the Print. .. command,
PageMaker instead sends its QuickDraw information to the printer driver and
lets the driver create the PostScript.
PageMaker is fully compatible with all standard background printing, including
System 7's PrintMonitor. Using the PrintMonitor frees up your computer for
your use while printing takes place in the background but does slow down the
printing process. If you want to disable background printing in order to get
faster pages off your printer, open the Chooser and tum Background printing off.

I

PICT graphics are converted by the LaserWriter 8.x driver into PostScript
commands and EPS files, w hich are sent to the printer. This process requires
adequate free space on your hard drive, takes some extra time, and increases
the chance of printing problems. When possible, save graphics in the EPS file
format w hen they are created, rather th an using the PICT file format.
PageMaker 5 allows three supplemental files to be used along with its own
PostScript code during printing. It looks in the Aldus folder for files named
albefore.ps, alafter.ps, and alerror.ps, and downloads both albefore.ps and
alerror.ps before the print job, and sends alafter.ps after the print job. The
alerror.ps file is the most commonly used, to download a professional PostScript
error handler that provides more comments when a printing error condition
occurs. To have the alerror.ps file downloaded, you must select the Include
PostScript error handler option in the Options dialog box in the Print dialog box.

-

,...

.-

-

I

'
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The Paper options dialog box
Clicking the Paper button in the Print document dialog box causes the box to become
the Paper options dialog box. Tills dialog box, shown in Figure 17~. contains these options:
Poper
P.apt r
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Figure 17-8: The Paper options dialog box.

•

Size. This pop-up menu provides a list of the paper s izes available for the current
printer based on the PPD file you've s elected. Some PPD files also provide a
Custom ... option that allows you to set any paper s ize you need. The physical
dimensions of any paper size you select will appear to the right of the Size
option. The printable area of that paper size appears below the Source option.
Most laser printers can only print to within Y-1 to ~ inch of their edges. The Print
area refers to the usable area on that piece of paper when being printed on the
output device currently selected. For example, when the Letter paper s ize is
selected, the Size is listed as 8.5 by 11 inches for eit her the Apple LaserWriter NT
or for the Linotronic 100; however, the Print area will be only 8 by 10 inches for
the LaserWriter NT, because the printer cannot actually print to the physical
edges of the paper; but the Print area will be 8.5 by 11 inches for the Linotronic,
because it is capable of printing to the physical edges of the paper. Any elements
in your publication that are positioned outside the Print area for the selected
paper size will not appear on the printed page. Most imagesetters can print edge
to edge at most paper s izes.
In order for your document to print correctly, you must choose a paper size at
least as large as the page s ize you selected in the Page setup dialog box. Additional space must be provided for printer's marks and page information such as
crop marks, registration marks, separation names, etc. If your paper size is not
large enough for your pages, you can use the Scale options to reduce your
publication, or print using the Tile option, as described in the next section.
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The amount of space required, in addition to the page size, to fit extra marks on printed
pages:
Option

Vettlcal Space

Horizontal Space

Printer's marks

.75 inch

.75 inch

Page information

.5 inch

.5 inch

Both

.875 inch

.75 inch

•

Source. This pop-up menu presents the paper trays available for the current
printer based on the PPD file you've selected.

•

Center page in print area. Your pages are normally centered within the physical
boundaries of the selected page size, but on some output devices you may want
to use this option to center the pages within the printable area instead.

•

Tile. The Tile option is used when your publication pages are larger than the
paper on which you need to print your file(and you don't want to print the page
at a reduction), or if you want to enlarge your pages so that they are larger than
the largest available paper size. Tiling allows PageMaker to print each page in
your publication in sections that can be pieced together after printing, as shown
in Figure 17-9.
You can control tiling manually or have PageMaker do it automatically. lf you
select the Manual tiling option, you print each section of your page individually,
manually setting the exact portion of the page to be printed on each tile. To do
this, position the ruler zero point in the publication window to designate the
upper left corner of each section you want to print. Then, with both the Tiling
and Manual options selected, click the OK button (or press the Return or Enter
key) to print the specified section. Continue this process, adjusting the zero
point to specify another section of the page and then clicking OK in the Print
document dialog box until all necessary sections of the page have been output.
The main benefit of manual tiling is that it allows you to control how a page is
broken into sections and avoid page breaks that would make it difficult or
impossible to reassemble the page accurately.
The Auto overlap option, on the other hand, instructs PageMaker to automatically create all the tiles required to print each page. When this option is used,
PageMaker starts at the upper left corner of each page and continues to print
sections of the page until the entire page has been output. Each section overlaps
all other sections by the amount of space specified in the option box following
the Auto overlap option. A larger overlap will result in easier reassembly (by
avoiding awkward breaks) but will require more sections per page.
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Figure 17-9: The Tile option lets you print large pages across multiple sheets of paper for later
reassembl .

•

Scale. To print your publication at any size other than 100% of normal size, use
one of these three options. The Scale option itself allows you to enter any
reduction or enlargement percentage between 5% and 1600% of current size, in
increments of .01%. Of course, enlargements may not fit on the selected paper
size so you may have to use the Tile option as well. When a page is printed at
either a reduced size or an enlarged size, the printed page is drawn to the center
of the paper.

•

Scale c:> Reduce to fit. This option automatically calculates the amount of
reduction necessary to fit the current page size on the currently selected paper
size within the current printable area. If the Printer's marks and Page information
options are chosen (described later), the reduction also makes sure these fit on
the printed page.
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To manually calculate the reduction percentage needed to reduce a document to fit, divide the horizontal print area of the paper by the horizontal
page size (such as 8/ 8.5 = 0.941) and the vertical print area by the vertical
page size (such as 10.5/ 11.5 =0.913). The smaller result corresponds to the
largest possible percentage of the original size, in this case, 91.3%.
Scale .::> Thumbnails. Selecting the Thumbnails options allows you to print
images of several pages of your publication on a single page, at a reduced size.
As shown in Figure 17-10, thumbnails allow you to view several pages simultaneously for design, both individually and in relation to each other. The option
box to the right of the Thumbnails option specifies how many pages are to be
printed on a single s heet of paper-the more thumbnails per page, the smaller
the size of each one.

...
AA

Figure 17-10: Printing thumbnails allows you to preview the general appearance of your
publication.

After setting the options in the Paper options dialog box, you can proceed in several
ways:
•

Click the Document, Options, or Color button. Each of these brings up another
set of options that affect printing. (fhe Document options are described in the
preceding part of t his section; the Options options and Color options are described in the following part of this section.)

•

Click the OK button. This initiates the actual printing process. More information
about this process is provided later in this chapter in the section "Messages
during Printing."

•

Click the Cancel button. This cancels the printing process and returns you to
the publication window.
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The Options dialog box
Clicking the Options button in the Print document dialog box causes the box to become
the Paper options dialog box. This dialog, shown in Figure 17-11, contains the options
described here.
Figure 17-11:
The Options
dialog box.
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These options are in the Options dialog box:
•

0

Graphics <> Nonnal, Optimized, Low TIFF resolution, Omit TIFF files. This set
of options determines how much data from your imported bitmapped and TIFF
images is sent to the printer. They do not affect EPS graphics. Using these
options can reduce printing time by limiting the printed quality of your TIFF
graphics. They present an alternative to the Proof option in the Print document
dialog box, which temporarily removes all imported graphics.
The Normal option sends all of the data so that the printer can produce the
highest quality representation of the image. The Optimized option resamples the
data in your images, on the fly, to eliminate extra data in the graphics. Extra data
means that the image was scanned or created at a resolution that is more than
twice the current line screen of your output device. In this case, the printer could
not use all of the data the graphic includes, so PageMaker discards some data in
order to speed printing. Unfortunately, this on-the-fly resampling may affect your
image quality, so you are better off either resampling the graphic in Adobe
Photoshop or Aldus PrePrint, rescanning it at the correct resolution, or printing
using the Normal option, which may be slow but will not sacrifice quality.
The Low TIFF and Omit TlFF options are the real time-savers and are not meant
to be used for final output. Low TIFF prints any TIFF or bitmapped graphics at 72
dpi, so you can see them, but not at their maximum resolution. Omit TIFF cuts
the TlFF graphics out altogether.
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Markings c:> Printer's marks. Selecting this option adds crop marks, registration

marks, density-control bars, and a color-control bar to your printed pages. (Colorcontrol bars appear only when printing separations or to a color composite printer.)
Crop marks are used to trim your pages down to their final size after printing.
Registration marks are used to align the various separations in a color printing
job so that all colors and elements appear in their proper locations. Densitycontrol bars print samples of each process or spot color used, in 10% increments, and help your service bureau or commercial printer check the calibration
of the imagesetter on which your pages are printed. Color-control bars show
100% and 50% tints of the process colors and combinations of the process
colors. These can be used to check color on a color printer, or they can be used
by your service bureau or commercial printer to check the quality of your pages
before and after printing. These marks will not show if the selected paper size is
not large enough. Figure 17-12 shows a page containing marks. A table earlier in
this chapter detailed the space requirements for the marks.
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Figure 17-12: A page output with crop marks and color-separation marks.

Chapter 17: Printing Publications

483

•

Markings ¢ Page information. Selecting this option adds the filename, page
number, current date, and color separation name (in 8-point Helvetica) to the
lower left corner of each page in your publication. These marks will not show if
the selected paper size is not large enough.

•

Send Data ¢ Faster (binary), Nonnal (hex). These options affect the format in
which data from your TIFF images and bitmapped graphics is sent to your
printer. They do not affect printing quality.
The Faster (binary) option cuts down on the time it takes graphics to be sent to
your printer, but if you experience printing problems (such as timeout errors),
you can use the Normal (hex) option to improve the chances of successful printing.

•

PostScript¢ Include PostScript error handler. In the past, the only feedback
you got when a document failed to print was a message that said "Document is
OK but cannot be printed." Not very helpful. This option gives you the opportunity to have the PostScript error handler downloaded into your printer, which
will cause a page to print whenever an error occurs, documenting the PostScript
error type, the PostScript command that caused the error, and a possible solution
to the problem. In order to really benefit from this information, you'll usually
need some understanding of the PostScript language, but you can also use this
information when you call Aldus T~chnical Support to discuss a printing problem.
A simple PostScript error handler is provided along with PageMaker, but
service bureaus and other professionals may wish to purchase a thirdparty error handler that offers additional error information. You should not
use this option when printing files to disk for output at a service bureau,
unless the service bureau requests that you do so, because printed error
pages would waste their film and could result in additional charges on your
output bill.

•

Write PostScript to file. Rather than printing your publication directly to a
PostScript printer, this option lets you capture the PostScript file created by the
printing process in a disk file that can be easily transported for remote printing
or used in some post-processing application like Aldus TrapWise or Aldus PressWise.
If your document is going to be printed at a remote location (such as a
service bureau), there are two potential benefits of printing a PostScript file
to disk instead of just sending the original PageMaker publication. First, it
avoids the possibility of not having all the screen fonts that are used in the
document available when the file is printed. You can also optionally include
any PostScript printer fonts that may not be available at the remote location. Second, it makes it impossible for anyone to accidentally change any
aspect of the publication.

By default, the name of the PostScript file you create is set as the existing publication name plus the extension .ps. If you choose the EPS or For separations
options (described next), other default names appear. You can change the name
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of the file being created by making any desired modifications to the name as it
appears after this option. The PostScript file is saved to the same location as
your publication file, by default, but you can click the Save As ... button to select
any other location where you want the PostScript file to be saved.
•

PostScript <> Nonnal, EPS, For separations. These three radio buttons determine the format of your PostScript disk file. The Normal option creates a standard PostScript file, ready for downloading, containing all pages in your publication or book. The EPS option creates an EPS file for each page of your publication
or book. Each page is automatically named with the existing publication
filename, plus an underscore, the page number, and the .EPS extension. (So a
publication named January News would create EPS files named January
News_I.ESP, January News_2.EPS, and so on. You can use this option to save a
page from a PageMaker publication for use in other applications or even within
another PageMaker publication, as shown in Figure 17-13.

INSIDE
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For A Fragile
Planet .•.
pg 3.

Studio VIa ...
pg 5 •

't i A

• • •

••

ot

The VIa
Collection ...
pg 3 .

•

Figure 17-13: Creating EPS files from pages in your publication allows you to use page
miniatures in your own table of contents, as shown here.
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The For separations option creates an OPI-compatible file that can be used in
Aldus PrePrint, Aldus TrapWise 2.0, or other OPI-consuming post-processing
applications. OPI files are automatically named with the publication filename and
the .SEP extension.
•

Include downloadable fonts. Selecting this option tells PageMaker to include in
the PostScript file the PostScript printer fonts associated with any PostScript
screen fonts used in the publication, unless these fonts are listed by the PPD file
as being already resident in the printer.
In order for PostScript printer fonts to be included in the file, they must reside in
the System folder, in the Fonts folder inside the System folder, or in the same
folder as any screen fonts added using MasterJuggler or Suitcase II. If a
PostScript screen font is used in the publication but its printer font is not available, it cannot be included, and the font will print incorrectly (Courier will be
substituted) if it is not first downloaded to the output device before printing.
Using this option dramatically increases the size of PostScript files, and many
service bureaus do not want you to use this option anyway. Be sure to check
with your service bureau to see if it has the fonts your document requires and, if
not, whether it wants you to include them in your PostScript file. Figure 17-14 shows
the message displayed when a font is being down loaded. Figure 17-15 shows the
message that appears if the font is missing.
Document: PM Demo Pub ; printer: Turbolaser/ Dne
Status: Downloading Font: GIIISons-Bold

Figure 17-14: The Print status dialog box as it appears while downloading a font.

Document: PM Demo Pub; printer: Turbolaser/ One
Status: Font Gill Sans- Bold Is not found onTurbolaser/ One,
subtltuting Courter.

Figure 17-15: The Print status dialog box as it appears when a required printer font is not
available and the Download bitmap fonts option is deselected.

•

Extra image bleed. When creating PostScript files, PageMaker normally includes

only those elements, and parts of elements, that fit within the page margins. This
option changes that default, including up to one inch of extra bleed in the file for
cases when your PostScript files will be post-processed using applications like
Aldus TrapWise that will take advantage of this extra data.
•

Launch Aldus PrePrint. This is the "day late and dollar short" command. It
exists because back when PrePrint was the only PageMaker alternative for
creating color separations, Aldus got a lot of flack regarding the number of steps
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necessary to use two different programs to create separations. Using this option
causes Aldus PrePrint to be launched automatically and the PostScript file
opened when the For separations option is used. This command is available only
when running System 7.0 or later.
Now that PageMaker can produce color separations directly and PrePrint has a
very questionable future, the inclusion of this command is a sad testament to the
kind of decision making and feature prioritization that Aldus has practiced in the
past but needs to avoid in the future. This isn't to say PrePrint isn't a very good
tool or one that is no longer needed in the face of PageMaker 5. ln fact, I think it is
a very underrated piece of software. But this method of integration is sadly
lacking. See Chapter 19, "Aldus PrePress Tools," for a complete discussion of
Aldus PrePrint.
•

Use Symbol font for special characters. Many fonts do not have some important
Symbol CharaCterS (including @,@, TM , L, Jt, J. Q, -,,~'and:?:) in the "standard"
Macintosh locations. Using this option causes the actual Symbol font, which is
automatically installed in all versions of the Macintosh System Software, to be
used instead of the selected font when the corresponding key combinations are
used in the file, in order to ensure that these symbols are printed correctly.
This feature provides a useful safety net when documents include symbols
and are first generated in a word processing program using some standard
Macintosh font Qike Times, Helvetica, or even Geneva) that provides all the
standard characters in their expected locations. When a document like this
is transierred into PageMaker and formatted in a less standard font, especially in PostScript fonts not from Adobe Systems, there is a good chance
that symbol characters will not translate correctly. Using this option can
save you the trouble of manually locating every symbol and resetting it
using the correct key combinations for the particular font you are using.
The downside of this option, however, is that the resulting Symbol font
characters, which are designed to match either the Times or Helvetica
fonts, may stand out as a different type style than the font(s) used in the
rest of the publication.

After setting the options in the Paper options dialog box, you can proceed in several ways:
•

Click the Document, Paper, or Color button. Each of these brings up another set
of options that affect printing. (fhe Document options and Paper options are
described in the preceding part of this section; the Color options are described
in the following part of this section.)

•

Click the OK button. This initiates the actual printing process. More information
about this process is provided later in this chapter in the section "Messages
during printing."

•

Click the Cancel button. This cancels the printing process and returns you to
the publication window.
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The Color dialog box
Clicking the Color button in the Print document dialog box causes the box to become
the Color options dialog box. This dialog box, shown in Figure 17-16, contains the
options described next.
Figure 17-16:
The Color
dialog box.
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The options in the Color dialog box are:
•

Composite/Color Composite. When a document contains colored elements, you
use this option to print all elements in the document on a single piece of paper or
film. In other words, this is how you print a color document without making
color separations. If the current printer is a non-color (grayscale) printer, the
option is titled Composite; if it is a color printer, the option is titled Color.
When printing a composite version of a publication on a non-color printer, each
color is represented by an appropriate level of gray when the default Composite
option is selected. Alternatively, you can click the Print colors in black option,
and all elements will be printed as 100% black in color regardless of their actual
color.
When printing to a color printer, each color in the document is printed as
accurately as possible on the selected printer. If you want to defeat the colors
from printing and instead print all colors as black (I'm not sure why you would
do this, however), you can use the Print colors in black option.

•

Separations. The alternative to making composite prints is to print separations,
where each spot or process color on each page is printed on its own separate
sheet. A document containing both process-color elements plus.three spot
colors would then produce seven printed pages for each publication page (one
page for each of the four process colors plus one page for each spot color.)
Printing separations prepares the file for color reproduction via commercial
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printing. Before producing separations, you s hould review Chapter 14, "Working
with Color," read the Commercial Printing Guide provided with your PageMaker
documentation, and talk to your commercial printer.
If you choose the Separations option, you can optionally defeat the printing of

any one color and convert all spot colors into process colors, using the Color list
options described next.
If the Write PostScript to file option and the EPS option are selected in the

Options dialog box, the Separations option is dimmed and unavailable.
•

Color list. Below the Separations option is a scrolling list of every process and
spot color used in your publication. The word Process precedes each of the four
process colors (cyan, magenta, yellow, and black), and all other colors are spot
colors. A check mark a ppears to the left of colors that are selected for printing.
To toggle this check mark to include or remove a color, double -click on the color
name or select the color and click the Print this ink option. Use the Print all inks
or Print no inks buttons to turn on or off all of the colors.
H your document uses process colors, and you want to convert all of the spot
colors to process so that only four color separations will be produced for each
page, click the All to process button. Note that this conversion occurs for
printing purposes only-the spot colors remain defined and applied to the
elements in your publication. If you want to convert a single spot color to
process, you'll have to close the Color dialog box and return to the Edit color
dialog box for the color you want to convert and select the Process option. (fo
get to the Edit color dialog box, choose Define colors from the Element menu,
select the color, and then click the Edit. .. button.)

•

Mirror. When printing negatives on high-resolution imagesetters, the Mirror
option is used to set emulsion up or down, depending on how film is loaded into
the imagesetter. You'Ll have to ask your service bureau how this option should
be set. It is normally selected to achieve right-reading emulsion dov.'ll or wrongreading emulsion up output, and deselected to achieve right-reading emulsion up
or wrong-reading emulsion down output.

•

Negative. The Negative option prints a negative image of the publication, making
all black items clear, all white items print black, and all screened items at 100%
minus their value (80% screens will print at 20%, 20% screens at 80%). See Figure
17-17 for an example.

•

Preserve EPS colors. PageMaker lets you edit the colors used in any imported
EPS graphics, as d escribed in Chapter 14, "Working with Color." Checking this
option causes all EPS graphics to print with their original colors, as they were
imported regardless of any changes you have made to those colors within
PageMaker. If this option is not selected, EPS graphics will print using any color
modifications you have made in PageMaker.
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Figure 17-17: The Image and Negative options are used to print to film as positive or negative
images.

•

Optimized screen. When printing colors or halftones, the screen ruling and
angles used in the halftoning process are critical to the quality of the resulting
output. Screen rulings determine the number of halftone cells that print per
linear inch and, along with the resolution of the output device, thereby determine the number of shades of gray (or the number of tints of a color) that can be
produced. Angles (or screen angles as they are more commonly called) determine the orientation of the lines in a halftone cell for each specific color. Each of
the four process colors is normally set at a varying angle so that the colors
appear to blend as smoothly as possible. When incorrect angles are used,
unsightly moire patterns become apparent in the final printed document.
The current PPD file provides PageMaker with information regarding the proper
screen rulings and angles as defined by the printe r manufacturer. Usually there
are more than one set of possible screen rulings and angles, and several resolutions at which the printer can be used. The Optimized screen option lets you
choose among the available combinations of screen rulings and resolutions.
Each of these combinations carries with it specific rules and angles for each
process color.
To select a screen ruling and resolution, click the Optimized screen option popup menu and choose among the available combinations, as shown in Figure 1718. Your choice for this option should be discussed with your service bureau
and commercial printer, as limitations posed by the imagesetter that will be
used to output your publication and the press on which your document will be
reproduced usually determine the optimum screen ruling and resolution for
your job.
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190 lpl I 3306 dpl
1011pl l 2540 dpl
./ 132 Ipi I 2540 dpl
157 lpl I 2540 dpl
1121pl I 2032 dpl
09 lpl I 1693 dpl
132 1pl I 1693 dpl
IOIIpl I 1270 dpl
I 09 1111 I 1270 dpi
104 lpl l 3396 dpl I HQS
120 lpl I 3396 dpl I HQS
133 lpl I 3396 dpl I HQS
199 lpl I 3306 dpl l HQS
100 tpl I 2540 dpl I HQS
11 2 lpl I 2540 dpi I llQS
120 ,,,, / 25-10 dpi : llQ\
130 lpl I 2540 dpl I HQS
ISO lpl l 2540 dpl I HQS
96 lpl I 2032 dpl I HQS
Ill lpl I 2032 dpl I HQS
75 lpl I 1693 dpi I HQS
06 lpl I 1693 dpl I HQS
120 lpl I 1693 dpl l HQS
75 lpl I 1270 dpl I HQS
9 0 lpl I 1270 dpl I HQS
I 00 lpl l 1270 dpl I HQS
75 lpl I 046 dpl I HQS

Figure 17-18: The Optimized screen option pop-up menu presents screen rules and resolution
options for the selected printer.

When you have selected a screen ruling/resolution combination, specific angles
and rulings are applied to each process color and spot color in your publication.
These values will apply to all elements in your publication, except those images
for which the angle or rulings have been modified in the Image control dialog
box. You can see the resulting angle and ruling for any specific color by selecting
that color from the color list and looking at the values in the Angle and Ruling
option boxes. You can modify any individual angle or ruling, but this is highly
discouraged unless you have been directed to do so, or have consulted with,
your service bureau and commercial printer. If you modify any values for the
Angle or Ruling options, the Optimized screen option will read Custom, indicating that a change has been made to the va lues provided by the PPD file.
After setting the options in the Paper options dialog box, you can proceed in one of three ways:
•

Qlck the Document, Paper, or Options button. Each of these brings up another
set of options, as described in the preceding parts of this section, that affect printing.

•

Click the OK button. This initiates the actual printing process. More information
about this process is provided earlier in this chapter in the section "Messages
during printing."

•

Click the Cancel button. This cancels the printing process and returns you to

the publication window.
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••••••••••••••••••••••••••••••••••••••••••••••••
Summary
•

Before you print your publication, you should check your document for
common items that cause printing problems. These include incorrect page
sizes, page elements placed beyond the printable margins of the printer,
incorrectly scaled graphics, use of incompatible font formats, sloppy text
blocks, and unnecessary page elements.

•

Also before printing you must use the Chooser to select at least a printer driver
and, unless you are going to print a PostScript file to disk, the specific printer
you want to print on. Also, the Chooser is used to tum on Background printing.

•

The Print dialog box is really four dialog boxes in one, which you control with
four buttons along the box's right edge. When printing to PostScript printers,
these are the Print document dialog box, the Paper options dialog box, the
Options options dialog box, and the Color options dialog box.

II The Printer Styles Addition lets you save printing settings into style sheets and
batch-print many different publications with many different printing option
settings.
•

While your publication prints, PageMaker provides messages regarding printing
status, font downloading, and printing errors .

••••••••••••••••••••••••••••••••••••••••••••••••
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c
H
A

Sample
Project Three
In this chapter, you will use PageMaker to create a four-page catalog that includes a
graphic, a photograph, a price list, and two spaces for advertisements. The step-by-step
creation of this catalog, shown in Figure 18-1, is the last of three sample projects
presented in this book. This chapter focuses on the most-advanced commands and
operations offered by PageMaker and, as always, demonstrates how these features can
be used to satisfy a wide variety of your publication needs.
The files you'll need for this project are found in the PM Bible Ch18 Files f folder on the
included disk. These files include the text and graphic images.

Creating Your Publication
I. To begin creating your publication, you must first launch PageMaker. Once the
launch has completed, click your mouse button to dispense with the copyright
screen.

Changing default settings
Before creating a new file, you will first alter a few application default settings in PageMaker, just as you did in the second sample project. The defaults you will change
include the system of measurement, the line weight and fill value, the column guides,
and a variety of commands under the Utilities, Layout, and Windows menus.
2. Choose the Preferences ... command from the File menu to display the Preferences dialog box. Select Inches decimal from the Measurement system and
Vertical ruler pop-up menus and press Return. Unlike inches shown on a standard ruler, decimal inches are divided into tenths and twentieths. This means
that you may be asked to position your cursor even with the 7.8-inch mark on
the horizontal ruler and the 4.15-inch mark on the vertical ruler. All measurements will be annotated in decimals, rather than fractions.
3. Now choose the Column guides ... command from the Layout menu to bring up
the Column guides dialog box. Enter 2 for the Number of columns option. Then
press the Tab key, enter 0.25 to replace the Space between columns value, and
press Return.
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Figure 18-1:
Creation of
the advancedlevel, fourpage catalog
is described in
this <;hapter.
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4. Choose the 2 pt weight from the Line poJrup listing and None from the Fill po(r
up listing in the Element menu.
5. Throughout this book, I have described a number of commands that toggle
various PageMaker attributes on and off. The following list contains the name of
the toggling commands that you will use in this project and the effects of each:
• Rulers: displays horizontal and vertical rulers.
• Snap to rulers: creates an invisible grid corresponding to each ruler
tick mark.
• Guides: displays margins and column guides and allows you to create
ruler guides.
• Snap to guides: cursor snaps to margins, column guides, and ruler
guides.
• Autoflow: automatically pours a placed text file into specified columns,
adding pages to a document if necessary.
You will also use the following Windows menu commands:
•
•
•
•

Toolbox: displays the toolbox.
Scroll bar: displays the scroll bars.
Control palette: displays the control palette.
Style palette: displays the Styles palette beneath the toolbox, containing a scrolling list of all available style sheets.
If any of these commands under either the Layout or Windows menu is not
checked, you should choose it at this time. When you are finished, your Layout
and Windows menus will look like those shown in Figure 18-2.

Help ...

Sh0111 ciJtoard
Collmn glides...

v'Ruler>
:leR
v'Snap to rulers :ill[

Zero loc~
Go topage... :leG f--- - -- - 1
Insert pages. ..
./Guides
:JeJ
Remove pages... ./Snap to glides aeu
Loc~ guides
Display master ltemrd - - - - -C~y ITklSllY guides ./Scroll barS

-1

Tie
Cascade
./Tool palette
./Style palette
./Color palette
Controlpalette
Lilrary palette

38 6
:ICY
:JeK
:ill'

v'Autotlow

Figure 18-2: The default settings in the Layout and Windows menus for this sample project.
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Creating a New Document
6. You are now ready to begin creating your catalog. Press Command-N to access
the Page setup dialog box. The options in this dialog box should be set as
follows:
Page size: Letter

Double-sided: not selected

Orientation: Tall

Facing pages: dimmed

Start page #: 1

Margin in inches: Left: 1, Top: 2, Right: 1, and Bottom: 1

# of pages: 4

When you have finished entering and selecting the specifications listed here, press the
Return key to instruct PageMaker to create your new document, as shown in Figure 18-3.

Figure 18-3:
The new
document
w indow,
displaying
default
column
guides,
deci mal inch
rulers, and
the onscreen Styles
palette.
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Preparing the master page
As always, your first step is to define and create items on the master page. In this
case, your master page will contain not only a system of ruler guides, but also a
banner at the top of the page. The banner, which you will input directly into
PageMaker, represents the name of the publication.
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You will also learn how to create a master page folio. A folio contains general information and is positioned at the top or bottom of each page of a document. The text of the
folio may include the name of a document or its issue date, along with the current page
number.
7. Click on the right master page icon, labeled Rat the bottom of your display. After
the master page appears, drag two guides down from the horizontal ruler. One
guide should be positioned at the 1.0-inch mark on the vertical ruler, and the
other at the 1.8-inch mark. Next, drag two guides from the vertical ruler, positioning them exactly even with the two outermost column guides (flush with the left
and right margins). These guides will provide a gridwork for text blocks created
in the areas above and below the margins.

Creating the banner text
8. Zoom in to the Actual size view mode by Command-Option-Clicking in the center
of the two-inch area above the top margin ruler guide. Then select the text tool.
Drag from the intersection of the upper ruler guide and the left margin to the
intersection of the lower ruler guide and the right margin. This determines the
column width of your banner text.
9. Type The Money Catalog. This text will display in the current default type and
paragraph specifications. lf you haven't created anything since the last sample
project, your text will be in 48/50 Palatino Bold-Italic. But it really doesn't matter;
you will be changing the type specs in the next step.
In previous sample projects, you altered the type specs of one or more selected words
either by choosing options from the various pop-up commands in the Type menu or by
accessing the Type specifications dialog box. This time, however, you will specify the
appearance of your text using style sheets. Style sheets contain specifications that you
use to quickly format entire paragraphs, including font, type style, size, leading, horizontal scaling, tracking, alignment, indents, tabs, and more.
In PageMaker, style sheets are easy to create, edit, and apply. When used properly, they
provide consistency for your publications and reduce formatting errors. If you want two
paragraphs in a document to be identical in font, style, and so on, you merely choose
the same style sheet for both. For example, all of your headlines can be set in one style,
all your subheads in another, and all body text in still another. If you later decide to
change the type specs of a group of paragraphs, you can ed it the style sheet directly. All
paragraphs to which that style has been applied will change, even if they are themselves separated by other paragraphs whose specifications you don't want to change.
Style sheets save time and help to minimize errors and inconsistencies.
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10. While your text entry cursor continues to blink in your text block, click on the
Headline option in the Styles palette. Immediately, your first line will change to
30-point Times-Bold, flush left, as shown in Figure 184.

· · ···T"h·e-1\toiiey··caiatog]' ... .. . . .... . .. . ... . .. ..... . . . .. . . . ,..... ...
········:·····················································································································:·········

Figure 18-4: The effect of applying the Headline style sheet to the first line of banner text.

Headline is one of PageMaker's default style sheets, available anytime PageMaker is
launched. Unfortunately, 30-point Times-Bold is not well suited to this project. Times
and Palatino do not generally complement each other, so Times is a poor choice for
your banner. You will change these type specs by altering the Headline style sheet.
11. Select the arrow tool to deselect your text. Although this is not an essential step,
it will demonstrate that changing a style sheet also changes text tagged to that
style, whether or not the text is currently selected.
12. To edit the Headline style, choose the Define styles ... command from the Type
menu or press Command-3. The Define styles dialog box that appears provides
full control over the manipulation of style sheets. Here, you can create a new
style by clicking the New ... button, alter an existing style by clicking the Edit ...
button, delete a style with the Remove button, and access any style contained in
other PageMaker files by clicking the Copy ... button. The scrolling Style list
contains the same style sheet names that are available in the Styles palette.

Chapter 18: Sample Project Three

499

13. Click on the Headline style to select it. Notice that the specifications of the
Headline style appear beneath the Style list. You can see that the Headline style
sheet currently includes the typeface Times Bold, a 30-point type size, Auto
leading, and so on, as shown in Figure 18-5. This display of type specs can be
used to quickly determine the attributes of any style sheet when you select its
name from the scrolling style list.

Define styles
Style:

I[

OK

]I

[ Cancel ]

92 Footer,Fl
93 R Footer, F2
94 Side bleeder
95 Chopter number
99 Keybd equius

~N! lorl:lrm oftl a•····~

·--····---------···
[New ••. ]
[ Edit ... )
[Remoue ]
[Copy ... ]

ntxt: S~mt stvlf. + f.ace : Tirnts +bold+ size: 30 +

lf.-JinO: IUtO + flush ltoft + inol TQC + htj phe-nation

Figure 18-5: The Define styles dialog box, with type specs for the Headline style displayed below
the scrolling list.

14. Click on the Edit ... button, displaying the Edit style dialog box, shown in Figure
18-6. This dialog box allows you to change the name of a style sheet or modify its
attributes by using the dialog boxes associated with the Type ... ,Para.. ., Tabs ... ,
and Hyph ... buttons.

Edit style
Nome:
Dosed on:
Neut styl e:

IBonneq

~~N;::o=s~ty~le::;l~------'
ISom e style I

ntxt : S.tmt s tvle + fac• : Ttmts +bold+ sin: 30 +
lt~dW'l9 : .t~uto + Oush lt fl + incl TOC -+ ~ph•n~tfon

I[

OK

II

[ Cancel ]
[Type ... ]
[ Poro .. . ]
[ Tabs ... ]
[ Hyph ... )

Figure 18-6: The Edit style d ialog box conta ining the new style name, Banner.

15. First, you should change the name of the Headline style so that it more accu-

rately reflects its purpose. Enter the name Banner into the Name option, replacing the word Headline.
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16. Now click on the Type ... button to change the type specs of the current style
sheet. The Type specifications dialog box will appear; you may recognize it from
previous sample projects. Using the methods outlined in Chapter 12, "Sample
Project Two," change the type specs to 46/40 Helvetica Bold. Then click the OK
button to return to the Edit style dialog box.
17. The only paragraph specification that you need to alter is the alignment. So click

on the Para ... button to go to the familiar Paragraph specifications dialog box,
and then choose Center from the Alignment pop-up options. Now press the
Return key three times. The first time returns you to the Edit style dialog box, the
second closes the Edit style dialog box, and the third closes the Define styles
dialog box and returns you to the publication window, which appears as shown in
Figure 18-7.
ED
-~·

Untitled

•.'1.

.1.

..~1 .

..:'1

··'·

..71

•1.

..~1

'· '· ••~1.

EDB ToolboH E

Lli'- 11- IA
olololtl
~ styl es

Em!
1Q

Noslyle
Body teHI
Coptlon

r--;

~ -·· ······~ Th-£r··Money···········catato·g
· ·· ·1 ····· ···

,_,

:

:
:

, , , , , , , o

"1" o •

:

, , , , , o , , , , o , ,

, , , , , o I , , , o o • o o • o o o • o o • o o o o o o 0 o oo o o o 0 o o o o • o • • • • "

• • • • o

o• oo• o "

o o o o

o•• • • o oo o o 0 oo • o • o• • • • 0 • • • • • • • • • • 0 0

'~' 0 0 '

' ' 0 0 0

~

,-:

Figure 18-7: The publication window as it appears after completing alterations to the Banner
style sheet.

Notice that despite the fact that your banner text is no longer selected, it has been
changed to your recent specifications. Once a paragraph has been tagged to a certain style
sheet, it will continue to reflect any changes made to the style itself. Also notice that the
Styles palette no longer contains a Headline option. It has been replaced by Banner.
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Your next operation is to create a new style that will be applied to a prospective second
line of text in the banner. You can use either of two ways to create a new style sheet:
Specify an entirely new style, determining type and paragraph specifications from
scratch, or create a new style based on an existing style and build on prevailing specifications. In this case, you will use this second method.
l8. Again choose the Define styles ... command from the Type menu or press Command-3. When the Define styles dialog box appears, select the Banner style from
the scrolling list and click on the New ... button. This brings up the Edit style
dialog box. The Name option is empty, since this is a new style and so far has no
name. However, the Based on pop-up option now contains the Banner style name.
19. Click on the Type ... button, change the type specs to 24/Auto Helvetica-Italic,
and press Return. Notice the specifications listing at the bottom of the Edit style
dialog box. The type style bold has been subtracted from the Banner style, and
italic has been added. Your changes to the type size and leading are also noted,
as shown in Figure 18-8.

Edit style

(

Name:

l!!l~
""lo~g=
on="':====;==
;:;:=·:::::::J>::!ll

Basellon:

~

NeHt style:

ISame s tyle I

Banrwr + ntxt: Sai"M sty lf - bold +
24

it~ lie+

OK

]I

[ concel]
[ Type ... ]

sizt :

[ Porn ... ]
[ Tabs ...

I

( Hyph ... )

Figure 18-8: The Edit style dialog box aft er creating a new style sheet based on the Banner style.

20. The centered alignment from the banner style sheet will be suitable for this
style, so there is no need to alter the paragraph specifications for your new style.
The last step is to name the style. Enter Slogan into the Name option box, and
press Re turn.
The new style has been designed especially to be applied to a slogan following the
banner text. You can apply this style automatically by slightly altering the Banner style,
as demonstrated in the following step.
21. Inside the Define styles dialog box, select the Banner style. Notice the first item in
the type spec readout: next: Same style. This indicates that any text you create
directly following a paragraph set in the Banner style will also use the Banner
style. If you prefer, however, you can instruct PageMaker to set succeeding
paragraphs in a different style. Click the Edit ... button. Click on the Next style
pop-up menu and choose the Slogan style from the list. Then press Return twice
to execute your changes and go back to the publication window.
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22. Select the text tool and click at the end of the word Catalog. Press Return to
advance to the next line and type Everything we sell costs money. Because you
changed the Next style option, your new paragraph changes to the 24-point
Helvetica-Italic specs included in the Slogan style, as shown in Figure 18-9.

Subheod 2

·······"~·Th·e ···· Money·····catatog

··

..... ... i ........... Everything..w.e.s.eU..costs.. money ............

Figure 18-9: The Slogan style sheet has been applied to the second line of banner text.

Creating the folio
Your banner and s logan are now complete. The next master page item to create is the
folio, or page number text.
23. Scroll down to the bottom of the page. Then drag two guides from the horizontal
ruler to the 10.3-inch and 10.5-inch markers on the vertical rulers, respectively.
24. Select the text tool and drag from the top left ruler guide intersection to the
bottom right ruler guide intersection. Type February, 1994issue--+ Page 0. Qf
PageMaker starts beeping at you or produces the alert dialog box shown in
Figure 18-10, select the folio text with the arrow tool and drag the lower handlebar down about an inch to display the second line of type. Then click in the text
with the text tool and continue typing.) Here I have used two more special
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character notations. The arrow symbol,-+, indicates that you should press the
Tab key. This creates a gap between the date and the page number. The symbol
0 represents PageMaker's special page number character, produce by pressing
Command-Option-P. On the master page, this character will appear as RM for
right master, but on any other page, it will reflect the current page number, from
1 to 9999.

e

Cannot show the Insertion point.

Turn the page, eHpand the teHt block, or
place more of the story. Note: Multiple
paste may repeot this messoge.

(( Continue

J

Figure 18-10: If this error appears, select your text with the arrow tool and drag t he lower
handlebar down to display another line.

Your folio text probably looks strange right now. Since you edited the Banner style
sheet while no text was selected, its type specifications have become your default
settings. For this reason, your folio text is centered. Tabs don't work very well when
inserted within centered text. The following steps demonstrate how to change the
alignment and tab settings so that the date is positioned flush left and the page number
is flush right.
25. With the text tool, triple-click anywhere on your folio text to select the entire
paragraph. Then scroll up the Styles palette until you reach the top, and select
the No style option. This untags your text so that it is no longer affected by any
style sheet. No immediate change takes place, since your folio text retains the
specifications of the Banner style sheet.
26. Press Command-T to access the Type specifications dia log box. Since you have
accessed this dialog box directly without going through the Edit style dialog box,
your type spec changes will not affect any style sheet. Change the settings in this
dialog box to 12/Auto Helvetica and press Return.
27. Now choose the Indents/tabs ... command from the Type menu or press Command-!
to bring up the Indents/Tabs dialog box. This dialog box allows you to alter the
location of tabbed and indented text in much the same way that you would move
tabs on a typewriter. You can select from the following four styles of tabs:
• Left: the traditional tab, where the first letter of text after the tab
character is flush left with the tab setting
• Right where a section of text between one tab and another, or between
the tab a nd a line return, is flush right with the tab setting
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• Center: where a section of text between one tab and another, or
between the tab and a line return, is centered at a specific point
• Decimal: where the decimal point in a tabbed number, such as $45.95,
is aligned at the tab setting
Toward the bottom of the dialog box, a series of down-arrow icons (T) are located on a
ruler, indicating default tab positions. These will disappear when you set a tab of your
own by selecting a tab button and clicking in the area just above the ruler. A tab aJr
pears instantly at the point where you click. The ruler allows you to measure the
location of the tab from the left boundary of the selected text block. You relocate an
existing tab by dragging it.
28. Click and hold on the scroll arrow to the right of the ruler until you can see the
triangular column width indicator at the 6.5-inch ruler mark. Next, select the
right tab button and click above the ruler at approximately the 5.5-inch marker.
The right tab symbol will appear where you click, accompanied by a number in
the Position option, displaying the exact location of the tab.
29. Drag the right tab symbol rightward, all the way to the end of the column. (If you
accidentally miss the existing tab and create a new one, drag the unwanted tab
directly downward, outside the dialog box, to remove it.) When you finish your
drag, the number in the Position option should read 6.5, as shown in Figure
18-11. (You can also enter the value 6.5 directly into the Position option box if
you prefer.) Then press the Return key or click the OK button.
Inden hllebr
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Position
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Figure 18-11: The Indents/tabs dialog box, showing your folio tab specifications.

30. Don't worry if youfpage number is not flush right. As I mentioned earlier, tabs
do not work correctly when a paragraph is centered. Generally, tabs work best
when text is aligned flush left, so press Shift-Command-Lor choose the Align left
option from the Alignment poJrup listing in the Type menu.
31. Now is a good time to save your document. Press Command-S or choose the
Save command from the File menu. Enter the name Four-page catalog or some
other appropriate name into the Save publication as dialog box, and press
Return. Figure 18-12 shows your progress so far.
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Figure 18-12: The master page folio, containing flush-left date and flush-right page number
character.

Placing and Formatting
Body Copy
Now that you have finished creating master page items and ruler guides, you can move
on to the actual pages. Your first operation is to place a long text file using PageMaker's
autoflow feature.
32. Click on the page 1 icon at the bottom of your screen display. Choose the Lock
guides command from the Guides and rulers submenu in the Layout menu. This
will prevent you from accidentally moving any master-page guides.
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Autoflowing a long text file
33. Press Command-O or choose the Place ... command from the File menu, select
Catalog Copy from PM Bible Chl8 files], and press Return. When you placed text
in previous sample projects, PageMaker displayed the manual text flow cursor.
This time, however, you will be presented with the autoflow cursor because you
set the Autoflow command from the Layout menu as an application default.
34. Position your autoflow cursor, as shown in Figure 18-13, at the top of the first
column. Then click. On a fast computer, the text will pour very quickly. Once
PageMaker finishes pouring the first column, it pours the second. Then it turns
to the second page, pours those columns, turns to the third page and pours
those columns, turns to the fourth page, and so on. II you don't intentionally stop
it, PageMaker will continue to pour the entire article, creating pages as it goes. If
you ever need to stop automatic text flow before it is completed, you can click
the Cancel button in the text status dialog.
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Figure 18-13: The autoflow cursor, ready to begin pouring you r long word processing file

As you can see in Figure 18-14, PageMaker arrived at page 5 before you stopped it. Later
you'll have to edit the text in your catalog copy if changing the type specifications does
not make all of the text fit on the first four pages.
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Figure 18-14: A status dialog box appears while PageMaker is autoflowing text, allowing you to
terminate its automatic text-pouring and page-creation cycle.

Editing the Body Copy Style Sheet_
35. To format your new text file, you will use a style sheet just like you did on the
master page. Select the text tool and click anywhere in the text on page 1. Then
press Command-A to select the entire file and click on the Body text style in the
Styles palette. Body text-another of PageMaker's preset style sheets-formats
the text as 12/Auto Times Roman. Since you're using Palatino and Helvetica,
however, the style will need to be edited.
36. Press the Command key and click on the Body text option in the Styles palette.
Command-clicking on a style sheet is a method of dis playing the Edit style dialog
box without having to choose the Define styles .. . command. Once the Edit style
dialog box appears, click on the Type ... button and change the type specs to 12/
Auto Helvetica and press Return. Then click on the Para ... button to display the
Paragraph specifications dialog box. Select the Justify option, then input 0.25 for
the First option and 0.065 for the After option. Next press the Return key twice to
return to the publication window.
Your text will automatically change to fully justified 12/Auto Helvetica. This completes
your manipulation of the body copy.
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Deleting Pages
37. Now that the text fits onto the first four pages as it s hould, you need to delete
page 5, which was created by PageMaker when the text autoflowed. To do this,
choose the Remove pages .. . command from the Page menu. This brings up the
Remove pages dialog box, as s hown in Figure 18-15. The default values in this
dialog box are the current page numbers. Since you want to delete page 5, enter
the number 5 in both the Remove pages and through options. (So you are
deleting pages 5 through 5.) Then press Return. An alert dialog box displays,
asking if you really want to delete the page and all items on it. If you are sure of
your specifications, click on the OK button. (Pressing Return will cancel the
operation, since the Cancel button has a heavy outline.)
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Figure 18-15: The Remove pages dialog box, containing your specifications, followed by the
subsequent alert dialog box.

38. After you confirm the removal of page 5, PageMaker deletes that page and turns
back to page 4. Since your next task will be to finish working on page 1, click on
the page 1 icon (or press Command-Shift-Tab). Now press Command-S to update
your file on disk.

Adding Ad Spaces and Graphics __
This publication certainly has a large quantity of text for a catalog. Now it is time to
clear spaces for advertisements, add graphic embellis hments, and create a price listing.
Sometimes when you create a document, you want to firs t position your graphics, then
pour your text around them. But in PageMaker, it usually works best to first pour your
text, as you have done, and then add the graphics.
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Repositioning existing text around
agraphic
In these next few steps, you won't actually create ads, as it would be too time-consuming in the context of this sample project. Instead, you will place ads that have already
been created, or in some cases simply create boxes that will act as markers, indicating
where the ads can be later pasted into place after the file is printed or imported electronically into your PageMaker file.
Throughout the remainder of this chapter, you will be instructed to move your cursor
using a coordinate system, in which H:O.O =the 0-inch marker on the horizontal ruler
and V:O.O = the 0-inch marker on the vertical ruler. All other coordinates are measured
from this point. For example, H:5.6 is equal to S~o inch.
39. Command-Option-Click near the bottom of page 1. Then select the rectangle tool
and drag from H:l.O, V:7.0 to H:7.5, V:lO.Oto indicate the size of an ad space. Your
rectangle should be the width of your margins, with a 2-point line weight and
transparent interior, as shown in Figure 18-16.
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Figure 18-16: The large rectangle that will represent your ad space currently overlaps text.

510

Part III: Advanced Topics

40. As you can see, your large rectangle overlaps about a third of the text on this
page. This must be remedied by altering the length of each of t he two text
columns. Select the arrow tool and click on the first column to select it. Then
drag the lower handlebar upward to approximately V:6.9, so that there is about
!-1o inch between the end of the text and the rectangle. The text that is displaced
by your sho rtening of this column will automatically wra p into the next column,
and so on. Next, click on the right column to select it and drag its lower handlebar upward t o V:6.9 or thereabouts (see Figure 18-17).

Figure 18-17: Lift the lower handlebars of each of your two colum ns of text so that they no
longer overlap the rectang le.

41. Now draw an X the size of your rectangle, indicating that it is not a real graphic,
but only a spaceholder. Select the diagonal line tool and drag from H:l.O, V:7.0 to
H:7.5, V: 10.0, the same coordinates you used to draw the rectangle. This creates
a diagonal line from the upper left corner to botto m right corner of the rectangle,
the first stroke of your X. Now, while the line remains selected, choose Hairline
from the Line pop-up listing, reducing the weight of the line. For the second
stroke of the X, draw from H: l.O, Y: l O.O to H:7.5, Y:7.0 with the diagonal line tool,
joining the other two corners of the rectangle. Also change this line to a hairline.
42. This completes page I, as shown in Figure 18-18. Press Command-W to zoom out
to the Fit-in-window view size. Then press Command-S to update your file on disk.
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Figure 18-18: The completed page 1, with autoflowed text and advertisement placeholder.

Wrapping Text around a
Rectangular Object
Suppose that you want to create a space for an advertisement on page 2. Rather than
positioning this ad at the bottom of the page, however, you want it to stand out more
prominently to attract attention in a distinctive manner. To accomplish this, you will
position a smaller vertical ad in the middle of the page, wrapping both columns of text
around the rectangle. If you had to do this manually, it would be a difficult procedure;
you would have to break your story into a number of additional columns, each with
varying widths. PageMaker, however, provides an automatic text-wrapping feature,
which you will use instead.
43. Hold down the Shift key and click on the page 2 icon at the bottom of your
screen display to turn to the second page. Holding down the Shift key changes
the view size to Fit in window and centers the page as you turn to a new page or
set of pages. Choose the Place ... command and locate the Page 2 graphic in the
PMS Bible Ch18 Files f folder. Double-dick on the file or click OK, and then place
the graphic right in the middle of page 2, as shown in Figure 18-19.
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Figure 18-19: The page 2 ad placeholder currently overlaps text.

44. Command-Option-Click in the middle of the graphic, zooming in to Actual size. If
necessary, press the Option key and drag to move your screen image until the
rectangle is centered in your publication window.
45. Your graphic is now partially obscured by text. You can remedy this situation by
taking advantage of PageMaker's text-wrapping feature. Select the graphic and
choose the Text wrap ... command from the Element menu. This brings up the
Text wrap dialog box.
The Text wrap dialog box, shown in Figure 18-20, contains three Wrap option icons and
three Text flow options. Each option is used to determine the visual manner in which
overlapping text is forced to wrap around a selected graphic element. The first Wrap
option icon, which is currently selected, indicates that text merely overlaps a graphic.
The second icon specifies that text will wrap rectangularly around a graphic. The third
icon, which is dimmed, is the custom wrap option; it allows you to wrap text around a
complex graphic. You will get a chance to experiment with irregular text wrapping on
page 3 of your catalog.
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The Text wrap dialog box
contains your specifications.
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The Text flow icons determine where text is allowed to pour in reference to a graphic.
The first option allows no text to pour below the selected graphic; the second allows for
text above and below the graphic, but none to the left or right side; and the third allows
text to wrap a graphic on all four sides.
The Standoff in inches options determine the dimensions of the graphic boundary. The
Text wrap ... command creates a rectangular dotted line around the selected graphic.
This graphic boundary forms a border of white space around an image, within which
text will not appear. The Left, Right, Top, and Bottom values are measured outward
from the selected graphic element.
46. Select the second Wrap option icon. PageMaker will automatically select the
second Text flow icon as well. However, since you will want text on the left and
right sides of your rectangle, select the third Text flow icon instead.
47. Enter .25 for the Left and Right options and .15 for the Top and Bottom options.
Then press Return.
48. A graphic boundary then appears around your graphic to the specifications you
entered. To get a better view of the graphic boundary and the manner in which
your text has wrapped around the spaceholder, press Command-W to zoom out
to Fit in window size, as shown in Figure 18-21. Then press Command-S to update
your file on disk.
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Figure 18-21: The ad placeholder with graphic boundary, which causes text to flow around it in
a rectangular manner.

Incidentally, don't worry when your graphic boundary disappears after saving your file.
Text wrap boundaries appear only when a graphic is selected; the saving operation
deselects all elements in your publication. If you want to see the boundary again,
merely reselect the rectangle.

Wrapping text around a complex graphic
For page 3, you'll import an existing graphic from the disk and then wrap text around it
as you did on page 2. This time, however, the graphic isn't rectangular so you'll customize the text wrap to follow the shape of the graphic.
49. Press Command-Tab to turn to page 3 (or click on the page 3 icon at the bottom
of your screen display). Press Command-D. select the Page 3 graphic from the
PMS Bible Ch18 Files f folder, and press Return. Click with your graphic placement icon in the upper left area of your page.
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50. Display the control palette by pressing Command-] or by choosing the Control
palette command from the Windows menu. Select the arrow tool and click on the
graphic, and then click on the control palette to activate it. Select the Proportional
scaling button so that it is on, as shown in Figure 18-22, and then enter 75 in the
Horizontal scaling option, and press Enter. The Vertical scaling option will change
to 75 automatically, and the graphic will be reduced to 75% of its original s ize.

Figure 18-22: A graphic positioned in the middle of page 3.

51. Command-Option-Click in the center of the graphic to zoom in, and center the

graphic between the two columns using the arrow tool.
52. Since the text again overlaps your graphic, use the Text wrap ... command from
the Element menu again to bring up the Text wrap dialog box.
As I mentioned earlier, you will wrap text irregularly around this image. So rather than

creating a standard rectangular graphic boundary, you will want your boundary to
imitate the outline of the graphic itself. It stands to reason that you should select the
third Wrap option icon. Unfortunately, this option is dimmed. In PageMaker, you must
always create a rectangular graphic boundary first and then manipulate that boundary
in the publication window. The next few steps demonstrate how this works.
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53. Select the second Wrap option and the third Text flow option. Then enter 0.15 for
each of the distance values, and press Return. A rectangular graphic boundary
now surrounds your image.
Now you can alter the boundary around the graphic pictured in Figure 18-22. To wrap
text irregularly around a graphic, you must manipulate the rectangular graphic boundary. Currently, the boundary has four handles, one at each corner. Each of these
corners can be moved independently by dragging them. Pressing the Shift key while
dragging constrains movement horizontally or vertically. You can also drag at the
boundary segments, the dotted lines between handles, increasing or reducing the text
wrap limitations from the value set for the rectangular boundary. This allows for limited
irregular text wrapping. But the only way to accurately imitate the outline of a graphic is
to add handles to the boundary by clicking on a segment with the arrow tool.
54. Create new boundary handles by clicking on the graphic boundary, and customize the fit of the graphic boundary by repositioning handles and moving boundary segments, as shown in Figure 18-23. As you change the graphic boundary, the
surrounding text will ref!ow after each move in response to your progress. If you
want to temporarily stop the text from reflowing, hold down the spacebar while
adding handles or modifying the graphic boundary -this will stop the adjacent
text from reflowing until you release the spacebar. The new graphic is shown in
Figure 18-24.

Figure 18-23: The graphic boundary is modified to more closely follow the edge of your graphic.
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Figure 18-24: The graphic and its new graphic boundary, viewed at 200%.

Applying Graphic Special Effects_
Graphics saved in the paint and TIFF formats are composed of a predetermined number
of tiny dots, or pixels. This is different than drawings saved in the PICT or EPS format,
where graphics are typically defined as mathematical objects. For more detailed
information about PageMaker graphic theory, see Chapter 11, "Graphic Elements."
Graphics that are defined as the combined result of thousands to hundreds of thousands of tiny pixels, such as paint and TIFF graphics, can be subjected to image control
in PageMaker. This means that PageMaker is capable of changing the lightness or
darkness of each of these pixels.
All paint graphics and many TIFF images are composed of only two gray levels. This
means that each and every pixel that makes up an image is either black or white.
Photographs scanned using a gray scale scanner can produce as many as 16 gray levels
or even more. A single pixel in such an image might be light gray, medium gray, dark
gray, very dark gray, and so on, in addition to black or white.
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Naturally, your MacPaint graphic on page 3 contains only black and white pixels. ln the
next few steps, you will alter the black pixels to a lighter shade of gray and leave the
white pixels white.

Controlling a black and white graphic
55. Your paint graphic should be selected. Choose the Image control... command
from the Element menu to bring up the Image control dialog box.
The first group of options in the Image control dialog box control the manner in which
an image is displayed and printed. Since a MacPaint graphic consists entirely of black
and white pixels, the Black and white radio button will be selected. As long as this
option remains active, all pixels in the selected graphic must remain either black or
white. The other two options-Screened and Gray-allow you to color the pixels in
shades of gray. Because this is a MacPaint graphic, you are still limited to two colors,
but these can be any two gray values.
If you do not own a grayscale or color monitor, the Gray option will be dimmed. In

general, this option is use ful only for viewing gray scale graphics and enabling the
Lightness and Contrast options (discussed shortly). The more functional Screened
option can be selected regardless of monitor. It also allows you to set the function,
angle, and frequency of your printed graphic using the options located below the radio
buttons. The firs t of these are the two Screen icons that determine whether gray values
in the selected graphic are printed as a series of s mall dots or parallel lines. Next is the
Angle option box, which determines the direction in which the dots or lines are arranged. And last is the Lines/in option, which specifies the number of dots or lines in an
inch. Typically, this option should be set to 60 when printing to a laser printer and to 90
or 120 if printing to an imagesetter. For more information about these options, see
Chapter 11, "Graphic Elements."
The Lightness option brightens a graphic. The Contrast option controls the amount of
difference between the lightest and the darkest sections of a graphic.
Between the Lightness and Contrast arrows are the gray-level bars. Since your MacPaint
graphic consists of only two gray levels, black and white, there are only two bars: One
bar is completely black and the other is completely white.
56. Select the Screened option. Then press the Tab key and enter 60 for the
Lines/in option.
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57. You want to adjust the Lightness option in order to lighten the darkness of the
black pixels and leave the white pixels white. This means that you should press
on the upper Lightness arrow. The arrow is extremely sensitive, so you will want
to press on it only for a moment. The bottom portion of the left gray-level bar,
representing the black pixels, will begin turning white. The ratio between the
black and white portions of the bar represents the gray value. For example, if the
bar is about 60% black, you have specified that all black pixels should now be a
60% gray value, or a medium-dark gray. Lighten the left bar so it looks like the
one in Figure 18-25, about 75% black and 25% white. If your left bar is too white,
press on the down arrow. If you press the down arrow too long, the right graylevel bar will start to turn black. If this happens, press on the up arrow again. Or
if you prefer, you can drag directly on the bar at the point where the black meets
the white.
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Figure 18-25: Increasing the Lightness of the MacPaint graphic lightens the black pixels to a
shade of gray.

58. Click on the Apply button. This applies your changes to the selected graphic,
part of which you can probably still see, without leaving the Image control
dialog box.
59. Press Return when the lightness of your graphic approximates that shown in the
figure.
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60. Notice that the white portions of your graphic, which used to be transparent, are
now opaque and cover up some of your text. Choose the Send to back command
from the Element menu, or press Command-B, to put the graphic in back of the
text so the text is no longer hidden.
61. Press Command-W to view the entire page. Press Command-S to update your file
on disk. Figure 18-26 shows your progress so far.
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Figure 18-26: The completed page 3, with irregular text wrapping and g rayed paint image.

Removing and inserting pages
62. Click on the page 4 icon to tum to the fourth page. You already have more than
enough text in this document, particularly for a catalog, so you will add a price
list to this page. The easiest way to completely change a page like this is to
simply remove it and create a new one.
63. Choose the Remove pages ... command from the Page menu. The Remove pages
dialog box will already contain the correct page numbers to be removed, from
page 4 to page 4. So press the Return key. When the alert dialog box comes up,
click the OK button.
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64. After page 4 is removed, you will find yourself at page 3. You now want to insert
a new page 4 into your catalog, so choose the Insert pages ... command from the
Page menu. The Insert pages dialog box, shown in Figure 18-27, allows you to
insert any number of pages before or after the current page(s). The Insert option
currently contains a 1, which is the number of pages you want to insert. The
After option is selected, which will add the new page after the current page,
as you prefer. Since all of the options are already correctly set in this dialog box,
press Return.
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Figure 18-27: The Insert pages dialog box.

Controlling a gray-level graphic
Once again, you are on page 4. The page is free of any text or graphic elements. During
the next few steps, you will import and apply image control settings to a gray scale scan
saved in the TIFF format.
65. Press Command-D. select the Project 3 folder on your PageMaker 5 Bible disk,
and press Return. Click with your TIFF-type placement cursor at the top of the
page. After the image is placed , drag it into position using the arrow tool. The
imported image is s hown in Figure 18-28.
66. U necessary, reduce the image proportionally by Shift-dragging at one of the
corner handles so that the image does not extend below the 6. 75-inch mark on
the vertical ruler. Later, you will create a price list below this point, so this area
must be left empty.
67. Choose the Image control. .. command from the Element menu to bring up the
Image control dialog box. As shown in Figure 18-29, you now have 16 gray-level
bars, one for each of the gray levels in your scanned image. A TIFF-type scan
demonstrates more of the effects possible using the options provided in this
dialog box.
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Figure 18-28: The imported gray-scale photo-graphic scan.
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Figure 18-29: The Image control dialog box as it appears when t he selected image is a
photographic scan w it h 16 gray levels.

68. Select the Screened option. Then select the lines icon from the Screen options
and enter 90 for the Unes/in value. This turns your scan into a line-screen image,
and also prepares it to be output to an imagesetter if you later choose to do so.
Notice the four special effects icons situated above the gray-level bars. Each of these
alters the gray level bars in some unique manner and thereby affects the appearance of
the selected scan. The first icon, the default selection, sets each bar to a normal graylevel setting. The second icon inverts the image so that it looks like a photographic
negative. The third icon polarizes the image, ascribing each gray-level bar to one of four
intermediate lightness values. The last icon lightens the medium-gray values, while
darkening the light- and dark-gray values. These special effects are fun, but not commonly useful.
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69. For this scan, you will not use the preset effect icons. Instead, very slightly
increase the Lightness and decrease the Contrast of the selected image to the
levels shown in Figure 18-29. Then press Return. Compare Figures 18-28 and
18-30 to see the effect of these manipulations.

Figure 18-30: The manipulated grayscale photograph, is now surrounded by a double-line
border.

70. Select the rectangle tool a nd draw a box that exactly traces the perimeter of the
scan. Then choose the double-line weight from the Line pop-up listing under the
Element menu.
71. Press Command-S to update your file on disk.

Preparing a Price List
This ends the discussion of graphic manipulations. Your next and near-final series of
steps is devoted to the creation of a short price list, a fundamental part of any catalog.
72. First, you will create a new style sheet, based on the existing Body text style.
Click on the arrow tool icon to deselect all elements in the publication window.
Then select the Body text style from the Styles palette. This style is now the
default setting for this file.
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Creating a new style sheet with tabs
73. Command-Click on the No style option in the Styles palette. This brings up the
Edit style dialog box, with an empty Name option and the Body text style listed
for the Based on option. Command-Clicking on the No style name allows you to
create a new style based on the style that was previously selected.
74. Click on the Tabs ... button to bring up the Indents/tabs dialog box. You will
insert two tabs. Select the Left option and click above the ruler at around the
%-inch mark. Alternatively, you can enter 0.75 into the Position option box.
Create a second left tab at 2.5.
75. Notice the indent markers at the beginning of the ruler, as shown in Figure 18-31.
The top half of the triangle is moved rightward slightly, indicating a first-line indent.
Drag this top marker back to 0, eliminating the first-line indent, and press Return.
Indents/tabs
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Figure 18-31: The Indents/tabs dialog box contains your specifications for the Price lists style
sheet.

76. Enter Price lists for the style sheet name. Then press Return.
77. Before you create the price list, you need to create a ruler guide to help position
the first line of text. So drag a guide down from the horizontal ruler to V:7.0. Qf
you incorrectly position the guide, you will not be able to move it because the
Lock guides command is active. Choose the Lock guides command from the
Options menu to deactivate it, move your ruler guide, and then reactivate the
Lock guides command .)
78. Scroll down the Styles palette and select the Price lis ts option. This is now the
default style s heet. Then select the text tool and click just below your ruler guide.
Input the following text, using tabs for the-+ symbol and carriage returns for the
~symbol:

Number -+

Item -+

Price~

04024 -+

LCD clock radio -+

139.95 ~

04025 -+

Stereo clock radio -+

229.95 ~

07220 -+

Gold-plated watch -+

79.95 ~
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07231--+

w/ moon phases--+

99.95 'll

10188--+

Knife sharpener --+

69.95 'll

43899--+

35-func calculator --+

24.95 'll

44899--+

2k data calculator--+

34.95 'll

57002--+

5-speed fan--+

49.95 'll

57305--+

Portable heate r --+

179.95 'll

57309--+

Portable AC unit --+

249.95 'll
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79. This fills out the length of the first column. Since the content of your text is not
important, your second column will be an exact duplicate of the first. Press
Command-A to select every word in the current text block. Then press Command-C to copy the selected text. Press the End key to move your text entry
cursor to the last character of type in the current text block and press Command-V to paste the copied text.
80. The text is now copied and pasted, but it has yet to be poured into a second
column. Select the arrow tool. Then select the price list text block and click on
the lower handlebar tab. Your cursor changes to the autoflow icon. Move your
cursor to just below the ruler guide in the second column. Then press the
Command key. Notice how your autoflow cursor changes to a manual flow
cursor. The Command key always toggles the autoflow cursor to the manual flow
cursor, and vice versa. While the Command key is still pressed, click with the
manual flow cursor to pour the second column of text. It should look like Figure
18-32. (Incidentally, if your second column text pours a little strangely, select the
text tool, click in the second column, press Command-A to select all the text, and
reselect the Price lists style sheet. This should solve the problem.)
81. Notice that the numbers in your text are aligned rather strangely. The first
numbers in each row are flush with each other, so that tens of dollars in one row
line up with hundreds of dollars in another. To fix this, Command-Click on the
Price lists style name in the Style palette. \Vhen the Edit style dialog box appears,
click on the Tabs ... button. The Indents/tabs dialog box displays the two left tabs
above the ruler. Select the rightmost tab by clicking on it and choose the Delete
tab option from the Position pop-up menu. This dispenses with the inappropriate
tab. Now select the decimal tab icon and create a decimal tab at 2.75. Then press
the Return key twice. Now the decimals in the price values line up, as is most
commonly seen in a price list.

526

Part III: Advanced Topics

LCD c:bck: radio
Stereo cloc:k radio
Gold-plated watch
1

w/ moon phases
Knile sharpener
35-func calculator
2k data calal later
5-speec! fan
Portable hee.ter
Portable AC unit

229.95
79.95
99.95
69.95
24.95
34.95
49.95
179.96

1

.

Stereo cloc:k radio
Gold-plated watch
w/ moon phases

229.95
79.95
99.95
69.95
Knife sharpener
35-fun c calculator 24.95
2k data ce.lcu later 34.95
6-speed fan
49.95
179.95
249.95
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Figure 18-32: The two-column price list.

Overriding a style sheet
To complete the list, you need to visually distinguish the list headings-Number, Item,
and Price-from the list itself. You will do this by directly assigning new type specs to
the list headings, overriding their style sheet specifications.
82. Select the text tool. Triple-dick on the top line of type in the first column. Then
press Shift-Command-S to assign the bold style to the type. A bold style helps to
differentiate the heading from the listed items, but it needs a little more. You may
also want to rearrange the tabs so that the Price head is more centered above
the dollar listings. Press Command-! to access the lndents/tabs dialog box, drag
down on the decimal tab to dispense with it, select the left tab icon and create a
new tab at 2.5. Then press Return.
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Notice the Styles palette. The Price lists option is followed by a plus sign, indicating that
there are certain differences between the selected text and its style s heet. These
differences will be retained unless you again click on the Price lists style sheet while
this line of type is selected.
83. The headline might look even better with some additional paragraph spacing and
a line between the headline and the list text. Press Command-M to bring up the
Paragraph specifications dialog box, enter 0.15 for the After value. Next click the
Rules ... button to display the Paragraph rules dialog box. Here, you can create
a rule above or below a line of text. This technique is preferable to underlining
the headline with the line tool, s ince paragraph rules move with your text. Select
the Rule below paragraph option and choose the 2 pt option from the Line style
pop-up menu, as shown in Figure 18-33. Press Return twice to execute your
paragraph specs.

~

Parag roph rules

D Rul e aboue paragraph

:;:::::::J

line style:

~IIJp~t

line color:

I Block

I

0 Wid th of tent
left ~ inches

OK

B

Cancel
[options ... ]

Line width:

® Width of column

In dent:

Right ~ inches

181 Rule below paragraph
Line st y le:
Line color:

~I2Jp~t~==]
I Block

I

0 Width of tent ® Width of column
left ~ inches Right~ inches

line width:
Indent:

Figure 18-33: The Paragraph rules dialog box, w ith specifications for creating a 2-point rule
under the headline text.

84. Triple-click on the first line of type in the second column and repeat Steps 82
and 83. Or simply copy the first headline and paste It in the place of the secondcolumn headline. Then press Command-S to update your file on disk. Figure 18-34
shows how the completed listings should look.
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1

Stareo clock radio
Gold-plated watch
w/ moon phases
Knife sharpen...35-func ce.Jculator
2k de. te. ce.lru Iator
6-spee:l fan
Portable heater
Portable AC unit

229. 95
79.95
99.96
69.95
24.95
34.95
49.95
179.96
249.95

w/ moon phases

99.96
69.95
Knife sharpen...35-func ce.Jculator 24.95
2k de.ta calc:u later 34.95
49,g:j
5-spee:l fan
Portable heater
179.95
Portable AC unit 249.95

Figure 18-34: The listing text, complete with distinguishable headings.

Last-Minute Clean-Up
One important fact about any electronically composed page is that nothing is permanent. If you don't like something, it can be easily changed. You will now take advantage
of this fact to modify your catalog.
85. Press Command-W to view all of page 4. Notice how closely the banner text (from
the master page) is positioned to the scanned photograph. Some white space
between the two elements would improve the appearance of this page dramatically. To create this white space, click on the master page icon at the bottom of
your screen display.
86. Select the arrow tool and click on the banner text to select it. Drag the text block
upward so the top ruler guide aligns with the baseline of the first line of type, as
shown in Figure 18-35. If you want to be extremely accurate, you can further
magnify your page to 200% by Shift-Command-Option-Clicking the banner.
87. Now click on the page 4 icon to see what a difference a little effort can make, as
shown in Figure 18-36. If you are satisfied, press Command-S to update your file
on disk.
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Figure 18-35: At 200% view size, the banner text has been moved upward to a location that
visually complements the other elem ents on this page.

EJB
.

.
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·

Figure 18-36: The completed page 4, after moving the banner text.
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Printing the Four-Page Catalog
88. Your catalog is now complete. The only step remaining is to print the finished
document. Make sure that your printer is turned on and is chosen in the
Chooser. Then press Command-P to access the Print to dialog box. Indicate one
copy, and print from page 1 to 4, as described at the end of your first sample
project (see Chapter 8, "Sample Project One''). When your flier is finished
printing, examine the pages of your printed catalog, paying special attention to
the restdts of your text wrapping and image control experiments. Make sure that
they meet your expectations. If you see any problems, make the necessary
changes to your file.
Successfully completing this chapter demonstrates an understanding of the most
advanced functions and operations offered by PageMaker. I hope that this has helped
you to better understand the topics covered throughout this book and provided you
with a more developed working knowledge of the PageMaker.
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Aldus
PrePress Tools
••••••••••••••••••••••••••••••••••••••••••••••••
In This Chapter
•

How PageMaker is used in the toolboxes of professional publishers

•

Color correction and separation with Aldus PrePrint

•

Electronic imposition with Aldus PressWise

•

Electronic trapping with Aldus TrapWise

••••••••••••••••••••••••••••••••••• •••••••••••••
The success that PageMaker has achieved over the past nine years has been due to the
fact that beginners and experts alike can use the program to produce anything from
office newsletters to newsstand magazines. But this is not to say that beginners and experts
use PageMaker in exactly the same way: Professional publishers have much more
exacting standards of precision, they use color more extensively in their documents, and they
reproduce their publications in large quantities using offset printing. As a result, professional
publishers must work more deliberately within PageMaker than casual publishers, but
they must also supplement PageMaker with other desktop production tools, such as
color separation utilities, trapping programs, and imposition software.
These tools are sometimes used by professional publishers themselves, but increasingly color separation, trapping, and imposition are services provided to the desktop
publisher by a service bureau or commercial printer. This marks a return to the kind of
specialization that historically characterized the prepress and printing industry and is
probably a positive change for desktop publishers. Each of these areas is technically
complex and depends upon a detailed knowledge of prepress and printing that only
these professionals can provide. And you gain cost and time savings without having to
take on additional areas of expertise yourself by letting your service bureau or printer
do your color separations, trapping, and imposition with electronic tools.
This chapter introduces four Aldus prepress products-Aidus PrePrint, Aldus
PressWise, Aldus TrapWise, and Aldus Fetch. The first three are largely used by service
bureaus and commercial printers, but if you produce color publications or long documents, you should understand the features these programs provide and the capabilities
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they make available to you. Aldus Fetch, on the other hand, is something that just about
anyone who uses PageMaker can benefit from. A trial version of Fetch is included on the
disks accompanying this book.

Color Separation and Color Correction with Aldus PrePrint ------------------Aldus PrePrint has always been a very misunderstood piece of software. It was designed
to provide a specific set of capabilities at a time when color, especially process color,
was very new to desktop publishing. It was supposed to fill a gap that existed in the
software world when most programs were not designed for professional-quality color
production, and to help clarify the roles of the desktop publisher, service bureau, and
traditional printing trades. It failed for a strange combination of reasonable and irrational reasons. (I won't bore you with the details here, but I am worldng that information
into the subplot of a new high-tech murder mystery I'm worldng on ... )
Forgetting its past or any lingering stigmas the software still carries from those times,
the fact remains that PrePrint provides three potentially useful capabilities:

•

PrePrlnt can perfonn global color corrections to TIFF images. Color images
created using either desktop or high-end scanners can have global color problems based on the original photograph, scanner miscalibration, or improper
scanning software settings. PrePrint provides easy-to-use and fairly powerful
commands that let you correct these color imperfections.
Of course, it's almost illegal to think of using any software other than Adobe
Photoshop to modify images these days. But while Photoshop is a world-class
tool for image editing and includes very powerful color-correction capabilities,
using Photoshop for color correction is quite complex. EFt's Cache, on the other
hand, specializes in color correction (it provides no image editing capabilities)
and provides a good range of capabilities with a very easy-to-use interface.
PrePrint is not as powerful as Photoshop for color correction, but it is easier to
use. It is neither as powerful nor as easy to use as Cache.

•

PrePrint can color separate TIFF images into the DCS or CMYK TIFF file
formats. As described in Chapter 14, "Worldng with Color," in order to color
separate files directly from PageMaker 5, you must use TIFF images that have
been preseparated into either DCS or CMYK TIFF format. PrePrint can open any
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TIFF file (standard TIFF files are more technically known as RGB TIFF files) and
then save it as a DCS or CMYK TLFF file so it can then be used in a publication
that will be output directly from PageMaker.

•

PrePrint can color separate finished pages from PageMaker or Quark. When a
PageMaker or QuarkXpress file contains RGB TIFF images, it cannot be printed
directly to separations from either PageMaker or Xpress. PrePrint can print
separations of these files, providing that they are saved in the .SEP or PostScript
format. PrePrint can also output EPS files from many other applications, including Aldus FreeHand and Adobe Illustrator, so some output services may use
PrePrint as a universal output application.

Aldus PrePrint was originally sold for $495, but was later bundled with PageMaker 4.0
and 4.2. Now that PageMaker 5 includes the ability to print its own color separations
directly, PrePrint is once again sold separately.
In order to use PrePrint with PageMaker 5, you'll need version 1.6, which is
available as a no-<:ost update to any PrePrint owner. In addition to adding
support for PageMaker 5, PrePrint 1.6 adds support for the new LaserWriter
Driver version 8.0, Super ATM, and image tiling.

A quick tour of Aldus PrePrint
When you launch Aldus PrePrint, the PrePrint start-up screen appears. Once you
dispense with this dialog box, you can open three kinds of documents:
•

PageMaker documents saved as separation files, which are compatible with
Aldus' Open Press Interface (OPO specifications. Note that PrePrint cannot open
standard PageMaker files. They must be specially saved as .SEP files as shown in
Figure 19-1. This is done by choosing the Print command from the File menu,
clicking the Options button, and then selecting the Write PostScript to file option
from the PostScript section of the dialog box, and then clicking the For separations radio button below this option.

•

OPI-compatible files created by other applications, such as QuarkXPress.

•

TIFF files, saved from an image editing application or scanning utility.
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Figure 19-1: Use PageMaker's PostScript print options dialog box to save you r document as an
OPI file.

Opening OPI files
If you open an OPI file, or a PageMaker .SEP file (which is actually an OPI file too), the

dialog box shown in Figure 19-2 appears. This dialog box lists all links for the graphics
files that are used in the selected publication and allows you to modify these links
(relink or unlink), mask images in the final output, or resample images to change the
amount of data they contain.
Figure 19-2:
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U links. As in PageMaker, linked files are important because in many cases the OPI
file does not have the actual data for a particular image but instead relies on the
linked file for the high-resolution data necessary to print the image correctly. Any
graphic files whose links have been broken are marked in this dialog box with a
question mark. Using the Update Links ... button, you can relink a single file, or
by then selecting the Compare names and update links option, you can have
PrePrint update multiple files at the same time.
8 Masking. Masking is used to completely knock out images that were placed in
the electronic file for position only and will be later replaced with mechanically
stripped-in images. The benefit of placing an electronic file and then masking it
before separation is that the electronic file was placed precisely, so that the
commercial printer can correctly strip in traditional photographic separations.

U Resampling. Resampling adjusts the amount of data in a particular TWF file to
better match the size at which the image is being used. Often, images are
scanned at larger sizes and then electronically reduced by scaling in PageMaker
or some other application. In this case, the TIFF image often contains more data
than necessary, which slows down the printing process without improving final
quality. Resampling allows you to dispose of this unnecessary data before it
wastes valuable imagesetter time. You can also use resampling to enlarge an
image, but since this process actually creates data to fill in new pixel locations, It
is unwise to resample images up any more than 15-20 percent. If an image needs
to be enlarged more than that, you should have the image rescanned, using the
correct scanning resolution to account for the proposed enlargement.

Opening TIFF files
When a TIFF file is opened in PrePrint, the image appears in an image window, as shown
in Figure 19-3, and your cursor will become an eyedropper icon. The status bar at the
top of the screen displays information about the image.
Figure 19-3:
The image window allows
you to manipulate the
current TIFF graphic.

•
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The status bar is divided into three parts:
•

The color sample bar. Click with your eyedropper cursor to display the color of
a pixel in the left end of the status bar.

•

Color attributes. The middle section of the status bar displays the color attributes of the pixel under your eyedropper cursor. If your cursor is not inside
the image window, the numbers reflect the attributes of the color sample box.
If the current image is a gray-scale TIFF file, a single intensity reading will appear,
ranging from 0 (black) to 255 (white). If a color TIFF image is open, the status bar

displays RGB (red, green, blue) and CMYK (cyan, magenta, yellow, black) values
for the current pixel. Each RGB value ranges from 0 to 255; each CMYK value ranges
from 0 to 100 percent. The last item number stands for total ink coverage, the total
percentage of the four CMYK values. TIC can therefore range from 0 to 400 percent.
•

Size and memory. The right end of the status bar displays the size of the image
in pixels. The free space value indicates the amount of memory that remains
available to PrePrint.

Although you cannot edit single pixels in TIFF images, PrePrint can perform global
adjustments that affect the entire image. All of PrePrint's image-processing capabilities
are accessed as commands under the Image menu, shown in Figure 19-4.
Figure 19-4:
The Image menu includes
commands that can be used
to perform global adjustments to a TIFF file.
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The commands in the Image menu operate as follows:
•

Soften decreases the amount of contrast between pixels, giving your image a
less-focused, softer appearance. Use this command when you want to obscure
blemishes in an image or improve the appearance of a bad scan.

•

Sharpen (Command-R) increases the amount of contrast between pixels, enhancing details so that your image appears sharply focused. Use this command when
you want to heighten the contrast between elements in an image.

•

Auto Enhance (Command-E) compensates for the resolution of an output device
by darkening some pixels and lightening others. The performance of this command is affected by the currently selected PPD file. Use this command when
printing to lower-resolution output devices, such as laser printers, or when the
colors in an image are severely unbalanced.

•

Enhance displays a pop-up menu containing three options- Highlights,
Midtones, and Shadows. Each of these options enhances the detail in the chosen
range of colors at the expense of the other two ranges. Use this command when
you want to heighten the appearance of a selected portion of an image.

•

Ughten (Command-L) increases the brightness of all pixels in an image. Use this
command if your image seems too dark or heavy.

•

Darken (Command-D) decreases the brightness of all pixels in an image. Use this
command if your image appears too light or washed out.

•

Increase contrast increases the brightness of light pixels and decreases the
brightness of dark pixels, increasing the contrast between light and dark colors.
Use this command to bring out depth and texture in a flat image.

•

Decrease contrast decreases the brightness of light pixels and increases the
brightness of dark pixels, reducing the gap between light and dark colors. Use
this command to soften a harsh graphic.

Color displays a pop-up menu containing four options-lncrease saturation, Decrease
saturation, Auto balance, and Balance to sample. The saturation options alternatively
raise or lower the intensity of colors in an image, strengthening colors or graying them
out. (Note that the Color command is dimmed if the current image contains gray values
only.)
The balance options adjust colors about a medium hue. Auto balance neutralizes overly
prominent colors in an image and boosts inconspicuous colors. Balance to sample
operates similarly, except that you specify the color that is treated as the medium hue.
For example, if you select red with your eyedropper cursor, colors will balance away
from red toward blue and green.
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Keep in mind that while some commands perform opposite functions, you cannot
choose one command to undo the effect of another. For example, if you choose Soften
and then choose Sharpen, you will not restore an image to its original appearance. You
will diffuse the image and then heighten whatever detail remains.
Once you've finished manipulating a TIFF file, or even if you didn't manipulate it at all,
you can then save the file as a DCS file or as a TIFF file. To do this, choose the Save
command from the File menu and a standard Save as dialog box appears. At the bottom
of the dialog box is a pop-up option that allows you to choose either TIFF or DCS format.
The choice between DCS and TIFF is largely one of personal preference, although there
are some issues of compatibility in certain applications. If you are preparing an image
for use in PageMaker or QuarkXpress and want to print separations directly from your
page layout program, you must save your file in either the DCS format or in the TIFF
format using the CMYK option (described below.) The main difference between these
two formats (DCS and CMYK TIFF) is that the DCS format saves a file as five separate
files, one for each of the CMYK color plates and one PICT file that provides an on-screen
display in the software application where the file is used. The CMYK TIFF format, on the
other hand, produces a similarly preseparated file that is stored as a single file on your
disk. This may make it easier to keep track of the file (misplacing one of the five DCS
files renders the whole file unusable), generally produces a smaller total file size, and
often prints faster on PostScript imagesetters.
After you select a file format and click the OK button, another dialog box appears
providing access to options specific to the file format you have selected.
•

DCS. If you choose DCS, the dialog box shown in Figure 19-5 will appear, offering
you several choices about the DCS file you want to save. The first option is Main
PostScript size, which can be Full size, Small, or No Postscript. This affects the
composite PostScript code in the file, which is important only if you print to a
composite-color device, like a QMS ColorScript. The second option is the PICT
size, which can also be Full size, Small, or No PICT, and affects the quality of the
on-screen preview you will see when the file is placed in your page layout
application. Neither has any effect on the printed quality of the image, but they
dramatically affect file size. Lastly, you can choose to have your DCS file use
either a Binary or an ASCII encoding scheme. Binary data is about four times
smaller than ASCII data and is the best choice in most situations. If you have
problems printing or transmitting the file in binary, then the larger ASCD format
can be used as an alternative.
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DCS options
Main fil e Postscript® size:
0 Full size
@Smull
0 No PostScript©
Moln file PI CT size:
OFull size
@Small
0 No PICT

Encoding:
0 RSCII
@Binary

Figure 19-5: The DCS options dialog box lets you specify the size of your DCS files.

•

TIFF. If you choose TIFF, the dialog box shown in Figure 19-6 will appear, providing you with a choice of five image formats and four compression formats. The
Image formats available are CMYK, 24-bit RGB, 8-bit palette, 8-bit gray, and black
and white. The CMYK format is a preseparated TIFF format and the only TIFF
format that can be used if you want to print color separations directly from
PageMaker 5. The 24-bit RGB is the format normally referred to using the generic
name TIFF.

00

TIFF options
Image format: 124-blt RGBI
Compression:

[ Cancel )

~

Figure 19-6: The TIFF options dialog box lets you choose the format of your TIFF files.

Printing separations from PrePrint
To initiate the printing process, choose the Print. .. command from the File menu or
press Command-P. Depending on the format of the current file, a variation on the
standard LaserWriter dialog box will appear (provided of course that you have selected
the LaserWriter driver with the Macintosh Chooser desk accessory). If the current
document is an OPI file, the dialog box shown in Figure 19-7 will appear. If a TIFF file is
currently open, your LaserWriter dialog box will look like the one in Figure 19-8.
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Figure 19-7: The LaserWriter dialog box for OPI files.
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Figure 19-8: The Print dialog box for TIFF files provides additional height and w idth options.

The following is a description of each option found in PrePrint's LaserWriter dialog box:
•

Copies, Pages, and Paper Source. These options are inoperative in PrePrint. The
program always prints one separation of every page in the current document
with no cover page, using paper from the paper tray.

•

Print as. This option specifies whether the process colors and spot colors used
in the current document are to be printed separately (one color per page) or all
on the same page. If you are printing to a color PostScript device, you should
select the Composite option. If you are printing separations for commercial
printing purposes , select the Separations option.
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When Separations is selected, PrePrint will follow the s pecifications set in the
Print options dia log box. Accessed by clicking the Options ... button, this dialog
box allows you to select specific inks (corresponding to separations) that you
wish to print, determine overlaps and knockouts, and so on. The Print options
dialog box is discussed in detail later in this chapter.
•

Image size. The Image width and height options appear only when you print a
TIFF file. These options display the dimensions of the current image in the
measurement system set up in the Preferences dia log box. You can enlarge or
reduce the image by entering a different number for either the width or height
option. PrePrint a lways retains the original proportions of the TIFF image by
automatically adjusting the other dimension.

At the bottom of the LaserWriter dialog box is an icon that displays the format of the
current file (OPI or TIFF) and an information window that lists the settings from the
Print options dialog box. Among these are the location of the current file on disk, the
active PPD file, selected inks, and so on. To change any one of these settings, click the
Options ... button.

Printing options
Clicking the Options ... button in the LaserWriter dialog box brings up the Print options
dialog box, shown in Figure 19-9. It is here that you determine the hows and whys of
separating color documents with PrePrint.
Figure 19-9:
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The options in this dialog include the following:
•

Printer type. This option is used to select the PPD (PostScript printer driver) file
that PrePrint uses to optimize its printing performance. Whenever possible,
choose the printer name that exactly matches the printer model you are currently using. Some PPD files have numbers following the printer name, indicating
the specific version of the PostScript ROM chips inside the printer described. If
you are unsure what version of the ROM your printer uses, consult your local
printer dealer.

•

Paper size. This option determines which paper tray will be used when your
page is output. PrePrint uses this information to calculate the placement of
margin notes and to decide if each page of the current document will have to be
tiled onto more than one printed page. In general, you want to choose the
smallest paper size that will contain your document and for which you have an
appropriate paper tray.

•

Optimized screens. Your printer can print only in black and white (or solid
colors). To create the appearance of grays and mixed colors, PrePrint outputs a
pattern of small dots called halftone cells. The Optimized screens option is used
to control the number in pixels ascribed to each halftone cell.
Your printer's PostScript interpreter determines the size of a halftone cell by
dividing the resolution of the printer (dots per inch, or dpi) by the resolution of
halftone cells Oines per inch, or lpi). For example, suppose you choose
LWNTX470 (the PPD for the LaserWriter NTX) from the Printer type pop-up
menu and 60 lpi 300 dpi from the Optimized screens options. The 300-dpi printer
resolution is divided by the 60-lpi halftone resolution to determine that each
halftone cell is 5 pixels wide by 5 pixels tall, for a total of 25 pixels per cell.
Therefore, by turning on as few as 0 or as many as 25 pixels in each cell, your
printer will be able to render a total of 26 gray values. By comparison, a 1,270-dpi
imagesetter can yield 60-Ipi cells measuring approximately 21 pixels wide by 21 pixels
tall, for a total of 448 pixels per cell. This means that the typesetter can render
449 gray values.

•

Positive/Negative and Emulsion. Here, you can select either the Positive or
Negative option, as well as either the Right reading/Emulsion down or Right
reading/Emulsion up option. Selecting Negative causes your document to be
printed with an inverse tracking function, so that all white areas print as black
and all black areas print as white. Select Negative only when you intend to print
to a imagesetter, outputting film that will be used to create printing plates. Select
Positive if your printer cannot output film, or if you want to print to positive film.
Selecting Right reading/Emulsion down causes your pages to print as if you were
looking at them in a mirror- the right and left sides are swapped. Select the
Right reading/Emulsion up option unless you are printing to film, in which case
you should consult your commercial printer.
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Other options. The two unrelated Options options are the Printer marks and
Print to disk check boxes. Printer marks are hairline rules that print around the
perimeter of a separation. These marks are used by your commercial printer to
align separations and to measure inks. I can think of no reason for ever turning
off the Printer marks option.
Check the Print to disk option when you want to save your separations as
PostScript files on disk rather than sending them to an output device. Click the
Set file name ... button to determine the name and location of the PostScript file.

•

Angle and Ruling. These values represent the optimum screen angle and ruling
for printing process-color screens. These values will serve almost all printing
situations left as is. Do not change these values unless you know what you're
doing or have been instructed to do so by your commercial printer.

•

P 0 Ink field and options. This field lists all inks included in the current document. PrePrint will print a separation for each ink preceded by a check mark. To
instruct PrePrint not to print a separation for a particular ink, select the ink name
in the field and deselect the Print this ink check box. The check mark will disappear. Selecting the Print this ink option makes the check mark reappear. You can
also use the Print all inks and Print no inks buttons.
You can control whether other colors can be printed on top of a selected color
using the Overprint this ink check box. This option is deselected by default.
PrePrint assumes that you want underlying colors to be knocked out, so that
differently colored shapes and text don't blend together. If you select Overprint
this ink, the selected color will appear behind areas of different colors, producing
a transparent printing effect.
Each custom or PANTONE color used in a PageMaker OPI document can be
separated to its own page. However, PrePrint also allows you to break down a
spot color into its four color-process components. Simply select the color and
select the Convert ink to process option. If your document includes color TIFF
files, you may want to convert all spot colors to process colors to save on the
number of separations and thereby minimize the commercial printer's fee. Keep
in mind that process colors can only approximate specially mixed PANTON£
inks. You should consult your printer before running an entire job.

Advanced and professional users can gain even more control over their printed separations by clicking the Press .. . button. The resulting Press control dialog box provides
options that allow you to compensate for discrepancies in the commercial printing
process. Presently, PrePrint is the only product to offer this kind of control over
press variations.
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Press Control
The options in the Press control dialog box, shown in Figure 19-10, adjust the algorithms used to convert RGB screen colors into CMYK process<olor values. They are
used almost exclusively for adjusting the separation of TIFF images.
Figure 19-10:
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The options in the Press control dialog include the following:
•

Paper stock. Ink bleeds into paper, spreading slightly from the point to which it
is applied. Depending on how porous the paper is, this bleed may be imperceptible or quite obvious. Coated paper, for example, has a plastic finish that
prevents ink from spreading. Newsprint, on the other hand, consists of very
loose fibers, which encourages ink to expand, resulting in muddy photos and
blurred text. By preparing your document for the paper on which it will be
printed, PrePrint can lessen a paper's bad effects. You can select one of four
options-Coated, Uncoated, Newsprint, and Supercalendered- from the Paper
stock pop-up menu. Each option carries default values for the other options in
this dialog, adjusting the manner in which your final separations are output.

•

GCR. These initials stand for Gray Component Replacement. When the density of
cyan, magenta, and yellow inks reaches a certain level, they blend to create a
muddy gray-brown. To avoid this unpleasant color and to conserve ink usage on
the press, PrePrint replaces these colors with a black screen. A GCR of 60%, for
example, instructs PrePrint to replace 60% of the cyan, magenta, and yellow ink
in a muddy area with black.
If you deselect the GCR check box, PrePrint relies on a technique called Under

Color Removal (UCR). Under the auspices of UCR, if cyan, magenta, and yellow
ink overlap areas of black, they are simply removed, since theoretically a color
cannot be any darker than solid black.
•

Gain compensation. When ink bleeds into a piece of paper, the size of individual
halftone dots tends to grow, or gain. When halftone dots grow, your scanned
photographic images, most specifically, will darken, blurring details and diminishing color clarity. You can prevent muddying of photographs by creating
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smaller halftone dots in the first place, compensating for ink gain in advance. The
value you enter for the Gain compensation option will reduce your halftone dots
by that percentage.
•

Total ink coverage. The total ink coverage is the maximum amount of ink
allowed on a page. The sum total of cyan, magenta, yellow, and black percentages, this value may range from 0% to 400%. The standard maximum total ink
coverage is 280%; anything over this value tends to cause clogging and smudging. Try changing this value and returning to the image window. Position your
eyedropper over the darkest area of a color image. The TIC value in the status
bar will never exceed the percentage specified in the Total ink coverage option.

For many users, the Press controls options may seem overwhelming or excessive. You
may want to ask your commercial printer what settings he or she recommends. Or you
can simply select a paper stock and rely on PrePrint's preset values. Any changes you
make to settings in the Printing options and Press controls dialogs are retained as
default settings for future PrePrint sessions.

Trapping with Aldus TrapWise _ _
Trapping is not a subject in which most designers or production professionals are well
versed. And with very limited exceptions, available desktop publishing software doesn't
provide very good trapping tools, be they manual, automatic, or semiautomatic. As a
result, even well-designed and otherwise well-constructed pages, when separated on
PostScript imagesetters, can result in less-than-perfect results on press because of poor
or nonexistent trapping in the electronic files.
Trapping electronic files has been a difficult problem for a variety of reasons. Good
trapping requires extensive knowledge of color as well as the prepress and printing
processes. And even then the inherent complexity of trapping requires commitment as
well as patience. Until recently, good trapping was also waiting for technological
breakthroughs because limits in existing software solutions were frustrating at best.
There have been several different approaches to trapping implemented on the desktop,
but each has provided only partial success and has imposed its own costs.
Aldus TrapWise largely solves the electronic trapping problem because it separates
trapping from the design and production of electronic pages, it automates the complex
and time-consuming aspects of accurate trapping, and it provides prepress professionals with a dedicated tool that they can use to produce precise trapping solutions that
were never before available.
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What is trapping?
Before we move forward, a few steps backwards. The term trapping, as used in desktop
publishing parlance (or the larger domain of electronic prepress), describes the process of intentionally creating a small overlap of the colors in adjacent objects. This
technique avoids visible problems caused by printing press misregistration: most
significantly, small gaps between objects that allow the underlying paper color (usually
white) to appear, and hue shifts caused by unintentional color overlaps. These gaps
and hue shifts are easily noticeable and completely unacceptable in most colorprinting situations.
Creating and controlling these intentional overlaps (traps) is not a trivial task. Accurate
trapping depends on the colors, shapes, and relationships of the objects on the page
and on the printing circumstances under which the document will be reproduced. For
each trap, color, width, and placement must be defined. And for the best possible
trapping, these attributes often must change as the color and relationship of the
trapped objects change.
The process referred to here as trapping is also known by several other names, including chokes and spreads, fatties and skinnies, lap register, making grips, and shrink and
spread. To further complicate matters, the term trapping has traditionally been used to
describe issues relating to printing multiple layers of ink on top of each other and the
way these overlapping inks react to each other. In this book (and in all Aldus documentation), trapping is defined as creating color overlaps.

Why trapping?
In a perfect world, trapping would not be necessary because every color would print in
the exact location intended. In reality, such perfection is improbable for a number of reasons.
The first event that makes trapping necessary is imagesetting, when the electronic file is
· printed and color separations are made. These separations should be aligned perfectly,
or in register, but every imagesetter has some degree of inherent inaccuracy, and so
misalignment is common.
The measure of imagesetter inaccuracy is known as repeatability, or the capacity to
mark in the correct position page after page. This is a particular problem on older
capstan-based imagesetters, many of which are still in use and which can be off by as
much as .012 of an inch for every 18 inches of paper or film printed. This margin of error
is too great for the generation of acceptable color separations. Capstan imagesetters
manufactured in 1992 or later are far more consistent, potentially varying only .006 of an

Chapter 19: Aldus PrePress Tools

547

inch for every 48 inches of paper or film printed. Drum-based imagesetters perform
even better, varying no more than .001 of an inch for every 24 inches of paper or film
printed. Separations produced on drum-based imagesetters are well within the standards of the prepress and printing industries but still contribute to the need for trapping.
The next potential trouble spot that necessitates trapping is film assembly, or stripping,
where the stripper may inaccurately position a piece of film. This happens infrequently
because most strippers are skilled professionals, and alignment marks make it easy to
check their work, but it is possible-especially on more complicated jobs. Electronically created documents tend to require very little mechanical page assembly, however,
so this problem is less common than it used to be. Errors can also be introduced during
plate making, when vacuum pumps, exposure frames, and exposure systems are used
to transfer film images onto plates. Misalignment, inaccurate exposure time, inconsistent light intensity, and operator error are all potential trouble spots.
Once a job is on the printing press, the potential for register problems increases
dramatically. In fact, this is the most common place for significant misalignment to
occur. As paper moves through the press at a high speed during printing, pressure from
rollers and the pull of edge grippers propel the paper, and ink and water are applied as
necessary. This can result in misregistration for a variety of reasons:
•

The mechanical elements that move the paper can cause the paper to stretch, as
can the heat resulting from this process.

•

Ink and paper characteristics and humidity can also contribute to
misregistration.

•

Mechanical misalignment of one or more rollers or grippers can cause the paper
to be out of position when ink is applied.

•

As sheets of paper are accelerated through one part of the press and then
stopped before being accelerated again by another set of rollers or grippers,
"bounce" can occur, leaving the paper out of position.

The result of any or all of the above, or some combination of them, is colors that should
abut but do not. Instead, these colors unintentionally overlap in some areas and leave
gaps where the paper remains unintentionally visible in others. Proper trapping eliminates these problems.
Of course, trapping is not without its own problems and costs. Trapping is, by the
above definition, the intentional addition of color overlaps, and when two colors
overlap, a third color is almost always created. This is true because process inks have a
degree of transparency: The overlapping color allows some of the underlying color to
show through, so the two colors appear as a mixed, or third, color.
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Adding these overlaps (and the "third colors" they create) around the borders of many
or most objects on a page is clearly not the preferred solution in terms of the aesthetic
fidelity of the original image. Instead, it is the lesser of two evils: The small intentional
overlaps and third colors caused by trapping are far preferable to the unintentional
overlaps, third colors, and gaps that result when a document is not trapped.
Proper trapping minimizes the unpleasant effects of overlapping colors by using colors
that produce the least noticeable overlaps possible and by positioning traps in such a
way that most overlaps will be completely unnoticed by most viewers. It also minimizes
these effects by applying traps in the correct widths, based on both the elements
involved and the anticipated printing methods.

Color on the desktop
To really understand trapping, you have to think about how colors are defined in
PageMaker (and your other software applications) and how color is applied to electronic objects, images, and pages. As you probably know, there are two broad color
categories - spot color and process color - which correspond to the two different
ways color is reproduced in the printing industry.
Spot colors are defined and used when documents will be printed with premixed semior fully opaque inks. Typically, spot colors are selected from a palette of existing colors,
such as the PANTONE matching system, although you can create spot colors by mixing
colors from any color model supported by your software application. For spot colors,
the elements in an electronic file (and the subsequently output separations) designate
only the location and tint of the colors used; the actual colors are based solely on the
ink used by your printer. (flnts are lightened colors produced by limiting the number
and size of the dots used to print the color.) With most desktop applications, you can
define spot colors using any one of several color models, such as HSL (hue, saturation,
lightness), HSB (hue, saturation, brightness), or RGB (red , green, blue), or by selecting
from existing color-matching libraries, such as Dianippon, PANTONE matching system,
orToyo.
Process colors, in contrast, are defined as composite percentages of cyan, magenta,
yellow, and black (CMYK) and are printed using overlapping dots (halftone screens) of
these colors. By varying the number and size of the halftone dots printed for each
CMYK color, you can produce about 50,000 different colors using only four ink colors. In
PageMaker, you can define process colors in CMYK percentages, or you can select
colors from CMYK matching libraries from PANTONE Inc., Focaltone, or TruMatch.
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When you're ready to print the electronic file, you must create separations based on the
number of inks that will be printed on the press. For documents that will be reproduced
using spot-color inks and contain just a few spot colors, a separation is produced for
each page for each ink color; all the elements to which spot color #1 have been applied
are on sheet 1, all the elements to which spot color #2 have been applied are on sheet 2,
and so on.
When you print a document using process colors (also known as four-color printing),
any elements in the document that are not already defined as CMYK colors must be
converted into CMYK. This includes colors originally defined using the HSL, HSB, or
RGB color models, colors selected from a spot-color matching library, and colors
scanned and saved in an RGB format such as TIFF. This conversion, which is known as
color separation, can occur before or during printing on an imagesetter. (Usually, you
can exclude any spot color from conversion, so you can create a fifth color or varnish
separation when needed.)

Trapping basics
There are four basic trapping techniques-overprinting, knocking out, spreading, and
choking. Each modifies the relationship between two color objects. Overprinting describes situations where one object is printed on top of another, thereby eliminating the
primary problem that trapping is intended to avoid-gaps where paper can show
through. This is not a panacea, however, because the transparent nature of process
inks causes overprinting to yield an unacceptable third color in most situations. As a
result, overprinting is the preferred solution only when the overprinting color is sufficiently darker than the underlying color to prevent a noticeable third color from being
created or when opaque spot-color inks are being used.
Knocking out (or creating a knockout) describes the opposite situation, where the
overlapped area of an object is removed so that the top object prints directly on the
paper. It is this very situation that makes trapping necessary: When the top object isn't
perfectly positioned within the knockout, portions will unintentionally overlap the
underlying color (possibly creating third colors), and gaps will appear where the paper
can show through. To compensate for these potential problems, spreads and chokes
must be applied when objects are knocked out.

A spread is created by extending the edge of the top object so that it is larger than the
area of the knockout where the object is supposed to print. This allows some margin for
error, ensuring that even with a little misalignment, the knockout area will be fully
covered. On the computer, it is relatively easy to spread most objects by adding or
adjusting the stroke of their edges. A choke is the opposite of a spread- it shrinks the
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area of the knockout (as opposed to enlarging the size of the object that will fill the
knockout)-but it has the same result, adding a margin for error to ensure that even
with a little misalignment, the knockout area will be fully covered.
You can create overprints, knockouts, spreads, and chokes using traditional mechanical
production techniques, using tools available within many desktop software applications
or using dedicated trapping software such as Aldus TrapWise. Later I'll describe each of
these methods.

Defining traps
Not every element needs to be trapped, only those that are physically adjacent to other
objects and would be likely to cause noticeable problems if shifted. These problems
(paper showing through or distracting third-color overlap) are not likely to occur, for
example, between two colors that have largely similar color components (because each
contains similar percentages of cyan, magenta, yellow, and black inks) or when one
color is substantially darker than the other color so that overprinting is a satisfactory
trapping method.
When a trap is needed, the color, placement, and size of the trap must be defined. A
basic rule of trapping suggests that the color of the lighter object should be used to
create the trap, which should be positioned to overlap the darker object. This is
generally true, but there is another important concern: The shape or edge between the
colored objects must be maintained. Some objects-rectangular graphic elements for
exampl~an easily be spread or choked without dramatically changing their appearance, while other elements- small- to medium-sized text or delicate line art for example-are easily disfigured by even subtle edge changes. As a rule, thin or delicate
objects (including text) should be overprinted whenever possible, should be choked
with lighter adjacent colors when overprinting is not possible, and should almost never
be spread.
In many cases, rather than using one of the object colors as a trap color, you can get
better results by using a tint of one of the object colors or a new, third color defined
using the common color components of both object colors. To select a third color to
use as a trap color between two process colors, you examine the component ink
percentages of the two adjacent objects and then define a new color using the higher of
the ink percentages for each color component. For example, if the color of one object is
· C25 M40 YlO Kl5, and the color of the other color is C40 MlO Y70 K5, then the trap
color that uses the higher of the common ink percentages should be C40 M40 Y70 Kl5.
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Traps using tints or third colors are likely to be far less noticeable than traps using the
color of the lighter object. Creating tint or third-color trap colors is difficult, if not
impossible, using traditional methods, but is relatively easy with electronic publishing
tools. As you will see, TrapWise creates these traps automatically and even varies the
third color as the objects' colors change gradients and vignettes. (A gradient is a fade
from one tint level of a color to another tint level of that same color. A vignette is a fade
from one color to another, different color.)
Trapping gradients or vignettes has been nearly impossible with traditional techniques
because of the need to vary the trap color and because these color changes require
changing the location of the trap--shifting from a choke to a spread and perhaps back
again-as the light/dark relationship of the objects changes. TrapWise positions these
traps automatically as well.
The size of a trap, which is expressed most often in either inches or points, depends on
the printing method used, the tolerances of the printing equipment, and the expertise of
the operators. As a rule of thumb, most traps vary between .25 point and .5 point.
Smaller traps are used for high-quality sheet-fed work, and larger traps for less demanding jobs like web-press newsprint. You should always obtain the size of the trap needed
from your printer, who can base trap size on equipment and experience. Building traps
too small will not overcome the undesirable effects of misregistration, and building traps
that are too large will result in excess overlap, which creates third colors on your pages.

Traditional trapping
With traditional prepress techniques, when overprinting cannot solve a potential
trapping problem, traps are created by selectively overexposing film, thereby causing
page elements to grow slightly and overlap adjacent elements. This is usually done by
growing (spreading) the foreground object, so that it slightly overlaps the underlying
background object. Alternatively, you can enlarge the background object (choking), so
that it overlaps the foreground.
Film overexposures that create chokes or spreads are made by sandwiching an original
film negative between the glass cover of a contact frame and clear spacer film over new
contact film. A diffusion sheet is then placed on top of the contact frame's glass cover,
and light is directed from above. Light rays passing through the diffusion sheet are set
at various angles. As these angled rays pass through the original film, those near object
edges travel an additional distance (due to the clear spacer film) before striking the new
contact film. The result is a growth of the original object as it appears on the new film.

552

Part III: Advanced Topics

The amount of growth is controlled by the thickness of the clear spacer film used
(normally .003 or .004 inch thick, although two or more sheets can be used for additional thickness, which makes additional growth possible) and the duration of the light
exposure Oonger exposures cause more growth).

Trapping with desktop applications
Some desktop applications provide features designed to help you perform basic
trapping, such as options for defining knockouts or overprinting, and control over the
stroke and fill of each individual object. These are especially prevalent in drawing
applications, such as Aldus FreeHand, Adobe Illustrator, and Corel Draw!, and to a
lesser extent in page layout packages such as PageMaker and QuarkXpress. Bitmap
painting packages and image-editing software usually do not offer specific trapping
capabilities because it generally isn't necessary to trap colors within one bitmapped
graphic (although anti-aliasing to avoid sharp edges is sometimes helpful). More
frequently, the bitmapped graphic needs to be trapped relative to other objects when it
is imported into another graphic application or a page layout program.
To trap using knockout, overprint, stroke, and fill commands, you must determine the
individual trapping needs of each element on your page and then set the options
appropriately. This requires an understanding of trapping rules, certainty about how
each color and each object will relate to other objects and colors when the piece is
finished , and information from the printer about press requirements. Good results can
be achieved in this way, and for simple pages containing simple color relationships or a
s mall number of color interactions, it is often the best solution. For more complicated
pages, however, achieving good results requires considerable time and diligence.
QuarkXpress offers several trapping options worth noting. Xpress's automatic trapping
option applies a trap of a user-defined amount based on the programs calculation of the
color relationship between adjacent objects. (The luminance of each color is checked,
and then the lighter object is trapped to the darker.) You can define specific color
relationships so that when an object of a certain color is adjacent to an object of
another certain color an overprint, a knockout, a spread, or a choke is applied. This
eliminates the need to make trapping decisions on an object-by-object basis, since the
software will apply color rule trapping based on the selected colors. These rules are not
optimal in all situations, however-s.mall objects with delicate shapes often should not
be treated like larger objects, regardless of similarities in the color relationships, for
example. (There is a workaround for this deficiency: Two versions of the same color
can be defined and named differently, with different trapping rules defined for them.
Either version of the color can then be applied to an object, depending on the trapping
needs.)
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The limitation of Xpress's trapping capabilities is the same as that of other programs
that allow you to create c hokes and spreads on an object basis: When a single element
is adjacent to more than one other element, or when the color of an element changes
(as in gradients or vignettes), there is no way to apply the correct trapping color. In
other words, if one part of an object needs one kind of trap, and a nother part of that
object needs another kind of trap, your options are either to build a trap that will be
right for part of the element and wrong for part of the element, build a trap that is the
best compromise, or build no trap at all. Xpress provides control over this decision
with its Indeterminate option, but there is no good decision in this common situation,
so such control is not a valid solution.

Trapping with Aldus TrapWise
When files will be trapped with Aldus TrapWise, the designer and production professional are free to complete the pages without building any traps at all. In fact, while
TrapWise can work with files in which manual traps have been built, it will generally
work better if the files contain no traps at all. In order to use TrapWise, each page of the
file that will be trapped must be saved as a separate single-page Encapsulated
PostScript (EPS) file. (frapWise 2.0 supports multiple page PostScript files such as
those created in PageMaker 5.)
Aldus TrapWise 1.0 is available only for Windows, which means that Macintos h files
must be moved to the PC either via network, communications software, or file transfer
utility before it can be trapped. Aldus TrapWise 2.0 is scheduled to be available in the
first quarter of 1994 on the Macintosh as well as for Windows.
TrapWise builds traps automatically in a four-step process:
1. First, your file is passed through a software RIP (raster image processor), which

converts the PostScript into a proprietary bitmapped format.
2. Then, TrapWise analyzes this bitmapped format to find the edges of every object
on the page. This ability is based on patent-pending technology and is where
TrapWise differs from all other electronic trapping solutions.
3. TrapWise then builds traps for all elements on the page, based on the size, color,
and location of object edges and based on a set of trapping parameters that you
have defined. TrapWise handles spot colors, process colors, and pages containing process colors and up to four spot colors. TrapWise is the only desktop
solution that can vary the color, size, and positioning of traps as it moves along
the edge of an object so gradients or vignettes are trapped accurately.
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4. Finally, TrapWise creates a new EPS file, containing the original, unmodified
PostScript file with the traps appended to it. This EPS file is ready for imposition
and/or imagesetting.
The only part of this process that takes any effort at all is the specification of the userdefined trapping parameters. These parameters, described next, make it possible to
control the color relationships that TrapWise traps, the size of the traps TrapWise
creates, and how TrapWise handles special situations like rich blacks, blends, spot
colors, and more. To make TrapWise as efficient as possible, it can store all of these
user-defined settings in trapping style sheets that it calls configuration (.CNF) files.

How TrapWise builds traps
TrapWise builds its traps by following a number of trapping rules and by considering
the trapping parameters set in the Trapping Defaults dialog box. The first rule that
TrapWise follows when building a trap is that it creates a trap that spreads lighter
colors onto the darker colors. This tends to preserve the visual edge of darker objects
and results in less noticeable traps. To do this, TrapWise must determine which color is
"lighter" and which color is "darker" by measuring the neutral density of every color.
Neutral density is based on the amount of light reflected back from the paper to which
the color is applied. It is calculated using a mathematical formula that converts the
component ink percentage of each color to a precise neutral density value. This value is
then displayed in TrapWise's Measured Color window when the densitometer tool is
selected. Neutral density values reflect an inverse relationship between the amount of
light and the neutral density value: Dark colors have high neutral density values based
on the low amount of light they reflect, and light colors have low neutral density values
based on the high amount of light they reflect.
Once TrapWise knows the neutral density of the adjacent objects, it then checks to see
if a trap is necessary by comparing the difference between the values to the minimum
step threshold option. This is important because it isn't necessary to create a trap
every time one color abuts another, only when the colors of the objects are likely to
cause trapping problems in the event of press misregistration. The minimum step
threshold specifies the amount of variation between the CMYK components of two
adjacent colors before a trap might be needed. By default, the value of the minimum
step threshold is 10%, so any color component (cyan, magenta, yellow, or black) in the first
color that is within 10% of the corresponding component in the second color will not be
trapped. If all color components are within 10% of each other, no traps will be added.
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In addition to the presence of at least two component colors that vary by at least the
minimum step threshold, at least one of t hese colors must be getting larger while at
least one is getting smaller in order for a trap to be created. So if there are three colors
that vary by an amount larger than the minimum step threshold, but they are all
present in larger percentages in one object than in the other, no trap will be created. In
that case, the result of a gap between the objects would be a color somewhere between
the two colors, so adding a tra p would not improve the situation.
Once TrapWise knows that a trap must be created, it must decide a trap color, trap
width, and the placement of the trap. TrapWise can determine trap colors in two
different ways. In its Overprint mode, the trap color includes only those component
colors of the lighter object that are darker than those in the darker color. These colors
are then overprinted on the darker color. Alternatively, in Conventional mode, traps are
built as they were built traditionally, by using the higher component percentage of each
component color.
In certain situations, an additional step is taken to achieve better results by slightly
reducing the percentage of some or all component colors in the traps. This process is
called trap color reduction, and supported by TrapWise in two ways. With manual trap
reduction, you specify reductions for each process and spot color independently. This
affects all common colors when you use conventional trapping (because all common
colors are used in the trap), but only affects the darker components of the lighter color
(because those are the only colors used in the trap) when overprint trapping is used.
Automatic trap reduction is a built-in TrapWise feature that makes traps less noticeable
without significantly changing their color. It does this by not selecting the higher of
each available component ink percentage but instead using the smaller of the two
values for each ink where the percentage difference does not exceed the minimum step
threshold. This method is used only if two adjacent colors have three or more common
color components.
Trap width is set as a trapping option and is set separately for Normal objects, traps set
Under black, and traps set Over images. The normal trap width should be sufficient to
compensate for any misalignment that might occur in prepress or on the printing press,
and values between .002 and .03 inc h are common. Trap widths for the Under black and
Over images options are usually the same as the Normal option or smaller.
Determining the placement of a trap is easy when one element is clearly lighter than
another. Whe n adjacent elements have similar neutral densities or include graduated
fills (fills in which the amount of color varies from one part of the object to another) or
vignettes (blends in which the object changes from one color to another), determining
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trap placement is more complex. In these cases, the trap must be placed so that it
partially overlaps the edge of each object. Fortunately, TrapWise handles trap placement
automatically, sliding traps from one element to the other as neutral densities change.

Other TrapWise features
Beyond this basic process of determining which elements on a page need to be trapped
and building appropriate traps for those elements, TrapWise provides several other
important features and capabilities.
•

Trapping black elements. Because the color black is always as dark or darker

than any adjacent elements, TrapWise handles black differently in a number of
ways. First, since the edge of the black object always defines the relationship
between a black object and another object, adjacent non-black colors always
spread into blacks.
If the black object is adjacent to a process color, the trap color is made up of the
CMY components of that process color. If the black object is adjacent to a spot

color, the spot color is used as the trap color. TrapWise does not create a trap
when a black object abuts another black object. If the black object contains some
percentage of cyan, magenta, and/or yellow ink, it is considered a rich b/acl?, and
the non-black component colors are called supporl screens. Support screens are
often used to ensure a deep, dark black that may not be possible with pure black
ink alone. Support screens also add another trapping consideration:
Misregistration can cause a support screen to become visible where it inadvertently extends beyond a black edge. To eliminate this possibility, support
screens must be choked back from the edge of the black object in which they
appear. TrapWise does this based on the value of the Under black option in the
Trapping Defaults dialog box.
•

Trapping images. When a file contains TIFF or MacPaint images (or OPI com-

ments pointing to such files), TrapWise recognizes these images but does not
create traps within these images: It traps the image only to any adjacent objects.
In fact, each image is treated as a single object filled with a uniform color defined
as 100% cyan, 100% magenta, 100% yellow, and 100% black. Because this is the
darkest color possible, any adjacent element will always be lighter, and so
TrapWise always traps by spreading the adjacent elements onto the image. The
color of the trap, as in any other situation, is based on the component colors of
the adjacent objects and whether conventional or overprint trapping is being
used. The width of the trap is defined by the Over images option in the Trapping
Defaults dialog box. (frapWise 2.0 adds the ability to trap continuous-tone
images against other elements.)
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•

Trapping resolution. TrapWise allows you to specify the resolution at which the
resulting file will be imageset, a value that determines the number of pixels
TrapWise manipulates when it traps the file. Normally this option is set at the
actual imagesetting resolution, but in some cases you can specify a value lower
than the resolution at which the file will actually be imageset to get faster trapping and smaller resulting EPS files. Doing so, however, also produces in somewhat lower-quality results because it affects the placement and shape of the
traps, so this should only be done after some testing and consultation with your
printer.

•

Ink control. TrapWise can successfully trap EPS files containing up to four spot
colors and the four process colors. (frapWise 2.0 can trap files with up to 16
spot colors.) If your trapped file will be printed using a spot-color ink for each
spot color present in the file, spot-color trapping is handled automatically. If any
of the spot colors will be converted into process colors before (or during)
separation, however, you must trap those colors as if they are process colors
so the correct trap colors will be applied.

•

Trap zones. Although TrapWise is normally used to trap entire pages, on many
pages only a small percentage of the page is actually at risk for trapping problems. In these cases, it is a waste of time to have TrapWise perform its complex
conversion and analysis on the entire page. A page that is made up primarily of
black text on a white background (which fills so much area on so many pages)
but includes one complex EPS graphic is a good example. On a page like this,
only the area of the EPS graphic really needs to be trapped. On other pages,
different areas of the page might have very different kinds of graphics, and the
trapping parameters that are right for one part of the page may be inappropriate
for another.
To handle these situations, TrapWise supports trap zones, which allow you to
define a set of trap parameters that apply only to specific areas of the page. By
creating more than one trap zone on a page, you can trap different areas of your
page using different trapping settings.

•

Traps previews. To help you see the trapping decisions that TrapWise is making
for your file, TrapWise can produce grayscale and full-color trap previews.
Grayscale previews display traps in red so trap locations are highly visible and it
is easy to measure trap color with the densitometer tool. Full-color previews
show the exact trap color, size, and placement (to the degree of accuracy
possible on your monitor) and also allow you to analyze trap color with the
densitometer tool.
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RoboTrap. This add-on program, provided with TrapWise at no extra cost ,
makes it possible to batch-process files through TrapWise or set up automatic
trapping that takes all EPS files placed in a specific folder (or directory in Windows), traps them using a predefined configuration file, and places the resulting
trapping file in another specified folder or directory. With RoboTrap, the process
of trapping files, which can be relatively time-consuming, can be set up and then
run unattended (keeping the program busy all night, for example) until all
trapping has been completed.

Imposition with Aldus PressWise_
When you cr eate multiple page documents such as newsletters, magazines, or books,
the publication pages that you finish in PageMaker are only the starting point of a
complex process that ends when your finished publication Is bound and ready to be
distributed and read.
One of the vital steps in this pr ocess is combining the pages of your publication into

signatures. Signatures ar e groups of 8, 16, or 32 pages that are arranged in such a way
that once the signature is properly folded, trimmed , and bound, the final pages wind up
in the proper order and orientation for reading. Determining which page goes where
when building signatures is called imposition.
To get the general idea of imposition, fold a piece of paper into quarters, like a gr eeting
card. Then number each panel, starting at the first page and continuing inside and out
through the pages as you come across them, as if you were paginating a book. Now
unfold the page, and you'll find that some of the numbers appear upside down and that
page 1 is not on the same side of the same page as page 2. This is an imposition form. If
you reprinted this page, front and back, on a new sheet of paper, you could fold the new
paper like the original, trim away the top two folds, and staple the center folder. The
result would be an eight-page, saddle stitch booklet.
To correctly design an imposition form, you must take into account the folding pattern,
binding method, paper stock, and publication design that will be used. Each page must
be positioned within the signature with great precision, to make sure it is centered and
correctly aligned after final trimming. This is a very complex task- there are literally
hundreds of possible imposition forms, and only one or two will work for a specific
printing job. And any mistakes in the imposition aren't likely to be found until after
printing, when all pages are folded and it turns out that page 17 is upside down or page
32 follows page 6. Imposition must be done right the first time.
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Traditionally, imposition was done by hand by a group of folks called strippers. But very
few of these strippers have any resemblance to Belle Star although I do hear they get
pretty wild at their annual convention. But that's another story. Strippers manually
build signatures by mechanically assembling page negatives. They follow imposition
forms that they've learned over years of experience, and the entire process is relatively
slow and accordingly quite expensive. Building signatures for a single 32-page four-color
project can take even an experienced stripper as long as four hours.
When imposition is done electronically, the calculations that determine which page
goes where are handled by the computer, and pages are positioned with perfect
mathematical accuracy. Signatures that would literally takes hours and hours to
produce manually are completed in just seconds, and pages come off the imagesetter
ready to be burned into plates, or at least nearly ready. Electronic imposition has only
recently become practical because of new wide-carriage imagesetters-between 40 and
60 inches in some cases-that are capable of printing 2-, 3-, or 4-page wide signatures as
single sheets. If the width of the imagesetter is less than the size of the total signature,
electronic imposition can still be done, but the signature is printed as tiles that are then
stripped together. Even this saves !-2 to J.1 of the time and effort of manual stripping in
most cases.

How PressWise works
Aldus PressWise takes finished electronic pages from many different sources-Aldus
PageMaker, QuarkXpress, Aldus FreeHand, Adobe Illustrator, and others-and electronically imposes them so that they are ready for imagesetting. The program can save
finished impositions to disk as PostScript files or can directly manage the printing of
these files to imagesetters. The general workflow used with PressWise goes as follows:
1. flnished files are saved in the PostScript file format. To impose a publication

electronically, you start by saving the finished PageMaker publication to disk as
a PostScript file. If any pages of the publication you are creating were produced
in other programs, such as QuarkXpress, Aldus FreeHand, Adobe Illustrator, or
Adobe Photoshop, you must save these files as PostScript files.
2. Launch PressWise. Depending on your particular workflow, you can choose to
impose your files before or after color separation and before or after electronic
trapping. Usually, however, files are both separated and trapped before
they're imposed.

560

Part Ili: Advanced Topics

3. Load your PostScript rues. PressWise allows you to open the PostScript versions
of all files (up to 32) that will be a part of your publication. As it opens each file,
PressWise scans the PostScript code to learn about each page In the file and the
fonts and colors used on those pages. The Page list, shown in Figure 19-11,
includes an icon for each page in each file you have opened and the order in
which those pages will appear in your final publication. You can reorder these
pages freely-even rearranging pages between different publications. You can
also delete pages or add blank pages that act as placeholders for pages that will
be mechanically stripped in later.
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Figure 19-11 : The Page list dialog box shows all open pages and publications.

4. Choose or create an imposition template. PressWise uses templates much like
PageMaker uses style sheets. A template file contains settings for every
PressWise option regarding one specific imposition. Dozens of ready-to-use
imposition templates are included with PressWise, and you can modify any of
these, if necessary, or you can build your own templates from scratch. You can
also get imposition templates from others and use them in your copy of
PressWise. Figure 19-12 shows signature options, and Figure 19-13 shows template editing options.
Once an imposition template is selected, a preview of your imposed file appears
on-screen, allowing you to check the page order and arrangement. You can then
add, remove, or reorder pages and print a thumbnail signature.
5. Print the imposed file to an lmagesetter or to disk. The resulting files are
imposed signatures. Print these on a wide-format imagesetter and you' re ready
to go. Or tile them to a not-wide-enough format imagesetter.
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Imposition templates and PressWise
features
PressWise imposition templates are essentially style sheets containing every option and
pa rameter for one particular kind of imposition. Followjng is a quick overview of many
of the options you can control for each PressWise imposition template, and some other
key PressWise features.
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•

Perfect bound, saddle stitch, or combination (Smyth) binding. Selecting one of
these three popular binding formats determines how PressWise arranges your
pages and s ignatures.

•

Individual page rotation. Any page in your form can be rotated to create headto-head, tail-to-tail, or head-to-tail templates.

•

Form independent page numbering. Page numbers are calculated, or manipulated, based on the total number of pages in a form (front and back), and
PressWise automatically figures out the number of the back of the form when
you change numbering on the front of the form, and applies numbering changes
from the first form to all other forms in the template.

•

Trim page size with shingled gutters. You can define any fold in your template
as a gutter, specifying the amount of space that should be added. In addition,
you can specify shingled gutters where you define the paper thickness, and
PressWise automatically adjusts pages to take into account the creep that occurs
when folded pages move from the inside to the outside of a publication.

•

Press Specifications. PressWise lets you enter the press sheet size, specify
gripper edges, and define side guides, center marks, and color bar positioning.
Figure 19-14 shows the options.
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Figure 19-14: The Press setup dialog box.

•

Printing options. PressWise offers a surprisingly powerful set of printing features. These include a wide range of printer's marks (crop marks, registration
marks, collation marks, density bars, and color bars), tiling support for narrow
carriage imagesetters, OPl support, and full support for PostScript Printer
Description (PPD) files. The Print options dialog box is shown in Figure 19-15.
In addition, PressWise has its own built-in batch printing, which allows you to

print multiple jobs in the background to multiple imagesetters simultaneously.
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Image Cataloging with Aldus Fetch
Keeping track of graphic files has never been easy. Graphic files come in a great many
file formats, usuaJly don't have terribly evocative names, and often take up too much
space and consequently wind up being moved around frequently. All of these problems
occur to even the smallest publisher, and they grow geometrically when you're working
on lots of publications, doing graphic-intensive work, sharing files with others on a
network, or using large amounts of clip art or stock photography.
Not too long ago, the idea of using a dedicated software package to keep track of your
graphics would have been overkill. Today, the increasing size of hard drives, the
introduction of Kodak's Photo CD technology, the vast amount of available high-quality
clip art, the ease with which you can do your own color or grayscale scans, and the
popularity of removable storage media like Syquest or Bernoulli drives or CD-ROM
players make it nearly impossible to keep track of your graphic files without a software
package dedicated to that task.
Aldus Fetch is designed to solve these problems by providing an image database with
which desktop publishers can keep track of all their graphic files. When you use Fetch,
you can create one big database to keep track of all of your graphics, or you can create
any number of smaller databases, each of which tracks the graphics stored in one
particular location or associated with one particular project. In each database, Fetch
stores miniature versions of each cataloged graphic, as well as lots of information about
each graphic, such as its size, file format, storage location, and any key words you
associate with that graphic in order to help find it later .
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Fetch lets you browse all of these items in a scrollable list or as graphic thumbnails,
even if the actual files are stored on removable cartridges, network file servers, or COROMs. Or instead of browsing, you can search for items by name, location, or keyword.
Once you find an item you want to use, you can preview that item at full size from
within Fetch, launch the application that created the file, or transfer the item into
another application.

Working with Fetch
To use Fetch, you create a database, called a catalog, in which you will store thumbnails
of your graphics files, sounds, movies, and text files. You can create and maintain
different catalogs for different purposes, or keep just one Fetch catalog that contains all
of your media assets. I tend to create a number of different Fetch catalogs for different
purposes: I have one I'm using to track all of the graphics for this book; one I'm using to
track all of the elements in a project I'm doing with the Apple Media Tool; one for all the
QuickTime movies I've collected or that reside on the various CD-ROM discs that I have;
one for my personal Photo CD collection; and one for all of the miscellanous graphics,
TIFF files, and clip art I own.
Once a catalog has been created, you add items to it by using Fetch to look at specific folders,
hard drives, file servers, removable cartridges, or CO-ROMs and gather information on all
available items. To do this, you use the Add/Update Items .. . command (Command-E) from
Fetch's Admin menu. This brings up the Add/Update Options dialog box, shown in Figure
19-16. Here you can specify what type of files you want to add to your catalog, the kind of
thumbnails you want created (1-bit, 8-bit, 32-bit, or combinations), and what kind of compression you want applied to the thumbails. You also specify whether you want the item's name
and location added as keywords, or if you want to be queried for additional keywords and
item descriptions as each item is added. After setting all of the options, you then select the
drive or folder that you want Fetch to scan.
Fetch can read just about every popular graphics file format and many other kinds of
files as well. Version 2.0 can read files in the following file formats: Adobe Photoshop 2.0
or 2.5, Aldus FreeHand 3.0 or 4.0, PageMaker 4.0 or 5.0, Aldus Persuasion 2.0 or 3.0, EPS,
MacPaint, PICT, TIFF, Edition files, Finder Sounds, GrF, Jpeg, PhotoCD, Multi-ad Creator,
SoundEdit, TEXT, RIFF, QuickTime, Storm JPEG, Targa, and more. And it ships with a
copy of Apple's Macintosh Easy Open, which allows you access to even more
file formats.
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Figure 19-16:
The Add/
Update Options
dialog box.
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As Fetch reads the location you have selected, a progress dialog box shows you how
many files have been added and displays the thumbail of each item as it is added to
your catalog. For most files, the thumbnail image is an actual miniature version of the
file's content, but in some cases (such as sound files) the thumbnail is simply an icon
that represents the file type. The process of adding items to the catalog takes some
time, but you only have to do this once-if files are moved or renamed later, Fetch
updates the catalog very quickly. When all files in the selected location have been
added, the Find dialog box, shown in Figure 19-17, appears. Clicking the Find button will
bring up a window that displays all items in the catalog, or you can use the dialog box
to search for specific items by name, keyword , or description.
Figure 19-17:
The Find dialog box can
search for items by
name, keyword,
location, file type, or
combinations of these
criteria.
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To continue building your catalog, you repeat the use of the Add/Update Items command until you have cataloged all desired items. This may mean scanning different hard
drives, floppy disks, file servers, CO-ROMs, and removable drivers. When you are done ,
you have a single Fetch catalog, s mall enough to keep on your hard drive, that includes
thumbnails and information about all of the items stored in all of these locations.
To browse items in your catalog, you use the Fetch Gallery window, which can display
in text or thumbnails view. In the text view, you get a list of all items in the catalog (or
the results of the last Find command search), and when you select any specific item, a
thumbnail of that item and a list of keywords appear in the bottom of the Window.
In the thumbnail view, you see a miniature image (about 1.5 inches-by-1.5 inches) of
every item along with the item name and file type. From the Gallery, you can get more
information about any item by selecting it and choosing the Get Info command (Command-1). The Get Info dialog box tells you the exact location of the original item, gives
details about the file, and shows the current list of keywords and item description (see
Figure 19-18).
Figure 19-18:
The Get Info dialog box
presents information
about any item.
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To preview any item from your catalog, double-click on the item from the Gallery. At
this point, Fetch reads the actual file, so if it is stored on a disk that is not mounted, you
will be prompted to insert the disk, or if it is stored on a remote file server, that volume
will be mounted. Then a new window will appear, showing the graphic at full size and
full resolution or allowing you to preview the sound or QuickTime movie you selected.
Graphic images can be magnified up to 3,200 percent.
Once you have located an item in the catalog that you want to use, Fetch provides
several ways of transferring that item. Most directly, you can simply use the Copy
command to transfer a copy of the original item to the Clipboard and then transfer to
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any other program and use the Paste command. If you locate items on remote servers,
CO-ROMs, or removable cartridges and want to transfer a copy of the items to your
hard drive (or some other location) where you can use it for a specific project, you can
use the Copy Original. .. command from the Item menu.

Fetch and PageMaker 5
You can move graphics from Fetch into a PageMaker 5 publication, using the Copy
command, or you can transfer any number of elements to the PageMaker 5 library
palette. To do this, select the items you want to transfer in Fetch, and choose the Copy
References command from the Edit menu, using the Include Thumbnails option. Switch
to PageMaker 5 and open or select the library palette. Choose the Import Fetch Items
command from the Options menu in the library palette, and the copied items are added
to the library. You can then transfer them into your publication just like any other item,
and save the library for use in other publications.
If you want to use Fetch to catalog all of your PageMaker publications themselves, make
sure and select the Save Preview option in the Save As dialog box. This adds a thumbnail image to your saved publication, which Fetch uses when the file is added to a
catalog. If you don't use this option, a PageMaker icon will be used in place of the
thumbnail when viewing the file in Fetch.
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•• ••••••••••••••••••••••••••••••••••••••••••••••
Summary
•

For professional publishers, PageMaker alone is not enough. Your files and
images require color separation, trapping, and imposition utilities. You probably won't have to acquire these programs yourself, because they are routinely
used by prepress service bureaus and commercial printers.

•

Aldus PrePrint can produce preseparated files in the DCS or CMYK TIFF formats
from any existing RGB TIFF file. It can also be used to globally color-correct
images or print finished files directly to any PostScript output device.

•

Aldus TrapWise provides complete electronic trapping for any PostScript page.
The program analyzes each page to locate the edges of adjacent objects and to
determine if these colors will require trapping. If trapping is required, a trap is
automatically built, using the proper color, trap width, and trap placement. All
trapping is done based on user-defined parameters that affect which objects
are trapped, the color of each trap, and the placement of each trap.

•

Aldus PressWise produces fully imposed signatures from pages in PageMaker,
Xpress, FreeHand, or Illustrator files. You can freely rearrange page order, even
intermixing pages from different applications. Signatures are built by applying
signature templates and defining options concerning the press and printing
conditions you will be using. New templates can be defined to create signatures with up to 64 pages per side and in many bindery formats including
sheet-fed, web-fed, perfect-bound, saddle-stitch, and combination binding .

••••••••••••••••••••••••••••••••••••••••••••••••

Index
• Symbols •
1-blt monito r, 18
16-bit
color, 18
mode, 19
monitor, 18
16.7 million colors, 18
200% view size, 109
Command-2 keyboard
equivalent, 110-111
Command-Option-ShiftClick mouse shortcut,
111
Shift-Command-Option-.
keyboard equivalent,
Ill
24-bit
color, 18
mode, 19
mo nitor, 18
25% view size, 67, 109
Command-O keyboard
equivalent, 109, 111
400% view s lze, 110
Command-4 keyboard
equivalent, 110-111
50% view size, 109
Command-S keyboard
equivalent, 109, 111
75% view size, 109
Command-7 keyboard
equivalent , 109, 111
S-bit
mo de, 19
monitor, 18

•A•
About PageMaker
command, 59
Command key and, 59
dialog box, 59
Shift key and, 59
accelerato r cards, II
ACF flle extension, 383
Acquire image Addition,
36,394
Action routines, 393
actions, revers ing, 141- 142
Activate/Deactivate Control
Panel Command+·
keyboard equivalent,
350,366
Actual view size, 109
Command-! keyboard
equivalent, 109, 111

Command-Option-.
keyboard equivalent,
111
Command-Option-Click
mouse shortcut, 111,
198, 330,339,497
Add con't line Addition, 36,
394-395
arrow tool, 395
Add Index entry dialog box,
438, 446
Cross-reference option,
441-442
Current page option, 441
For n ext_ paragraphs
o ptlon, 441
Import button, 440
Range optio ns , 441
Reference Override
option, 442
Reorder button, 439
Sort option, 440
To next occurrence of
s tyle option, 44 1
To next style change
option, 441
Topic option, 4~39
Topic ... button, 43~40
Add Space Between Pairs
(Shift-Command-/E)
keyboard equivalent,
260
Add tab command, 249
Add word to user dictionary
dialog box, 185
Additions command, 212
Additio ns folder, 36, 383,
392,394
Additions Interface
Manager, 393
Additions submenu, 36, 388,
392,414
Adobe Illus trato r, 289
trapping, 552
Adobe Pho tos hop, 290, 532
Adobe Type Manager
(ATM), 32, 464
Adobe Type Reunion, 30
alafter.ps file, 476
albefore.ps fil e, 476
Aldcolor.add lile, 383
Aldus Additions, 25, 36-50,
39 1~ 25

accessing, 65
Acquire Image, 36, 394
Add con't line, 36, 394- 395
Balance columns, 36, 395

Build booklet, 36,
396-399
Bullets and numbering, 37,
399~00

Create color library,
37,401
Create keyline, 37, 40 1 ~02
Display pub info, 37,402
Display s tory info, 37, 403
Display text block info,
37, 403
Drop cap, 37, 212, 40~06
Edit tracks, 37, 396,
40~07

Expert kerning, 38, 46, 261,
396, 407~08
Find overset text, 38,
408-409
grip es, 396
how they work, 392-393
ins talling, 394
Library palette, 38, 396
List styles used, 37, 409
listing, 59
loadable Additio ns, 392
Open stories, 38, 409
Open template, 38, 409-410
Printer styles, 38, 410-413,
467
PS Gro up it, 38, 41~14
PS Ungroup it, 38, 4 1 ~ 14
re ins talling, 29
Run Script. .. , 392,423
Running head ers/footers,
39,396,414-417
scripts, 392-393, 423
selecting, 26
Sort pages, 39, 396, 4 17~1 8
standalo ne applications,
393
technology, 393
third-party Additions,
418-422
Traverse text block, 39,
418
Update PPD, 39, 476
with PageMaker 5, 394-418
Aldus Additions
command, 65
submenu, 392
Aldus Fetch, 563-568
adding items to
catalog, 564
brows ing items in your
catalog, 566
catalo gs, 564

graphics me formats, 564
PageMaker 5 and, 567-568
previewing any item, 566
Aldus Filters folder, 158
Aldus folder, 22, 24, 158,
383, 388,392,394, 407
moving, 28
Aldus FreeHand, 289, 291
EPS graphic from , 386
trapping, 552
Aldus hot link, 64, 291
Aldus Installer Diagnostics
file, 25, 28
Aldus Installer History
flle, 28
Aldus Installer Main
Window dialog box, 24
Additions optlon, 25
Filters option, 25
Install Everything option,
24
PageMaker 5.0 option, 24
Printer Description File
o ptio n, 25
Tutorial option, 24
Aldus Installer/Utility, 24
Aldus PageMaker 5.0 folde r,
24,26
moving fil es around in , 28
Aldus PrePress tools, 531-568
Aldus Fetch, 563-568
Aldus PrePrint, 532- 545
Aldus PressWise, 558-562
Aldus TrapWise, 545-558
Aldus PrePrlnt, 291, 532-545
all inks Included in the
current document, 543
Auto Enhance (Command-E)
command, 537
basics, 533-539
color attributes, 536
color correction, 532-545
color sample bar, 536
color separation, 532-545
fini sh ed pages from
PageMaker or
QuarkXPress, 533
TIFF images into the DCS
or CMYK TIFF flle
formats, 532
convert RGB screen
colors into CMYK
process-color values,
544-545
Darken (Command-D)
command, 537
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DCS files, 538
Decrease contrast
command, 537
Enhance command, 537
gain compensation, 544
GCR (Gray Component
Replacement), 544
halftone cells, 542
Image menu, 536-537
Increase contrast
command, 537
LaserWriter dialog box,
540-541
launching, 485-486
Lighten (Command-L)
command, 537
OPkompatible flies, 533-535
PageMaker documents
saved as separation
files 533
Positive or Negative
option, 542
PPD (PostScript printer
driver) file, 542
preparing for paper
stock, 544
Press control dialog box,
544-545
Print options dialog, 541-543
print to disk, 543
Print. .. command, 539
printer marks, 543
printer paper tray, 542
printing separations,
539-545
process colors and spot
colors printed
separately, 540
saving file as DCS or TIFF
file, 538
screen angle and ruling, 543
Sharpen (Command-R)
command, 537
size and memory, 536
Solten command, 537
TIFF Iiles, 533, 535-539,
541
total ink coverage, 545
Aldus PressWise, 558-562
form independent page
numbering, 562
how it works, 559-560
impositions templates,
561-562
individual page rotation,
562

loading PostScript
files, 560
perfect bound, saddle
stitch or combination
binding, 562
press specifications, 563
printing imposed file to
imagesetter or to
disk, 562
printing options, 563
saving files in PostScript
format, 560
trim page s ize with
shingled gutters, 562
Aldus Printer Description
(APD) files, 20
Aldus Scripting Language, 65
running scripts, 39
Aldus SuperPalnt, 291
Aldus TrapWise, 545-558
automatic trap reduction,
555
building traps, 554-556
determining trap
colors, 555
ink control, 557
manual trap reduction, 555
measuring neutral density
of colors, 554
minimum step threshold,
554
placement of a trap, 555
rich black, 556
RoboTrap, 558
support screens, 556
trap zones, 557
trapping, 545-558, 553-558
trap width, 555
alerror. ps file, 476
alert dialog boxes, 56
Application not found, 91
algorithm-based hyphenation, 253, 250
Alignment command, 71 ,
202,255
Alignment pop-up menu, 330
Apple lmageWriter, 21
Apple LaserWriter, 20
Apple LaserWriter NT, 477
Apple menu, 58-59, 465
launching PageMaker, 80
AppleScript, 423
Application not lound alert
box, 91
applications
defaults, 95, 320

hot links, 64
arbitrary zoom, 110
arrow tool, 76, 90, 153-154,
175,199,204,213,296,
298,304,306,459
dragging objects, 136
marquee, 134
selecting objects, 133
Shift key and, 133, 135
Shlft-F1 keyboard
equivalent, 76
ASCII text files
Importing, 160
removing extra carriage
returns, 159
replacing spaces with
tabs, 160
attributes
defining, 60
toggling on/off, 495
Attributes dialog box,
182, 184
Auto (Shift-Command-A)
keyboard equivalent,
214
AutoDoubler, 32
Autoflow command, 69, 167,
169- 170,495,506
autoflow text Icon, 167
automatic
hyphenation, 252-253
pair kerning, 257-259
text flow, 85, 168, 170

•B•
background printing, 20,
467,476
backspace key, 63, 141
Backward (Shift-Tab) key
combination, 56
Balance columns Addition,
36,395
Baseline Grid Addition, 420
baseline leading, 237
baseline shift, 40, 241
viewing, 360
basic terminology, 52-57
dialog boxes, 55-57
menus, 52-54
mouse operations, 52
.BCF file extension, 383, 388
Beginning of Line
Keypad 7 keyboard
equivalent, 232
Shift-keypad 7 keyboard
equivalent, 233

Beginning of Paragraph
Command-keypad 8
keyboard equivalent,
232
Shift..Command-¢
keyboard equivalent,
233
Shift-Command-keypad 8
keyboard equivalent,
233
Beginning of Sentence ShiftCommand-keypad 7
keyboard equivalent,
232-233
Beginning of Story
Home keyboard equivalent, 232
Shift-Command-keypad 9
keyboard equivalent,
232-233
Shift-home keyboard
equivalent, 233
Bernoulli drives, 16
binary system, 18
bitmapped graphics, 288, 464
bits, 12
body text, 268
Body text default style
sheet, 275
Bold Style (Shift-Command-B)
keyboard equivalent,
202,240,526
book lists, 427
adding publications, 428
building, 428
deleting files, 428
printing all publicat ions
In, 475
rearranging, 428
saving, 428
sending to other
publications, 429
table of contents from all
publications In list, 434
when to build, 428-429
Book publication list dialog
box, 61, 42S429
Auto renumbering option,
429-430
Book... command, 61,
427-431,448
chaln-prlnting
publications, 429
Command key and, 429
books,57,427-431
Indexing, 65
printing all flies , 61

Index

borders , 422
boundary segments, 516
bounding box positional
coordinates, 362
boxes
around any object, 37
copying, 220
Bring to front command, 73,
132,341
Command-F keyboard
equivalent, 73, 132
Build booklet Addition, 36,
396-399
Consecutive binding
optio n, 399
creep values, 399
Gutter space option, 399
Layout option, 398-399
Perfect binding
option, 399
preparing to use, 398-399
saddle stitch option, 399
scrolling page list, 398
Spread size option, 398
Bullet (Option-B) keyboard
equivalent, 37, 181
Bullets and numbering
Addition, 3 7, 399-400
Edit ... butto n, 399
Numbers button, 399
Range option, 400
Busy message, 470
bytes, 12

• C•
Cache, 532
Cannot fin d dialog box, 460
Cannot save as dialog box,
103
Cannot undo command, 62
Canvas,289
Capstan imagesetters, 546
Caption default s tyle sheet,
275
Caret (Shlft-6) keyboard
equivalent, 181
Cascade command, 46, 74
Catalog Copy file, 506
cent sign (¢) (Option-4)
keyboard equivalent,
338
Center (Shift-Command-C)
keyboard equivalent,
202,214,255,323, 340
Change dialog box, 65, 183-184

Attributes ... button, 184
Change & Find butto n, 184
Change all button, 184
Change button, 184
Change to option, 183
Find butto n, 184
Change Measurement
System CommandOption-M keyboard
equivalent, 366
Change ... command, 65,
183-184,443
Command-9 keyboard
equivalent, 65, 183
Character Mode command
set, 349,357-360
Baseline s hift optio n, 360
Font o ptio n, 357
Kerning optio n, 359-360
Leading o ption, 359
Set width option, 359
Style option, 358
Tracking option, 359
Type Size option, 359
character spacing, 256-257
Character view, 77
Character/Paragraph Mode
Command-Shilt-'
keyboard equivalent,
357,360,366
characters
attributes, 230
fonts of selected, 235
formatting basics, 230-231
formatting details, 233-241
leading, 237
new or exis ting text
formatting, 230-231
preset v.'idths, 234
selected te:~.'t mus t lit on
line,240
tracking, 238
type s ize, 235-236
type sty les, 240
wid th, 238
Charset.PT5 template, 176
check boxes, 55
choke,549
Chooser, 465-467
Background printing
o ption, 469
printer driver selection,
465-467
printer selection, 465-467
ciceros, 321
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circle/oval tool, 302, 305-306
correction in Aldus
Shift key and, 305
PrePrint, 532- 545
circles, 77, 302, 305-306
delining new, 378-384
Clear command, 63, 14 1,
deleting, 389
304,306
editing, 384-387
Shilt-C1ear o n keypad
!ill patterns, 307
keyboard equivalent, 63
import ing, 387-388
Clear key. 355
knockout. 380
click, 52
line segments, 304
clip-out coupon, 334-338
listing, 375- 377,488
column guides, 335
naming, 379
coupon border and dragging
on the desktop, 548-549
guides, 334-335
overprinting, 380
entering te.xt, 335-336
predelined, 381
graphic elements, 336-338
printing document without
Clipboard, 186-188
sepa rations , 487
choos ing fro m available
process-color printing,
file formats, 188
371-373
closing, 74
removing, 378
copying objects to, 63
replacing with another
file formats for contents, 64
color, 386-387
getting text into PageMaker
separat ions, 487-488
from, 186-191
shapes,306
multiple copies of o bjects ,
spot-color printing, 371-373
63, 138-139
text, 322
OLE serve r application
tint creation, 383-384
contents, 64
Color clia.log box, 487-490
pasting from, 63
Colors list, 488
pasting graphic into, 290
Composite/Color option, 487
pasting text from, 187-188
Mirror option, 488
placing objects in, 63, 138
Negative option, 488
s toring elements, 200
Optimized screen option.
viewing contents , 74
489-490
clock speed, 11
Preserve EPS colors
Close command, 60, 105
option, 488
Close Folder (Command-up
Separations option, 487-488
arrow) keyboard
Color folder, 383, 388
eq uivalent, 157
color libraries, 37, 381-383
Close Nested Dialog boxes
creatio n, 401
(Option-click)
c ustom, 388
keyboard equivalent ,
exporting, 388
247
file name, 388
Close Quotation (Optionlibrary name, 388
Shift-[) keyboard
new, 47
equivalent, 177, 181
colo r lists
Close story command,
Aldus FreeHand EPS with
76, 179
process color, 376
Command-W keyboard
deleting colors, 376
equivalent, 76
EPS graphic with spot
CMYK (cyan, magenta,
colors, 376
yellow, black) color
process-color names, 375
model, 379
s pot-color names, 375
color, 73, 37 1-390
tint names, 375
16-bit, 18
colo r matc hing systems,
16.7 million, 18
381-383
24-bit , 18
Library d ialog box, 382
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MUNSELL, 382
PANTONE, 381
selecting colors, 382
support, 47
TOYO, 382
TRUMATCH, 382
colo r models, 379-380
CMYK (cyan, magenta,
yellow, black), 379
HLS (hue, lightness,
saturation), 379
process color, 380
RGB (red, green, blue), 379
spot color, 380
Color options dialog box, 469
Color palette command , 375
Command-K keyboard
equivalent, 75
color separations, 372
Aldus PrePrint, 532-545, 549
built-in, 40-41
color-control bars, 482
color-picker file, 383
Colors palette, 4 1, 375-378
[Black] option, 376-377
[Paper] option, 376
[Registration ] item, 377
apply ing colo rs to
elements, 377-378
color list, 375-377
Command key and, 378
copying from ot her
publications, 387
line-segment color, 304
opening, 375
removing color, 378
saving In color library, 37
s hape color, 306
toggling on/ off, 75
column guides, 120-122
adding, 120
clip-out coupon, 335
customized, 121
dragging, 122
facing pages, 121
h id ing, 130
newsletter sample project,
205-206
number and space
between, 69
options, 42 1
overriding, 213
permanently locking, 130
position, 61
repositioning, 122
security, 130

temporarily locking, 130
Column guides dialog box,
69,120,205,216,493
Number of columns
o ption , 121
Set left and right pages
separately option, 12 1
Space between option, 121
Colu mn guides ... command,
69,1 20, 205,2 13,216,493
columns, 120-122
evening on pages, 395
headlines spanning, 213
limitations per page, 205
Command key, 297
defining style sheets, 270
selecting overlapped
objects, 133
commands, 58-78, 424
About PageMaker, 59
Add tab, 249
Aldus Additions, 65,2 12
Alignment , 71,202,255
Autoflow, 69, 167, 169-170,
495,506
Book ... , 6 1,427-43 1,448
Bring to front, 73, 132, 341
Cannot undo, 62
Cascade, 46, 74
Change ... , 65, 183-184, 443
check mark (-./), 54
choosing, 52
Clear,63, 141,304,306
Close, 60, 105
Close story, 76, 179
Colors palette, 75, 375
Column guides ... , 69, 120,
205, 213, 216,493
Control palette, 75, 344,
348-349, 495, 515
Copy, 63, 138, 14 1,200,
220,304,306,407
Copy master guides, 69, 128
Create color library ... , 388
Create Index. .. , 66, 428,
437,448
Create TOC . .. , 66, 428,
431,433,436
Custom ... , 307
Cut, 63, 137, 140-141,
154-155,298,300,304
Define colors ... , 73, 307,
376, 378, 382-384,
385-387, 389
Define styles ... , 72, 269,
271,274-276, 283-284,
432,498,50 1

Display master Items, 69,
118, 120
Display paragraphs, 76
Display style names, 76
Edit layout, 178-180, 186
Edit object, 190-191
Edit Original, 46, 64, 190,
291
Edit story, 57, 64
Editions, 46
Edlllonsc:>Stop all
editions, 64
Edltionsc:>Subscribe, 63
Editlonsc:>Su bscrl ber
options, 63
Empty Tr ash, 23
executing, 54
Export..., 6 1, 193,279,284
Fill, 142,305
Fill and line ... , 73, 304,
307,378
Find next, 65, 183
Find ..., 65, 180-183
Fit In window, 109
followed by an ellipsis, 53
Fo nt,202,234,322
Get Info, 13
Go to page ... , 69, 113, 167,
201,294
Gu ides, 120, 127-128,495
Guides and
rulers c:>Guides, 68
Guides and rulers c:>Lock
guides, 68
Guides and rulersc:>Rulers,
68
Guides and r ulersc:>Scroll
bars, 69
Guides and rulersc:>Snap
to guides, 68
Guides and rulers<>Snap
to rulers, 68
Guides and rulersc:>Zero
lock, 68
Help ... , 74
hierar chical submenus, 53
highlighted, 52
Hyphenation ... , 71, 25 1
Image control... , 73, 290,
312-316,518,521
Indents/tabs ... , 71, 248,
503
Index entry ... , 65,437-438,
444
Insert object. .. , 46, 64,
191,295

Insert pages ... , 69, 114,
521
Justify, 330
keyboard equivalents, 54
Leading, 234
Library palette , 75
Line, 142, 199, 305, 323
Lines and File, 304
Link info ... , 73, 173, 302,
453,455--457
Link options ... , 74, 191,
29 1,453, 458--459
Links ... , 61, 173, 291, 301,
453--456
Lock guides, 130, 505, 524
Move tab, 250
Multiple paste ... , 63, 139
New Story ... , 57, 75, 179
New ... , 60, 83, 196,325
Open ... , 60, 79, 91-92
Other... , 234
Page setu p ... , 62, 118, 324
Paragra ph ... , 7 1, 210,
24 1-247,255,258, 432
parameters, 424
Paste, 63, 81, 137-138, 141,
154-155, 187-188, 200,
220,298,300,405, 407
Paste Link ... , 46, 64,
190-191, 295
Paste special..., 64, 188
Place ... , 6 1, 116, 155-157,
172, 179, 190,203,206,
216,22 1,277,288,
291-295,301- 302,328,
332,337,506,511
Preferences ... , 61, 95, 128,
166, 196,320,493
Print.. .• 62, 225, 428,
467-469
Publish and Subscribe, 46
Quit, 62, 105
Redo, 63, 142
Remove pages ... , 69, li S,
508,520
Remove transformation, 73
Repeat tab, 249
Replace, 186
Restart, 23
Restore o riginal color, 73,
378
Revert,61, 104, 142-144
Rounded corners ... ,
73,305,34 1
Rulers, 89, 123
Run Script Additions, 39

Index

Save,60, 92,98, 101,142,
224,327,504
Save as ..., 60, 92, 98,
102- 103,328
Scroll bars, Ill, 495
Select all , 57, 63, 134-135,
172,202,209,465
Send to back, 73, 132-133,
154,34 1,520
Set\~dth,2 34 ,343

Show clipboard, 74
Show index ... , 66, 437, 445
Show pasteboard, 109
Size, 202, 234
Snap to guides, 129, 136,
303, 495
Snap to rulers, 124, 136,
324,495
Spelling... , 65, 184
Style palette, 75, 270,
280, 495
Subscribe to, 189, 295
Subscriber options, 189
Te>.t rotation ... , 345
Tell.t wrap ... , 309, 512
Tile, 46, 74, 137
toggling options , 54
Tool palette, 75
Track, 234
Type specs ... , 71,235-24 1,
322,359
Type style, 202, 234
Undo, 62, 128, 140-142,
296
View¢400% s ize, 68
View¢50% size, 67
View¢ 75% size, 67
View<>Actual size, 67
View<>fit in window, 66
Wrap text, 406
Zero lock, 126
commercial printers,
working with, 374-375
compression utilities, 31-32
Autodoubler, 32
automatic compressors,
32
DiskDoubler, 32
driver-level compressors,
32
eDisk, 32
manual compressors, 32
Now Compress, 32
Stac, 32
Stuffit Deluxe, 32
Stuffit SpaceSaver, 32

continuous-tone images, 372
control palette, 41-42, 49,
77- 78, 347-367
activating, 350-351
Apply button, 351
applying changes, 35 1
arithmetically modify
existing values ,
354-355
Baseline shill option, 299
basics, 348-357
changing style sheet, 361
cha nging values, 354-356
character mode, 41
Cha racter Mode command
set,349,357-360
Character view, 77, 357
cro pping, 364
Deselect Mode command
set, 349
displaying, 515
displaying object size, 363
hiding, 349
horizontal movement
units, 98
in line graphic, 365-366
kerning, 46, 359
leading, 359
magic stretch scaling, 364
movable reference
points, 353
navigating, 353-354
nudge arrows, 355
object coordinates,
362- 363
object mode, 42
Object Mode command
set, 349, 362-367
object placement, 137
Object view, 78
options, 353
paragraph mode, 42
Paragraph Mode command set, 349, 360-362
Paragraph view, 78
po p-up option lis t, 355
positioning, 356-357
power nudge, 355
proportional scaling, 364
proxy,35 1-353
reference points, 35 1-353
resetting values, 355
resizing text blocks, 152
scallng,364
stationary reference
points, 353

to nearest ruler tick
mark or non-printing
guide, 98
toggling on/off, 75
type s tyle options, 358
typing re placement
values, 354
value accuracy, 356-357
vertical movement units, 98
viewing lont size, 359
what it allo ws you to
do, 347
when to use, 348
width ol selected text, 359
Control palette command,
75, 344, 348-349, 495,
515
Command-' keyboard
equivalent, 75, 344,
348-349, 366, 515
control panel, act ivating
control palette, 350
Convert color CommandOptio n.Shilt keyboard
equivalent, 385
Copy colo rs dialog box, 387
Copy command, 63, 138,
141,200,220, 304,
306,407
Command-C keyboard
equivalent, 63, 138,
200,220,304,334,
407,525
Copy master g uides
command, 69, 128
Copy styles dialog box, 276
Copyright Symbol (Optiong) keyboard equivalent, 18 1
copyright window. See
startup screen
Corel Draw!, trapping, 552
Create color library
Additio n, 37, 401
Create color library .. .
command, 388
Create cus tom content
dialog box, 416
Create index dialog box, 66
f ormat ... button, 449
Include book publications
o ption, 449
Remove unrelerenced
topics option, 449
Replace existing index
option, 449
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Title option, 449
Create index entry dialog
box,65
Create index ... command,
66,428,437,448
book lists, 427
Create keyline Addition, 37,
401-402
Create table ol contents
dialog box
Between entry and page
number option,
434-435
f ormat option, 434
Include book publications
option, 434
No page number option,
434
Page number alter entry
option, 434
Page number belore entry
option, 434
Title option, 434
Create TOC.. . command, 66,
428,431,433,436
book lists, 427
Cricket Draw, 289
crop marks, 377, 482
cropping tool, 77, 299, 333
Shift-F8 keyboard
equivalent, 77
Current Page Number
(Command-Option-p)
key board equivalent,
177
cursor, displaying current
location, 349
cus tom
color library, 388
graphic boundary, 311-312
line weights and fi ll
patterns, 42
page sizes, 84
view sizes, 43
Custom ... command, 307
customized column guides,
121
Cut command, 63, 137, 140,
141, 154, 155, 298, 300,
304,306
Command-X keyboard
equiva lent, 63, 137,
140, 154, 298,300,304
Command-keypad period
keyboard equivalent, 63
cutlines, 268
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•D•
DCA (document common
architecture) format,
158
DCS file, 538
default settings, 95
default style s heets, 275
Deline color dialog box,
378-381 ,384
CMYK (cyan, magenta ,
yellow, black) color
model, 380-381
color models, 379--380
color name, 379
color type, 379
Ubraries pop-up
menu, 381
Overprint option, 380
Deline colors ... command,
73, 307, 376, 378,
382-384, 386-387, 389
Define printer style s heet
dialog box, 412
Define printer styles dialog
box, 411
Define styles dialog box, 72,
269-272, 274, 276, 283,
498,501
Edit button, 432
Include in table of
contents option, 432
Para ... button, 432
Define styles ... command,
72, 269, 27 1, 274-276,
283-284,432,498,501
Command-3 keyboard
equivalent, 72, 432,
498,501
Delete key, 63, 141, 304
Delete Space Between Pairs
Command-- keyboard
equivalent, 260
Command-Delete keyboard
equivalent, 260
Shift-Command-"
keyboard equivalent,
260
densitY-control bars, 482
Deselect Mode command
set, 349
design grids for master
pages, 116
desktop
opening existing
publications, 90-91

rebuilding, 91
diagonal lines, 77
diagonal-line tool, 77, 302-309
Shift key and, 302
Shift-F2 keyboard
equivalent, 77
dialog boxes, 53, 55--57
alert, 56
check boxes, 55
entering measurements, 96
option boxes, 56
option, command, or
menu is dimmed, 57
options, 55
pop-up menus, 56
radio buttons, 55
tips for working in, 197
units of measurement, 96
utilities, 30-3 1
dialog-box utilities
Directory Assistant, 31
Super Boomerang, 31
dictionaries
adding words, 185
editor, 43
hyphenation, 250
Digital Darkroom, 290
Directory Assistant, 31
discretionary hyphens, 250,
252
Command- (hyphen)
keyboard equivalent,
177, 181
Dis k Express II, 16
Dis k full error message, 101
DiskDou bier, 32
Dis play master items
command, 69, 118, 120
Display Paragraphs
command, 76
Display pub info Addition,
37,402
Dis play story info Addition,
37,403
Display style names
command, 76
Display textblock info
Addition, 37, 403
Distort Type Addition, 421
documents, 57. See also
publications
adding pages, 69
Clipboard and, 63
d efault values, 61, 62
double-clicking to launch
PageMaker, 79

going directly to page, 69
large, 86
linking with other
documents, 291
long, 427-462
naming, 224
new, 325--328
page number limitation, 114
page-number style, 85
printing, 62, 225--227
removing pages, 69
reverting to last save,
142-144
saving and naming, 60
specifying page size, 84
dots per inch (dpi) and
monitors, 17
double-clicking, 52
double-headed arrow
icon, 296
double-sided publications
configuring, 86-87
page numbering, 118
ruler zero point, 125
Downloading fontname
message, 471
dragging, 52
drag-and-drop feature, 91
draw-type graphics, 289
res izing, 298
driver-level compressors, 32
Drop cap Addition, 37, 212,
403-406,404
dialog box, 21 2
drop caps, 37, 211-212,
403-406
creating your own, 405--406
importing pre-made drop
cap,405
producing own drop cap
art, 405
drop s hadow, 219
drum-based lmagesetters, 547

•E•
Easter egg, 59
eDisk, 32
Edit colors dialog box, 246,
378,387
locating libraries, 383
Process option, 488
tints, 383
Edit layout command,
178-180, 186

Edit menu, 57, 62--&1, 81, 128,
133-134, 137-138, 141,
172, 177-180, 183-184,
186-187, 191, 200, 209,
220, 291, 295-296, 298,
300,304,465
Edit Object command,
190-I91
Edit o riginal command, 46,
64, 190,291
Option key and
double-cl.icking, 64
Edit story command, 57,
64, 177
(Command-E) keyboard
equivalent, 64, 177,
180, 186
Edit style dialog box, 269,
271,282-283, 499, 50 1,
507, 524-525
Based on option, 270-27 1,
274,283
Define next style option, 272
listing style sheet
attributes, 270
Name option box, 270-271,
274,283
No style option, 283
Edit tracks Addition, 37,
396,406-407
edition files, 188-190
importing, 63, 189
importing graphics, 295
stopping automatic
u pdates, 64
updating, 63
Edition Manager, 64, 295
Editions command, 46
Editions<>Stop all editions
command, 64
Editions<>Subscribe
command, 63
Editions<>Subscriber
options command, 63
Element menu, 72-74, 132,
154,191,199,205,220,
302-307, 309, 312, 323,
341, 378,382-384, 386387,389,406,453,456,
458, 512,518, 520-521
elements. See also graphics
and text
applying colors , 377-378
bringing to front, 73
combining, 38
constraining, 199

Index

copying and pasting,
137-140
cutting and pasting, 137
deleting, 63, 140-141
deselecting, 135
dragging, 1 ~6- 1 37
flippin g horizontally or
vertically, 365
graphic creation, 302
guide positions, 132
hierarc hical order, 132
layers, 131-132, 34 1
links, 456-459
manipulating, 131- 141
moving, 136-1 37
moving to back, 73
pos itioning, 129
repeating, 116, 198
selecting, 132-134
stacking order, 131- 132
transferring between
programs, 188-191
ungrouping, 38
ellipses
applying color, 377
Option-; (semicolon)
keyboard equivalent,
177, 18 1
Em Dash (Shift-Option-(hyphen)) keyboard
equivalent, 177, 181
Em Space (Command-Shiftm) keyboard equivalent, 177, 181, 337
Empty Trash command, 23
En Dash (Option- (hyphen)) keyboard
equivalent, 177, 181
En Space (Command-Shiftn) keyboard equivalent, 177, 181,337
End of Line
Keypad I keyboard
equivalent, 232
Shift-keypad 1 keyboard
equivalent, 233
End of Paragraph
Command-keypad 2
keyboard equivalent, 232
Shift-Command-keypad 2
keyboard equivalent, 233
Shift-Command-0
keyboard equivalent, 233
End of Sentence
Command-keypad I
keyboard equivalent, 232

Shift-Command-keypad I
keyboard equivalent, 233
End of Story
Command-down arrow
keyboard equivalent, 232
Command-keypad 6
keyboard equivalent, 232
End keyboard equivalent,
232
Shift-Command-keypad 6
keyboard equivalent, 233
EPS (Encapsulated
PostScript) graphics
Aldus FreeHand, 386
combined elements, 38
file form at, 288
graphics, 289
importing spot colors, 45
printing original colors, 488
process colors, 384
resizing, 298
s pot colo rs, 384
expert kerning, 257, 26 1
Expert kerning Addition, 38,
46,261,396,407-408
Export d ocument dialog
box, 61, 193
Entire s tory o ption, 193
Export option, 193
Selected text only option,
193
Export .. . command, 61, 193,
279,284
exporting
files, 61
s tyle s heet tags, 193
sty le s heets, 284
text, 192-1 93
extensions
Shared Code Manager, 28
turning o ff, 23
external scripts , 423

•F•
facing pages and column
guides, 121
file compressio n utilities,
31-32
fil e management and links,
453-461
File menu, 59-62, 79, 83, 91,
95, 104-105, 118, 128,
144, 155-156, 166, I 79,
186, 193, 196, 202-203,
206,216, 224-225, 292,
320, 324-325, 332, 428,
453,493, 504,506

File Open dialog box, 30
files, 14, 57
alafter.ps, 476
albefore.ps, 476
Aldcolor.add, 383
Aldus Installer
Diagnostics, 25, 28
Aldus Installer History, 28
alerror.ps, 476
Catalog Copy, 506
color-picker, 383
converting to version 5.0, 21
formats, 61, 64
how they are saved , 98
library, 383
logical connection
between, 427-431
naming, 224
opening, 60
Page 2 graphic, 511
PM5 Defaults, 95
printing informatio n job
s lug, 410
Product Description , 328
Read Me, 28
reversing effect of last
action, 62
saving to disk, 224- 225
tips fo r saving, 225-227
Top/Chair.EPS, 332
Tracking Values, 407
working o n copy not
original, 9 1
Fill and line dialog box, 42,
73,307
keyline attributes, 401
Reverse line option, 307
Trans parent background
option, 307
Fill and line ... command, 73,
304,307,378
Command-] keyboard
equivalent, 73, 307
Fill command, 142, 305
fill patterns, 304
color, 307
custom, 42
overprinting, 308
Fill submenu, 72, 304, 306, 307
filters
im port and export, 25
listing, 59
reinstalling, 29
selecting, 26
Find dialog box, 65
All stories option, 182
Attributes ... button, 182
Curren t story o ption, 182
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Find what option, 180-181
Match case option, 182
Search Document option,
182
Search Story option, 182
Selected text option, 182
Whole wo rd option, 182
wildcard characters , 180
Find Next command, 65, 183
(Command-,) keyboard
equivalent, 65, 183
Find overset text Addition,
38,408-409
Fmd ... command, 65, 180-183
Command-S keyboard
equivalent, 65
first-line indent, 71
Fit in window command
Command and Option
keys, 109
Command-Option-.
keyboard equivalent, Ill
Command-Option-Click
mouse shortcut, Ill
Command-W keyboard
equivalent, 66, 109,
Ill , 338
page display, 113
Shift key and, 109
Fit in window view size, 109
fixed spaces, 336
flag. See masthead
fl owing text, 167-1 73
automatic text flow, 168
drag-placing to create new
text block, 171
manual text flow, 168
manually placing
imported text, 168-169
semi-automatic text flow, 168
fo ld ers , manipulating, 157
Font command, 202, 234, 322
fo nt managers, 29- 30
Adobe Type Reunion, 30
Master-Juggler, 29
MasterJuggler, 30
MenuFonts, 30
Suitcase II, 29, 30
WYSIWYG menus, 30
Font matching dialog box,
166
Default font option, 166
PANOSE font substitution
option, 166
Font submenu, 70
Font/ DA Mover, 29
Fontname is not found
message, 471
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fonts
adding in System 7, 29
attributes, 71
available type sizes, 70
baseline shift, 40
changing, 202, 357
controlling size, 235-236
default, 202
downloading to printer on
page-by-page basis, 474
expanding or condensing,
421
lmageWrlter, 464
importing text and, 155
kerning pair information,
258-259
laser, 464
listing, 70, 234-235, 322
listing for publication, 402
mapping, 164-167
matching, 44
missing, 44
moving tracking between,
407
naming for text, 357
non-PostScript, 464
outline, 464
PostScript, 464
printing, 464
sizes, 234
styles, 202
substitute, 357
TrueType, 464
unavailable, 357
viewing size, 359
Fonts folder, 29
footers, 39
Force Justify (ShiftCommand-f) keyboard
equivalent, 255
formatting text, 229-265
character-formatting
details, 233-241
characters,230-233
paragraphs, 230-233,
241-247
typography, 255-265
forms, 420
four-page catalog, 493-530
adding ad spaces and
graphics, 508-511
autoflowing long text file,
506-507
bannertext,497-502
black and white graphics,
518-520

changing default settings,
493-495
deleting pages, 508
editing body copy style
sheet, 507
folios, 502-505
graphic spedal effects, 517
gray level graphics, 521--523
last-minute clean-up, 528
master pages, 496--497
new document, 496--505
new style sheet with tabs,
524-526
overriding style sheet,
526--528
placing and formatting
body copy, 505
preparing price list, 523
printing, 530
publication, 493-495
removing and inserting
pages,520
repositioning text around
graphics, 509-511
saving and naming, 504
style sheets, 497-502
wrapping text around a
complex graphic,
514-517
wrapping text around
rectangular object, 511
fractions, kerning, 241
Framz Proportional Borders
Addition, 422
Frontier, 423

•G•
Get Info command, 13
Get Info dialog box
adding more RAM, 92
Memory Requirements
option, 13
Preferred option, 14
Go to page dialog box, 69, 113
Go to page ... command, 69,
113, 167, 201, 294
Command-G keyboard
equivalent, 69,201,294
Shift key and, 114
grabber hand, Il l
Shift key and, 112
gradients, 551
graphic boundary, 302,
309-311
customizing, 311-312

handles, 311
viewing, 513
graphic file formats
Encapsulated PostScript
(EPS), 288
Mac Paint (MPNT), 288
PICT, 288
Tagged-Image File Format
(riFF), 288
graphic flies
broken links, 535
copying Into memory for
placement, 61
stored inside PageMaker,
458
graphic placement icons,
294-295
graphics, 287-317
adding, 331-334
Aldus hot link, 291
applying color to
imported, 377
best or fastest display, 97
bltmapped Images, 288
black and white, 518-520
cataloging, 563-568
circles, 302, 305-306
converting to acceptable
format, 290
copying all linked files, 102
cropping, 77, 299, 333, 364
custom fill value or line
weight, 73
draw-type, 289
editing in PageMaker, 291
element creation, 302
embedding, 100, 291
Encapsulated PostScript
(EPS), 289
fUI patterns, 72, 304,307-308
forcing best resolution, 98
graphic boundary, 302,
309-311
handles, 296, 299
Icons, 332
Importing, 288-295
Independent, 291- 295
inline, 291-295
line segments, 302, 302-309
line weights. 72, 307-308
linking, 61, 100, 291, 302,
534-535
listing imported, 453-456
magic stretch feature, 464
manipulating, 73, 295-302
master pages , 69

memory used to create
and store, 99
modifying, 312-316
ovals, 302, 305-306
paint-type, 288
pixels, 517
preparing for Importation,
288-291
printing scaled, 464
proportionally resizing, 296
rectangles, 302, 305-306
replacing or updating,
301- 302
repositioning, 298-299
resizing, 296-298, 464
returning to original size, 296
rotating, 77
scaling,364
selecting, 76
shapes, 304-306
special effects, 517
squares,302, 305-306
switching between lnline
and Independent,
300-301
text wrapping, 73, 308-31 1
TIFF format, 290
updating, 291
gray value mapping, 315-316
Negative mapping, 316
Normal mapping, 316
Posterlze mapping, 316
Solarize mapping, 316
greeklng, 61, 100
Gridzold Addition, 420
guides, 120-129
accidentally selecting, 98
displaying, 68
drawing lines between, 303
hiding, 128, 130
locking, 68, 130
master pages, 119-120,
127,497
positioning elements, 129
relationship to text and
graphics, 128
ruler, 126-127
security, 130
snapping elements t o, 68
stacking order, 98
Guides and rulers submenu,
68, Ill , 120, 123-124,
126,128-129,324,505
Guides and rulers¢Guides
command, 68

Index

Command-J keyboard
equivalent, 68
Guides and rulers¢Lock
guides command, 68
Guides and rulers¢Rulers
command, 68
Command-R keyboard
equivalent, 68
Guides and rulers¢ Scroll
bars command, 69
Guides and rulers¢Snap to
guides command, 68
Command-U keyboard
equivalent, 68
Guides and rulers¢Snap to
rulers command, 68
Command-[ keyboard
equivalent, 68
Guides and rulers¢Zero
lock command, 68
Guides command, 120,
127-128, 495

Guides submenu
Snap to guides option, 356
Snap to rulers option, 356
gurus
how they get that way, 3

•H•
halftones, 313
printing, 489-490
screen, 372
hand icon, 198
handlebars, 1, 151,203
tab, 152
handles, 133
graphic boundary, 311
graphics, 296, 299
hard drives
access time and throughput, 15
defragmenting, 16,23
removable storage, 16
size, 14
speed, 14
system recommendations,
14-16

system requirements, 1416

verifying free space, 23
hard hyphens, 252
HDR file, 417
headers, 39
HEADERS.INI file, 417
headings, shading, 246

Headline default style sheet,
275

headlines, 218
centering, 214
leading, 214
news letter sample project,
212- 218

side bar, 222
spanning columns, 213
with default type specs,
330-331

help system, 74
Help ... command, 74
Command-? keyboard
equivalent, 74
hierarchical submenus, 53
HLS (hue, lightness,
saturation) color
model, 379
hot links, 64
HyperCard, 423
hyphenation, 250-255
adding words to
dictionary, 254-255
algorithm-based, 250, 253
automatic, 252-253
dictionary, 250
discretionary hyphens,
250,252

hard hyphens, 252
limiting consecutive
hyphens option, 253
manual, 250-252
rule-based, 253
setting attributes, 71
zones, 253
Hyphenation dialog box, 71,
251,270

Add ... button, 254-255
Hyphenation zone option,
253

Limit consecutive
hyphens option, 253
Manual only option,
251-252

Manual plus algorithm
option, 253
Manual plus dictionary
option, 252-253
Hyphenation ... command,
71, 251

Command-H keyboard
equivalent, 71
Option and Shift diagnostics key, 251
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•I•

gray value mapping, 315-316
independent graphic,

1-beam, 202
icons
double-headed arrow, 296
dragging and dropping, 80
L (Left master page), 116
R (Right master page), 116
Image control dialog box,

in line graphic, 291-295
inverse mapping, 315
linear mapping, 315
manipulating, 295-302
modUying, 312-316
replacing or updating,

73,312,518,52 1

Angle option, 315
Black and white option, 314
Contrast option, 315, 518
current mapping
specifications, 315
Gray option, 314, 518
Lightness option, 315, 518
Lines/In option, 315
Screened option, 314,518
Image control. .. command,
73,290,312-316, 518, 521

images
cataloging, 563-568
taking directly from
scanners, 36
lmagesetters, 464
Capstan, 546
drum-based, 547
Inaccuracy, 546
Unotronic 100, 477
repeatability, 546
ImageWriter fonts, 4.64
Import button, 440
import filters, 45, 158-164
acquiring new, 158
Microsoft Excel options,
161-164

Microsoft Word 4.0/5.0,
161-162

Smart ASCII, 159-160
supported text formattin g,
162-164

imported color, 387-388
imported EPS graphics, editing
spot color, 385-386
importing files
Object Linking and
Embedding (OLE), 295
publishing and subscribing, 295
importing graphics, 288-295
applying color, 377
cropping, 299
edition files, 295
graphics size, 294-295

291- 295

30 1-302

repositioning, 298-299
resizing, 296-298, 301
removing color, 378
switching between inline
and independent,
300-301

importing text, 155-167
DCA (document common
architecture) format, 158
font mapping, 164-167
fonts and, 155
import filters, 158-164
into or over an existing
story, 172-173, 179
manually placing, 168-169
RTF (rich text format), 158
style tags, 157
text Import filter, 155
text-only (ASCII) file, 158
use paragraph and character
formatting, 157
impositions, 397--399, 558-562
Aldus PressWise, 558-562
signatures, 558
templates, 562
inch decimal, 320
inches, 320
indent, displaying values, 361
Indents/tabs dialog box, 44,
71, 248-255, 270

adding new tabs, 249
checking tab position and
leader, 249
indent markers, 248
remove all the existing
tabs, 249
series equally spaced
tabs, 249
tab markers, 248
Indents/tabs ... command,
71,248,503

Command-! keyboard
equivalent, 71, 248, 503
independent graphic, 291-295
graphic placement icons,
294
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making into in line graphic,
298
positio ning, 298
switching to inline
graphics, 300-301
Index entry.. . command, 65,
437438,444
Command-; keyboard
equivalent, 65, 438, 444
Index format dialog box
Before x-ref option, 45 1
Between entries option, 45 1
Between page #s option, 451
Entry end option, 451
Following topic option, 451
Format option, 450
Include empty index
sections option, 450
Include index sectio n
headings option, 450
Page range option, 451
Index marker, 442
l ndexes ,61 , 6~6 . 4 3 7-453

by searching and
replacing, 443-444
capitalization, 447
character after fi na l entry,
451
character between page
numbers, 451
character between
reference and page
n umber, 451
compiling, 448-452
cross-references, 441-442,
451
definin g to pics in
advance, 444-445
editing and formatting,
452-453
editing topic references,
445-448
fi rst, second, and third
level relerences, 43S-439
importing terms from
o ther publications, 440
Includ ing files in current
book list, 449
Index marker, 442
listing all entries, 445
marking topics, 438-443
names and titles, 443
nested fo rmat, 450
page ranges, 441
placing in d ocument, 452
re formatting, 452

re placing o ld with new,
449
r un-in format, 450-451
section headings, 450
separators for references
and ent ries, 450
s pecia l text added before
page-number
refe rence, 85
s pecific page listing, 44 1
style s heets , 452-453
tips and s hortcuts, 443-445
t it les, 449
to pic refe rences, 438440
to pics with different style
fo r emphasis, 442
viewing entries, 66, 439
word o r p hrase without
changing any options,
443
Informatio n ro utines, 393
inline graphics, 268, 291-295
aligning to grid, 299
contro l palette, 365-366
locatio n of baseline,
365-366
manipulating text formattlng attributes, 299
repositio ning, 298
style s heets, 299
s witching to independent
graphics, 300-301
insert o bject.. . command,
46, 64, 191, 295
Insert pages dialog box, 69,
141 , 521
Cancel b utton, 114
Insert pages ... command,
69, 114, 521
Installer, 23
Installing PageMaker, 23-28
Aldus Installer/Utility, 24-25
defragmentlng hard drive
before, 23
inserting dis ks, 2S-29
personalizing your copy, 27
restarting Macintosh with
extensions off, 23
selecting location o n hard
drive, 26
selecting templates, PPDs,
Additions, and filters, 26
Shared Code Manager
extension, 28
verifying free space on
hard drive, 23

internal scripts, 423
interruptible screen red raw,
45
Italic Style (Shift-Command-1)
keyboard equivalent, 240

• J.
Justify command, 330
Shift-Command-J
keyboard eq uivalent,
255,330

•K•
Kern Edit, 25S-259
kerning, 46, 256-257, 407-408
auto matic pair kerning,
257-259
co ntro lling, 38
expert kerning, 257, 261
fractlons , 24 1
into margins, 260
manual pair kerning, 257,
259-260
modifying automatic
pairs, 421
range kerning, 257, 259-260
viewing applied, 359
kerning pairs , 258
KerningPalrs Additio n, 421
Key Caps , 176
keyboard equivalents, 54
Command - ] (Fill and
line), 307
Command- (hyphen)
(Discretionary
Hyphen), 177, 181
Command+· (Actlvate/
Deactivate Control
Panel, 350, 366
Command-' (Contro l
palette), 75, 344, 348349,366,515
Command-, (Find Next),
65, 183
Command-; (Index entry),
65,438,444
Command-= (Links), 61,
453-456
Command-? (Help) , 74
Command-[ (Snap to
r ulers), 68, 125, 324
Command-) (Fill and line),
73
Command-" (Delete Space
Between Pairs), 260

Command-O (25% s ize) , 67,
109, 111
Command-! (Actual s ize),
67, 109, 111
Command-2 (200% s ize),
67, 110-111
Command-3 (Define
styles), 72, 432, 498, 501
Command4 (400% size),
68,110-111
Command-S (50% size) , 67,
109, 111
C om m an d~ (Tool
palette), 75
Command-7 (75% s ize), 67,
109, 111
Command-S (Find), 65
Command-9 (Change),
65, 183
Command-A (Select all),
57, 63, 134, 172, 202,
209,214, 330,340, 342,
507,525
Command-arrow key
(Nudge Object), 366
Command-B (Send to back),
73, 132, 154,342, 520
Command-C (Copy), 63,
138, 200,220,304, 334,
407,525
Command-O (Place), 61,
206,221,301,328,332,
506,514, 521
Command.O (Replace), 186
Command-Delete (Delete
Space Between Pairs),
260
Command-down arrow
(Scroll Display Down
One Line), 232
Command-down arrow
(End of Story), 232
Command-E (Edit story),
64, 177, 180, 186
Command-F (Bring to
front), 73, 132
Command-G (Go to page),
69,201,294
Command-H (Hyphenation) , 71
Command-! (Ind ents/
tabs), 71. 248, 503
Command-<> (Space
Between Pairs), 259
Command-J (Guides), 68
Command-K (Color
palette), 75

Index

Command-keypad 0
(Paste),63
Command-keypad 1 (End
of Sentence), 232
Command-keypad 2 (End
Paragraph), 232
Command-keypad 4 (One
Word Left), 232
Command-keypad 6 (End
of Story), 232
Command-keypad 6 (One
Word Right), 232
Command-keypad 7
(Beginning of Sentence), 232
Command-keypad 8
(Begin Paragraph), 232
Command-keypad 9
(Beginning of Story),
232
Command-keypad period
(Cut), 63
Command-L (Spelling), 65,
184
Command-left arrow (One
Word Left), 232
Command-left arrow
(Previous Drive), 157
Command-M (Paragraph),
71,210,255,258,336,
432,527
Command-N (New), 60, 83,
196,325,496
Command-O (Open), 60,
91, 196
Command-Option
(Rebuild Desktop), 91
Command-Option(hyphen) (Non-breaking
Hyphen), 177, 181
Command-Option-. (Actual
size), 111
Command-Option-. (Fit in
window), 111
Command-Option-/ (slash)
(Non-breaking slash),
177, 181
Command-Option-K
(Remove Kerning), 260
Command-Optlon-M
(Change Measurement
System), 366
Command-Optlon-p
(Current Page
Number), 177
Command-Option-P (Page
Number Marker), 85,

117, 181,503
Command-Option-p
(Paragraph End
(Return)), 181
Command-Option-Shift
(Convert Color), 385
Command-Optionspacebar (Normal),
343
Command-Optionspacebar (Unzoom),
43,110
Command-Option-V
(Multiple Paste), 140,338
Command-P (Print), 62,
225,345,468,530
Command-Q (Quit), 62, 105
Command-R (Ruler), 68,
123,197,325
Command-right arrow
(Next Drive), 157
Command-right arrow
(One Word Right), 232
Command-S (Save), 101,
224,327,330,334,504
Command-Shift-' (Character/Paragraph Mode),
357,360,366
Command-Shift-; (Quick
Index), 443
Command-Shlft-m
(Em Space), 177, 181
Command-Shift-n
(En Space), 177, 181
Command-Shift-!
(Thin Space), 177, 181
Command-Shift-Tab
(Previous Page), 167
Command-Shift-Z (Last
Name First), 443
Command-spacebar
(zoom tool), 110
Command-T (Type specs),
71 ,235-24 1,322,330,
336-337, 503
Command-Tab (Next
Page), 167
Command-U (Snap to
guides), 129
Command-up arrow
(Close Folder), 157
Command-up arrow
(Scroll Display Up One
Line), 232
Command-V (Paste), 81,
137-138, 154, 187, 200,
220,298,300,407,525

Command-W (Fit in
window), 66, 76, 109,
111 ,338
Command-X (Cut), 63, 137,
140,154,298,300,304
Command-Y (Style
palette), 75
Command-Z (Undo), 62,
136, 141-142, 296
Down arrow (One Line
Down), 232
End (End of Story), 232
Home (Beginning of
Story), 232
keypad 1 (End of Une), 232
keypad 2 (One Une Up), 232
keypad 4 (One Character
Left), 232
keypad 6 (One Character
Right), 232
keypad 7 (Beginning o f
Line), 232
keypad 8 (One Line
Down), 232
Left arrow (One character
Left), 232
Option- (hyphen)
(En Dash), 177, 181
Option-; (semicolon)
(EIIpses), 177, 181
Option-( (Open Quotatlon), 177, 181,330
Option-] (Single Quotation
Open), 177, 181. 330
Option-2 (Trademark
Symbol), 181
Optlon-4 (cent sign (c)), 338
Option-S (Bullet), 181
Optlon·dick (Close Nested
Dialog boxes), 247
Option-g (Copyright
symbol), 181
Optlon-r (Registered
Trademark), 181
Option-Shift-( (Close
Quotation), 177, 181
Option-Shift-] (Single
Quotation Close),
177, 181
Option-spacebar (Nonbreaking Space), 177,
181 ,260,443
Right arrow (One
Character Right), 232
Shift-Command-C
(Center), 255
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Shift-Command-F (Force
Justify),255
Shift-Command-J (Justify),
255
Shift-Command-Option-.
(One Size Larger
Type), 234, 236
Shift-·· (One Character
Left), 233
Shift4 (One Line Up), 233
Shlft-6 (Caret), 181
Shlft-IE (One Character
Right), 233
Shift-Clear on keypad
(Clear), 63
Shift-Command-, (Smaller
Standard Type Size),
234,236
Shift-Command-. (Larger
Standard Type Size),
234,236
Shift-Command-/
(Strikethru Style), 240
Shift-Command-- (Delete
Space Between Pairs),
260
Shift-Command-¢
(Beginning of Paragraph), 233
Shift-Command-A (Auto),
214
Shift-Command-/£ (Add
Space Between Pairs),
260
Shift-Command-B (Bold),
202, 240,526
Shift-Command-C (Center),
202,214,323,340
Shift-Command-O (Outline
Style), 240
Shift-Command-Delete
(Space Between Pairs),
259
Shift-Command-l (Italic), 240
Shlft-Command-J (Justify),
330
Shift-Command-K (Upper
Case), 340
Shift-Command-keypad 1
(End o f Sentence), 233
Shift-Command-keypad 2
(End of Paragraph), 233
Shift-Command-keypad 4
(One Word Left), 233
Shift-Command-keypad 6
(End of Story), 233
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Shift-Command-keypad 6
(One Word Right), 233
Shift-Command-keypad 7
(Beginning of Sentence). 233
Shift-Command-keypad 8
(Beginning of Paragraph), 233
Shift-Command-keypad 9
(Beginning of Story), 233
Shift-Command-L (Left
Aligned) , 255, 338. 342
Shlft-Command-M
(Em Space), 337
Shlft-Command-N
(En Space), 337
Shift-Command-0 (End of
Paragraph), 233
Shift-Command-Option-,
(One Size Smaller
Type), 234, 236
Shift-Command.Qptlon-.
(200% size), 111
Shift-Command-R (Right
Alignment), 255
Shift-Command-T (fhin
Space), 337
Shift-Command-U
(Underline Style), 240
Shlft-Command-W
(Shadow Style), 240
Shift-Command-z (Normal
Style), 240
Shlft-FI (Arrow tool), 76
Shlft-F2 (Diagonal line
tool), 77
Shift-F3 (Perpendicular
line tool), 77
Shift-F4 (fext tool), 77
Shift-FS (Rotation tool), 77
Shift-F6 (Square corner
tool), 77
Shlft.f7 (Oval/circle tool), 77
Shift..f8 (Cropping tool), 77
Shift-home (Beginning of
Story), 233
Shift-keypad I (End of
Line), 233
Shift-keypad 2 (One Une
Down), 233
Shift-keypad 4 (One
Character Left), 233
Shift-keypad 6 (One
Character Right), 233

Shift-keypad 7 (Beginning
of Line), 233
Shift-keypad 8 (One Line
Up), 233
Shift-0 (One Une Down), 233
Shift-Option- (hyphen)
(Em Das h), 177, 181
Shift-Option-) (Right Single
Quote), 330
Shift-Option-[ (Right
Double Quote), 330
Shift-Return (Line Break),
177, 181
Shift-Tab (Backward), 56
Shift-Tab (Previous
Option), 366
Snap to guides
(Command-U), 68
Undo (Command-Z), 140
Up arrow (One Line Up),
232
keylines,37
keys
Backspace, 63, 141
Clear, 355
Command, 297
Delete, 63, 141, 304
Shift, 23, 296
Tab,56, 366
kilobytes (K), 12
knockout,374 ,549
color, 380

•L•
L (Left master page) Icon. 116
landscape orientation, 84
Larger Standard Type Size
(Shift-Command-.)
keyboard equivalent,
234, 236
laser fonts , 464
laser printers
print area, 477
unprintable margin area, 464
LaserWriter 8.0 printer
driver, 20, 467, 476
Background printing
option, 467
PICT graphics, 476
LaserWrlter Print dialog
box, 472
Last Name Firs t (CommandShift-Z) keyboard
equivalent, 443

launching PageMaker, 79-82
Layout menu, 46, fXHJ9, 108,
110-111 , 113-114, 118,
120, 123-124, 126-130,
167,170,205,324,493,
505-506
layout window, d eactivating
control panel, 350
leading, 209, 237
baseline, 237
headlines, 21 -1
listing options, 23-1
lis ting sizes, 70
proportional, 237
top of caps, 237
viewing, 359
Leading command, 234
Leading s ubmenu, 70
Left Aligned (ShiftCommand-L) keyboard
equivalent, 255, 338, 342
Left Double Quote
(Option-[) keyboard
equivalent, 330
Left Single Quote (Option-])
keyboard equivalent, 330
letter s pacing, 257
libraries, color, 381-383
Ubrary dialog box for color
matching systems, 382
library file, 383
Library palette Addition,
38,396
placing objects in, 38
toggling on/off, 75
Library palette command, 75
Line and fill dialog box
fill patterns, 307
Overprint options, 308
Line Break (Shift-Return)
keyboard equivalent,
177, 181
Line command, 142, 199,
305,323
Line menu
Hairline option, 199
Line submenu, 303-304, 378
line segments, 302-309
color, 304
constraining, 199
cut, copied, or deleted, 304
d efault line width, 303
diagonal, 77
length, 304
manipulating, 304

perpendicular, 77, 302
overprinting, 308
repositioning, 304
reversing, 307
weight, 42, 199, 304
weights and s tyles, 72
Une submenu, 72, 305, 307
Custom ... option, 305
Unes and File command,
304
Lines and fill dialog box
Transparent option, 308
Unk info dialog box, 73, 302,
456
Link info ... command, 73,
173, 453,456-457
Unk options dialog box, 74,
455-456
Alert before updating
option, 456, 459
Store copy in publication
option, 102, 455, 458
Update automatically
option, 456, 459
Link options ... command,
74,191, 291,453,458-459
links
altering options for
elements, 458-459
automatically updating, 459
Cannot find dialog box, -160
controlling edition file
updates, 63
file management and,
453-46 1
information about one
element, 456-457
listing for graphics fil es,
534-535
manually updating, 457
new file to link to e lement,
455
OPI files, 535
re-establishing, 535
replacing element with more
current version, 456
saving publications and,
460-461
Links dialog b ox, 61,453
Info .. . button, 455
LM symbol, 455
NA link symbol, 454
No Symbol link symbol. 454
Open diamond link
symbol, 454

Index

Open triangle link symbol,
455
Options . . . button, 455-456
OV symbo l, 455
Page#? symbol, 455
PB symbol, 455
Question Mark link
symbol, 454
RM symbol, 455
Solid black diamond link
symbol, 454
Update all button, 456
Update button, 456
X symbol, 455
Links ... command, 61, 173,
291, 301, 453-456
Command-= keyboard
equivalent, 61, 453-456
link symbols, 454-456
Linotronic 100, 477
Llnotro nic imagesetter, 20
Lis t s tyles used Addition,
37,409
loadable Additions, 392
Lock guides command, 130,
505,524
long documents, 427-462
indexes, 437-453
links and file management,
453-461
page number prefixes,
430-43 1
page numbering, 429-430
table of conte nts, 431-437
whe n to build book lis ts ,
428-429
Looking for Printe r
<printemame>
message, 4 70

•M•
MacDraw II, 289
Macintos h
clock sp eed , 11
processor, 11
restarting with extensions
off, 23
syste m recommendations,
11
syste m require ments, II
Maclink Plus , 158, 290
MacPaint, 288
MPNT file format, 288

MacTools, defragmenting
features, 16
Magic Menu, 32
magnifying glass tool, 43
major subheads, 268
manual
hyphenation,250
pair kerning, 257, 259-260
style sheet tags, 279
manual text flow, 167-169
margins, 71,87-88
displaying and printing
beyond boundaries, 88
kerning into, 260
Marksmake r Addition, 421
marquee, 2 13
o bjects , 134
Shift key a nd, 134
text block, 134
masking OPf files , 535
maste r pages, 116-120
copying elements
b etwee n, 200
des ign grids, 11 6
disp laying te>.i and
graphics, 69
d ouble-sided, 86
elements o n publication
pages, 118-119
folio, 502-505
four-page catalog, 496-497
guides,69, 119-120, 127,497
horizontal ruler guide, 200
left mas te r page, 198-199
newslette r sample project,
198-201
page number p laceholder,
117
page numbering, 117-118
placing text, graphics, o r
guidelines, 116
pre paring, 198-20 I
printing, 120
re moving ele ments from
publication pages, 118
repeating elements, 116, 198
right master page, 200-20 I
rule r guides, 127, 325-326
running heads o r footers,
116
s tacking ord er of
ele me nts, 132
u ses, 116
MasterJuggler, 29-30, 202,235

masthead
adding rule, 204
adding to page I , 201-205
centering, 202
isola ting from newsletter,
204-205
moving text vertically, 204
text creation, 201-204
meas urement system,
setting, 196
megabtyes (MB), 12
memory
allocation, 13
bits, 12
bytes, 12
kilo bytes (K), 12
megabtyes (MB), 12
prefe rred amount, 14
used to c reate and s tore
graphics, 99
menu bar, 82,88
s tory edito r , 178
Me nuFonts, 30
me nus, 52-54, 58-78
choosing command, 52
commands followed by an
ellips is, 53
e xecuting commands, 54
hierarchical s ubmenus, 53
highlighted commands, 52
layout r evis ions, 46-50
toggling comma nd
options, 54
messages
Busy, 470
Downloading fontname, 471
Fontname is not found , 471
Looking for Printe r
<printe m a me >, 470
Preparing Data, 470
Preparing Printe r, 4 70
Printing, 470
Proces s ing Job, 470
Starting Jo b, 470
Microsoft Excel Import
filter, 161
Microsoft Word style
s heets , 276
Mic rosoft Wo rd 4.0/5.0
impo rt filte r, 16 1-162
Import conde nsed/
expanded type option,
162
Import Index entries
option, 162
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Import page br eak before
paragraph option , 162
Import table of contents
option, 162
mini-save, 104
returning to last, 104, 143
minor subheads, 268
moire pattern, 372, 489
monitors
1-bit, 18
16-bit, 18-19
24-bit, 18-19
8-bit, 18-19
bit depth , 17-1 8
dots per inch (dpi), 17
multiple, 19-20
options, 17-19
physical size, 17
pixels per inch (ppi), 17
QuickDraw accele ration,
19
resolution, 17
system recomme ndatio ns,
16-20
system requirements, 16-20
video cards, 19
video RAM (VRAM), 19
Monitors control p anel,
resolution changes, 17
mouse
clicking, 52
double-clicking, 52
dragging, 52
moving, 52
press and hold, 52
mouse shortcuts
Command.Qption·dick
(Actual view/ Fit in
Window), 111 , 198,330,
339,497
Command-Option-ShiftClick 200% size, 111
Move tab command, 250
multiple monitors, 19-20
multiple object selection, 133
Multiple paste command,
63, 139
Command.Option-V
keyboard equivalent, 140
Option key and, 140
Multiple pas te dialog box,
63, 139
Paste option box, 140
MUNSELL color matching
system, 382
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•N•
networks copy-<letection
feature, 27
nelllfeatures,35-50
Aldus Additions, 36-50
baseline shift, 40
built-in color separation,
40-41
colors palette, 41
control palette, 41-42
custom line weights and
fill patterns, 42
custom vte111 sizes, 43
dictionary editor, 43
expanded object linking, 46
font matching, 44
import filters, 45
importing EPS spot
colo rs, 45
Indents/tabs dialog box, 44
interruptible screen
redraw, 45
kerning, 46
menu layout revisions, 46-50
multiple open publica!Ions, 46
new colo r libraries , 47
No Break option for text, 47
printing improvements, 48
rotation/transfonnalion, 49
scripts, 39-40
New Story ... command, 57,
75, 179
New ... command, 60, 83,
196,325
Command-N keyboard
equivalent, 60, 83, 196,
325,496
ne111sletter sample project,
195-227
adding masthead to page
I, 201-205
changing paragraph
specifications, 210-211
changing type speciflcalions, 209
column guides, 205-206
creating publication,
196-197
drop cap, 211-212
formatting text, 208-212
headllnes,212-2 18
importing article from
word processor, 206-207

iso lating masthead from,
204- 205
left master page, 198-199
manually pouring sto ries,
207-208
master pages, 198-201
page 2, 214-216
Page setup dialog box, 196
placing text, 206-208
printing, 225-227
right master page, 200-201
saving to disk, 224-225
s ide bar, 219-223
s ubheads, 218
Next Drive (Command-right
arrow) keyboard
equivalent, 157
Next Option (Tab) key, 366
Next Page (Command-Tab)
keyboard equivalent, 167
Non-breaking Hyphen
(Command-Option(hyphen)) keyboard
equivalent, 177, 181
Non-breaking slash
(Command-Option-/
(slash)) keyboard
equivalent, 177, 181
Non-breaking s pace
(Option-spacebar)
keyboard equivalent,
177, 181,260,443
no n-LaserWriter printer
drivers, 472
non-PostScript fonts, 464
non-PostScript printers, 21
PostScript fonts, 21
TIFF images and bitmapped graphics, 21
TrueType fo nts, 21
Normal
Command-OptionSpacebar keyboard
equivalent, 343
Normal Style (ShiftCommand-z) keyboard
equivalent, 240
Norton Utilities
defragmenting features, 16
Directory Assistant, 31
Now Compress, 32
Now Me nus, 80
Now Utilities, 196
Super Boomerang, 31
Nudge Object (Commandarrow key) keyboard
equivalent, 366

•0•
Object Linking and
Embedding (OLE), 64,
190-191,291,295
linking, 190-191
listing server applications, 64
Object Mode command set,
349, 362-366
Baseline offset o ptio n,
365-366
Cropping button, 364
Positio n (X and Y) option,
362-363
Printer resolution scaling
option, 364
Proportional scaling
button, 364
Reflection (Horizontal or
Vertical) option, 365
Rotation option, 364
Scaling button, 364
Scaling percentage option,
363-364
Sizing options, 363
Skewing option, 365
Object view, 78
objects
aligning to rulers, 68
arrow tool selection, 133
boxes around, 37, 401-402
Command key while
selecting, 130
constraining movement, 136
coordinates of reference
point, 362-363
copying, 63
copying and pasting,
137-140
current rotation, 364
cutting, 140
cutting and pasting, 137
displaying size, 363
dragging, 136-137
duplicating, 138
expanded linking, 46
gro uping and ungrouping,
41 3-4 14
handles, 133
hierarchical o rder, 132
hot links to applications, 64
Information abo ut, 349
manipulating, 421
marquee, 134
modifying characteristics,
362- 367
modifying s ize, 364

moving, 136-137
multiple copies, 63, 139
number of degrees
skewed, 365
placing in library palette, 38
positioning, 124,418-419
proportional scaling, 364
removing rotation, skewing,
or reflecting, 73
resizing, 363
ret urning to colors
imported as, 73
rotation/transformation, 49
selecting, 132-134
on-line tuto rial program , 24
OnCue, 196
launching PageMaker, 80
One Character Left
keypad 4 keyboard
equivalent, 232
Left arrow keyboard
equivalent, 232
Shift-" keyboard equivalent, 233
Shift-keypad 4 keyboard
equivalent, 233
One Character Right
keypad 6 keyboard
equivalent, 232
Right arrow keyboar d
equivalent, 232
Shift-IE keyboard
equivalent, 233
Shift-keypad 6 keyboard
equivalent, 233
One Line Down
Down arrow keyboard
equivalent, 232
keypad 8 keyboard
equivalent, 232
Shift-keypad 2 keyboard
equivalent, 233
Shift-0 keyboard
equivalent, 233
One Line Up
keypad 2 keyboard
equivalent, 232
Shift4 keyboard equivalent, 233
Shift-keypad 8 keyboard
equivalent, 233
Up arrow keyboard
equivalent, 232
One Size Larger Type
(Shift-Command-Option.) keyboard equivalent,
234,236

Index

One Size Smaller Type
(Shift-CommandOption-,) keyboard
equivalent, 234, 236
One Word Left
Command-keypad 4
keyboard equivalent, 232
Shift-Command-keypad 4
keyboard equivalent, 233
One Word Right
Command-keypad 6
keyboard equivalent, 232
Command-right arrow
keyboard equivalent, 232
Shift-Command-keypad 6
keyboard equivalent, 233
Open Press Interface (OPI),
533
links, 535
masking, 535
opening, 534-535
resampllng, 535
OPI<ompatible file, 485
Open publication dialog
box, 60, 91
Open Quotation (Option-[)
keyboard equivalent,
177, 181
Open stories Addition, 38, 409
Open template Addition, 38,
40~10

Open template dialog box, 38
Open ... command, 60, 79,
91-92, !96
Command-O keyboard
equivalent, 60, 91, 196
Copy option, 91
optical drives, 16
option boxes, 56
Options dialog box, 313,
481-486
Extra image bleed option,
485
Graphics c:> Normal,
Optimized, Low TIFF,
Omit TIFF options, 481
Include downloadable
fonts option, 485
Launch Aldus PrePrint
option, 485-486
Markings c:> Page
information option,
483
Markings c:> Printer's
marks option, 482
PostScript error handler
option, 476

PostScript c:> Include
PostScript error
handler option, 483
PostScript c:> Normal, EPS,
For separations
options, 484
Send Data c:> Faster
(binary), Normal (hex)
option, 483
Use Symbol font for
special characters
option, 486
Write PostScript file
option, 483-484
Options menu, 125, 129, 2 13,
305,524
Options options dialog
box, 469
Other leading dialog box, 209
Other Preferences dialog
box,99-!0l
Auto include images
under option, 100
Display 'i option, 101
Display all pages option, 99
Display Style names
option, 101
Preserve character shape
in TrueType option, 100
Size of internal bitmap
option, 99
Use typographer's q uotes
option, 100
Other... command, 234
outline fonts, 464
Outline Style (ShiftCommand-D) keyboard
equivalent, 240
Oval/circle tool, 77
Shift-F7 keyboard
equivalent, 77
ovals, 77, 302, 305-306
overprinting, 374, 380, 549
tints, 384
oversettext,38,408

•P•
Page 2 graphic file, 511
page icons
master-page and regularpage icons, 90
selecting pages, 112
Shift key and, 113
Page menu, 115, 201, 508,
52(}. 521

Page Number Marker
(Command-Option-p)
keyboard equivalent,
85, 117, 181, 503
Page numbering dialog box,
85
Page setup dialog box, 60,
62,93-94, 141,196,
324-325, 496
# of pages option, 85
Custom option, 84
Double-sided option, 86,
116, 198
existing publications and,
93-94
Facing pages option, 86, 87
initial attributes of
publication,83
Margin in unit of measure
option,87-88
newsletter sample project,
196
Numbers ... button, 85, 431
Orientation option, 84
page numbering, 118, 430
Page option, 84
Page size, 464, 477
Restart page number
option, 430
single-sided option, 116
Start page # option, 85
TOC and index prefix
option, 431
Page setup ... command, 62,
118, 324
PageMaker 1.0, keeping, 22
PageMaker 2.0, keeping, 22
PageMaker 3.0 or earlier
keeping, 22
opening files, 92-106
PageMaker 4.0/4.2
import filter options,
160-161
keeping version, 22
PM4.2 RSRC file and Aldus
Prep file, 22
naming and opening files,
92
PageMaker 5.0
Additions Interface
Manager, 393
after installation, 28
Aldus Fetch and, 567-568
changing default settings,
320-325
copyright screen, 59
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deleting o lder versions, 23
exiting, 62
getting around, 107-116
import filter options,
160-161
installing, 23-28
launching, 79-82, 196
menu bar, 88
new features, 35-50
on-line tutorial program, 24
opening existing publicalions, 91-93
personalizing your copy, 27
preferred amount of
memory, 14
publications that can be
opened,90
quitting, 105
reinstalling, 28-29
user inte rface, 51
what to do with older
versions, 21-23
PageMakericon, 79,196
PageMaker Story Importer
dialog box, 160
Select all button, 160
View button, 160
pages
adding, 69, 85, 114-115
balancing text columns,
36,395
columns, 120-122, 205
complex grids, 420
creating new text on,
174-175
d ragging objects between,
137
first page number, 85
going directly to, 201
grid on a selected box on
page,420
landscape orientation , 84
long document numbering, 429-430
magnification levels, 108-111
margins, 87-88
master page numbering,
117-118
maximum number in
documents, 85
moving text blocks
between, 155
moving to next, 112-114
non-standard s ize, 84
number limitation, 114
numbering, 85, 118
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options, 62
orientation, 84
portrait orientation, 84
rearranging, 39,417-418
removing, 69, 115-116
saving elements before
deleting pages, 115
setting guides like master
page,69
setting number in
document, 85
specifying s ize, 84
turning, 112-114
zooming in on, 110
paint-type graphics, 288
modifying, 312- 316
resizing, 297
palettes, 5~78
control, 77- 78
tool, 76-77
PANOSE font matching
dialog box, 155
PANOSE font matching
system, 44, 357
changing predefined or
default substitution, 167
editing exceptions, 166
Super ATM, 165
PANTONE color matching
system, 381
Paper o ptions dialog box,
469,477-480
Auto overlap option, 478
Center page In print area
option, 478
Manual tiling option, 478
Scale <!> Reduce to fit
option, 479-480
Scale <!>Thumbnails, 480
Scale option, 479
Size option, 477-478
Source option, 478
Tile option, 478
Paragraph dialog box
Include In table of
contents option, 432
Paragraph End (Return)
(Command.Option-p)
keyboard equivalent, 181
paragraph formats, 268
body text, 268
cutUnes, 268
inline graphics , 268
major subheads, 268
minor subheads,268

Paragraph Mode command
set, 349, 360-362
Align to grid option, 361
Alignment option, 361
Cursor-position option, 361
Grid size option, 361
indent o ptions, 361
Paragraph Style option, 361
Space after option, 361
Space before option, 361
Paragraph rules dialog box,
245-247,299,302
Custom ... Line style
option, 246
Line color option, 246
Line width of the text
o ption, 246
Line width option, 246
Options ... butto n, 246
Rule below paragraph
option, 527
Paragraph specifications
dialog box, 71 , 210,
241-247,270, 299,336,
500,507,527
Alignment option, 255
Alignment poJ>Up menu, 210
Column break before
option, 244
First Indent option, 242
Include in table of
contents, 245
Indents options, 21(}.211
Keep lines together
option,244
Keep with next __ lines
option, 244
Left indent optio n, 242
Orphan control __ lines
o ption, 244
Page break before, 244
Paragraph space options,
210
Right Indent optio n, 242
Rules button, 245
Spacing... button, 247, 258
lines
Widow control
o ption, 244
Paragraph view, 78
paragraph-level formatting,
360-362
Paragraph ... command, 71,
210, 241-247, 255, 258,432
Command-M keyboard
equivalent, 71, 210,
255,258,336,432, 527

paragraphs
alignment, 72, 210, 255
applying styles, 280
attributes, 210, 230
automatically applying
style sheets , 272
beginning at next available
column, 244
beginning at top of next
available page, 244
bullet character or
number, and tab at
start, 399-400
bulleted, 37
changing specifications,
210-211
cursor-movement keys, 232
drop caps, 37, 211-212,
403-406
extend selectio n keys, 233
first-line Indent, 71
form atting, 71, 230-233,
241-247
included in table of
contents , 245
indents ,242-245, 24~25 5

keeping lines together, 244
letter and word spacing,
262-265
listing styles, 37
manually tagging, 279
margins, 71
marking for table of
contents, 432-433
numbering, 37
orphans,244
rules above and below,
245-247,302
setting hyphenation
attributes, 71
space before and after,
243-245,361
space between, 210
spacing, 247-258
style sheets based o n
existing, 271, 274
tab settings, 71, 24~255
widow control, 244
word and letter space
parameters, 247
parameters, 424
Paste command, 63, 8 1,
137-138, 141, 154-155,
187-188,200,220,298,
300,405, 407

Command-keypad 0
keyboard equivalent, 63
Command-V keyboard
equivalent, 63, 81,
137-138, 154, 187, 200,
220,298,300,407,525
Paste Link command, 46, 64,
190-191,295
Paste special dialog box, 64
Paste special... command,
64, 188
Command-Option-V
keyboard equivalent, 338
pasteboard, 90
viewing with publication,
109
perpendicular line tool, 77,
198, 204, 302-309
Shift-F3 keyboard
equivalent, 77
perpendicular lines, 77
pica, 321
points, 321
Pica Gauge Addition, 421
PICT graphic flle format,
288-289
LaserWriter 8.x driver, 476
PlxelPalnt, 288
pixels, 517
pixels per inch (ppi), 17
Place dialog box, 301, 405
Place document dialog box,
61,173,206, 292, 332
As In line graphic option,
292
As independent graphic
option,292,332
Convert quotes option,
157,207
PageMaker 4.0/4.5 and 5.0
Import filters, 160-161
Read tags option, 157, 193,
207, 277
Replace existing graphic
option, 301
Replacing entire story
option, 173
Replacing selected text
option, 173
Retaln cropping data
option, 301
Retain format option, 157,
207
selecting word processor,
156

Index

Place ... command, 61, 116,
155-157, 172, 179, 190,
203,206,2 16,221,277,
288,291-295,301-302,
328,332,337,511
Command-O keyboard
equivalent, 61, 206,
221,301,328, 332, 506,
514,521
PMS Defaults file, 95, 321
PMS.O RSRC file, 81
.PMG lilelextension, 414
PMproKit, 421
pointer cursor, 90
pointer tool, 377
points, 321
pop-up menu, 53
dialog boxes, 56
portrait o rientation, 84
postal bar codes, 420
POSTNET Bar Code
Addition, 420
PostScript, 20, 464
Adobe Type Manager
(ATM) and, 32
determining file format, 484
including one inch of extra
bleed, 485
including printer fonts In
file,485
printers and, 21
printing file to dis k, 466
Type I fonts tracking, 406
Type 3 fonts tracking, 406
type sizes, 235
PostScript printers, 20,
313-314
Apple LaserWriter, 20
halftone cells, 313
Llnotronic imagesetter, 20
PPD (PostScript Printer
Description) file, 20,
226, 467,476
installing, 25
listing, 473
paper sizes available for
printer, 477-478
reinstalling, 29
screen rulings and angles ,
489
selecting, 26
updating, 39
preferences, 95
Preferences dialog box, 44,
61,95-98,320,493
Back option, 128

default nudge amount, 355
Front option, 128
Graphics option, 97- 98
Guides in back option, 130
Guides option, 98, 128, 132
Horizontal nudge option, 98
Measurement system
option, 96, 123, 320-321
Other ... button, 99-101
PANOSE Font Matching
option, 165
Save option, 98
Show Keeps' violations
option, 97, 245
Show loose/tight lines
option, 97
story editor font and size,
178
units of measurement, 88-89
Use snap to constraints
option, 98, 356
Vertical nudge option, 98
Vertical ruler option, 96-97,
123
Preferences folder, 321
Preferences ... command,
61, 95, 128, 166, 196,
320,493
Preparing Data message, 470
Preparing Printer message,
470
preset character widths, 234
Previous Drive (Commandleft arrow) keyboard
equivalent, 157
Previous Option (Shift-Tab)
keyboard equivalent, 366
Previous Page (CommandShift-Tab) keyboard
equivalent, 167
Print document dialog box,
48,61,468, 471-476
Collate option, 473
Color button, 487
Copies option, 473
Options button, 481
Orientation option, 475
Page independence
option, 474
Pages ¢ All option, 474
Pages ¢ Ranges option, 474
Paper button, 477
Paper sizes, 464
Print all publications in
book option, 475
Print blank pages option, 474

Print ¢ Both/ Even/Odd
options, 474
print queue options, 411
Print to option, 473
Proof option, 473
Reverse order option, 473
Scale option, 236
Type option, 4 73
Use paper settings of each
publication option, 475
print queue
adding documents, 411
management, 410-413
rearranging, 411
Print status dialog box, 226
messages, 470-471
Print to dialog box, 62, 225,
530
Copies option, 225
listing printer, 226
Page range option, 226
Type option, 226
Print... command, 62, 225,
428, 467-469
book lists, 42 7
Color dialog box, 487-490
Command-P keyboard
equivalent, 62, 225,
345,468,530
dialog boxes, 471-491
Option key and, 476
Options dialog box, 481-486
Paper options dialog box,
477-480
Print document dialog
box, 471-475
printer drivers, 20-21, 225
LaserWriter 8.0, 20
non-LaserWriter, 472
PSWriter 8.0, 20
selecting, 465-467
Printer styles Addition, 38,
410-413,467
printing style sheets, 467
printers
Apple lmageWriter, 21
Apple LaserWriter, 20
Apple LaserWriter NT, 477
fonts downloading on
pa~by-page basis, 474
how information is sent
about TIFF images and
bitmapped graphics, 483
how much information is
sent from imported
bitmapped and TIFF
images, 481
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imageable area, 464
Linotronic imagesetter, 20
listing, 226
name of selected, 473
non-PostScript, 21
paper sizes available, 477478
paper trays available, 478
PostScript, 20.21, 313-314
PPD (PostScript Printer
Description) file, 467
print area, 477
printer driver, 225
printing page order, 473
QuickDraw, 21
selection, 465-467
StyleWrite.r, 21
system recommendations,
20-21
system requirements, 20-21
TrueType fonts, 21
unprintable margin area, 464
printing, 62
all publications in book
list, 61, 475
background,20,467,476
blank pages in publication, 474
centering pages within
printable area, 478
changes in PageMaker 5, 476
Chooser, 465-467
collated, 473
color document without
separations, 487
color-control bars, 482
continuous-tone art, 372
crop marks, 482
deleting unused elements,
465
density-control bars, 482
emulsion side up or
down, 488
entire document, 474
EPS graphics original
colors, 488
even-numbered or oddnumbered pages, 474
file information job slug,
410,413,483
fonts, 464
four-page catalog, 530
halftones, 372, 489-490
imageable area, 464
improvements, 48
knocking out, 374
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LaserWriter driver 8.x, 476
mas ter pages, 120
messages,469-471
modifying style sheets,
411-412
moire pattern, 372, 489
negative Image of
publication, 488
number of copies, 225, 473
OPI-compatible file, 485
overprinting, 374
overview of process,
465-471
page order, 473
page orientation, 475
page size vs. paper size, 464
paper size specifications, 84
PostScript file to disk, 466
PPD file, 476
process-co lor, 371-373
publications, 463-491
range of pages, 474
rectangles in place of
graphics, 473
registration, 373-374
registration marks, 482
scaled graphics, 464
scaling, 479-480
screen ruling and angles,
489-490
separations, 372, 487-488
spot-color, 371-373
style sheets, 410-413,467
text blocks, 465
things to worry about
before, 463-465
tiling, 84, 478
trapping, 373-374
two-page document,
225-227
two-sided flyer, 345
whenever an error occurs
message, 483
working with your printer,
374-375
Printing message, 470
printing press, trapping, 547
PrintMonltor, 476
window, 469
process color, 548
color models, 380
color separation, 549
converting to spot color,
385
creation, 380-381
EPS graphics, 384

listing for document, 488
printing, 371-373, 549
registration, 373
Processing Job message, 470
processor, 11
Product Description file, 328
programs
Adobe Illustrator, 289
Adobe Photoshop, 290, 532
Adobe Type Manager
(ATM), 464
Aldus FreeHand, 289, 291
Aldus PrePrlnt, 291
Aldus SuperPalnt, 291
Cache,532
Canvas, 289
Cricket Draw, 289
Digital Darkroom, 290
Disk Express II, 16
KernEdlt, 258-259
MacDraw II, 289
MacLlnk Plus, 158, 290
MacPalnt, 288
Master Juggler, 202, 235
Now Menus , 80
Now Utlllties, 196
OnCue, 80, 196
PixelPalnt, 288
PMproKlt, 421
QuicKeys, 196
RoboTrap, 558
Suitcase II, 202, 235
Super Adobe Type
Manager, 44
SuperPalnt, 288
transferring elements
between, 188-191
proportional leading, 237
.ps file extension, 483
PS Group it Addition, 38,
413-414
encapsulated PostScript
(EPS) copy, 413
PS Ungroup It Addition, 38,
413-414
PSWrlter 8.0 printer driver, 20
publication window, 88-90,
197
25 percent of actual size,
67, 109
50 percent of actual size,
67, 109
75 percent of actual size,
67, 109
200 percent of actual
s ize, 67

400 percent or actual
size, 68
basics, 107- 145
close box, 105
closing, 62
displaying all pages, 66
facing pages, 8 7
fit In window, 109
full-size representation of
page,67
page icons for masterpage and regular-page
icons, 90
PageMaker menu bar, 88
pasteboard, 90
pointer cursor, 90
rulers, 89
scroll bars, 90
selecting all objects, 63
toggling scroll bar
display, 69
window for each open
publication, 88
publications, 14, 57
adding pages, 85, 114-llS
adding to book lists, 428
arranged In s ignatures for
printing, 36
arranging pages for
printing, 397-399
autoflow text without
showing pages, 99
chain-printing, 429
changing view s ize of
entire, 113
closing, 60, 105
color list, 375-377
configuring double-sided,
86-87
converting to 5.0, 21
copying all linked
graphics files, 102
copying colors !rom,
387-388
creating new, 83-88
defaults, 95
defining attributes, 60
deleting colors , 389
discarding changes, 61
displaying all pages, 66
double-clicking on the
leon, 90
dragging and dropping
icon, 80
dragging objects
between, 137

faci ng pages, 87
first page number, 85
font matching, 44
fo ur times actual size, 110
imported text and graphic
information, 74
importing style sheets,
276- 279
indexing, 65
large, 86
laying out o nto film for
service bureau, 421
linking to text a nd
graphics Iiles, 61
listing fonts, styles, and
linked o bjects, 37, 402
magnification sizes, 66
margins, 87-88
master-pages, 118-119
maximum number of
pages, 85
mini-save, 104
moving to next page,
112-114
multiple open, 46
newsletter sample, 196-197
non-standard size pages, 84
numbering pages, 85, 114
opening, 60, 90-94, 91-93
PageMaker l.O, 2.0, or 3.0
files, 92- 106
PageMaker 4.0 files, 92
page orientation, 84
paper size fo r print ing, 84
placing story from s tory
editor, 179-180
preferences, 95
printing, 463-491
printing all in book list, 475
printing rectangles in
place of graphics, 473
printing to PostScript file,
483-484
rearranging pages, 39,
417-418
removing master-page
elements, 118
removing pages, 115-116
reversing actions, 141- 142
reverting to last save,
142- 144
running headers and
footers, 39,41 4-4 17
saving, 60, 101-104, 460-461
secret diagnostics, 251
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setting Initial attributes, 83
setting number of pages, 85
signatures, 558
size and source settings,
475
size specified in Page
setup dialog box, 109
s iideshow mode, I 14
spell-checking, 184-186
storing and organizing
text, graphics, and
images, 38
table of contents or index,
61
templates, 38,409-410
twice actual size, 109
unplaced text, 38
verify or modify text and
graphics relationships ,
73
versions that can be
o pened,90
view s izes, 108-1 II
viewing with pasteboard,
109
violated settings for
specific text and
paragraph options, 97
which to create boo k list
in, 428-429
window fo r each open, 88
Publish and Subscribe, 46,
188-190, 291
PageMaker and, 189

• Q•
QuarkXPress
color rule trapping, 552
trapping, 552-553
queries, 424
Quick Index (CommandShift-;) keyboard
equivalent, 443
QuickDraw printer, 21
object-<>riented graphics, 21
QuicKeys, 196
Quit command, 62, 105
Command-Q keyboard
equivalent, 62, 105
quotation marks
converting, 157
typographer's, 100

•R•
R (Right master page) icon,
11 6
radio buttons, 55
RAM (random-access
memory)
adding more for
PageMaker, 92
system recommendations,
12-14
system requirements, 12-14
range kerning, 257,259-260
Read Me file, 28
Rebuild Desktop (Command-Option)
keyboard equivalent, 91
rectangle tool, 340
rectangles, 302, 305-306
applying color, 377
rounded comers, 73, 305,
341
square corners, 77
Redo command, 63, 142
Regis tered Trademark
(Option-r) keyboard
equivalent, 181
registration marks, 377, 482
printing, 373-374
reinstalling PageMaker 5.0,
28-29
Remove Kerning (Command-Option-K)
keyboard equivalent, 260
Remove pages dialog box,
69, 115, 141,508,520
Remove pages ... command,
69,115,508
Remove transformation
command, 73
Repeat tab command, 249
Replace command, 186
Command-O keyboard
equivalent, 186
ResEdit utility, changing
startup screen, 80-81
Resource #260, 81
Resource #262, 8 1
Restart command, 23
Restore original color
command, 73, 378
Revert command, 61, 104,
142-1 44
Shift key and, 61, 104, 143
Revert to last mini-save?
d ialog box, 143

RGB (red, green, blue) colo r
model, 18, 379
rich black, 556
Right Alignment (ShiftCommand-R) keyboard
equivalent, 255
Right Double Quote (ShiftOption-[) keyboard
equivalent, 330
Right Single Quote (ShiftOption-]) keyboard
equivalent, 330
RoboTrap, 558
Rotate & Merge Text
Addition , 42 1
rotation tool, 49, 77
Shift-F5 keyboard
equivalent, 77
Rounded corners dialog
box, 73,341
Rounded corners ...
command, 73, 305,341
RTF (rich text fo rmat), 158
rule-based hyphenation, 253
Ruler Addition, 421
ruler guides, 126-128, 219,
221,325-326
creation, 198
hiding, 130
locking, 130
returning to master page
state , 128
security, 130
rulers,89, 120-129
aligning objects to, 68
displaying or hiding, 123
guides , 126-127
measuring, 125-126
position, 61
positioning objects, 124
tick marks, 96, 123
toggling on/off, 68-89
tracking position of
cursor, 124
units of measurement, 61,
89,96
view sizes, 123
zero point, 68, 89, 125-126
Rulers and guides submenu,
127, 130
Rulers command, 89, 123
Command-R keyboard
equivalent, 123, 197,325
rules, 42 1
Run Script Additions
command, 39
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Run Script. .. Addition, 392,
423
Running headers a nd
footers Addition, 39,
396, 414-417
custom searches, 416
HEADERS.INI file, 4 I 7
HRD file, 4 I 7
Running headers\ footers
dialog box, 415
Find option, 415
Insert o ption, 4 IS
Left Page and Right Page
optio ns , 415-4 I 7

•S•
Safari Addition, 420
sample projects
four-page catalog, 493-530
newsletter, 195-227
two-sided flyer, 319-346
Save as dialog box, 60, 62
Copy all linked files
option, 460
Copy linked files for
remote printing
option, 460
Save as ... command, 60, 92,
98, 102-103,328
when to use, 103
Save changes dialog box, 62,
105
Save command, 60, 92, 98.
101 , 142, 224,327,504
Command-S keyboard
equiva lent, 60, 101,
224,327,330,334,504
reverting to last, 144
Save publication as dialog
box, 102, 224,327, 504
Cancel button, 103
Copy linked files option, 102
Desktop (or Drive) and
Eject buttons, 102
Publication option, 102
Te mplate option, 102
scanners
TIFF file format, 394
TWAIN standard, 36
TWAIN universal interface
language, 394
Scrapbook, 187
pasting into, 290, 405
screen
Command-Clicking view
sizes, 112
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grabber hand, Ill
horizontal or vertical
movement o nly, 112
interruptible redraw, 45
scrolling, 111-112
zoom tool, 112
Script Language Guide, 423
scripts, 39-40, 392- 393, 423
converting fraction Into
typographer's fraction,
424
executing, 65
external, 423
internal, 423
running, 39, 392
sample, 40
Script Language Guide, 423
Scroll bar command, 495
scroll bars, 90, Ill
toggling display, 69
Scroll bars command, 111
Scroll Display Down One
Line Command-down
arrow keyboard
equivalent, 232
Scroll Display Up One Line
Command-up arrow
keyboard eqWvalent, 232
searches, 65
Select all command, 57, 63,
134h35, 172,202,209,465
Command-A keyboard
equivalent, 57, 63, 134,
172,202,209,214,330,
340,342, 507,525
Select topic dialog box, 439,
442,444445
Import button, 445
semi-automatic text flow,
167-168, 170--171
Send to back command, 73,
132-133, 154, 34 1, 520
Command-S keyboard
equivalent, 73, 132,
154,342,520
.SEP lile, 485, 533
opening, 534
Set Up Columns Addition, 421
Set width command, 234, 343
Set width s ubmenu, 70
Shadow Style (ShiftCommand-W) keyboard
equivalent, 240
shapes
color, 306

cut, copied, or deleted, 306
!ill pattern, 306-308
line we ight, 305, 307-308
manipulating, 305-306
repositioning, 306
resizing, 306
Shared Code Manager
extension, 28
Shift key, 23, 296
adding objects to
marquee, 134
constraining line
segments, 199
constraining object
movement, 136
deselecting objects with
arrow tool, 135
reverting to last mini-save,
143
Show clipboard command,
74
Show Index dialog box, 66,
445-446
adding cross references, 446
editing, adding, and
deleting topics, 446
s hortcuts, 448
Show index... command, 66,
437,445
Show pasteboard command, 109
sidebar, 219-223
box with a drop shadow,
219-221
headline, 222
pouring and formatting
text, 221-222
signatures, 558
Single Quotation Close
(Option-Shift-])
keyboard equivalent,
177, 181
Single Quotation Open
(Option-]) keyboard
equivalent, 177, 181
Size command, 202, 234
Size submenu, 70
slideshow mode, 114
small caps, 71
Smaller Standard Type Size
(Shift-Command-,)
keyboard equivalent,
234,236
Smart ASCII Import filter,
159-160

Smart ASCII Import !liter
dialog box
At the end of every line
option, 159
Between paragraphs
option, 159
But keep tables, lists and
indents as is option, 159
Monospace, Import as
Courier option, 160
No conversion, Import as
is option, 160
Replace_ or more s paces
with tab option, 160
Snap to guides command,
129,136, 303,495
Command-U keyboard
equivalent, 129
Snap to rulers command,
124,136,324,495
Command-( keyboard
equivalent, 125, 324
Sort pages Addition, 39, 396,
417-4 18
Space Between Pairs
Command-¢ keyboard
equiva lent, 259
Shift-Command-Delete
keyboard equivalent, 259
Spacing attributes dialog
box,247
Auto leading option, 237
Letter space option, 253,
262- 265
letter- and word-spacing, 97
Word space option, 253,
262-265
special characte rs, 176-177
codes for finding/
changing, 177
stories, 76
Symbol font, 486
Special menu, 23
spelling checker, 65, 184-186
returning to layout view, 186
Spelling dialog box, 65, 184
All stories option, 185
Current story option, 185
poss ible actions using,
185-186
Search Selected text
option, 185
Spelling... command, 65, 184
Command-L keyboard
equivalent, 65, 184

spot color, 548
color models, 380
converting to process
color, 385, 488
editing In Imported EPS
graphics, 385-386
EPS graphics, 45, 384
lightened color, 383
listing for document, 488
overlays, 372
printing, 371- 373
spread,549
square-comer tool, 302,
305-306,77
Shift key and, 77, 305
Shift-F'6 keyboard
equivalent, 77
squares,302,305-306
rounded corners, 73, 305
Stac, 32
standalone applications, 393
Starting Job message, 470
startup screen
black and white, 81
changing, 80--81
changing color, 81
stories , 57, 150--155
affects of resizing text
block, 153
automatically opening, 38
closing, 76
continued line, 394-395
displaying information
about, 37
drawing box around, 214
headlines,2 18
Importing text, 172-173,
206-208
Information about, 403
listing paragraph styles, 37
listing style sheets, 409
new window, 64
opening multiple, 409
oversettext, 409
placing, 216
reflowlng, 153
saving.text for use in word
processor,61
searching, 182
selecting all text, 63, 172
special characters, 76
spelkhecking, 65, 184-186
style-sheet names, 76
subheads, 218
table of contents, 433-435

Index

text blocks, 57
continued to and from, 395
viewing text, 57
creation, 269-275
s tory editor, 177-186
default, 275
accessing, 177
defining, 72, 267-270
automatically opening
displaying, 71
stories, 38
dynamic link between, 273
change command, 437
editing, 72, 283-284
character or paragraph
edi ting text, 284, 507
formatting, 178
exporting, 284
cursor-movement keys, 232
four-page catalog, 497-502
discarding story, 179
from scratch, 269-270
font and type size, 100
importing, 72, 276-279
importing text into, 179
indexes, 452-453
inline graphics, 299
menu bar, 178
name of styles display, 101
listing, 37, 402, 409
non-printing character
listing names in stories, 76
manual tags, 279
display, 101
opening story, 177
Microsoft Word, 276
mixed attributes, 27 1
placing story in publicamodifying printer, 411-412
tion, 179-180
returning to layout view, 178
naming, 270-271, 274
searching for text, 180-183
new with tabs, 524
story window, 75
overriding, 280-281,
526-528
text appearance, 178
paragraph formats, 268
text creation, 179-180
Story menu, 46, 75-76, 179
preserving non-type style
Strlkethru Style (Shiftoverrides, 281
Command-/) keyboard
printing, 38, 410-413,467
equivalent, 240
running headers and
strippers, 559
foot ers based on, 415
stripping, 547
setting hyphenation
Stuffit Deluxe, 32
attributes, 71
Magic Menu, 32
table of contents, 432-433,
Stuffit SpaceSaver, 32
436-437
Style command submenu, 280
tags, 157, 277-279
style palette
type style overrides, 280
viewing for selected text, 361
Body text style, 523
word processors,276-279
toggling on/off, 75
viewing, 270
WordPerfect, 276
Style palette command, 75,
Style submenu, 71
270, 280,495
Styles palette, 281-284, 503
Command-Y keyboard
applying style s heets, 280,
equivalent, 75
282
style sheet tags, 193
Body text option, 507
style sheets, 267-285. See
checking style of text,
also styles
281-282
applying, 71, 272, 280
Command key and, 270,
272, 274, 282-283
attributes, 270-271
disassoc iating text from a
automatically applying, 272
based on existing style
style s heet, 282
sheets, 273-275
Headline option, 498
based on existing text,
new s tyle sheet, 282
270-272
No style option, 524
breaking link between, 275
Price lists option, 524, 527
character level formatting,
reformatting edited style
s heet text, 282
280-281

shortcuts, 282-283
style sheets, 272, 282-283
StyleWriter, 21
Subhead 1 default s tyle
sheet, 275
Subhead 2 default style
sheet, 275
s ubheads, 218
shading, 246
submenus, 53
Subscribe to command,
189,295
Subscribe to dialog box,
63, 189
Subscriber options
command, 189
Subscriber options dialog
box, 63-64, 189
subscript, 71,322
fractions, 241
substitute fonts, 357
Suitcase II, 29-30, 202, 235
Super ATM (Adobe Type
Manager), 44
PANOSE matching system,
165
Super Boomerang, 31
SuperPaint, 288
superscript, 71, 322
fractions, 241
Symbol font, 486
Syquest drives, 16
System 7
Edition Manager, 64, 291
launching documents, 91
launching PageMaker from
Apple menu, 80
system recommendations,
10-21. See also system
requirements
hard drives, 14-16
Macintosh, 11
monitors, 16-20
printers, 20-21
RAM (random access
memory), 12-14
system software, 21
system requirements,
10-21. See also system
recommendations
hard drives, 14-16
history, 9-10
Macintosh, II
monitors, 16-20
printers, 20-2 1
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RAM (random access
memory), 12, 12-14
system software, 21
system software, recommendations and
requirements, 21

•T•
Tab key, 56
Tab Text Addition, 421
table of contents, 61,431-437
creating story, 433-435
creation, 66
from all publications in
book list, 434
including paragraph, 245
marldng paragraphs,
432-433
page number location, 434
placing, 435-436
replacing with new table
of contents, 434
special text added before
page-number referencc,85
style sheets, 436-437
titles, 434
what is between entry and
page number, 434
when to create, 436
Table of contents dialog
box
Replace existing table of
contents option, 434
tabs,248,503-504
adding new, 249
based on text width, 421
checking position and
leader, 249
deleting, 250
modifying, 250
removing, 249
resetting, 250
series equally spaced, 249
settings, 71
tab leader, 248
tagging, 268
tags. See style sheets
templates, 38
Charset.PT5, 176
closing, 60
Copy option, 91
creation, 102, 420
discarding changes, 61
impositions, 562

590

Macworld PageMaker S Bible

modifying, 91
opening, 60
Page~aker version, 410
publications, 409-410
saving, 60
selecting, 26
text, 149-194
adjusting column width,
328-329
aligning In multiple
column layouts, 362
alignment documentation,
361
autoflow, 99, 115
automatic o r semiautomatic flow, 69
automating formatting, 267
centered, 323
changing fonts, 202, 209, 357
character-level formatting,
357-360
character-width options,
70,322
color, 322, 377
condensing and rotating,
343-345
controlling size, 235-236
creating new, 174-177
cutting and pasting, 176
default type size and font,
202
deleting, 63
displaying width, 359
drop cap, 211-212
editing, 229, 284
exporting, 192-193
finding and changing,
183-184
flowing, 167-173
form atting, 208-212, 216,
229-265
from the Clipboard, 186-191
graphic boundary and text
wrap, 309-311
hyphenation, 250-255
Importing, 155-167,206-207
kerning, 407-408
Jeadlng,209,237,359
manipulating, 421
manually pouring stories,
207-208
master pages, 69
masthead creation, 201-204
name of font used, 235, 357
newsletter sample project,
206-2 12

no break option, 47
paragraph specifications,
210-211
paragraph-level formatling, 360-362
pasting, 187-188
position of the baseline, 360
repositioning around
graphics, 509-511
saving for use in word
processor,61
searching, 180-184
selecting, 63, 76, 202
size of greeklng, 100
size of text grid, 361
special characters, 176-177
spell-<:hecking, 184-186
stories, 150-155
storing In Scrapbook, 187
story editor creation,
179-180
style s heets based on
existing, 270-272
styles, 71, 202, 234
subscript, 322
superscript, 322
tagging, 268, 277-279
text blocks, 150-155
unavailable fonts, 357
unplaced, 38
viewing kerning applied,
359
viewing style sheet, 361
viewing tracking, 359
violating Keep with
settings, 97
wrapping around
graphics, 73,308-311
text blocks, 117, 150-155,
175,203
combining, 154
Continued .. . lines, 36
creation, 77
displaying additional text,
152
displaying Information
about, 37
drag-placing to create
new, 171
finding oversets, 408-409
handlebars, 151,203
handles, 152, 329
hidden text, 152, 203
horizontal location of
cursor, 361
information about, 403

Inserting text Into, 173
marquee, 134
missing text, 465
moving, 153-155
moving between, 39,418
moving between pages, 155
predefining size, 175
printing, 465
reflowlng, 152
repositioning, 203
resizing, 151- 153
rotating, 77
selecting all, 202
stories, 57
tab for handlebars, 152
threading, 150
text flies
copying Into memory for
placement, 61
linking to publication, 61
listing Imported, 453-456
Text flow dialog box
Column break Icon, 310
Jump graphic Icon, 310
Standoff In option, 311
Text flow option, 310-311
Wrap around Icon, 311
text flow Icons, 167
text Import filter, 155
Text rotation ... command,
345
text string, searching for, 65
Text tool, 77, 117, 154, 174,
213, 271, 298,300
Shlft-F4 keyboard
equivalent, 77
Text wrap dialog box, 73,
309,5 12
Custom graphic boundary
Icon, 310
None icon, 309
Regular graphic boundary
Icon, 309
Wrap options, 309-310
Text wrap ... command, 309,
512
Thin Space (CommandShift-t) keyboard
equivalent, 177, 181,337
third-party Additions,
418-422
Baseline Grid, 420
Distort Type, 421
Framz Proportional
Borders, 422
Grldzold, 420

KernlngPalrs, 421
~arksmaker,421

Pica Gauge, 421
POSTNET Bar Code, 420
Rotate & ~erge Text, 421
Ruler, 421
Safari, 420
Set Up Columns, 421
Tab Text, 421
UPC-EAN BarCode, 420
ZephyrSmartAIIgn, 418-419
Zephyr SuperSnap, 418-419
threading, 150
tick marks, 68, 96, 123
positioning objects, 124
TIFF (Tagged-Image File
Format) file fo rmat,
288,290,464
color attributes, 536
color sample bar, 536
global color corrections, 532
modifying, 312-316
opening, 535-539
resizing graphics, 297
scanners, 394
size and memory, 536
Tile command, 46, 74, 137
Option key, 74
tiling and printing, 84, 478
tints, 383-384
Edit color dialog box, 383
fine objects and, 384
overprinting, 384
tool palette, 76-77
Arrow tool, 76
Cropping tool, 77
deselecting objects, 135
Diagonal line tool, 77
Oval/circle tool, 77
Perpendicular line tool, 77
Rotation tool, 77
Square corner tool, 77
Text tool, 77
toggling display, 75
Tool palette command, 75
Command-6 keyboard
equivalent, 75
toolbox, 90
top of caps leading, 237
Top/Chair.EPS file, 332
topic reference, 438
TOYO color matching
system, 382
Track command, 234
Track submenu, 71
tracking, 234, 256-257, 322,
406-407

Index

characters, 238
displaying optio ns, 71
modifying, 37, 40!H07
moving between fo nts, 407
storing tracking curves, 407
values, 261,407
viewing for selected text, 359
Tracking Values file, 407
Trademark Symbol (Option2) keyboard equivalent,
181
trapping
Adobe lllustrator, 552
Aldus FreeHand, 552
Aldus TrapWise, 545-558
basics, 549-550
choke,549
colo r on the desktop,
548-549
Corel Draw!, 552
defi nition. 546, 550-551
gradients, 55 1
inaccuracy of
imagesetters, 546
knocking out, 549
overprinting, 549
printing, 373-374
printing press, 547
QuarkXPress, 552-553
size, 551
spread,549
stripping, 54 7
third colo r as trap color,
550
traditional, 55 1-552
vignettes. 55 1
why it Is necessary,
546-548
with desktop applications,
552-553
Traverse text block
Addition, 39, 418
TrueType font s, 464
character rendering, 100
printers, 2 1
tracking, 406
type sizes, 235
TRUMATCH colo r matc hing
syste m, 382
TWAIN scanning standard, 36
two-headed arrow. 306
two-sided flyer, 319-346
adding simple graphic,
331-334
adjusting column width of
text, 328-329

building outer side, 339-346
changing PageMaker
default settings, 320-325
changing type specs,
329-330
clip-out coupon, 334-338
condensing and rotating
text, 343-345
coupon border, 323
creation, 319-324
fold lines, 326
fold margins, 326
headline with default type
s pecs, 330-331
naming file, 327
new document, 325-328
panels, 325-326
placing body copy, 328-331
printing, 345
ruler guides, 325-326
saving to disk, 327-328
type, condensing or
expanding, 322
Type menu, 70--72, 142, 202,
209-210, 214, 230, 233,
241, 248, 251,255,258,
269,271,274, 276,280,
283-284, 322, 330, 343,
432,503
Type options dialog box,
71, 240
baseline shift option, 241
type specifications, 65
Type specifications dialog
box. 71 , 235-241, 270,
322,330,336-337,340,
342-343, 503
Break option, 47, 240
Color option, 322
Font option, 235
Font pop-up menu, 322
Leading option, 237
leading sizes, 70
No Break o ption, 47, 240
Options button, 240-24 1,
359
Pos ition pop-up menu, 322
Set width option, 238, 322
Size option, 235-236
Track option, 238
type s izes, 70
Type style option, 240,
322,330
Type s pecs ... command, 71,
235-24 1,322,359

Command-T keyboard
equivalent, 71 , 235-241,
322, 330, 336-337, 503
Type style command, 202,
234
type style
modifying, 359
options, 358
overrides, 280
Type style submenu, 71
typesetting quotation
marks, 157
typographer's quotes, 100
typography, 255-265
characterspacing,256-257
condensing or expanding
type,257
kerning, 256-257
letter spacing, 257
tracklng, 256-257

•U•
Underline Style (ShiftCommand-U) keyboard
equivalent, 240
Undo command, 62, 128,
140--142,296
Command-Z keyboard
equivalent, 62, 136,
140--142,296
units of measurement
clceros, 321
dialog boxes, 96
Inch decimal, 320
inches, 320
overriding, 88
pica, 321
rulers, 89, 96
vertical ruler, 96-97
view sizes, 124
unplaced text, 38
Unzoom (Command-Optionspacebar) keyboard
equivalent, 43, 110
UPC-EAN BarCode Addition ,
420
Update PPD Addition, 39, 476
Upper Case (Shift-Command-K) keyboard
equivalent, 340
user Interface, 51
utilities, 29-32
Adobe Type Manager
(ATM), 32
compression, 31-32
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dialog boxes, 30-31
font managers, 29-30
font-family management, 30
Utilities menu, 36, 46, 64-66,
212,388,392,433,438,
444-445, 448

•V•
variable space, 336
vertical ruler units of
measurement, 96-97
video cards, 19
video RAM (VRAM), 19
view sizes, 108-111
25% size, 109
50% size, 109
75% size, 109
200% size, I 09
400% size, 110
Actual size, 109
changing entire publicatlon, 113
Command-clicking, 112
Command-Option keys, 109
Fit in window, 109
Option key and, 113
rulers, 123
Shift-Command-Option
keys, 110
Show pasteboard, 109
units of measurement, 124
ways to change, 110
View submenu, 66, 108-110,
113
View submenus, 109
View¢25% s ize command
Command~ keyboard
equivalent, 67
Vlew<>SO% size command, 67
Command-S keyboard
equivalent, 67
View¢75% size command, 67
Command-7 keyboard
equivalent, 67
View¢200% size command
Command-2 keyboard
equivalent, 67
Shift, Command, and
Option keys, 67
View¢ 400% size command,
68
Command-4 keyboard
equivalent, 68
Vlew<>Actual size
command, 67
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Command and Option
keys,67
Command- I keyboard
equivalent, 67
Viewc:>Fit in window
command, 66
views, custom sizes, 43
vignettes, 551

Window menu, 46, 74-75,
137,375
windows, cascading and
tiling, 74
Windows menu, 270, 280,
344, 348-349, 495

word processor
Importing article from,
206-207
style sheet tags, 277-279
style sheets, 276-277
WordPerfect and style
sheets, 276
Wrap text command, 406
WYSIWYG menus, 30

•Z•
Zephyr SmartAlign
Addition, 418-4 19
Zephyr SuperSnap Addition,
418-419
Zero lock command, 126
zero point marker, 126
zoom tool, 110
arbitrary zoom, 110
Command-spacebar
keyboard equivalent, 110
moving on-screen, 11 2
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Find out why over 6 million
computer users love IDG'S
... FOR DUMMIES BOOKS!

"I laughed and learned•••"
Arlene J. Peterson, Rapid City, South Dakota

• • ...,.,-!lllllmDI
by Dan Gookin

This fun and easy DOS primer
has taught millions of readers how to learn
DOS! A Ill bestseller for over 56 weeks!
ISDN: 1·878058·75-4
$16.95 USN521.95 Canada
.£14.99 UK and Eire
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by Andy Rathbone
Here's the complete, easy-to-follow reference
for upgrading and repairing PCs yourself.
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ISBN: 1-568SI-002-0
$19.95 USN$26.95 Canada
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by Andy Rathbone

by Dan Gookin

team the Windows interface with this
bestselling reference.

learn Word for Windows basics
the fun and easy way. Covers
Version 2.
~-

ISBN: J-878058-61-4
$16.95 UM/521.95 Canada
.£14.99 UK and Eire
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ISBN: 1-878058-86-X
$16.95 USN$21.95 Canada
£14.99 UK and Eire
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by John Levine

by Dan Gookin

Surf the Internet with this simple reference
to command, service and linking basics.
For DOS, Windows, UNIX, and Mac users.

WordPerfect 6 commands and
functions, presented in the friendly
... For Dummies style.

ISBN: t~<;688.t-024 ·1
$19.95 USN$26.95 Canada
.£17.99 UK and Eire

ISBN: 1-878058-77-0
516.95 USN$21.95 Canada
.£14.99 UK and Eire
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1-2·1 HI -.wiD'"

by Dan Gookin & Andy Rathbone

by Greg Harvey

This #1 bestselling reference is
the perfect companion for the
computer phobic.

Spreadsheet guru Greg Harvey's fast
and friendly reference covers 1-2-3
Releases 2 • 2.4.

ISBN: 1-878058-51-7
$16.95 USN$21.95 Canada
.£14.99 UK and Eire

ISBN: 1-878058-60·6
Sl6.95 USN$2J.95Canoda
.£14.99 UK and Eire
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by David Pogue

by Greg Haroey

The #I ~lac book, totally revised
and updated. Get the most from

Updated, expanded-The easy-touse reference to Excel 5 features
and commilllds.
·.·;,-;~·

your Mac!
ISBN: 1·56884-051-9
$19.95 USN$26.95 Canada
.£17.99 UK and Eire
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by Dan Gookin
Bestseller Dan Gookin teaches all the
basics in this fun reference that covers
WordPerfect 4.2 • 5.1.
ISBN: 1-878058-52-5
$16.95 USN$21.95 Canada/.£14.99 UK and Eire
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ISBN: 1-56884-050-0
S16.95 U5.111$21.95 Canada
.£14.99 UK and Eire
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by John R. Levine &
Margaret Levine Young
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This enjoyable reference gets
novice UNIX users up and
runninHasL
ISBN: 1-878058-58-4
519.95 USN$26.95 Canada/

.£17.99 UK and Eire

For more information or to order by mail, call 1-800-762-2974. Call for a free catalog! For volume discounts and special orders, please call
Tony Real, Special Sales, at 415-312-0644. For International sales and distribution information, please call our authorized distributors:
CANADA Macmillan Canada
UNITED KINGDOM Transworld AUSTRALIA Woodslane Pty Ltd.
416-293-8141
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"If It wasn't for this book, I would have
turned In my computer for a stereo."
Experam:a Andrade, Enfield, CJ'

"DOS For Dummies Is the Ideal book
for anrone who's just bought a PC
and Is too shy to ask friends stupid
questions."

M1V, Computer Book of the Year,

Cllll.IIRAWI RIIIWMB'"

United Kingdom

by Delre McClelland
This bestselling author leads designers
through the drawing features of
Versions 3 & 4.

"This book allows me to get the answers to
questions I am too embarrassed to ask."

Amanda Kelly, Doylestown, PA on Gookin
and Rathbone's PCs For Dummies

ISBN: 1-56884-0-12-X
$19.95 US.V$26.95 Canadoll7.99 UK & Eire
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by Steve Nelson
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~tan age finances like a pro with Steve
Nelson's friendly help. Covers Version 3.

by John IVa/kenbach

ISDN: l-56884-005-5
$16.95 USN$21.95 Canada
£14.99 uK & Eire
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This friendly guide makes Quattro Pro
fun and easy and covers the basics
of Version 5.
ISBN: 1-56884-023-3
$16.95 USN$21.95 Canada/14.99 UK & Eire
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by Tina Rathbone
Learn how to communicate with and get
the most out of your modem - includes
basics for DOS, Windows, and Mac users.
ISBN: 1-56884-001-2
$16.95 USN$21.95 Canada
14.99 UK & Eire

by John IValkenboch
Learn the basics of 1-2-3 for Windows
from this spreadsheet expert
(covers release 4).
ISDN: l-56884-052-7
$16.95 USN$21.95 Canada/14.99 UK & Eire
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by Ed Tittel & Denni Connor

by Andy Rathbone

Learn to install, use, and manage
a NetWare network with this
slraightforward reference.

This fun and easy OS/2 survival
guide is perfect for beginning
and intermediate users.

ISDN: 1-56884-003-9
$19.95 USAI$26.95 Canada/17.99 UK & Eire

ISBN: I-8780S8-76-2
$19.95 USN$26.95 Canada/17.99 UK & Eire
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by Steve Nelson
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Manage your own finances with
this enjoyable reference that
covers Version 7.

by Beth Slick
This friendly reference teaches
novice Word users all the basics of
Word 6 for DOS

ISBN: 1-56884-006-3
$16.95 USAI$21.95 Canada/14.99 UK & Eire

ISBN: 1-56884-000--1
$16.95 USN$21.95 Canada/14.99 UK & Eire
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by Jim Meade

by Margaret Levine Young

Learn Ami Pro Version 3 with this
friendly reference to the popular
Lotus word processor.

liere's a fun and friendly reference lhatteoches
novice users features and commands of
WordPerfect For Windows Version 6.

ISIIN: l -56884-049-7
$16.95 USN$2 1.95 Canada/14.99 UK & Eire

ISBN: l -56884-032-2
$16.95 USA!S21.95 Canada/14.99 UK & Eire

For more information or to order by mail, calll-800-762-2974. Call for a free catalog! For volume discounts and special orders, please call
Tony Real, Special Sales, at 41 5-312-0644. For International sales and distribution information, please call our authorized distributors:
CANADA Macmillan Canada
UNITED KINGDOttl Transworld
AUSTRALIA Woodslane Pty Ltd.
416-293-8141

44-81-231-6661

61-2-979-5944

IDG BOOKS' .. . FOR DUMMIES QUICK REFERENCE SERIES
IDG's bestselling ... For Dummies Quick Reference
Sedes provides a quick and simple way to
remember software commands and functions,
written in our down-to-earth, plain English style
that guides beginners and experts alike through
important commands and
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hidden troublespots.

WORDPERFECT Rll DOS FOR
DUMMIES'" QUICII R&IJIINCE
by Greg Harvey
With this guide you'll never have to
worry about deciphering cryptic
WordPerfect commands again!
ISBN: 1-56884-009-8
$8.95 USN$11.95 Canada
£7.99 UK & Eire

I

WORD Rll WINDOWS FOR
OOMMIES,... QUICIIIHBDCE

"Thanks for coming up with the
simplest Idea ever, a reference that
you really can use and understand."

by George Lynch
End your stress over style sheets, mail
merge, and other pesk-y Word features
with this quick reference. Cover Word 2.

Allison J. Oi\'eill, Edison, NJ

ISBN: 1-56884-029-2
$8.95 USN$11.95 Canada
£7.99 Ul{ & Eire

ILLUSTRATED COMPIITIR
DlcnDNARY Rll DUMMIES'"

1-2-3 FOR DUMMIES'"
QUICK REFERH£E

by Dan Gookin, Wally Wang,
This plain English guide to
computer jargon helps with even
the most techie terms.

by John Walkenbach
l{eep this quick and easy reference
by your desk and you'll never have to
worry about forgetting tricky 1-2-3
commands again!

ISBN: 1-5688-i-004-7
$12.95 USN$16.95 Canada
£11.99 UK & Eire

ISBN: 1-568!YI-027-6
$8.95 USN$ 11.95 Canada
£7.99 UK & Eire

WINDOWS FOR UMJEJ'"
QUiallllftmNCE

EXC8. Rll DUMMIES'"

& Chds Van Buren

~CK IIBBifNCE

by Greg Harvey
The quick and friendly way to
remember Windows tasks & features.

by John Walkenbach
A fast, fun and cheap way to remember
bothersome Excel commands.

ISBN: 1-56884-008-X
$8.95 US:V$11.95 Canada
£7.99 UK & Eire

ISBN: 1-568!YI-028-4
$8.95 US!V$ 11.95 Canada
£7.99 lJK & Eire
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by Greg Harvey
A fast, fun, and cheap way to
remember DOS commands.
ISBN: 1-56884-007-1
$8.95 USN$11.95 Canada
£7.99 UK & Eire

by Greg Harvey
The quick and friendly "look-it-up"
guide to the leading Windows
word processor.
ISBN: 1-568!YI-039-X
$8.95 USN$11.95 Canadal£7.99 UJ{ & Eire

f'or more information or to order by mail, calll -800-762-2974 . Call for a free catalog! For volume discounts and special orders, please call
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IDG BOOKS' MACWORLD SERIES

"This Is the perfect book for
the way I think and work."

''This was an Incredible book.
It tnlly made leamlng Word 5 .0
quick and easy."

Chris Rosa, Opera/ions Mgr.,
South San Francisco, CA on
Macworld f.tacintosh SECRETS

William Levin, Chicago, IL, on
~1 acworld Guide to Microsoft Word 5

"Lon obviously 'sweated the details'
when he complied this excellent
System 7.1 reference. The unusually
detailed table of contents makes
finding Items a breeze!"

"An essential guide for anyone
managing Mac networks."

Reese Jones, President, Farallon Computing,
on /he Macworld Networking Handbook

James F. Steffy, Syscon Corporation,
Middletown, R!, on Lon Poole's Macworld
Guide To System 7.1, 2nd Edition

"Should've put It In a wire binder,
I am continuously using Itt"

Ric Rivera, Sea tile, WA on Lon Poole's M.acworld
Guide To System 7.1, 2nd Edition

MACWOII.D GUIDE TO
SYSTEM 1.1, 2111 mmoo

MACWIIU.II GUIDE TO
MICIIIiSon WORKS 3

by Lon Poole

by Barrie Sosinsky

Take an extensive tour of System 7.1
software, with Macworld columnist
Lon Poole's insider tips and
troubleshooting help.

This complete guide to Works 3 gets
you up and running with Microsoft's
popular integrated software-fast.

ISBN: 1-878058-65-7
$24.95 USN$33.95 Canada/£22.99 UK & Eire
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ISBN: 1-878058-42-8
$22.95 USN$29.95 Canada/£21.99 UK & Eire

by Steven Schwartz

by David Maguiness

Learn with step-by-step quick tips
how to integrate the powerful
modules and features of this popular
top-selling integrated package.

Create powerful spreadsheets right
away with this clear and extensive
step-by-step guide to Excel4.

ISBN: 1-56884-018-7
S22.95 USN$29.95 Canada/£21.99 UK & Eire

MACWOIID GUIDE TO

ISBN: 1-878058-40-1
$22.95 USN$29.95 Canada/£21.99 UK & Eire
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MICROSOFT WORD 515.1
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byJimHeid

by Dave Kosiur &
Nancy E.H. Jones

This is the complete guide to
Word 5 & 5.1, with step-by-step
tutorials and timesaving lips for
creating impressive-looking
documents with Word.

Mac network management from the
inside out! This insider's guide won lne
Society of Technical Communication's
"Award of Excellence."

ISBN: 1-878058-39-8
$22.95 USN$29.95 Canada/£21.99 UK & Eire

ISBN: 1-878058-31-2
$29.95 USN$39.95 Canada/£26.99 UK & Eire

For more infonnation or to order by mail, call 1-800-762-2974. Call for a free catalog! For volume discounts and special orders, please call
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"The time this book Is going to
save Mac users will pay them
back about fifty times over."

"The 8MB of software legitimately
.••smokes the covers off... any book/
collection I have found to date."

Doug Hamer, DS Hammer Design,
Wakefield, MA, on Deke McClelland's
bestselling ~1acworld Photoshop 2.5 Bible

Earl Wirth, Account Mgr., Calgary, Alberta,
Canada, on Macworld Macintosh SECRETS
"Great 'behind the scenes' Information
on Macintosh hardware and software."

Kevin Garrison, Sales, MI. Pleasant, SC on
Macworld Macintosh SECRETS
"Found Information In this book
that I have seen nowhere else."

Michael/(. Riggs, Moscow, lD on
Macworld Macintosh SECRETS

MACWOIID QUARKXPRESS

MACWOII.D MACINTOSH
SECIITS.

3.2/3.3 BIBLE
by Barbara Assadi & Galen Gruman

by David Pogue &
Joseph Schorr

The definitive guide to QuarkXPress
3.2 and 3.3 explains page layout, graphics,
and color prepress. Includes FREE disk
with QuarkXPress XTensions and scripts.

Hundreds of the latest expert tips on fl1ac hardware, software,
multimedia, networks, and much more are revealed by
Macworld magazine's, "Desktop Critic" David Pogue, with
coauthor and Macworld magazine's contributing writer
Joseph Schorr! Includes over 8MB of commercial
software and shareware.

ISBN: 1-878058-85-1
$39.95 US!V$52.95 Canada
£36.99 incl. VAT UK & Eire

ISBN: 1-56884-025-X
$39.95 USN$52.95 Canada/£36.99 incl. VAT UK & Eire

MACWORlD PAGEMAKER 5BIBLE
by Craig Danuloff
Stuffed with insider tips & techniques,
the ultimate guide to page layout
is here, plus 2 disks of PageMaker
utilities, templates, fonts,
and clip art.
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MACWOIILD PHOTOSHOP
2.5 BIBLE
by Deke McClelland
Packed with lips & techniques on electronic painting,
photo retouching & specia.l effects by Macworld
Contributing Editor Deke McClelland, this is the
complete reference to image editing. Now covers
version 2.5.1
ISBN: 1-56884-022-5
$29.95 US!V$39.95 Canada/,C26.99 incl. VAT Ul<& Eire

ISBN: 1-878058-04-3
$39.95 US!V$52.95 Canada
£36.99 incl. VAT UK& Eire
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This is the ultimate guide to using,
mastering, and expanding the Mac.
Includes CD-ROI'>t with software,
demos, QuickTime movies, & more!
ISBN: 1-56884-033-0
$39.95 US!V$52.95 Canada
£36.99 incl. VAT UK & Eire

Q REVIIION Of NATIDNAI. BEITSBURI
For more information or to order by mail, call 1-800-762-2974. Call for a free catalog! For volume discounts and special orders, please call
Tony Real, Special Sales, at 415-312-0644. For International sales and distribution information, please call our authorized distributors:
CANADA Macmillan Canada
UNITED KINGDOllt Transworld
AUSTRALIA Woods lane Pty Ltd.
416-293-8141
44-81-231-6661
61-2-979-5944

Order Form
Order Center: (800) 762-2974 18 a.m.-51un.• PST, wccl<~lavsl or (4151 312-0650
For Fastest Service: Photoco py This Order Form and FAX it to : (415) 358-1260
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Quantity

Total

Title

Shipping & Handling Charges
Subtotal

Up to $20.00
$20.01-40.00
$40.01-60.00
$60.01-80.00
Over $80.00

U.S.

Add $3.00
$4.00
$5.00
$6.00
$7.00

Canada &
International

Add $4.00
$5.00
$6.00
$8.00
$10.00

Subtotal
International
AirMail

Add $10.00
$20.00
$25.00
$35.00
$50.00

CA residents add
applicable sales tax
IN residents add
5% sales tax
Canadian residents
add 7% GST tax
Shipping

Total

In U.S. and Canada, shipping is UPS ground or equivalent
For Rush shipping call (BOO) 762-2974.

Ship to:
Name
Company
Address
City/State/Zip
Daytime Phone

Payment: o Check to lOG Books (US Funds Onlvl
Card#

Exp.

oVisa

o Mastercard

Signature

Please send this order form to: lOG Books. 155 8ovet Road, Suite 310. San Mateo. CA 94402.
Allow up to 3 weeks for delivery. Thank you!

oAmerican Express

IDG Books Worldwide License
Agreemment _____________________
Read this agreement carefully before you buy this book and use the programs
contained on the enclosed disk.
By opening the accompanying disk package, you indicate that you have read and agree
with the terms of this licensing agreement. If you disagree and do not want to be bound
by the terms of this licensing agreement, return the book for refund to the source from
which you purchased it.
The entire contents of these disks and the compilation of the software contained
therein are copyrighted and protected by both U.S. copyright law and international
copyright treaty provisions. The individual programs on these disks are copyrighted by
the authors of each program respectively. Each program has its own use permissions
and limitations. You may copy any or all of these programs to your computer system.
Do not use a program if you do not want to follow its licensing agreement. Absolutely
none of the material on these disks or listed in this book may ever be distributed, in
original or modified form, for commercial purposes.

Disclaimer and Copyright Notice _
Warranty Notice: IDG Books Worldwide, Inc., warrants that the disks that accompany
this book are free from defects in materials and workmanship for a period of 60 days
from the date of purchase of this book. If IDG Books Worldwide receives notification
within the warranty period of defects in material or workmanship, IDG Books Worldwide will replace the defective disks. The remedy for the breach of this warranty will be
limited to replacement and will not encompass any other damages, including but not
limited to loss of profit, and special, incidental, consequential, or other claims.
IDG Books Worldwide, Macworld, Inc., and the authors specifically disclaim all other
warranties, express or implied, including but not limited to implied warranties of
merchantability and fitness for a particular purpose with respect to defects in the
disks, the programs, and source code contained therein, and/or the techniques
described in the book, and in no event shall IDG Books Worldwide, Macworld, Inc.,
and/or the authors be liable for any loss of profit or any other commercial damage,
including but not limited to special, incidental, consequential, or other damages.

Installing the Macworld
PageMaker 5 Bible Disks
The software that comes with this book includes the elements you need to work
through the three sample projects in Chapters 8, 12, and 18 of the book. The disks also
include Aldus Fetch Trial Version 1.2/Macintosh®.
Follow these steps to complete a successful installation of the disk:
1. Insert Disk #1 in your floppy drive.
2. Copy the three folders named PM Bible Ch8 Files f, PM Bible Ch12 Files f . and
PM Bible Ch 18Files f to your hard drive. (Alternatively, you can use the sample
projects from the floppy as you work through Chapters 8, 12, and 18.)
3. To install Fetch, double click the Aldus Installer/ Utility icon in the Utilities folder
and follow the instructions in the dialog boxes.

FREE SOFTWARE
Macworld
FROM

YOUR FREE GIFT. Give Macworld a try and we'll send you a gifta free copy of Pogue's Power Utilities. With it, you get more than
14 fantastic programs specially selected by Macworld editor,
David Pogue. Your free disk comes with a desktop calendar,
anti-virus program, keyboard synthesizer... and more. It's the
most co111prehensive collection ofpower 11tilities aro11nd!

FREE ISSUE
Macworld gives you authoritative technical news. Award-winni ng
feature articles. Plus, more than 275 product reviews in every issue!
Why not send fur your FREE issue of Macworld today? When you
do, you'll automatically receive Manvorld's Power Utilities. FREE.
If you enjoy Macworld, you can subscribe at 37% off the regular
rate. If Macworld is not for you, simply write "cancel" on our
invoice. You pay nothing. You owe nothing. The free issue and
software are still yours to keep.

The Best Shareware
of the '90s!
• 14 Complete Power Utilities
iucluding ColorSwitcll,
\ViudowSiwde aud MeuuCiwice
• Coutrol pauels, desk
accessories aud games
• It's practical, iuuovative aud
fuu -to-use!

YES!

Send me my FREE software along with a
FREE issue of Macworld. If I like Macworld, I can
subscribe for a full year ( 11 additional issues for a
total of twelve in all). I'll pay the low rate of just
$ 18.97- that's a savings of 37% off the regular rate.
Write to:

I

Macworld

I
I

50 I Second St rcet

'I

San ha n cisco, CA 94 107

I

I

NA..\i l:.

CITYi~IA1 1J/II'

Basic sul>5<riplion price is $30 for 12 issu<S. The anuual corer J>rice is S3.95 per isme. For Mexican
and C'•mJdian subscriplions, please add SIS per year lor sl1ipping; $70 for all 01her foreign counlri<S.

Macworld

4B2o7

FREE GIFT!
The most comprehensive collection
of power utilities around.

:DAVID POGUE'S

:POWE

• 14 Complete Power Utilities

including ColorSwitch,
WindowShade and Menu Choice
• Control panels, desk accessories
and games
• It's practicat innovative and
fun-to-use!

--- ------------------------------------ -----------------------------------------,

I

\\\\\\ ~~\1\£5\

ft'E.E. utt

~-----------------

BUSINESS REPLY MAIL
FIRST CLASS MAIL

PERMIT NO. 1167

BOULDER, CO

POSTAGE WILL BE PAID BY ADDRESSEE

Macworld

SUBSCRIPTION DEPARTMENT
P.O. BOX 5 1666
BOULDER, CO 80321-1666
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return the
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card
today!

RETURN THIS
REGISTRATION CARO
FOR FREE CATALOG

IDG BOOKS WORLDWIDE REGISTRATION CARD
Title of this book:

Macworld P

Maker 5 Bible

My overall rating of this book: 0 Very good 111 0 Good m 0 Satisfactory Ill 0 Fair ,,, 0 Poor 151
How I first heard about this book:
0 Found in bookstore; name: 161
0 Book review: m
0 Catalog: 1s1
0 Advertisement: '''
0 Word of mouth; heard about book from friend, co-worker, etc.: 1101
0 Other: '"'
What I liked most about this book:

What I would change, add, delete, etc., in future editions of this book:

Other comments:
Number of computer books I purchase in a year:
0 11121 0 2-5 1131 0 6-10 1141 0 More than 10 11sl
I would characterize my computer skills as: 0 Beginner 11;1 0 Intermediate 1111 0 Adva nced 11e1 0 Professional 1•s1
I use 0 DOS 1201 0 Windows 1211 0 OS/2 1221 0 Unix 1231 0 Macintosh 1241 0 Other: 12s1_ __ __ __ _
fplease specify)

I would be interested in new books on the following subjects:
(please check all that app ly, and use the spaces provided to identify specific software)
0 Word processing: 1261
0 Spreadsheets: 1211
0 Data bases: 1281
0 Desktop publishing: 1291
0 Money management llll
0 File Utilities: llnl
0 Programming languages: 1331
0 Networking: 1m
0 Other: Jl'l

0 home ll>l 0 work tlEI 0 school 1371 0 other: (Jal _ _ _ _ _ __
The disks I prefer to use are 0 5.251391 0 3.5 I<OJ 0 other: '"' - - - - - - - - - - - - - - - - - -

I use a PC at (please check all that apply):
1have a CD ROM:

0 yes 1•21

0 no (Ill

I plan to buy or upgrade computer hardware this year:
I plan to buy or upgrade computer software this year:
Name:
Address ( 0 home r.;o1

0 yes '"'
0 yes t.osl

0 no 1111
0 no 1•11
Type of Business: ,,;,

Business title: 14!1

0 work (si)/Company name:

Street/Suite#

City ~/State ($JJ/Zipcode [541:

0 I liked this book! You may quote me by name in future
IDG Books Worldwide promotional materials.
My daytime phone number is _ _ _ _ _ _ _ _ __

Country 1551

IDG

BOOKS

TH E WORLD 0 1'
COMI'llfE R
Kl'\"OWLEDGE

0 YES!
Please keep me informed about lOG's World of Computer Knowledge.
Send me the latest IDG Books catalog.

COMPUTER
BOOK SERIEs

FROMIDG

NO POSTAGE
NECESSARY
IF MAILED
IN THE
UNITED STATES

BUSINESS REPLY MAIL
msTClASSMAIL. PERMITN0.2605 SANMATEO,CAUFORNIA

IDG Books Worldwide
155 Bovet Rosd Suite 310
Ssn Mateo CA 94402-9833
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Macwortd
PageMaker 5 Bible
Software Disk # I
~ac:IMrMt Md Copyrtlht Notice:
PleaH ref'd the not~es et tht bock of the book

MM• Uetton

'Piiiiiiiiid'"tne lntfelief"Kif'l ~10M tt the~.
o.k Cont•nta:
Aldut Fetch Tnel VersiOn 1..2/M.ctntolh tw

Pe1eMa1<"' 5 Soble Sem... Proje<t Ales:

PM O•b'- Ch 8 Filet/ • PM Bib~ Ch 12 Filet/ • PM Bib~ Ch 18 Flt.t /
C1i92 93 Aldus Corpon~Uon. MtK:App""; C198&-88 Apple Computer Inc. Pon1on1:

CI1G92 Eett/'1'1.6n Kodak. Company, C1987·93 SleiTa Software lonovetJont. Al1 rlct'tt•
reHrvtd JPEO decomprens~on technology h f!nsod from Storm Technolo~tr tne.

COW'IIl< ' Ul94 by l O G - WOIIcMde.
For moft lnfcwmatnn abOut lOG Bookl, CIII1-A1S.312.Q6!50

By breaking the seal on
this disk pack, you
accept the terms of the
lOG Books Worldwide
License Agreement Included In this book.
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PageMikerS
Bi61e
'Very useful for PageMaker beginners
and veterans alike - contains a wealth
of tips and tricks to make you a faster,

more powerful PageMaker user."
- Paul Brainerd, President and Founder,
Aldus Corporation

• How to use PageMaker's control
palette to work more quick~ and
with greater precision
• Tips and tricks for manipulating and
customizing type
• Find out how Aldus Additionstechnology
can save you time and automate
repetitive tasks
. Streamline your work and reduce
production errors with dozens of
keyboard shortcuts

"Since 1985 I've been tuming
PogeMoker upside down ond inside
o"! to find o!" what it con really _do.
J!r•s book will teoch you everythmg
1ve leo'!'ed ove~ the yeors plus tons
of new mformation on
~ Tldlllcii iiMiwllr
.
version 5. My goal is to
:.:i::
Tim Cole
• Techn1ques you need to
help you produce great
·
know vvh~n producing
looking pages in less
. . four-color JObs for
time ond with less eHort than you
separation 1n PageMaker
ever thought possible."- Craig Danuloff • Save time by using style sheets to

--.==.=-

LEVEL

Beginning to
Advanced
Users

COMPUTER
BOOK SHELVING

CATEGORY:

.s aII new Macworld pageMaker 5
Th 1
Bible is the ultimate hands-on resource
for everyone who works with the
,
t
t
world s mos popu1ar page 1ayou
program. From detailed instructions for
every PageMaker feature, to clearly
marked tips and tactics, and thre~
sample projects, this complete
PageMaker companion will show you
how to put PageMaker's power to use
creatively and productive~. It's the only
reference you'll need, whether you're
designing a one-page invitation or
building a 100-page book!

Madntosh/
Desktop Publishing/
Create the perfect page layout!
PageMaker
Inside you'llleam:
Sl9.95 USA
$52.95 Canada
06.99 ind VAT
UK & Eire

• Tips for setting up a Macintosh workstation so that it real~ has enough
power for PageMaker
• Everything you'll need to understand the
PageMaker pasteboard metaphor and
all on-screen tools and palettes
• The proper way to import text or
graphics from nea~ any source

Locate cfrgital images
With ease \\
Aldus Fetch, e :isua!
database :ha'lets )00

catalog, brcr.vse. and
retne\e graphic

pubhca::ons, ·ex:
sound
dip a:-

a1e5,

~

presen:atJons
a
variety ri meGIa Yoo cz:o:
save up ~ 50 ems Kl
FlEE '"<l: ~ ot

automate text formatting
.
. .
• Management strateg1~ for wo~n? wrth
long d~uments, and t1psfor bulld1nga
better 1ndex and table of contents
• The role Aldus PressWise, TrapWise,
and PrePrint can play in your electronic
prepress document production system

About the Author
Craig Danuloff opened one of the first desktop publishing service bureaus in Boulder,
Colorado, in 1985, and has authored
almost two dozen books on desktop
publishing and the Macintosh since then.
He is also a former Business Development
Manager at Aldus Corporation.

PLUS Cra~ Oa

has tnduded the
text and graphia
from the bc:d: s
three sample prorec:s.
making it easy to in~
apply the techniaues
you learn ·n the bool

Tho World of Compull!fi<n<1Medgo IS alradomafl< and lOG Bool<s IS a

regosttredtrad<ma~~<oftnt~Dat.JGroup. Fdchisatrac~ema~~<

of AIM Corporation.

ISBN 1-878058-84-3
53995
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